mSupply User Guide

Simple. Powerful.
Pharmaceutical Management.
Whether you run a pharmaceutical distribution warehouse, or are a
manufacturer needing dozens of connected users, or a small dispensary,
mSupply is a valuable partner.
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Why mSupply?
This brief paper outlines the main areas of functionality that mSupply covers, along with something of the approach and ethos of Sustainable
Solutions.

People
•
•
•
•

Our aims are to serve developing countries with solutions that provide real benefit.
That means that we are driven by a desire to serve, rather than by profit.
That said, we are a profitable company with no debt and a commitment to stay in business for as long as we are needed.
We have a balanced mix of expatriate and Nepali staff who work on mSupply.

Experience
• We've been doing mSupply since 1998, and full-time as Sustainable Solutions since 2001. In that time we've done hundreds of days of
trainings, converted hundreds of thousands of records from other systems to mSupply, and installed mSupply in hundreds of locations.
• Our experience in Nepal as a developing country, and in the many other developing countries that we've worked in, gives us a unique
perspective and understanding of the challenges and opportunities involved in working in similar environments.
• We're committed for the long term. We know that a decision to install mSupply is a big one. We're planning to be here decades from now.

Ease-of-use
• There is always a balance between features and usability, and while we know we don’t always get it right, we try to make sure we don’t add
features that aren’t really needed, and we make sure that features only needed by one client don’t clutter up the interface for everyone.
• mSupply is very easy to install- 10 minutes and a whole department is up and running.
• mSupply uses an easy-to-use graphical interface that makes adding Purchase Orders, Patient Prescriptions, Tenders, etc a breeze!
• The system is also made with high usage warehouses and busy pharmacy departments in mind. When fine-tuned, the system automates
item purchases, receipts and sales for the warehouse administrator and also provides features such as abbreviated directions entry for quick
prescribing of medicines.

Stability & Reliability
• The initial mSupply server installations in 2002 have run since then without ever crashing.
• We have more than ten years of experience in keeping mSupply installations running in developing countries, so we know what it takes to
make a reliable system. All multi-user mSupply systems we have installed are still running.
• mSupply includes an automated internet backup system, so backups are automatically transferred to a remote secure site.
• Server backups are automatic with configurable frequency.
• mSupply keeps a log of every action you make, and if there is a power failure then the log can be used to restore all unsaved data on the
server.

Security
• We do not know of any instances of a security breach of an mSupply server
• There is a full password protected login and permissions system, allowing each user’s access to functions to be controlled and recorded.
• A user log records all significant user interactions, allowing an audit of which user performed which actions.

Local or Cloud or Both!
• mSupply can run in many different ways, depending on whether you want to run a local or cloud-based service:
◦ Local server with client connecting over your local network
◦ Cloud based server with clients connecting via a special application or a web browser (e.g. Citrix)
◦ If you have several sites and want to manage them centrally, but the internet does not support a cloud-based service, then
mSupply also supports running individual servers at mulitple locations that then synchronise their data back to a central server
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when communications are available.

mSupply mobile
• On Sept 2nd 2013 we officially released mSupply mobile. It allows you to run a small medical store using a tablet computer (iPad or
Android or Windows). An internet connection is required, but users in developing countries are successfully using mSupply mobile over an
EDGE (2g) mobile network.

As of mid 2016, the internet connection does not need to be there all the time! See
Mobile (Android) user guide - new, featuring offline operation

• mSupply mobile can give stock visibility and automated replenishment for hundreds or thousands of stores connected to a single server,
which may be hosted on your premises or be cloud-based.

Scalable
• The same data file can grow from being used in a single-user system to having hundreds of concurrent users with millions of transactions.

Customisation
• Many mSupply users have unique needs requiring some customisation of the standard mSupply software. mSupply allows customised
versions that can still be easily upgraded as new releases are made. Often customisation is done at no extra cost if the client has a current
up-to-date contract.

Specially designed for pharmaceuticals
• mSupply is built from the ground up to handle batches and expiry dates.
• There are multiple ways of classifying medicines, and mSupply supports ATC coding, WHO’s EDL1) categories and the user’s own custom
categories.
• Many of the reports are specific to the needs of pharmaceutical distribution

Reporting
• The in-built reports have been developed since the beginning in response to user requests.
• Users can easily create their own custom reports and save them for use again. Saved reports are available from a menu in the custom report
window.
• Items, Names, and transactions all have lots of spare fields that users can use to store custom data, and then use those fields in reports.
• mSupply dashboard allows managers in remote locations to log on with a web browser and view reports.

Mistake tolerance
•
•
•
•
•

mSupply provides easy merging of duplicate items.
Easy adjustment of inventory errors (but with a full audit trail!)
Most fields allow entry by name or code, and allow partial entry of as much of the name or code as the user knows.
Easily find transactions you've entered, by number, by customer/supplier name, by a list of recent transactions or by a custom search.
If the user’s hardware is powerful enough, fuzzy find searches allow finding data even if the search terms are incorrectly entered.
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Backorders
• Items that you are unable to supply to customers are put onto backorder. A report of all backordered items is easily generated. When the
stock for the backorder becomes available a customer invoice is automatically created awaiting your confirmation.

Web interface for customers
• mSupply allows customers to remotely log in via a web browser and place orders, view order status, stock status and transaction history.
This system is in daily use.

Customer stock history / indent ordering.
• mSupply supports a unique system of centralised supply where the distribution point submits current stock on hand figures, and mSupply
calculate a rational quantity to supply, knowing the historic stock on hand, the ordering cycle, and the amount supplied during the previous
cycle.
• mSupply also supports the simpler imprest system where the amount given to customers is based on a fixed level of stock, as is commonly
done when supplying wards in hospitals.

Quantification
• mSupply uses a powerful ordering system that allows accurate real-time analysis of how much stock should be ordered, based on historic
consumption, order lead time, the ordering frequency, desired “buffer” stock levels and current stock levels. Unmet demand from
customers, backorders, and stock on order are also taken into account.
• This system has proven reliable, and requires little user intervention, unlike systems that require you to set minimum and maximum stock
levels. mSupply still allows minimum stock to be set if really needed.

Procurement
•
•
•
•

mSupply handles purchase orders in multiple currencies, and allows split deliveries.
The goods receipt module allows full or partial receipt of each purchase order plus addition of stock not ordered.
Ad hoc quotes from suppliers can also be handled.
The quantification, tender management and purchase order systems all tie together so data flows from one to the other without requiring reentry.

Tender management
• The Tender Management module provides detailed production and management of tenders including using mSupply data to determine
quantification, printing invitation letters, comparing tender submissions and automatically producing Purchase Orders for the winning
tender supplier.
• The Remote Tender Management Module provides posting of tenders by suppliers to https://tenders.msupply.org.nz
(https://tenders.msupply.org.nz) secure web site. You download and automatically import completed tenders to mSupply for easy
comparison of supplier responses, choosing the winning supplier and creation of purchase orders.
• Supplier Registration functionality is planned to be developed as part of the Tender management module.

Dispensing
•
•
•
•
•
•

mSupply integrates well into hospital pharmacies, providing easy breakdown of bulk packs for dispensing.
Prescribers are recorded, and prescriber reports allow analysis of prescribing trends and costs.
Drug interactions are handled, as is repeat dispensing.
Patient history is recorded and easily accessible.
Customisable abbreviations allow rapid entry of patient instructions on to printed labels.
Medicine labels are produced using specialist label printers. Busy sites using mSupply produce hundreds of thousands of labels per year.
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Multiple sites from one server
• mSupply is able to handle multiple virtual stores within a single data file. A common use for this is a hospital, where several stores may be
present, but each needs to run independently.
• Stores can run in either dispensary or store mode, so one server can handle both a hospital pharmacy and a warehouse store simultaneously.
• Using Citrix and a DSL internet connection you can run a whole country's medical distribution system from a single server, greatly
reducing infrastructure requirements while dramatically improving availability and reliability.

Stock control
•
•
•
•
•

Because mSupply tracks each batch separately, full FEFO 2) can be maintained for every item.
There is a full audit trail for each stock line.
Each stock line has a record of warehouse location, enabling easy warehouse management
If stock lines have the same batch number, expiry and pack size, they can be split and combined.
Stock lines can be re-packed to different pack sizes for convenience. Warehouses will find it easier to handle cartons with a pack size of,
say, 12,000 tablets while dispensaries will be dispensing individual tablets, and so will want a pack size of 1.

Warehouse management
• Full Location management
◦ mSupply allows volume based calculations of available storage, that is especially critical for cold chain items.
◦ Volume information is used to provide either reports or a graphical depiction of how full each section of the warehouse is.
◦ Alerts are given when placing purchase orders if there will not be enough space to hold the incoming goods.
• Basic bar-coding functionality is planned to be developed soon.

Vaccines monitoring
• mSupply allows recording of VVM3) status for batches, and allows sorting available stock by VVM status rather than by expiry.

Mobile communications
• mSupply integrates with Frontline SMS to provide an interface for using SMS messaging to submit information such as stock levels and
goods receipt confirmations to mSupply.

Hospital Information System
• A simple hospital information system has been developed as part of mSupply. It is designed to provide a basic service to record critical
data:
◦ Recording a hospital's wards and beds.
◦ Recording inpatient admissions (admitting a patient, assigning them to a ward and bed).
◦ Recordng ICD4) 10 disease codes for each patient admission. You can assign multiple disease codes, and prioritise them
(primary, secondary, etc..).
◦ Moving patients to different wards/beds.
◦ Recording discharge data (patient status at time of discharge)
◦ Reporting on bed occupancy rates as a whole and by ward, and other useful statistics e.g. average length of stay, ICD10
statistics.
• The mSupply HIS is a cost effective alternative to large commercial installations.

Product / Medicine Registration
• mSupply's Registration module allows mSupply to manage registration of suppliers and their products on a per brand, dose, and form basis.
• mSupply will record and track the status of supplier's registrations and stores the documentation for easy retrieval.
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No data lock-in
• All data in mSupply can be exported as industry-standard XML or as an SQL dump, allowing use by other systems as needed.
• A public API has been developed, allowing any system to retrieve and submit information from/to mSupply.

Cross-platform
• mSupply is available for Windows and Macintosh.
• We recommend Windows servers, but client computers can be either Windows or Macintosh.

Interaction with other systems
• mSupply can either query other systems or provide data in real time via XML web services and other industry standard connectors.
• mSupply provides automated seamless integration with Moneyworks accounting software and general export files which can be easily
customisable for import to other systems.
All of these features and qualities go together to make a very powerful medical inventory chain management system, which has been tried and tested
in dozens of locations around the world. We believe it has a unique set of features that means there is no other product that is comparable for
managing medical supplies in developing countries
For full information, visit http://www.msupply.org.nz (http://www.msupply.org.nz) A demo version is available here (http://www.msupply.org.nz/
download)
The user guide is available here (http://www.msupply.org.nz/files/mSupply_user_guide.pdf)
The home page for the documentation wiki is here (http://docs.msupply.org.nz)
Next: Who uses mSupply?
2011/04/19 07:56

·

Who uses mSupply?
This list isn't exhaustive.
All sites are multi-user with the number of sites x number of concurrent users at each site in brackets unless denoted by SU (=“Single User”) after the
name.

Africa
Nigeria
• Six Government state stores (6 x 3)
• Ten Government stores managed by Axios (10 x 2)
◦ Axios HQ, Abuja (4)
◦ Axios uses mSupply synchronisation to connect sites that don't have full time internet access. This system has been in use since
2010, and continues to function well.
• FCMS Store, Lagos (5)
• Jigawa CMS
• From March 2016: 20 new users spread over 6 states (Kaduna, Katsina, Zamfara, Kano, Jigawa, Yobe)
• Private non-pharmaceutical supplier, Lagos (STIL)(SU)

Democratic Republic of Congo
• Cordaid (3)
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Ghana
• Central Medical Stores (5)
• Status 2015: CMS was destroyed in a fire in 2014, and the project has been on hold since then.

Liberia
• Axios: 1 site synchronising to a central server
• Liberia MoH: 11 sites being consolidated to a single mSupply installation Dec 2016

Sierra Leone
•
•
•
•

MRC (SU)
Crown Agents Ebola Response and Free Health care distribution (20) - several stores around Freetown running from a single cloud server.
National Pharmaceutical procurement unit (2017). Central server with 18 users, 13 regional sites, et al.
LSHTM Ebovac (2017). Server with 5 users.

Gambia
• Gambia Central Medical Stores (14)

Malawi
• Orant Charities (SU). From 2017.

Tanzania
• Haydom Hospital

Sudan
• Medair (SU)

South Sudan
• Medair (SU)
• Central Medical Stores (SU)
• UNDP Juba (5)

Zambia
• Churches Health Association (4)

Zanzibar
• ZILS (5)
◦ This system employs an EDI interface to pick up orders sent to a dropbox folder from the Zanzibar LMIS system and
incorporates it into mSupply.
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Pacific
Kingdom of Tonga
•
•
•
•
•
•

Central Pharmacy Medical Stores (3)
Vaiola Hospital (4)
Haapai Hospital (SU)
Vava'u Hosptial (SU)
'Eua Hospital (SU)
Mobile (11)

Republic of Nauru
• Central Hospital and Stores (4)

Solomon Islands
• National Medical Stores (7 + Web server + Tender module)
• National Referral Hospital (4)
• mSupply mobile- 8 Second Level Medical Stores (phased installation from October 2016)

Republic of Kiribati
• Tungaru Hospital (9)
• 3 26 sites using mSupply mobile

Marshall Islands
• Ministry of Health/Majuro Hospital (2)

Tuvalu
• Princess Margaret Hospital (2)

Vanuatu
•
•
•
•
•

Central Medical Stores (2)
Vila Central Hospital Pharmacy and Store (3)
Lenekel Hospital (2)
Norsup Hospital (2)
Luganville Hospital (2)

Papua New Guinea
• 44 user system across the country:
◦ Cloud system (12) serving
▪ National Department of Health, Medical Supplies Procurement Department - Installed June 2013
▪ Daru TB Unit - Installed Sept 2015
◦ Badili (Port Moresby) AMS (8) - Installed June 2013
◦ Port Moresby General Hospital (10) - Installed November 2014
◦ Hagen AMS (4) - Installed October 2015
◦ Hagen General Hospital (4) - Installed October 2015
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◦
◦
◦
◦
◦
◦
◦
◦
◦

Lae AMS (4) - Installed May 2015
Lae General Hospital (4) - Installed May 2015
Alotau General Hospital (4) - Installed Sept 2015
Wewak Area Medical Store (4) and Hospital
Vanimo Hospital (4) - 2016
Goroka Hospital (5) - 2016
Kundiawa Hospital (5) - 2016
Kokopo AMS - 2017
Nonga Hospital - 2017

Federated States of Micronesia
• National Hospital and medical store (7) - October 2015

Cook Islands
• Desktop Sites (5) - January 2018
• Mobile Sites (10) - January 2018

Asia
India
• Meyer Free Clinic

Nepal
•
•
•
•
•

INF (3 sites- SU)
MSMT (SU)
Patan Hospital (SU)
Lal Gadh Hospital
Gurkha Welfare scheme (26 sites, SU) Funders: DFID, GWT

Afghanistan
• Six NGOs responsible for medicine distribution in provinces synchronise data back to a management server in Kabul (July 2016). Includes
automated generation of a multi-workbook Excel spreadsheet that includes macros that submit data to a Ministry of Health database.

South-East Asia
East Timor
•
•
•
•
•
•

SAMES (10)
Hospital Nacionale Guido Valedares (5)
Dili Central Medical Services (Mobile)
100 mSupply mobile sites
National Laboratory, Dili
Baro Pite Clinic, Dili

Laos
• 28 sites spread over the country connecting to a cloud server running mSupply.
• 10 sites using mSupply synchronisation
36

mSupply user guide July 2018

Myanmar
•
•
•
•

31, no 42 50 62 145 sites using synchronisation to connect to a cloud server
6 sites using remote access to connect to the same server
Central Medical Store (5) from January 2016
RSCS program - 70 synchronising sites (also connecting to the same server) from November 2016 (by end of Jan 2017 mSupply was
storing almost 4 million data points for the project)
• Medical Action Myanmar (Dec 2017) - 25 mobile sites connecting to a cloud server running mSupply.

Cambodia
• World Mate Emergency Hospital
• WMEH Warehouse

Americas
USA
• Iowa Prescription drug corporation
◦ users: 2
◦ Web server: clients from all over Iowa place orders using the mSupply web interface

Europe (and the United Kingdom!)
United Kingdom
• UK Microbiological Products supplier (Private company). Since 2012
• CAIPA
◦ Specialist system with 20 users. Was running emergency Ebola Response Programme for DFID, including management of a UK
based warehouse with air freight deliveries to Africa. Now managing a distribution programme in South Sudan.
Previous: Why mSupply? Next: Which One?
2011/04/19 07:35

·

Which one?
Introduction
Since its creation in 1998, mSupply has grown and multiplied as it has been applied to different challenges. The original Free-user (Windows or Mac
based) application continues to be downloaded and used regularly. In fact, it comes packed with (almost) all the bells and whistles of some of our most
sophisticated installations, but is only suitable for a small, single concurrent user facility.

We need two servers!!!???
The ICT industry is plagued by the practice of using the same term to refer to software, hardware or both
combined! As it relates to mSupply in multi-user environments, there is often confusion over two of these:
• The term 'Server' can refer to:
◦ The mSupply computer software which runs the mSupply database,
◦ The hardware which the server software is installed on, and;
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◦ Both the hardware and the software acting together. This is possibly the most common
usage. When we say something like “send to the server” we mean send data to the server
software operating on the server hardware.
The server hardware can actually be a cloud hosted 'service' rather than physical hardware that you own and try
to manage. Sometimes the server hardware is referred to as a 'file server', and this can help to avoid confusion.
In any case, for any multi-user mSupply installation, including mSupply mobile, both server software and server
hardware are needed, and both of them cost money.
• Similarly, the term 'Client' can refer to:
◦ The mSupply computer software which accesses the mSupply server (software) database
on the server (hardware),
◦ The hardware which this client software operates on, and;
◦ Both the hardware and the software acting together.
Sometimes the client hardware is referred to as a 'client PC' (Mac or Windows) and this can help to avoid
confusion. Again, for any multi-user mSupply installation, including mSupply mobile, both client software and
client hardware are needed. For mSupply mobile, the client hardware is an Android Tablet - refer Mobile
(Android) user guide v2.0 - featuring offline operation.
We are a software company, so when we use these terms, we will almost certainly be referring to our software,
but sometimes not. The context normally helps, but please forgive us if we fail to distinguish between these
meanings!

System configuration comparison
So which is the right mSupply product / configuration for you? The key differences between the configurations basically comes down to how the
user(s) interact with the database. We hope this table helps in making that decision.

Product / configuration

Description

Software price
implications - refer
Pricing
(http://msupply.org.nz/
pricing/)

PC or Mac application - Download here (http://msupply.org.nz/
downloads/). The database resides on the computer that the application
has been installed on. It can be used by only one user at any one time.

Free! You still need to
register mSupply with
Sustainable Solutions,
but we don't charge you
for it - and we don't sell
your contact details
either!

Single-user

Same as PC or Mac application, but for users who wish to make use of
Support5) and Up-to-Date (UTD)6)

A software license needs
to be procured, generally
for about 1/3 of the price
of a multi-user client, and
then Support and UTD
on top of that.

Multi-user

For situations where more than one user needs to access the database at
one time. The database is hosted on a file server and mSupply server
software is installed on that hardware. Users have access to this data
through mSupply client software installed on client PCs that communicate
to the server through a Local Access Network (https://en.wikipedia.org/

A software license needs
to be procured for each
concurrent client.
Support and UTD is
optional, but highly

Free-user
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Product / configuration

Description

Software price
implications - refer
Pricing
(http://msupply.org.nz/
pricing/)

wiki/Local_area_network) (LAN). Remote users can access the server
through Remote Desktop Protocol (https://en.wikipedia.org/wiki/
Remote_Desktop_Protocol) (RDP) or similar.

recommended. Most of
our customers are very
happy to pay for these
services.

Synchronised Multi-user

If the internet connection to remote users in a Multi-user configuration is
inadequate, then Remote Synchronisation allows a Primary - Satellite
configuration to be deployed. 'Satellite' multi-user servers are installed at
remote sites where users operate mSupply on their local store without
worrying about the internet connection. In the background, these 'satellite'
servers will synchronise their local store data with a 'Primary' server when
the internet connection becomes adequate.

A software license needs
to be procured for each
concurrent client for each
server. Synchronisation
and Web server modules
are required.

Synchronised Single-user

There are situations where the remote sites (with poor internet access) are
just single-operator stores needing to manage and report their stock using
the fully featured mSupply client. Procuring the minimum multi-user
satellite server configuration for each of these sites would be expensive. A
solution was developed that entails installing single-user clients at these
remote locations and then synchronising them to the primary server much
like the Synchronised Multi-user configuration.

Lower cost than
conventional
synchronised multi-user
as the single-user client
license is less costly than
multi-user client licenses.
Synchronisation and Web
server modules are
required.

Mobile

This is a Synchronised Single-user configuration, but the users operate
with mSupply Mobile (client) software on Android tablets. This apps has
a reduced feature set, but is more than adequate for most Last-Mile needs.
Local stock details are synchronised back to the Primary server, and can
be monitored and reported on there.

Pricing is even lower
than for Synchronised
Single-User. We see this
as the way forward for
the medical supply chain
in small and remote
facilities.
Synchronisation and Web
server modules are
required.

mSupply Customer Interface

Allows staff of Customers in your mSupply system to report their stock
levels and order stock from a Virtual store in mSupply system. It runs on a
browser on any device: tablet, smartphone, net-book, desktop computer
etc.

Depends on your
situation - contact us.
Web server module is
required.

FrontlineSMS integration with 2G
mobile phone

mSupply has the ability to integrate with a FrontlineSMS installation.
This allows a customer to send their current stock levels to mSupply using
an SMS (text) message from any mobile phone. This is particularly useful
if, for example, you are a mobile or remote health post or dispensary
which doesn't have internet access and only needs to send in information
about a few items at a time.

SMS module is required

Other modules
Other modules are available for addition to the basic mSupply application:
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Module

Comments

Software price
implications - refer
Pricing
(http://msupply.org.nz/
pricing/)

FrontlineSMS

Allows users to send their current stock levels to mSupply using an SMS
(text) message from any mobile phone. This can then be used by mSuppy
to determine how much stock to send to the facility.

Equal to the price of 1
client license.

Product (drug) Registration

Allows integration of product registration (control of what products can be
supplied by authorising particular suppliers and products) by recording and
tracking the status of supplier's registrations and storing the documentation
for easy retrieval.

Equal to the price of 2
client licenses.

Web Server Module

Allows you to access mSupply data on the server from any networked
computer that has internet access.
This module is a prerequisite for several other modules.

Equal to the price of 2
client licenses.

Synchronisation Module

Maintains data integrity between a 'primary' mSupply server and 'satellite'
mSupply servers. It therefore only applies to situations where there is a
multi-mSupply server setup.
Requires the Web Server.

Equal to the price of 2
client licenses.

Tender Management

Allows execution of a full tender process including publishing of the tender
through a web site, and so allowing tenderers to submit tenders on-line.
Requires the Web Server.

Equal to the price of 1
client license.

Previous: Who Uses mSupply? Next: Mobile (Android) user guide - new, featuring offline operation
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Mobile (Android) user guide v2.0 - featuring offline operation
1. Getting Started
Hardware Requirements
Recommended Specifications:
•
•
•
•
•

Display: 800 × 1280 pixels
Mobile Data enabled (3G minimum)
Android 4.4.4 or higher
1.5 Gb Ram
Quad-core 1.3 GHz

Minimum:
• Display can be 768 × 1024 pixels

Installation
You can get the latest version from the Google play store
If you are upgrading to version 2.0.0 of mSupply Mobile, there are a few changes that need to made to your mSupply Desktop/Server.
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•
•
•
•

Upgrade to 3.83 +
Set Visibility for Supplying Stores (including main Supplying Store)
Add a new Supplier as facility (External Supplier) and make it visible in mobile store
Set all other mobile/desktop stores that current mobile store needs to interact with (send/receive Requisition, send/receive Invoices) as
'transfers' in store/synchroniser (this needs to be done by your mSupply team)

Initialisations
The mSupply mobile App needs to be installed on your tablet. Once it is started, you need to enter the Site user name and password and the URL for
the mSupply server that will hold the data that the tablet will generate.

OK. Here we go!
This is the login screen. You will be given a User Name and Password when your tablet computer is installed at your clinic. Your tablet computer can
only log in to one facility.
The first thing you will need to do is to choose your preferred language, by clicking 'language' at the bottom left of your screen, as outlined in orange
below:

The Tablet above is asking for the user name and password for the person that will
be operating the store. This user name and password needs to be set on the
mSupply server. Please look up Managing users in this guide

For example, if your first language is Tetum, then you're in luck!
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So, once you have selected the language of your choice, enter your User Name and Password and click ‘Login’!

This brings us to the main screen, we will be returning to the main screen a lot as we use mSupply Mobile, so it's important to understand the main
functions. Let's go through them one by one.
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A link on the top right of the screen shows the sync status.

Clicking this link will take you to a page where you can choose to do a manual sync if there is internet connectivity.

You can close this page by clicking the cross on the top right.
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CUSTOMERS
The 'Customers' area is for all the stock that goes OUT of your facility. It contains a list of customer invoices and
customer requisitions. Customers can be other facilities you supply, doctors and nurses doing outreach tours, or
individual patients.

The Customer Invoice button will bring up a list of the most recent customer invoices (orders TO customers) and allow you
to create new ones.

The Customer Requisitions button will bring up a list of the Customer Requisitions.

SUPPLIERS
The 'Suppliers' area shows orders that you have sent for your own stock. Usually, you will only have ONE supplier (a
medical store or other healthcare facility) and this will be pre-programmed for you. The Suppliers area allows you to place
orders (Supplier Requisitions), see a list of your pending orders, and shows the stock you have already been sent or are
waiting to receive (Supplier Invoices).

The Supplier Invoices button will bring up a list of the orders you have been sent or are waiting to receive.

The Supplier Requisitions button allows you to place an order and shows you a list of orders you have already placed.
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STOCK
The 'Stock' section shows you a list of your current stock and allows you to do stocktakes. You can also use this area to
search for an individual item (“how many paracetamol tablets do I have?”) or to update the stock levels for each item
when you realise there is a mistake, or you are doing your regular stocktake.

The Current Stock button allows you to easily see how much stock you have on hand, search for an individual item, or check
expiry dates.

The Stocktakes button allows you to do a stocktake on all items or a small selection of items and shows you a list of all
previous stocktakes.

(and here's the main screen in Tetum!)

2. Customer Invoices
Aspen Medical Centre sends an order to your facility. They are doing an outreach tour to households in a nearby village and would like to collect some
items to take.

45

mSupply user guide July 2018

The CUSTOMER is Ami CHC
They have ordered:
Amoxicillin 500mg tabs x 11 Paracetamol 500mg tabs x 100 Diazepam Injection 5mg/ml Amp/2ml x 50
Let's create a Customer invoice…
1. Click on 'Customer Invoices'
The Customer Invoice button will bring up a list of invoices. If you haven't finished working on an invoice and you have not confirmed it, you can
click on it now to bring it up and keep working on it.

2. To start a new Customer Invoice, click 'New Invoice'.
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Add the customer you are ordering for..

3. You can add items to the customer invoice one by one. To do this, click on 'New Item'.
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If you have a lot of items to add to the invoice, it can be slow to add them one by one. To add a lot of items at once, click 'Add Master List item'.
Here you can see we have completed this invoice by adding the 3 items we need.
4. When you have finished, click the 'FINALISE' button at the top, and then CONFIRM.

What is a Master List?
The Master List is a list of all the items available to you at your facility. The list is set by your supplier, and/or the Ministry of
Health.
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3. Customer Requisitions

When a customer wishes to order stock from you, they will create a supplier requisition in their own store and it will appear as a customer requisition
in your system.

Open the requisition by clicking on it and check the details. If you wish to change quantities of items you are going to supply you can do so now.

Once you are satisfied with the details you can click the finalise tick on the top right.
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mSupply will then generate a customer invoice in your system which will be sent to the customer as a supplier invoice.

4. Supplier Requisitions
You would like to order some stock from your supplier (Medical Stores). You need to place an emergency order for Ampicillin injections and CoTrimoxazole tablets.
To do this, you must send a 'Supplier Requisition' for:
Ampicillin 1g inj x 300
Co-Trimoxazole 480mg tabs x 500
So let's do it!
1. Click on 'Supplier Requisitions'

This will bring up a supplier selection screen. Select the supplier here.
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You will now see a list of recent requisitions you have placed. If you have started working on the requisition previously, it will display in the Status
column as 'In Progress'. If you haven't finalised it, you can click on it and keep working on it.
2. Now click on 'New Requisition'.
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These are the two ways to add items to the requisition.
To add a lot of items (for example, when you are placing your main order), click 'Add Master List item'.
If you only have a few items, click 'New Item'. This is the best option for small orders.
3. We only have two items, so click 'New Item'.
Add in the details for the items:
Ampicillin inj x 50
Co-Trimoxazole 480mg tabs x 100
Make sure your quantities are correct. If you want to change them, click on the 'Requested Quantity' column and change the number.
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4. You can click on 'Use Suggested Quantities', or 'Create Automatic Order' if you are certain that you are not ordering an item which you have not
previously ordered. By choosing one of these options, mSupply will automatically calculate the amounts of each item you require, once it builds up a
history of how much stock you're using.
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5. When you are completely sure that everything is correct, click the 'Finalise' button, then 'Confirm' and your order will go to the supply store.

Even if you don't have internet at the time, it's Ok! The order will send automatically when you do have internet later.

What is the difference between a supplier requisition and a supplier invoice?
A Supplier Requisition is an order that YOU have placed to the Medical Stores. A Supplier Invoice is a record of what they
have sent you. These are not always the same, as Medical Stores might not have had enough stock to fill your requisition, or
they might have sent you some stock that you didn't order. When stock arrives at your facility, check it off against the Supplier
Invoice - as this is what you were supposed to receive.

Calculating quantities on your requisitions...
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When you are creating a new requisition, mSupply Mobile now has a tool to help you work out how much stock you need to order! In the past, you
had to use a calculation formula to work out how many of each item, and you needed to do this for EVERY item in your order.
Now, simply select the 'Months Stock Required' and mSupply Mobile will calculate your order quantities automatically. You can even check the
amounts and change them if you require.

5. Supplier Invoices
After you've sent your requisition to your supply store, you then wait for your order to arrive.

55

mSupply user guide July 2018

And wait and wait and wait…….
Then finally your order will be on the way!
When your order has been prepared by your supply store, you will see a Supplier Invoice. This is exactly like the hard-copy (paper) invoice you would
usually receive with your order.
You may still continue to receive a paper invoice when your order arrives, but it is very important you check everything against the electronic invoice
on mSupply Mobile when you order arrives.

Remember: The supplier invoice will not always match the requisition you sent.

Also remember that the supplier invoice SHOULD match the stock you are receiving, but it may not. You must always check your order when it
arrives. You can make changes to the Supplier Invoice on mSupply Mobile, or you can confirm everything is correct. When you are satisfied that the
Supplier Invoice matches the stock you have received, you can 'Finalise' the order and accept it into your stock. Your 'Stock-On-Hand' numbers will
automatically update!
Let's go through each step…

1. Click on 'Supplier Invoices'
A list of Supplier Invoices will appear. You can use the 'Status' column to check which one you have been sent but has not yet been received.
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2. Click on the Supplier Invoice you have been sent.
This will bring up your Supplier Invoice. You can see the two items that we entered on the requisition earlier.
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3. Once you are happy that the 'Quantity' and 'Expiry Date' columns are correct, click 'Finalise', and then 'Confirm'.
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6. Current Stock
One of the most important - but easiest - tasks in mSupply Mobile is to check how much stock you have on hand. When you create a Customer
Invoice and add an item, mSupply Mobile will tell you if you have enough stock. But at many other times, you might want to quickly check, and it is
very simple to do so.
Let's try!
1.Click on 'Current Stock'
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This will bring up a list of your current stock-on-hand.You can scroll through this list and quickly see each item's name and 'Stock-On-Hand' (amount
of each item you currently have in stock).
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2. If you want to know a little more about an item, click on the item and it will bring up more information, such as the Category, Department, and
closest expiry.
If you want to search for a specific item, without having to scroll through, just enter the first few letters into the search bar at the top.

7. Stocktakes
mSupply Mobile will automatically keep track of your stock levels for you, as you receive stock and give it out. But sometimes data gets entered
incorrectly or stock goes out without anyone making an entry in the system. Of course, we try not to let that happen - BUT if it does happen, we can
make corrections. The easiest way to correct mistakes is to do a stocktake.
With mSupply Mobile, you can easily do the data entry for a full stocktake, OR you can choose to do a stocktake on a limited range of items (such as
all your anti-malarials). You can even do a stocktake on a single item, if you notice that the quantity on your shelves is wrong.

Stocktakes
You should already be doing stocktakes with your current ordering systems.
Stocktakes are a very important way to ensure that the orders we are placing are
accurate and that the stock will be correct if anyone checks!
Ideally, you should be doing a physical stocktake of each item EVERY time you
place a main order- but this depends on your local policies and procedures (and it
may not be possible in larger facilities).
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Let's learn how to do a stocktake… using mSupply Mobile makes doing stocktake a LOT easier than before.

1. In the main screen, click on 'Stocktakes'
This brings up a list of all your previous stocktakes. The description of each Stocktake will be shown, with its date and 'Status'.
There are two stocktake statuses: In Progress (Current) and Finalised (Past).
An 'In Progress' stocktake is one you are still working on. If you want to keep working on an 'In Progress' stocktake, double click on it.

'In Progress' Stocktakes
'In Progress' Stocktakes are the stocktake you are still working on, and haven't
finalised.
We strongly recommend only having one In Progress Stocktake at any time. This
will prevent mistakes when moving between them.
Finalise or delete old stocktake before starting new ones!
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Let's start a new stocktake now…
2. Click on 'New Stocktake'

3. Select the items that you wish to count by highlighting them in the far right column.
If you want to include EVERY item or most items, click 'All Items Selected'.
4. Give your stocktake a logical name, such as “April Full Stocktake'., and click CREATE.
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5.This will bring up the stocktake editor. This lists each item, its 'Snapshot Quantity' and its 'Actual Quantity' (from the physical count). The
Snapshot Quantity is what the system THINKS you have. If it is correct (when compared with your physical count), you don't need to do anything!
The Actual Quantity is what you have actually counted. You can change this by clicking in that column and typing in the correct quantity.
6. Go through each item and compare your physical count with the Snapshot Quantity. Change each one you have to by clicking in the
'Actual Quantity' column. If you change the amount of stock you have in the Actual Quantity column, this variation will now show in in the
Difference column.
This can take some time but remember - if the Snapshot Quantity is correct, you don't need to do anything!
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7. When you are finished, click 'Finalise'.

This will update all your stock levels to match the quantities you have entered in the 'Actual Quantity' column.
Like always with mSupply Mobile, you don't need internet to do this - the information will sync in the background when internet becomes available.
Previous: Which one? Next: Setting up mSupply moblile
2017/09/07 20:24

·

Setting up mSupply mobile

Note - we will complete these steps for you. The following instructions are for
your information only.

Adding a store
On mSupply desktop go to Special > Stores > New Store
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Enter the Store Code and Store Name

Click on the Master List tab and select a Master List
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Click OK
Click OK again

User Access
Next you need to make the current user have access to the store you have just set up.
Go to Admin > Edit Users

Select the user and go to Login Rights.
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Select the new Store

Logging in to the Store
Now, you need to log in to the new Store
Go to File > Switch (or ‘cmd 2’ (apple) or ‘ctrl 2’ (windows))
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Log in

Setting up a Sync Site
Got to Admin > Preferences
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On the Synchronise tab on the left-hand side and click on the unlock button and enter the password

Add new Sync Site

Enter ID, Username and Password and click OK
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Log in to the Store
Go to Special > Stores

Double-click the Store
Click the unlock button and enter password
Set Synchronisation type to active store
Select store (as local)
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Click OK
Click the unlock button and enter password again
Set Sync type to Collector and sync type to Active/Collector
Click OK
Click OK again
Start the web server

Initialising mSupply Mobile on Device
After installing the app, you must do an initialisation of the data for the store the tablet is going to be used in. All above steps must be complete for
this to work. The first screen upon opening the app looks as follows:
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You must enter:
1. The correct URL for your mSupply server, usually using SSL/HTTPS protocol for security.
2. Sync site name as defined above in this guide.
3. Password for the sync site name
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Once you have entered the information, click “Connect” to start sync:

Initialisation can take between 1 and 15 minutes, depending on the number of records on the server related to the site being synced. Once the server
has found all the records to sync, mSupply Mobile will start pulling them 20 records at a time.
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Limiting Initial Sync Record Count
If the amount of records to sync are greater than around 50,000 it may take over an hour to sync on a good connection. Many hours on a slow
connection. For this reason it is possible in mSupply to limit the amount of records up to a specified amount of months ago.
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1. You need to change the store synchronisation type from “collector” to “active” or “none” to unlock adding custom data
2. Add a custom data row with “Field label” `syncMonths` and the numeric value desired in “Field value”
3. Change the store synchronisation type back to collector
Now when you do initial sync, the store will only get transactions and stock takes for as far back as specified from the current date.
Previous: mSupply mobile 2.0 user guide Next: mSupply Introduction
2017/10/26 01:26

·

Introduction
Thank you for choosing mSupply.
Before you launch in (if you haven't already!), we suggest you plan to take the following steps.
• Read the rest of this introduction.
• Read the setup, tutorial and license chapters in this manual.
Please note that installation requires basic computer skills:
• You need to be able to locate a file using the “open” and “save” windows.
• If you are not sure, why not try, and email us if you get stuck.
mSupply is designed to handle the following tasks:
•
•
•
•
•
•
•

Recording quotations received from various suppliers in a way that makes for easy comparison of true cost prices.
Create tenders for suppliers to respond to.
Ordering (Purchasing) of items from a particular supplier, using actual usage figures to calculate the required quantities.
Entering of incoming goods into inventory.
Manufacturing items. That is, building new items from raw materials in your stock.
Tracking Accounts Payable and Accounts Receivable
Issuing of invoices for customers, and recording the transaction against inventory.
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•
•
•
•

Customers are able to order on-line via the internet, and can view stock status and the status of their orders.
Exporting purchase and invoice data for import into an accounting program.
Reporting on transactions and other data in almost any manner you want!
If you need help with installing mSupply please feel free to email us at info@msupply.org.nz (mailto:info@msupply.org.nz)

About this user guide
The latest and most authoritative version of this User Guide is located on-line at http://docs.msupply.org.nz/ (http://docs.msupply.org.nz/). You can
export the chapter you're viewing in PDF format by clicking the export:pdf tab to the right. It may then be viewed off-line within Acrobat Reader or
other PDF viewer. To obtain the whole user guide in PDF format, visit http://www.msupply.org.nz/download (http://www.msupply.org.nz/download)
If you are reading a PDF version, it is likely that a more up-to-date version is available on-line.

The software is under constant development as new features and facilities are added. We strive to ensure that the user guide and the graphics
that it contains reflect these developments, but occasionally you may find that there are differences between the program itself and the guide or
its graphics, where the updating of the guide has not quite kept pace with the development of the software. These are usually of a minor nature,
but should you have any difficulties, do please send us an e-mail with details of your problem.
It should also be noted that with the considerable range of preferences and user permissions, a particular user's window may have features
included or omitted (according to their preferences and their permissions) when compared with the screenshots appearing in the guide.

As mSupply is compatible with both Windows OS and Apple Mac OS, there is a mix of screenshots in the manual taken from each operating system.

About us
Sustainable Solutions was established in 2001 with the primary aim of supplying and supporting mSupply software in developing countries. We are
committed to producing software that enables excellence in health care delivery. We take pride in looking after people who choose to use our services.
We are based in Kathmandu, Nepal
We can be contacted at:
•
•
•
•
•

email:info@msuppy.org.nz (mailto:info@msuppy.org.nz)
or info@sussol.net (mailto:info@sussol.net)
phone: +977 1 5548021,
fax: +1 (815)572-9431
post:
◦ PO Box 8975, EPC 355,
◦ Kathmandu,
◦ Nepal

Please feel free to request more information.

Thanks
Juliet has always been encouraging and more, and has put up with me thinking about mSupply when I shouldn't have been.
This software grew out of necessity at the Medical Supply Department, Kathmandu, Nepal. We learnt a lot from Jaap Zijp's software “Bhandari”, and
from the staff at MSD where mSupply was originally developed and tested.
Ujwal Khatry has stuck with Sustainable Solutions for ten years, including the startup period where our company name could well have been a
misnomer.
Jim Staples of 4D inc. http://www.4D.com (http://www.4D.com) kindly arranged an initial donation of the superb development environment we use.
Thanks to those people in the 4D tech mailing list who have helped for no benefit to themselves.
John Ross, Pharmacist of Patan Hospital, Kathmandu, believed in the quality of mSupply enough to use it long before it was fully ready.
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David Adams kindly donated his superb texts on 4D.
The moderators of the E-Drug mailing list have been gracious in letting us use that list for occasional announcements.

Copyright
mSupply software is copyright Sustainable Solutions, 2006, UMN/INF/Interserve 1996 to 1999. You may only use the software in accordance with the
accompanying licence agreement.

Licence Agreement and Costs
Commercial users or any user wanting multi-user functionality enabled must obtain a licence from Sustainable Solutions.
Please view our web site http://www.msupply.org.nz (http://www.msupply.org.nz) for up-to-date pricing.
A free version of mSupply is available for Non-commercial use
• You may use mSupply software in single user mode for free as long as it is used:
◦ in an approved not-for-profit organisation
◦ in a developing country.
• Sustainable Solutions shall be the sole arbiter of those qualifying for free use.
• All users (free and paid) must register with Sustainable Solutions to obtain a registration code. Information supplied will not be used for
any purpose other than generation of registration code.
• Users who have obtained a free licence number are not eligible for free support.
Please contact us for quotes regarding customised versions and installation and training packages.

Changes in recent versions
The mSupply version history is available here (http://msupply.org.nz/history)

Conventions used in this user guide
If you aren't familiar with using a computer, you should read this chapter, and also work through the tutorial.
Menus: Choose New item… from the Item menu (sometime also written as Choose Items > New item… means … Click on the word Item in the menu
bar, then choose New item… from the menu that drops down.
Keyboard keys: A handful of keys on the keyboard are used extensively and are indicated in italics font. The most common are: Tab, Shift, Ctrl, Alt,
Enter and Backspace.
Field: An area where you can make an entry, either text or numbers - usually a white coloured box. In many places a user can hover over an input field
for a description of what is required.
Typed data: Anything that must be typed into a field is shown in monospace font. For example: Type 100 and press Enter.
Check box: is a box that changes from having an “X” in it to being blank each time you click in it. To “check” a check box means to click it so that an
“X” appears (if there is not one already present). Check boxes have text beside them explaining what the box is for.
Tab & Shift: You can generally move the “focus” (the active area) from field to field in a window by using the Tab key. Holding down the Shift key
while pressing the Tab key will move the focus from field to field in the reverse order to normal. Note that on Windows, some buttons are “tabable”that is, pressing the Tab key moves the “focus” to a button. Pressing the Return or Enter key then activates that button.
Highlight button: Pressing the Enter key will operate the highlighted button in a window, which is usually the OK button.
Double-click: In lists (e.g. of Names or of Items), double click the left mouse button on a line to edit or view more details.
Insertion point: is the blinking line in a field that indicates which field is currently accepting typed input.
OK button: The OK button can be operated by pressing the Enter key.
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Cancel button: The cancel button can be operated by holding down Ctrl key (cmd on Macs), and pressing the period key (full stop).
Path to a file (or document): is a way of describing where a document is stored on your hard disk. It is written as “hard disk:folder 1: folder
2:document”, which is the same as “C:\folder 1\folder 2\document”.
Modifier keys: Windows and Macs have different modifier keys. We've tried to list both in the manual, but sometimes one might slip through, so
• The Windows Ctrl key does the same as the cmd (command) key on Macs
• The Windows Alt key does the same as the opt (option) key on Macs.
Column headings: Column headings can be clicked to sort the list by that column.
Stock: Also called “inventory”- an entry in mSupply that represents physical stock (inventory) in your store.
Item: An “ item ” in mSupply is a particular product. An item may or may not have stock lines at any given time. For example: In the example data
file provided with mSupply, “Amoxycillin 250mg tab/cap” is an item. When you first start to use the example data file it has 2 stock lines. (You can
view them under the “stock” tab of the Item details window (more on that later!).
Item lines (or “stock lines”) represent different batches of the same item in your store.
Negative values: In general, there is no need to enter negative values in mSupply. Even when you are entering returned goods from customers, or
returned goods to suppliers, you must enter positive values. mSupply automatically converts the invoice total to a negative amount when it is a credit
to a supplier or from a customer.
Supplier invoice: A supplier invoice is the same as a “bill” or a “purchase”
Build: A transaction that records the manufacturing of an item by turning raw materials into a finished product - refer Building (Manufacturing)
Items.

Setting up mSupply
Hardware requirements:
Windows
Hardware requirements vary widely depending on what you want to use mSupply for
Here's a rough guide.
Absolute minimum

Windows 7,XP, Vista or Windows 2000 computer with a 500 Mhz Pentium processor or equivalent.

Suggested single user or
Client machine for use
with server.

Win 2000 or later, 800 Mhz or faster Pentium processor or equivalent, 256Mb RAM

Suggested server

Win 2003 or XP or Win 7 or later, 1.8Ghz Core 2 duo or equivalent, minimum of 1Gb RAM. 4Hard disks. 3
configured as RAID5, Attached to Uninterruptible Power Supply (UPS) unit with software to shut down server if
battery power is about to run out.

Macintosh
• Mac OS X 10.5 or later.
• 50Mb hard disk space.

Backup system
Once you start using mSupply, it is of crucial importance that you have a method of backing up your data. mSupply stores all its data in a file that
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rapidly becomes large. You need, therefore, to have a high capacity removable storage device. We strongly recommend the use of an external hard disk
using either firewire (IEEE 1394) or USB2 to facilitate off-site storage of backups.
• See the section in Preferences that covers mSupply's built-in backup features that allow backup to another disk, and to an internet backup
site… you'll find it here: backup
• If not using our internet backup service, you need to be able to store backed up data off-site to prevent the risk of loss by fire, theft, etc.

Sustainable Solutions will not be able to help you recover lost data in the event of hardware failure if no backup is available.

Antivirus
Windows based operating systems are particularly prone to malware if precautions are not taken. We recommend the following precautions:
• Install a reputable anti-virus program, including web protection if the computer has access to the internet. We recommend F-Prot
(http://www.f-prot.com/).
• Disable USB ports - refer to this site (http://www.thewindowsclub.com/disable-enable-usb-windowunlock-pen-drive-at-office-or-schoolcomputer) for suggested methods.
Ensure that access to passwords to allow exceptions to the above two measures are kept secure.

Hardware recommendations:
• A connected printer is not absolutely necessary in every situation, but for most situations it is a requirement. A dot-matrix printer may be
used, but an ink-jet or laser is preferable.
• Buy hardware for which you are able to obtain good support.
• Buy brands with a reputation for quality (even if it means buying a slower/older machine).
• We have clients running mSupply on a wide range of hardware. We are happy to discuss hardware options further via email or phone.

Upgrading from previous versions
If you open a data file that was created with a previous version, it will automatically be updated to the new format. Please note that this process may
take some time.
Note that if you are using a version earlier than v1.96 you must upgrade to v1.96 and then to version 2 or 3.

IMPORTANT! Always make a backup of your data file before upgrading, and
preferably keep a copy off-site. We will not be able to help you in the event of
some unexpected disaster if you haven't followed this advice!

Installation
We are assuming you have obtained mSupply via the Internet or on a CD.
If you have downloaded the file you need, and you have saved it to your desktop, it is important that you saved the file with an “.exe” extension or it
will not run (You can rename a file by right-clicking on it). The default name for the file is “mSupply_installer.exe”
If you are using the CD, it should automatically run when inserted. Otherwise, locate the file “mSupply…..exe” on the CD using Windows Explorer.
It is strongly recommended that users who are not familiar with program installation adhere to these directions.
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• Double-click “mSupply_installer.exe”, and it will automatically run the mSupply installer.
• The installer will do the following:
◦ Create a folder on your chosen drive called “mSupply”
◦ In Windows XP & 2000, create in the mSupply folder a sub folder called “Database” containing an example data file.
◦ In Windows Vista and Windows 7, the example data file is installed in the My Documents/mSupply/Example sub folder.
▪ NOTE: You can use this data file for practice. (Or use the tutorial at the start of the manual to learn the basics
quickly)
◦ Install the “mSupply.exe” application and associated files. Double-clicking this file will do the same as double-clicking the
“start mSupply” icon on your desktop.
◦ Install “readme.txt” - information on licensing and using mSupply.
◦ Install “mSupply manual….pdf” - this document (CD version only).
◦ Create two shortcuts on your desktop: “ start mSupply” and “ mSupply manual” (CD version only)
◦ Create a “mSupply folder” entry in the “programs” section of your “start” menu.
Now you are ready to begin! Proceed to the section below on starting the example database.

Example data file
The mSupply installer treats Example data files in a special way. Re-installing mSupply on a previous installation will replace all the files except the
Example data file. This is to prevent valuable data from being deleted as users may have started entering actual stock into the Example data file.
To install a fresh copy of the Example data file on Windows you can carry out one of the options described below:
• Un-install mSupply using the Windows menu Start > Program Files > mSupply > Uninstall mSupply . This will remove all installed files
of mSupply which includes the Example data files. Re-installing mSupply now will install a fresh copy of the Example data file.
• You can manually delete the Example data file and re-install mSupply. The mSupply installer will install a fresh copy of the example
database as the previously installed file has been deleted.
On Macintosh machines, simply replace the Example folder from the mSupply installer image.

Notes for Windows users
• In the regional settings in Control Panel, we recommend that the short date format is set to display only 2 digits for the year (YY, not
YYYY).mSupply lists are set up to allow only enough space for 4 digits with most font sizes, but occasionally 4 digit years may be
truncated. Having the wrong setting here will only affect display, not the actual data. It does not matter if you use DD/MM/YY or MM/DD/
YY or YY/MM/DD
• If the display of lists in mSupply overlaps the separator lines, turn off large font in the display control panel.

Starting mSupply for the first time
To start mSupply, either
• double-click the start mSupply icon on your desktop, or
• choose the start mSupply item from the mSupply menu in the programs section of the Start menu (on Windows). If this is the first time
mSupply has been started after installation, then an example data file will be opened allowing you to follow the mSupply tutorial. mSupply
will present you with a log in window.
Note that mSupply will “remember” the last data file used, and automatically present the log-in window for that file unless you move or rename your
data file. If you do this, mSupply will show you a standard open/save window for you to choose the new name/location of your data.

Creating a new data file
If you would like to create a new data file now, then log in to the example data file and from the mSupply menu do the following.
• File > New Data File… Navigate to a convenient location. Assign a name to your data file and click the save button. mSupply will now
start creating a new data file.
• You will be presented with a login window. See below for instructions
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• Start entering your data.

Alternative method for creating a new date file
Here is an another way to create a new data file.
• Quit mSupply if it is running.
• Start mSupply and then immediately hold down the “alt” key (You will now be shown the following which has a number of radio buttons
with the different options available.

• Choose the 3rd radio button Create a new data file . Another window will open where you can choose the location and name of your new
data.
Once mSupply has opened up a particular data file, that file becomes the default file which is opened automatically on restarting mSupply. To use a
different file, it must be chosen, as described later. If the default data file is renamed or moved to a different location, it must be opened using its new
name or location.
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Log-in to mSupply
The first time you use mSupply, you will be presented with the log-in window like this:
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mSupply® ships with three users. “user 1” and “user 2” are the designer and administrator - these two users cannot be deleted, but they
can be edited, allowing the use of appropriate names and making changes to their passwords and permissions.

1. You should select user 1(pass=user1) from the list
2. Enter the password “user1” (without the quotes). When different users with their own level of access have been set up, you will then log-in
by selecting your user name and typing your own password.
3. From the drop down list, select the store with which you are working. Most mSupply users will be operating with a single store, but for
users operating with more than one store, the login screen allows you to select any of the stores to which you have access. After selecting
the desired store, all transactions will relate to that store until you return to the login screen and select a different store from the drop down
menu.
◦ Supervisors and other Level 1 users will have an additional menu item, Supervisor - All stores . In this mode, all stores are
accessible, and you would use this mode, for instance, when placing an order for supplies which will be distributed to a number
of stores. Further information is available here: Show stores
4. Choose login mode …., you have the option to select Store mode or Dispensary mode ; the default can be set in your Preferences
Finally, click OK to login

Preparing mSupply for actual use
The following 2 steps are necessary to start mSupply for the first time.
• Create a new data file
• Prepare the new data file for use

Create a new data file
In order to create a new data file, see above creating_a_new_data_file
Save the data file in a location that you can easily find for doing backups. We suggest you create a folder called “mSupply data” inside the My
Documents on Windows PC or the documents folder on a MAC to store your data file.

Prepare the new data file for use
1. Choose your home currency. Currencies are used when you are calculating cost prices for orders, and when you are comparing quotations
from suppliers. Choose Special > Currencies. If your currency is not already shown, click the New button at the top of the window and
choose from the pick-list the three letter code abbreviation of the currency you will use to operate your database (e.g. “INR” for Indian
Rupees, or “SAR” for South African Rands, or “USD” for US dollars). Set the “Rate” to “1”.
2. Enter your Preferences. Choose File>Preferences to do this. Read the chapter of the manual on Preferences to learn what the different
Preference settings do. You will find the Preferences section here
3. Enter your Suppliers and Customers.
4. If you have a computer file holding your customer and/or supplier details, it can be imported directly into mSupply. See
importing_customers_suppliers_patients.
5. You can also do this as you go along simply by entering a customer or supplier the first time you create an invoice or order from them.
6. Enter the items you keep in stock. There are a number of ways you can do this:
◦ If you have a computer file holding details of the items you stock, it can be imported directly into mSupply. For more
information see import_items
◦ A file containing the WHO essential drug list is available from the download page of the mSupply web site. You are encouraged
to use this file should you have no computer file of your own.
◦ You can enter each item using the New item Command from the item menu.
◦ Enter your stock figures.
◦ If you have a computer file holding both details of the items you stock and your current stock figures, it can be imported directly
into mSupply. See: import_items_and_stock
◦ Your opening stock may be entered manually; choose Item>Inventory adjust - add stock , and enter the required details.
◦ If you intend to record the location of each item, you should define the locations that your store contains. See Locations Defining locations.
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About Stores
At the log in window you have the option to log into a specific store or to log in as 'Supervisor' by choosing option 3 shown in the below window.

Unless you intend to use multiple virtual stores in mSupply you can ignore this option. More information will be found here: virtual_stores

About Dispensary Mode.
mSupply allows you to log in in two different modes, Store mode or Dispensary mode . Each user can have his/her permissions set to allow or disallow
each mode.
Each mode presents the user with a different menu bar and different windows, depending on whether you are issuing stock to an organisation or an
individual
See Dispensary Mode.
Previous: Mobile (Android) User Guide Next: Logging in
2011/05/18 10:38

Logging in
When mSupply starts you will be presented with the log-in window:
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This is the way the window appears when mSupply is started for the first time

1. You should select your user name from the list. If you're just opening mSupply for the first time after installing it, select user
1(pass=user1). If the list is long you can type the first few characters of your user name in the Search users field to shorten the list tio
usernames that begin with what you have typed. On subsequent logins mSupply will default to the last logged in user.
2. Enter your password. The password for the user 1(pass=user1) user is “user1” (without the quotes - the hint is in the user name!).
3. From the drop down list, select the store which you want to login to. Most mSupply users will be operating with a single store, but for users
operating with more than one store, the login screen allows you to select any of the stores to which you have access. If you have been
working with one store and want to change to another one see Switching stores. After selecting the desired store, all transactions will relate
to that store until you return to the login screen and select a different store from the drop down menu.
◦ Supervisors and other Level 1 users will have an additional menu item, Supervisor - All stores. In this mode, all stores are
accessible and you would use this mode, for instance, when placing an order for supplies which will be distributed to a number
of stores or for reporting over more than one store. Further information is available here: Virtual stores.
◦ If you have enabled the Hospital Info System (HIS) in the user login permission settings (see foreign_keys), and at least one
license is allocated to HIS (see HIS preferences), then you will also see Hospital Info System in the list of stores. If you select
this, the login mode automatically changes to HIS mode.
4. View any messages that might be displayed
5. Finally, click OK to login. If login is successful you will be taken to the navigator.

There are various options that can be set that cause a successfully logged-in user to be taken to other
screens or shown other information. For example, Reminders or Invoices preferences.

Previous: Introduction Next: Tutorial
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2011/05/18 10:38

The tutorial like no other
If some of the terms used below are not clear, please see Conventions used in this user guide.
Only mSupply®'s basic features are covered in the Tutorial; its many enhanced features are covered in depth in appropriate chapters in the User
Guide.

mSupply Explained
This chart shows the common steps in most pharmaceutical supply processes. (Of course, the manufacturing step only applies to manufacturers!)
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mSupply work flow diagram

The two most common transaction types in mSupply® are the supplier invoice (si) and the customer invoice (ci) . These transactions record stock
purchases from suppliers, and stock supplies to customers. mSupply® records a full audit trail by only allowing stock adjustments by way of a
transaction. Therefore, given an opening balance of stock for the year, mSupply® can show a series of transactions that result in the recorded closing
stock.
Of course, there is much more to it than that, but these two transactions are the core of the system.
Note that mSupply® has dozens of preference settings (File>Preferences) which change the behaviour of many aspects of the software. If you have
customised Preferences from their default settings, some aspects of this tutorial may not be as stated below. To work through the tutorial, we
recommend you start with a fresh copy of the example data to ensure the Preferences are set correctly.
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Before starting the tutorial, you will need to have installed mSupply®, and opened the example database. If you haven't done so, see installation

mSupply® runs best with a screen resolution of 1024 or 768 or greater. If you have your screen set to 950 x 850 or lower, some
windows will not fit on the screen. To change screen resolution:
• Windows: Right click anywhere on the desktop, select Properties > Settings , and make the necessary changes.
• Macintosh: Choose Apple > System Preferences… then click on the Displays icon and set a new resolution

Opening the example data file
You will have two icons on your desktop - double-click the mSupply icon.
If you are opening mSupply® for the first time, the program should automatically open the example data file.
The full path to the data file is displayed, along with other useful statistical information by clicking on Menu >Help>About mSupply:

If you have already been using mSupply® and have another data file open, but would like to open the example data file for use with this tutorial, then
you can use the mSupply® menu File > Open data file… to open the example data file. In Windows, by default the example data folder is stored
inside c:/mSupply/database/; navigate to the location and open the data file.
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If you have chosen a different location from the one suggested by the installer, the example folder will be in your chosen
location.

A password entry window is presented as mSupply® opens up a data file. The message panel informs the user that the example data base is in use.

The “User 1” (pass= “user1”) entry should be highlighted, but if it is not, it should be selected. Enter “user1” (without the quotes) at 2.Enter your
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password.
The Choose store …. . drop-down list will display General, and the Choose login mode … drop-down list will display Store - these should not be
changed. Click the OK button. After you have logged on, the Navigator screen appears:

The Navigator
Overview
The mSupply® Navigator provides access to most of the functions you will be using regularly in mSupply®. You will learn that many of these
functions may also be opened with shortcut key sequences from the various Menu items, and once you have gained some experience, you may find it
quicker to use the shortcuts.

The Navigator always opens at the Customers screen in Store mode, shown above, or the Patients screen in Dispensary mode,
shown below:
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Displayed along the top of the screen are four items of information:
•
•
•
•

the mode selected at logon (store or dispensary),
the store in which you are working - for most users, “General”,
the active data file,
the user currently logged on.

Immediately below this, there are six large icons, Customers or Patients, Suppliers ……. Admin .“ Click on the icon appropriate to the task you are
performing, and you will be presented with a panel displaying annotated icons listing the available functions and procedures; these are in turn selected
either by clicking on the icon of your choice with the mouse, or by advancing through the icons with the right or left arrow keys and pressing the
Enter key. You will be using the Items panel of the Navigator in the next step in the tutorial, and as the same procedures are common to all panels,
you will quickly become familiar with them.
The bottom right area of the Navigator screen is available for displaying your own logo - the logo of “Acme Medical Supplies” is displayed in our
example. The placing of your logo is performed by choosing File > Preferences > Logo. You can also read how to do it here.

Creating and viewing items
Creating a new item
For this section of the tutorial, we are going to add two new items to our mSupply® database. From the Navigator's opening screen, click on Item, the
3rd of the large icons near the top of the screen

92

mSupply user guide July 2018

and the following screen appears:

• Click on the New item icon
• You are presented with a window with a number of fields to enter:
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Below is a list of fields and the text to be entered into each field. Use the Tab key to advance from field to field or, using the mouse, click on the field
you want to edit.
Type: The default entry normal is shown in the drop-down list, and should not be changed.
Item code: Enter amo500c then press the Tab key to advance to the next field.
Item name: Enter Amoxycillin 500mg tab/cap then press the Tab key to advance to the next field

Continue to use the Tab key for the rest of the tutorial when you need to advance to the next field.

Units: “None” is displayed by default. The options are: unit, ea (for each), gm and ml.
Price list: Click in the box so a check appears in it. This means that when we export a price list, the price for this item will be included.
Shelf location: Enter a3. Amoxycillin is stored on shelf 3 in the “a” section of our imaginary store. Note that “A” is interpreted differently from “a”,
so it is recommended to be consistent and use either all upper case or all lower case letters for entering shelf locations.
Preferred pack size: Enter 100. This means we want a 100 unit pack to be our standard for comparing prices of this item.
Category: If a list of categories has been defined, this field allows the item which is being added to be placed in its appropriate category.
Normal stock, Critical stock, Essential drug, ATC category, DDD value, DDD factor, Weight, Non stock item, Default customer: For this
tutorial, ignore these fields and leave them blank.
Click the OK & Next button to add this item to mSupply®. The window's fields will clear allowing you to add a further item.

If you have no more items to add, click the OK button to add only the item just added and exit. If you accidentally click OK &
Next and then want to exit, just click the Cancel button. The Amoxycillin 500mg tab/cap would still be entered, as it was saved
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when you pressed the OK & Next button.

Proceed to add a further item with the following details:
Note that if you make a mistake, you can click in a field and edit the value.
Field

Enter….

Item code

“amo125s”

Item name

“Amoxycillin 125mg/5ml syrup”

Units

“mL”

Price list

check the check box.

Shelf location

enter “a7”.

Preferred pack size

enter “60”.

Click OK now that you have added the item, then click Cancel to exit the window.
Congratulations! You have now added 2 items to our example data file. Let's go and see how to find them.

Viewing item details
Click on Show items from the Navigator's Item screen.

95

mSupply user guide July 2018

You will be presented with a window to find items:

• Type “a” into the text entry area, then click the Find button.
• A list of all the items whose name or code starts with “a” is shown.
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• We will choose the Amoxycillin 250mg tabs/caps - an item that was already in the example data file. To choose the item, double-click
anywhere on its line in the window.
• You will now be presented with a window that displays a lot of information about “Amoxycillin 250mg tab/caps”. From this window you
can see stock on hand, view and edit supplier quotations, view usage for this item for the last 24 months, view backorders, view, add and
edit notes for this item. Phew!
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• At this stage, we only want to know how to view the information. For an explanation of all the information displayed see item_edit__general_options
• When you have finished viewing the information, click the OK button to return to the list of items.
• If you want to view a different item, you can double-click its line. Otherwise click the X button in the top right corner (on Windows) or the
top left corner (on a Mac) to exit to the Navigator.

Customers, Suppliers, and Contacts
Adding a Customer or Supplier
For this tutorial example, we will first add a new supplier, then add a new customer.

Adding a Supplier
From the Navigator's opening screen, click on the 2nd of the large icons, Suppliers tab, then on the New Supplier
You will be shown this window to enter the details:
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You can now enter the details for your new Supplier.
Field

What to do….

Code

Enter “Acmep” to identify the Supplier (Acme Pharmaceuticals).
You need to choose a unique code for each name.
Try to choose a logical system, as the code is used to look up the Supplier (or Customer) when you are
entering invoice data.
(for example, try to start the code with at least the first three letters of the Supplier name)

Charge to

Enter “Acmep” again. This field is only used when exporting data to an
accounting program - this code must match the code
you use for the supplier in your accounting program.

Name

Enter “Acme Pharmaceuticals” - the name of our supplier.

Master ID

Ignore for now

Category
Customer check box

Leave this box unchecked, as we are entering a new Supplier.

Supplier check box

As you chose “new supplier” this box is already checked.

Manufacturer

Leave unchecked
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Field

What to do….

Benchmark

Leave unchecked

Contact
Email, Web site etc.

Fill in with the appropriate details

Status
Hold checkbox

If this box is checked for supplier or customer, that particular supplier or customer can neither supply
nor be supplied with items.

Preferred checkbox

Leave unchecked

Price Category

This applies to customers. It is possible to assign multiple sell prices to customers. Leave it set to “A”.

Supplier details

Currency

The field is automatically filled in with “Nrs”
(=Nepali rupees - the default currency in our example data).
This is the currency that this supplier will use to bill us.

Margin

Enter “10”. Items purchased from this supplier will have a 10%
margin added to calculate the selling price.

Freight factor

Enter “1”. Acme Pharmaceuticals does not charge any freight to us.
Their prices are “CIF”(Cost, Insurance & Freight to named port). This field is only used for comparing
quotations from suppliers
- it is not used for actual invoices.

Other
Category 1-6

Ignore for now

Custom 1-3

Ignore for now

Flag

Ignore for now

Comment

You can enter a brief note here (Ignore it for now)

Print invoices

Ignore for now

Address
Address, Main & Postal address.

You can complete these with appropriate values.

If you are satisfied with the details, click OK . You will be returned to the mSupply® startup screen.

Adding a Customer
From the Navigator's opening screen, click on the 1st of the large icons, Customers, near the top of the screen, and then click on “New Customer”
from the Navigator screen that appears. You will be presented with a window similar to the New Supplier one above to enter the details:
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Fill in the fields as follows:
Field

What to do

Code

Enter “bluec”

Charge to

Enter “bluec”

Name

Enter “Blue Cross Hospital” - the name of our customer.

Master ID

Ignore for now

Category
Customer check box

As you chose “new customer” this box is already checked.

Supplier check box

Leave this box unchecked, as we are not entering a new Supplier.

Manufacturer, Benchmark check
boxes

Leave these unchecked too

Status
Hold checkbox

If this box is checked for supplier or customer,
that particular supplier or customer can neither supply nor be supplied with items.

Price Category

This applies to customers. It is possible to assign multiple sell prices to customers. Leave it set to “A”.

Contact
email, web site, etc.

You can complete these with appropriate values.

Other
Category 1-6

Ignore for now

Custom 1-3

Ignore for now

Flag

Ignore for now

Comment

You can enter a brief note here (Ignore it for now)

Print invoices

Ignore for now

Addresses
Address, Main, Postal and Shipping
address.

You can complete these with appropriate values.

Click the OK button to save the details and exit the window.
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Editing a Customer or Supplier
Let's now look up “Acme Pharmaceuticals”
• Choose Show suppliers … from the Navigator's Supplier screen. You are presented with a window to enter as much of the Supplier name or
the code as you know.

For this tutorial, just click the Find button - you will get a full list of all suppliers.

For information on the Normal - Fuzzy slider, see editing_a_customer_supplier_or_manufacturer
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• Double-click the “Acme Pharmaceuticals” entry in the list. You will be shown a window the same as you used to enter “Acme
Pharmaceuticals” as a new supplier.
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• Note the window has “Tabs” down the left side in the sidebar: “General”,”Invoices“, “Backorders”, “Quotes” and “Notes”, etc. Let's add a
note for Acme pharmaceuticals:
• Click on the “Notes” tab.

• Click on the New Note button. Today's date is entered automatically and highlighted. Click inside the Note Entry field.
• Enter “This is a test note” then click the OK button.
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• The first line of your note text will appear in the list of notes.
• Click OK to exit viewing/editing the supplier, then click OK again to exit the list of suppliers.

Viewing location in Google maps
If the precise geographical location of the supplier or customer is known, the Lat and Long fields can be completed in the Photo tab. Entries are made
in these fields thus:
• decimal degrees, and not degrees, minutes and seconds
• in the Lat field, locations south of the Equator are entered as negative - i.e. the number is preceded by a '-' sign
• in the Long field, locations west of the Prime meridian are entered as negative - i.e. the number is preceded by a '-' sign

Don't know a precise location? Using Google Maps find the desired location and place the cursor on it. Right click and select
What's here from the drop down list. The geographical co-ordinates are displayed at the top of the screen. These should be
noted and copied to the appropriate Lat and Long fields in mSupply®

In our example, the location of the imaginary Acme Pharmaceuticals is on Chetrapati in Kathmandu. Click on the Google Maps button to display a
map of the vicinity, with the precise location pinpointed by a green arrow.
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Enter incoming goods (a supplier invoice)
In some countries an invoice for incoming goods is referred to as a “bill”- we use “supplier invoice” to mean the same thing.
Let's suppose we have just received a shipment containing two items from Acme Pharmaceuticals, and we want to enter these goods into stock. The
invoice looks like this:
From: Acme PharmaceuticalsBill no.:A939
Item

Quan

Pack

Batch

Expiry

Price

Amoxycillin Caps 250mg

1000

100

b93333

31/12/2015

344

344,000.00

Cotrimoxazole 240mg/5mL susp

65

60

bb23d

31/10/2015

21

1,365.00

Cotrimoxazole 240mg/5mL susp

100

60

bb22d

31/01/2016

21

2,100.00

Total:

Extension

347,465.00

Choose Supplier > New invoice from the menu or navigator.
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The cursor will be positioned in the Name field. Type “a” and then press the tab key. If there is only one supplier whose name starts with “a”, the
details will automatically be filled in.

In our case the supplier “Arbuckle distribution” was already present, so you are presented with a window listing the suppliers starting with “a”.
Double-click the line containing “Acme Pharmaceuticals” to choose them for this invoice. The insertion point will jump to the Their ref. field.
Type “A939” into the Their ref. field. Press the Tab key to advance to the Comment field.
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In the Comment field you can type a comment or information to identify the invoice.
Note that the margin is showing as 10 percent (the percentage that will be added to your cost price to obtain the selling price).
Click the New line button to add the first invoice line. You will be presented with the window for adding invoice lines.

• The cursor will be positioned in the Item field. Type “a”, then press the Tab key. You will be presented with a window listing all items
whose name starts with “a”. Double-click the “Amoxycillin 250mg tab/cap” entry to choose it. The cursor will now be positioned in the
“Quantity” field.
• Enter the number of packs received in the Quantity field: “1000” (Note that this is the number of packs, not the total quantity of capsules).
Press Tab to advance to the next field.
• Enter the pack size: “100.” Press Tab to advance to the next field.
• The cursor will now be in the location field. Ignore this for now and press Tab again.
• You can also ignore the Volume per pack field and press Tab to keep going.
• Enter the batch number: “b93333.” Press Tab to advance to the next field.
• Enter the expiry date: “31/12/2014” (Presuming you have dates set up to enter as dd/mm/yy. If your dates are set to the USA's mm/dd/yy
format, enter “12/31/14”). You only have to enter 2 digits for the year, as long as the year is in the range 1961 to 2060. Dates outside this
range must have the year entered as four digits. Press Tab to advance to the next field.
• In the “Invoice line cost” field enter the pack cost price: “344”
• The table shown in the picture at the bottom appears if you have Show previous purchases checked in your preferences. It will show
purchases you have made of this item in the past.
• Donor is the donor who provided funds for the goods on this invoice. You can create donors by activating donor tracking in File/
Preferences/Suppliers/New Supplier and then check the donor check box.
As we have another line to add, click the OK and Next button. The entry is recorded, and the window is now blank to accept your second invoice line.
• Enter “c” into the item name field and press tab. In the list of items showing, you will find “Cotrimoxazole 240mg/5mL susp”. Doubleclick the entry.
• Enter the remaining invoice details for “Cotrimoxazole 240mg/5mL susp”:
• num units: “65”
• pack size: “60” (Note that it is better to record the actual volume of most packs, unless the volume is not important- for example with an
eye-drop, where you could record the pack as “1”)
• batch: “bb23d”
• expiry: “31/12/2013”
• price: “21.00” (You can just enter “21”)
Click the OK & Next button to save the details and start to enter another item.
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Now enter the third item on the supplier invoice from the example invoice from Acme Pharmaceuticals example invoice above.
When you have finished, click the OK button to take you back to the main list of invoices.
Our invoice will now have 3 items added to it. The invoice total should read “347,465”, and should appear like this:

If you have made a mistake, click on the relevant line , which will now be highlighted; double-clicking on it allows you to edit it. You will be shown
the line details again, and you can then make corrections and click the OK button to save your changes. There are 3 icons in the lower left corner of
the invoice window.
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1. This allows you to rearrange the order in which the lines are shown on the invoice
2. Here you can make a note of anything relevant to this invoice
3. This will copy the details of the invoice to the clipboard
Now click the OK button. As long as you have left the “print” check box (bottom right corner) checked, you will be asked if you want to print the
invoice (you may do so). Note that when you print, you are shown two windows. The first window is the page setup for your printer, the second
window allows you to specify how many copies to print, etc. (The second window also has “preview” check box, where you can preview the print
job).

As this invoice is a “supplier invoice” it has been “confirmed” when you clicked the OK button in the invoice entry window. You can view and edit
the invoice details until the invoice is finalised. Note that if you issue some of the stock you have just entered to a customer, some fields relating to
that stock will no longer be edit-able.
NOTE - As of mSupply® v190, a more precise alternative for entering received goods has been implemented. See Viewing and editing supplier
invoices created via Goods Receipts

Enter outgoing goods (a customer invoice)
Now let's suppose we have just received an order as follows:
From:

Blue Cross Hospital

Order number:

PO882
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Delivery: Express courier please
Item

Quan

Amoxycillin 250mg tab/caps

10,000

Cotrimoxazole 240mg/5mL susp

120

Choose New Invoice from the Customer menu, and the following window appears:

Type “b” into the Name field, and press the Tab key. You will be presented with a list of customers whose name starts with “b”. Double-click the
“Blue Cross Hospital” entry to select it.
• In the Their ref field enter “PO882”.
• In the Comment field enter “This afternoon by courier”
• Click the New line button to add a line to the invoice. You are presented with the “Add item” window.
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Enter the following details:
• Type “a” into the Name field then press the Tab key. In the list you are presented with, double-click the “Amoxycillin 250mg tab/cap”
entry.

• You will see that a list of available stock has appeared in the window, and the cursor has moved to the Line number field. Enter “2” to
choose line 2. (The list is sorted so batches with the shortest expiry date are at the top - usually you would choose the shortest expiry batch,
but today we're being different!).
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• Quantity field - the line we have chosen has a pack size of “100”, so we need to enter a quantity of “100” to make a total of 10,000
Click the OK & next button to add the second line of the order.
This time enter “c” and press the tab key. Double-click the “Cotrimoxazole 240mg/5mL susp” entry. The window will close and the list of available
batches and quantities will be completed.

Note that in the list of available stock, the second line we entered from “Acme pharmaceuticals” is now at the top of the list - this is because the list is
sorted so that the item with the shortest expiry date comes to the top of the list.
Line 1 is selected, despite the fact that there is insufficient stock of line 1 to meet the order of 120. Nevertheless, you should enter “120” in the
Quantity field, press Tab, and the following message will appear:
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For this tutorial, choose Distribute (which is likely to be your normal choice), and the necessary stock to complete the order will be drawn from
another batch/other batches, starting with the batch which will be the first to expire. There will be occasions, however, when you wish to override this
automatic means of distribution, and in this event you would select Try Again and manually select the batches from which you wish to meet the order.
Click the OK & Next button
Because the invoice has not been confirmed, the “available” amount for the line has been reduced, but the “total stc” (total stock) is still showing as
“100”. mSupply® includes these lines in the list so you can see stock that has been allocated to an invoice but has not yet left your store. You can then
edit the other invoice if stock is urgently needed on the current invoice.
Click OK as we are finished entering lines. You will be returned to the main Customer invoice window.

At the bottom right of the invoice you will see the invoice total.
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• As the customer has requested an express courier, we will charge them Rs200 for the service (Rs = “rupees” the currency in our tutorial).
At the bottom of the window you will see the Other charges field:
• There, enter “Courier charge” and press the Tab key
• In the “amount” field enter “200” and press the Tab key. The new total should be “37,020.00”
Now we are ready to print a packing slip. Make sure that Print is checked in the bottom right corner, and click OK; a window appears displaying your
print options:

We want to print a packing slip, so the default settings suit our purpose. You will notice the packing slip printed has a column where you can write
down the actual quantity packed.

Confirming the invoice:
Let's suppose the order was successfully packed according to the packing slip, and you now want to confirm the order and print an invoice to pack
with the goods. (We're in a hurry - the express courier is on her way!)
First, we need to look up the invoice. Here's an easy way to look up the last invoice you have entered:
• Choose Show invoices.. from the Customer menu.
• If you know the invoice number (printed on the packing slip) you can enter it. To bring a list of the most recent invoices, you enter the
number of invoices to view. As we know the invoice we want is the last one to be entered, we just type “1” and click OK - you will be
taken straight to the invoice.
Click the Confirm truck icon,

and today's date will appear in the Confirm date field. Click OK to confirm you want to proceed.
The invoice is confirmed, and you are given the opportunity to print an invoice.

Entering Quotations
mSupply® allows you to keep a record of prices that suppliers have quoted to you. Let's assume that you have just received 2 quotations for
Amoxycillin 250mg capsules; one of the companies has used US dollars for their quotation, and the other has used British pounds, so before entering
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the details of the quotations, it is necessary that both of these currencies are recognised. To achieve this, choose the menu item Special > Currencies,
and this window appears:

Click on the New button, and a window appears which allows you to enter another currency:

Enter “USD” in the Currency field; in the Rate field you should enter the number of units of the default currency - in this case Nepali Rupees equivalent to 1 US dollar; at the time of compiling this tutorial, the rate was 71.74 N.Rs. to US $1, so “71.74” is entered in the Rate field. Click on the
OK button, and repeat the exercise for British pounds, the rate presently being 116.36.
Once you have performed this, the Currencies window should look like this:

116

mSupply user guide July 2018

We're now ready to proceed.
To enter a quotation:
1.
2.
3.
4.
5.
6.
7.

Choose Items > Show items
Type “Amox” then press Enter.
Double-click the “Amoxycillin 250mg caps” entry from the list.
The item view window, on the left, has vertical content list (General, Usage, Quotes). Click the Quotes line.
Click the “New Quote” button.
Note that the item is entered for us. We need to choose a supplier and enter their price details.
Enter “Arb” in the supplier field and press tab. Arbuckle distribution is automatically chosen. They have quoted in US dollars, so choose
“USD” from the currency menu.
8. Their price is US $3.50 per 100 capsules, so enter “3.5” in the price field and “100” in the pack size field.
9. Click OK to save the entry
10. Now click “new quote” again and enter the following details:

Supplier

Gold Medical Supplies

Currency

Sterling [GBP]

Price

20.00

Pack size

1000

Click OK when you are done.

117

mSupply user guide July 2018

Now we can see the list of quotes, which should look like this:

Notice how the adjusted price takes into account differences in pack size and currency, so you can easily compare suppliers.
Thanks for working through the tutorial. We hope you learnt something useful, and now feel confident to start using mSupply®!

Where to now?
• Use the example database to experiment with different commands as you read about them in the user guide.
• Have a “dummy run” at starting a new data file and using it.
• Return to our main documentation page at www.docs.msupply.org.nz
Previous: Logging in Next: Working with lists
2011/04/13 07:27

·

Working with lists
Whenever you perform a search in mSupply resulting in more than one item being found, you will be presented with a list of records (be they items,
names, contacts or another list) that matches the criteria you entered.
mSupply uses two types of list display. Shorter lists, such as those you see when you view an invoice, or view the stock for an item employ a list with
a striped background. These lists have resizable and moveable columns, and have an indicator to show the sorted column. Their use is discussed in the
next chapter. In this chapter we are concerned with tools for handling lists of names and items and transactions, which run into hundreds of thousands
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or millions of records.
When these lists are displayed, a series of buttons are present along the top of the window, as shown:

Customising the columns viewed: Clicking the Customise button in the toolbar will display this window:
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On the right is a list of columns you are currently using.
On the left is a list of available columns. To add a column to the view, click on the item in the left-hand list, then click the right–pointing button in
between the lists. You can control-click to add multiple columns at the same time.
To remove a column select the column(s) to remove from the right-hand list, and click the left-pointing button to move the columns back to the
available list. You can not remove the first column in chosen list, as it is a hidden key column to identify each row uniquely.
Renaming columns: By clicking twice on a field name in the right hand list you can change the column title.
Column widths: The easiest way to set column widths is to drag the dividers between the columns in the list view..
Note that if the total column width is too wide for the window, a horizontal scroll bar is added to the list allowing you to view columns to the right of
those displayed.
Choosing the column order: To change the sequence of the columns in a list, drag a column header to a new location. This is done when viewing the
Item list window, not in the Customise columns window.
Viewing or editing a particular record: To view or edit a record, double-click the row in the list you wish to view. A new window will open showing
the details of the record you clicked.
Ordering (Sorting) lists: Ordering a list is the same as sorting it. Frequently a column may be ordered by clicking on the column heading. The
column will be sorted in ascending order. Ascending means:
• A > Z (upper and lowercase are not considered different)
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• 1 > 2 > 3 for numbers
• earlier dates to later dates
Descending means the opposite of Ascending .
Note that ordering a list does not add or remove any records from the list. It simply changes the order in which the records are displayed. Should you
require two (or more) sort parameters, clicking the Order by button shows the Order by window:

The Available Fields list will reflect the type of records you are viewing. The list shown is for Items . To order by a particular field, double-click it in
the left-hand list; double-clicking on the “flags” and “item name” fields results in this window:
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(You can also drag fields to the right, or click the right-pointing arrow after highlighting the field on the left)
You can order by multiple fields by adding further fields to the right-hand list.
To change to ascending/descending ordering: Each item in the “Ordered by Fields” list has a small triangle to the right. If pointing up, the ordering
will be ascending. If pointing down, descending.
To change the direction, click on the triangle.
To remove a field: Highlight the field in the right-hand column, then click the red single left-pointing arrow between the two lists. The double leftpointing arrow will clear the “Ordered by Fields” list
Using formulae: If you want to order by a formula, click the Add formula button. Here the formula window is shown, and the formula
“Length([items]code)” has been entered.
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Using this formula would allow you to identify items whose item code is shorter/longer than your organisation's specifications.
Click the OK button to close the window.
Once the details are entered, click the Order by button to order the list.

Printing Lists
You can press the print icon to send the list to Excel. The list will display in Excel with the column headings you have selected.

Finding records
In the item list shown above there is a Find button.
This button shows a simple find window where you can enter the start of the item name or code.

Complex finds: The window shown above has a Complex find button. This allows you to perform a search using multiple criteria. Clicking this button
shows the query editor
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Within this window there are four areas from which you have to choose or set a value for each line of a query.
1.
2.
3.
4.
5.

Available fields,from where you make your selection
Operands, from where you select the one appropriate
Value, where you enter your specific criterion
For queries with more than one criterion, click Add line , .then ….
Click the appropriate conjunction.

For example, if you want to find all items whose default pack size is greater than ten and whose code starts with “A” these are the required steps:
1.
2.
3.
4.
5.
6.
7.
8.

Click on “default_pack_size” in the available fields list.
Click on “is strictly greater than” in the Comparisons list
Enter “10” (no quotes) in the value field.
Click the Add line button
Scroll down the available fields lists then click on “code” in the available fields list.
Click on “is” in the Comparisons list
Enter “a@” (no quotes) in the value field.
Click the Query button to perform the query.

Before step 8, the window would look like this

The upper area of the query editor shows a summary of the query that is about to be performed.
Note that the wildcard character “@” has been used following “a” to find all items whose code has “a” as the first character
This example will return a list of items where both the search criteria are met, because the conjunction And was used. If you wanted to find items that
matched only one of the criteria entered, you would click on the second line in the large upper panel to select it, and then click on the Or button where
the conjunctions are displayed.
Saving and Using saved queries: If you have spent time on developing a particular query , and you are likely to use the same query in the future,
click the Save button. You will be asked to choose a name and location to save the query. The saved file is very small.
When a blank query window is first shown, you can re-use a previously saved query by clicking the Load… button and locating the query file.
Previous: The Tutorial Next: Understanding Items
2011/05/18 10:38
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About items
An item in mSupply is usually a product that you purchase form a supplier, hold in stock and supply to a customer. However, there are also other types
of items:
• A service item has no stock, but can still be added to customer invoices and charged for. Service item examples are a freight charge, a
consultation fee, an express delivery fee, etc.
• A cross reference item points to another item, so that when it is chosen in a list, it is substituted with the item to which it refers. This allows
you to have items in your system that are referred to by trade name, but are only issued according to their generic name.
Managing items is mostly done from the Item menu or Item tab on the Navigator. The item menu also contains commands for managing lists related
to items such as accounts, drug interactions and units.
For how to add a new item, see Adding a New item.

The Item Menu

Show items....
Use this command for viewing or editing just about any information about an item.
First you are presented with a window asking you to enter search criteria to find the items you are interested in:
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If you click on the Find button (or press the Enter key on the keyboard) without changing anything you will be shown a list of all the visible items in
your store. But you can refine the search by entering and selecting different values in the different filter lines shown in the window. If you enter no
value for a filter then that filter is ignored.
Randomly select x items from returned list text box: If you enter a number in here mSupply will randomly select that number of items from the
items which match the search criteria you have entered in the filters above. Beware: if there are less items returned from the search than the number
you enter in here mSupply will return all the items it found with no random selection.
Exclude hidden items checkbox: This is checked by default and means that only items that are visible in the store you are logged into are included in
the search. If you uncheck this box then all items in all stores in your datafile will be included in the search.
If only one item is found by your search then its details are displayed, otherwise you will be shown a list of matching items.
The Complex find button gives you access to a more powerful query editor where you can find a very specific set of items. A tutorial on using the
query editor is to be found in the custom reports section.

To do a “contains” search, use the wildcard character '@'; e.g. entering “@250”
will find all items with “250” anywhere in their name.

Here's an example of a list of items displayed after clicking the Find button:
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Double-click the item in the list to view its details.

The Items list view
New item: Click this button to enter the details of a new item you are adding to your inventory. You can find out how to do this here
Report: Click this button to open a report editor window where you can design a report. The report will use the currently displayed records (not the
highlighted records).
Set values: A flag is a quick way of identifying a group of items for use in a report.

* You can set and remove flags for multiple items at the same time. To do so, hold down the control key (command key on Mac) and click on the lines
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you wish to flag. They will become highlighted. Then click the “set flags” button. You will be shown a window like this:
We recommend you use a single character (or two) as the flag.
If you choose Append to existing flags, any items with existing flags will have the new flag added to the end of the flag. If you choose Replace
existing flags, then the selected items will have their flags cleared. Note that you can clear all flags for all items by selecting all items (control - A)
then leaving the Set flag to. field blank, clicking “Replace existing flags”, and then clicking the OK button.
Find: Clicking this button displays the Find window, the same as if you had chosen Items > Show items.
Order by: Clicking this button will bring up the standard Order by window, where you can choose fields by which to sort the displayed items
Print: Click this button to print the items currently displayed in a list.
Modify: Click this button to show details for the first record that is highlighted. Clicking the OK and Next button in the item details window will
jump to the next highlighted record. To select multiple records, hold down the control key (command on Mac) while you click on the records you wish
to select.
Duplicate: Click this button to create a new item with the same details as the selected item. A message box like the one below will appear. Click on
button Duplicate to confirm creating the duplicate. Note that the only difference you will see between the existing item and the newly created item is
the name of the new item ends with the text '(copy)'. The new item will be added to the end of the currently displayed list of items.

Note that for recording and audit purposes a Log event is created when an item is duplicated. For more information on log events see The Log
Customise list: Clicking this button will show a window where you can choose which fields from the items table are shown in the list view. See
Working with lists.
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The Item Details Window

Buttons in the item details window
Delete: Provided that an item has no transactions, quotes, order lines or backorder lines, it can be deleted, and this button performs that action.

Once you have received stock for an item, it cannot be deleted. You can delete an
item immediately after you have created it or imported it. Note that if you have
imported an item and stock, you can delete it, and it's associated stock will be
deleted too (but not once it has been used in a transaction such as an invoice or
build).

OK & Next: Saves changes, exits the window, then brings up the next item in the item list. If you did not have an item list open, or if you have
reached the last item in the list, you will be returned to the list or the initial menus, depending on your starting point.
Cancel: Exits the window without saving changes.
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Changes you have made to quotes, notes and backorders will be saved, even if you
click Cancel .

OK: Saves changes then exits the window.

Tabs on the Item Details Window
The item details window displays a vertical list of 'tabs' down the left side. Click on the appropriate item to view a 'tab' displaying particular
information about an item. The Item Details Window normally opens at the General tab.

The General tab

What are those lock icons? To minimise the chance of accidental amendment,
some critical fields have a lock icon to the left of it. To change any of these fields,
you must click on the lock icon first, and then enter the new value in the field.

Item name: This is the name by which mSupply will refer to the item.
Store: The store which you are using is displayed here. For mSupply systems that are only using a single store, this field is not relevant. For users
managing more than one store, the desired store may be selected from the drop down menu. For users having access to all stores, and wishing to work
with the cumulative data from them all, one of the options displayed will be “Supervisor - All stores” - refer Miscellaneous topics,
Supervisor Mode.

• You should avoid changing the name of an item to that of another item.
If you have accidentally created two copies of the same item, these
should be merged - refer Merging two items.
• Historical records will still record the original name, but future invoices
and invoices in process will pick up the new name when you add or
edit an invoice line.

Item code: This is the code assigned to the item. This should be a unique code, and ideally, should not be a part of another code. For example, 1034
is unique, but is a part of 1034a, and so these two codes should ideally not coexist in an mSupply system.

General
Units: Choose the unit you use for this item. It is useful to distinguish items you issue by pack (eg eye drops) from items you issue by volume (eg oral
liquids)
Department: You can assign each item to a department by choosing from the list of departments here. To set up departments, refer Managing Item
Access....
Category: Provided that you have defined item categories, the appropriate category should be selected using the drop down list which displays your
defined categories - refer Item categories.
Interaction group: Here you can choose the interaction group for the item - refer Manage drug interaction groups.
Item Flag: The item flag field is designed for bulk editing, where you use the list view to update many items at once. You can enter or edit an
individual item's flag(s) here, though it can be easier to do so using The list view.
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Universal Code: mSupply has the ability to look up and store a Universal Code for each item. Click on the select button
to look up a universal
code. mSupply will look up matches based on the first three letters of the item name. Ensure you carefully select the correct item from the list when
using this feature.
If you want new universal codes added to the system send an email to support@msupply.org.nz
You can search universal codes from a web browser at https://universalcodes.msupply.org.nz/ (https://universalcodes.msupply.org.nz/)
Catalogue Code: Frequently organisations may apply a second code to an item - e.g. one for auditing purposes, in addition to one for general use.
This field allows the entry of such a code.. Provided the Include catalogue code for each item box is checked under Preferences > Misc, a report on
Catalogue codes may be produced.
Hold: do not issue: If this box is checked, the item will not be available to be issued on invoices. It will still appear in lists, but you will get a warning
if you choose it when issuing stock, and will be required to choose a different item.

Putting the Item on hold applies to all stock lines of the item in your system. If
you wish to hold selected stock lines only, you should do that through by editing
the individual stock lines using Show items with stock.

Issue in builds only: Checking this box will mean that the item cannot be issued on customer invoices. This is useful in situations like where an item
which by law can not be sold in an unprocessed state, but is used to 'build' (refer Building (Manufacturing) Items) another item which is legal for
distribution.
Allow pack to one conversion: Checking this box allows stock of the item to be repacked to “1”.
Convert pack to one when receiving: If this box is checked, when you receive items the pack size will automatically be converted to “1”. This is
primarily for use in dispensary mode, but may be useful in other situations too.

For example: say you receive 50 x 100 boxes of paracetamol tablets, but you issue
variable amounts of paracetmol tablets on invoices. If this option is checked, as
you receive the stock on a supplier invoice, it will be converted to 5000 (quantity)
x 1 (pack size). You will now be able to issue any quantity you like. The cost and
sell price are automatically adjusted for the new pack size.

Shelf locations
Shelf Location: The default shelf location for this item in this store. When you receive items into stock, they will be given the shelf location you enter
here unless a different location is chosen. Type as much of the location (ie the first few characters) or code as you know, then press the Tab key. If only
one location code matches your entry it will be filled in automatically, otherwise you will be shown a standard choice list like this:
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Select the location you want by double-clicking a line or by clicking once on the line and then clicking OK

Each batch of stock can have its own shelf location, or can share a location with
another item.

Bulk Shelf Location: Similar to shelf location but it is used to store bulk quantities of goods/items. You can enter a code here in the same manner as
for the Shelf Location.
Preferred pack size: This is the default pack size that will be chosen when receiving new goods or adding an item to a purchase order. It will also be
used for comparison of quotations from suppliers (i.e. the adjusted price used when comparing quotations is the price if all quotes for for the pack size
defined here.
Restricted to Here you can choose from a list of Location types. For example, all cool store locations could have been given a type of “cool” and then
if the item you are editing should be kept in a cool store, choose that type here, and you will only be able to receive that item into a cool store location.
Volume per pack: If you are using available volume tracking in your warehouse, then fill in the default volume for one pack of the preferred packsize
of the item here.

mSupply® always stores volumes as m3 (cubic metres), but you can enter a
volume as millilitres (mL), litres (L) also.

You enter

Value displayed

mSupply® stores

30ml

30ml

0.00003 m3

1500L

1.5 m3

1.5 m3

600 L

600 L

0.6 m3

1500 ml

1.5 L

0.0015 m3

Outer pack size: The number of default packs per default outer pack
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Outer pack volume: The volume for the default outer pack. This may be different to an exact multiple of the volume per default pack you entered
above, as outer packs may have their own packing. (For example, vaccine packs may come in an insulated container.)
Weight per pack: The weight of a default pack in kg.

Pricing
Default margin: This is the margin that will be applied to this item on supplier invoices to calculate the selling price. Note that if a supplier margin is
also set, there is a setting in the Preferences > Invoices 1 that determines which margin will be used. Note also that if a default selling price is set, this
price will take priority and be used rather than the margin.
Default sell price of preferred pack size: Only enter a price here if you want a fixed selling price for this item. Enter the price for one unit (eg 1
capsule or 1 gm). A price entered here will override any margins you have specified for either the supplier or the item.
Price editable when issuing: Check this box to enable this feature

Full description
This field may be used for entering a fuller description of the item should the item name alone be insufficient.

VEN Category
Like all categorisations, this one is used for reporting. VEN category options available are:
•
•
•
•

Not assigned
Vital
Essential
Necessary

You can select one of the options only and Not assigned will be selected for all items by default.

Authorities, including the WHO, are inconsistent on whether N should stand for
Necessary or Not Essential. It makes no difference to mSupply, but if you want
this changed in your installation of mSupply, talk to Sustainable Solutions

Stock Category
These categorisations are used for reporting and you can check as many as are appropriate. You don't have to check any, they are entirely optional.

Custom fields
These are 7 fields available for users to store information appropriate to their operation. These fields may be queried when performing a search or
producing a custom report. Their default names are user_field_1, user_field_2, etc.., but these labels may easily be edited to more descriptive ones as
required..
Field types:
• Fields 1,2,3 & 6 are text fields
• Field 5 is a numerical field
• Fields 4 & 7 are boolean - True/False (Yes /No) entry.
To set the names of the user fields, refer General Preferences, Miscellaneous tab.
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The Misc(ellaneous) tab
This window has settings for:
1.
2.
3.
4.

cautionary warnings used when dispensing medicines
accounts used when exporting transaction information
SMS (text) messaging
Price list

Warnings: Warnings which apply to this item are chosen from a standard list. This list is set up using the Special > Warnings menu.
Use the Add button to add a warning for the item. This will open the below window where you can choose the warning from a list. Double click on
the warning you want to use. You may also add new warnings to the list by clicking the new button.
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To delete a warning, click on its line then click the Delete button.
When an item has more than one warning, the warning that has priority will be automatically printed on the label. You can add other warnings as part
of the label directions if required.
To give a warning priority, double-click its line in the list and check the Priority box:

A warning's text may only be edited by choosing Warnings from the Special
menu

Accounts: You can set the general ledger account to be used for exporting purchase and supply transactions involving this item here.
To set each account enter a portion of the account description or code and press the Tab key. You will be shown a standard choice list if more than one
account matches what you typed.
SMS settings: These settings concern the item and SMS messages from mobile phones.
SMS code: This is the code that will be entered in an SMS to refer to the item. Keep the code short and unique! If you change this code you must
notify all the users who send SMS messages to mSupply about the new code, otherwise they will not know how to refer to this item in their SMS
messages. Because of this, you can only change this item after you 'unlock' the padlock next to it by clicking on it. When you unlock the padlock you
will be shown a warning that SMS users must be told about the new code.
SMS pack size: The pack size to use to convert the pack size quantities entered in an SMS message into item quantities. You must enter a value greater
than or equal to 1 for this if you have entered an SMS code. Otherwise this field is ignored.

Price List
On Price list: If this box is checked, this item will be included when the price list is produced - refer Other Reports.
Catalogue price: The price for the item that will be used when you produce the price list
Catalogue pack size: The pack size for the item that will be used when you produce the price list

The Catalogue pack size can differ from the preferred pack size on the General tab
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The Usage tab

The Usage tab allows you to view the item usage per month for the previous 24 months. This information is very useful for quickly spotting a trend in
usage for a particular item.
Below the list of usage for each month there is a drop down list to choose from 1 to 24 months. After choosing a value, the Mean (average) usage and
Standard deviation figures will be updated to give the figures for the period chosen (the period is from the selected number of months ago to the
current day).
Refresh usage button: This button allows you to update the usage with transactions that were added since you opened the window (this applies to
multi-user mode). It also allows you to show the usage with or without build transactions included in the totals, depending on whether or not the
Include builds checkbox is checked.
Show Graph button: Clicking this button shows the same information in a graphical format:
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One coloured set of bars shows the usage for the current year, another coloured set shows the usage for the previous year (if data is available).

The Stock tab

The “Stock” window shows the lines of stock for this item together with the stock on hand. mSupply® will calculate how many days this stock will
last, based on your usage over a number of months - you can specify how many months.
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If you have turned on any of the custom stock fields in store preferences they will
be displayed as columns (between the Supplier and Manufacturer columns) in the
list of stock lines on this tab and the information you entered for these fields when
the stock was received will be shown in the appropriate cells.

Show zero lines: This button will show all the lines that are still in your data file, but which have no stock on hand. If you can think of a use for this
information, please let us know! When you click the button the button title changes to “hide zero lines”, which allows you to get back to the info you
really wanted.
Splitting: There may be occasions when you need to split your stock- e.g. if you are moving it, say, from a store to a dispensary or clinic, or when you
are repacking some stock; select the line to be split, and click on the Split icon to show a window allowing you to enter the quantity to be split, the
new location, and - if applicable - the new pack size.
In the example shown, 2 packs of 1,000 Erythromycin tablets are being transferred to a new location, and the `outer' of 1,000 ( actually 10 x100 shrink
wrapped together) is being opened to yield 10 individual packs of 100.

Update sell prices: Clicking on this icon will update the selling prices of the highlighted line(s). mSupply® will use the figure entered in the Default
sell price of preferred packsize field in the General tab, which must show the updated price before this will take effect. If you make use of the
Default margin field, and you update this figure, then Supply® will calculate the updated sell price using it. Note that mSupply® looks first in the
Default sell price … field, and any figure entered there takes precedence.
Labels: Clicking this button will print shelf labels for the highlighted batch(es). The shelf label includes the location, the item name and code, and the
batch and expiry. Here's a (bad) example

Show related invoices
Highlight a line then click on this button to display a list of transactions which used this particular line.
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Consolidate
You can consolidate (join 2 stock lines together) if they have
•
•
•
•

The same batch #
The same expiry
The same pack size
Are at the same location

If 2 batches you want to consolidate are at different locations, use the split button
to move one of the batches to the location of the other batch, then consolidate.
This reflects what you would have had to do physically anyhow!

1.
2.
3.
4.
5.

Hold down the control key (command on Mac)
Click on the two lines you want to consolidate
Click consolidate
If the two batches are at different locations you'll be warned and asked if you want to continue.
You're shown this window

◦
6. Choose which batch to keep.
7. Click OK
An example:
• Before:
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• After:

Other information on the stock details page
Stock
Minimum stock: The minimum stock you wish to keep on hand. Note that you do not need to enter a quantity here for mSupply®'s ordering system to
work. In fact, it is better in most cases to leave this number set to zero. This field should only be filled in if you absolutely must keep a minimum on
hand. For example, if you stock naloxone for narcotic over dosage reduction, and even if you only use 1 vial every year, you have decided you need to
keep five vials on hand, you would enter “5” as the minimum quantity for naloxone.
Stock on hand: The total stock of this item on hand.
Stock on order: The total quantity of stock of this item on order from suppliers
Non-stock items
If this is a non-stock item, you can check this check box. If there is one, you can specify the default customer for the item, otherwise leave this box
blank. For more on this topic see Non-stock items
Months Cover
You can use this calculator to estimate the time left until the stock of this item runs out. The values which appear estimating the time it takes to use the
stock on hand (and on order) are calculated from the average usage of the last few months. You can choose the number (from 1 to 24) of months used
to calculate this in the drop down list.
You can also exclude stock that will expire soon. Enter a number of months and any stock that expires before your chosen time frame will be excluded
from the calculation.
If you would like to know how much stock to order so that you have enough for the next few months, enter the number of months you would like
stock for. After entering or changing any or all of these values, click Calculate to see the results.

Editing a stock line or viewing more stock line details
To edit the cost price and selling price for an item line, double-click the line you wish to edit.
The Item stock line details window is displayed:
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The Stock lines > General tab
This tab shows the details of a stock line.It also gives you total and available quantity of that stock line.
Hold checkbox: To hold a batch check the Hold check-box. Once an item is held, it cannot be issued. It will still appear in the available stock window,
but held lines will have a check box in the hold column, and if a user attempts to issue the line they will be informed that the line is on hold. Note that
the Hold: do not issue option in the General options takes precedence, and if that option is checked, then no stock may be issued, regardless of batch.

The Stock lines > Ledger tab
This tab shows a list of transactions (supplier and customer invoices, inventory adjustments etc.) for the item batch being viewed. You can use this
window to view immediately see a list of customers who have been supplied with this particular batch:
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The In/Out column tells you whether the transaction on that line brought stock into or took stock out of mSupply.

The Stock lines > Status tab (Vaccine vial monitoring)
A window appears with 4 columns:
•
•
•
•

Date
VVM status
Entered by
Comment

There are two buttons:
• New
• Delete.
This has been specifically designed to use the Vaccine Vial Monitoring (VVM) feature. All vaccines requiring cold storage bear a VVM label which
registers cumulative heat exposure over time; the combined effects of heat and time cause the inner square of the label to darken gradually and
irreversibly. A comprehensive description of VVM is available in the WHO's pdf document accessible here (http://tinyurl.com/n2mge23).
Batches of vaccines should have their status VVM labels regularly checked, and assigned to the relevant status; Clicking on the New button allows the
details to be recorded.
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Should a batch of vaccines have the status 3 (or 4), the Hold checkbox under the General tab should be checked.

The Stock lines > Reference Documents tab

The standard Document Management window appears. See Reference documents for more information on the use of such documents.

The Ledger tab
The item Ledger tab lists individual transactions for the item in question. By default is shows all transactions for the current year:
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The Type column has a shorthand label for the type of transaction:
•
•
•
•

si = supplier invoice and inventory adjustment to increase the amount of stock
ci = customer invoice column describe
sc = supplier credit or inventory adjustment to reduce the amount of stock
cc = customer credit

Note that all supplier lines have a grey background and customer lines have a white background to help you identify them easily.
The Quan column shows the number of packs of pack size shown in the Pack column that were involved in the transaction.
As a quick indicator, if the transaction reduced the amount of stock in mSupply then the number is negative.

Filtering the ledger list

Two drop down lists are available to filter the transactions you see in the table:
You can use the Show…. drop-down list to show:
•
•
•
•
•
•

All transactions (the default)
Only supplier transactions (supplier invoices)
Only customer transactions (customer invoices)
Inventory adjustments
Repacks
Transactions whose status is `New'
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•
•
•
•

Transactions whose status is `Suggested'
Transactions whose status is `New or suggested'
Transactions for just one name (click on a transaction line for the name you are interested in)
Transactions for one particular item line. This will show the supplier invoice on which the item line was received, and all subsequent issues
of that item line to customers.
• Same batch as selected - this will show all the supplier invoice on which the batch was received, and all subsequent issues of that batch to
customers. This can be useful for tracing a particular batch of medicines.
The other drop down list allows selection from a variety of periods during which transactions occurred.

Tip: Clicking on the column headings of the transaction list will sort the list by the information in that column. The column header will be underlined
to show by which column the list is sorted.
Note: If the cost price column is blank, this is because the current user does not have permission to view cost prices. (This option can be turned on or
off for each user from the “File > edit users…” menu item).
If you want to view an invoice for one of the displayed lines, simply double-click the line you are interested in. The invoice (or payment, as the case
may be) will be shown in a new window.

Printing the ledger list

Clicking this button will give you the following printing choices:
• the information currently displayed in the window
• a complete ledger from the start of your year
• stock movement for a specific period or between two dates of your choice
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The Quotes tab

A quotation is a record of a price you have been given by a supplier. For each item you can have multiple quotes recorded, reflecting different prices
you have been quoted from different suppliers, or even different prices from the one supplier for different pack sizes.
When you come to compare quotes, there are several factors that need to be taken into account. By entering the information in mSupply® you are able
to find the best price once these factors have been taken into account, and you build a history of quotations from each supplier.
The date until which the quote is valid is displayed, and you can choose to display all quotes, or currently valid quotes.
There may be occasions when a supplier has quoted for an item from two or more manufacturers, and in such cases, the manufacturer's name will
appear in the column headed Manufacturer .
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Cost: Cost is the price for that pack size in your local currency, taking into account the freight factor and the exchange rate.
Adjusted cost: Adjusted cost is the price for your “preferred pack size” you have entered for that item. This second price allows for a direct
comparison between suppliers. Note that if you change the “preferred pack” for an item, all your quotes will be updated to reflect the new pack size.
Comparing quotes:: Click “Adj cost” heading in the list of quotes to bring the cheapest quote to the top of the list.

Add a new quote
Click the “new quote” button. The quotes input window will open

• Type as much of the supplier code as you know, then press the Tab key- you will be presented with a list of suppliers if there is more than
one to choose from.
• Enter the price and the pack size in the currency you have been quoted.
• Note that the currency and freight factor are filled in with the information you have entered for the supplier.
• If the supplier has quoted in a different currency to the supplier's default currency, you can change the currency for this quotation from the
drop-down list on the right.
• The freight factor is the factor you need to add to the supplier's prices to account for delivery costs. If your supplier includes these costs in
the quoted price (i.e. prices are “CIF”), the freight factor for the supplier should be set to “1”. If your supplier adds freight that amounts to
about 15% of the invoice price, set the freight factor to 1.15.
Strip pack: This check box allows easy identification of quotes that are for strip/blister packed items (as opposed to “loose” items).
Preferred: This check box allows you to identify one (or more) suppliers as the preferred supplier for the item. One of the ordering methods uses the
“preferred” check box to indicate which items should be considered for ordering from a particular supplier. See Ordering from suppliers for more
details.
Supplier code: If you are using electronic invoice transfer, you must use this field to record the code for the item that this supplier uses on their
electronic invoices.
Supplier bar code: Here you can record the bar code identifier for this product.
Price Break: Enter the quantity that generates a price break along with the percentage discount that will apply once this quantity is reached.
Freight: Enter the value for the preferred pack (outer pack) and the freight for that pack provided by the supplier.
Click OK to accept the details, or cancel if you decide not to add a quote for this item.
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To modify a quote:
Double-click the line you want to edit.
In the window that appears you can change the date, the supplier, the price, the pack size, the Strip check box, or the Preferred check box.
To delete a quote:
• Click on the quote line you wish to delete
• Click the Delete quote button
• Confirm that you want to proceed

The Backorders tab

You can view the backorders for an item here. To edit a backorder, double-click the line you wish to edit.

To add a new backorder for this item, click the New backorder button. This window will be shown:
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• Enter part of the customer name, then press Tab to search for the customer.
• Enter the order date, quantity and any comment, then click OK to save the new backorder entry.
To delete a backorder, click the line you wish to delete, then click the Delete backorder button.
The total stock on backorder is shown below the list.

The Notes tab

You can add and edit notes for an item here.
Click the New note button to add a note. A note can be up to 32,000 characters.
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The date on which you are entering the note is already completed, and in the main panel you should type in the wording of the note itself. In the lower
left of the window is a drop-down list offering various choices concerning the displaying of the note on screen; it may appear as an alert when this
item is issued on a customer invoice, received on a supplier invoice, or, if all is chosen, it will display for both customer and supplier invoices.

You may also set the background colour of the note, but as the text is always black, dark colours should be avoided. A further option allows you to
have one or more audible `beeps' sound when the note is displayed. Each note will display according to the attributes set for it, independently of other
notes defined for the same item.
Subsequently, when the item is selected (depending on the specified display settings), the note will appear on screen; be aware that the note does not
disappear automatically - you must close it/them manually.
To edit a note, double-click the note in the list you want to edit.
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The Reconcile tab

Clicking the Reconcile button will give a summary of usage.
It is useful for checking mSupply® is working as it should be! If you get an error here it is most likely due to your using mSupply® when a power
failure occurred. In multi-user versions we are able to provide you with a log file that will allow you to incorporate transactions entered even if a
power failure has occurred. In normal use, with a UPS, mSupply® will automatically save data and you will not see an error here.

The Bill of Materials tab

This may not be showing if you do not have a registration for mSupply® that
enables manufacturing, or the buttons may be dimmed so you can not make entries
if your user permissions do not allow you to view Bills of Materials.
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Here you can specify a Bill of Materials for the item if it is a manufactured item. Once you have done so, and have checked the Use a Bill of
Materials to manufacture this item check box, when you enter a new build, it can be automatically filled out with the correct materials (ingredients)
and the correct quantities for the total to be manufactured.
Use a bill of materials to manufacture this item: If this check box (1) is not checked, the bill of materials (if one has been entered) will not be used
when manufacturing builds.
New ingredient: This button(2) allows you to add items to the bill of materials.
You will be shown a window like this:

Enter the start of the item name or code then press the Tab key. If only one matching entry is found, you can then enter the quantity. otherwise you
will be shown a list of matching items. Double-click the item you wish to use.
Click the OK button when you have finished, and the item will be added to the bill of materials for the item you are editing.
Note: (3) Be careful to enter quantities corresponding to the units you have specified for the item.
Delete ingredient: To delete an ingredient, first click on the ingredient you wish to delete so that it is highlighted, then click this button.
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Print: This button allows you to print the bill of materials that is displayed.
Quantity of finished product this bill of materials is for: This is the total quantity of this item that will be produced by the bill of materials that is
entered for the item. Be careful to set this quantity and the units correctly.
Manufacture Method: This panel may be used to record the steps in the manufacturing process. When you are entering a build you have the option to
print the manufacture method along with the build ingredient list. For more information see Building (Manufacturing) Items

The Purchase Orders Tab

• The Show drop down list beside allows filtering the display of Purchase Orders according to their status - All, Suggested, etc. • If you double-click a row the Purchase order will be opened in a new window.
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The Order Options tab

Never order this item: If you have items that are “one-offs” or have been discontinued, use this check box to stop them appearing in orders.
Hold: do not receive: If this check-box is checked, you can not receive this item. This can be useful if you have changed to using a different item, and
you do not want people to accidentally use the redundant item.
Expiry date required on receive: When this is checked, you will be unable to receive this item unless an expiry date is entered for it. Therefore it is
best to check this box for items that will always have an expiry date such as oral medicines and to leave it unchecked for items that will never have an
expiry date such as surgical instruments.
• You will be warned if you try to add or edit an item on a goods receipt or a supplier invoice that has no expiry date entered. Also, you will
not be able to finalise a goods receipt that contains items which have no expiry date entered.
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The Dispensing tab

Default directions
A feature of mSupply® which can reduce the time taken to dispense a prescription is its use of abbreviated patient directions, which allows the entry
of a short sequence of characters that expand to meaningful text. This is where you can set an item's default directions which will be used at the time
of dispensing. When there is more than one entry, priority is given to the direction that is ranked at no.1 under Priority, and it will be automatically
suggested for the item when you dispense it. Further information on the use of abbreviations will be found in the section Dispensing, Abbreviations
In cases where multiple abbreviated directions have been defined, the required one(s) will be available from a drop-down list when dispensing the
item. Note that even if you set up default directions, you can override these at the time of dispensing, either with longhand text or by editing the
abbreviation that has been entered.
Warning: If you choose to use this option be very careful to:
•
•
•
•

Inform other users that default directions have been entered.
Ensure the directions are appropriate.
Check each prescription dispensed, and change the directions if the prescription has different directions to the default set.
Update the default directions if you change any of the abbreviations.

Add button: Click this button to show a window where you can add directions. You can enter any combination of directions and text. (Abbreviations
are managed by choosing Special > Abbreviations)
Delete button: Click a line, then click this button to delete directions you no longer need, or if you have made an error.

Picture, Instructions and Purpose
These fields provide default information to be used with the Patient medication records system.
Item Picture: You can drag and drop or past a picture into this field. Common file formats such as JPG and PNG are accepted.
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When you add a picture, the size is shown to the left- we suggest pictures are less than 200KB each.
To clear a picture, click on the field and paste it.
Purpose: Enter the purpose of the medication here. This will be available to add to patient medication records
Instructions: Enter the medication instructions here. For example, you might want to explain about sensitivity to sunlight with long term use, or that
certain foods should be avoided. This will be available to add to patient medication records. Note this is separate to the medication warnings system,
which will print on dispensing labels.

Other fields
Warn if user tries to issue more than field: You can enter a number here and have the user warned if they try to dispense more than this quantity.

The Reporting tab

ATC Category: This field is intended for the ATC code. The use of ATC codes and DDD values is discussed in detail here.
DDD value: The DDD value is the defined daily dose of the item. For example, doxycycline's DDD value is 100mg., while that of Amoxycillin is 1g.
DDDs are a means of quantifying the issue of medicines by doses rather than by the raw number of units dispensed.
DDD factor: Defined Daily Dose factor- this is the number of units of the item that make up the DDD value. In the case of amoxycillin 250mg
capsules the DDD factor is 4, while amoxycillin 500mg capsules have a factor of 2. For Doxycycline 100mg tablets the DDD factor is 1
ABC category: This option allows you to mark items that are commonly used and then report on only those items. For Reports using this category,
see Items and Stock reports

The Log Tab
mSupply® maintains a record of any changes to an item's details - name, code or units. The log window displays a list of such changes, under the
headings:
•
•
•
•

Date
Time
User and Event
Event Type
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Requisitions
Selecting Requisitions shows the stocktakes featuring this item,
• Choose a date range from the drop-down list to show custom stocktakes within that range.
• Double-click a row to view the customer stocktake in question.

The Stores tab

Only users who have Admin privileges may access this feature. See Managing
Users

Selecting this item shows the stores where this item is visible, and allows these stores to be set to Active using the checkbox.
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If the Active checkbox is unchecked, the item will not be visible when logged in to that store
Note that
1. you can only change the visibility of an item for the store you're logged in to.
2. you can not make an item invisible in a store if it has stock on hand in that store.

Seeing an invisible item
Once an item has been made invisible it will no longer show up in your items list when performing a normal find items task. To include invisible items
when finding items, untick the Exclude hidden items box:
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The items list will now display any invisible items and you will be able to able to make them visible again in the store tab.

If your mSupply system is a Primary - Satellite synced system, you can only
change visibility of items on the Primary server.

Previous: Working with lists Next: Adding items
2011/04/15 05:04

·

Adding a new item
There are different types of item in mSupply but this is the function you use to add them all. The different types are:
• Normal: This is the one you will nearly always use and is something which you can receive, distribute and hold stock of.
• Cross reference: This type of item is a pointer to a normal item. Whenever you select a cross reference it will be replaced with the normal
item that it points to. In this way, you can use cross reference items to represent brand names (e.g. Panadol) or familiar names (e.g.
“Cetamol” is used to refer to “Paracetamol” in Nepal) that actually refer to generic items.
• Service: These are items which do not have physical stock such as consultancy fees or other charges.
To add any type of item choose Item > New item from the menus (Note: this is not for adding actual stock, just details of the items themselves - to
add stock see Receiving goods (goods receipt function) or Receiving goods - a supplier invoice).

Don't be put off by the number of fields appearing on these windows! mSupply will operate satisfactorily after entries have been
made in just the Item code and Item name fields for any item type. All the other fields can be regarded as optional extras, some
or all of which you may use at some later date, or never. mSupply is very versatile!
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Normal items

Type: Select the type of item you want to add here. The field always defaults to normal.
Item code: This field is mandatory and is a short way of referring to and finding the item throughout mSupply
Item name: This field is also mandatory and is the name that the item will be known by throughout mSupply. It will appear in reports and displays,
wherever the item is referred to.
Barcode: Enter the text value of the item's barcode in here. Not used at the moment but will be in the future - mSupply is ready for the time when
barcodes contain batch and expiry information and therefore become useful for managing pharmaceuticals.
These 4 fields are available to be filled in for every type of item.
You should decide on a clear scheme for item names and codes. This can be a tricky process but is worth persevering with. You can change your mind
later but changing the codes of all the items and names in your datafile could be a time-consuming business.
We would recommend that the item code is systematic and can be worked out from the item's details e.g. first 3 letters of the item's name, 3 figures for
the strength, a letter for the formulation then a letter or number for disambiguation if necessary. e.g. the code for Amoxycillin 500mg capsules could
be amo500c.
For item names we would recommend again that you use generic names (no brands or familiar names - use cross reference items for those), be
systematic and start with the broadest part of the name. For example, “Brody forceps” would be entered as “Forceps, brody”, “Aqueous iodine” would
be entered as “Iodine, aqueous”. For pharmaceuticals we would recommend the name followed by the strength then the formulation e.g. Amoxycillin
500mg capsules.
You are, of course, free to choose your own schemes, these are just our recommendations and one way of doing it. There are many reasons for
adopting other schemes and it is not necessary to know or remember item codes while using mSupply!
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General tab
Units: The drop down list allows you to choose the appropriate units for the new item ; mSupply comes with a limited list of pre-defined units, but it
is recommended that users define their own list. You will find more information here.
Category 1: Click on the magnifying glass to select the category 1 this item belongs to. Category 1 is hierarchical and needs to be setup before you
can select them here. See Item categories for details on setting them up.
Category 2 and 3: Select the category 2 and 3 that this item belongs to. You must setup these categories before you can select them here - see Item
categories for details on doing that.
Department: Select the department the item belongs to. Departments are not a way of categorising items (use the other categories for that) but are for
restricting access to items for different customers and are described in detail in Managing item access.
Default shelf location: This is the location in the store that the item is normally stored. It will be offered by default when the item is received into
stock. Type as much of the location code or description (e.g. the first few characters) as you know, then press the Tab key. If only one location code
matches your entry it will be filled in automatically, otherwise you will be shown a standard choice list like this:

Select the location you want by double-clicking its line or by clicking once on the line and then clicking OK.
Default pack size: This is the standard pack size that you use for comparing quotes from suppliers.
Default weight: The weight of the preferred pack size in kg.
Price list: If this box is checked, this item will be included when you produce price lists. If checked the item will also be included in the online
catalogue.
Non stock item: If the item is something you do not normally keep in stock, but is passed straight to a customer, this box should be checked.
Default customer: This is the customer the item is sent to by default - used for non-stock items only. Type the first few characters of the customer's
name and press the Tab key on the keyboard to select the customer you want.
VEN category: Select which WHO VEN category the item belongs to (one only) - used for reporting.
Stock category: Check each one of these that apply to your item (used for reporting):
• Normal stock: For practically all new entries this box should be checked; at a later date, should the item be removed from your formulary
for instance, you would remove the check from this box.
• Critical stock: Should it be a requirement that you must never be out of stock of this item, this box should be checked.
• Essential drug: Check this box if the item is on your Essential Drugs List.
161

mSupply user guide July 2018

When you have added all the details for your new item, click on the OK button or, if you want to add another new item, the OK & Next button.
If you have clicked OK & Next but don't want to add more items, press Cancel. Items previously added are still saved - just the details showing on
the screen are not saved.

Stores tab
On this tab, you select which stores the item will be visible in.

Simply check the Visible in store checkbox against each store in the list you wish the item to be visible in (if an item is visible in a store then it can be
sued in that store). You can use the All/None checkbox to toggle selection of all stores or no stores.

If the preference Automatically update item visibility to match the master lists used by each store preference (see General
preferences) is turned on then the table in this tab will be replaced with some text telling you that visibility is controlled by
master lists and not selecting store visibility directly. Use the Master lists tab (details below) in that case.

Master lists tab
On this tab, you select which master lists the item should be added to.
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Master lists can be used for many things in mSupply (e.g. controlling visibility of items in stores or determining which items appear on requisitions).
See Item master lists for details of how to set them up and use them.
To add the new item to a master list simply check the Add to list checkbox against the particular master list in the table. Note that any master lists that
have the Automatically add new items to this master list option checked will have their Add to list checkbox checked and you will not be able to
uncheck it.

Cross reference items
To create a cross reference item select cross reference in the Type drop down list. The window changes slightly:
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The Item code, Item name and Barcode fields are the same as for a normal item (described above) but remember you're entering the details of the
brand or familiar name in here!

Cross reference item tab
When this item is chosen in a list, use: Type the first few characters of the normal item you always want to replace the brand/familiar name with in
this field. Then press the Tab key on the keyboard and select the item you want.
That's it, all done. After clicking the OK or OK & Next buttons, every time a user chooses the item you entered in the Item name / Item code fields
it will be replaced with the item you entered in the When this item is chosen in a list, use field.

Stores tab
You select the stores the cross reference item will be visible in on this tab. It operates exactly the same as the Stores tab described above for normal
items.
Note: cross reference items cannot be added to master lists so there is no Master lists tab. Their visibility cannot therefore be controlled by master lists
but only by directly selecting the stores they are visible in on this stores tab.

Service items
To create a service item select service in the Type drop down list. PLEASE NOTE: the service option will not be available in this drop down list if
the preference to allow service items has not been set. Please see General preferences for details.
The window changes slightly:
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The Item code, Item name and Barcode fields are the same as for a normal item (described above).

Service item tab
Cost price: Enter the cost you buy this service (e.g. getting an oxygen cylinder refilled) for.
Sell price: Enter the price you charge when selling the service.
Neither of these fields is compulsory.

Stores tab
You select the stores the service item will be visible in on this tab. It operates exactly the same as the Stores tab described above for normal items.
Note: service items cannot be added to master lists so there is no Master lists tab. Their visibility cannot therefore be controlled by master lists but
only by directly selecting the stores they are visible in on this stores tab.
Previous: Understanding Items Next: Item categories
2011/04/18 12:21

·

Item categories
Item categories are a great way of grouping your items. This enables you, for example, to report on specific groups of products by filtering by item
category. This can be extremely helpful.
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mSupply provides 4 different categories (called category 1, category 2, category 3 and VEN) for you to use. Category 2 and 3 are normal categories
but 1 is a bit special - it's hierarchical and has 3 levels (level 1, 2 and 3. Level 1 is the top level, level 3 is the bottom). VEN refers to the WHO
categories of Vital, Essential and Nonessential.

Be careful not to get mixed up between the levels of category 1 (1, 2, and 3) and
the different categories (1, 2, 3 and VEN) themselves here!

Category 1 categories
Selecting Show Item Categories from the Item menu opens the window appearing below, showing all the category 1 categories in their 3 levels by
default (Note that the 3 “None” categories are default categories and cannot be renamed or removed):

In the screenshot you can see that “6.Antiinfectives” is a top level (level 1) category 3 category. It has 3 level 2 child categories: “6.1 Antiinfectives,
anthelmintics”, “6.2 Antiinfectives, antiamoebic/antigiardics” and “6.3 Antiinfectives, antibacterials”. And level 2 category “6.2 Antiinfectives,
antiamoebic/antigiardics” has a single level 3 category “Antileprosy medicines”.
Clicking on any of the categories will show you which items are assigned to that category in the panel on the right hand side of the screenshot.
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Adding category 1 categories
To add a category at level 1, 2 or 3, click on another category at the same level you want the new one to be, click on the Add button (or the Add child
button if you want the new category to be a child of the category you selected) shown in the screenshot and the new level will appear at the bottom of
the categories pane called “Click to edit” and already selected. Click on it once and type the category's name. When you're done click outside the
category and that's it!

Editing category 1 categories
Renaming a category is simple. Click once on the category you want to rename to select it then click on it again to edit the name: the category will
become a text box and you can type the new name. When you've finished editing the name, simply click outside the textbox (but inside the category
pane) and the new name will be saved.
Changing the parent of a category is almost as simple. You simply click on the category once to select it then click on it again, drag it onto its new
parent (or a sibling of the new parent) and let go of the mouse button. Two things to note here:
1. You can only move a category to a position at the same level. If it's a level 3 category then you can only drop it onto a level 2 category or
another level 3 category. If you drag a level 3 category onto a level 1 category nothing will happen. For example: in the screenshot you
could drag category “6.1 Antiinfectives, anthelmintics” onto category “1. Anaesthetics” or onto category “4.2 Antidotes, specific” and it
would move (to become a child of category “1. Anaesthetics” or “4. Antidotes”). But if you dragged it onto category “6.2.3 Antileprosy
medicines” it would not move (this is a level 3 category, 1 level below “6.1 Antiinfectives, anthelmintics” so the move is not allowed).
2. If you move a category which has any child categories, all the child categories will be moved too. For example: in the screenshot you could
drag category “6.1 Antiinfectives, anthelmintics” onto category “4.2 Antidotes, specific” and it would move to become a child of category
“4. Antidotes”. It's child (“6.1.3 Antischistosomals…”) would remain its child and become a grandchild of “4.2 Antidotes, specific”.

Deleting category 1 categories
This is the simplest of all. Select the category you want to delete by clicking on it and then click on the Delete button. After confirming you want to
delete the category it will be deleted. mSupply will not allow you to delete categories that have items assigned to them - it will warn you that you have
to remove the items from the category first. See the Assigning items to categories section below for details on how to do this.

Category 2 and 3 categories
Category 2 and 3 categories are simpler - they are not hierarchical. To view the category 2 or 3 item categories select Show Item Categories from the
Item menu and change the Show drop down list at the top of the window to “Category 2” or “Category 3” and the window will change to look like the
screenshot below:
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The window shows a list of the existing categories of this type.
Save sort order button: The sort order of the categories is the order they will appear in the list when you are assigning items to the categories (see the
Assigning items to categories section below) or when you're selecting them in a filter e.g. for a report. You can drag the categories up and down the
list to give them the order you want them to appear in. When you are happy with the order, click on the Save sort order button and the order will be
saved.
New button: Clicking on this will take you to the edit category window shown below:
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Simply type the name of the category shown in the Item category textbox and click on the OK button to create the new category
If you double click on a category in the list you will also be taken to the edit category window where you can edit the category's name, see which
items have been assigned to the category, delete the category (click on the Delete button).

VEN Categories
mSupply allows you to categorise items according to the World Health Organisation categories of:
Vital - medicines are potentially lifesaving, have significant withdrawal side effects (making regular supply mandatory), or are crucial to providing
basic health services.
Essential - medicines are effective against less severe but nevertheless significant forms of illness but are not absolutely vital to providing basic health
care.
Necessary - this group of drugs is used for minor, or self- limiting illnesses, and those which have a comparatively high cost for additional therapeutic
value. It includes drugs which are prescribed but which provide useful alternative therapy.
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You can use these categories to make purchasing decisions using reports such as the Suggest Order Quantities report.

Assigning items to categories
Once you have set up the categories, all items can be assigned to their appropriate category. This is performed on the Item details window under the
General tab (get here from File > Show items, click on the Find button and double click on the item you want to add to a category):
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To assign the item to a category 2 or category 3 category, select the correct category from the Category2 or Category 3 drop down lists.
To assign the item to a category 1 category click on the magnifying glass next to the Category box. The following window will open:
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• If the item is already assigned to a category then that category is highlighted in the list
• If you want to change the item's category, simply select the level 3 (bottom level) category you want
to assign the item to, and click on the OK button
• If you want to remove the item from all category 1 categories, select the level 3 “None” category in
the list.

You can assign an item to a category 1, 2 and 3 category at the same time.

Previous: Adding items Next: Items - Master lists
2011/04/28 06:46

Item master lists
Master lists are standard lists of items you would supply to wards, clinics, etc. on a regular basis. Once set up, a master lists can be assigned to
customers or Virtual stores, and then used to support Stock Control including imprest orders. Master Lists are useful to stores which have a number of
customers or virtual stores that they supply whose lists of stock items are either identical or very similar.
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Choosing the Item > Show item master lists… menu item or clicking on the Show master lists icon
this window:

on the Item tab of the navigator displays

Adding (and importing) a master list
Click on the Add Master List icon and you are presented with this window:
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Description field: Enter the name of the master list here - this is the list name that everyone will see e.g. Health Posts - Standard List.
Note field: Add any note or information here that will help you and others understand what the list is for.
Automatically add new items to this master list checkbox: If you check this, any new items created, whether manually or during import, will be added
to the master list. This is a particularly helpful setting when you are using master lists to control the visibility of items in stores.
The Items tab shown in the screenshot shows the list of items on the master list. The In use by tab shows which customers the master list has been
assigned to (see below).
You then populate the list with the required items by clicking the Add Item icon:
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On entering the first few characters of the item to be ordered and pressing the Tab key, the (by now!) familiar list will appear from which the desired
item is selected by double clicking.
If the imprest system is used in your organisation, the quantity is entered in the Imprest Quantity field. If the imprest system is not being used, you
don't have to enter anything in this field.
If you want this list to determine the price of this item for customers using it, the price is entered in the Price field. If not, no entry is required in this
field.
In our example, a number of master lists have been created. A sample Health Posts - Standard List master list is shown below.

Sorting: Clicking on any of the column headings allows you to sort the list according to that heading; you also have the ability to click on an item in
the list, and drag it to a new position; once the list is sorted to meet your requirements, you can click on the Save Sort Order icon, and mSupply® will
retain the list in the order in which you have set it, and display it in that order next time it is accessed.
Copy to clipboard: The master list is copied to the clipboard when this button is clicked so that you can paste it into other applications on your
computer e.g. a word processor or spreadsheet application.

Import Item List
You can import a list of items created elsewhere e.g. an accounting application or a spreadsheet. This can save you a lot of time! The file to be
imported must be tab delimited text and must contain the item code, item name and imprest quantity (in that order) for each record. Records in the file
are, of course, separated by the end of line character. For example:
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code

item

imprest quantity

amo250t

amoxycillin 250mg tab

800

amo500t

amoxycillin 500mg tab

300

Note that:
• The item code must match an existing item code,
• The item name is for information purposes only and is not actually imported (you can leave a blank column in its place if you like)
• The imprest quantity is also optional and can be left blank (you would leave it blank if the master list is not going to be used for an imprest)
Clicking on the Import item list button takes you to a prompt:

after which you can select the file:
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And then the import preview dialogue box is displayed:

On this screen you use the Next and Previous buttons to move through the records and see what details will be imported for each. The First line
contains column headers tells mSupply whether to ignore the first record in the import file (checked = ignore first line of file). The first record in the
import file often contains headers describing the fields in each record, not actual data.
The Remove quote characters on import checkbox, if checked, tells mSupply® to strip all “ characters from the data. This is recommended. In fact,
this option can be selected anyway without detriment to the import.

The imported items are added to the master list, nothing is overwritten by the
import.

Clicking the Import now button executes the import with the settings you made and takes you back to the master list screen with the imported items
now showing in your master list.
The Cancel button also takes you back to the master list screen but, obviously, does not execute the import.
Editing imprest quantities or price: If you click once on the row you wish to edit, and then click on the imprest quantity or price, it becomes
editable. Enter the new value, and you can then use the <tab> key to advance to editing the next imprest quantity or price field.
The In use by tab: Under this tab you'll find the list of customers who have been assigned to this master group (i.e. are using this master list).

Deleting a master list
From the Item Master lists window, selecting the Delete Master List icon allows you to delete a list which is no longer required. This action has
significant consequences for any customers who are users of the list. So to prevent accidental deletion, this action cannot be completed until
any customers who are users of it have their association with it removed.

Duplicate a Master list
Should you wish to create a Master list which is very similar to an existing one, click on this icon, and a new Master list entitled ` Duplicate of ….. .' is
created; this can then be edited and renamed to suit your requirements.

Assigning a list to a customer
To assign a list to a customer, the customer's details need to be on screen; Choose Customer > Show customers , or using the Navigator, select Show
customers , fill in the appropriate details, and press Find, or just press Find, then double click the entry required on the Names list
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Once the desired customer's Edit Customer/Supplier window appears click on the Item Lists tab.

Buttons in the Item Lists section:
• Add Master list: From the list of master lists which have been created, double click on the name of the desired list.
• Add Local list: This serves to cater, for example, for the situation where a patient with a rare disease requiring medicines not normally
stocked, collects these medicines from the local Health Centre. In this example, a patient attending London Dispensary requires
tetracosactide, and so a local list (London local) has been created with a single entry, Griseofulvin

• Copy from Master list: This feature would normally be used where a specific customer's drug needs differ to a minor degree from the
drugs listed in one of the Master lists, or under the Imprest system where the stock levels are different from those defined on a Master list;
first click on the Add Master list icon, select the appropriate Master list, add it, and it will appear under List name. With that list
highlighted, click on the Copy from Master icon, and a new entry appears displaying the name of the Master list followed by `(local)'. The
Master list may then be deleted, and the local copy modified and renamed as appropriate.
• Delete list: Two distinct functions are performed, depending on whether a Master list or a Local list is selected
1. if applied to a Master list of which the present customer is a member, it has the effect of removing that list from this customer's Favourites.
The Master list remains in mSupply.
2. If applied to a Local list, it allows deletion of the list, but only after all the items have been removed from the list by making use of the
Delete Lines feature.
• Add item: Once you have selected a list, this allows you to add an item to that list.
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You can only add items to a local list. If there are no buttons visible above the item
list, it is because you don't have any local lists for this customer (or if you do, you
haven't clicked on that local list to highlight it first)

When operating multiple stores in mSupply, you can sometimes have difficulty
with item visibility: an item might be on a master list for a particular customer but
if the item is not visible in the store you are logged into when using the list, then
the item will not appear.
A temporary fix can be achieved by setting the item visibility in a particular store
to match an item list - refer the Visibility tab. This is only a temporary fix. If you
add a new item to a master list, the visibility of that item in the stores using that
list will not be updated.
To avoid this problem, you can set a preference (see here for details) to have the
visibility of items on lists altered to match the visibility of the name for which the
lists are made.

• Printing:
◦ Before printing, choose either Sort by Group or Sort by department
◦ Choose whether to send to Excel® or your printer.
◦ Click Generate

Buttons in the Items section:

These icons appear only when a local list is selected; for obvious reasons, Master
lists cannot be edited here.

• Add Item Self explanatory! Allows you to add required lines to the local list.
• Delete Item(s) Lines may be deleted, either singly or, by selecting multiple lines, they may be deleted together.
• Save sort order Allows you to save the list according to how you have sorted it here.

Information button
Edit list properties
The attributes of a list are set by double clicking on the name of the list. This window is displayed:
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The options should be checked as appropriate:
• Imprest: If checked, this list will populate an imprest customer stock history created for the customer.
• Customer stock history: If checked, this list will populate a customer stock history created for the customer.
• Ordering list for web: Means that the list represents all items that the customer can order using the mSupply Customer interface. If a
customer who uses the customer interface for ordering stock does not have a list with this option checked, they will not be able to order any
items.
• Price list: Means that the prices on this list will be used for these items when they are being distributed to this customer on a customer
invoice. The price on this list will override any sell prices that individual stock lines have. Only one list can have this option checked for
each customer.

Using Master Lists to control Item visibility in Stores
You can use master lists to control item visibility in each store, by checking the Items preference box 'Automatically update item visibility in all stores
to match master lists used by each store'. This will make the items visible in each individual store match exactly the items included in the master list(s)
selected for that store.
Example
There are 100 satellite stores, and you want all of them to have the same item visibility:
1. Create a master list and add some items
2. Go to each store and make sure that the master list is selected
3. Turn on the preference 'Automatically update item visibility in all stores to match master lists used by each store'

This preference can drastically affect item visibility.
A temporary list is created for each store containing items that cannot be removed
from visibility when the master list preference is activated.
Do not turn it on unless you know what you are doing! It affects ALL stores in the
system.

Now whenever an item is added or removed from this master list, the preference will automatically update the visibility for all of the 100 stores, so
that the items visible for each individual store matches the items included in the master list.
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• Adding an item to a master list will automatically add that item to visibility for all stores using that master list
• Deleting an item from a master list will automatically remove that item from visibility for each store using that master list, given it is not
included in another master list in use by each store respectively.

When deleting items from a master list, mSupply will first check all stores using
the master list to make sure it is safe to remove that item. It is unsafe if the item
has stock on hand and isn't included in another master list for any stores using
master list you are editing.

To create a large master list, you can export all items to be added to mSupply, and then import them to the master list - see above.
Previous: Item categories Next: Item locations
2011/04/28 06:14

·

Locations and location types
Keeping track of where items are in your store is an important part of good warehouse practice. You don't want to have to go hunting through your
whole store for an item, wasting time and energy when mSupply can tell you exactly where it is!
Locations in mSupply are the places you store items. Locations can have types (e.g. normal, cold, bulk…) to help you categorise them, you can define
parent/child relationships between locations to help you manage them effectively and you can even create a line drawing plan of the location to
pictorially show the layout of your store.

If you use location types it will help you if they are defined before the locations that belong to them otherwise they won't be
available to select when defining a location - and you'll have to go back later and edit the locations. What a waste of time! So
this section explains location types first and goes on to explain about locations.

Location types
Location types give you the ability to categorise your locations. They can be used for reporting on a group of locations, but also to restrict the
locations that can be used for a particular item. For setting the location type for an item, see Item basics
Choose Item > Show location types to define or show a list of available location types.
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The window that appears allows you to define the criteria for the various types of location in your store - e.g. the permitted temperature range, whether
location must be dark, etc.

Adding a location type
Click on New , and the window that appears allows you to enter a name for the storage type, and the permitted conditions pertaining to that storage
type.:

In the above example, a storage type “Refrigerator” has been defined, the permitted range of temperature being 2o C - 8o C.
Having defined your storage types, the Show location types window might look like this:
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It is worth emphasising that the list does not show the actual store locations, but the types of locations.

Editing a location type
Should you wish to edit the details of any location type, double click on it in the list and change the details in the window which appears.

Locations
Viewing locations
To view the locations you have defined choose Item > Show locations and you will see a list of location codes and descriptions:
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From this window you can view, edit and remove locations and their details - this is the 'location management' window. Here are the various functions
of the window:
New location icon: Click this to add a location (see 'Adding a location' below).
Print icon: Click this to print the list of locations displayed in the window (see 'Printing the locations list' below).
Show warehouse icon: Click this to see a graphical representation of your warehouse. This representation shows all the layouts of the individual
locations that you have created in the layout tab when adding a location (see 'Adding a location' below).
Search location: Enter some text in the text field and the list is updated as you type to show only the locations whose code or description starts with
the text you have entered.
view and edit a location's details: Double click on a location in the list - see 'Viewing and editing a location' below. All the details are editable. See
the 'Adding a location' section below for the meaning of the individual details.

Adding a location
Before you can associate an item with a specific location (e.g. Shelf D4, Refrigerator 2, etc.) you must define the locations in mSupply. To add a new
location, click on the New location icon in the View locations window shown above. You will be shown the following window, where you can enter
the details of the new location:
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Code: This is how you refer to the location in mSupply and, for example, what you will select when you set an item's location.
Description: This is a description of the location e.g. “Top shelf of refrigerator 3” or “3rd shelf up in rack E” to help you identify it or remember
something important about it. You will only see this in the list of locations shown above.

General tab
Under this tab, you enter the location's main details:
Location Type: Select one from the location types you have already entered (see Location types section above).
• Each item can have a Restricted to Location type set, and then you will only be able to store that item in a location with that type:
• You can set the location type for an item by viewing the item's general tab, and choosing the type from the drop-down list (Items/Show
Items/Find Items - double click applicable item):

Parent: Select one from the locations already entered in mSupply. This is the location to which the location you are adding belongs. This is for
descriptive purposes and does not have any functional effect in mSupply, except when viewing the warehouse layout.
Summary: Checking this means that the location is a summary location only and cannot be used for storing items. This is normally checked for all
locations that are parents of others.
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Comment: You can note anything you need to remember or indicate to others in here. It is only visible if you view the location's details (Item > Show
locations, double click on the item in the list) later.
Total volume: The total volume of goods that you can store at the location. Volumes are stored in cubic metres [m3] but other volumes e.g. litres (l)
may also be entered, provided the appropriate unit is entered following the number e.g. 5l for 5 litres. See the entry Volume per pack in item_edit__general_options. Note that whatever you enter will be converted to and displayed in m3.
Knowing the volume of a location is important if, for example, you are replenishing your stock of vaccines, and you need to know if there is enough
space available in the refrigerator in which you store vaccines to accommodate a new order (obviously, you would also need to know the volume of
the vaccines that you are ordering).
Priority: This is used when printing a picking slip. Setting a priority for a location will override the default alphabetical ordering of shelf locations in
a picking list. A location with a lower priority number will be printed before a location with a higher priority number. All locations with 0 priority are
counted as having no priority and will be printed, in alphabetical order, after all locations with a priority.
Hold: If this is checked then goods in this location cannot be issued to customers. Goods can be put into the location but they cannot be issued from
that location. This is particularly useful if:
• The stock needs to be kept from being issued until some inspection / approval (e.g. quarantine).
• The stock is a bulk quantity with the same expiry date as another stock line in another location from which you want stock issued. You can
use this feature to force mSupply to always suggest issuing stock of this item from the 'issue' location rather than this 'bulk' location.
If you want to make the stock in an On hold location available for issue, then there are two options:
Move the stock in that location to another location that is not On hold Remove the On hold status of the location here.

Layout tab
Under this tab you can create a graphical plan view of the location in your store. This is useful for helping people to quickly locate any given location
and presenting a graphical layout of your whole store. Locations are drawn as either rectangles (for which you enter the top left coordinate and the
lengths of the 2 sides) or polygons (for which you enter a number of sequential coordinates which are connected with straight lines). Here's what the
various input items mean for a rectangle, the rest we'll show you by the way of an example:

So, as an example, the coordinates are entered as above in the appropriate boxes, then the Draw button is clicked to produce the following display
under the layout tab:
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This has created a picture of location main1. This is the whole store or warehouse. You can't see the settings but this location will have no parent and
will have its Summary checkbox checked (no items can be located here - it's just a summary location for descriptive purposes).
In our imaginary warehouse we have a set of open racking which is 'L'-shaped. We want to draw it in the warehouse so we create the location, call it
'sub1' and set its parent as Main1. If this set of shelves also has other locations in it we would also check its Summary checkbox.

To draw this location we click on the Layout tab and select Polygon as the object type. Click on the Add button to add a coordinate and then overwrite
the zeros in the X and Y columns to give the correct coordinates. If you make a mistake, click on the set of coordinates in the list that is wrong and
click on the Delete button to delete it. When all six co-ordinates have been entered, click on the Draw button to produce the layout displayed below:
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You can do this same thing for all locations so that anyone can easily locate them in your store.

Viewing and Editing a location
As you already know from above, to view all the locations you have defined select Item > Show locations. To view and edit the details of a particular
location, double click on that location in this list. You will be shown the following window:

General tab
This is the same as the General tab for adding a location (see the 'Adding a location' section above) except that its details are filled in with the details
of the location you selected. To edit the details simply overwrite the current value with a new value or select another option as appropriate.
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Layout tab
This is the same as the Layout tab for adding a location (see the 'Adding a location' section above) except that the current graphical representation of
the location is displayed (if you've already created one). You can edit the plan view of the location if required by changing, adding or deleting coordinates.

Stock Tab
The Stock tab shows a list of existing stock lines stored in that particular location. A lot of information regarding the stock is displayed in the list and,
as with most mSupply lists, it can be sorted on any column by clicking on the column heading:

If you want to know more information about any particular batch in the list, simply double click it and you'll be shown another window with lots of
information about the batch, arranged in four tabs:
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Deleting a location
To delete location you select Item > Show locations to view the list of locations, double click on the location you want to delete (as if you wanted to
view all its details) and then click on the Delete button at the bottom of the window. If you confirm the deletion, the location is removed.

Merging two locations
If you want to remove a location from further use in mSupply (for example, you might have accidentally double-entered a location) this command can
be used.
When you Choose Item > Merge two locations , this window is shown:

Use extreme caution! This operation will affect all historical records of the
location you delete. They will be moved to the location you are keeping. The
operation can only be undone by reverting to a backup copy of your data file.

In the window displayed enter the location to keep, and then the location to merge. When you have checked that the information is correct, click the
OK button.
Previous: Item master lists Next: Manufactured items
2011/04/28 06:55

·

Building (manufacturing) items
mSupply provides for a mechanism to manufacture (build) a new item from two or more existing items. A build is a way of recording items you have
manufactured. That is, raw materials that are in your stock are used (taken out of stock), and a new stock item is created.

Show builds...
From the Items page of the Navigator, click on the Show Builds button:
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You will be shown the standard find window to enter either the number of recent builds to display, or a particular build number.

You will then be shown a list as shown below:
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From this list you should select the required build by double-clicking on it.
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New build...
From the Items page of the Navigator, click on the New Builds button:
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On choosing this menu item you are shown the build entry window:
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If you have restricted access to builds, you will not be able to see cost prices or the
profit summary window at the bottom.

The build window has two parts:
• The top part of the window records the details of the item to be built
• The lower part lists ingredients that are used in the manufacture of the product.
click the Item to build or to edit icon

and in the next window enter the name of the product you're manufacturing (Syrup in our example)
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and this window is displayed where you should complete the appropriate fields:

Adding ingredients manually
Note that ingredients can be added automatically from the Bill of materials tab. If you regularly build the same item, we recommend that you enter a
Bill of Materials for the item being built, and use the method outlined under the Using a Bill of Materials heading below.
First, if you are entering a projected build (one that you expect to perform in the future), check the This is a projected build check box. If checked, all
items added will be placeholder lines rather than actual stock. Doing this allows you to enter your manufacturing schedule in advance of ordering raw
materials. The schedule will be taken into account when ordering to ensure that you will have enough materials in stock when the time comes to
manufacture.
• To add a new ingredient, click the New ingredient button. You will be shown the standard window for issuing goods from stock:

•
•
•
•

Enter ingredients just as you would for entering a customer invoice.
Once you have finished entering ingredient lines, click OK to return to the main window.
If you wish to edit a line, double-click it, and change the details.
To delete a line, double-click it, set it's quantity to zero, then click the OK button.
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Adding the item to be built.
• To add the item to build, click Item to build or edit button. You will be shown the Add/edit supplier invoice line window below for
receiving goods.

•
•
•
•
•

The cost price for the item is automatically calculated for you. You may enter the margin or the selling price as you prefer.
Once you have entered the item to build, click OK to return to the main window.
If you wish to edit the item, simply double-click inside the “item to build” rectangle.
At the bottom right of the window in Summary section is a summary of the cost, margin and selling prices for the build.
Once you are satisfied with the details, click OK to enter the build into the system. You will be asked if you want to enter the details into
stock. If you say yes , the newly created item will immediately be available for issuing to customers. If you click later then the stock will
not be available until you open the build window at a later date and enter it into stock.
• Note that the ingredients used in a build are considered to have been “sold” for re-ordering purposes, and will be counted in your usage.

Finishing build entry
• Understanding build status codes enables you to know what stage each build is at. The codes are the same as for other transactions.

Each build transaction has a status code:
Code

Meaning

nw

A new build is being entered, but has not been saved.

sg

“Suggested”. A build has been entered, but has not yet been confirmed.
If stock lines have been entered, raw material stock is reduced so
that it is no longer available for other invoices, but the new item is not yet entered into stock.
You should leave builds with this status while manufactured items are “in process” ,
or if it is a projected build for a future date.

cn

“Confirmed.” The item to build has been entered into stock.
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Code

Meaning

fn

“finalised.” The build can no longer be edited

• When you click the OK button you may be asked if you want to enter the build into stock. You should only do so once the manufacturing
and Quality Assurance (QA) process is complete. You will not be asked this question if there are any placeholder lines (those with a batch
of “none”) entered as an ingredient. Such builds are presumed to be for projected manufacturing, and are kept with status sg automatically.
• To finalize builds, choose File > Finalize builds when the splash screen is showing.

Converting projected builds into an actual build.
• Once your manufacturing of a projected build is about to take place, choose Item > Show builds … to locate the build you want to edit.
• For each line whose batch is equal to “none” (a placeholder line) you will have to double-click it and choose an actual stock line from the
item issue window (either by entering the line number or double-clicking the line you wish to use). Once you have done this, the stock you
have chosen will be reserved, and manufacturing can take place.
• mSupply® calculates the number of items that will result from your build, and clicking on the Print labels icon prints the correct number of
labels.

Using a Bill of Materials
A Bill of materials can be thought of as a “recipe” or “formula” for building an item. It records the ingredients, and the quantity of each required to
make the finished product. You should create a bill of materials for an item before you come to this screen. This is done in an item's Item details
window: see here for details. Screenshots in this section are using Simple Syrup as an example, and for this product a Bill of Materials has already
been created.
When you click the “Bill of materials” tab in the build window, this window appears:
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First you need to choose the item to be manufactured:

in the next window you need to specify the quantity to be manufactured and other details:
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When you click OK, you are returned to the New Build window, and when you click the Add Bill of Materials Button, a window appears where you
can confirm or cancel the quantity to be manufactured:

Assuming the quantity is correct, click OK, and you are returned to the New Build window, where the open tab is the Bill of materials tab. Click the
Add Bill of Materials button, and the details on the Bill of Materials according to the formula previously entered for Simple Syrup is displayed:
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Now click the Ingredients tab, where the ingredients are listed, but no stock is attached to any item - they are placeholder items (displayed in red).
This is done as mSupply® cannot take into account all the factors that go into choosing an appropriate batch to use for each manufacturing run (The
expiry, amount on hand, etc). click each line in turn to select the quantity and batch number of available stock lines for each ingredient. Note that there
is a button displayed Re-distribute all. Clicking this button will take the “total quantity issued” figure and re-distribute it over the available batches,
making it easy to move from using a placeholder line to issuing actual stock. The ingredient is repeated in black with appropriate details displayed. At
this time (or later) you can also adjust the amount issued to reflect actual issued quantities and the actual batches of raw materials used, as opposed to
the theoretical quantities that are initially entered.

If you are manufacturing the product immediately, the status of the build transaction should be changed to Confirmed on completion of the
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manufacturing process.

Print options:
It's possible to print either a Pick list, detailing the ingredients and quantities, or a summary of the manufactured product. To achieve this, check the
print icon in the bottom right hand corner of the window and click the OK button. The printing options window will appear and you can choose which
document to print:

Calculate Yields button: This button (on the Bill of materials tab) compares the actual quantities issued and the actual final quantity manufactured
with the theoretical amounts that should have been used and made. This allows you to monitor production efficiency. Use the Print yield report
button to print the yield information if required.
Previous: Locations and Location types Next: Merging items
2011/04/15 05:14

·

Merging two items
If an item has inadvertently been added twice, with slightly different descriptions, here is your safety line! Choose Merge two items… from the Item
menu. This window is displayed:
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In the Item to keep box type the first few characters of the item you want to keep and press the Tab key. Then select the correct item from the list
displayed (if only 1 item matches what you have typed it will be put in the box for you without the need for selection).
Now do the same in the Item to merge - will be deleted box. The item you select here will be completely replaced with the one in the Item to keep box.
Note that when selecting these items you are selecting from all of the items in your datafile, not just those visible in the store you are logged-in to.
When you are ready, click on the OK button. BUT BEWARE:

If you merge two items that are, in fact, different, you will really mess things up. There is no undo function for this operation, so
you will be begging us to help you fix the mess, and we charge a special penal rate for people who do things after having been
warned ;-)

Notes:
1. Merging replaces all the instances of the item selected to delete with the item selected to keep throughout everywhere your datafile.
2. Merging items affects all historical records except for item names on finalised transactions, which will retain the original name for safety
reasons.
3. Items that either have a bill of materials or are used in a bill of materials cannot be used for the item to delete/merge. If you try to do so,
you will be warned.
4. If the item you are merging/deleting has stocktake lines associated with it, these stocktake lines will be deleted, as you can't stocktake a
non-existent item (except if you're Harry Potter).
Previous: Building (Manufacturing) Items Next: Ad hoc items
2011/04/28 11:10

·

Ad hoc items
From the Item menu, choose Ad Hoc items…

This feature requires activation in Preferences > Invoices 1

mSupply® defines Ad Hoc items as items that you don't keep in stock, and that you never will keep in stock. An example of an Ad Hoc item is a
specialised item of diagnostic equipment which you would purchase on one occasion only. When a customer orders an item that you decide will be a
“one-off” purchase, you can enter it as an Ad Hoc item.
Ad Hoc items differ from non-stock items in only one respect; they are purchased once. Non-stock items are items which, although they do not feature
in your stock list, may be purchased with some degree of regularity.
The following diagram outlines the work flow for Ad Hoc items:

203

mSupply user guide July 2018

When you choose Items > Ad Hoc items, the following window is displayed:
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From this window you can view Ad Hoc items, add new items, delete items and edit existing items.

The "Show" Drop-down list
This drop-down list allows you to view Ad Hoc items by their status. Ad Hoc items can have the following status codes:
Status code

Meaning

== un ==

The item has not yet been assigned to a supplier- think of this as your “to-do” list

== as ==

The item has been assigned to a supplier, but has not been placed on a Purchase Order. These items also
need action.

== po ==

The item has been added to a Purchase Order, but the goods have not arrived.

== fn ==

The item has arrived from a supplier and been invoiced to the customer

The "Name" field
Enter part of a customer or supplier name in this field and press Tab to show a list of matching names. Choosing a supplier will show items assigned to
that supplier. Choosing a customer will show items supplied or to be supplied to that customer.
Once you have chosen a name you can fine-tune the list displayed for that name.

The "New" button
Clicking the “new” button displays this window:
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From this window you can add an item name, the name of the customer, then name of the supplier, the quantity to order, and add a comment.
When the customer orders an item, you may not know who the supplier is. You can just leave the supplier name blank.

Editing an Ad Hoc item
To edit an item, double-click it in the list to display the item details, and a window Edit Ad hoc item, almost identical to the Add Ad hoc item :,
appears where you can edit the required details.

Adding Ad Hoc items to a Purchase Order
When you are making a Purchase Order for a particular supplier, you can click on the Ad Hoc items Tab to view a list of Ad Hoc items you have
assigned to that supplier, allowing you to add them to the Purchase Order. More information is available here - the_ad_hoc_items_tab
Previous: Merging two items Next: Non stock items
2011/04/18 10:34

·

Manage drug interaction groups
This feature is chosen from the Item menu
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The examples given in this section are included only for the purpose of
familiarising the user with the interactions feature of mSupply and how to use it.
Use of this feature is the responsibility of the user, and Sustainable Solutions®
bears no liability whatsoever for any consequence of inappropriate use.

Drug interaction groups allow you to specify groups of items that interact with each other, and then prepare a warning message to be displayed if these
items from interacting groups are issued to the same patient.
You can set up interactions in store mode, but warnings will only appear in dispensary mode.
To use this feature, it must be set up, and these are the steps:
1. Choose a way of defining interaction groups. A number of systems are in use or are under development, and the internet is a useful
resource for further investigation.
2. Define which items are in which groups.
3. Add interactions between groups.
Let's look at each of those steps in turn

Defining interaction groups
Choose Items> Drug interaction groups … Until you have set up some groups, the list will be blank; a number of groups have been set up for the
purposes of this guide, shown below right:

Click the New Group button to add a new group, or double-click an entry to edit it.
Double clicking on NSAID displays this window:
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The window has two tabs.
The Items tab shows a list of items that have been assigned to the group.

Define which items are in which groups
You assign an item to a group by viewing the item details (Choose Items > Show items ), and setting interaction group from a drop-down list.

Add interactions between groups
The Interactions tab shows a list of groups that the current group interacts with.

This tab has two buttons allowing you to add or delete a drug interaction. (To delete an interaction click on the line you wish to delete before clicking
the Delete interaction button).
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To edit an interaction double-click on the one to be edited. This window appears::

You choose the group that affects the current group, and then enter details about the interaction by choosing from the drop-down lists.
The choices available are:
• Type of interaction
◦ Inhibits (I)
◦ Augments (A)
◦ No effect (N)
◦ Conflicting evidence (C)
• Clinical Significance
◦ Minor (1)
◦ Moderate (2)
◦ Major (3)
◦ Unknown (?)
• Quality of evidence
◦ Poor (P)
◦ Fair (F)
◦ Good (G)
◦ Unknown (?)
You can enter a message to be displayed when an interaction occurs, and any notes you may want to record. These fields are optional.
When you are issuing items in dispensary mode, in order to display a warning:
• the Alert when there are drug interactions checkbox must be checked in File > Preferences > Drug Interactions. The warning as
shown will be displayed if the patient is being issued with interacting items:
• Number of days of patient history.. must be set. We recommend setting it to 180, so that any items dispensed in the last six months that
interact with the item you are currently dispensing are found.
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Previous: Non-stock items Next: Managing Item access
2011/04/26 05:11

·

Managing item access
Introduction
Item departments are a mechanism by which you can restrict item availability to certain customers only.

Item departments are a bit complicated. Here's what you need to remember:
• Each customer can be a member of only one group.
• Each item can be a 'direct' member of only one department. However, a
department can be a member of another department, so an item can, in
effect, be a member of more than one department
• Each group can have access to items from multiple departments.

The Activate restricted item access by customer group option must be turned on
in Preferences>Invoices2 before this option to work.

• Here is a summary of how department groups affect whether or not an item can be issued.
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• When you attempt to issue stock to a customer whose group does not have access to the department of the item you are issuing, either a
warning will be displayed or mSupply® will not allow you to issue the stock - depending on how your preferences are set.
• Items that are not in any department can be issued to any customer
• Items that are members of a department can not be issued to any Customers that are not members of a group.

Creating and editing item departments
Choose Show departments from the Item menu displays the Edit departments… window. This is where you are able to create and edit item
departments. Once you have created departments the window might appear something like this, and you are now ready to assign items to a
department:
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View item departments
Taking as an example the department Anti anaemic tablets, the items in the department are shown by clicking Show item departments on the Item
menu, and then double clicking on the Anti anaemic tablets department:

• Each department can have any number and combination of items and
departments in it.

Setting up access from customer groups to item departments
• From the Item menu, choose Manage item access…, and this window is displayed:

• The left hand list shows the available departments
• The right hand list shows the customer groups that presently have access to the department which is highlighted on the left hand side.
• The example shown identifies the four customer groups which are linked to the Anti-anaemic item department:

212

mSupply user guide July 2018

• The icons on the right side allow you to add and/or remove groups that have access to the highlighted department.
• Clicking the Add a new relationship button shows a list of groups you can add:

• Double-click (or click and then click OK) to add a group to the current department. You will be given a warning if you try to add the same
group twice.

Show groups...
Customer groups can be used to group customers (or suppliers) together for reporting purposes, and also to set up an item restrictions scheme,
allowing some items to be issued only to certain customers.
An explanation of how to set up a restriction scheme is in Managing Item access.
The groups window allows you to set up group names:
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• Click the New group button to add a new group.
• Double-click an entry to edit its name:

• You can enter or edit the group name in the top field.
• The list displays all names which are members of this group.
• Click the Delete button to delete a group. You can only delete groups that have no names as members. You can remove group members
from the Groups tab of the name viewing window (From the Customer menu, choose Show Customers and find the required customer in
the usual way.)
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• The drop down list displays the group to which this customer belongs, and to remove the customer, make sure none is selected from the
drop down list; to assign the customer to a different group, highlight the new group in the drop down list.
• Click OK to leave the window.

Departments
Overview: A manufacturer might create departments for raw materials, packing materials, and quality control reagents. A drug store or hospital might
create departments according to dose form or according to pharmacological classification, etc.
From the Item menu, choose Show departments …; you are shown a list of departments:

By default the list displays in alphabetic order; clicking on Departments toggles between alphabetic order and reverse alphabetic order; you may also
drag and drop individual departments to any position in the list to suit your own requirements, and on clicking OK you will be asked whether or not
you wish to save the list in the order you have specified.
To add a new department, click the New dept button.
To edit a department, double-click the department you want to edit. You are shown a window allowing you to edit the department name:
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The radio buttons allow you to choose what will happen when you attempt to issue an item to a customer who is not a member of a linked group.
Either the user can be warned or the issue can be disallowed. This only applies if you have Activate restricted item access by customer group
turned on in the Preferences - otherwise you can ignore this setting.
The Items tab displays a list of items that are members of the group you are viewing:

To delete a department
Double-click it to display the entry window, then click the Delete button. Note that you can not delete a department that has item members. You will
be warned if you try to do this. To delete a department with Items, click the items tab and note the items that are members, then edit those items (using
the Items > Show items … menu command) and set their departments to either none or a different department. You will then be able to delete the
department.
Previous: Managing drug interaction groups Next: Prices in mSupply
2011/04/28 07:04
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Prices in mSupply
The price you charge customers for your goods is, of course, very important. mSupply provides you with several different ways to set the selling price
of your goods. Here they are:
• Each supplier has a margin field that determines how much to add on to the cost price when buying from that supplier
• Each item has a margin field that determines how much to add on to the cost price when buying that item
• There is a preference ( File > Preferences > Invoices 1 ) which controls how these 2 margins relate:
◦
◦ If this preference is ticked then the item margin will be used instead of the supplier margin. If it is unchecked then the supplier
margin will be used instead of the item margin.
• You can set custom margins for each customer group ( File > Preferences > Invoices 2 )
◦
• You can fix the item price under the General tab in the Item details window.

◦
◦ Note that setting an item price here will set the price of new stock as you receive. It will not affect the price of existing stockyou can change existing prices if you have permission to do so by viewing an item and going to the “Stock” tab.
• You can set item prices when setting up a data file by importing an item list. (see below)

Per customer pricing
Alternatively, individual prices can be set for each customer. This can be done in the Edit Customer/Supplier window which you can find by:
•
•
•
•
•

going to the Customer tab of the Navigator
click on the Show Customers button
find the customer you wish to customise prices for
double click the customer line
choose the Item Lists tab (see below)
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To customise the pricing, add a list to the Favourite Lists column (either by clicking Add master list, Add local list or Copy from master list) or
edit an existing list by double-clicking on it. Check the Price list checkbox from the window that comes up and any other checkboxes that you require.

• You only need the Price list check box marked to customise prices
• Only one list per customer can be price customised

Make sure the list is selected and then go to the Items section of the window. Enter the corresponding prices that you would like to assign to each item
for that customer by clicking on the item and then clicking on the price (“0” by default). You can also add items to the list by clicking Add item and
entering the item name and the price in the window that appears. The customer will now be charged the prices set in the list instead of any other price
set.
Previous: Managing Item Access Next: Repacking items
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2011/04/12 05:30

·

Repacking items
Creating a New repack
The command Items > New repack will display a window where you can repack a particular item into smaller or larger packs and/or move all or part
of a batch to another location. It is a more complex version of the split functionality and will allow you to handle several batches at a time.

There are 4 steps for creating a repack. The window is numbered from top to bottom to help you follow the correct steps:
1. Choose item to be repacked: At [1.] type the first characters or code of the item to be repacked, then press the Tab key. If only one item
text or code matches your entry, it will be filled in automatically, otherwise you will be shown a standard choice list from where you can
select the item.
2. Choose a batch: At [2.] double click a line to choose the batch; for repacking, batches cannot be mixed, and a single batch must be used.
3. Quantity to be repacked: At [3.] enter the quantity which is to be repacked; the pack size field is automatically completed.
4. Details of new line(s) - i.e. the repacks: At [4.] click the New line icon to bring up this window calling for the details of the repacks, and
enter the details as appropriate.
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Note that repacks of different sizes may be created at this stage - e.g. 5,000 Paracetamol tablets may be repacked into 40×50 and 30×100. The Sell
price, the Batch number and the New Location are automatically completed, but all these fields may be edited as required.
Not infrequently, because some tablets may be broken, for example, the total quantity of the item re-packed will be less than the quantity selected for
re-packing at [2.]. To maintain the accuracy of your stock record, an inventory stock adjustment should be performed - see the stock adjustments
section here for this.

Printing a repack

While the status of the repacking transaction is suggested (sg), checking the box beside the print icon will produce a picking slip of the number and
size of packs of the original item; once the status is finalised, the same operation will give you the choice to produce a detailed record of the re-packs
or a stock movement report (for when you're moving stock - perfect for giving to the people physically moving the stock in the warehouse because it
shows what is to be moved to which location).
On clicking the OK button, a transaction is created showing the original line taken out of stock, and the new line(s) put into stock. The total value of
the transaction is always zero.

You cannot edit a repack transaction after you have clicked the OK button, so get
it right the first time! (Tip: You can always “re-repack” an item to adjust a mistake
however!)

Deleting a repack
If you click on the Delete button, then the repack will be deleted. Only repacks whose status is “sg” (suggested) or “nw” (new) can be deleted.
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Viewing repacks
Repacked items can be viewed in the normal transaction list window - (Item > Show repacks) and select Repacks from the drop down list

Note that repacks created with versions of mSupply® prior to v1.4 will not show up using the “recent transactions” section of the window- you will
have to enter the number directly.

Previous: Prices in mSupply Next: Show items with stock
2011/04/15 05:15

·

Show items with stock
This can be accessed by choosing Show items with stock from the Item menu or by clicking on the Stock icon
Either of these options will display this window:

on the Item tab of the Navigator.
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By default all stock is listed, and where the stock of an item is present in different batch numbers, each one is displayed.
Just like nearly all the other tables of information in mSupply, you can order the information by any column by simply clicking on the column header.
Reverse the sort order by clicking on the same column again.

Customising the list
You can choose the columns displayed by clicking on the Customise button to display this window:
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Listed under Available are the columns not presently displayed, and under Chosen are the columns presently displayed. Changes are made by
highlighting your chosen column on this window, and moving it using the buttons in the centre to add or remove it from the display.
You can drag the items in the Chosen column into the order of your choice to change the order they are displayed in the list (top of the list is displayed
on the furthest left, bottom of the list is displayed the furthest right).

Printing/exporting the contents of the table
You can export the stock information on the items displayed in the table by clicking on the Export to Excel button. Only the items displayed in the
table will be exported and a fixed set of columns will be exported - this set is not affected by any changes you make to the displayed columns using the
Customise button described above.
In your spreadsheet application you can manipulate or print the data as you please.

Filtering the list
Entering the item name or code in the box will filter the list; entering the first few characters of an item name will display only those items which
begin with those letters (or numbers).
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To display a specific item, either the item code or the full name should be entered.

To find all items containing ran enter @ran which will display all items which
include the characters entered, not only those items where the characters entered
are at the start of the item name - e.g. this will not only display any Ranitidine in
stock, but will also display `Pyrantel', `Nitrofurantoin', Propranolol', etc..

Filtering by location
Alternatively you can filter by location. Leave the first search box blank and enter a location into the second search box. This will show only the items
with that location.
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Even more specific
To view an even more specific selection of stock you can filter by both item name and location. By entering your criteria into both boxes, only the
stock which matches your specified name and location will appear.
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Previous: Repacking Items Next: Splitting a batch
2011/05/11 10:24

·

Stocktakes
General
There are two main types of stocktakes.

A rolling stocktake
A rolling stocktake means counting a small number of items at a time, ensuring that your overall stock is counted on a consistent basis. You may select
different locations, stock groups, types, suppliers, etc to stocktake a various times.

A full stocktake
All items are counted at one time.
Traditionally, during a full stocktake, the store is closed, and no transactions may take place until the exercise is completed.
The inconvenience caused by closure of the store varies from minor to significant. The benefit of using mSupply's stocktake module, while requiring
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that the store is closed while the physical stock check is in progress, is that the store may be opened immediately after the physical count is completed.
Entry of the adjusted figures into mSupply® may be made at any convenient time over the next few days.

Having said that normal operation can occur immediately after the stocktake, it is
important to note that:
• mSupply will not allow stock that is on a Customer Invoice with status
= “sg” to be taken out of stock by any other transaction process,
including an inventory adjustment flowing from a stocktake - refer
Creating inventory adjustments.
• It is therefore highly recommended to process (take the stock off the
shelves) and confirm any Customer Invoices with status = “sg” before
doing a stocktake - refer Issuing Goods to a Customer (Customer
Invoices), Confirming an invoice, and
• Process the inventory adjustments from the stocktake as soon as
possible after the physical count - refer Creating inventory adjustments

A stocktake makes a list of your stock, providing you with a 'snapshot' of your stock at a point in time. mSupply® enables you to automatically create
custom printed lists of your stock items from which you and your staff can do the physical stocktake. The items included can be customised to focus
on particular location(s), particular items, or your entire store.
The default list produced (i.e. the one where you don't change any settings) will:
• be in alphabetical order
• omit items whose stock level is zero
Lines on a stocktake may be edited provided the user's permissions are appropriately set. [File > Edit user > Permissions]
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As of version 3.1 mSupply also has a web stocktake module, that allows entering
stocktake results from a laptop or tablet on the warehouse floor.

Displaying stocktakes already performed
Select Show Stocktakes… from the Items menu to display any stocktakes already created or performed. This displays the following screen:

The Show: filter allows you to choose which stocktakes are displayed in the list. Options are:
•
•
•
•

All: shows all stocktakes in the current store with any status for all time. Could be many of them!
Current: selected by default when the window is displayed and shows all stocktakes with a status of Suggested (sg).
This year: shows all stocktakes of any status that have been created in the current year.
Last year: shows all stocktakes of any status that were created in the year before the current one.

There is little point in keeping old stocktakes with status = “sg”, especially if you
are about to create a new stocktake containing the same items. If time has passed
since the stocktake was created, then the snapshot and actual quantities are almost
certainly incorrect. For good housekeeping reasons, it is good to delete old
“suggested” stocktakes (status = “sg”).
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Creating a new stocktake
After viewing the current stocktakes, click on the New stock take icon, and the following window will appear:

Choose the items to be included
You can produce a stocktake for all items in your store by clicking OK without entering any criteria. If you want to narrow the items your are
stocktaking, you can do this in a number of ways (note that, whatever you do, ad-hoc or non-stock items will never be included in a stocktake):
• Search for items by Donor (e.g.items that have been donated by an organisation) NB. this filter needs to be set in Preferences:Invoice
Preferences.
• Search for items by some criteria (item name, code, category).
• Search by actual shelf location.
• Search for items whose expiry is before a particular date. This allows you to easily remove all expired items from stock.
• Select a number of items randomly chosen by mSupply.
The two drop-down lists allow you to customise the stocktake list you are producing, while the filter allows you to specify a particular location
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To find stock at a particular location
Note that the “Shelf location” in the top left drop-down list is the default shelf location of the item, which is where the item is usually stored. To
search by actual shelf location- where the stock has actually been stored- use the “Actual shelf location” panel.
In our example, only the location filter has been set to equals, and the entry in the box is A (so only stock in shelf locations called “A” will be
included in the stocktake):

The stocktake list shown below, with items listed in alphabetical order is the result.

Such a list is, of course, dependent upon locations having been defined, and items
allocated to specific locations

At this point the status of the stocktake is sg, i.e. suggested:
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Now fill in the information at the top of the stocktake:
• Description: A default description is filled in for you. You might want to edit it to make it more memorable. For example, add “Annual
stocktake” or “Monthly check” so that you can easily see what the stocktake was for when you look back at your records later.
• Comment: Put any other information you need to record about the stocktake in here.
• Stock take date: This is the date you performed the stocktake and is set to the date the stocktake was created by default. Users will only be
able to edit this if they have the Can edit stocktake dates permission set (see Managing users for more information). They will also be able
to set the confirmation date of the inventory adjustments created from the stocktake when it has been finalised (but you can never change
the date to before the Stock take date set in this field).
Just a quick word about the read-only (non-editable) information displayed at the top of the stocktake:
• Stock take key: The stock take number. This is an automatically generated number which increments by 1 for each new stocktake. It is
unique within a store only so it is possible for stocktakes from different stores to have the same number.
• Stock take entered date: The date the stocktake was created in mSupply.
• Stock take status: The current status is the stocktake:
◦ sg = suggested, the stocktake is still being worked on and is editable - new lines can be added or deleted and values can be
edited etc.
◦ fn = finalised, the stocktake is complete and cannot be edited (inventory adjustments have been created form it)
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Print sheets to do the stocktake
Before printing you need to ensure that the order in which items are displayed is appropriate. By default the list is alphabetical, but for stocktaking
purposes, it may be more appropriate to sort the list by location and then by item name; this is achieved by clicking on the Order by button and
choosing Sort by location then item name

If you want another sort order, click a column heading for a simple sort, or choose the Custom sort option from the Order by button.
You can filter a stock list by entering the item name - or the first few characters of the name - or the item code in the box Item name/code in the top
right area of the window, then clicking the Find button
Clicking on the Print icon displays the available options:

• General: contains several options. Click on it and you are presented with a further window:

The Form to use drop down list contains these options:
◦ Stock take line - prints out all the lines on the stocktake, including their quantity, with a space to write the actual counted
quantity. It looks like this:
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◦ Stock take line with space - is the same as the one above but with no quantity and 5 lines of space under each line. Useful if you
know there's a lot of stock in the warehouse that isn't in mSupply.
◦ Stock take line wt quantity - is the same as Stock take line but with no quantity. This is the one we recommend you normally use
to give to the people carrying out the physical count. This helps to ensure that the quantity of stock on the shelves is actually
counted and not just guessed!
◦ Stock take line wt quantity big font - is the same as the one above but printed landscape as a table in a bigger font
◦ Stock take lines with signature - same as Stock take line wt quantity but the stocktake signature entered in the printing
preferences is printed at the end.
◦ Stock variance - this shows the items that were adjusted after the stocktake was finalised. Similar to the Inventory adjustments
option below but a slightly different format.
• Inventory adjustments: prints information about all the items that had their quantities adjusted because of the stocktake after the stocktake
has been finalised (see finalise section below).
• Inventory adjustments-all items: prints information about inventory adjustments made after finalisation but includes all items, not just
those which have had their quantities adjusted.
There is, of course, a further option - you may provide the staff performing the stocktake with blank sheets, requiring them to list the items, batches,
expiry dates, locations, pack sizes and quantities manually. We don't recommend you use this option unless your printer is broken ;-)

Perform the stocktake
Allocate staff to perform the stocktake, instruct them in the process you wish to follow, and issue the sheets to them.

Enter quantities into the system
Once the physical stocktake has been completed, you are ready to make entries to record any differences in stock levels into the system. Remember
that any item which mSupply calculates as having zero stock will not appear on the stocktake sheet.

Filtering the list by item name or code
To help quickly find any item you want to make any adjustments to, you can enter the first few characters of its name or its code in the Search by
item name and code field. The displayed list of items will be changed each time you enter a character to show only the items whose name or code
matches what you have entered so far. To return to the full list just delete everything in this field.

Making Adjustments
If there is a discrepancy between the amount mSupply says you have in stock (the figure which appears in the Snapshot quantity column) and the
physical amount counted or between the batch, expiry date or location of the stock and what is shown in mSupply, you need to make an adjustment as
follows:
1. Double click on the row you wish to edit, and the Edit stock take line window appears, with the figure in the Stock take quantity field
highlighted.
2. Enter the figure from the completed stock sheet in the Stock take qty field (just type the new figure, and the currently highlighted figure
will be replaced).
3. change the batch, expiry date or location fields also if needed.
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Tip to make things fast!: If you only need to change the quantity for a particular
stocktake line then click on the value in the Enter quantity column and type the
correct value directly into the stocktake sheet. Use the Tab key on the keyboard to
move to the cell below that one or shift+Tab to move to the cell above it.

Adding items not in the stocktake list
In the event of an item being physically present in the warehouse, but not on the list then it needs to be added to the stocktake in mSupply:
1. Click the New line button and this window will appear:
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2. If you want to add a line of stock that already exists in mSupply then, in the Existing stock lines table at the top, check the checkbox for the
line you want to add and then click on the Add selected button. You can add more than one line if you wish - just check all the lines you
want to add. If you check the checkbox in the header of the checkbox column this will check all the boxes for you (and uncheck them again
if you uncheck it).
3. If you want to add a new line of stock that doesn't exist in mSupply then enter its details in the New stock line section at the bottom and
click on the Add new button to add it.
◦ Stock take qty: the number of packs you found in the warehouse.
◦ Pack size: the number of items in each pack that you found in the warehouse.
◦ Batch: the batch number of the item you found.
◦ Expiry date: the expiry date of the item you found (click on the calendar icon to select it or enter it manually).
◦ Location: the shelf location in the warehouse where you found the item (if you don't know the exact location then type the first
few characters of the location label, press the Tab key on the keyboard and select the location from the list that appears).
◦ Cost price: if you know it, enter it in the currency you are using in your datafile. If you don't know it, you could check the 12
month average checkbox and mSupply will enter a weighted average price of all the stock of this item you received over the last
12 months.
◦ Sell price: if you know it, enter it in the currency you are using in your datafile.
◦ Use details of line selected above button: this is a shortcut to save typing values in all the fields in this section. If the details are
similar to a stock line that is shown in the Existing stock lines table above then click on the line in the table to select it then click
on this button. mSupply will copy the details of thew line into the fields in this section and you can then edit the ones that aren't
quite right.
4. You can also select a colour for the line in the stock take using the colour picker in the top right hand corner (set to black by default, as
shown in the screenshot).
After clicking on either the Add checked or Add new button you are returned to the Stocktake sheet window, where the new line entered will now
appear in the colour selected; note that the new line(s) appear at the bottom of the stocktake and they have a value of zero in the Snapshot column.
All details of a new line added may be edited, but only the quantity or the location of existing lines on the sheet may be edited; this is performed by
double clicking on the row you wish to edit.
The Delete item button will only work to delete lines which you have added yourself (i.e. lines with a snapshot quantity of zero).
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Create inventory adjustments
When all necessary adjustments have been entered, you are ready to create the inventory adjustments; this is easily performed by:
• clicking on the Create inventory adjustments button
• confirming your intention in the window which appears

Creating inventory adjustments (finalising the stocktake) is not reversible, so you
have to be quite certain you've finished making all the changes you want to the
stocktake.

Once inventory adjustments have been created, the status of the stocktake changes from suggested (sg), to finalised (fn). You will now observe a
change in the buttons appearing on the Stocktake sheet:
• in the upper area, only the Print button is present
• while at the bottom two new buttons are present; Show added adjustments and Show reduced adjustments. Click on either button to
display the related inventory adjustment transaction. Note that if you have the Can edit stocktake dates permission (see Managing users)
then you will be able to edit the confirmation dates of the inventory adjustments to match the stock take date.

If an item has limited stock and that stock is allocated to an invoice during stocktake, when you try to adjust the stock the following window will
display.

Click “Cancel” to return to inventory adjustment. Press “Open in Excel” to open a spreadsheet to analyse the invoices to which the stock is allocated.
The highest invoice number is likely to be the one entered during stocktake.
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Obviously closing off transactions until stocktake is complete and avoiding these kinds of issues is best practice.

Print the report
Clicking on the Print button and clicking on Inventory adjustments will print this information:

In this example, three adjustments have been made:
• Magnesium carbonate: present at the physical check but not on the sheet, has been added
• Peppermint oil has had its stock increased
• Sodium bicarbonate has been reduced in stock
Items that weren't changed don't show in the report - if you want to see all items, including those that weren't changed then click on the Print button
and select the Inventory adjustments - all item option.

Some points to note:
• When you have created the stocktake sheet, it's like `taking a snapshot'; the physical stock at that location should not be removed until the
stocktake has been performed; nor should stock be added.
• New transactions can however, be entered into the system.
• the Log tab on the Stocktake sheet will list any anomalies. An anomaly may occur if a transaction has been entered after the stocktake that
issued more stock than you physically counted. Obviously someone has made a mistake in such a situation.
• There is on the stocktake window (lower left corner) a checkbox Locked , which, if checked, will allow neither deletion of the stocktake
nor any changes to be made to it.

• Ok and Next - if you have no more stocktakes to add, click the 'OK' button, to add only the stocktake just completed. To add a further
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stocktake, click the 'OK & Next' button and proceed to add your next stocktake.

Previous: Splitting a batch Next: Inventory adjustments
2011/04/28 10:39

·

Inventory adjustments
Choose Items > Show inventory adjustments
Inventory adjustments allow you to increase or decrease the stock of an item that is recorded in mSupply®. You will need to adjust the inventory if:
• Stock is discarded (due to damage or expiry)
• You do a Stocktake and find that physical stock is different to the stock recorded in mSupply®. In this case the first thing to do is to see if
you can find out where a mistake may have been made in issuing stock. For example, you may be able to retrieve extra stock mistakenly
given to a client, or may need to ask a supplier for an order that has been entered but never actually received.
• Stock has been stolen.
• As a general rule, consider using a regular invoice to account for any transactions with a customer or supplier. Only use an inventory
adjustment as a last resort.

If you are doing a “normal” stocktake, it's better to use the stocktake module
described here as it will create the needed inventory adjustments automatically.

Inventory adjust - add stock...
Choose Items > Inventory adjust (Add stock) Use this function when you have performed a stocktake and find that the physical stock of an item or
items exceeds the amount recorded in mSupply®.
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A transaction that is like a supplier invoice will be created. Enter the details in just the same way you would as if you were receiving goods from a
supplier, except that mSupply® fills in the Name field for you automatically, and does not allow you to edit it.
After a stocktake, this can be used to adjust any stock lines where the stock recorded in mSupply® is less than the physical stock.
You will be asked to enter the margin when starting this transaction. For a normal inventory adjustment, set this to zero. If you are using this procedure
to enter stock when starting to use mSupply® for the first time, enter the percentage to apply here.

Inventory adjust - reduce stock...
Use this function when you have done a stocktake and find that the physical stock of an item or items is less than the amount recorded in mSupply®.
A transaction that is just like a customer invoice will be created, except that you do not choose the customer. The section on entering customer
invoices describes the entry procedure. See the section on Issuing goods - Customer invoices here
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Inventory adjustments are treated by mSupply as a kind of Supplier invoice (or credit). To view or edit an inventory adjustment, Choose the “Show
inventory adjustments” option from the “Item” menu.
Previous: Stocktakes Next: Units
2011/04/18 10:33

·

Units
Choose Show units from the Items menu. When you have defined your units, a list is displayed:
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Click the New button to add a new unit.

Note that you will need to have sufficient user permissions to use this function.

Do not change the record for one unit into a different unit, as all items using that
unit will be updated.

Click the Merge button to merge two units. Note that duplicated units can occur on import of units or a user may duplicate a unit being unaware of
one existing already. The below window appears to merge the units. The green boxed unit is the one that will be kept, the red boxed unit will be
deleted.
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Accounts...
Choose Show accounts from the Items menu. This window allows you to manage the range of accounts that can be assigned to items.

Account codes are used when exporting transaction data from mSupply® to external accounting software. Double-click a line to edit its details.
Changing an account code or description will affect all items that are assigned to that account.
Click the New button to add a new account.
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Fill in the code, description field and select the account type. The field Items that use this account code will display such items for each account
code. Account types are Expense, Income and Asset .Click on OK button to add a new account, and Delete button to delete an account.
Previous: Inventory adjustments Next: Names: Using, adding and editing
2011/04/28 07:13

Forecasting

Updated: version 3.2, May 2014 (This functionality not available in earlier
versions)

In mSupply, consumption is defined as stock that is issued. Stock lost due to
damage, expiry, etc. (managed through Inventory Adjustments) are not included in
consumption. During the later quantification calculation, there are options to
include or exclude Stock Transfers and Builds in the consumption calculation.

By default, mSupply uses the assumption that future consumption will continue at the same level as consumption over a given historic period. Our
experience is that in 99% of situations the results obtained using this method are between very good and excellent. However, in certain situations you
may want to provide your own forecasts. Reasons for this could include factors such as:
•
•
•
•
•

Natural population increase
An epidemic causing increased demand
Historical usage being inaccurate due to operator error or out of stocks.
A change to Standard Treatment Guidelines meaning a new treatment is being introduced, and there is no historical data
Morbidity and mortality data has been obtained and used to calculate requirements. mSupply provides a number of alternative methods for
making a forecast of future consumption. These other methods are detailed in sections following below.

mSupply allows you to choose to use from a range of forecasting methods on a per item basis. To choose a different forecasting method for any given
item, find the item you are interested in, then open it's details view, and choose the Usage tab:
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In the Forecasting section of the window shown above there are four options:

Use Historic AMC
This is the default option, and is the recommended method. During the later quantification stage (creating a new tender, creating a new purchase order
or the suggested order report), there is an opportunity to provide the number of months of historical data to use to calculate the forecast.

For our worked example, we will use the Historic AMC method, based on 12
months of historic data.

Use historical AMC increased by a factor of X %
Using this option, mSupply will still calculate requirements based on historical AMC, but increased by the percentage you have entered.

BEWARE! Once set, this option will continue to govern for every forecast
generated by mSupply for this item until you re-set forecasting to the default (use
of historical AMC).

244

mSupply user guide July 2018

Use a fixed, estimated AMC of .....
This option allows you to specify a particular amount that will be applied to all future months. For example, you might have caluclated a target
consumption for an oral contraceptive based on fixed population and coverage targets.

BEWARE! Once set, this option will continue to govern for every forecast
generated by mSupply for this item until you re-set forecasting to the default (use
of historical AMC).

Use Projection (A or B)
With this option, mSupply allows you to maintain an A and a B projection, and easily swap between them. Of course you must enter projections for
this to be of any use!

Entering Projections
You can enter projections in a number of ways

Manually entering projections
If you click once on a cell that contains a projection (as opposed to a cell containing historical data), then you can click again to edit the cell's value.

Don't double-click: you need to click once, wait for a second or two, then click
again

Copying a projection
You might want to copy historical data as a starting point for your projection. You can do this by choosing a column for from column and to column
in the Projections section, then clicking Copy values.

Modifying a projection
You can use the Modify selected cell button to increase or decrease a column or some cells in a column by a certain percentage.
For example, you might have entered values for 2016, and then decide your 2017 values should by the 2016 values plus 8%. To do this
1.
2.
3.
4.
5.

Fill in your 2016 column values
Add a column for 2017 if one doesn't already exist
Use the Copy values button to copy 2016 to 2017
Drag to highlight all rows in the 2017 column
Enter 8 in the percentage field, then use the Modify selected cell button to increase the 2017 values by 8%.

If you are using projections, you are responsible to fill in future values for the
period to be covered by your ordering. Leaving future projections at zero will have
potentially serious consequences.
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BEWARE! Once set, this option will continue to govern for every forecast
generated by mSupply for this item until you re-set forecasting to the default (use
of historical AMC).

Where does mSupply use forecasts?
Any time mSupply produces a suggested order quantity, it will consider each item and use the forecast options for that item to produce a forecast. This
includes:
• Creating a new tender
• The suggested order report
• Creating a new purchase order

2014/04/29 05:20

·

Names: Using, adding and editing
About names
In mSupply a “name” can be any combination of a:
•
•
•
•
•
•

customer: a recipient of your goods
supplier: someone who sends your store goods
manufacturer: someone who makes the goods that you receive, store and distribute
donor: an entity that donates goods to you (you can track donated stock)
patient: someone you dispense goods to
others: you'll find other types e.g. benchmarks mentioned through out the documentation

Adding a Customer, Supplier, Manufacturer, Benchmark or Donor
Adding a new Customer
• To add a new customer, choose Customer > new customer from the menu.
• The form shown below will come up.
• The customer checkbox will be checked and disabled (from editing).
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Adding a new Supplier
• To add a new supplier, choose Supplier > New supplier from the menu (makes sense really!)
• The window will look the same as for adding a customer, except the supplier checkbox will be checked and disabled (from editing).

Adding a new Manufacturer
• To add a new manufacturer, choose Supplier > New manufacturer from the menu.
• The window will look the same as for adding a customer, except the manufacturer checkbox will be checked and disabled (from editing).

Adding a new Donor or Benchmark
• Select Customer > new customer or Supplier > New supplier from the menu.
• The same window for adding a new customer or supplier will open and you should check the Donor or Benchmark checkbox in the
Category section.

Items in the names entry window
Name Code: The unique code to identify this customer, supplier or manufacturer.
Charge to: mSupply is made to work in tandem with an accounting program (although it will also function just fine by itself). The “Charge to” code is
what is exported with each invoice. Generally you should make the charge code and name code the same (If you want, there is an option in the
Preferences > Misc tab to make sure this is the case). For example:
• If you have 3 hospitals you supply, but you send the bills to one centre for payment, you may want to enter each hospital with its own name
code, and all of them with the same charge code. In your accounting program you would just enter one debtor (customer) with a code the
same as the charge code. eg.
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Customer

Name code

Charge code

Fred H Hosp

fhhosp

bluehos

Mary P Hosp

mphosp

bluehos

Sam Q Hosp

sqhosp

bluehos

• In your accounting program you would enter “Blue Hospitals Assoc” with the code “bluehos”
• For a supplier, if you have entered a default currency and margin these will be entered, but you can override them. Every supplier should
have its currency entered (The currency it uses for your invoices). If the currency isn't yet in your system, close the name entry window and
choose Currencies from the Special menu to add it.

• if you do not wish to use different name codes and charge codes, check the “supplier name code and charge must
match” and “customer name code and charge must match” check boxes in the mSupply Preferences. If you do this,
the charge code will automatically be identified with the name code.
• spaces are not allowed in name codes and charge codes

Either the “customer” or “supplier” check box will be checked as appropriate, depending on whether you have chosen “new supplier” or “new
customer” from the menus to produce this window. However, you can still alter things here without upsetting mSupply.
Name: The customer/supplier name. (Remember you can use the Tab key to move from field to field)
Master ID & Master name: These are used when using the remote tender module to link suppliers with their master ID on the remote tender server
and maintained by Sustainable Solutions.
To link a supplier to the remote tender server, login to the tender server using the login details sent to you by Sustainable Solutions, and find the
supplier and find its ID. When you have that, copy it down (or copy it to the clipboard) then click on the padlock to make the Master ID field
enterable in mSupply. Now enter the ID (or paste it in) and click on the synchronise button next to the Master ID field. mSupply will then contact the
tender server and search for a supplier with the ID you have entered. If the search is successful, the name the supplier has on the server will be put in
the Master name field and you're finished. It it's unsuccessful, you'll be given an appropriate message.
Type: In the main entry screen, there are 4 check boxes to mark each entry as a customer, a supplier, a manufacturer and an additional Benchmark
category. This last category is a feature of the Tender Management module, and is fully explained in that section, under Using Benchmark prices
Status - Hold checkbox: If this is checked this name can not be used for receiving or issuing goods.
Donor checkbox: (Applicable to suppliers only) There are two situations in which this box should be checked:
1. If this supplier/organisation provides goods free of charge (either in whole or in part).
2. If this supplier/organisation provides funding (either in whole or in part) for purchasing.
Price Category: Selection of any of the categories will fix a certain price margin for that Supplier or Customer.The price category value is entered in
File >Preferences > Prices . When goods are being issued to this customer, the selling price is increased/decreased by the percentage specified in the
Preferences for this price category.
• Eg: Consider customer XYZ, who is in category B, and in the preferences category B is assigned a value of 50. If an item is issued to
customer XYZ with a normal selling price of $10, the selling price on this invoice will be $15.
Address and contact details: These should be completed with relevant details
• For customers, you can enter separate delivery and billing addresses as necessary.
Other section - Categories: There are 6 category fields available for selecting as required. Each category has its own drop down list containing the
categories which have been defined using the menu item Supplier > Show categories… or Customer > Show categories… (see Name Categories for
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more details). The labels of these 6 categories can also be changed in the preferences (see General preferences, Names tab for details).
These category fields are used for reporting and are available for you to make whatever entries are appropriate in your situation. For example, you
might wish to subdivide your Hospital category by number of beds, or your Clinics by the number of patients seen daily, etc. Or you may wish to
identify your customers by their geographical location (region, district, state etc.) or by location type - urban, city centre, rural, remote, etc. The choice
is yours - the main point to remember is that these fields are searchable, enabling you to produce reports relating to very specific criteria.
Analysis: You can use this field to group together certain types of customers or suppliers. You can filter the report by selecting the group in the
Analysis field.
Postal address: Here you can enter a postal address if it is different to the physical address of the supplier.

Mapping a customer's location
You can use the coordinates
If you locate a customer on Google Maps and then click the link button at the top right corner of the window, you can copy a google map link. If you
copy and past the link into a text editor or word processor you will see a section that looks like this
ll=-21.261901,-175.140309

The first number after “ll” is the longitude, and the second number is the latitude. If you enter these numbers into the provided fields in mSupply, you
can then view the customers location by clicking the Google maps button.

If the US President suddenly becomes your customer then his location would be :
• Latitude : 38.897669
• Longitude : -77.03655

Hiding Names on a per-store basis
If you check the Hide in this store checkbox, the customer/supplier you are currently viewing will no longer be shown in the store your are now
logged in to.
• This allows you to have customers that are specific to each store.
• To find a name that is hidden, you can use the Complex find button in the window that is shown when you choose Names > Show
customers or Names > Show suppliers

Extra information for customers only
Shipping address: If the name is a customer, shipping address fields will be shown.

Extra information for suppliers only
Currency: Enter the currency code of the currency this supplier uses for invoicing you.
Margin: Enter the percentage margin to apply to items received from this supplier.
Freight factor: Enter the amount to add to quotations from this supplier to adjust quoted prices for freight. For example: a physical check on invoices
from IDA reveals that freight to Nepal generally amounts to about 15% of the net value of the invoice. Therefore we would enter “1.15” in this field
for IDA. Note that if suppliers quote you “CIF” prices, then you should enter “0” here.

About Manufacturers
When you are receiving goods, you can optionally specify the manufacturer of each item. Manufacturers can be chosen from a list that is made up of
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names which have the Manufacturer checkbox checked.
For the manufacturer field to be shown, the option must be turned on going to Special > Show stores > [choose your store and double-click] >
Preferences tab and checking the Able to specify manufacturer when receiving, ordering or quoting for items checkbox

Editing a Customer, Supplier or Manufacturer
Finding a name
Before you can edit a name, you have to find it and display its details! For this example we will edit a customer. Editing a supplier is just the same,
except that you start by choosing Show supplier from the Supplier menu.
Choose Customer > Show Customer. You are presented with a window to enter as much of the Customer name or code as you know:

• The slide bar at the top of the window may be set to Normal, at the left, or at intermediate points towards the Fuzzy end (right); this
determines the accuracy of matching your entry; when set to Normal, the search will only match exactly what has been entered; when set at
Fuzzy the search will list entries which are approximate matches to what has been entered. The accuracy with which the list matches the
entry is determined by the position of the slider.
• If you leave the Name/Code text field empty, clicking the Find button will produce a full list of all customers.
• You can enter values for the other filters too (or them only!) if you want to refine your search.
• Note that the window has a series of radio buttons to select the target of your search - All names, Customers, Suppliers, Manufacturers, etc.
So even if you start this search from, say, Customer > Show Customers…, by selecting the Suppliers radio button, you can search in
suppliers rather than customers.
• The Exclude patients checkbox is checked by default and means that any patients you have in your datafile will not be included in the
search. If you uncheck it, any patients in the current store will be included in the search.
• The Exclude hidden names checkbox is checked by default and means that any names hidden in your store (but probably visible in other
stores) will not be included in the search. If you uncheck this box then the search will include all names in all stores, and their visibility will
be ignored.
If the search finds only one name that matches the filter criteria you entered, its details window will be displayed. If more than one name matches then
you are shown a list of them all:
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Buttons in the names list window
New: This button allows you to enter the details of a new customer
Modify: This button opens a window displaying the details of the highlighted customer, allowing their details to be modified.
Set Flags: This button allows you to mark certain names with a flag.
• First, highlight the names you wish to flag by holding down the control key (command on Mac) and clicking the names in the list you wish
to use. Then click the Flags button to show a window where you can enter the flag you wish to add, and decide whether to replace any
existing flags or append the new flag to the old one.
Print: Clicking this button will print a list similar to the one displayed on screen.
Find: This button shows the same find window as choosing the menu item did so you can find a different group of names.
Order by: This button allows you to sort the displayed list by the criteria you choose. The Labels and Print buttons will use the order that is displayed.
By default, names are displayed alphabetically based on the name column.
Merge: This button allows two customers to be merged into one; highlight the two entries click on the Merge button to display this window:

Choose the record you wish to keep and click on OK ; the data from the deleted record is then merged with the data of the record being kept. If you
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change your mind, click on the Cancel button, and the merger will be cancelled.
Labels: Clicking this button allows you to print address labels for the names in the list. The label editor is displayed.
Report: Click on this icon to open the Quick Report editor window. Use of the Quick Report is discussed elsewhere in the guide. See Custom
Reporting Tutorial
Customise: Allows you to choose which columns to display using this window (Note: this only affects the columns you see in this list, it won't affect
what other users see):

Columns on the left are available. Columns on the right are the ones in use in your names list. Click a row in either column then click the move left or
right button to transfer it to the other column. Click OK when you're done, or Cancel if you want to stick with what you've got. Your choice of
columns to display will be remembered for the next time you display a list of names (customers, suppliers etc.).
OK Button: Closes the window

Editing or viewing a name
To edit/view a particular name, if you are looking at a list of names double-click the name you want to edit on the list (no need to do this if you are
already looking at the name's details page because only 1 name was returned from your search).
You will be shown the name's detail window which has a sidebar showing several tabs, General, Invoices, Backorders, Quotes etc. and opens at the
General tab:
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The Invoices tab
Here you can view the invoices for a customer or supplier.
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You are able to edit an invoice directly from this window by double-clicking the one you wish to edit. A new window will open with the invoice
details displayed.
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Buttons on the Invoices tab
Print Range: Click this button to print a range of invoices for a customer. You will be asked to enter the first and last invoice numbers to be printed.
Aging: Click this button to display a list of aging categories and the outstanding unpaid balance for each invoice in each category.

255

mSupply user guide July 2018

Dates: Choose a date range from this menu to show quickly recent invoices, or to revert to showing all invoices

The Backorders tab

• Here you can view, add and edit the backorders for a customer. mSupply allows entry of backorders against suppliers as well, but we are
not sure why you would want to do this!
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Buttons on the backorders tab
New backorder: Clicking this button presents you with a window where you can add a backorder line for this customer.

•
•
•
•
•

Type at least a portion of the item code or item name, then press the Tab key.
Today's date is automatically entered. You can change the date if you like
Enter the total quantity owing.
Enter a comment (e.g. an expected arrival date)
Click OK to save changes and exit the window.

Delete backorder: Click a backorder line to highlight it, then click this button to delete the line.
Copy: This command copies the backorder to the clipboard, allowing you to paste the report into an email message, word processor or spreadsheet
document.
Print: The list of backordered items for the customer is printed.

Viewing Backorders
Double-click a backorder line to edit the line. You will be shown the backorder entry window, where you can change any details you wish.
Show: This drop-down list allows you to choose which backorders to display.

• Backorders are normal items that have not been supplied to customers.
• Ad Hoc items are items that customers have ordered but which you do not want to add to your stock list, rather making a special order just
for that customer.
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The Quotes tab

You can view the quotations you have entered in mSupply for this supplier.

The Notes tab
To add, edit or delete a note, click on the Notes tab, and this window displays:
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Click on New note to create a note, or select an existing note and double click on it to view, edit or delete it.

• The date on which you are entering a new note is already completed, and in the main panel you should type in the wording of the note
itself.
• In the lower left of the window is a drop-down list offering various choices concerning the displaying of the note on screen; it may appear
as an alert when a Supplier invoice is created, when a Purchase Order is created, etc..
If never is chosen, the note will never be displayed on screen, and if all is chosen, it will display for all events for this customer/supplier. You may
also set the background colour of the note , but as the text is always black, dark colours should be avoided. A further option allows you to have one or
more audible `beeps' sound when the note is displayed. Each note will display according to the attributes set for it, independently of other notes
defined for the same customer/supplier.
Subsequently, when this customer/supplier is selected and depending on the display settings made, the note will appear on screen; be aware that the
note does not disappear automatically - you must close it/them manually.
The text of a note can be up to 32,000 characters.
Click OK when you are finished.
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The Contacts tab

Adding a Contact
To add a contact for this customer or supplier, click the Add contact button , then enter the details in the window that appears.
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Deleting a Contact
To delete a contact, click on the contact you wish to delete, then click the Delete contact button.
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The Group tab

Groups are only relevant to customers, not suppliers.

If this customer has been added to a group, this tab displays the name of that group. An explanation of groups and how to work with them will be
found here: show_groups

Here you can select the group of which a customer is a member. When you choose a group, you will be shown a list of item departments which are
linked to the chosen group. Once the group system is activated in the Preferences, only items belonging to one of the listed departments (or items with
no department) may be supplied to that customer.
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The Purchase Orders tab

This tab shows a view of Purchase Orders for the current name, and applies to suppliers only.

The Web log-in tab

If you are allowing customers to access their order information using the mSupply web server, this is the window where you assign a logon name and
password to a customer.
Also displayed on this tab is the internet connection speed. It should be noted that this value is derived from your network settings, and may not be
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edited manually.

The Item lists tab

This tab is used to assign master lists to customers for use in requisitions and mSupply mobile. For more information, see Item master lists.
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The Stock history tab

A list of stock histories, showing dates of both the stock take and the date of entry into the computer, the ID reference, the status and the type, is
displayed.

The Store tab

Only users who have Admin privileges may access this feature. See Managing users

When the Store tab is chosen, this window appears.
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The window shows which stores the customer/supplier is visible in. Only when the visibility checkbox is checked, is the customer/supplier visible
(and able to be used for receiving and/or issuing goods) in that particular store.

The Photo tab
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On this tab you can assign a photo of the customer or supplier and set their world map coordinates. Both of these can be used in reports.
To add a photo, either copy the contents of a file to the clipboard and paste them into the image area or click on the Add photo button and select the
picture file (png, jpg, bmp or gif files supported).
To delete a photo either click on it in the image area and press the delete key on your keyboard or click on the Delete photo button.
Previous: Units Next: Contacts
2011/04/19 05:47

·

Contacts
This command from the Special menu displays a window where you can edit contacts.

Contacts are usually associated with a name (a customer or supplier), and it is easier to edit such contacts using the “show suppliers…” or “show
customers…” command.
If a contact is not associated with a name, you can edit details for that contact using this command.

Buttons in the contact list window:
New: Use to add a new contact.
Report: Presents the Quick report editor window. See using_the_query_search_editor
Find: Use to find an individual contact
Order by: sort the contacts
Print: clicking this button will present you with a dialog with two choices:
• If you click list a list will be printed of the records in the window.
• If you choose labels, you will be shown the label editor, allowing you to print a set of address labels for the current list of contacts. Note
that you can save a particular label layout and then use the load command in the label editor to restore your layout.
New: To edit a contact, double-click on the line you want to edit. You will be shown the contact details:
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Previous: Names: Using, adding and editing Next: Merge two names....
2011/05/20 06:42

·

Merge two names
If you accidentally enter two names into mSupply that identify the same organisation, you can use this command to combine them.
Use extreme caution: This operation will move all historical records from the name you delete to the name you are keeping. The operation can only be
undone by reverting to a backup copy of your data file.
In the window displayed enter the name to keep, and then the name to delete. When you have checked then checked again that the information is
correct, click the OK button. You will be given one last chance, and then…..

You can also merge a name into a virtual store (the store must be the name to keep). This is particularly useful if, for example, you have a customer
which you now want to turn into a store to manage their stock more fully. This has the benefit of moving all the transactions connected with the
customer into the store so that you don't lose any historical transaction information. Note that when you carry out such a merge you must finalise all
transactions belonging to the customer first (mSupply will tell you to do this if you have not already).

If the virtual store is 'Active' on a satellite server in a synchronised system (refer
Remote Synchronisation) then the merging needs to take place on the primary
server.

Previous: Contacts... Next: Name Categories
2011/05/12 07:09

·
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Name categories
You can categorise names in mSupply with 6 different categories. This is very helpful for producing detailed reports. You can apply one or all or some
of these categories to a name. Categories 2-6 are standard categories but category 1 is special - it's hierarchical and has 3 levels, level 1 is the top and
level 3 is the bottom (similar to item categories).
Suppliers and customers have their own sets of categories. To view and edit them you choose Show categories from the Customer or Supplier menu
and that brings up this window:

Here you can add and edit categories for your suppliers or, in this case, your customers.
Show drop down list: This determines which category type is shown in the list and which type of category will be created if you click on the New
button. Note that the Category 1-6 labels in the drop down list will be replaced with any custom labels you have defined in the category label
preferences in the General preferences, Names tab.
Delete button: Deletes the category you have selected in the list. You'll be asked to confirm the deletion first of course!
New button: Opens up the new category window which looks like this (Note that double clicking on a category in the list opens up this window too
but it will be populated with the current settings for the category you double clicked so that you can edit them all):
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Description: This is the category name and will be seen everywhere when assigning names to categories or filtering on name categories in reports.
Category_user_field_1: This is a user-defined field. If a label has not been entered in the preferences then the default Category_user_field_1 shown
here is used. The information you enter here is used in some reports.
Category_user_field_2: A second user-defined field, same rules as for Category_user_field_1 apply.
Parent category drop down list: This only appears if you're editing a category 1 level 2 or 3 category because they are the only ones that can have
parent categories. A parent category is the category to which this category belongs. If the category you are creating or editing is level 3 then you will
be able to choose one of the level 2 categories as a parent. If you are editing a level 2 category then you'll be able to select one of the level 1
categories.
Previous: Contacts Next: Suppliers: Adding and Viewing
2011/05/12 07:12

·

Suppliers: adding and viewing
New Supplier
To add a supplier, choose this item.

270

mSupply user guide July 2018

Note- if this supplier will have invoices entered against it and you are exporting invoice data to an accounting program, a new “creditor” must be
made in your accounting software with the same code, or you will get an error when you import! (You can usually make the code when you get the
error in your accounting software when you try to import!)
The window for viewing/editing a supplier contains basic information. Fields that especially relate to suppliers include:
Currency: If you are using currencies, enter the currency used by this supplier. This value will be filled in with the value set in the “default currency”
option of the Preferences.
Margin: The amount (as a percentage) that will be added to the cost price to calculate the sell price when you enter an invoice. For example, if you
enter “10”, items from this supplier that are bought for 30 dollars will have their value increased by 10% (i.e. 3 dollars) and will be sold for 33 dollars.
Category: You will note that the Supplier box is already checked. The special Benchmark category is discussed fully in the section on Tender
management, which you can access here.
Freight factor: The amount to multiply supplier quotations by to account for freight charges. (If their quotations are “CIF” you should set this to
zero).

Show suppliers
This item allows… you guessed it - you to view suppliers. This window is displayed.
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In the field, type as much of the supplier name or code as you want to. If there is only one matching item, the details will be displayed, otherwise a list
will be displayed from which you can choose the name you want by doubling clicking it.
Note that if a supplier has invoices entered against it, you will not be able to uncheck the “supplier” check box, and you will not be able to delete the
supplier.
Previous: Merge two names Next: Introduction to Tender management
2011/05/12 06:47

·

Introduction to tender management
Introduction
In order to achieve the best value for available funds, it is common practice to seek out the best prices for the medicines that will be required, usually
for the forthcoming year, by publishing a tender. Normally, the full tender process creates a lot of work which can be very time consuming and error
prone. The mSupply tender module is designed to make the process as simple as possible, to minimise the work involved and to reduce the chance of
errors.
As usual in a tender process, forward planning is necessary, as the process must be started several months before the goods will be on site and
available for use.
The work flow for using the tender module is:
1. Prepare list of items and quantities. See creating_a_new_tender. When all items have been added to the tender, it should be set to confirmed
status.
2. Distribute list to suppliers. See Adding suppliers to a tender
3. Create benchmark prices. See Using Benchmark prices
4. Evaluate received quotations. See Receiving Quotations from suppliers
5. Select preferred suppliers. See accepting_tenders. After selecting the preferred suppliers for all items, the tender should be set to finalised
status.
6. Create Purchase Orders. See Supplier responses & Creating Purchase Orders
From your usage history, mSupply can prepare a list of items and anticipated quantities. This list is distributed to suppliers, who are invited to submit,
after a reasonable period of time, their quotations, inclusive of all additional charges., e.g. freight.
The list may be uploaded to the web, and interested suppliers invited to submit their quotations online; conventional methods of submitting quotations
are also available. We recommend the online method, as it reduces paper consumption, and is less labour intensive.
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Once all the quotations have been received, mSupply will assist in processing them, comparing quotations, performing necessary currency conversions
where appropriate, applying freight charges etc. mSupply will mark the lowest item price blue. If two lines are the same price and are the lowest price
both will be coloured blue.
The user then has all the relevant information enabling informed choices to be made in selecting which supplier for which item.
Finally mSupply will create Purchase Orders for the successful bidding suppliers. While mSupply can perform all these tasks from stored usage data,
it will allow users to change supplier and/or quantities, should special circumstances prevail in particular situations.
Preferences: There are preferences that can be set for the tender process, see tender preferences.

Note that for multi-user installations, Tender management activation requires
payment of a fee. Please see the website here (http://www.msupply.org.nz/
index.php?s=pricing) or contact Sustainable Solutions for more information.

Getting started
Select Show tenders… from the supplier menu or from the Navigator's Suppliers tab.

A window is shown with a list of current tenders (if any) and some options:
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The Show drop down list is a filter which allows the list of tenders displayed to be changed:

Creating a new tender
Two options are available :
• New Generated Tender Once you have been running mSupply for a year, and providing that year is fairly typical of your overall usage, the
New Generated Tender is recommended; this option will suggest quantities based on actual usage, having regard to seasonal fluctuations,
thus eliminating any guesswork. Note, however, that quantities are suggested only, and may be amended as required.
• New Tender - allows you to create the tender manually and is a more labour intensive process.

Note that the creation (or deletion!) of a new tender will be logged by mSupply.
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Also note that all tenders belong to the store they are created in and will not be accessible in other stores (but supervisor mode users can view tenders
in all stores). This also means that you can only access items visible in the store the tender is created in, whether you manually create or auto-generate
your tender.

New Generated Tender (Auto-generation)
To have mSupply automatically create a suggested tender based upon your projected demand, click on the New Generated Tender button, and confirm
your intention by clicking Yes on the Confirm window.
This window will appear. You may recognise it from the Item usage report, suggested order report and the Managing Purchase Orders, creating a
Purchase Order - it uses much of the same functionality:

You can tailor your search by item in the usual way. Clicking the refresh button (double arrows near the centre) shows an estimate of how many items
will be processed. Further refinements can be added. It is recommended to use the Calculate button to refine the Months of stock required figure by
entering Lead time, Ordering Cycle and Buffer stock values directly.
Processing all this data may take some minutes if you have a lot of stock items recorded in your system, so mSupply will ask you if you've got the
time to do it. If you do, click `Yes'. A progress indicator will show you how much work is left to be done. When mSupply has finished processing
everything, it will let you know:

275

mSupply user guide July 2018

Auto-generated tenders may be rather large, so you may wish to process several tenders with more specific criteria rather than one huge one at once.
You can choose to look at your tender immediately, or return to it later. If you click `Yes', you'll see something like this:

Points to note here:
• Several default values have been entered for the Description (made up of the tender number, date and time of creation and number of
months stock required), Issue (the current date) and Response by (one month from the current date) dates and Our ref (AUTO followed by
the tender's number) fields at the top that you're going to want to change.
• There are no units chosen for any of the tender items.
A pack size of 1 is usually assumed because mSupply looks for the default pack size and default unit for each item as it creates the tender (these values
are set when editing Items - see Item Basics ). If it does not find a default unit, it leaves units blank, but enters a `Check units!' warning into the
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comments. The same goes for pack size - although if you don't tell it otherwise, mSupply assumes a default pack size of 1. Tender auto-generation will
therefore be most useful if these default values are set for items. (A default pack size of 1000 shows here as this was loaded at the time of item
creation).

New Tender [manually entered]
To create a new tender manually, having opened the Tenders window by clicking on Show tenders on the menu, click the New Tender button.
This window opens:

Here you can fill in basic information about the tender.
• Creation date: The date the tender was created. This defaults to today's date.
• Issue date: The date the tender is/was sent to suppliers. This also defaults to today's date, but can be changed.
• Response by date: The date by which suppliers must respond to the tender. The default is set to one month from the creation date, but can
be changed.
• Status: Tenders can have a status of sg/cn/fn (suggested, confirmed or finalised), which signifies its passage through the overall tender
process. To change the status of the tender, simply select the new status from the drop down list and click on the OK button to save all
changes. You will be asked to confirm a change because it has a significant impact on the editability of the tender. These are what the
statuses mean:
◦ Suggested status - tender is still being built. Everything is editable.
◦ Confirmed status - list of items & quantities is complete and can no longer be edited. Suppliers invited to provide quotations
may be added, and, once received, their responses may be added. Decisions may then be taken regarding which quotation is
preferred for each tender item.
◦ Finalised status - no further editing may be performed, and the tender can now be used as a basis for purchasing
• Locked checkbox: Check this box to ensure the tender is not accidentally deleted.
• Our ref: This field may be used to enter a short reference code to appear in tender-related correspondence.
• Comment: The comment field is for your internal use. It is not printed on any tender documents.
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Tabs on the Tender Details window
Details of the tender are managed through the tabs on the Tender Details window:

Items and compare prices
• This tab displays by default when you open a tender for editing. It displays the items currently included in the tender, and by selecting 'All',
'Filled' or 'Unfilled' from the drop-down list above and to the right of the list, you can select which items are displayed.
◦ New line button: click this to add a new item line to the tender. The addition of the new line will be logged by mSupply.
◦ Delete line button: select an item line from the list and click this button to remove it from the tender.
◦ Print internal report button: click this to select one of several reports to print out or export to a spreadsheet. There are several to
choose from and will give you the information you need to help evaluate or analyse a tender:
▪ Preferred suppliers only
▪ Winning tender lines
▪ All supplier responses
▪ Supplier quotes with adjusted price
▪ Supplier quotes for each item
▪ Tender lines with predicted cost
▪ Tender lines where the lowest price was not chosen.
◦ Incoterm drop down list: Allows you to select an incoterm (https://en.wikipedia.org/wiki/Incoterms) to apply to the tender
◦ Search items text box: as you type in this text box, only items whose names start with what has been typed will be displayed in
the table. You can use the “@” character as a wildcard to represent anything. For example, typing “@ol” will display only items
with names which end in “ol”. This box is helpful for quickly finding a specific item. Overrides any selection made in the Show
drop down list (see below).
◦ Show drop down list: is another way to change what items are displayed in the table. Selecting one of these options will override
anything typed in the Search items text box:
▪ All - display all items without filtering
▪ Filled - display only those items for which a bid has been accepted
▪ No bids - display only those items for which no suppliers have made a bid
▪ Lowest cost not chosen - display only those items where the lowest offered cost price was not chosen as the preferred
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bid
Note that changes to tender lines will be logged by mSupply.

Notes
• This tab shows a field where you can add notes about your tender. This will not print on the documentation sent to suppliers.
• To start a new line (as with any text box), press Shift+Enter (although any long lines will wrap). See below for an example:

Choose suppliers and enter responses
• The use of this tab is used to manage sending of the tender to suppliers, and entering their responses - see Receiving Quotations from
suppliers

Standard conditions
• The use of this tab is described here: Standard conditions

Purchase Order
• The use of this tab is described here: Creating Purchase Orders

Reference Documents
• The use of this tab is described here: Reference Documents

Tender Preferences
• The use of this tab is described here: Setting up purchase order preferences.

Synchronise
• This tab will only appear if you are using the remote tender module have set up your remote tender preferences. The process and use of this
tab is described in Uploading and Downloading Web Tenders.

Log
• This tab shows recent events relating to this particular tender. It will show, for example, changes in prices or other significant events. You
cannot edit the details on this tab. If an event fails to be logged for any reason while the tender is being processed, you will be given an
appropriate warning message.

Adding items to a tender
To add an item to a tender, click the New line button on the Items and Compare Prices tab.You will be shown a window like this, which opens at the
Set tender item criteria tab:
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1. Type as much of the item name or code as you know, then press the Tab key. If only one item matches your entry, it will be filled in. If
multiple items match, you will be shown the standard item choice list to choose the item you want. Any details completed in the Full
description under the General tab of the selected item are displayed (Description).Should you wish to identify a line (or lines) for any
reason, clicking on the Colour button presents you with a selection of colours available for the type on that line.
2. Fill in the number of packs you wish to purchase, and the pack size. The total quantity of individual units will be calculated. The Round
quantities button will round the number of packs to the nearest reasonable number of whole packs (most useful for auto generated tenders
when the number of packs can sometimes be set to a decimal number).
3. Choose the units you wish to use.
4. You may optionally enter a price per pack figure in the Estimated price field.
5. Entries in the Comment field are for your internal use, and won't be printed on the tender documents you present to suppliers.
6. In the Conditions field, enter any conditions which are specific to this item of the tender , but NOT applicable to the tender as a whole.
These conditions will be printed on the tender letter with the item details.
7. Click on OK & next to add the next item to the tender, and when you are finished, click on OK.
8. The addition of a new line will be logged by mSupply.

It is perfectly possible to add the same item more than once to a tender. Each entry
will be treated separately. This allows for the same item to be added, for example,
in different pack sizes.

The second tab Compare supplier responses, is for use after suppliers have responded to the tender - refer Receiving quotations from suppliers Comparing quotations from different suppliers.

Deleting tender items
Click the line you wish to delete so that it is highlighted, then click the Delete line button. If a supplier has already quoted on a tender item, you will
be warned before deletion. The deletion of any tender lines will be logged by mSupply.

Editing tender items
From the Items and compare prices tab, double-click the tender line you wish to edit. The 'Edit tender item' window will open, allowing you to edit the
details in the same way as entering a new tender item, above. Note: you cannot edit or delete lines on finalised tenders.
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The Search item field allows you rapid access to any item in the tender - just enter the name (or first few letters of the name) of an item in the tender,
and it will be displayed.
Here's how the Edit tender window looks when the item Ranitidine 25mg/mL injection has been selected; the automatically generated tender has
calculated that 1023 ampoules are required; here you can edit the quantity to conform with, say a pack size of 10, so you would adjust the pack size to
10, and the quantity to 102 or 103.

Note that any changes to a tender line are logged by mSupply.
Previous: Suppliers: Adding and Viewing Next: Standard conditions
2011/04/19 07:22

·

Standard conditions
mSupply allows you to set up a list of standard tender conditions called master conditions. These are all the conditions you will apply to tenders from
year to year. Each time you create a tender you can copy the master conditions you want to your tender as required - these form the standard
conditions list for that one tender. These instructions cover managing master conditions and applying them to individual tenders as standard
conditions.
When you print your tender invitation letter, you can choose to have the list of standard conditions print (not all the master conditions!), followed by
the list of items for which you are requesting prices.

Setting up conditions and their categories
Choose Suppliers > Show tenders, and open the Master Conditions categories tab
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Here you may define categories for your master conditions. Examples shown above are Annual, Supplementary and Emergency. Subsequently you can
restrict the display to a single category by selecting that category from the Show drop down list.
Choose Suppliers > Show tenders, and open the Master Conditions List tab:

You can print a master condition selected in the list by clicking on the Print conditions button. To add a new master condition, click on the New
Condition button. This window opens:

282

mSupply user guide July 2018

Point: The conditions will sort by their point entry when printed. We suggest you label your points 1.1, 1.2, 1.3, 2.1, 2.2 etc.
Note that if you have more than 9 points in one of the levels, you should add a leading zero so that they sort properly (01.1, 01.2, etc)
Heading: Enter the Heading.
Body: The body can be as long as you like for each entry.
Category: If you have defined categories, they will be displayed in the drop down list, and you may select the appropriate one.
Flag: Say you have some entries that need changing after copying to an individual tender (e.g. a closing date). You can enter a value in the flag field to
identify such entries.
Print heading and body: Use this drop-down list to choose what will print. Normally you'll want to print both heading and body, but near the top of a
tender form you may want several headings together.
Click OK & Next to add further conditions.

Editing and deleting conditions
Double-click an entry to edit it.
To delete a condition click on it to highlight it, then click the Delete condition button.

Copying master conditions to a tender
When you enter a new tender, go to the Standard conditions tab.
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Click the Copy from master button to copy conditions from the master list
Once you have copied conditions, you can add, edit and delete them in the normal way.

when deleting rows you can highlight multiple rows by holding down the control
key (command key on Mac) as you click rows, or press control + A to highlight all
rows.

Printing the standard conditions with the invitation letter
To have the standard conditions printed at the end of the suppliers' tender invitation letters, go to the tender's Tender Preferences tab:

In the Acceptance letter section, check the Print tender conditions checkbox. That's it, all done!
Previous: Introduction to Tender management Next: Adding suppliers to a tender
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2011/05/12 09:05

·

Adding suppliers to a tender and inviting responses
To add suppliers to the tender, click the Choose suppliers and enter responses tab to open this window, where the suppliers to whom your tender will
be sent may be added, or subsequently deleted:

Note: The RTM Link column in the table shows whether the selected supplier has been linked with the Remote Tender Module (checked if it has)
To add suppliers to the list, click the Add Suppliers button.
A list of all suppliers is shown:
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You can add multiple suppliers by holding down the control key (command key on Mac) and clicking on those suppliers you wish to add. Once you
have selected a supplier or suppliers, click the Use button to add them to the list. To create a new supplier, click the New button.
Once suppliers are added, they will appear in the list:
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Double clicking a supplier will open a window for adding and editing quotations - see below.
It there are any suppliers listed that do not have a tick in the RTM Link column and you intend to publish the tender to the web, you will need to
contact mSupply Support: support@msupply.org.nz (mailto:support@msupply.org.nz)

Deleting a supplier
Highlight the supplier you wish to remove from the tender, then click the Delete supplier button. This will remove the supplier from the tender - it will
not delete the supplier from mSupply. Note: you cannot remove a supplier from a finalised tender, or if the supplier has quoted on one or more tender
items. If you want to remove a supplier for which quotations have been entered, delete the quotations first, then you can delete the supplier.

Inviting quotations from suppliers
Print Invitation letter
Clicking this button prints an “Invitation to tender” letter ready for dispatch to the highlighted supplier; the letter includes all the items, quantities, etc.
as specified in the tender. The default date for a response is one month after the date of the letter, but this can be amended to a date of your choosing.
If the default format of the Invitation letter does not meet your requirements, please let us know and we will customise the print format to meet your
individual requirements.

Email Selected button
Clicking this button produces email documents for each of the highlighted suppliers. A PDF document (the same as the printed document) is
produced, attached to an email and stored in the email queue. This option will work only if you have entered email addresses for the chosen suppliers.
Whichever method you choose, you will be given the option for the Date sent field to be filled automatically with today's date.

To Spreadsheet
Clicking this button opens your spreadsheet application, with all the items and quantities required on the tender document already entered in
appropriate rows and columns. This may be saved and sent to the supplier along with the tender letter. Appropriate columns are already in place for
suppliers to enter their responses.
Previous: Standard conditions Next: Reference Documents
2011/05/12 09:11

·

Adding supplier responses to a tender
Suppliers respond to your invitation to respond to a tender with quotations. To process a quotation from a supplier, open a tender (choose Suppler >
Show Tenders… from the menus and double-click on the tender in the list) and go to the Choose suppliers and edit responses tab. Now double-click
the supplier name you want to enter a response for. The Edit Quote window will appear:
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{{ :tender_management:tend_edit_quotes.png?600 |}}
The Date sent field may be edited if necessary. You should enter the date the supplier responded, and in the Valid till field, the expiry date of the
quotation. Also, enter the reference that the supplier is using for their own records (to be quoted in future correspondence) in the Their reference
field, and, importantly, the currency in which the supplier has responded (on the Edit Quote tab). If you have previously set a default currency for this
supplier, this drop-down list will already be set to that currency. Otherwise, your own default currency will appear.
The freight charge per cubic metre [m3] should be entered; if the volume of each item's pack is known, this can also be entered (at a later stage),
allowing a more accurate total cost of each item to be evaluated.

Multiple currency tender quotations
A quotation may be received from a supplier which has used one currency for some items, and another currency for others; or has submitted more than
one quotation for the same item, each one in a different currency (e.g. Euros and US dollars). Should this occur, it is strongly recommended that you
process the quotation as two or more separate quotations, each one restricted to a single currency. That is, enter the supplier twice in the list of
suppliers, then add a comment to the quotations to distinguish which quotation is in which currency. We have designed mSupply like this so that when
Purchase Orders are created, a single Purchase Order only uses one currency. Mixing currencies on a Purchase Order is likely to cause confusion and
errors.

Adding quotation lines
Now you can add the supplier's quotation line by line. On the Edit Quote tab, click on the New line(s) button. A window will open showing you a full
list of all the items on the tender:
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Select from the list all the items you want to enter quotes for. You can use the usual Control+click (Cmd+click on Mac) to add/remove an item to your
selection, Shift+click to add/remove a range of items from your selection or Control+A (Cmd+A on Mac) to select all items. Now click on the Use
button and all the items you have selected are added to the quotation with zero cost. In this example we chose to add the first 5 items in the tender:

289

mSupply user guide July 2018

To add the same item twice to a quotation from a supplier, click the Add lines(s) button and choose the item a second time. You will be shown a
warning that the item is already on the quotation, and be asked if you want to add it again. You might need to do this if the supplier has supplied two
prices for the same item based on differences in packaging or other specifications. Note that if you entered an item twice in a single tender to account
for such differences, it will appear twice in the list and you won't need to carry out two selections.
In the event that the currency of the quote from the supplier is not the same for each line, mSupply allows each line's currency to be edited, and the
appropriate one selected.

Entering prices for each quotation line
When you have added all the items you want to the quotation, it's time to add the prices and other details of the supplier's quotation. To do this,
double-click on the first quote line to open the Edit Tender Response Item window:

You will note that this form is very similar to the form for ad-hoc quotes; the related tender is shown at the top, and the item and supplier fields are
filled in automatically. Enter the price and other details the supplier has provided - enter as much as you can because you'll use this information when
comparing quotes from different suppliers.
Manufacturer: Type the first few characters of the manufacturer's name and press the Tab key on the keyboard to see a list of matching
manufacturers. Select the one you want.
Price: Very important, the price you enter is the price for ONE PACK of the packsize shown in the Pack field.
Valid until: The date this quote will expire.
Pack: The pack size (number of single items in one pack) this quote is for.
Currency: The currency the Price is in.
Rate: The rate used to convert the Currency of this quote line to the currency you are using in your datafile.
Rate to use: You can use a different rate to convert the Currency of this quote line to the currency you are using in your datafile if you like - just enter
it here.
Disqualified: Check this if the quote line is disqualified for any reason (excluded manufacturer, for example).
Preferred: Check this if this is the quote you want to accept as the best - see later sections on comparing quotes from different suppliers for more on
this.
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Cost Local/Pack: The quoted cost per pack in your local datafile currency when converted from the quote line currency using the rate entered in the
Rate to use field.
Comment: Enter anything you need to remember or need others to know when comparing this quote with those from other suppliers.
Price breaks: You can also add price break information that the supplier has provided you in the Price break section. A price break is a reduction in
price when you order over a certain quantity. The Price Break quantity is the number of items at which the reduction occurs and Discount is the
percentage reduction that will apply to the price entered in the Price field once the Price break quantity is reached.
Freight: If you are calculating freight based on volumes or weight, or using a freight factor, enter that information in this section.
Supplier: Enter any extra details about the supplier in this section.
When you have finished entering details for the quote for this item, click on the OK & Next button to move to the next item or OK to save the current
quotation line, close the window and go back to the Edit Quote window.
When you have finished adding all suppliers' quotes to the tender we recommend that you set the tender's status to confirmed (on the Edit tender
window at the top).

If you're finding that entering all the supplier's quotes is too much work then
there's help for you! The remote tender module is what you need, where the
suppliers all enter their own quotations and, when the tender closing date has
passed you can simply download them to mSupply. See Uploading and
downloading web tenders for details and give Sustainable Solutions a call if you're
interested.

Deleting an item from a supplier's quotation
If you wish to delete an item from the quotation, click on the line to highlight it, then click the Delete line button. Note that this action deletes the
selected item from the quotation only, not from the tender!

The Reference documents tab
This is used for saving documents which refer to the Supplier's quote, not the whole tender - use the Reference documents tab on the Edit tender
window to do that (see Reference documents for more details). You might want to use this to save a scanned version of a paper copy of the supplier's
quotation, for example.

291

mSupply user guide July 2018

Upload document button: Click on this to store a document with the quote. You will be shown a window allowing you to browse to the required
document. Double-click on the document or click on it and click the Open button to add it to the quote (called “uploading” it). Once it has been
successfully uploaded it will appear in the list of documents below the buttons.
Delete document button: Click on a document in the list to select it and click on this button to delete the file and remove it from the quote. You will
be asked to confirm the deletion.
Download document button: This will allow you to save one of the files in the list to your computer (called “downloading” it) so that you can view or
edit it. Click on the file you want to view or edit to select it in the list then click on the Download document button. You will be shown two options:
click on Download to just save the file on your computer or Download and open to save the file on your computer and open it for viewing or editing.
A window will open for you to select the location to save the file on your computer. Browse to the folder you want to save it in then either doubleclick on the folder or click on it to select it then click on the Open button. The file will be saved in the location you chose. If you selected the
Download and open option the file will also be opened for you to view or edit.
If you want any edits you make to the document to be saved to the quote, when you have finished editing, you must upload the edited version to the
quote using the Upload document button. Don't forget or your edits will only exist on your computer, not on the quote! It is not necessary to change
the document's name so that you don't overwrite the original, as mSupply will recognise that changes have been made, and will save it as a new
version (and keep the old version too). The file's version number will appear in the Version no column. The Show drop down list above that column
allows all versions to be displayed, or only the latest one.

The Comments tab
This is used for adding comments from you or the supplier, things that need to be remembered or considered later.
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Simply type the comments you want to save in the appropriate box. When you click the OK or OK & Next button the comments (and all other
changes to the tender) will be saved.
To view comments saved on the quote, simply view this tab.
Previous: Reference Documents Next: Using Benchmark prices
2011/05/12 08:59

·

Reference documents
While managing a tender, several documents may be consulted - for example, the quotations received from bidding suppliers, quality assurance
documents, or prequalification documents. These documents, provided they are in electronic form (or have been scanned into electronic form if they
were supplied as paper copies), may be uploaded and conveniently stored so that they may be readily consulted.
To access this functionality, open a tender by choosing Supplier > Show Tenders… from the menus and double-click on the tender you want (or
create a new one) to add reference documents to. Finally, click on the Reference documents tab:
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Upload document button: Click on this to store a document in the tender. You will be shown a window allowing you to browse to the required
document. Double-click on the document or click on it and click the Open button to add it to the tender (called “uploading” it). Once it has been
successfully uploaded it will appear in the list of documents below the buttons.
Delete document button: Click on a document in the list to select it and click on this button to delete the file and remove it from the tender. You will
be asked to confirm the deletion.
Download document button: This will allow you to save one of the files in the list to your computer (called “downloading” it) so that you can view or
edit it. Click on the file you want to view or edit to select it in the list then click on the Download document button. You will be shown two options:
click on Download to just save the file on your computer or Download and open to save the file on your computer and open it for viewing or editing.
A window will open for you to select the location to save the file on your computer. Browse to the folder you want to save it in then either doubleclick on the folder or click on it to select it then click on the Open button. The file will be saved in the location you chose. If you selected the
Download and open option the file will also be opened for you to view or edit.
If you want any edits you make to the document to be saved to the tender, when you have finished editing, you must upload the edited version to the
tender using the Upload document button. Don't forget or your edits will only exist on your computer, not on the tender! It is not necessary to change
the document's name so that you don't overwrite the original, as mSupply will recognise that changes have been made, and will save it as a new
version (and keep the old version too). The file's version number will appear in the Version no column. The Show drop down list above that column
allows all versions to be displayed, or only the latest one.

The ability of users to upload and download documents to and from tenders is covered by permissions. To set these permissions
choose the File > Edit users… menu item, double-click on the desired user, and set their permissions on the Permissions(3)
tab:

294

mSupply user guide July 2018

See Managing users if you need more detail.

Previous: Adding suppliers to a tender Next: Using benchmark prices
2011/05/12 09:00

·

Using benchmark prices
A benchmark price can be considered to be a standard price to which other prices can be compared once you are at the stage of evaluating quotations.
mSupply provides the ability to set up benchmark prices to help you make such a comparison. This section describes how to set them up and how to
use them.

The International Medical Products Price Guide, published and maintained by
MSH, is available on their website (http://mshpriceguide.org/en/home/
(http://mshpriceguide.org/en/home/)) and is a good source of information on
medical products from a range of international distributors.

Setting up
You need to create a dummy supplier, that is to say a `virtual' supplier, whose only purpose is to store benchmark prices.
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From the menu, or the Navigator, choose Supplier > New supplier

mSupply® requires that the Code, Charge to and Name fields are completed, so you should choose appropriate entries. In the Category section, the
checkbox Supplier should already be checked, and you must check the Benchmark checkbox.
You may set up more than one benchmark `Supplier'

Entering benchmark prices
Once you have the required benchmark prices, they should be entered into mSupply, and here's how to do it:
Open the Edit supplier window for the Benchmark supplier and click on the Quotes tab

Click on the New Quote button to enter the benchmark figure for each item - in our example we're entering the details for Albendazole 400mg tablets:
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Points to note:
• If the figure you have is for a single tablet, we suggest you multiply it by 100 and change the pack size to 100 to avoid working with very
small figures.
• Make sure that the currency used for the entry is correct, remembering that it might be different from your default currency.
• Make sure that your pack size matches the pack size of the benchmark figure.
Once a number of entries have been made, the window may appear like this:

You will note the difference for each item in the Price column and the Cost column; the explanation is that the default currency in this example is
AUD (Australian dollars), while the benchmark figures are in US dollars; the Cost (and Adjusted cost) columns show the figures converted by
mSupply to their AUD equivalents.
Using the benchmark figures when evaluating submitted quotations from suppliers is discussed here
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Previous: Reference documents Next: Analysing supplier responses and creating purchase orders
2011/05/12 09:04

·

Analysing supplier responses & creating purchase orders
Review
At this stage you should already have performed the following:
1.
2.
3.
4.
5.

Created a new tender
Quantified how much you need to order and added these lines and quantities to the tender
Decided which suppliers should be invited to tender, and added them to the tender
Sent out the tender and invitation to take part to the suppliers you selected
Entered responses to your tender (quotations) from suppliers

Having performed these steps, your tender should be set to confirmed status and you are ready to compare the prices quoted, and decide upon a
preferred supplier for each item.

Benchmark supplier
Before analysing the various responses to your tender, you may wish to set one of the suppliers to be a benchmark (or maybe you had specifically
added a dummy benchmark supplier to the tender and added benchmark prices in their quote). If you so this, mSupply will indicate how much higher
or lower than the benchmark supplier's quote, all the other suppliers' quotes are. It can be a handy indicator to help the analysis process.
To set a benchmark supplier, open the tender (choose Suppler > Show Tenders… from the menus and double-click on the tender in the list) and on
the Tender preferences tab, in the Benchmark supplier section select the desired benchmark supplier in the Benchmark supplier drop down list:

For more details on using benchmark price see Using benchmark prices.

Analysing the responses
Once you have the tender open (choose Suppler > Show Tenders… from the menus and double-click on the tender in the list), select the Items and
compare prices tab:
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Note that mSupply will remember any changes you make to the widths of the columns on this tab. This can be
very useful if you want to minimise columns you are not interested in to make room for other, more important
columns over several sessions to select the winning bids.

Then double-click the first item in the list, which in our example is Acetazolamide 250mg tablets, to bring up the Edit tender item window, which
opens at the Compare supplier responses tab:
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In our example, 5 suppliers have been invited to tender, and 4 have submitted tenders, one supplier having submitted prices for two different pack
sizes. One supplier has not submitted a quotation, so all the entries for that supplier are zero.
The important column is the Adj Cost column, this allows you to compare prices which have been evened out to cater for differences in pack sizes,
currencies and freight costs. mSupply makes it easy to identify the lowest price quoted because it appears in blue type. Clicking the Adj Cost column
header will sort the entries so that the cheapest one appears at the top of the list.
If a benchmark supplier had been selected then the +/-% column would display what percentage above or below the benchmark supplier's quote that
particular quote was. A negative value indicates that the quote is below the benchmark quote, a positive value that it is above. e.g. a figure of -2.78%
would mean that the quote was 2.78% less than the benchmark quote.
If you want to highlight any particular line for any reason, you can change its colour by clicking on it in the list to select it then selecting the desired
colour from the colour drop down list (currently showing “Black” in the screenshot) in the top right hand corner.
Note that if you want historical data of all previous stored quotes for an item, including those from previous tenders, this is available by choosing
Items > Show items… from the menus, locating the item, then viewing the Quotes tab.
Before marking the supplier of the cheapest item as the preferred supplier, there are other factors to be considered, including:
1. Has the supplier met all the tender conditions?
2. Is the proposed delivery schedule acceptable?
3. Is the product being supplied by a reputable manufacturer?
The Disqualified column allows you to disqualify the quotation from a particular supplier if required by checking the box in the relevant row.

If you want to see more information about a particular quote line, double-click its
row to open the Edit quote line window to view all the details of the quotation
(and edit it too - useful if you discover a data entry error, for example). You may
want to fill out the Quote Comment to record any decisions you made e.g. reason
for disqualification.

When you have decided on a supplier for an item, check the box in the Preferred column in the row for that supplier. Proceed to the next item by
clicking the OK & next button and repeat the process. When you have finished, click the OK button to return to the Edit Tender window.
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It is, of course, not necessary to complete the selection of preferred suppliers at one session on the computer; it can be done in stages. Actually, you
don't have to select preferred suppliers for all items before you complete the tender; you may want to wait for more favourable market conditions
before purchasing some items, for example.
Please also note that all changes to tender lines are logged by mSupply.
Here is an example of a tender that has been partially processed, looking at the Items and Compare prices tab:

Two of the lines have been changed to a green colour and the Show drop down list just above the list of items has been changed to “Not chosen” so
that it displays all the items for which a preferred supplier needs ot be chosen - helpful for seeing what still has to be done!
If the Show drop down list is changed back to “All”, all items will be displayed in the list, with the name of the Preferred supplier column for each
line shown in the Preferred Supplier column.

Back to the Items and compare prices tab
Once you have finished editing, click OK (or Cancel if you want to close the window without saving changes to the current tender line).
The column Preferred Supplier will now display either the name of the supplier you have chosen or Not chosen where you have not yet processed
the item.
The Original column will display the cost of that line if you purchase the tender quantity of that item from the preferred supplier in the currency
quoted (The Original Local column displays the cost in the local (default or home)currency you are using in mSupply). Note that you might end up
editing the quantity on the purchase order to a different value, and then the PO local column will have a different value.

Back to the Choose Suppliers and Enter responses tab
Just before you create purchase orders for the winning suppliers you might like to see the value that each supplier has won. To do this, click on the
Choose Suppliers and Enter responses tab and the total value that each supplier has won (i.e. the total value of all the lines where they were selected as
301

mSupply user guide July 2018

the preferred supplier) will be shown in the Tender value column. The total amount that each supplier bid will be displayed in the Total bid column.

Reports
You might need to provide reports to a tender board, or for internal records. The tender module has several reports built in, accessed by clicking on the
Print internal report button on the Items and compare prices tab of the tender details window. Clicking on the button displays this window with a
drop down list of reports to choose from:

Winning tender lines: Shows all the items in the tender which have been allocated a preferred supplier and the costs of those lines. This is an
example:

Supplier quotes for each item: Shows quotes from all suppliers for all items, grouped by item. Handy for a summary of all received quotes.
Tender lines with predicted cost: Can be used to give an approximate cost of the tender before choosing preferred suppliers for all items has been
completed. Where items have not been allocated a preferred supplier, mSupply will use previous purchase costs as an estimate of what the cost will be
in this tender.
Tender lines: lowest price not chosen: Shows all tender lines which have been chosen as the winning bod when their price was not the lowest.
Summary detail shows how much more you will pay than choosing the cheapest lines.

Setting up Purchase Order (PO) preferences
Once the choice of preferred supplier has been made for all the items you want to purchase in the tender, the next stage is to generate the Purchase
Orders.
Click on the Tender Preferences tab on the Edit Tender window:
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mSupply offers two options for creating Purchase Orders:

1. Recalculate PO quantity according to usage should be chosen if you wish mSupply to take into account the usage during the period since
the tender was generated; this may be significant depending on the length of that period of time.
2. Distribute Tender quantity evenly should be chosen if you wish to make no changes to the quantities calculated at the time the tender was
generated.
For our example, we are choosing Distribute Tender Quantity evenly because we are content with the quantities which mSupply has calculated and we
do not want to make any adjustments. In this case, the Based on field should be ignored.
Split deliveries
If you want to receive split deliveries, then mSupply will create multiple purchase orders for you, each with a different requested delivery date.

mSupply will behave differently when creating Purchase Orders depending on
whether this option is checked or not.

Note that the creation of purchase orders from tenders will be logged by mSupply.

Creating Purchase Orders with split deliveries
1. Go to the Purchase Orders tab
2. If you have checked the “Split deliveries” checkbox in the preferences for this tender, the first button on the toolbar will be Create blank
POs.

You will need to confirm that this is what you want to do by clicking the Yes button on the confirmation window which appears:
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You are then shown a list of suppliers:

Click on the supplier(s) you want to add, and enter the requested delivery date, then click OK.
You will need to add each supplier twice if there are to be 2 deliveries, or 3 times for 3 deliveries (etc) Make sure you get the delivery date right for
each one.
You can double-click an already entered line to change the delivery date.
Use the Delete PO button to remove a purchase order (highlight to one(s) to delete before clicking the button).
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Creating Purchase Orders without split deliveries (single delivery)
If you aren't creating split deliveries, the first button will be labelled Create PO
1. Click this button, and the needed Purchase orders will be created.
2. Double-click a row to see the order.
3. Return to the “Suppliers” tab if you want to see the value of the purchase orders in total.

Viewing tender purchase orders
When you have created purchase orders in a tender you can view them at any time by clicking on the Purchase order tab which will look like this:

To see the details of the items on any of the purchase orders in the list, simply double-click on the purchase order's line in the table and you will be
shown the details in a window which looks like this:
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Editing Purchase Order Quantities
Once you have created Purchase orders you might want to edit some quantities (for example, you might want the first of two purchase orders for a
supplier to have 60% of the total order, and the second purchase order only 40%)
1.
2.
3.
4.
5.
6.
7.

Go to the “items and compare prices” tab
Double-click a line to edit
Go to the Purchase Order tab.
You will see your purchase orders for that item.
To edit the first row, click once on the quantity, wait 2 seconds and click again.
You can now change the quantity.
Use the tab key to advance to edit the quantity of the second row, etc.
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Converting to a "normal" purchase order
While a purchase order is being created and edited inside the tender module, it has the status of “tn” and isn't visible in the same way that purchase
orders created outside the tender module are. Purchase orders that are visible in the main mSupply system have a status of “sg” (or “cn” or “fn”). Once
you are satisfied with your purchase order in the tender module do this:
1.
2.
3.
4.

Go to the purchase orders tab
Click on a purchase order to convert (only one at a time at the moment, sorry)
Click Convert to SG
Confirm the warning window, and the purchase order will now:
a. no longer be editable in the tender module
b. be available using Suppliers > Show Purchase orders from the mSupply menu or navigator.
5. Repeat the process with other purchase orders that are ready to send to a supplier.
You can now view the purchase order, confirm it, and send to a supplier - see Purchasing: Ordering from Suppliers: Viewing a purchase order.

Finalising a tender
This should be done when all processing of the tender is complete and the purchase orders have been created and sent to the suppliers. The tender will
not be editable after this so PLEASE make sure you are sure that all processing is complete!

When you finalise a tender you will be warned if there are no Purchase orders
associated with it because you won't be able to create them later!

Previous: Using benchmark prices Next: Supplier instructions for using the tender submission web interface
2011/06/06 05:51

·

Supplier instructions for using the tender submission web interface
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Introduction
This user guide explains how to use the web site at https://tenders.msupply.org.nz (https://tenders.msupply.org.nz) that is used by mSupply users to
publish tenders. It is only relevant if you are a supplier who is being invited to tender by a user of this system. If you have been invited to tender and
have questions that are not answered in this document, you may request support by emailing tender_support@msupply.org.nz.

• Save the login credentials. The login credential for the website does
not change. Once received, it is the responsibility of the supplier to
securely save or note down the login credential for future tender
participation.
• Don't wait until the last minute. Many suppliers have left the entry of
tender till the last moment, not followed instructions correctly, and
bombarded Sustainable Solutions with support requests during the last
24 hours of the tender closing. Please do not do this.
◦ Please carry out a dummy run of entering lines and saving.
You can change your entries later before finalising the
tender. This will allow you learn how the system works
without the pressure of a submission deadline.
◦ If you choose to populate the tender with an uploaded file,
that too should be tried out in advance and not left till the
last moment. The instruction must be followed carefully. For
example, importing an Excel file directly will not work.
The file must be a Windows tab-delimited text file - refer
Uploading prices.

How it works - a summary
1.
2.
3.
4.

The Client prepares tender document and distributes by email to suppliers.
Each Supplier receives details, including a username and password, for accessing the secure website where the tender is to be found.
The password provided is valid only for the first time the website is accessed, so the supplier’s first action will be to change it.
During the period between receiving the tender document and the tender’s deadline, the supplier decides on the quotations to be submitted,
and enters the details on line. This may be done over multiple sessions.
5. Before the deadline, the supplier finalises the quotation; this action is not reversible and prevents any further changes being made. The
status is changed from SG (suggested) to FN (finalised).
6. Once the deadline is passed, the client may access all quotations which have been finalised, evaluate them, and notify successful suppliers.

How it benefits suppliers
• Accuracy: you can be confident that the information entered by you will be accurately transferred. Manual systems are prone to
transcription errors in the price, pack size, currency, etc.
• Speed: while the tender process may be slightly slower for the supplier, the time between tender closing and bid evaluation is dropped from
weeks to one or two days. This means tender closing dates can be moved closer to the date on which suppliers are notified of winning bids,
benefiting all involved.

Costs
• There is no charge to suppliers to use the system. Development and maintenance costs are covered by software support contracts with
mSupply users.
• If you pester us with frivolous support requests (i.e. things that are answered in this document), this policy will be reviewed.
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Charges to suppliers
Due to a steady stream of requests for help for issues that are covered in this guide,
or issues that are not our fault (e.g. password reset requests), the review mentioned
above has been carried out and we now often charge for these kinds of support
requests.

Security
• We take the security of this module VERY seriously.
• Only https (secure) website access is allowed: observe the closed padlock icon in the corner of your browser. This means that no-one can
read the interactions between you and the tender server.
• Automatic disconnection: should there be no activity after a short time, you are required to confirm that you are still working on the
website. In the absence of such confirmation you are disconnected and the login screen reappears.
• One-time password: the password provided for the first time you access the website is valid only for that first occasion. You must change it
to a password of your own choosing for continued access to the website.
• The server running the Tender Management System is managed by Sustainable Solutions and is accessible by us alone. We know this
system will only be successful if we maintain the highest standards of ethical, impartial behaviour and keep your data secure and accessible
only to authorised parties.
• Restricted access by IP address: if you wish to limit access to your online account to users within your office, let us know an IP address or
subnet that you will use and we will put this restriction in place until you instruct us to remove it.
• We track the IP address of all log on attempts. Repeated attempts from the same IP address will be blocked.
• We have coded the software carefully to ensure that supplier information entered is only available to that supplier and to the customer
(obviously once the customer downloads the submitted bids, we can not control the information flows outside of our system).
• All emails sent by the tender module are sent by SSL (Secure Socket Layer) for added security.

First logon
Log on to https://tenders.msupply.org.nz (https://tenders.msupply.org.nz) and this is the window which appears when you log on

You should enter your supplier code and password, both of which were sent to you by email.
You will immediately be shown the window for changing your password:
In the Old Password field you should enter the password sent to you by email. You must then enter a password of your own in the New Password
field, re-entering it in the Confirm Password field; when you have done this, and clicked on OK, the standard log on window appears again, and you
should enter your user name and the password which you have just created. You will now be logged on to the system, and these are the details you will
use for logging on in future..
Note that the web site uses a large Javascript library, so will take a few moments to load the first time you use it. In return you get a fast and easy-to309
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use interface.
If you have chosen to do so in the preferences, each time you log in, you will be sent an email saying that you logged in to the web interface - this
means if someone else was to log in to your account, you would know about it.

Staying logged on
If no user activity is detected for a few minutes, as a precautionary measure to restrict unauthorised access, a window appears. You need to click Keep
Working, otherwise you will be logged out.
Once you have logged on, you will be shown a list of tenders for which you have been invited to submit quotations.

The example shows that 4 tender documents from client Namaste Medical Stores, have been uploaded and await the supplier’s attention.

The My Information button
Clicking the My Information button displays this window:
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The above window may not display properly using the Google Chrome webbrowser. If this is the case, then please use Firefox.

This is where the supplier’s details held on the server are entered and stored, and this is also where they can be edited. Those details include name,
address, contact details, and the default currency for this supplier.
Default currency The default currency is that currency in which the you normally supply quotations - in the example shown, it is Singapore dollars,
and this will normally remain unchanged for a particular supplier; suppliers located in another country are likely to use their own country’s currency as
their default one.. In the case where a supplier submits a quotation with one or more lines quoted in another currency - e.g. Euros or US dollars - the
particular currency used is entered on the appropriate line of the quotation Note that changing your default currency will affect new quotations, and
won’t have any affect on existing quotations.
Inactivity time This is the length of time in minutes after which you will be logged out if there is no activity. 10 minutes is the default but you can
choose from between 1 and 60 minutes.
Email me manufacturer list As the name suggests, this will email a tab-delimited text file with the complete list of manufacturer names and their
corresponding codes to the email address specified. If you want to take advantage of the new facility to upload a quotation as a tab-delimited text file,
you will need to use the manufacturer codes specified in this list.
Saving your settings and closing the window Click the OK to update button to save your settings. Click on the close box in the top right of the
window to close it when you are finished.

Viewing the tender list and individual tenders
The window which appears when you log on is the Current Tender List, and it shows all of the tenders for which the supplier has been invited to
submit a quotation; it also shows the status of the tender, which is set to SG (= suggested), and should remain at this status until all work has been
completed, and the quotation is ready to be finalised. Access to a particular tender document is achieved by double clicking on the line. The tender and
the items involved in it are then displayed in a window which looks similar to the following:

Description: This is the description or title of the tender. Use this whenever you refer to the tender so that everyone knows you're talking about the
same one!
Customer: This is the name of the organisation who created and published the tender and then invited you to respond to it.
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Currencies drop down list and Set currencies icon: This sets the default currency for your quote. Use the set currencies icon to change the currency
for all items currently entered. If you struggle to find the correct currency, type the first letter of the one you want and you will be taken to the first
currency beginning with that letter. The list is in alphabetical order so it should make it easier to find.
Show button: displays the whole of the customer's comment if they've entered one. May contain useful information for you.
Edit button: Displays a window to enable you to enter or edit a longer tender comment for the customer (the one who invited you to tender). Any
information you want to convey to the customer about your quotes can be put in here. Note: you also have the opportunity to enter comments on
individual quote lines. See Entering prices section below.
Duplicate button: Duplicates a selected quote line. Will put the new quote line at the top of the quote. Helpful if you want to enter a quote for the
same item but with slightly different details. If you need to do this for many items, use the Upload button mentioned below.
Show totals button: Shows the total value of your quote for each currency you've included in your quote.
Reset lines button: Removes any changes you have made to the selected quote lines.
Email me this quote button: Sends you a copy of your quote as it currently stands. It will be sent to you a tab-delimited text file attachment to an
email.
Email me a quote template button: Sends you a copy of the tender with all items included with no price or other information added. This is the
perfect thing to use as a base for your quote if you are going to create it in a spreadsheet and upload it using the upload button (see below).
Browse button: Allows you to select the tab-delimited text file to upload as your quote.
Upload button: Uploads the selected text file as your quote (see the Uploading prices section below).

Entering prices
To enter the details for a line, double click on the line.

Details should be entered in each of the columns:
Item code, name and quantity These are fixed by the tender and cannot be changed.
Pack size The pack size requested by the customer is already on the form; if needed, it can be changed.
Price per pack The unit price of the pack you are offering to supply in the chosen currency.
Expiry date and delivery time When completing these fields, it is suggested that a series of abbreviations be used:
•
•
•
•
•
•

min = minimum
max = maximum
w = week
m = month
y = year
So for example, if you want to indicate a delivery time of 3 months, enter “3m”
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Delivery times should be specified from when you receive the purchase order, so
must also include the time for order compilation by the supplier

The tender document is likely to specify minimum expiry dates, but it is important that there should be no misunderstandings. Delivery time is
understood to mean the estimated period of time between the consignment leaving the supplier’s premises and delivery to the customer.
Currency: The relevant currency should be selected from the drop down list - it doesn't have to be the same as the default currency. If you're
struggling to find the right currency from the list, type the first one or 2 letters of the currency you want - should make it easier to find.
Manufacturer: The name of the manufacturer should be chosen from the drop-down list. Typing the first few characters of the manufacturer's name
will show a list of matching manufacturers. Click to select one.
Manufacturers are not linked to suppliers in our system, so multiple suppliers who source goods from the one manufacturer do not cause a problem.

Problems saving entered data ? : Simply entering price and saving is not sufficient.
The website will not save the row of data. The Manufacturer column must also be
filled with a valid manufacture. If you choose to not to specify a manufacture then
simply choose : “Not Specified” as the options.

Adding new manufacturers into the tender module
Due to the desire of mSupply users to collate manufacturer data, you cannot enter manufacturer names yourself. If you want to have a manufacturer
added to the list, please email to tender_support@msupply.org.nz (mailto:tender_support@msupply.org.nz) and we will add the name(s) within 24
hours.
Please submit Manufacturers in the following manner:
The country where the manufacturer is based must be specified. The address column is optional.
If you have more than 5 manufacturers to add then it may be worth creating and a spreadsheet with the column headings described below, then sending
to us as an attachment:
Manufacturer

Country

Address (optional)

John Western Pharmaceutical

US

32 Obama Road, Virginia

Jürgen Klinsmann Group

Germany

Göppingen, West Germany

Universal Supplies

Great Britain

If you do not want to or cannot specify the manufacturer, choose the entry 'Not specified' from the list. You may wish to add a comment to that quote
line to explain your entry.
Country of Origin: Some tenders require you to specify country of origin instead of manufacturer. Common countries are specified in the
Manufacturer list, so you can just choose a country rather than a specific manufacturer if you wish.
Comment: Use this column for entering any comment or note you may wish.
Once you have made all the entries for a row, click Save to update the tender document with the details you have entered. It is quite possible that you
will not have all the necessary information to complete a tender document at a single session; this is not a problem - just close the document at the
stage you have reached and later, once you have the further information you require, reopen the document and continue with the process.
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Submitting multiple quotations for the one item If you wish to do this, then select the line you wish to submit a second (or third) price for and click
the 'Duplicate' button in the toolbar. Fill in the details of the second quotation.
Tender conditions Some tenders may have more restrictive conditions than the web site allows for. For example, a tender may specify only one
currency, or that multiple quotations for the same item are not allowed. Currently the web site will NOT reflect such conditions, and it is your job to
read the tender conditions and respond accordingly.

Uploading prices
This facility allows you to upload a specially formatted tab-delimited text file containing a header line and one or more item lines for your quotation.

Preparing the quotation file
The file should be in plain text format, having the following 10 columns, each separated by a tab, and without using any kind of quote characters as a
text delimiter around individual fields:
•
•
•
•
•
•
•
•
•
•

Item code
Item name
Quantity
Pack size
Currency (in 3 letter international code format: e.g. AUD USD EUR )
Price per pack
Expiry date
Delivery time
Manufacturer code (as per the manufacturer code list you can download from the “My info” button when logged in)
Comments

This is very similar to the file format you will get if you select the 'Email me this quote' button on the tender items window, but with the manufacturer
name replaced by the manufacturer code (less likely to make mistakes as the code is shorter). You can download a manufacturer list from the 'My
information' page (see the 'My Information button' section above). Note that the Item Name and Quantity columns are only included for the sake of
human readability, and will be ignored.
If you wish, you can download a suitable template for uploading by clicking the 'Email me a quote template' button on the top-right of the tender items
window. This will have the first four columns pre-filled for your convenience and is the best way to start if you intend to upload your quotes.
• If opening using Excel, save it in Text (Tab delimited) format before uploading (select File > Save as… then select “Tab delimited text
(.txt)” in the Format drop down list. This is true for Excel 2011, it might be slightly different if you're using a different version). Please note
that Excel on Apple MAC's may not create the Text (Tab delimited) format file that will comply with the website. Please use Excel on a
windows PC, unless if you are fairly IT literate.
• If opening this template using OpenOffice, saving it as tab delimited text is done in a slightly different way:
◦ Select File > Save as… from the menus
◦ In the File type: drop down list select the “Text CSV (.csv)” option and click on the Save button
◦ In the Export Text File window that opens, select “{Tab}” in the Field delimiter drop down list and delete the double quote
marks in the Text delimiter drop down list so it looks like this:
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◦ Click on the OK button and you're done
• The header line, with the column titles, is included for the sake of human readability, but will be ignored during import. But make sure the
header row is there, otherwise your first quote line will be ignored.

Please note that:
• The text file must be in tab-delimited format (not comma separated)
• The end-of-line character is a carriage return- you must not have any
carriage returns (end of lines) in the comment or manufacturer fields of
a row, or the upload will fail, thinking it has reached the end of a row.
• The decimal point separator must be a period (“.”) not a comma.
• The currency should be entered using standard 3 letter currencies as per
https://www.iban.com/currency-codes.html (https://www.iban.com/
currency-codes.html) (3rd column)
• the upload process will ignore the first line of the file. This line is
reserved for the column headings so that the text file remains humanreadable. So, whether you use the template sent to you via email or
whether you manually create an upload file make sure the first line of
the file contains column titles and not quote information.

Uploading the quotation file
First of all, you need to select the file that you wish to upload by using the Browse button on the far right of the tender items window. The selected
filename will then be visible in the text field to its left. Then click on the Upload button and you will be presented with the following window:
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Update existing quote lines: Select this if you want the contents of the file to update quote lines already in the tender. Note that information will only
be updated for items in the tender where the current price for the line is 0. If a line in the tender has a non-zero price any line in the file with details for
that item will be ignored. So, if you want item lines to be updated by the contents of the file reset their prices to 0 before you carry out the upload.
Note also that if there is more than one matching zero-price tender item line with the same item code, then it will select the first match it comes to i.e.
the system will cope with multiple quote lines for the same item. Therefore, if you want to upload multiple lines for an item, you need to duplicate that
line in the tender first (using the Duplicate button on the toolbar) before uploading the file.
Replace existing quote lines: Select this if you want the contents of the file to replace everything already in the tender. All your existing lines will be
deleted from the tender and the contents of the upload file will be entered into the tender. Note that if there are multiple lines in your upload file with
the same item code this method will put them all into the tender. This is helpful if you keep your text file as a master copy and use it to update your
quotes. And also means that you can easily input multiple quotes for the same item (with different pack sizes or manufacturers, for instance - but
mSupply won't check so the multiple lines could be identical if you wish).
Click on the Cancel button to cancel the upload or the OK button to continue.
Having clicked on the OK button you will, after a short while, get a confirmation that the upload was successful and the list of displayed tender items
will be updated to reflect the data that has just been uploaded.
Please note the following points regarding the file upload process:
• Only text files (extension of '.txt' or '.csv') smaller than 1Mb are accepted.
• Currently, the only web browsers which fully support file upload are Firefox and Chrome. The next versions of Internet Explorer, Safari
and Opera are also planned to include support for this new HTML5 feature.
• A successful upload message does NOT imply that the contents of the file are valid, simply that it has been processed. An email will be
sent to your email address, with two attachments:
◦ A text file which contains the output generated from the upload process i.e. the number of records which were successfully
processed, and any error messages generated during the upload process.
◦ A tab-delimited text file in the same format as produced by the 'Email me this quote' button, which will include the updated
tender items - you should check that this reflects the changes you are expecting.
• Any blank lines in the uploaded file will be ignored.
• Any lines which do not contain the expected number of columns, or with data in the wrong format will generate an error message and will
not be imported.
• Any lines with an invalid item code or an invalid currency code will generate an error message and will not be imported. We use the
standard 3-character currency codes - see here (http://www.xe.com/iso4217.php) for a complete list.
• Any lines with an invalid manufacturer code will still be imported but will be given a manufacturer of 'Not specified'.
Note also that it is possible to perform as many file uploads as you like.

Finalising a tender

• Firstly, be warned: Finalising means exactly that. It can not be undone.
• Only when you are satisfied that you have completed the details on all
the lines for which you are quoting should you finalise your tender
entry.
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Email it to yourself first
We strongly recommend you use the button in the tender window to email yourself the tender, and then check that the entries in the online tender
module match your intended entries.
To email a quotation to yourself, open the tender your wish to email, and then click the “Email it to me” button at the top-right of the window.

What finalising does
Clicking on Finalise does two things:
1. It locks the tender document, changing its status to FN (finalised) and you can make no further changes to it.
2. It makes the finalised tender submission accessible to the customer once the tender has closed. Only finalised quotations will be accepted
by the customer.
Finalising the tender submission, therefore, must be performed before the closing date as specified by the customer.

How to Finalise
1. You need to be viewing the list of tenders, not the particular tender you have just entered.
a. If you are not logged in: Log in and you will be shown the list
b. If you are editing your tender, close it to return to the list of tenders.
2. Check the checkbox in the left-hand column next to the tender you have completed
3. Click on the Finalise button.
4. You're done

Closing date and time
Note that closing date and time is specified as GMT (Greenwich Mean Time). This is NOT likely to be the same as your local time. Please take this
into account when planning for when you will finalise your prices.

Results notification
The client will notify successful suppliers directly by submission of a purchase order. The web site will not show you any information about you or
any other supplier’s success or otherwise

Obtaining support
Please email tender_support@msupply.org.nz if you have any problems. We are based in Nepal, but provide support 18 hours per day Monday to
Friday while there are open tenders in the system.
Note that you should only communicate with us regarding technical matters. For all matters relating to tender conditions, pricing, etc., communicate
directly with the client who published the tender.

The future
• We hope you appreciate both the concept and the hard work we’ve put into making this system work for both clients and suppliers.
• The system is used by several mSupply users, and is being taken up by more each year.
• We have lots of our own ideas on how to improve the system, and we’d love to hear your criticisms, compliments or ideas as well. Use the
email address above.

Warranty
There is none. Our software is provided “as is”. We take the responsibility to act fairly and carefully very seriously. We are replacing manual systems
that are prone to gross errors, so even when our system experiences the odd (very rare) issue, it remains a vast improvement on what has gone before.
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Infrequently asked questions
• Q: What if your server failed just before a tender closed.
◦ A: Our advice is: This isn’t an auction. There is no need to submit at the last minute. However, if there was more than a few
minutes of downtime in the last 24 hours of a tender, we would ask the customer's permission to extend the closing date. Also,
our server has been running for several months. Should the tender module prove popular we will transfer it to a data centre.
• Q: Can we phone you for support.
◦ A: Yes.
▪ Nepal: +977 1 5548021
▪ New Zealand: +64 22 519 0499

Thanks
Thanks to the staff of Republic of Kiribati’s Ministry of Health & Medical Services Pharmacy Department who pioneered the use of this feature! :-)
Previous: Analysing supplier responses &amp; creating purchase orders Next: Uploading and Downloading Web Tenders
2011/10/17 09:15

·

Using web tenders
A web tender is one that is uploaded to our remote tender server and is made accessible to suppliers to enter their responses. This greatly reduces the
load on you to input all the responses from all suppliers and means there will be far less data entry errors.

Setup
To use web tenders, there are several setup steps that only need to be done once:
1. Contact Sustainable Solutions to arrange a user account. We'll send you your account details.
2. In File > Preferences…, on the Tender tab, enter the account details Sustainable Solutions sent you. See General preferences, Tenders
section for details.
3. Link each of your suppliers with the Supplier's master record on the tender web site. For further information see Adding and editing names,
Master ID and Master name fields.
4. Tell Sustainable Solutions about any of your suppliers that are not in the tender web site list. We will then add them, and you can link the
remaining suppliers.

The process
The following steps describe the whole remote tender process:
1.
2.
3.
4.
5.
6.

Carry out the setup steps given above.
In mSupply, create a new tender.
Set up tender name, reference number, opening and closing date.
Add items to the tender. Make sure you add a quantity and pack size for each item.
Add suppliers to the tender.
Go to the Synchronise tab on the tender details window and click on the Upload tender to web site button to upload the tender to the
tender server. You will be given an error message if the upload is not successful. If you get stuck, contact Sustainable Solutions for further
assistance. For a tender to upload successfully:
◦ Each supplier must be linked. You will be warned if they aren't.
◦ Your internet connection must be working.
◦ You must have entered the user name and password correctly in the mSupply preferences Tender preferences (see above).
7. Inform suppliers by sending physical or electronic tender documents (both can come from mSupply) and send them a link to the Supplier
instructions for using the tender submission web interface
8. The suppliers enter their bids into their part of the remote tender server web site.
9. After the tender has closed, download the tender by going to the Synchronise tab on the tender details window and clicking on the
Download tender from web site button. You will be given an error message if the download is not successful. If you get stuck, contact
Sustainable Solutions for further assistance. For a tender to download successfully:
◦ Your internet connection must be working.
318

mSupply user guide July 2018

10.
11.
12.
13.
14.

◦ The tender closing date must have passed.
Compare prices and print appropriate reports for the tender committee or others.
Award each item to a supplier.
Create purchase orders.
Send the purchase orders to the suppliers.
Sit back, relax and give yourself a pat on the back. Nice going.

Uploading the tender is final…
mSupply records when a tender has been uploaded, and will no longer allow the
editing or deletion of tender lines on that tender. So make sure your tender is
correct and complete before you upload it!

Previous: Supplier instructions for using the tender submission web interface Next: Ordering Items From Suppliers
2011/12/08 02:23

·

Ordering items from suppliers
Introduction to Ordering
mSupply provides ways for you to generate a Purchase Order with manually or automatically calculated quantities. Each organisation tends to have
different requirements for their ordering process, so we have tried to strike a balance between providing different methods and making the ordering
module so complex that it is of little use to anyone. mSupply has two general methods for generating a purchase order:
• Creating a new calculated purchase order. We recommend that you use this method since it will save you time and avoid mistakes.
• Creating a blank Purchase Order. This method allows you to create a purchase order based on manual calculations of quantities.
However you create a purchase order, the purchase order window looks like this:
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There is some read-only information at the top of the window which cannot be edited:
• Order num: This is the purchase order's number. It is automatically generated and increments by 1 for each new purchase order. It is unique
within a store only so it is possible for purchase orders in different stores to have the same number.
• Confirm date: The date the purchase order was confirmed. If it has not been confirmed yet, this will be “00/00/00”.
• Status: The current status of the purchase order:
◦ sg = suggested, the purchase order is still in the process of being completed and can be edited. No goods can be received against
it yet
◦ cn = confirmed, the purchase order is complete and cannot be edited. Goods can now be received against it
◦ fn = finalised, the purchase order cannot be edited and goods can no longer be received against it
• Store: The name of the store the purchase order belongs to.

Creating a new (calculated) Purchase Order
Before launching into creating a new (calculated) Purchase Order, it is important to understand the logic that mSupply uses.

Logic used for calculating Purchase Order quantities
There are three distinct steps required to arrive at Purchase Order quantities for each line of stock:
• Forecast future consumption
• Calculate required stock quantity
• Calculate purchase order quantity
mSupply uses this methodology to produce a suggested order quantities in a number of other places including:
• Creating a new tender
• The suggested order report
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To assist in understanding these calculations, an example will be developed through the following sections. Amoxycillin 250mg tabs/caps is being
ordered at the end of December 2015. Historical consumption data is as follows:
Month

2013

2014

2015

Jan

200

1,000

1,000

Feb

250

1,050

1,100

Mar

300

950

900

Apr

350

1,000

1,000

May

400

1,200

1,400

Jun

450

800

600

Jul

500

1,000

1,000

Aug

550

1,150

1,300

Sep

600

850

700

Oct

650

1,000

1,000

Nov

700

1,100

1,200

Dec

750

900

800

From this data, the following AMC (Average Monthly Consumption) calculations can be made.
Period

AMC

Last 36 months (Jan 2013 - Dec
2015)

825

Last 24 months (Jan 2014 - Dec
2015)

1,000

Last 12 months (Jan 2015 - Dec
2015)

1,000

Last 6 months (Jul 2015 - Dec
2015)

1,000

A more detailed analysis of this historic consumption shows a steady increase through 2013, and then the AMC sits at 1,000 per month in 2014 and
2015. In this case, we have an AMC of 1,000 per month regardless of whether we look at 6, 12 or 24 months of historic consumption data.

Forecast future consumption
By default, mSupply uses the assumption that future consumption will continue at the same level as consumption over a given historic period.
mSupply has a number of other options for making a forecast of future consumption. All of these methods are documented in the Forecasting section .
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Calculate required stock quantity

mSupply does not use set “minimum” & “maximum” stock levels as its primary means of determining order quantities.
Conventional minimum and maximum stock levels are calculated using the methods described here, but it is problematic to try
and fix these values, because:
• The parameters will keep on changing,
• It takes a lot of manual work to calculate,
• The assumptions made in calculating them are often lost.
Be assured that the system that mSupply uses will give you much better inventory control!
Having said that, mSupply does allow for minimum stock levels so as to allow you to ensure a minimum quantity of rarely used
items. e.g. essential emergency supplies - refer Other information on the stock details page. These minimum stock levels should
not be used for most items.

The amount of stock you require to have is based on the forecast of future consumption (previous section), modified by a range of factors including:
• The Lead time: The time delay between ordering stock and its delivery to your store.
• The Ordering cycle: How often you order from this supplier
• How much “buffer” stock you want on hand just before your next order arrives.
All of these are measured in months.

Some agencies recommend the buffer stock to be double the Ordering cycle. However, if your ordering cycle is long (say 12
months) then this means keeping two years worth of stock as a buffer. This could become a problem with expiry dates.

For example:
• Lead time = 3 months
• Ordering cycle = 6 months
• Buffer stock = 12 months
From the equation above, Stock required is calculated as:
• = Lead time + Ordering cycle + buffer stock
• = 3 + 6 + 12
• = 21 months.
So, 21 months worth of stock is required.

The amount of stock required is almost certainly NOT the amount of stock to be purchased! See the next section: Calculate
purchase order quantity for an explanation.
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Calculate purchase order quantity
Purchase Order quantities are based on the amount of stock required, normally expressed as a number of months of AMC, modified by factors
including:
•
•
•
•

The current stock level.
The amount of stock on backorder to customers ((if you are running the backorder feature).
The amount of stock already on order from Suppliers, but that has not yet arrived in your store.
The months of anticipated stock-out before the order arrives (more on this below).

mSupply makes an important assumption as to how to handle anticipated stock-out. That is, the situation of running out of
stock before the order arrives. mSupply assumes that the consumption that you forecast to happen between you running out of
stock, and the purchase order stock arriving should not be provided under this purchase order. The basis for this are two further
assumptions:
• You will either obtain the shortfall through another purchase order (an emergency order, or from another supplier), or
you will simply run out of stock.
• Your customers will not increase their demand in the time immediately after you receive the stock from this
purchase order to compensate for the stock being unavailable prior to the new order arriving.
Therefore, mSupply reduces the purchase order quantity by the anticipated stock-out amount.

It can be seen that
• Anticipated Stockout = the Lead time - Current stock level + stock on backorder to customers - stock on backorder from suppliers
If the above equation produces a negative number, this means that there will be no stock-out, and the anticipated stock-out will have no impact on the
Purchase order quantity. So, for the purposes of this mSupply calculation, Anticipated Stockout = maximum of zero and the above expression. This is
expressed mathematically as:

Continuing our worked example, suppose:
• Current stock levels = 5 months
• Stock on backorder to customers = 3 months
• Stock already on order from Suppliers = 2 months
Then, Anticipated stock-out is calculated as:
•
•
•
•

= max(0,Lead time - Current stock levels + stock on backorder to customers - stock on backorder from suppliers)
= max(0,3-5+3-2)
= max(0,-1)
=0

and Purchase order quantity is calculated as:
• = stock required - current stock level + stock on backorder to customers - stock on backorder from suppliers months of anticipated stock-out
• = 21-5+3-2-0
• = 17
So 17 months worth of stock to be ordered. Compare this with the 21 months worth of stock required calculated in the previous
section!
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To demonstrate the impact of a stock-out, let us suppose that we have only 1 month's worth of stock on hand:

• Current stock levels = 1 month
• Stock on backorder to customers = 3 months
• Stock already on order from Suppliers = 2 months
Then, Anticipated stock-out is calculated as:
•
•
•
•

= max(0,Lead time - Current stock levels + stock on backorder to customers - stock on backorder from suppliers)
= max(0,3-1+3-2)
= max(0,3)
=3

and Purchase order quantity is calculated as:
• = stock required - current stock level + stock on backorder to customers - stock on backorder from suppliers months of anticipated stock-out
• = 21-5+3-2-3
• = 14
So, due to the 3 month anticipated stock-out, only 14 months worth of stock are to be ordered.

To Create a Purchase Order
Choose Supplier > New Purchase Order.
In most instances the following window will be displayed:

This window allows for a number of factors to be entered.
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Types of order available from the popup menu
Firstly, you have the opportunity to select the order types:

Order for all suppliers.
• All items in the database will be evaluated to see if they need ordering. This is the default option
• If you have a large number of items, this may take a few minutes.
• By default, a single order will be generated. You have the option to generate a separate order for each supplier by checking the Separate
order for each supplier box. In this case, mSupply will
◦ For each item, look to see whether a supplier has been identified as preferred on a current quote
◦ Create a separate order for each supplier.
◦ Items without a preferred quotation will all be placed together in a single order.

Order for some items only

• Either click on the Query items box, to bring up the Query Editor window, and enter the required parameters, or select one or more criteria
by placing check marks as appropriate in the three boxes; use of the Query Editor is described in detail in the Reports chapter. See
using_the_query_search_modifier

Order for one supplier
• This method is the best method to use for ordering from a particular supplier (you might have guessed that!)
• Enter the supplier code, and press the tab key. The supplier name will be filled in, or you will be given a list to choose from.
• Any items that have a quotation from that supplier that is marked as “preferred” will be evaluated to see if they need reordering.

Calculate Forecast
Secondly, the forecast of future consumption will be calculated in accordance with each item's settings as documented in the Forecasting section. The
only forecasting factor that can be adjusted here is the number of months of historical consumption data that will be used to calculated historical
AMC.
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• The bigger the number you enter here, the more accurate mSupply is likely to be, provided that consumption has
been reasonably stable over that period. Entering a large number will slow down the calculation.
• Also, beware of extending this time period to a time in the past when data is inaccurate or non-existent. This will be
detrimental to the quality of the forecast.

From our worked example above, consumption has been stable at 1,000 per month for the last two years (2014 and 2015), but
was significantly lower in 2013. Putting 36 months would result in a lower AMC than has been the case for 2014 and 2015.

The number of months of historical consumption data to be used to calculated historical AMC will be ignored for those items
that are configured not to use AMC in the forecast - refer Forecasting.

Calculate quantity required
The quantity of stock required can be entered directly into the Months of stock required field. However, as demonstrated in the Calculate Purchase
Order quantities section above, a more reliable way of getting to this figure is to use the Lead time, order cycle and buffer stock parameters. Clicking
on the Calculate button brings up a window allowing you to enter these values, from which mSupply will calculate the quantity required.
Using the same figures as in our worked example above:

• Orders take three months to arrive from your supplier - (Lead time = 3 months)
• You order every six months. (Ordering cycle = 6 months)
• We want a buffer stock of at least 12 months when a Purchase Order arrives.

• The Lead time figure will generate an Expected delivery date, and the Lead time / Expected delivery date can
have a significant impact on actual Purchase order quantities - refer Calculating Purchase order quantity above.
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• BEWARE of manually entering in a date that is unrealistically far into the future - this will REDUCE the quantity
ordered!

Other settings in the create order window
Comment
Add a comment (note) to the order should you so wish.

Exclude transfers from usage calculations
This option is only applicable if you are running multiple (virtual) stores. If you have more than one store, this option controls whether inter-store
transfers are taken into account when calculating historic consumption. The default setting is not to exclude transfers. That is, stock transfers will be
included in the calculation.

Include usage for build ingredients
Selecting this option ensures that any items that were used in builds (i.e. manufactured items) will be taken into account when calculating historic
consumption.
Builds can be entered with placeholder lines to reflect a projected manufacturing schedule. If the Include usage for build ingredients check box in the
“new order” window is checked, the proposed order quantity for each item will be adjusted by the amount of the item that is required for all projected
builds, multiplied by the “times covered” value you have entered.

Using our worked example:
•
•
•
•
•

Let us say that we wish to 'build' a kit which includes 100 x Amoxycillin 250mg tabs/caps.
We have a projected build for 200 of these kits.
This will consume 20,000 Amoxycillin 250mg tabs/caps.
We enter 1.5 in the times covered box
Then the additional quantity of Amoxycillin 250mg tabs/caps that will be added to the order will be:
◦ = 100x200x1.5
◦ = 30,000 tabs/caps

•
•
•
•

In our worked example, ignoring projected builds, 14 months usage was to be ordered.
The AMC is 1,000 per month.
Without taking into account projected builds, this would result in an order of 14,000 tabs/caps.
When we add the usage of the projected builds, the amount to be ordered will be:
◦ =14,000+30,000
◦ =44,000 tabs/caps

Include items with suggested zero order quantity
If mSupply calculates that any of the lines from the supplier are not required, when this box is checked such lines will appear on the Purchase Order,
the order quantity being 0.
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Create Order Now button
Once you have entered the details, click the Create order button. Order generation may take a couple of minutes, depending on how many items need
to be evaluated. You will then be presented with the following Alert box:

Clicking on OK will close the Alert box and return you to the Navigator.

Creating a blank Purchase Order
Choose Supplier > New blank Purchase Order . You are presented with a blank order form, to which you can add items. This form only allows the
choice of one supplier.

The name field is where you choose the supplier you are ordering from.
If it has been set in Preferences, the Donor field will appear, and the donor details may be entered here. Setting this preference is described in
supplier_invoices.
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The Reference field allows you to enter any relevant information.
In the top right hand corner, there is a box where you may select a particular colour from a range of colours - in the window shown below, blue has
been selected.

The purpose of this is to distinguish this particular Purchase Order in the Purchase Order list - see the example below where PO number 5 is shown in
the selected colour (blue):

Once a supplier(Name) has been chosen you may enter the item you are ordering by clicking the New Line button.

In the Item field type the beginning letter of the item you want and hit the Tab button. You may then choose the item from the displayed list. If you
want to see the entire list of items available type @ and then Tab.
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From more information on the other tabs in this window see Editing Purchase Order lines
Once you have chosen the Item and entered the appropriate details clicking OK will return you to the Edit Purchase Order screen where you will see
the line you have created. Below I have ordered 300 Packs of Chlopromazine.

The Original and Adjusted Quantities columns show the number of packs you ordered multiplied by the number of units in the pack.

Viewing a Purchase Order
To view a recently created order choose Show Purchase Order… from the Supplier menu.
Choosing this menu item shows a window where you can enter either the number of recent orders to display or the order number (this is printed on an
order if you have printed it out). If you click OK without changing any information you will be shown a list of the 15 most recent orders.

You will then be shown a window with a list of Purchase Orders. (If you entered a Purchase Order number you will be taken straight to the Purchase
Order details window, bypassing the Purchase Order list, as shown above).
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Buttons in the Purchase Order list Window

New Purchase Order
When you click the New PO button, a Purchase Order details window is displayed . See “New Purchase Order” below.

Delete
Any highlighted orders will be deleted by clicking this button. You can delete multiple Purchase Orders by highlighting more than one line. To do so,
control-click (command-click on Mac) the lines you wish to highlight. If your orders are finalised, those can not be deleted. If you attempt to delete a
finalised order, you will receive an alert message:

Report
Clicking on the Report button presents you with the quick report modifier window, from which a simple report can be constructed. This report can be
viewed, saved to disk or printed.

Find
This button is very useful for quickly finding a group of Purchase Orders. when you click on the Find button, you will be presented with a window
with the same functionality as if you chose the Menu item Supplier > Show Purchase Orders (above).

Order by
The Order by button allows you to sort the orders by multiple fields. Otherwise simply clicking on an individual column will also sort the order list by
that column.
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Print
This allows you to print the displayed list of purchase orders. When you click on the Print button, it shows two windows. The first is the page setup
for your printer, the second allows you to specify how many copies to print. The column sizes set in the list window are reflected in the printed output.

E-mail order(s)
Any highlighted orders will be converted to queued emails.

Customise list
This button allows you to change the columns that are displayed in the list and what order they are displayed in:

See Working with lists for more details.

Duplicate
If you wish to duplicate any orders, highlight desired orders from list and click the “Duplicate” button.

Split
This button allows you to split the selected order between two or more suppliers, and may be used only on orders with a status of sg.

Editing a Purchase Order
Double-click the order in the list you want to modify.
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You will be presented with the Edit Purchase Order window:

If the entire order qualifies for a discount, either the discount percentage should be entered at 1, or the cash value of the
discount should be entered at 2.

Split Deliveries
There may be occasions when you want to arrange for split deliveries - for instance if you are placing a single order for a year's supply, but you want
certain items to be delivered in, say, four consignments, at three monthly intervals. The order as generated lists the total quantity to be ordered, and
you need to modify this; what you are actually doing is modifying a Purchase Order line. The procedure is described in Split deliveries in
the_order_menu

Editing Purchase Order lines
To modify an order line, double click on the line you wish to modify.
Note: you can resize the order modifying window to show more lines, or to show more of the item name. To do so, drag the handle in the lower right
corner to a new position.
When you double-click an order line (or when you click on the New line button) you will be presented with a window allowing you to modify the
item, quantity and pack size:
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Information in the Edit Order Line window
Item
Here you can modify the item that is being supplied. To change the item, type as much of the item name as you know, then press the tab key. If only
one item matches your entry, it will be filled in automatically, otherwise you will be presented with a list where you can double-click the item you
wish to enter.

Comment
You can enter any information you wish to record about this order line here. Comments will be added to order lines when you email an order to a
supplier.

Original quantity
The original quantity ordered from the supplier. This information is not modifiable once you have confirmed an order.

Pack size
This is the pack size the supplier prefers.

Units
The units that the pack is measured in.

Price
The quoted price for this item
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Price extension
The price multiplied by the quantity ordered.

Volume per pack
In this field, you can define the volume per pack for the pack size chosen. If you are entering a new line the volume and pack size you have entered for
the item will be used.
Note the mSupply always stores volumes as m3 (cubic metres), but you can enter a volume as millilitres (ml), litres (L) or cubic metres (m3)

Shelf location
Type the first few characters of location name or code as you know, then press the Tab key. If only one location code matches your entry, it will be
filled in automatically, otherwise you will be shown a standard choice list.

Adjusted quantity
The total quantity you now expect to receive from the supplier in all consignments. You can adjust this figure so that the amount received is reduced or
increased due to changes in what the supplier actually sends.

Refresh Buttons
The refresh button (to the right of Volume per pack), on clicking, displays the default volume of the selected item if it has been set previously.
Similarly the refresh button next to Shelf location displays the default location.
The refresh button in the “Pricing for this item” frame reloads the price data from a preferred quotation. The price from the most recent quote is used if
there are no preferred quotations. If you have received an updated quotation after generating the original price, use this button to apply the updated
details to this line.

Comment
Put anything you need to have recorded for this purchase order line in here. It will print against the line when the purchase order is printed out.

Notes
Any important notes you need to make about this purchase order line should go in here. These notes will not print out when the purchase order is
printed but, if you check the Show notes on Goods Received checkbox, the note will be displayed on the goods received note line and the line will be
coloured red when the goods are received into mSupply - see Goods receipts for details.

Other information in the Order line details window:
On hand: This is the quantity of stock on hand of the item
On order: This is the quantity of stock in other confirmed orders awaiting delivery.
On backorder: The quantity of stock you owe to customers on backorders
Quantity received: The total quantity of this line that has already been received on this order.

Tabs in the Order line details window
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The usage tab
This tab shows the usage for the last 24 months of the item being viewed. This is useful for deciding if reported usage is consistent from month to
month, or is due to one or two very large supplies to clients.

The quotes tab
This tab shows quotes from suppliers for the item being viewed.
You can double-click a quote to view and/or modify details.
View quotations for the item in question. You can double-click a quotation to modify its information.
Note that the supplier of the quotation that is marked as “preferred” will be the supplier selected when using the “split” command to break a general
order into orders for each supplier.
The New button allows you to add a new quotation.
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The receipt history tab
This tab shows all goods receipts for the item being viewed.
If you double-click a line the associated goods receipt transaction will open in a new window.
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The Ledger tab
• This tab shows supplier and customer invoices for the item being viewed.
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• You can display a sub-set of the transaction lines by choosing options from the drop-down lists.
• The option Received ledger for this Purchase Order line shows all supplier invoice transactions for the current Purchase Order line item.
This is particularly useful if you want to see the history of prices paid for this item.
• Goods receipts are shown on the Receipt history tab.
• Unordered List ItemThe Dates drop-down list allows you to show only recent transactions….

• If you double-click a ledger line, the associated invoice will be opened in a new window

Buttons in the Edit Purchase Order Line window
OK & Next
This button will take you to the next order line, unless you have reached the last line in the order, in which case you will be taken back to the order
modifying window.

OK
Will exit the window saving changes to the current window.
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Delete
If you click the Delete button, the order will be deleted and the order number will be reused for the next order.

Purchase Order status explained:
• When a purchase order (PO) is first created it has status “sg” (for “suggested”)
◦ POs with status sg can be modified in almost every way, including changing the supplier.
• Once there are no more lines to add to a PO, it can be confirmed and sent to the supplier. A PO is confirmed by clicking on the Confirm
button.
◦ Once a PO is confirmed, it has status “cn” (for “confirmed”) and an appropriate log entry is created.
◦ Confirmed POs have the order amount added to the “on order” field for each item, so that if another PO is created for the same
item, this quantity already on order will be taken into account.
◦ Confirmed POs can not have new lines added to them. However, details of existing PO lines can be amended.
• Once no more stock is to be received against a PO, it can be finalised. An order becomes finalised by clicking on the Finalise order tickbox at the bottom left of the PO window.
◦ POs that have been finalised have status “fn” (for “finalised”) and an appropriate log entry is created.
◦ Finalised POs can no longer be modified in any way.
◦ No more goods can be received against a finalised PO. The `unsupplied' lines will not appear when you look for outstanding PO
lines (Supplier>Show outstanding PO lines) and the `unsupplied' quantities are ignored in any of mSupply's subsequent Stock on
order calculations.

Estimated order costs explained

From version 1.7 onwards, mSupply displays a new column (Price Ext) in the order modifying window that shows the cost of
the order line.

Buttons on the General tab
New line
Click this button to add a new line to the Purchase Order. You will be shown this window:
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You may enter the quantity of the item either by number of packs or by total quantity. mSupply will automatically fill in the other fields for you.
By default the Requested delivery date will be today's date but you may edit this to request deliveries at the times you require. The expected delivery
date can be entered manually now but it would normally be entered once a response from the supplier has been received.

Delete lines
Select one or more lines in the Purchase Order and then click this button to delete the lines from the Purchase Order.

Update EDD
Select one or more lines in the Purchase Order and then click on the Update EDD (Estimated Date of Delivery) button to enter a new date when
delivery is expected.

Info
Click the Info button to display information about the Purchase Order including the name of the initials of the Purchase Order creator and modifier refer figure below.
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Notes:
• If the Purchase Order has not been modified, then a modify date of 00/00/00 will be displayed.
• If there is no name against the Created by and Modified by entries, then this Purchase Order was created / modified
on the Primary Server in a synchronised mSupply system.

Print
Clicking the Print button will print the complete Purchase Order form for sending to a supplier. Note that you should fill in relevant details on the
Details tab before printing the order.

Confirm
See the section above on “order status” for an explanation. Orders should be confirmed once the order has been placed with the supplier.

Check boxes on the General tab
Locked
When the locked check box is checked, the Purchase Order cannot be processed to the next status (confirmed or finalized) - refer Order Status
explained.

Auto calc usage
When the Auto calc usage check box is checked, each time you modify an item line, the usage for that line will be calculated. This is slower, but gives
useful information upon which to base your ordering . Note that this option can also be turned on within the order line modifying window.

Print my signature
When the Print my signature check-box is checked, the user's signature will be printed on the Purchase Order if it has been loaded - refer Managing
users.

Other tabs on the Purchase Order Form
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The Details tab
This tab allows you to record a range of information that will be entered on the Purchase Order when it is sent to the supplier.

PO sent date
Enter the date the Purchase Order was sent to the supplier. When you print a Purchase Order mSupply will offer to fill in this date for you, but you
should modify it if necessary to reflect the exact date.

Contract signed date, Advance paid and Received at port fields
Enter dates in these fields as appropriate. They are all optional unless any of them are made compulsory by turning on the appropriate preferences on
the Purchase orders 2 tab of the File > Preferences… menu item. See Purchase order preferences for more details.

Heading message
Any text you enter here (e.g. “Urgent”, “Supplementary order for PO 183”) will be printed in a large font across the top of the Purchase Order so your
supplier will (or at least “should”) notice the message.

Expected Delivery
Enter the date you expect the order to arrive
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Goods Received date
Fill in the actual delivery date. Leave the date blank for Purchase Orders that have not been delivered

Invoice received
Enter the date when you received the invoice from the supplier
Hint: you can find all orders that have not had an invoice supplied by querying on this field.

Comment
You can enter any appropriate comments here.

Supplier's agent
Enter the name of the intermediary party here - if there is one.

Delivery method
Enter a delivery method (eg “Air”, “Courier” …)

Authorizing officers
Enter the names of the people who are required to sign off the Purchase Order. These names are printed on the Purchase Order.

Freight conditions
Enter the delivery address, shipping marks, etc. here.

Additional instructions
Enter any further information you wish to appear on the Purchase Order.

Commissions and charges fields
Fill in any relevant charges agreed between you and the supplier. Note that any charges that are zero will be skipped when printing the Purchase Order.

The Ad Hoc items tab
Here you can display a list of items that have been assigned to the supplier, but not yet added to a Purchase Order.
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Click on a line, then click the “Add selected line to order” button to add a line to the current Purchase Order.
Warning: if you delete a line from a Purchase Order it will not have its status updated automatically- it is your job to do so using the Items > Manage
Ad Hoc items menu.

New Ad Hoc line button
Here you can add an ad hoc item “on-the-fly”. This is useful if you want to process a Purchase Order for a single Ad Hoc item that has not yet been
entered into mSupply.
Note that the Items > Manage Ad Hoc items menu is the normal route to add, modify and delete Ad Hoc items.

The Goods Received tab
This is a record of the receipt of the order, and, where multiple deliveries have been made, records each instance.
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The Invoices tab
This tab displays a list of invoices that have been created from this Purchase Order.
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There are two types of invoice that are created directly from Purchase Orders:

Supplier invoices are created each time a consignment arrives.
1. Customer invoices are created when a supplier invoice is created that contains Ad Hoc items.

The Supplier Invoice tab
This tab list Supplier Invoices related to the current Purchase Order.
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The Log tab
This tab provides information of events that users have performed on a particular order. The below image shows that the Purchase Order has been
confirmed for sending to the supplier and printed:
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The Location tab
This tab displays the locations of the items received, if this feature is used. Where details of the volume of available space in any location has been
entered, and where details of the area/volume of item pack has also been entered, the remaining available space will be displayed.
Lines will also be coloured red/orange/green to indicate greater than 100%, 90 to 100% or less than 90% of space used. showing which lines are likely
to cause space problems on receipt.
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The Order Menu
When the order modifying window is being shown, an extra menu is added to the menu bar:

Copy order to clipboard
Copies the order details to the clipboard, so you can paste it into an email or text document.

Export html ...
If you want to produce an order which can be saved as a file in html format, use this option. . If you have Excel installed, the report will open in Excel.
Note that if you want to keep the Excel file, you should choose File > Save as.. in Excel and choose a location.

Print
Prints the order. You will be shown the standard printing dialog boxes.
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Note that if Show all lines is selected, the entire order is printed; if Show incomplete lines is selected, the printout lists only lines which have either not
been supplied at all or require a balance to complete the order.

Split
Splits the order into a number of smaller orders based on the preferred supplier for each line. The preferred supplier is the quotation that is marked as
“preferred” for that item. To view and modify quotations you can double-click the order line then chose “quotes” from the “show” menu. All items
that do not have a quotation marked as “preferred” will be put into a separate order.

Email in body
The order will be turned into an e-mail and placed in the queue so that it is sent next time you send e-mails. You will be warned if you have not
entered an e-mail address for the supplier.
The e-mail will be formatted as follows:

To check the email before sending it, choose Special > show l_formatemails , then double-click the email to modify it. Note that to make the columns
line up properly, you will have to click the <|-|> button to view the text in a fixed-width font.

Email HTML attachment...
The order will be turned into an HTML attachment, and attached to a new email that is then placed in the queue so that it is sent next time you send emails. You will be warned if you have not entered an e-mail address for the supplier. The attachment will be stored in the export folder you have
nominated in the Preferences. (For multi-user mSupply, the export folder is set as the folder “C:\mSupply\mSupply client\Export” (on the assumption
that you have selected the default install location for mSupply).
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Email PDF
Choosing this item will cause mSupply to generate a PDF file, create an email and attach the PDF file to the email.
Note that you must use the PDF xChange PDF driver installed on the computer generating the email for this to work. The driver currently costs
US$50, and is available from Sustainable Solutions info@ss.org.np (mailto:info@ss.org.np)
The PDF that is created is stored in the mSupply data file, so you can create a PDF attachment on one computer and send it from a different computer
without problems.

Update quotes using this order
This command allows you to check that quotation data is up to date based on actual supplied prices.
Each order line will be evaluated, and if a quotation does not exist, one will be created. If a quotation does exist and the price you have paid in the
order and the price stored for your quotation are different, you will be shown a window to compare prices, and you can decide whether to keep the
existing quotation or update it.

Note that you need to have your user permissions “Can add quotations” and/or “Can modify quotations” set before this command is available.

Split Deliveries
Creating split or multiple deliveries will now be described using the following example.
It is important to note that the Purchase Order should not be finalised before this procedure is performed, as a finalised order may not be modified or
altered in any way.
A store is placing an order for Normal Saline and, having followed the normal procedures, mSupply has created the Purchase Order displayed: below.
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The store does not have the storage capacity to hold 1250 packs of Normal Saline, so the supply of this item needs to be made in multiple deliveries; it
is decided that 500 be requested for delivery at the beginning of January, followed by 250 at the beginning of each of the months of April, July and
October - i.e. at three monthly intervals.
The Purchase Order is modified as follows:
•
•
•
•
•
•
•
•
•
•

Click on New line, and add the item `Normal Saline'
In the Number of packs field, enter 500
In the Requested Delivery date enter 1/1/17
Click OK & Next
In the Number of packs field, enter 250
In the Requested Delivery date enter 1/4/17
Click OK & Next
In the Number of packs field, enter 250
In the Requested Delivery date enter 1/7/17
Click OK & Next

Repeat the last two steps, but enter 1/10/17 in the **Requested Delivery date* field for the final delivery in October.
To complete the process, delete the line calling for 1250 units on 1/1/17.
The Purchase Order should now look like this:
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You won't see the different requested dates on this screen. Expected dates are generated upon feedback from the supplier or can be entered manually.
This feature enables mSupply to take future deliveries into its reckoning if, for example, an additional order for Normal Saline was placed in mid June,
and a delivery of 2,500 had already been arranged for 1 July.'

Authorising purchase orders
If required, it is possible to turn on authorisation of purchase orders. An unauthorised purchase order will print with an “Unauthorised” watermark
clearly visible across it but an authorised purchase order will print without the watermark. This is the only difference authorising purchase orders
makes - unauthorised purchase orders can still be confirmed and have goods receipted against them so it is not as restrictive as customer invoice
authorisation for example.
To turn on purchase order authorisation, check the Purchase order must be authorised store preference. See Virtual stores preferences for details of
how to do this.
When a user is logged into a store with this preference turned on, an Authorise checkbox appears in the bottom left hand corner of a purchase order:
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Only users with the Can authorise purchase orders permission can check the Authorise checkbox and therefore authorise a purchase order. See
Managing users for instructions on setting permissions for users.

Purchase order categories
Purchase order categories are useful for separating up your purchase orders when reporting. For details about setting them up and assigning them to
purchase orders please see Purchase order categories.
Previous: Uploading and Downloading Web Tenders Next: Managing Purchase Orders
2011/05/08 16:38

·

Managing purchase orders
Managing purchase orders you have placed is an important part of running a medical supply facility. There are two main windows you will use to do
this, along with a variety of reports.

Show outstanding Purchase Order lines....
Choosing this Suppliers > Show outstanding purchase orders from the menus or the Navigator displays a list of all lines outstanding on all
confirmed Purchase Orders.

Using the find box
In the toolbar there is a field to enter searches. To the left of the field you can choose from the drop down list what to search for.
You can restrict the list displayed to a single supplier, to a single item, or to items whose delivery is expected within a specific number of days.note
that the search excludes finalised orders.
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Printing and opening in Excel
Click the Print button to print the list as displayed. If you want to send the list to Excel, choose Open in Excel from the print options window that is
shown after you click Print Double click on a line to display the Purchase Order containing that line

Show Purchase orders
Choose Suppliers > Show Purchase Orders.
• In the find window you can choose what will be displayed. By default mSupply displays the last 15 purchase orders.

• You will be shown a list of matching Purchase Orders. Double-click a purchase order to open it.
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For a more detailed description of this window see Ordering Items From Suppliers
Previous: Ordering Items From Suppliers Next: Purchase Order categories.
2012/02/26 23:36

·

Purchase order categories
Sometimes it's really helpful to categorise your purchase orders for reporting purposes. To allow you to do this, mSupply allows you to create
purchase order categories and then apply them to purchase orders as needed.

Viewing purchase order categories
Choose Supplier > Show purchase order categories… from the menus. You will be shown this window:
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This shows a fill list of all the purchase order categories that you have at the moment. The user_field_1-3 columns show the values of the custom
values given to each category, which can be used to further refine your reporting later.
The functions to adding, delete and edit purchase order categories is all accessed from this window.

Adding purchase order categories
Click on the New button in the window shown above to add a new category. This window will open:

Enter the Description of the category (this is name by which the category will be known and selected throughout mSupply) and any values for the
custom fields you wish and click on the OK button to save the new category. You will see it immediately added to the list of available purchase order
categories.
Note: user_field_3 takes numerical values, user_field_1 and user_field_2 take alphanumeric (any combination of letters and numbers) values.

Deleting a purchase order category
Select the category to delete in the list of purchase order categories and click on the Delete button. You will be asked to confirm the deletion.
Note: you will only be able to delete a purchase order category if no purchase orders belong to it.
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Editing an existing purchase order category
To edit a purchase order category simply double-click on it in the list. The same window as for adding a new purchase order category will open
populated with the selected category's details. Simply edit the details as required and click on the OK button to save your changes.

Assigning categories to purchase orders
Assigning categories to purchase orders is really simple, as you'd expect! When editing or creating a purchase order, simply select the category the
purchase order belongs to using the Category drop down list on the General tab:

The drop down list will contain the descriptions of all the categories you have added.
Previous: Managing Purchase Orders Next: Ordering from one store to another
2011/05/12 07:04

·

Receiving goods - a supplier invoice
Introduction

If you are using purchase orders (which you should be!) supplier invoices will be
created automatically when you finalise a goods receipt. So you should read
Receiving goods (Goods Receipt function) before reading this section.

All goods you receive should be recorded in mSupply either by entering a “Supplier Invoice” or by using the Purchase Order system, which leads to
359

mSupply user guide July 2018

the creation of a supplier invoice. In some countries a supplier invoice is called a “bill”.
Confirming a supplier invoice is what actually puts the goods into stock in mSupply, ready for issue. It calculates the selling price based on the
margin you have chosen for that supplier or for that item, depending on how you have set your mSupply Preferences.
You will notice there is a Prices tab in the Supplier Invoice window- this is for use with invoices received in foreign currencies, which will usually be
done via the goods receipting system. See Viewing and editing supplier invoices created via Goods Receipts.

Creating a new supplier invoice

If you are receiving the goods from another virtual store in your mSupply system, and they are not responding to an internal requisition
(purchase order) from your store, then they should have followed the procedure for transferring goods to another store.
Provided that they have finalised their customer invoice, a new supplier invoice will be created automatically in your store, populated with the
stock lines that they are sending to you. In this instance, you should NOT create a new Supplier invoice, and can skip most of the following
section.
Search for this automatically created invoice using Suppliers>Show invoices…
Depending on the store preferences, the supplier invoice may be finalised. If not, you will be able to add, edit or delete lines on the supplier
invoice if what you actually received is different to what the supplier invoice states…

To create a new supplier invoice, choose Supplier > New invoice. The supplier invoice entry window will open with the cursor in the Name field:
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If you have turned on any of the custom stock fields in store preferences they will be displayed as columns (between the Batch
and Expiry columns) in the list of invoice lines and the information you entered for these fields will be shown in the appropriate
cells.

Information to enter in the main window
Name: Enter the first few characters of the supplier's name, and then press the Tab key. Any name that has the “Supplier” check box checked can be
used. If only one name matches the entry, the supplier name will be filled in. Otherwise, a list will be displayed:

Double-click the appropriate entry, or click Cancel to try again. You can also use the up and down arrows or the “u” and “d” keys on the keyboard to
move the highlighted item up or down, then click the Use button or use the Enter key to choose the highlighted item. This will return you to the
Supplier Invoice window with the name of the supplier you have chosen entered in the Name field.
The downward pointing arrow to the right of the Name field takes you directly to the Edit Customer/Supplier window, giving access to all the
information relating to the name entered.

Bill no.: Enter the bill number - the serial number on the bill the supplier gave you.
Comment: Click on the downward pointing arrow to the right of the Comment field to display a window where any comment relating to this invoice
can be noted.

Category: Category for supplier transaction is created in File>Preferences>Invoices1 . The categories created are listed in this category field.
Colour: Clicking on the colour box in the top right corner presents you with a selection of eight colours from which the desired one should be
selected; this does not make any change on the invoice window itself, but when the list of invoices is displayed, the line showing this particular
invoice will show the entry using text of your chosen colour.
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Confirm date: This is normally read only but will be editable if the “Allow entry of dates on invoices” preference is turned on in Preferences on the
Invoices 1 tab

Read-only information at the top of the invoice
There is some information at the top of the invoice that is read-only and cannot be edited:
• Entry date: The date the invoice was created.
• Confirm date: The date the invoice was confirmed. Will be “00/00/00” if the invoice has not been confirmend.
• Invoice number: This is the invoice number. The number is automatically incremented and assigned when the invoice is first saved (which
actually occurs when the first line is added to it) and is unique within a store. Note that supplier invoices in different stores could have the
same invoice number.
• Status: The current status of the supplier invoice:
◦ nw = new (just created, can still be edited, stock not yet added to mSupply)
◦ sg = suggested (has been opened since first creation, still editable, stock not yet added to mSupply)
◦ cn = confirmed (stock has been added to mSupply but invoice is still editable)
◦ fn = finalised (stock has been added to mSupply and the invoice is no longer editable)
• Goods received ID: If the supplier invoice was created automatically when a goods received note was finalised then the goods received
note's ID will appear here in blue, indicating that it is a link and, if clicked, will open the goods received note.
• Purchase order ID: Again, if the supplier invoice was created automatically when a goods received note was finalised then the ID of the
purchase order which the goods were ordered on will appear here in blue, indicating that it is a link and, if clicked, will open the purchase
order.
• Entered by: The user name of the user who created the invoice.
• Store: The name of the store the invoice belongs to.

Buttons in the supplier invoice window

New line: Will add a line to the invoice. This command can be used on any invoice that is not finalised. Clicking the button will present you with the
window for adding a line from stock.. See the Adding lines to an invoice section below for more details. To select a line to edit, simply double-click on
it. Note that New line and Edit line are disabled on finalised invoices
Delete line: Will delete a line whose batch is “none”. To delete other lines, you must first edit the line and set it's quantity to zero. Multiple lines can
be deleted if highlighted.
The Hold Check Box: Checking this box means that the invoice can not have its status changed. If its status is “nw” it cannot become “cn”
(confirmed). If it is “cn”, it cannot be changed to “fn” (finalised).
Note the “nw” status invoices do not have the stock entered into the system yet, so this allows you to enter a supplier invoice, but to make sure the
stock is not available for issued until all the details have been checked.
The Finalise Check box: This check box allows you to finalize an invoice when you click the OK button. This will mean that it can no longer be
edited, so be sure first that all the details are correct. Note that only users with Can finalize individual invoices checked in their user permissions have
access to this check box. Other users will be warned if they try to turn it on, and the check box will automatically uncheck.
If this check box is not checked and OK button is clicked, it will display a confirm window with a message Confirm invoice and enter into stock now?
If you click on Later , the invoice will have a status “nw”(new). If you click on Confirm , the invoice will be confirmed.
If this check box is checked and if the invoice is not yet confirmed, it will display a confirm message. If you click on Later , the invoice will have a
status “nw”(new) and will not be finalised. If you click on Confirm , the invoice will be confirmed as well as finalised.So be very careful! A finalised
invoice may be viewed and/or printed but it can not be edited.
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Should a finalised invoice need to be changed, the entire invoice may be cancelled,
and the correct data may be entered as a replacement. In order to maintain the
accuracy of any subsequent audit trail, mSupply creates a transaction which
reverses all the stock movements on the invoice being cancelled, having due
regard to all appropriate details, such as batch numbers, etc. See Cancelling
finalised invoices

If Confirm supplier invoices without asking is checked in the “Invoices 1” tab of the Preferences window, then all invoices will be finalised
automatically (whether you like it or not!)

If you have the store preferences set to force supplier invoice authorisation, you will not be able to
confirm supplier invoices until they have been authorised. See here for details.

Copy button: This button copies the invoice details to the clipboard, allowing you to paste them into a spreadsheet or email message.
Delete: Allows the deletion of an invoice.
When you press Delete button, it will leave no trace of your entry, and the invoice number assigned will be reused.
Note: Unless the invoice has a status of “nw” if you have added lines to an invoice, you must manually delete each line using the “delete line” button
before deleting the invoice. This is intentional, to save the “Oops, I just deleted my invoice with 100 lines on it” feeling.
Invoice status

Description

nw

The invoice has just been created- clicking cancel will delete the invoice and automatically delete each
line

sg

The cancel button will only delete the invoice if you have first deleted all lines using the “delete line”
button

cn

Same as for status “sg”

fn

No changes or deletions can be made

If the invoice has already been saved by previously clicking OK, Cancel will be disabled or not present.

OK: Saves the changes you have made and exits the window. You are given the opportunity to print if you want to. If the invoice status is “sg” a
packing slip will be printed, otherwise an invoice will be printed. (Tip: you can bypass the print messages by holding down the shift key as you click
OK)

Adding new lines to a Supplier invoice
Click the New line button to add a line to the invoice. This window appears:
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The cursor will be in the field ready for you to enter the item name.
Item: Enter as much of the item name (or code) as you know, then press the Tab key. As usual, if only one entry matches, it will be filled in. More
than one matching entry will present you with a list from you should double-clicking on the required item. The text you type will be matched against
both the item name and the code. A match for either will display the item.
Note: To query for an item name or code that contains (rather than starts with) “250mg” (for example), enter “@250mg” in the search field (without
the quotes).
Hint: you can use the “up” and “down” arrow keys to change the highlighted item (You can also press u to move up and d to move down!) . Pressing
the enter key will choose the highlighted item.
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Note: If you did wish to apply a different margin to the whole invoice, click the cancel button, and edit the margin for that supplier by choosing
Supplier >Edit supplier and change the margin. If you wish to apply a different margin to just some lines, you can do this as you enter the lines, as
long as Editing margins is enabled in the Preferences.
If the the item you are entering is not listed, you can click New item to add it.
Note: it is a good idea to agree upon a standard form for entering items. For example, will you enter an “infant feeding tube” as:
• “infant feeding tube”
• “feeding tube, infant”
• “tube, infant feeding”
Duplicated items can later be merged, but it is better to get it right first time!
Note: if you need to see the full details of the item itself after selecting it, click on the down arrow icon (
you will be taken to the item's details window.

) to the right of the item name field and

Now there are a series of fields to enter to fill in the basic information for the line
Num units: How many did you receive?
Location: The location of the item should be entered in this field.
Pack size: How many units in a pack
Note: Say you receive 50 packs of 100 amoxycillin caps, you should enter “50” in the quantity field and “100” in the pack size field. However, if you
issue the capsules in strips of 10 to customers (e.g. you allow them to order 20 or 30 capsules), you should enter quantity “500” and pack size “10”
Batch: The batch number or other identifying information. The batch appears on the invoice, so you can use this field to differentiate between brands
if you need to (eg you operate using generic names, but occasionally want to give a specific brand- you can put an abbreviation for the brand name
here as well as the batch).
Expiry: You can use “/” or “.” to separate the day/month/year. Note: Use whichever date format you have set in your computer (dd/mm/yy or mm/dd/
yy or yy/mm/dd). You can enter the year as 2 digits, which will be understood as a date between 1961 and 2060. This should cover the expiry date on
most things you receive in the next 52 years!
Cost price (invoice line unit cost): Enter your cost price for one pack of the pack size you entered above. If your supplier's currency is different to that
of mSupply the cost price will appears in the supplier's currency.
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Adjusted local cost: This information field displays the cost of a single unit of the item in local currency.
Margin and sell price: If you have allowed editing of these fields in Preferences, you can adjust the margin (and the sell price will adjust
automatically), or you can adjust the sell price (and the margin will adjust automatically).
Click OK if you are finished, or OK & next to add another line. (The invoice lines added will be displayed in Items Display Field.)Click cancel to exit
to the main screen without saving any of the details.
Manufacturer: This field displays the name of the manufacturer of the item. It will only be shown if you have turned the Able to specify manufacturer
when receiving, ordering or quoting for items preference on in the store preferences.
Entering a manufacturer follows the same pattern as entering an item or supplier - type the first few letters of the manufacturer's name or code, and
press the Tab key. Choose the required manufacturer from the list if more than one is displayed.
You can add a new manufacturer by clicking on the New button.
Donor: The donor of the item can be entered to this field. A valid donor should be entered, type the wildcard character '@' and press the TAB button
to view your list of donors.
Price extension: This information field provides the cost price in local currency for the total quantity of the item you have entered.
Custom fields 1-8: The appearance of these fields is controlled by the Custom stock field preferences. Any information you enter in these fields will
be displayed wherever stock information is displayed (e.g. when issuing stock on a customer invoice or when viewing the stock of an item on the
stock tab of the item details window). The fields can also be reported on so they are an important and powerful way of tracking different categories of
stock. For full details please see Custom stock fields.

mSupply provides the feature of receiving service items into stock. Service items are items that are not
normally held in stock and are called non-stock items in mSupply. See here for more information on
those. One use of service items is for managing assets. For more information on this, see the chapter on
Asset Management.

Editing lines on a supplier invoice
Supplier invoice lines can be edited at any time until the invoice is finalised.
To edit a line, simply double-click on the line you wish to edit.

Editing lines if stock has been issued
If you have already issued stock of this line to a customer, you will be warned with a window like this:

Clicking View issued invoices will show you a list of customer invoices containing this particular line:
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Clicking OK will take you to the item issue window, where certain fields only may be edited. You may not reduce the received quantity to a figure
lower than the quantity already issued.
The item issue window: You will be presented with a window where you can edit the line details in much the same way as when entering new details.

In the graphic above you will notice the “units issued: 100” text in blue to the right of the Quantity field. This will only be present if stock has already
be issued to customers. You can click on that text to display a list of issued invoices as described above with the View issued invoices button.
Note that the OK & Next button is very useful for editing a whole invoice. Simply double-click the first line of the invoice, then use the OK & Next
button to go from line to line.
Note also that many options for the window are set in the mSupply Preferences. For example, whether or not line one is chosen automatically, and
whether you can use placeholder lines.

Working with the list of invoice lines
Resizing columns: These columns are resizable. If any of the column data is cut-off or remains hidden, the column width can be increased or
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decreased by positioning the mouse at the borders of the column. The cursor changes to a cross with arrowheads on the horizontal bar. Click and drag
the cursor to the left or right.

Sorting columns: Columns may be sorted either in ascending or descending order by clicking on the header.

The order of the columns can be re-arranged by clicking on the header and dragging it to the new position.

Deleting a line on a supplier invoice
To delete a line, do one of the following:

• Click on the line you wish to delete, then click on the Delete line button:
• Double-click the line to edit it (see above) and set it's quantity to zero.
Click the OK button. You will be asked for confirmation. Click OK to proceed.

You cannot delete a line from a supplier invoice that has been finalised.
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Selling price calculations in mSupply
mSupply uses a number of items of information to calculate the selling price of an item. This enables you to have the price calculated just the way you
like it.
Here's the logic mSupply uses:
• Does the item have a selling price specified? If it does, this price will be used regardless of any other information. Note that the price
entered for the item is for one unit. The price will be multiplied by the pack size to get the selling price for the line.
• If either the supplier margin or the item margin is specified as zero, then the other (non-zero) value will be used?
• If a margin is specified for both the supplier and the item, the Preference Item margin overrides supplier margin will be examined to see if
it is on or off. If it is set, the item margin will be used, if not the supplier margin will be used.
For example:

Cost price

Pack
size

Supplier
margin

Item
margin

Preference set for Item margin
overriding Supplier margin

Item
price

Price
used

100

100

6

10

yes

1.15

115

100

100

6

10

no

1.15

115

100

100

6

10

yes

0

110

100

100

6

10

no

0

106

100

100

0

10

no

0

110

100

100

6

0

yes

0

106

Note that if you have turned on “allow editing margins and sell prices on supplier invoices” in the Preferences you will be able to over-ride the prices
mSupply calculates.

The Price tab
This tab provides functions for applying discounts and apportioning different charges to items.

Applying a Discount to the whole invoice
If a supplier gives a discount at the bottom of the invoice rather than adjusting the price of each invoice line, you can use the discount button.
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This window will be shown:

If you enter “5” the cost price of each line will be reduced by 5%, and the invoice total will be recalculated. It should then match the amount the
supplier is actually charging you.
If you want the sell price calculated based on the new cost price, check the “Recalculate sell price” checkbox. The selling price rules as described
above will still apply.
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Applying local charges
Local charges are any charges you want to add to the cost of individual items on this invoice in your data file's local currency (i.e. the default currency
used in your data file - this might not be the same as the currency you use when you visit a local shop!). These could be administration charges, local
freight charges, handling charges etc.
You can either enter the amount of local charge to apply to each invoice line or the total amount of charges to apply to the invoice.

Entering local charge amounts on each invoice line
You do this by directly entering the amounts to apply to each line in the cells of the Local charge column in the table. As you do this, mSupply will
automatically increase the sell price per pack by the amount you have entered divided by the number of packs for the line and will add the amount you
entered to the current value in the Local charges field above the table.

Entering the total amount to apply to the whole invoice
To do this, you simply enter the total amount in the Local charges field above the table. When you do that, mSupply will automatically apply a
portion of the local charges to each invoice line's sell price, according to the ratio of that line's Price extension to the sum of all the Price extensions of
all lines on the invoice. You can see how much mSupply added to each line in the Local charge column. If you wish, you can edit the local charges
applied to each line after this by simply clicking on the appropriate Local charge cell in the table and typing in the cost to apply. As you do that,
mSupply will keep track of the total local charges applied to all lines in the Local charges field.

Applying foreign currency charges
These charges are applied in the currency selected in the currency selected in the Currency drop down list, following the rate displayed in the
Currency rate field (which you can manually adjust if the default shown by mSupply is not what you require). The charges could be, for example,
international freight charges or administration charges.
Simply type the amount of foreign currency charges to apply to the whole invoice in the Extra foreign currency charges field and mSupply will
apply a portion of the whole amount to each line, according to the ratio of the line's Price extension to the sum of the Price extensions of all lines.
mSupply will automatically update the sell price value for each item.

Applying other charges
These charges will NOT be added to the sell or cost prices of the items on the invoice. You enter them in the Other charges section below the table of
items:
• Item(s) field: Enter what the charges are for in this field.
• Amount field: Enter the total amount of the other charges in here. When you do this, you will see the amount added directly to the Subtotal
and Total amounts and none of it will be added to the sell or cost prices of the individual items in the table.

Applying tax to the invoice
Tax, like other charges, will not be added to the sell or cost prices of the individual items. To add tax, click on the % tax rate below the Subtotal field
on the right hand side below the table of items and enter the rate you wish to use. mSupply will calculate the amount of tax (the % you entered of the
Subtotal value) and automatically add it to the Subtotal value to give you the new Total.

If you have set a default tax rate in the preferences (see General preferences) you will see it applied as soon as you open the
invoice. Also, you will only be able to edit the tax rate if the Allow editing tax rate and amount on invoices preference is turned
on (see Invoices preferences).
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Viewing supplier invoices
To view or edit any supplier invoice, choose Supplier>Show invoices. The details of how this works is virtually identical to that of viewing customer
invoices.

Rapid access to Goods Received note from Supplier invoice, and vice versa
Supplier invoices show the Goods Received transaction number in the upper right
area of the window. By clicking on that, the Goods received transaction will be
displayed. Similarly, the Edit goods received list has a link Click here to open
Supplier inv ……. which will display the required invoice.

Printing supplier invoices
When a supplier invoice is open you can print it by checking the print checkbox in the bottom right hand corner:

When the checkbox is checked and you click on the OK button, the invoice is closed and the printing options window is displayed:
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• Form to use drop down list: Select the form you want to use to print the invoice. There may be several in the list. There is also a None
option if you don't want to print the invoice but just want to print pallet labels.
• Remember this choice checkbox: The form you choose in the Form to use drop down list will be selected (and everyone else!) next time
the supplier invoice printing options window is opened if this checkbox is checked.
• Print pallet labels checkbox: Check this if you want 100x150mm pallet labels in a specific format to be printed out from a label printer. A
label will be printed for each line on the supplier invoice. Note: the label printer has to be installed and configured in mSupply before this
option will work - see Label printer installation and Printing preferences (setup) for details.
• Destination radio buttons:
◦ Printer: the invoice will be printed out straight away.
◦ Preview: a preview of what the invoice will look like when it is printed will be displayed in your installed PDF file reader. You
might be able to print the invoice from the PDF reader, depending on its features.
◦ PDF file on disk: the invoice will be saved to disk in PDF format.
◦ Email PDF: the invoice will be created as a PDF file and attached to an email for you to send. You can double-click the email
attachment to see a preview of the invoice. The email preferences in File > Preferences should be setup correctly before using
this feature.
◦ Export to Excel: the invoice will be exported as a spreadsheet file and opened for you (provided you have a spreadsheet
application installed).
When you click on the OK button the invoice will be printed in the form you have chosen.
Previous: Ordering from one store to another Next: Receiving goods (Goods Receipt function)
2011/04/28 11:15

·

Receiving goods (goods receipt function)
Entering goods received

If the receiving store is receiving goods from another virtual store in your mSupply system, in response to an Internal
Requisition (Purchase Order) from that store, the Goods Receipt will be created automatically - refer Receiving the goods
(Customer Store). Open this automatically created Goods Receipt. Do not create a new Goods Receipt!

Choose Supplier > New goods received and this window appears:
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There is some read-only information at the top of the goods received note that cannot be edited:
• Store: The name of the store the goods received note belongs to.
• Goods received ID: This goods received note's number. The number is automatically incremented and assigned when the goods received
note is first created and is unique within a store. Note that goods received notes in different stores could have the same number.
• Created by: The name od the user who created the goods received note.
• Modified by: The name of the user who last modified the goods received note.
• Entry date: The date the goods received note was created.
• Purchase order: The number of the purchase order the goods on this goods received note were ordered on. It is a link and clicking on it will
open the purchase order.
• Supplier invoice: The number of the supplier invoice produced from this goods received note. The number is filled in after the goods
received note is finalised. Agaqin, it is a link and clicking on it will open the supplier invoice.
• Status: The status of the goods received note:
◦ nw = new, the goods received note is not complete yet and is still editable
◦ fn = finalised, the goods received note is complete and is no longer editable
If you have goods receipt authorisation set up in Store Preferences there will be an extra Authorised column - see the Authorising items on goods
received notes section below for more details.
In the Supplier field (which displays Search Purchase Order when it first opens), enter the first few characters of the name of the supplier from whom
the order has been received; to display all Purchase Orders awaited, enter @ in the Supplier field. (This has been done in the example shown below):
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From this screen select the entry which matches the order you have received either by double clicking on the entry, or by highlighting the entry and
clicking on the Use button.
The New Goods Receipt window reappears with the supplier field and some other details completed.
At this point you should fill in the Supplier reference field (with the delivery note number, for example) and the Comment field (with any extra
information you need to record about the delivery).
Next, you should click on the Add from Purchase Order button to add the items which have arrived to the goods received note. Clicking the button
brings up the Choose order lines… window:

This window displays the goods on the Purchase Order, and you may either select each item separately (click on a single item), the entire order (click
on an item then press Ctrl+A on the keyboard, or Cmd+A on a Mac) or something in between (use Ctrl+click to select individual items and add/
remove them to/from the selection and/or Shift+click to select a range of items) to enter the details of the items received!
If you're trying to find a particular item in a long list you can also type the start of the item's name or code into the search box at the top and the list
will be filtered to show items which have a name or code starting with what you have typed.
In any case, when you have selected the items to receive, click on the Use button.
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Occasionally goods may be received which were not ordered; when this occurs, click on the Add an un-ordered item button and select the item before
proceeding.

Goods receipt line entry
You are now presented with the Edit goods received line window for the first item:

Let's have a look around the window and see what information is being displayed:
• Item: the name of the item we're entering the information about what we've received for. At the end of the field is the item's code.
• Remaining quantity to receive: the number of packs we're still waiting to receive from the supplier on the purchase order this goods receipt
note is for. This is 0 on the screenshot because, by default, mSupply creates a line in the table which contains all the outstanding stock.
• packs of: the pack size (number of items in the packs) we're waiting to receive. So, the total number of individual pieces of this item we're
waiting to receive is Remaining quantity to receive x packs of.
• table: contains all the lines of the item that we're receiving from the supplier. Click on any of the cells to edit them (they are all editable
except the Total quan column because this is a calculated column and equal to Quantity x Pack Size). There will be a separate line in this
table for each batch or location (and manufacturer if the preference to record manufacturer is turned on - entering a manufacturer is the
same as entering a location i.e. enter the first few characters of the manufacturer's name and press the Tab key on the keyboard and select
the manufacturer you want from the list displayed or click on the New button to create a new manufacturer).
• Expiry date picker: this is in the column just to the right of the Expiry column. Click on it to select the expiry date from a date picker:
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•
•
•
•
•
•
•

Click on a month and year in either order and mSupply enters the last day of that month in the expiry date column. You can manually edit
the date (or manually enter it without using the picker) if you don't want the last day of the month.
Volume per pack: the volume per pack for the line currently selected in the table. Will be set to the item's default volume per pack if it has
one, otherwise 0.
Weight per pack: the weight per pack for the line currently selected in the table. Will be set to the item's default weight per pack if it has
one, otherwise 0.
Total line weight: the total weight of this line in the table (= Weight per pack x Quantity column figure for the line)
Total capacity: the total volume the location for the selected line in the table has. 0 if the location is not set for the line or has no volume
set.
Available space: the available space in the location before putting this line in it.
Space required: the volume this line requires (= Volume per pack x Quantity column figure for the line). So compare this with the Available
space figure to see whether the line will fit in the location selected.
Comment: Anything you want recorded for this line. Anything typed in here will appear in the Comment column in the table.

If you have set a note for this item on the purchase order (see Notes section in Editing Purchase Order Lines) then an extra Note section will appear at
the bottom of the window:
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Until the Note has been actioned checkbox is checked, lines for this item will appear in red on the overall goods receipt window (see below).
To add lines for new batches or locations, click on the Add line or Duplicate line line button - they both add a line, Add line adds a blank one,
Duplicate copies the line currently selected in the table. No surprises but, to delete a selected line, you click on the Delete line button!
You can edit a row in the table by clicking on the various cells. It is best to click on the left-hand Quantity cell and adjust that one first. Then you can
use the tab key to advance to the next cell in the row.
Let's take the following example for amoxycillin 500mg caps.
quantity

pack

batch

expiry

648

1000

b1234

30/6/18

324

1000

b1235

30/11/18

Let's say there are 12 packs in a box, and 27 boxes on a pallet, so you have 2 pallets of the first batch and one pallet of the second batch. You can only
put one pallet in each location, so the first row will be split into two.
Enter the details into the first row as above.

If you are entering details for an item which has its “Expiry date required on receive” preference set (see here for details) and you do not enter
an expiry date for any of the item's batches then, when you click on the OK or OK & Next buttons, you will be shown a warning message and
you will not be able to close the window without entering an expiry date for each batch or deleting all the item's batches.
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Location management when receiving goods.
If the items you are receiving have had a location and volume entered when the Purchase Order was created, these will be transferred to the goods
receipt. If you want to edit these details you can do so by double-clicking a line and either changing the volume or the location.
You can then choose a different location by entering it in the location field, or enter the start of a location code and press tab to get a list of matching
locations.
When you get to the location column, we type m then press tab. you are shown the location choosing window with locations that match “m”

Note we have then clicked the Show empty radio button, as we are putting away a whole pallet, and pallets only go in empty locations. The Show
available radio button shows locations that have enough spare capacity to take the volume of the line we are receiving. We then double-click on the
location to choose.

If the item you are receiving has a default location set for it, this will have already been filled in when the line was added to the purchase order.
Default locations should be set if the same item is always put in the same place, otherwise leave it blank. In the current example we've assumed
it has not been set for each item.

Now we have entered all details for the line, we can click on the row to highlight it, then click the Duplicate line button to create another row the
same without entering all the details again - you then only need to click on the location column on the newly duplicated row, and you can edit the
location to find another empty location for the second pallet.
Once done, you can duplicate the row again, and this time you have to change the batch (to b1235), expiry (to 30/11/18) and location.
Then your window should look like this:
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Note that the bottom row of the table shows you the total number of packs and total quantity being received.
If all the details are correct click OK (or OK & Next if you selected more items to be added from the purchase order) or click Cancel if you want to
abandon this entry. You will be taken back to the window showing the overall goods receipt, this time including the lines you've just entered:
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Review overall Goods Receipt

All the items you've selected have been added to the goods receipt The quantity is set to the total remaining to be received for that item.
Double click on each item in turn and the window allowing you to enter quantities, pack, batch numbers, expiry dates.

Red line in the Goods Receipt?
If you see lines show up in red on the Goods Receipt that means that you have set a note that must be actioned for that line on
the Purchase Order (see Notes section of Editing Purchase Order lines for details).
Once you have actioned the note, the lines will return to their 'normal' black colour.

The right hand side of the window shows you the shelf location, total capacity and available space for a particular item in a particular shelf location.
You are also shown the volume or space required for a particular item. The small “refresh” icon the right inserts the default location for the items.
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The volume of the shelf location is now reduced to reflect the space consumed by our newly added stock item.
After entering the details for each item, you can click on OK & next to proceed to editing the next item.:

Finalising Goods Received
The next step in receiving your goods into mSupply is to create a supplier invoice (that is where you will enter pricing information if you need to).
This is done automatically for you when you finalise the goods receipt.
When you have entered all the goods you have received onto the Goods Receipt note, you finalise it by checking the Finalise box in the bottom left
hand corner of the window and clicking on the OK button. Only do this when you are sure the Goods receipt note is an accurate record of what you
have received and contains all the information you want in it because finalised means finalised and you won't be able to change it afterwards (just like
everywhere else in mSupply!).
Your goods are not yet entered into stock in mSupply - that only happens when the supplier invoice is confirmed. The initial status of this
automatically created supplier invoice is controlled by the “When finalising a Goods Receipt” store preference - see here for details.

If you have the store preferences set to force supplier invoice authorisation, you will not be able to confirm supplier invoices (and therefore
bring items into stock) until they have been authorised. See here for details.

Authorising items on goods received notes
When you have goods received note authorisation turned on in Store Preferences you will see an extra “Authorised” column on your goods received
note:
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The column will contain a checkbox for each batch you add to the goods received note. If a batch is authorised then check its box in the Authorised
column (only users with the Can authorise goods received permission can check these boxes). You can enter any notes on batches which fail
authorisation in the Authorisation comment box at the bottom. When you finalise your goods received note only the batches which have been
authorised will be put on the automatically created supplier invoice. In this way you have a complete record of what was received, what was
satisfactory and what was sub-standard.

Viewing existing Goods Receipts
Choose Supplier > Show goods received…
A standard mSupply find window is shown:

Click the OK button to view the last 15 goods receipts, or enter a value to find in the lower field, and choose the field you are searching for in the lefthand drop-down list (if you enter something in the lower text box this filter only will be used and the top one - number of recent goods received notes
- will be ignored). This window then opens to show the goods received notes that match your filter selections:
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New button: Creates a new goods received note
Find button: Opens the search filter window again, allowing you to make a new search for goods received notes.

Viewing a related Purchase Order or Supplier invoice
Accessing the related Purchase Order when the Edit goods received window is open is achieved by clicking on the blue “Purchase Order” on the right
side.
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Similarly, if you want to see the linked Supplier Invoice then click on the blue Supplier Invoice“.
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If you have turned on any of the custom stock fields in store preferences they will be displayed as columns (between the Batch
and Expiry columns) in the list of items and the information you entered for these fields when the stock was received will be
shown in the appropriate cells. If you double-click on one of the supplier invoice lines to edit it (assuming they are editable!),
you will see the custom fields and be able to enter information into them.

Outstanding Purchase Order lines
Outstanding PO lines are those which you are still waiting to be delivered from the supplier (also known as you pipeline stock). You can view them by
either:
• Clicking on Show outstanding PO lines on the Navigator's Supplier tab or
• From the Supplier > Show outstanding PO lines menu item
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Viewing and editing supplier invoices created via Goods Receipts

Supplier invoices created via goods receipts differ slightly from standard supplier invoices.

The Price tab
Here, you can add in any extra currency related charges
1. in the supplier's currency in the Extra Foreign Currency charge field , and
2. in your local currency in the Local charges field and mSupply will automatically calculate the updated invoice price.
Here's an example of how mSupply will do this with a currency “YXB” whose rate is YXB 7 = USD 1

Item

Foreign Price

Quantity

Foreign Currency
Price Extension

Local Price

Local price Extension

Amoxycillin 250mg tabs

50

10

500

70

3,500

Paracetamol 500mg tabs

300

5

1,500

35

10,500

Now we add USD300 of freight charges and YXB1400 of import duties:
• The total USD value of the order is USD2000, so 15% must be added to each line to account for this
• The YXB1400 is equivalent to USD200 in local charges, so 10% must be added.
• Therefore a total of 25% is added.

Item

Foreign Price

Quantity

Foreign Currency
Price Extension

Local Price

Local price Extension

Amoxycillin 250mg tabs

50

10

500

87.5

4,375

Paracetamol 500mg tabs

300

5

1500

43.75

13,125
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Currency and Currency rate
Select the supplier currency from this drop-down box, and enter the current exchange rate in the Currency rate field . Note that currencies must first be
entered using the menu item Special>Currencies. See Currencies...

Extra foreign currency charges
In the supplier's currency, enter any extra charges from the supplier.

Local charges
Enter any local charges, in your local currency.

Application of charges
mSupply distributes any extra charges proportionally according to the invoice value of each item on the invoice; this is done automatically

MoneyWorks tab
If you are using the MoneyWorks accounting software (which is highly recommended), clicking on this tab allows you to export the invoice details to
MoneyWorks. Elsewhere in this guide instructions on setting up mSupply to work with Moneyworks are to be found. See moneyworks.
Previous: Receiving Goods - a Supplier Invoice Next: New Supplier credit
2011/05/18 10:02

·

New supplier credit
Entering a supplier credit is exactly the same as entering a customer invoice, except that you enter a supplier code rather than a customer code.
Note that the transaction uses the cost price of the goods to calculate the invoice value. If you have set the mSupply Preferences to allow editing sell
prices, you will also be able to edit the price at which you return goods on a supplier credit.
You can also adjust the cost price of an item line manually. To change an item line's cost price, choose Items | View or edit item… Locate the item
concerned, then click on the “stock” tab to display the item lines. Click the item line you wish to change, then click the “edit line” button. (Only users
in the “high access” group can perform this action.)
Previous: Receiving goods (Goods Receipt function) Next: Editing Pack Sizes
2011/05/12 06:54

·

Editing pack sizes
Changing pack sizes for items already received
If you have received goods and the supplier invoice is taken off hold, these goods will go into stock and be available for issue.
You can still edit the pack size if.
1. No stock has been issued, or:
2. You have the user preference set that allows editing pack sizes even after issue. 7)
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Allowing editing of pack sizes

Changing a received pack size after items have been issued
Take as an example chloramphenicol eye ointment; a delivery has been received, comprising 500 tubes, packed in packs of 100 - i.e. 5 boxes, each
containing 100 tubes. When the entry is made into mSupply the operator in error enters a quantity of 5 and a pack size of 1, instead of a quantity of 5
and a pack size of 100.

Provided the user permission described above has been set, the error can be rectified, and the invoice altered to show the correct pack size of 100.
389

mSupply user guide July 2018

From the Supplier menu, choose Show invoices to access the required invoice. Select the line Chloramphenicol 1% eye oint,and double click on it. If
stock has already been issued, a window will appear to alert you, and allowing you immediate access to the customer invoices detailing the issues.

It should be noted that adjustments may be necessary on these invoices.

Click OK to display the Add/edit supplier invoice line where the correction can be made by changing the Pack size entry from 1 to 100.

How is this different to splitting a stock line?
Splitting a stock line is required when a store receives and manages an item whose pack size contains a number of units in the pack, but typically
issues the item to the store's customers in smaller quantities. Taking the example above, the store receives and manages chloramphenicol eye ointment
in a pack size of 100, but issues in single tubes.

• Editing the pack size in a supplier invoice, changes the total stock on hand (and / or issued)
• Splitting a stock line does not change the total stock on hand (and / or issued)

The Item details screen is displayed from the Item > Show items menu, by entering the first few characters of the item in the Find item window.
From the list on the side bar, click Stock, and on the window which appears click on the appropriate line to select it; the window should now have this
appearance:
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Click the Split button, and fill in the appropriate details on the form - in this example the 3 packs of 100 are to be changed to 300 packs of 1.

Looking again at the Item details window, the stock is now displayed as 300 single units, and the store is now able to issue as little as a single tube, or
any quantity up to the total available.

Previous: New Supplier credit.... Next: Show outstanding Purchase Order lines
2011/05/30 10:29

·

Managing outstanding purchase order lines (pipeline stock)
Stock that you have ordered and waiting to be delivered is called your pipeline stock. Sometimes it's helpful and important to monitor this stock so
mSupply has functions to help you do that.
Pipeline stock is represented by all the outstanding purchase order lines i.e. purchase order lines on confirmed purchase orders which haven't been
fully received into mSupply yet.
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To see all your pipeline stock simply choose Supplier > Show outstanding PO lines… from the menus or click on the Outstanding icon in the
Purchase orders section of the Suppliers tab on the navigator. This window will open:

All lines in black are those where the expected delivery date (EDD) is after the current date i.e. where the Days to EDD column (which contains the
difference between the EDD for a line and the current date) has a number greater than 0. These are items which are not yet overdue but, if the Days to
EDD column contains a small number, you might want to call the supplier to check on the delivery.
All lines in red are those where the expected delivery date is on or before the current date i.e. where the Days to EDD column contains 0. These items
are overdue and it probably means that the supplier could do with a call to find out what's happening with your delivery.
The Adjusted quantity column shows the actual number of items you ordered (number of packs x the packsize).
The Qty received column shows the number of items (number of packs x the packsize) yo have already received into mSupply.
The Qty Outstanding column shows the remaining number of items on the order waiting to be received (Adjusted quantity - Qty received).
Double clicking on any line will open the Purchase Order with that line highlighted.
You can print the list of purchase order lines currently displayed in this window at any time by clicking on the Print button - as usual, you will be
given the option of printing or exporting to Excel.

Update EDD button
If you speak with the supplier about a delivery or receive information from elsewhere about when goods are going to be delivered you can update the
expected delivery date for those lines.
To do this, simply select the lines in the table that are affected then click on the Update EDD button. In the window that opens, enter the new EDD for
the lines and click on the Update button. The EDD is immediately updated for the chosen lines and, if the lines were red, they will turn black.

You can select multiple lines to update using the usual Shift+click to select/deselect a range of lines and Ctrl+click (Cmd+click
on Mac) to add/remove a line to/from what is currently selected.

Filtering the list
Sometimes the list of outstanding purchase order lines can be very long (just after running your annual tender for example, or when you have placed
several large orders) and it can be hard to find a specific item or items expected from a particular supplier. To help in this situation, mSupply allows
you to filter the displayed list.
To do this, select the type of filter you would like to apply by clicking on the filter icon (

) just to the left of the textbox and select one of:

• Search by supplier or code - will show only those outstanding purchase order lines on purchase orders whose supplier name or code begins
with what you type in the textbox
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• Item name or code - will show only those outstanding purchase order lines whose item name or code begins with what you type in the
textbox
• Days to expected delivery is less than… - will show only those outstanding purchase order lines with an expected delivery date less than the
number of days you enter in the text box from the current date.
Then enter the value you wish to filter by in the textbox and click on the Find button. The list will then be changed to show only those purchase order
lines matching the filter you have selected.

Finalising purchase orders
Any outstanding goods on finalised purchase orders will NOT be included in this window. So, if there are goods that you have ordered but will never
receive from a supplier (maybe a substitute item has been shipped or you cancelled part of an order because a supplier said they couldn't deliver it),
when everything else on the purchase order has been received you should finalise it. The goods on the purchase order that you have not received will
then no longer be shown as outstanding in this window.
It is good practice to finalise purchase orders for which you have received everything because it also removes the purchase order from the list you can
create a goods received note from (see Receiving goods (goods receipt function)), making it easier to find a purchase order you're wanting to create a
goods received note for, and means that no changes can be made to the purchase order in the future.
But beware: don't finalise a purchase order before you have received everything the supplier is going to send because you won't be able to make any
changes to it or receive goods against it using the goods receipt function (Receiving goods (goods receipt function)).
Previous: Editing Pack Sizes Next: Managing Donors
2011/05/12 07:00

·

Custom stock fields
Custom stock fields are a useful way of tracking your stock. You can think of them as providing stock tags or categories which can be seen wherever
stock is viewed throughout the system and can be used for filtering reports.
There are 8 custom stock fields available. The first 4 are free text (the user can enter any text they like) and the final 4 allow the user to select values
from preset lists defined by you.

Setting them up
You turn them on in the stock tab of File > Preferences. See here for details.
To define the lists the user can select from for custom stock fields 5 to 8, click on the Item > Show custom stock field value lists… menu item. This
window is displayed:
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In the Show drop down list, select the custom stock field you want to add/edit/delete values for. Note that the items in the list will be “Custom stock
field 5” to “Custom stock field 8” but those fields which have been given a Display name in the preferences will be replaced by it. In our example,
Custom stock field 5 has been given the display name “Programme”:

The custom stock field values table below the drop down list shows all the values currently in the list for the selected field.
New button Click on this to enter a new item for list for the custom stock field currently selected in the show drop down list. Note that the list of
items will always be displayed in ascending alphabetical order for a user to choose from.
Delete button select an item in the list and click on this button to delete an item from the list
Double click on an item in the list to edit its name
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Using them
Now that they have been set up, when you receive goods in on a supplier invoice the enabled custom fields will appear on the supplier invoice line
detail window. Enter the values in there as you receive stock into mSupply. The values will then appear wherever you see stock in the system e.g. on
the stock tab of an item's details window.
The fields will also be available for filtering on when you are running any of the stock based reports.
Previous: Managing donors
2016/04/19 13:25

·

Managing donors
What/Who is a Donor?
In mSupply, we have the idea of a 'name'. A name can be a customer, a supplier, a patient, … or a donor.
A donor is the organisation that has either paid for, or somehow managed the supply of certain items.

A donor can also be a supplier and / or a manufacturer or they can be just a donor.
mSupply allows for any combination of that.

mSupply allows you to specify the donor for each incoming stock line independently of the supplier.
For example, GlobalFund might agree to supply certain malaria medicines, and then contract a supplier to deliver them to you. mSupply allows you to
record this accurately, and to track and report on all the stock and transactions relating to those medicines donated by GlobalFund.

Using the Donor Module
To use the donor module, you must first turn it on:
• Click drop down menu File>Preferences…
• Click the Invoice 1 tab in the left-hand list
• Check the box Allow tracking of received stock by donor
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Once you have done this you can add donors and track stock by donor.

Adding or Editing Donors
To add or edit a donor you should first bring up the list of donors. Do this from the Navigator:
• Go to the Suppliers tab > Show Suppliers and check the box beside Donors so that the list shows donors rather than suppliers. Click
Find. This will bring up a new window showing any donors you have added
• You can edit a donor by double-clicking on it.
• You can add donors using the New tool bar at the top of the window. This will bring up a window like this:
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• Now add your donor details and click OK.

Track a Donor in mSupply
Donors and the Purchase Order
• Create a Purchase Order in one of the usual ways - refer Ordering Items From Suppliers.
• With donor tracking turned on, the Donor field will appear in the window - see below. The value you enter here will be tracked from this
point on through to receipt, stock transfers and dispatch.
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• In the Donor field type the first few characters of the donor name or code (or enter the wildcard character '@' in field) and press the Tab
key on the keyboard. This opens the window below, showing the donor that match what you typed:

398

mSupply user guide July 2018

• If your donor does not exist, you can add it at this point by clicking on the New button - see Adding or Editing Donors above.
• Once you have selected your donor, click on the OK button and the donor's name will appear in the Donor field:
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• Add your Item line(s), check your order is correct and click the Confirm button to make the order available for Goods Receipt in the
normal way - see Ordering Items From Suppliers for more details.

Donors and the Goods Receipt function
Receive goods in the usual way - see Receiving goods (Goods Receipt function). The only difference is that the Donor's name is now present in the
Donor field:
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Donors and the Supplier Invoice
• Clicking Finalise on the Goods Receipt generates the Supplier Invoice in the usual way (see Receiving Goods - a Supplier Invoice). Note
that you can see the donor identified in the Purchase Order in the Default donor field:
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Default donor for each stock line
• Each stock line on a Supplier Invoice will inherit the Default donor from the Supplier Invoice.
• The Default donor can be edited.
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Changing the donor for a particular supplier invoice line
• There may be circumstances when delivered stock may be from a mix of donated and non-donated, or from different donors. You can
change the donor for any stock line on a supplier invoice when editing the details of the stock line (double-click on the stock line).
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If you change the Default donor, you will be presented with the following options:

•
•
•
•

“Do nothing”: The change will have no effect on existing invoice line(s).
“Update existing donor lines with this donor”: existing donor lines will be updated to match the newly selected donor.
“Assign this donor to the lines with no donor”: lines with no donor selected will be updated with the newly selected donor.
“Assign this donor to all lines”: all lines will be updated with the newly selected donor.

Donors and the Customer Invoice
Customer Invoices, including stock transfers for donated goods are created in the usual way - refer Issuing Goods to a Customer (Customer Invoices).
• They key thing to note is that when selecting from the stock lines to add to the Customer Invoice, the donated stock lines can be
distinguished from the other stock lines by the donor name in the Donor column - see below:

404

mSupply user guide July 2018

mSupply will still suggest a stock line according to its selection criteria (primarily,
FEFO). You will need to manually select the donated stock line if it is not the first
expiring!

Reporting
Obviously, one of the points of entering all this donor information is to be able to report on it. When the donor tracking preference has been turned on,
many of the stock based report filters in mSupply will have an additional donor filter added to them. Simply enter the donor filter settings you need, as
appropriate, to filter the reports accordingly.
Previous: Outstanding Purchase Order Next: Issuing goods
2012/09/25 02:09

·

Issuing goods to a customer (customer invoices)
Creating a new Invoice
Choose Customer>New invoice. A window like this will open:

User defined fields are displayed in the above screenshot. To show or hide user defined fields go to File> Preferences> Invoices 2.
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Information to enter in the main window
Name:
Type as much of a customer name here as you know and then press Tab. If there is only one name that matches your choice, it will be entered
automatically for you, otherwise you will be presented with a list of available choices. Once you have entered a valid name, the New line button will
be enabled. If you can not find the name you are looking for, you can add a new name by clicking the person icon (

) to the left of 'Name'.

By default, names with their code starting with a tilde (~) are not shown. This is a great way preventing a user selecting a name
when it can't be deleted or hidden in a store - put a tilde character at the beginning of its code.

The downward pointing arrow to the right of the Name field takes you directly to the Edit Customer/Supplier window, giving access to all the
information relating to the name entered

Their ref:
Enter the customer's order number if there is one

Comment:
Click on the downward pointing arrow to the right of the Comment field to display a window where any comment relating to this invoice can be
noted.

Category
If you are using the category feature, and have defined them, the appropriate category is selected from the drop-down list.

User-defined transaction fields:
If you are using the user-defined transaction fields, they will appear and can be filled in here. Should you wish to use them, they have to be activated
in Preferences>Invoices 2, refer Show customer transaction fields.

Read-only information on the invoice
There is some information on the top of the invoice that is read-only and cannot be edited:
• Confirm date: The date the invoice was confirmed. “00/00/00” if the invoice has not been confirmed.
Note: this date can be made editable from preferences.
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• Invoice: This is the invoice number. The number is automatically incremented and assigned when the invoice is first saved (which actually
occurs when the first line is added to it) and is unique within a store. Note that customer invoices in different stores could have the same
invoice number.
• Entry date: The date the invoice was created.
• Goods received ID: If the customer invoice is linked to a goods received note then its ID will appear here in blue, indicating that it is a link
and, if clicked, will open the goods received note.
• Status: The current status of the customer invoice:
◦ nw = new (just created, can still be edited, stock not yet removed from mSupply)
◦ sg = suggested (has been opened since first creation, still editable, stock not yet removed from mSupply)
◦ cn = confirmed (stock has been removed from mSupply but invoice is still editable)
◦ fn = finalised (stock has been removed from mSupply and the invoice is no longer editable)
• Entered by: The user name of the user who created the customer invoice
• Store: The name of the store the customer invoice belongs to.

Buttons at the top of the customer invoice window
At the top of the Customer invoice window, there are a series of buttons:

New line
Will add a line to the invoice. This command can be used on any invoice that is not finalised. Clicking the button will present you with the window for
adding a line from stock. See the Adding lines to an invoice section below for more details. To select a line to edit, simply double-click on it. Note that
new line and edit line are disabled on finalised invoices.
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Delete line(s)
Will delete a line which has been selected, and appears highlighted. Multiple lines, which do not need to be sequential, may also be selected and
deleted using this button.

Backorders:
This icon is displayed only if `We run a backorder system' is checked in the Preferences > invoices 2 options - refer We run a backorder system.
Clicking this button shows you a list of items that are on backorder for the customer you have chosen. To view the backorder list of items, you must
first confirm the transaction.

Refer to Issuing Goods - Managing Customer backorders for a full coverage of the
backorder topic.

History:
Clicking on this icon will display a record of all that this customer has purchased in the past. This may produce a very long list! The list appears in
chronological order, but clicking on any of the column headers will sort the list according to that parameter.

Confirm:
When this button is clicked, the status of the order changes from nw (new) or sg (suggested) to cn (confirmed).

If you have “confirm invoices automatically” set in the Preferences, the Confirm
button will not be visible. The invoice will be confirmed as soon as you click on
the OK button. Read below to see what confirmation does.
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• The confirm button is only available for invoices with status sg (suggested).
• Confirming an invoice should be done when the goods have been removed from the shelves and have left the store or have been packed
ready for dispatch). Most importantly, as far as mSupply is concerned, this stock is no longer in the store and a stocktake will not find it!

More detail around confirming a Customer Invoice:
• Each item line records two stock levels- the quantity is the total stock
on the premises. the available amount is what can be issued on an
invoice.
• For example:
◦ You have 10 bottles of Paediatric Paracetamol Elixir in
stock.
◦ You get an order for 3 bottles from Fred, and create an
invoice for Fred. The quantity in stock is still 10, but
quantity available drops to 7, as these 3 bottles are 'reserved'
for Fred and can't be issued to anybody else.
◦ You are about to dispatch the order. At this point you
confirm the order. The quantity in stock also drops to 7.
• In summary, the Confirm button does the following:
◦ Each line has its quantity in stock reduced by the amount
issued on that line
◦ The Customer Invoice status changes to cn

• If you are running a backorder system, confirming a Customer Invoices also deletes any placeholder lines (those with a batch entry of
“none”) and adds them to that customer's backorder file.

Modifications may still be made to the invoice (and those changes therefore
directly affect the stock in mSupply). See Confirming an invoice.

If you have the store preferences set to force customer invoice authorisation, you
will not be able to confirm customer invoices until they have been authorised. See
here for details.

Buttons and checkboxes at the bottom of the Customer invoice window
At the bottom of the Customer invoice window, there are a series of controls.

Hold
Checking the Hold checkbox prevents the Customer Invoice from being confirmed or finalized.

Finalize
Checking the Finalize checkbox allows you to finalize an invoice when you click the OK button. Only users with Can finalize individual invoices
checked in their user permissions can check this box. Other users will be warned if they try to turn it on, and the Finalize checkbox will automatically
uncheck.
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If the Finalize checkbox is checked and you click the Confirm button, the invoice
will be confirmed as well as finalised when the OK button is clicked, so be very
careful! A finalised invoice may be viewed and/or printed, but it can not be edited.

If the Finalize checkbox is checked but dimmed out, it means that
File>Preferences>Invoices 2>Finalize customer invoices automatically is
checked and all confirmed invoices will be finalised whether you like it or not!

OK & Next
The OK & Next button saves the changes you have made and exits the window. You are given the opportunity to print if the Print checkbox is ticked.

Delete
The Delete button allows the deletion of an invoice. If the invoice has a status of 'nw' you can delete the invoice even if has lines added. If the status
is 'cn' or 'sg' you will have to delete the lines manually first - refer Deleting line(s). When an invoice has been deleted the invoice number that it
was assigned will be reused.

OK
The OK button saves the changes you have made and exits the window. You are given the opportunity to print if the Print checkbox is ticked.

Printing the invoice
If the Print checkbox is ticked then print options will be presented when the OK or OK & Next buttons are clicked.
If the invoice status is 'nw' (new) or 'sg' (suggested), pick list options will be printable.
If the invoice status is 'cn' (confirmed) or 'fn' (finalized), invoice options will be printable.

If the option to turn on the print check box has been set under
File>Preferences>OK and print, you can override the printing process by holding
down the Shift key as you click OK, and no invoice will be printed.

Instead of an invoice, should you wish to print a pick list for an invoice whose
status is 'cn' or 'fn', hold down the Alt key (Windows) or the Option key (Mac)
while clicking OK.

Tabs in the customer invoice window
The three tabs allow the invoice to be viewed in three different formats, but note that the lower area of the window remains the same and is available
for appropriate input in all views.
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General tab
Once an invoice has been created, a detailed view of the items on it may be seen by selecting this tab; where the supply of a single item is made up of
different batch numbers, they will be displayed as separate lines:

Buttons in the General tab
There are a row of small icon buttons at the bottom left of the window. Hovering the mouse over each button gives a description of what it does.

Process button (grinder icon)
Clicking this button shows a menu with the following choices:
1. Renumber lines: will re-assign line numbers to all lines on the invoice according to their current order (you can move lines around by
dragging and dropping to a new position.
2. Issue stock for all placeholder lines: This option will go through each placeholder line on the invoice and attempt to issue stock.
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• There are several factors that affect the success of the Issue stock for
all placeholder lines operation, so you should review the automatic
choices mSupply makes to ensure it is appropriate.
• mSupply will issue the oldest expiry stock first. There are good reasons
why you might not want this to happen, including:
◦ Availability of sufficient stock of the line in question
◦ Pack sizes that fit with the quantity/pack on the placeholder
line. mSupply will happily issue parts of a pack. In reality,
you may wish to choose from a different stock line with
different pack sizes!

Financial summary
Clicking this button shows you a summary of the cost and selling price information for the invoice.

If you check the Print as Pro-forma invoice checkbox in this window, rather than printing a pick slip, a pro-forma invoice will be printed, allowing
you to give a paying client a form showing expected charges.

Transaction note
Allows you to make a note relating to this invoice.

Copy to clipboard
Copies the entire invoice to the clipboard.
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Summary by Item tab
The Summary by Item tab displays the items on the invoice, consolidating different batch numbers and displaying the total quantities for each item
only; the invoice above appears in the following format when the Summary by Item tab is selected.

Summary by Batch tab
The Summary by Batch tab displays the items differentiating between batches, and showing a breakdown where more than one batch has been
supplied on the order. The above invoice appears in the following format when the Summary by Batch tab is selected; note that two different batches
of metronidazole tablets were supplied.
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Transport Details tab
Selecting this tab displays the following window:
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Here you can add information about the method of transportation and other related information.

Order Tracking data
The five date boxes enable you to track your order from it being generated (written) to the customer confirming receipt of it (actual arrival date):. The
five date fields are:
•
•
•
•
•

Order written date: The date the customer wrote the order (this will usually be on their requisition form).
Order received date: The date the customer's order was received by you
Order shipped date: The date the order left your store
Expected arrival date: Given the shipping method you're using, when you expect the goods to arrive at the customer's premises.
Actual arrival date: The date the goods reached the customer you are supplying. Obviously you will only know this if they report the
information back to you (e.g. via SMS message)

If you use these date fields, it allows reporting using the Transaction Report using the report form Order Processing time. Sometimes it is necessary to
edit these dates after finalisation of a customer invoice so there is a special permission for users to allow them to do this (on the User details page,
Permissions 2 tab - see Managing users, the Permissions tabs for details.

You can make the Order written date and Order received date fields compulsory in
File > Preferences, Invoices 2 tab as explained in Invoices preferences
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You can add a Shipped to contact name if you select Choose contact for transport
details in File > Preferences, Invoices 2 tab as explained in Invoices preferences

Shipping method
The list of options in the Ship method drop down list is set by choosing Customer > Show shipping methods…, when you are shown a window
with a list of existing shipping methods:

To enter a new method, click the New button. To edit an existing method, double-click the item in the list and edit its details. To delete a method, click
on it in the list to select it then click on the Delete button. You will not be able to delete a shipping method if it is being used by a customer invoice.

Responsible officer
The choice list for Responsible officers is a list of mSupply users for whom the “Can be responsible officer” check box has been checked. Choose
File>Edit users…, then double-click a User Name to set up each user as a responsible officer (or remove them from the responsible officer list)
If you enter information here, you can report on performance of your transport operations in various ways using the Report>Transport Report….

Box Management and label printing
The Box Management feature is used to tell mSupply which items were put in which 'box' or container for transporting to your customer. This has a
few advantages:
• You can print labels from mSupply to stick on each box (either from a label printer or a normal A4 paper printer - see the Printing an
invoice: Picking slips and delivery notes section below for details).
• You can create (automatically or manually) weight and volume information which can be printed on the packing list or passed to your
freight handlers.
• It tells the customer what's in each box to help their goods-inwards processing.
For details about how to use this feature, please see Box management.
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This is an example of a box label printed from a normal A4 paper printer:

Log tab

The log tab displays changes to the invoice that have been logged. Details of all logged activities are record in the mSupply Log
(http://docs.msupply.org.nz/admin:the_log).

MoneyWorks tab
If you are using the Moneyworks accounting software then the link between mSupply and Moneyworks will need to be enabled in
File>Preferences>Moneyworks - refer General Preferences - Moneyworks. If this option has not been enabled, then the Moneyworks tab will not be
visible.
The Moneyworks tab will show the status of the invoices inside Moneyworks accounting software once mSupply has carried out an export.
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Adding lines to an invoice
Clicking New line will bring up the Add Item… window:

Finding the Item you want
The first thing to enter is the Item Name or Item Code in the Item field. Type as much of the Item Name as you know, then press Tab. mSupply
searches for all Items whose Name or Code starts with the text you have typed.

By default Items with a Code starting with a tilde (~) are not shown. This is a great
way preventing a user selecting an item that shouldn't be used when it can't be
deleted or hidden in a store - put a tilde character at the beginning of its code.

If no entries match the request, the Item field will read 'try again'. You can try as many times as you like! If you conclude that the Item you want
does not exist in your system, click New item to add the Item.

Caution should be exercised before adding a new Item to your mSupply system.
Duplicate items cause problems. Ensure that the item you are looking for does not
already exist in your system and is hidden in the store you are logged into or is
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under a different Item Name and Item Code.

If only one Item matches your request, it will be chosen automatically and you will be returned to the Add item… window with that Item already
selected.

If your mSupply system has been set up with unique Item Codes for each Item,
then the experienced user will find that typing in the full Item Code here will save
mouse clicks and/or key presses.

If more than one Item matches your request, all of them will be displayed.

If the wanted Item is visible, double-click on it or click on it once and then click Use.
If the wanted Item is not visible, click Cancel to try again to find it.

Selecting from Item Lines
Once the item you want has been selected, the Add item… window will display a list of available Item Lines (if any). Each Item Line may be a
different pack size, batch, expiry, or price. The Item Lines are sorted by expiry date; first expiry at the top.

419

mSupply user guide July 2018

The lines are numbered in the left hand column and arranged in FEFO order (first expiring line at the top). The first line (the first expiring one) is
selected by default but you can choose another line in one of three ways:
• Type the line number into the Line field and press Tab. The cursor moves to the Quan field.
• Double-click on the line in the list. That line number is displayed in the Line field and the cursor moves to the Quan field.
• Single-click on the line in the list. Clicking again in the Issue column will allow you to directly edit the issue amount in the list - see
following.
Once you have chosen your line, the number of packs available will be shown to the right of the Quan field, the Pack size will be shown in the Pack
field, and the total quantity to be issued will be shown below the list of lines.
In the Quan field, you can enter any number greater than zero.

If you need to see the full details of the item itself, click on the down arrow icon (
) to the right of the item name field and you will be taken to the item's details
window.

The number entered in the Quan field is the number of packs. The pack size of the
currently selected line will be used to calculate the total quantity of units issued which is shown below the list of lines as Total quantity issued.

Issuing from a single line
If the number entered in the Quan field is less than or equal to the number available for the selected line, then that value will be shown in the Issue
column in the list.
Click OK to return to the main invoice screen, or OK & Next to add another Item.

Issuing from multiple lines
If the amount to be issued is greater than what the top line can issue, then you can issue from multiple lines without leaving the window. There is an
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automatic and a manual way of doing this.

Manually issuing from multiple lines
For each item line that stock is to be issued from:
1. Click once on the list to select the line
2. Click again in the Issue column
3. Enter / edit the issue amount in the Issue column
The Tab / Shift-Tab keys move the focus up and down the Issue column.
The Total quantity issued is updated at the bottom of the Add Item… window.

Automatically issuing from multiple lines
If the amount to be issued is greater than what the top line can issue, mSupply can automatically select stock from multiple lines on a FEFO basis. To
allow mSupply to do this, simply enter the total quantity you wish to issue into the Quan field.

If the quantity typed in the Quan field is more than there is available for the selected line, and the Tab key is pressed to leave the Quan field, this
message is displayed:

If you accidentally entered more than you intended, click Try again, otherwise click the Distribute button.
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Issuing when there is not enough stock
If the amount to be issued is greater than the total stock available from all of the available lines, then a placeholder line may be used, if your mSupply
preferences allow.

Placeholder lines
If there are no lines available, or none of the lines are suitable (for example, this order needed strip packaged stock, and the available lines are all bulk
packs), then you can add a placeholder line that will record the desired quantity and pack size until either you get stock, or go to confirm the order, at
which time the item will be either moved to backorder or deleted (depending on how you have set your Preferences).
A Placeholder line can be added manually or automatically.

Manually adding a placeholder line
A Placeholder line can be added by clicking the Add Place holder button.
As shown in the window displayed below, placeholder lines are coloured in red and have a batch of “none” so you can easily identify them.

The quantity to be issued in the placeholder line is entered in the same way as any other Item Line - refer Manually issuing from multiple lines

Automatically adding a placeholder line
If the number entered in the Quan field is greater than the total stock available from all of the available lines, then mSupply will prompt you with an
Alert:
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After clicking OK, all existing stock lines will have the Issue column populated with the total quantity available for each line, and a placeholder line
will be created with the outstanding quantity inserted in the Issue column.

If you have allowed placeholder lines in the Preferences, and you choose an item
that has no available stock, a placeholder line will be created automatically.

Confirming an invoice with placeholder lines
When confirming an invoice that has placeholder lines, the following actions will occur:
• If you have activated backorders, a backorder line will be created for each placeholder line.
• If you have set the Preferences to delete placeholder lines when confirming, they will be deleted, otherwise they will remain on the invoice
to show the client that their order was received, but the goods were not supplied.

Issuing all available stock of a batch
Sometimes you might end up with an unusual available amount of a particular batch. Due to the fact that mSupply rounds the available quantity, it
may be hard to enter the exact amount to completely issue the batch. In such situations you can issue the total amount available by holding down the
shift key while you double-click a line. This will issue the total available amount of that batch.

Lines on Hold
Sometimes you will see that a stock line has a tick in the tick-box in the Hold column and the line cannot be selected for issue - see example below.
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There are two possible reasons for this:
• The stock line is On Hold - refer Issuing goods to a customer (customer invoices), Adding lines to an invoice, Selecting from Item Lines,
Lines on Hold.
• The location is On Hold - refer Locations and location types, Adding a location, General tab.
You can find out whether it is the stock line or location (or both!) that is On Hold by double clicking on the line in question.
If there is insufficient stock in 'off-hold' stock lines to fulfill the invoice, a placeholder line will be created.

Adding lines from a Bill of materials
If the “Show 'Add from BoM' button” preference is turned on (see here for details) there will be an additional Add from BoM button on the customer
invoice form:

When you click this button it shows you a list of all the Bills of Material that exist in mSupply. Select one of those then mSupply will add all the items
on that bill of materials (with the quantities they have on the bill of materials) onto the customer invoice as placeholder lines. You can then assign
stock to the placeholder lines in the normal way (see, for example, Editing a placeholder line on an invoice below).
See the Bill of materials section for details about creating and using bills of material.
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Editing an invoice line
To edit an invoice line, double-click on it. You will be presented with the Edit line window, which is identical to the New line… window, except that
the item name is already chosen.

In the Edit line window the quantity you have already chosen is added back into
the Available stock column. You are viewing the stock records as if the line has not
yet been processed.
Similarly, any other invoice lines for the same item are also shown in the same
way; the Issue column is filled out with the the amount being issued from each
batch on the invoice and the Available column includes the Issue amount.

For example, in the window below, there are three lines on the invoice for different batches of paracetamol, and all three are shown when editing,
irrespective of which of the three lines was double-clicked.

At this stage you can:
• Edit the Issue value for the selected line item, or change the value in the Quan field
• Select a different item line (that is, a different batch) and edit it's Quan or Issue value.
• Click in the item name field, and select an entirely different item!

Selecting a different item has the following effects
• If you proceed to issue the new item, all invoice lines for item you were
editing will be deleted, and invoice lines will be added for batches
being issued of the new item.
• If you choose a new item for which there is already an invoice line(s)
on the invoice, the stock to be issued on those lines will be shown in
the “issue” column. If you proceed you are effectively editing the
quantities of the item you have just selected, and you are deleting all
invoices lines of the item that was originally on the invoice.
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Changing the batch to be issued
If you want to choose a different batch for an existing invoice line:
•
•
•
•

double-click the invoice line
set the quantity of the batch you don't want to zero,
double-click the batch you do want, and enter the quantity you want to issue.
Note that if possible the new batch will be added to the invoice at the bottom of the other lines, and the former invoice line will be deleted.
You can use drag and drop to reorder invoice lines if this is a problem.

Editing a placeholder line on an invoice
When you double-click a placeholder line, an extra button is displayed:

The Redistribute all button takes the quantity on placeholder lines and re-assigns it to actual batches in stock.
When you are not editing a placeholder line, the button is not visible.

Deleting a line from an invoice
• If the line is a placeholder line, you can simply click the line you wish to delete, then click the delete line button.
• If the line is a normal invoice line (with stock associated with it), double-click on the invoice line. In the line details window that appears,
press Tab to advance to the quantity field, enter 0 (zero), then click OK. You will be asked to confirm that you really want to delete the line.
Note : Once an invoice that has been finalised, you can not remove an item from it.

Reordering invoice lines
Invoice lines can also be reordered by drag-and-drop of a line to a new location. This can be useful to group lines for the same item.
If the invoice lines are currently sorted by line number the renumbering will happen, otherwise you will be shown an alert message.
If you really want to reorder lines when sorted by a different column, hold down the shift key as you drag-and-drop to override the message.
Note that reordering can not be undone, apart from you manually dragging lines back to their original location.
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• Lines in most mSupply forms can be sorted according to any column
by clicking on the heading of the column that you want to sort by.
• To make any sort order 'stick' when it is printed, you will need to
renumber the lines - refer Issuing Goods to a Customer (Customer
Invoices), The Grinder button above.
• A common desired sort order for a pick slip is to sort lines by Location,
so that when a pick slip is printed, the picker can work their way
through the store systematically by Location. In fact, this is such a
popular feature, we have set a printing preference so that it will happen
automatically without needing to manually sort the list - refer Printing
Preferences 8-).

Currency Settings
If you have customers that use a currency other than your own, mSupply can be configured to use your customer's own currency. Firstly you need to
make a selection in the Store's preferences to enable issuing in a foreign currency.

Once you have done this, you can select a currency for a customer from the edit customer window.
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You can also select the customer's currency when entering an invoice.
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Currency: This is the currency your customer uses. It is set in the Customer Details window of the Customer record and is displayed when you add
your customer's name to the invoice.
Currency rate: Gives the exchange rate stored in mSupply.
Foreign currency total: Provides the invoice total in the currency the customer uses.

Printing an invoice: picking slips and delivery notes
You can print an invoice at any time by checking the print icon checkbox (next to the OK button) and clicking the OK button:
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But note: you print different things depending on what status the invoice has:
• If the invoice is suggested (sg) then a picking slip is printed.
• If the invoice is confirmed (cn) or finalised (fn) then a customer invoice or delivery note is printed.
In either case, after clicking the OK button, you are shown the print options window:

The Form to use drop down list contains all the options for the format of the print out you will get. All the standard mSupply options will be here, as
well as any custom forms we have created for you.
If the form you selected to use wasn't the one offered by default and you want to set it to be the default from now on (beware, this will set it for
everyone!) then check the Remember this choice checkbox before you click on the OK button.
If you want to print dispatch labels to go on each box then check the Print dispatch labels checkbox. This will print labels on 100x150mm labels on a
label printer, not the usual A4 paper printer you print the picking slips and delivery notes with so you must have configured that in mSupply first - see
Printing preferences (setup) for details on how to do this. If you only want to print the dispatch labels and not a delivery note then select the None
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option in the Form to use drop down list.
The print Destination options:
• Printer: the invoice will be printed out straight away.
• Preview: a preview of what the invoice will look like when it is printed will be displayed in your installed PDF file reader. You might be
able to print the invoice from the PDF reader, depending on its features.
• PDF file on disk: the invoice will be saved to disk in PDF format.
• Email PDF: the invoice will be created as a PDF file and attached to an email for you to send. You can double-click the email attachment
to see a preview of the invoice. The email preferences in File > Preferences should be setup correctly before using this feature.
• Export to Excel: the invoice will be exported as a spreadsheet file and opened for you (provided you have a spreadsheet application
installed).
The general process for distributing your goods should be this:
1.
2.
3.
4.

Create the customer invoice (new or suggested status).
Print the picking slip and give it to the staff who will pick the goods off the shelves.
As the goods are picked, note down any discrepancies between what was actually picked and what was on the picking slip.
When the pick is complete, enter any changes into the customer invoice in mSupply (Note that inventory adjustments or location
adjustments of stock may be needed to correct issues found by the pickers). This step is very important to make sure your stock remains
accurate in mSupply.
5. Confirm the customer invoice when it matches exactly what was picked.
6. Print the invoice again - this time a delivery note is printed.
7. Send off your goods with the delivery note!

A note about picking order on picking slips
You can print picking slips by item name in alphabetical order (the default) or, if this does not match the way goods are stored
in your warehouse, you can change the order to make the top-to-bottom picking order more efficient. Use location priority (see
Locations and location types) and the printing preferences (see Printing preferences) to achieve almost any order you want to
match the most efficient way of picking in your warehouse.

Entering a service line on an invoice
All “normal” customer invoice lines represent the issue of stock lines to a customer. (These lines appear in the large section in the middle of the
“Customer invoice” window).
mSupply also allows you to charge a customer for “service” item(s) such as freight, or advice or a refundable deposit on a cool box.
Enter the description and amount at any time until the invoice is finalised.
Note: the “subtotal” amount on the invoice includes any service charges, and tax (if any) will be added to the amount you enter.

Editing tax on invoices
The tax rate on an invoice is determined by the “default tax rate” setting in the mSupply Preferences.
To edit the tax rate on an invoice, click on the tax rate box at the bottom of the invoice entry window. You will be asked to enter a new percentage tax
rate. Click the cancel button if you do not want to change the tax rate.
Note: you can not change the tax rate on finalised invoices.

Invoice from supplier invoice
Choosing this command from the Customer menu allows you to take a supplier invoice and directly make a customer invoice.
It is useful for goods that are delivered directly from a supplier to a client, but are charged through your organisation.
431

mSupply user guide July 2018

You will be asked to enter the supplier invoice number and the customer code for the invoice to be created, so have this information ready.
When finished, a customer invoice with suggested status is created.
If any lines from the supplier invoice have been issued already, you will be alerted and only the available balance will be added to the customer
invoice.
Previous: Doners Next: Viewing Customer Invoices
2011/05/03 08:30

Viewing customer invoices
To view or edit any customer invoice, choose Customer>Show invoices

The Find Transactions window
You will be presented with this window where you can enter a number.

If you enter:

Transaction(s) Displayed

1

You will be taken directly to the most recent invoice entered

25

A list of the 25 most recent invoices

123 in the lower box

Invoice number 123 will be displayed.

Click the Complex Find button

The query editor will be displayed, where you can enter a more detailed query.

The list invoices window uses the Transactions list form, which looks like this:
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Note. All of the columns may be adjusted in width to meet your requirements; for the screenshot above to fit on the page, most of the columns were
reduced in width.
Down the left side is a sidebar, with 5 headings:
1.
2.
3.
4.
5.

Type
By date
By status
My transactions
My custom filters.

Clicking on the small triangle to the left of each heading will expand it and display the options available. In the graphic below, the Types heading has
been expanded to display the available options

Once the type of transaction has been selected, it remains selected while you further define the required criterion from one of the four remaining
headings, By date, By status , etc. Be aware that a single criterion only from this group of 4 headings may be selected.
At the bottom left of the window you'll notice there are 3 numbers separated by slashes- “1/15/67” in the example above. These numbers, in order, are
the number of highlighted rows, the number of found rows, and the total number of transactions in the database.
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Along the top of the window are these buttons:

Their functions are:

Find
Click on this button to recall the Find Transactions window, where several options are available.

Click on the drop down list on the left to display the options available for determining which field to query:

Choose the comparison from the next drop down list (equals, starts with, etc)

The comparison popup menu will change depending on the type of field you have
chosen in the first list.

This window is very useful for quickly finding a group of invoices.
If you want to query on multiple criteria, click on the Complex Find button, which takes you to the Query Editor, which has powerful features to
perform queries with multiple conditions. Detailed guidelines for using the Query Editor are to be found in Working with lists

Sum
Click on this button to display the total value of the highlighted invoices. Highlight more than one invoice by control - clicking (Mac: commandclicking) invoices. Highlight a block of invoices by clicking on the first invoice of the series, then shift-clicking on the last invoice in the series.
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Order by
The invoices displayed may be sorted according to any of the columns by clicking the column heading. A more comprehensive sort facility is
available when you click the Order by button. This displays the order by window, where you can drag fields from the list on the left to the right-hand
pane to sort the list by the fields you have chosen.

Print
Click on this button to print the list of invoices displayed. This does not print the actual invoices, just a list of them.

Finalise
Click on this button to change the status of the invoice to finalised.

Duplicate
Click on this button to duplicate the transaction. You would use this feature, for example, to supply exactly the same items to another customer. You
will be asked if you want to duplicate all lines on the invoice, or just the placeholder lines.

If the invoice was part of the internal requisition process (from one virtual store to
another) then the links to the originating purchase order will be maintained, and a
goods receipt will be created if you finalise the customer invoice at a later date.

Cancel
Click on this button to cancel the highlighted transaction 8). This command only works on finalised invoices. The invoice is not deleted from the
system; mSupply makes a duplicate finalised invoice with the same invoice number but with negative quantities matching those on the invoice you're
cancelling. This ensures that all transactions are preserved and will appear in an audit trail. But note that you will not be able to cancel a finalised
customer invoice which put stock into mSupply and some of that stock has been used. An exception to this is a stock transfer: if none of the
transferred stock has been issued then the original finalised customer invoice which initiated the transfer can be cancelled if the supplier invoice
produced from it is first deleted.

If you have accidentally finalised a transaction you can use the cancel and duplicate buttons to
• Highlight the finalised invoice and click Cancel
• Hightight the finalised invoice again and click Dupplicate to duplicate the original transaction
• You can then edit the duplicated transaction to the correct values before finalising it again.

Filters
Click on this button to apply filters to reduce the volume of information displayed to reflect more precisely what you require.
Take as an example, a hospital where you have searched on a large number of customer invoices, but you are really only interested in issues to the
Orthopaedic Clinic during the first six months of a year.
Clicking on the New Filter icon presents you with a window where you can define the criteria for your filter, in our case the customer's ID is entered,
and the period under review - i,e, January to June 2009 using the syntax of a WHERE clause in SQL
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The Respect selected invoice type checkbox has the effect of applying the filter to the type of invoice which has been selected in the sidebar, and if we
do this in our example, instead of displaying several hundred invoices, only the handful of invoices for the Orthopaedic clinic will be shown.
Any filters so created are listed under My custom filters , and are available for use as required until they are deleted.

Customise
Click on this button to:
• display the information you require
• arrange the column order display to suit your requirements

Display the information you require
Displayed under Available on the left are the available fields, while displayed under Chosen on the right are the presently selected fields.
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To add a column to the display, click on the required one to select it in the Available column, then click the upper button between the two displays, and
it will appear at the bottom of the Chosen list.
mSupply provides the feature of analyzing customer invoices by their despatch/delivery/arrival dates. Once a customer invoice has delivery dates
entered for it, transport_details, choose the customer delivery columns 'Order written', 'order received', 'dispatched', 'expected arrival', 'actual arrival' to
be included in your transaction list.

This list show customer invoices in mSupply ordered by Expected Arrival Date. Click on the column header to order on that column.
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Arranging column order
This is done by clicking then dragging the column heading to the required position.

Sorting the list
Click a column heading to select it, then click on the small triangle on the right to display the list in order or reverse order as required.

Modify
Click on this button to edit the selected invoice. This is the same as double-clicking the invoice.

Export to MYOB
Click on this button to export the selected invoices to the MYOB software (https://www.myob.com/au) - refer to Exporting to MYOB.
Previous: Issuing Goods to a Customer (Customer Invoices) Next: Customer credits
2011/05/16 04:59

Customer credits
Choose Customer > New customer credit from the menu bar.

Entering a customer credit is exactly the same as entering a Supplier invoice, except that:
• You will enter the customer name rather than the supplier name.
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• Items will be entered with zero margin. This is because mSupply uses the cost price entered to calculate the amount to credit the customer,
so you must enter the amount you charged them as the cost price for each line. Presumably you want to sell the item again for the same
price you sold it originally, hence the cost and selling price must be the same

If the customer is not visible as a Supplier, you will not be able to prepare this
transaction as a Supplier Invoice.

There is no need to enter negative values in mSupply . Even when you are entering
returned goods from customers, or returned goods to suppliers, enter positive
values. mSupply automatically converts the invoice total to a negative amount.

Previous: Viewing Invoices Next: Backorders
2011/05/16 11:20

·

Backorders
Overview
mSupply's backorder system allows you to record items you were unable to supply to clients, and (hopefully) supply them at a later date when you
have enough stock.
When you do not have enough stock of an item that a customer orders, it is normal to add a placeholder line to the invoice you are creating. If you
have local suppliers, it is possible you will be able to receive stock in time to fill the order, and the placeholder line can be edited and replaced with a
normal stock line.
Once it is time to ship the order, placeholder lines will be converted to backorder lines, and you will be invited to enter a comment for each item (e.g.
“We're very sorry- it's coming next week.)

Backorder preferences
The behaviour of mSupply in handling backorders is controlled by several preference settings:
• To do anything at all with backorders, you need to choose File > Preferences and go to the Invoices 2 tab . There, check We run a
backorder system

• If you wish to have customer invoices automatically created when goods on backorders are received, the appropriate box should be
checked.

• On the same tab, check Allow placeholder lines on customer invoices . This allows you to use placeholder lines to record stock ordered by a
customer but not able to be issued.
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• On the right side of the same tab is the option to Delete placeholder lines when confirming invoices. If this option is not checked,
placeholder lines will be left on an invoice when it is confirmed. Otherwise they will be deleted. In either case, as long as the We run a
backorder system option is checked, confirming an invoice will result in placeholder lines being transferred to backorders.

How much is on backorder?
There are four ways in which you can view backorders
•
•
•
•

When creating a customer invoice, there is a backorders button. This is described in detail below.
Use the backorders report to view some or all backorders.
When viewing details for a particular item, see all the backorders for that item on the backorders tab.
When viewing details for a particular customer, see all the backorders for that customer on the backorders tab.

Backorder management from the Customer invoice window
Clicking the Backorders button when viewing a customer invoice will show all lines for the entered customer that are on backorder.

The Backorders button will be hidden if ” We run a backorder system “ is not
checked in Preferences > Invoices2.
If you are entering a new invoice, you need to have entered a customer name on
the invoice before clicking the button.

The window also shows current stock, so you can easily see which backordered lines can be added to the current invoice

Buttons in the backorder window
New backorder: Placeholder lines are automatically changed to backorders when an invoice is confirmed, but there may be occasions when the
manual entry of a new backorder is necessary: click this button to create one.
Delete backorder: You can delete an item line or multiple item lines by selecting the line(s) and clicking on Delete backorder button.
Modify line: This button is used to edit the item line. Select the desired line and click on Modify line button to display the following window.
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Add lines to invoice
Highlighting lines and then clicking the Add lines to invoice button will (surprise) add the highlighted lines to the invoice. The backorder quantity will
be set to zero, and may then be deleted.
Note that as you issue lines on an invoice, the quantity on backorder is automatically reduced. However, once a line reaches zero, it is not
automatically deleted. This is because it is possble the user will delete or edit the line on invoice, and hence the reduction in backorder quantity may
have to be reversed.

The Backorders report
Choose Reports > Backorder report.
You can enter settings to reduce the scope of items or customers for which the report is produced.

The first drop down list allows the report to be filtered by many options, but note that if Item name is chosen, then the full name must be entered and
not just partial details.
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Two options are available: for display:
• each customer and the items on backorder for that customer
• each item and the customers having backorders for that item.

Note that this report does have limitations, as if a customer orders the same item more than once, it is likely that demand will be overstated.

Viewing backorders for a customer or an item.
Clicking the backorders tab when viewing a customer or item details shows a window where you can view or edit items on backorder. The example
shows backorders for an item, ibuprofen 200mg tablets.
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Notes
• If you have set the preference to leave placeholder lines on confirmed invoices, then you can use the Item ordered shortfall report to display
the difference between customer demand and what was actually supplied.

Automatic creation of customer invoices for backorders
With the required boxes checked under Files > Preferences > Invoices , mSupply will automatically create invoices for those customers having items
on backorder when the items are received from suppliers.
This description is illustrated by the situation in which two customers, Urban Clinic and Rural Clinic both have Promethazine 25mg tablets on
backorder - Urban Clinic awaiting 5 x 100, and Rural clinic awaiting 2x 100. The supplier is Arbuckle.. This may be confirmed by previewing a
backorder report:

On receiving the goods from the supplier, a new goods received record is created in the usual way, and finalised. When you click on OK to create the
supplier invoice, you are required to confirm your intention to finalise the order, which you would normally do. The supplier invoice is displayed, and
in the bottom left corner of the supplier invoice, you will see that the Hold box is checked. You should click on it to remove the check mark.
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and this alert message is displayed:

Review the invoices as alerted, and for this example the invoice generated for the Urban Clinic is shown:

The invoice generated has all the relevant details, e.g. batch no., expiry, etc., copied across from the supplier invoice, and the comment has been added
to the effect that the invoice has been generated automatically, and also identifies the Goods Received ID:
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Previous: Customer credits Next: Electronic Invoices
2011/05/03 08:32

Transferring goods to another store
This feature is available only to those users who are managing more than one store on their systems - e.g. if you have a General store for holding
stock, and you supply a Dispensary with their day to day needs - refer Virtual stores.

If you are transferring goods to the receiving store in response to an Internal Requisition (Purchase Order) from that store, DO
NOT follow the instructions in this section. The relevant section is Processing the customer invoice (supplying store)

If you're not able to perform a transfer there are several possible reasons
• There must be more than one store set up in your copy of mSupply
• You must have the user permission to perform transfers
• The store you're transferring to must be visible. To make it visible choose Special > Show stores and double-click
the store you want to transfer to, then on the preferences tab click the View name button and set the visibility on the
Stores tab. Phew!

This procedure follows closely the steps as described under Issuing Goods to a Customer (Customer Invoices); to avoid unnecessary repetition, please
make sure you are familiar with that procedure.
You must be logged in to the issuing store (the store you're transferring stock from); the 'customer' in this process is the receiving store. So, you create
a new invoice from the Customer menu, and in the Name field the you put the name of the receiving store in the normal way (i.e. type the first few
letters of the store's name, press the TAB key, and select the store in red colored text from the list displayed). You are presented with a window in
which you must confirm your intention:
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Stock transfer label (under comment field) defines that the goods being issued are for a store. not for a customer.

The procedure from this point is identical to that described under Issuing Goods to a Customer (Customer Invoices).

It is necessary to finalise the transfer when you have finished entering the items to be transferred. Only after finalising the
transfer will the new invoice appear on the system, as a Supplier Invoice in the receiving store, and as a Customer invoice in the
issuing store. The status of the supplier invoice in the receiving store will either be confirmed and on hold or finalised,
according to the setting you have for the “For stock transfers, the supplier invoice in the receiving store should be…” store
preference. See here for details.

If the item(s) you are transferring are not visible in the receiving store the following message will appear:

Check whether there is any reason for the item(s) in question not to be visible in the destination store. If there is no reason to prevent visibility click
OK.
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If you are running a syncing system (see Remote Synchronisation) and the
receiving store is active on another site, the receiving site will send back a
confirmation log message to confirm that it has received the transfer. This will
show up in the Log tab of the sending customer invoice.
On a syncing system, the sending site does not have access to the item visibility
records in the receiving store if it is a transfer store, so it cannot do the item
visibility check above.

Reversal of stock transfer
Should a reversal of a stock transfer be necessary, this may be achieved by the operator at the sending store, and only if the receiving store has not
issued any of the transferred stock.

Receiving the goods (customer store)
In the customer store a Supplier Invoice will be automatically generated, provided that the Customer Invoice in the sending store was finalised - see
above! You can view the customer invoice record via the Suppliers tab on the Navigator or via the Supplier > Show invoices… menu item.
On the supplier invoice the lines from the customer invoice will have been filled in automatically.
Depending on your store preferences, this customer invoice may or may not be locked, or finalised.
Previous: Electronic invoices Next: Box management
2011/05/05 09:32

·

Box management
On the transport tab of a customer invoice window, there are two methods for managing boxes.
• The simple method allows you to directly enter any Box identifiers in the Boxes column
◦ To use this method you should not turn on the preference mentioned below. You simply click twice (slowly) in the box numbers
column of the “Transport details” tab on a customer invoice and enter box numbers.
• If you want to assign exact quantities of each invoice line to a box or boxes, and also possibly record box weights and volumes, you need
to:
◦ Choose Special > Show Stores
◦ Double-click on the store in question (you might only have one)
◦ Click on the preferences tab
◦ Check “Able to pack items into multiple boxes”
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The rest of this chapter assumes you're using mSupply with this preference checked.

Setting up boxes
• Once you've created a customer invoice, and picked goods, the pickers should have marked the pick slip with what quantities of each item
were put into what box.
• Now go to the Transport tab of your customer invoice.
• Click Manage Boxes (Note: if you haven't turned on the preference as above, these buttons are hidden)
• You'll see this window:
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•
•
•
•
•
•
•

Click New to add boxes
We suggest you keep box names short. e.g. 1, 2, 3, 4 or A, B, C, D
Type a box name, click OK & Next (shortcut: the Enter key) to add another box.
On the last box click OK to save and close the window.
If you're Gary, you might have clicked OK & Next one too many times. In that case you can use the Cancel button to close the window. ;-)
Note that you can't have a blank box name, and you can't have two boxes on the same invoice with the same name (You can just use the
same series of box names over and over on different invoices).
• If you make a mistake with a box name you can double-click a row to edit it.
• Click OK to close the Box Management window when you're done.

Using the Box Selected Button
• In most cases you will be able to put the total contents of an invoice line in the one box.
• In that case, click on a row, or hold down <control> (Windows) or <command> (Mac) and click on multiple rows.
• In the example below we have highlighted rows 2, 3 and 4.

•
• Now click Box selected
• You'll be shown the “Pack selected boxes” window:
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•
• Choose the box for the items from the drop-down list.
• Click OK to close the window.
• You'll see the boxes column in the list has been filled out.

Splitting a single invoice line over multiple boxes
• If you have bulky invoice lines or large quantities, you will need several boxes to hold the one line.
• Double-click the line to assign to boxes.
• Let's say in the example above, you got a supplementary request to increase the water for injection quantity from 100 to 2000. You go back
to the “general” tab and do this. Now back on the transport tab you double-click the water for injection. This is what you would see:

•
• Notice that at the top of the window “1900” is in red. That's the quantity still to distribute.
• Click the Add to box button.
• You'll see this window:
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•
• Let's say we're going to put 1000 in box A and the remaining 900 in box B
◦ Enter 1000 in the quantity field
◦ Choose A from the drop-down list
◦ Click OK & Next
◦ Fill out the window to enter 900 in box B and click OK to close the window.
◦ Now your window should look like this:

◦
• You can double-click a row to edit it.
• To delete a row, click on it to highlight it, then click Delete
• Note that the weight and volume for the item will be calculated automatically if you have set them in the item details window, but you can
also override the calculated weight/volume when you are assigning an item to a box.

Removing an invoice line from all boxes
•
•
•
•

You can use the Unbox button to remove an invoice line from all boxes at once.
Highlight one or more invoice lines.
Click Unbox
You're done.
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Seeing what is in a box
• If you click Manage Boxes and then double-click a box you will be shown a list of items in that box.
• You can also set the measured weight and volume in this window, which will usually be somewhat higher than the calculated weight/
volume:

•

Printing packing list for each box
• We have custom printing forms available that will print packing lists for each box. Ask us for more details.
Previous: Transferring goods to another store Next: Stock Control methods for your customers
2012/03/16 03:08

·

Stock control methods for your customers
Stock supply philosophy
mSupply is designed for situations such as a central supply facility within a country or region, or within a hospital where the supply of stock to
customers is controlled by the supplying facility. That is, supply of stock to customers is managed by the supplying store.
Regardless of who controls the supply of stock, it needs to be made principally on the basis of information about the customer's anticipated usage.
mSupply has several ways of arriving at quantities to be supplied to customers:
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• The stock history method
• The imprest method
• Response requisitions
Collectively, these are grouped together as different types of requisition. When editing an item, you can view all types of requisition records for that
item. More information is available here
(If you can think of better names, please tell us!)

Defining the list of items to be included in the re-supply
Both the imprest and stock history methods require a stocktake of the customer's stock. The items to be included in the customer's stocktake is defined
in lists which are specific to each customer, and must therefore be individually compiled, however, they can be based on Master Lists.

Master Lists and Local Lists and how to create and assign customers to them are covered elsewhere in Master Lists

Lists are defined for each customer in the Edit Customer window. Click on Item lists in the side bar menu.

This displays the window in which you create the required lists.
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Adding a local list
First, click on Add local list and in the panel that appears, enter a name for your list then click OK - in the example we've named it Items_Imprest.

Adding items to a list
Select the list to highlight it, and you're ready to compile it. Click on Add item to do this, and repeat until you've added all the items you require. Our
example (below) shows that one item (Ibuprofen) has been added, and a second item (Prednisolone) is being added.
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Only if you are using the The imprest method is it necessary to enter imprest quantities. If you are not using the
imprest method, the Imprest Quantity field should be left blank.

Entering an imprest quantity
We'll now add another item, Haloperidol 5mg tablets, with an imprest quantity of 200, to demonstrate how it's done.
1.
2.
3.
4.

Click on the Add item icon to bring up the standard search window.
Type the first few letters: hal, followed by the Tab key.
From the list, select: HALOPERIDOL TABS 5MG by double clicking on it. The Add item window appears.
Enter 200 in the Imprest Quantity field.

For the purpose of the guide, only 3 entries are present for the fictitious Highland Health Centre. In the real world
your imprest list is likely to contain many items
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The stock history method
The theory behind the stock history method (sometimes referred to as the Historical Logistics Method) is based on the the assumption that future
customer usage will be similar to historic usage.
We can calculate the customer's average usage over time if we know their stock levels at two points in time, and what stock they received from us in
that intervening period. We assume that this average usage rate will continue over the coming supply period.
There are three more variables that need to be estimated:
• The number of months in the coming supply period
• The lead time required to supply them (that is, the time lag between the customer doing a stocktake in order to trigger re-supply, and receipt
of the stock)
• The number of month's worth of buffer stock they need
With this data, the calculation is like this:
•
•
•
•
•
•
•
•
•
•

A = Stock on hand on date1
B = Amount supplied to customer between date1 and date2
C = Stock on hand on date2
D = Quantity used in period between date1 and date2 = A+B-C
E = number of months between date1 and date2
F = Usage rate = D/E
G = Number of months in coming supply period
H = Number of buffer stock months desired
I = Lead time (months) between date2 and delivery of stock
J = Amount to supply = F*(G+H+I)-C

Using the stock history method:
•
•
•
•

A and C are reported by the customer on date1 and date2 respectively
B is calculated by mSupply based on mSupply records
G, H and I are entered by the user
D, E, F and J are calculated by mSupply

Note that mSupply uses stock issued by the supplying store to arrive at the
parameter B. Obviously, if the customer has received goods from other sources
during the calculation period, B would be inaccurate.

First stocktake record
In order to calculate the usage rate, mSupply requires stock on hand figures of the items on the list recorded on an earlier date (date1) = A, above. This
becomes the initial stock history record.
To create such a record, follow the procedure described below for entering a stock history, noting particularly, the following:
1.
2.
3.
4.

Enter the date as the correct date at the time the stocktake was performed.
Ignore the figures that automatically appear along each row, except for the Their current stock column.
Enter their current stock figures in the Their current stock column
Close the window using the OK button.

Regular use
Once your customer's first stocktake record has been entered, and a period of time has passed with some customer stock usage, re-supply can be be
generated on the basis of this usage.
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A re-supply using the stock history method needs to be triggered by a customer stocktake. If your customer is set up with mSupply Customer Web
Interface, then this process can be initiated by the customer directly, and then completed in the supplying store as described below.
If your customer has not used the mSupply customer web interface to report their stocktake, then their stock data needs to be entered in manually to
the supplying store.

Manual entry of customer stock history
To begin the process, choose Customer > Show requisitions, and the list of any historic customer stock histories is displayed along with the other
requisition types. The Status column lets you know the status: sg (suggested) or cn (confirmed). The Type column shows the stocktake type: im
(Imprest), sh (Stock History) or response (Requisition):

Double-clicking on a line will allow you to edit the selected record (provided that you have permission to do so).
With the passage of time, entries on the list will rapidly grow in number, and so mSupply allows you to apply a filter selecting exactly what will be
displayed. The default display is for Suggested, as these are most likely the ones you will be processing; other options include All, Confirmed, Web
entries to be processed - this covers histories submitted via the web customer interface - and Entered today

Add new customer stock history
Click the New customer stock history button, to display the Enter new customer stock history… window:
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Enter the first few letters of customer's name in the Name field, then press the Tab key to call up the list of customers' names from which the required
customer may be chosen. In this example, our customer is Medical Ward.
Once you have chosen a customer, the window is populated with the items that are members of any item lists that:
• Have been assigned to that customer (both master lists and local lists)
• and that have the “Stock history” check box checked for that list
You are presented with this window:

Fill in customer stock history
The Our SOH column is the stock on hand in our own store, while figures in all subsequent columns are the customer's data.
The first entry to be made is in the Days to supply field, where the appropriate figure should be entered - e.g. 30 if the ordering frequency is monthly,
90 if it is quarterly, etc.
You will see in our example that
• 29 days have passed since the last stocktake
• The column headed Their old SOH shows their stock on hand at the last stocktake
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• The column headed They received shows the amounts supplied when their last order was processed
• The column headed Their current SOH is the column where the customer's current stock figures (as provided by the customer) are entered.
But note that, just as with the imprest method, if the name you entered in the Name textbox is actually another store then this column will
be automatically filled in with the current stock in the store - saving you a lot of time (you only need to edit those figures where the stock in
mSupply does not actually match what's on the store's shelves).
• As figures are entered, mSupply® calculates a suggested quantity to order, and this appears in the Suggested quan column. These suggested
quantities should be reviewed, and any adjustment entered in the Actual quan column to reflect, for example, pack sizes and to ensure that
actual quantities match exact multiples of the pack size.
After entries have been made in the column Their current SOH the window will look like this:

All that remains is to make adjustments in the Actual quantities column, to reflect appropriate pack sizes.

Once you are satisfied, the Confirm box (bottom left corner) should be checked, the Create customer invoice button should be clicked, and you will
proceed to Creating the customer invoice, which is the same for all requisition types.

Printing forms
Clicking the Print button provides several options for printing forms:
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1. Customer stock takes: This form you can give to the customer (for example, if they are a ward in a hospital that has mSupply running in
it's pharmacy store), and they can fill out the quantities they have on hand, and then values are entered into mSupply.
2. Customer stock supply: This form provides information to give to the customer about the quantity they will be supplied.
3. Customer stock request and issue: This form provides information for the customer comparing what was requested with what was
actually supplied.
The second two reports are for use after you have entered quantities to be supplied into the customer stock history window.

The imprest method
With the Imprest method, the quantity to be ordered is the quantity necessary to restore the stock on hand to a pre-agreed fixed quantity. This imprest
stocktake must be carried out on a regular fixed frequency (daily, weekly, fortnightly, monthly, whatever.) This pre-agreed fixed quantity is arrived at
on the basis of a number of simplifications to the stock history method:
•
•
•
•
•
•
•
•
•
•

A = Stock on hand on date1
B = Amount supplied to customer between date1 and date2
C = Stock on hand on date2 THE ONLY INFORMATION COLLECTED
D = Quantity used in period between date1 and date2.
E = number of days between date1 and date2
F = Usage rate PRE-DETERMINED AND FIXED
G = Number of days in coming supply period PRE-DETERMINED AND FIXED
H = Number of buffer stock days desired PRE-DETERMINED AND FIXED
I = Lead time (days) between date2 and delivery of stock = 0
J = Amount to supply = F*(G+H+I)-C

The Imprest Quantity = F*(G+H+I)
If stocktakes are not taken at the pre-determined frequency, and particularly if they are missed, the system will fail. It is a fairly rigid system, in that
once set, F, G and H must remain constant. It is frequently used for supplying wards in a hospital setting, where operations are generally more
controllable.

Using the imprest system
The imprest system operates in this way:
• The stock of a particular item which a customer (usually a clinic, ward or department) should hold is agreed. This is the Imprest quantity.
• A stocktake is carried out at the facility, giving us a Stock on hand.
• The amount to be ordered by the facility is calculated as:

For example, take the case of a rural clinic which receives a monthly order from a
central store:
• It is agreed that the clinic, when fully stocked, should hold 10,000
paracetamol 500mg tablets. This is the Imprest quantity.
• At the end of a particular month, a stocktake shows that the Stock on
hand is 2,400 paracetamol tablets.
• To restore the stock of paracetamol tablets to the Imprest quantity, the
amount to be ordered is calculated as:
Order quantity = 10,000 (Imprest quantity) minus 2,400 (Stock on hand) =
7,600

This feature caters for mSupply users who operate an imprest system, where a central store supplies goods on a regular basis to a number of
customers, who may/may not be mSupply users themselves. We advise that the customers should be provided with a list - perhaps for a 12 month
period - of the dates on which they should perform a stock check and submit the figures, ideally on a customised form, to the central store acccording
to the prearranged schedule. It is important to note that the customer needs to supply only the current stock on hand figures, a relatively simple task;
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customers are not required to submit details of what they perceive to be order quantities.
It should be remembered that the items to be included in the list and their imprest quantities must be defined for each customer individually. The
imprest quantity defined for a particular customer is unique to that customer, and has no bearing on imprest quantities defined for other customers.

Processing the order from the customer
The central store, on receiving the stock on hand details from the customer, selects from the Navigator or Customer menu the item Show requisitions,
which displays this window:

If you are working with a customer for whom no imprest list has been defined, clicking on the New customer imprest will display the Enter new
imprest window, where appropriate entries are made.

461

mSupply user guide July 2018

Continuing to use Highland Health Centre as our example (for whom we have created an imprest list), double clicking on that entry displays this new
window on which the imprest list appears:

You will note that there are no entries in the Their current stock column, and the figures supplied by the customer should be entered; click on each
line, and after a second or two the zero appearing in that column can be edited with the required figures.
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There is an important exception here: if the name you entered in the Name textbox is actually another store in mSupply then the Their current
stock column will be automatically filled in with the stock in the store. Very useful time saving feature!

Simultaneously, mSupply completes the next two columns, Suggested Quantity , and Actual Quantity. The Actual Quantity entries may be edited to
reflect, for example, pack sizes, to ensure that actual quantities match exact multiples of the pack size. After editing, the window may appear like this:

Should you have any reason to identify one or more lines, this may be performed by highlighting the line(s), and changing the colour of the font.
Black is the default, but other options may be selected from the drop-down list:
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Selecting 5 or more lines brings up an alert requiring confirmation of your intention.
Once you are satisfied, the Create customer invoice button should be clicked, and you will proceed to Creating the customer invoice, which is the
same for all requisition types.

Response requisitions
These work in much the same way as customer stock histories, but with some notable differences:
• It is possible to generate multiple customer invoices from a single response requisition e.g. if not all of the requested stock is available at
the time the requisition is entered, this allows for an initial customer invoice to be sent to partially fulfil the request and another to be sent
at a later date when more stock becomes available.
• It provides a more accurate way to track demand vs supply.
• A response requisition will be automatically created in the supplying store as a result of a request (supplier) requisition from mSupply
mobile (see here for details) or (coming soon) an internal order from a store on another mSupply syncing site. In both of these cases, the
customer is another store and most of the data will have been entered already in the customer store.
• It doesn't attempt to calculate usage or suggest an amount to supply - this data is expected to have come from the customer.

Entering a requisition
To begin the process, choose Customer > Show requisitions, and the list of any historic response requisitions is displayed along with the other
requisition types. A Status of sg (suggested) means that no customer invoices have been created yet - as soon as the first customer invoice is created,
the status will go to cn (confirmed):

Either double-click on an existing requisition to edit it, or click the Add new requisition button to create a new one. The example below is for a
manually entered requisition:
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If this is a manually entered requisition:
• Enter/update the customer Name in the same way as a customer stock history (i.e. enter the first key characters and hit the Tab key to find
matches), but note that changing the customer will invalidate any other data that you've already entered.
• If necessary, update the Requisition date and Order received - these will default to the current date.
• Use either the New line button to manually add a single item, or Add from master list to add any items in the customer's master list which
are not there already.
◦ If the customer is another store, mSupply already knows their current stock, otherwise adding a single item will give you the
opportunity to enter the customer's current stock for that item. Either way, the cursor will go into the Customer current stock on
hand cell, which will already be filled in.
◦ If adding from a master list, the cursor will go into the first new item's Customer current stock on hand cell, but you'll then have
to type in a value (unless the customer is another store, in which case the value will have been filled in for you).
◦ Either way, hitting the Tab key will move the cursor into the Customer requested cell. Type in a value and this will be
automatically copied to the Remaining to supply cell and also the Supply this invoice cell, which will now have the cursor.
◦ Amend the Supply this invoice value if necessary and optionally enter a Comment (e.g. if the amount supplied is less than
requested).
• If necessary, use the Delete line(s) button to remove selected item lines.
If the requisition has come in automatically from another store (e.g. mobile):
• The customer Name is already filled in and cannot be changed.
• The Customer current stock on hand and Customer requested columns are already filled in and cannot be changed i.e. only the Supply this
invoice and Comment columns are editable.
• If necessary, you can still add and/or delete item lines manually.
If the requistion has a lot of item lines, you can filter them by typing into the Filter items field, which will change to display the number of visible
items out of the total number in the requisition:
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Note that, while a filter is active, some of the other buttons are disabled e.g. you can't create an invoice or save the sort order unless all lines are
visible.
Once you are satisfied, the Create customer invoice button should be clicked, and you will proceed to Creating the customer invoice. The Supply this
invoice values will be used to populate the new customer invoice and the requisition status will change to confirmed.

After creating a customer invoice
• The Already issued column will be updated to reflect any non-placeholder lines (i.e. those not coloured red in the customer invoice) in any
customer invoices which have been generated from the requisition regardless of the customer invoice status (i.e. it doesn't have to be
confirmed).
• The Remaining to supply column will be reduced by the amount already issued, and Supply this invoice will be updated accordingly:
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In the example above, a single customer invoice has been created to supply most of the requested stock, apart from two items. You can then create a
second customer invoice to supply the outstanding amounts.
Details of the related customer invoices can be seen in the Invoices created tab:

Double-clicking on any of these lines will open the corresponding customer invoice.
467

mSupply user guide July 2018

Creating the customer invoice
Regardless of the requisition type, when the Create customer invoice button has been clicked, and the following window appears:

Press the grinder icon at the bottom left to issue stock for all placeholder lines.

All the entries appear in red, as mSupply needs the operator to select the specific item to be supplied from your store, i.e. the batch required, and, if
necessary, to distribute the order over two or more batches, if there is insufficient quantity of one batch in your store. The next step is to double click
on each entry and in the example, the 1st item on the invoice, Ibuprofen 200mg tablets, is being processed; there are several batches in our store, some
of which have reached their expiry; although line 4 indicates there are sufficient to meet this order in the store, you will note that only 106 tablets are
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available, so we select line 6.

Clicking on OK & Next displays the next item on the invoice, Prednisolone 5mg tablets.

Click Redistribute all, which is the normal procedure. There is only one batch available, but there is insufficient stock to meet the order, so mSupply®
creates a placeholder line for the outstanding amount.
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When the final item has been processed, clicking on OK will display the completed invoice.

Make sure the Hold checkbox is not checked, and at this stage the invoice may be confirmed.

Danger of failing to re-supply in time

Obviously, regardless of the calculation method employed, if the supplying store
fails to re-supply the customer within the supply period (G) then the customer will
start eating into the buffer stock and is in danger or running out of stock!

Previous: Box Management Next: Customer Budgets
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·

Customer budgets
This feature enables you to manage the budgets of customers in your system. Remember, in mSupply customers are names to which you supply goods.
To enable the feature you need to turn it on and then set preferences for its use and allocate budgets to your customers. When using it, you see extra
fields on a customer invoice which tell you how much budget the customer has been allocated and the amount you have remaining. Once a customer
has reached their budget limit a customer invoice cannot be confirmed unless it is first authorised. All the details you need are below.

Setting up the customer budgets feature
Turning the feature on: File preferences
• Go to File > Preferences…
• Select the Invoices 1 tab.
• Check the 'Per customer budgets' checkbox. Note that 'Activate budget module' must be checked first and you should have previously set
up your budget periods (see Budgets for details).
• After clicking Per customer budgets checkbox confirm dialog box is shown with message “Turning on the customer budgets functionality
requires that the preferences for authorising customer invoices be turned on and automatically confirming and finalising customer invoices
be turned off. Is this OK?”
• You must click OK to activate the functionality. When you do, the “Customer invoices must be authorised” and “Authorisation needed only
if over budget” store preferences are turned on for all stores.
• Optionally, you can divide budget periods up into smaller equal parts and apply the same fractional amount of the period budget to each
part-period. For example, if your budget period is a year you might want to split this up into quarters and allow customers to freely spend
up to a quarter of their annual budget in this time. To activate these additional limits check the Apply part-period limits checkbox and
type into the textbox the number of part-periods you want to split the budget periods into. To split annual periods into quarters you would
enter 4 into the textbox:

Note that any unused amounts of part-period budgets roll over to the next partperiod. Full period budget amounts do not roll over to the next period.

Configuration: Store preferences
• If Per customer budgets is turned on then “Customer invoices must be authorised” checkbox and “Authorisation needed only if over
budget” are turned on. This is done automatically for you when you turn the feature on (as mentioned above). You can, however, uncheck
these checkboxes for individual stores to have the feature work in different ways:
1. “Customer invoices must be authorised” and “Authorisation needed only if over budget” both checked - customer invoices can
be confirmed freely until the budget limit is reached. After that, customer invoices must be authorised before they can be
confirmed.
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2. “Customer invoices must be authorised” and “Authorisation needed only if over budget” both unchecked - mSupply will display
the budget information on the customer invoice but it will not enforce the budget.
3. “Customer invoices must be authorised” checked, “Authorisation needed only if over budget” unchecked - all customer invoices
must be authorised, regardless of whether the customer has exceeded their budget.

Add budget periods
• These are the system-wide budget periods that mSupply uses for its budget functionality. Customer budgets are assigned to these budget
periods so you must set them up before you can start setting up individual customer budgets.
• From the Navigator click the drop down menu Special > Show budgets…. You click on the New button to create a new budget period but
for the full details please see Budgets.

Setup: Set individual customers' budgets
• Note that if you want to set up many or all customers' budgets at one time you can use the import feature, details of which are here
• To set up the budget for each customer, go to Customer > Show customers…, click on the Find button, and double click on the first
customer to show their details
• Click on the Budget tab
• Add budget: Click on this button to add a budget. This opens the edit budget window shown below.
• Delete budget: Select a budget in the list and click on this button to remove the budget for the customer.
• Edit a budget by double clicking on a budget in the list. This will also open the edit budget window (shown below) pre-populated with the
budget's current settings, all of which are editable.
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Customer budget edit window

•
•
•
•

Description: The description for the budget. This is for your reference, only displayed in the budget tab of the customer details window.
Budget period: The period that the budget applies to. This list contains only the budget periods previously set up using Budgets.
Amount: The amount of the budget in your local currency
Additional budget: If checked this tells mSupply that the budget amount is to be considered as an additional amount available only from
the part-period in which its effective date falls. For example, if you have a budget of 100,000 which runs from 1st January to 31st
December in a given year and is split into 4 part periods and you then have an additional budget amount of 10,000 with an effective date of
30th July, the following budget limits will apply: for the 1st quarter the customer has 25,000 available, the 2nd quarter 50,000 available
(25,000 + 25,000 because part period amounts roll over), the 3rd quarter 85,000 available (25,000 + 25,000 + 25,000 + 10,000) and the 4th
quarter 110,000 available (25,000 + 25,000 + 25,000 + 10,000 + 25,000).
• Effective date: This field is only visible if the Additional budget checkbox is checked. The date that the budget amount is to be effective
from: mSupply applies the additional budget amount to the part period in which this date falls. Note that if part periods are not in use then
additional amounts simply add to the total budget available for the whole budget period.

Using the customer budgets feature
The customer invoice window
This is where you see the customer budgets feature doing its job; when you're distributing goods to a customer:
•
•
•
•
•
•
•
•

•

Create a new customer invoice (Customer > New invoice…)
Enter the customer name
Select the budget period that this invoice belongs to from the Period drop down list (this list contains the periods you set up using Budgets).
If you haven't set up a budget for the customer you are warned with this message: “There is no budget set for this customer in that period.
You will not be able to confirm the invoice until the budget has been set.”.
If you've followed the instructions above and setup the customer's budget correctly then the Total budget used and total budget fields are
populated to show you exactly how much of their budget the customer has used so far.
Add items to the invoice as required.
Everything will behave exactly as it has done before until the customer's budget amount has been exceeded.
When the customer's budget has been exceeded (this can be the full period amount or the part-period amount if the part-period limits are
turned on) and the confirm button is clicked you will be alerted with the message “This invoice exceeds the budget set for this customer.
You cannot confirm it without authorisation (Note: you cannot confirm the invoice at the same time as authorising it, you must save the
authorisation first by clicking the OK button, then re-open the invoice and confirm it)”.
The invoice must now be authorised by a user with suitable permissions before it can be confirmed: See Invoice Authorisation for details
on authorising customer invoices.
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Reporting on Customer Budgets
There are several reports that provide various information on customer budgets, they are:
• Disbursement Report - shows items with their values which have been distributed to customers during a budget period.
• Expenditure report - shows spending against budgets with remaining available budget.
• Trend Report - shows, in graph format, spend against budgeted amount.

Disbursement Report
• From the Navigator click drop down menu Reports and click option Customer Budgets.
• Choose budget_balances from the print options window which appears:
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1. Budget period: select the period you want to report on.

Expenditure report
• From the Navigator click drop down menu Reports and click option Customer Budgets.
• Choose budget_district_expenditure (or budget_facility_expenditure) from the print options window which appears:

1. If District: Select “All” to see expenditure for all districts, or select a district to see expenditure for the facilities in that district
2. If Facility: Select the facility to see expenditure for that facility, and select the reporting interval
3. Select the date range you want to report on.

Trend Report
• From the Navigator click drop down menu Reports and click option Customer Budgets.
• Choose budget_trend_district (or budget_trend_facility) from the print options window which appears:
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1. District/Facility: Select “All” to see a graph for all, or select a district/facility to see a graph for just the selected district/facility
2. Interval: Choose the intervals you want for the horizontal axis, eg. quarterly, yearly, etc.
3. Select the date range you want to report on.
Note that this is a cumulative report, so the graphs generated need to include the entire budget period. This means that the date range is only used to
determine which budget periods intersect with the selected dates e.g. if the date range covers more than one budget period, a graph will be generated
for each one.
Previous: Stock Control methods for your customers Next: Payments to Suppliers
2013/12/31 06:14

·

Payments to suppliers
The best practice payment flow is diagrammed below. These steps ensure accuracy is maintained and payments are made for the correct amounts
based on the actual goods received.
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Entering payments
This functionality is used to record payments that you have made to suppliers for goods received from them. To be able to record payments you need
to activate the payment module in the preferences (Invoices 1 tab, 'Activate supplier payment module' check box) first.

• When the payments module is activated, each supplier invoice will
have its amount outstanding recorded (the amount left to pay to the
supplier). Any invoices finalised before the module is activated have
their outstanding amount set to zero, so will not show for payment.
• Only finalised supplier invoices can have payments entered for them.
Use the File > Finalize supplier invoices command to finalise all
invoices or view invoices (Suppliers > Show supplier invoices) and
finalise them individually once all the details are correct.
• You cannot pay a supplier more than the total outstanding (as if you'd
want to!). This is different to a cash receipt, where you can accept an
overpayment from a customer.

To enter a new cash payment, choose Supplier > New Cash Payment from the menus (or click on the
Suppliers tab of the navigator to be shown the new cash payment window:

icon in the Payments section on the
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The Their ref field label can be customised in the preferences to be anything you want. Please see General preferences for more
details.

Entry steps
1. Enter the supplier name or code in the Name field. Once you have chosen the supplier, a list of finalised supplier invoices that still have an
amount outstanding will be displayed.
2. Enter a comment about the payment in the Note box. If you leave this blank mSupply® will automatically create a note containing a list of
the invoices the payment is paying off.
3. Select the currency you want to pay in. You can only enter payments in one currency at a time so all those invoices that are in a different
currency to what you have selected will be greyed out in the list and you will not be able to enter a payment amount against them.
4. The rate stored in mSupply for the particular currency you have selected is displayed in the Rate box. If you wish to use a different rate
(e.g. the rate you know the bank will use ) you can change the rate to match it (and the calculated payment amounts will be updated
automatically). Note that the rate is set to 1 and is unchangeable if you have selected your local currency.
5. Enter the total amount you wish to pay in the Payment box and click the Distribute button. This will distribute as much of your payment as
it can among all the outstanding invoices in the currency you selected, in the order they appear in the list. If there is any left over it will be
shown in the To allocate box.
6. Alternatively, you can shift-double-click each non-greyed out invoice to pay the full amount of that invoice. (Note that shift-doubleclicking toggles between allocating nothing and full payment against an invoice). A quick way to find out the total outstanding amount for
a supplier in the selected currency is to shift double click all the non-greyed out invoices. The total will then be displayed in the Allocated
amount.
7. To partially pay an invoice you can double-click it's line and enter the amount you wish to pay.
8. If there are any local charges that need to be added onto the payment, they can be entered after you have allocated the full amount entered
in the Payment box to invoices.
9. As well as adding in local charges you can edit the total amount of the payment in local currency if needs be so that the actual payment
amount matches your bank records (such a situation might arise if your bank uses a different currency conversion rate to that stored in
mSupply® but you don't know what it is).
10. Once you are happy with the details, click the OK or OK & Next button. If you want to print the information, make sure the print
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checkbox is checked.
11. Note that the OK and OK & Next buttons will remain disabled until the Payment amount is non-zero and the To allocate amount is zero
(i.e. a payment amount has been entered and has all been allocated to invoices).

Viewing cash payments already made
Choose Suppliers > Show cash payments… from the menus or click on the
icon in the Payments section on the Suppliers tab of the navigator.
You will be presented with the standard transaction find window which allows you to filter the cash payments you see:

When you click on the Find button will be taken to the usual transaction viewing window with the cash payments you selected displayed:

To view an individual payment simply double click on its line in the list and you will be shown a read-only view of the cash payments form containing
all the details of the payment you made and the invoices it was paying.
Previous: Customer Budgets Next: Receiving payment from Customers
2011/05/12 07:07

·

Receiving payment from customers

Note that the “Activate customer receipts module” checkbox on the Invoices 2 tab
of the Preferences must be checked before you can use the Customer Receipts
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module. Once this option is checked, new invoices will have the outstanding
amount recorded. If this option is not checked, the outstanding amount of invoices
is set to zero.

A payment from a customer is referred to as a Cash Receipt (whether the payment is by cash, cheque or transfer)
The system mSupply uses to record payments is the accounting standard “open invoice” system, which means that the outstanding (that is, unpaid)
amount of each invoice is tracked by mSupply.
Payments from customers can be received in any currency that customer invoices have been issued in. But a single payment transaction can only
record payment in one currency - if you need to record multiple currency payments from a particular customer then record a separate payment for
each.
To begin the process of recording a received payment choose Customer > New cash receipt… and you will be presented with this window:

The Their ref field label can be customised in the preferences to be anything you
want. Please see General preferences for more details.

1. Enter the customer name or code into the first field and press Tab. You will be shown a list if there is more than one matching entry for
what you have typed.
2. Once a customer is chosen all (customer) invoices that have unpaid amounts for that customer will be listed.
◦ Note: only finalised invoices are shown. If there are no finalised invoices with outstanding amounts, this alert appears:
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3.
4.

5.
6.

7.

◦ If you wish to receive a payment and there are no invoices available to record the payment against, you can either record the
amount as an overpayment (see below) or click Cancel and finalise the invoices that are being paid, then restart the payment
process (If the customer is paying you it most likely means they agree with the invoice and it is OK to finalise it!)
Enter the cheque number or similar in the Their ref field and a note in the Note field if you want to.
Select the currency of the payment you are receiving (your home currency will be chosen by default). Any invoices that are in currencies
different to the one selected are disabled and cannot have a payment entered against them. If you are receiving a payment in a currency
other than your home currency you can manually adjust the conversion rate that mSupply uses by entering the rate you want to use in the
Rate field.
Enter the total amount of the payment you are receiving into the Receipt field.
You have a number of choices to allocate payment amounts to the various invoices:
◦ Click on the Distribute button. This will allocate payment to the top invoice first and work its way down the other invoices until
the payment is all allocated (note that disabled invoices in a different currency are ignored). If the payment is not enough to
cover all invoices then one will receive a partial payment and some may receive no payment.
◦ Double-click an invoice in the list to be shown a box to enter the payment amount, or
◦ Hold down the shift key while double-clicking an invoice to allocate the full outstanding amount of that invoice.
Click the OK button to record and finalise the payment (you will be warned that the payment cannot be edited).

Note: If you receive more than the total amount of the invoices you will be asked to confirm that this is OK and the extra received amount will be
recorded as an overpayment - see below.
Note: customer credits should be entered as a negative Receipt amount. It is generally good practice to allocate credits as soon as they show in the list.

Overpayments
• Sometimes a customer might pay you more than the amount owing (not so likely, but it does happen to some nice organisations!), or the
customer might pay you for an invoice that is not yet finalised. If this happens, allocate any amount that relates to invoices in the list. When
you click OK you will be warned there is an overpayment and you will be asked if you want to continue.

• Click OK if you want to continue, or Cancel if you want to allocate the extra amount to invoices.
• The next time you enter a payment for that customer you will be presented with a window asking you if you want to use the overpayment
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for this transaction:

• Click Use if you want to use the overpayment, or Don't use if you want to enter another payment (Some customers just keep sending in the
money…)
Previous: Payments to Suppliers Next: Importing Items
2011/05/05 03:44

·

Importing a supplier invoice
From the Supplier menu, the Import invoice command allows you to import an invoice generated by one of your suppliers who also uses mSupply.
You will be presented with an open/save window where you should locate the invoice file to be imported.

• The invoice must have been generated by the “export invoice”
command in another copy of mSupply.
• The item codes in your copy of mSupply must have your supplier codes
entered (see below). If mSupply attempts to import a code that it does
not know, the import process will stop.
• Once an invoice has been imported, you are still free to edit it. You
should check the invoice against a paper copy when it arrives.
• After import the file is edited so that if you attempt to import an invoice
again you will not be able to. This prevents accidental doubleimporting of the same invoice.

Entering Supplier Codes
If you are importing invoices from a supplier, you must perform the following steps:
1. enter a quotation for each item you receive from the supplier. This is done from the quotes tab of the item details window, or from the
quotes tab of the supplier details window.
2. enter the supplier code for the item in the supplier code field of the quotation. There is no need to enter other details for the quotation if you
do not want to.
Previous: Importing abbreviations Next: Exporting invoices
2011/05/12 06:55

·
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Importing items
You can import a tab-delimited text file of items by choosing File > Import > Import items….
During import you can specify what happens with duplicates, which stores the imported items will be visible in and which master lists they will be
added to.
Please note that this command only imports items and not the stock. If you would like to import both, see the next heading: Importing items & stock.
After selecting the menu item you are shown a message asking you to select the file to be imported on the next window:

After clicking OK, a window opens allowing you to select the file to import. After selecting it (by double clicking on the file in the window or clicking
on it and clicking on the Open button) this window is displayed:

First line contains column headers: If you have used the first line of your import file for column headers, check this box. Then mSupply will ignore
the first row in the file, and start importing from the second row.
Remove quote characters on import: If this is checked then double quote characters (“) are removed from item names as they are imported. This is
useful if you have exported the import file from spreadsheet software and it has incorrectly placed double quote characters around the text. If you have
used double characters in item names (e.g. as a symbol for inches) then they will also be removed if this option is checked.
Handling duplicate items: mSupply compares the item code in the import file (1st column - see below) against the codes of items already in its
database to determine whether an entry is a duplicate item or not. If a duplicate item is found in the import file the mSupply will handle it according to
your radio button selection in the If duplicate codes are selected section:
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• Create new duplicate items and continue: a new item will be created. Note that you can only use this option if the preference “Item codes
must be unique” is not selected in File > Preferences.
• Ask each time: every time a duplicate is detected mSupply will ask you what you want to do. Your options are the same:

• Skip the duplicate without asking: the duplicate is ignored and not imported.
• Stop the import: if a duplicate is detected mSupply will stop and cancel the whole import i.e. the database will be exactly that same as it
was before you started the import.
• Update the existing item: the item with the same code already in mSupply will be updated with all the details of the item in the import
file.

The Preview tab

This tab enables you to see a preview of what will be imported into mSupply and helps you check that mSupply is reading what you expect from the
import file.
The left hand column of the table (“Field”) shows you all the fields mSupply is expecting to see (in that order, first at the top, last at the bottom of the
table). The right hand column (“Value”) shows you the value that mSupply has read from the file for that field. Use the Next and Previous buttons to
move between the records in the import file.
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The Stores tab

This is the tab you use to specify which stores the items you import will be visible in. The store you are logged into is ticked by default. Simply check
the “Visibility” column checkbox for the stores you wish all imported items to be visible in.
Note that only imported item visibility is affected during the import - for example, if you choose to ignore duplicates and a duplicate item is found in
the import file, the visibility of the item already in mSupply is not affected by the import process. But if you have chosen to update duplicates, if a
duplicate item is found in the import file the existing item in mSupply will be updated to match what it in the import file have and its visibility will be
altered to match what is set on this tab.
One further thing to note is that if the preference “Automatically update item visibility in all stores to match master lists used by that store” (see here)
is checked then item visibility is controlled by master list membership so the table on this tab will be replaced with this message telling you to use the
Master lists tab instead:
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The Master lists tab

This is the tab you use to determine which master lists the items in the import file will be added to as they are imported. Simply check the “Add to
list” column checkbox for the master lists you wish all the items in the import file to be added to.
Any master lists that have the “Automatically add new items to this master list” option checked will have their “Add to list” checkbox checked by
default on this tab and you will not be able to uncheck them.
Note that only imported items will be added to the master lists selected. This means that items already in mSupply which match duplicates in the
import file that you choose to ignore will not be added to the selected master lists. Similarly, items already in mSupply which are updated because they
match duplicates in the import file and the “Update the existing item” option was chosen are added to the selected master lists. And don't worry, if an
item is already on a msster list it won't be added again.

Import file format
Field order for the text file:

Column number

Column
letter

Field

Description

1

A

item code

18 alphanumeric characters (must be a unique value)

2

B

item name

80 alphanumeric characters

3

C

units

3 alphanumeric characters recommended (ea, ml or mg). Entries in the units
list will be created
if you import a unit that does not already exist in the data file.
60 characters supported

4

D

reference
pack size

integer
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Column number

Column
letter

Field

Description

The above fields are mandatory, while the following fields are optional and may or may not be included
as per your requirements
5

E

shelf
location

60 alphanumeric characters

6

F

user field
1

30 alphanumeric characters

7

G

user field
2

30 alphanumeric characters

8

H

user field
3

30 alphanumeric characters

9

I

user field
4

“true” or “false”

10

J

edl

“true” or “false”

11

K

ATC
category

30 alphanumeric characters

12

L

ddd value

8 alphanumeric characters- the ddd and its units

13

M

ddd factor

number greater than zero (default=1)

14

N

item
description

The long description for the item. Do not include carriage returns
(new lines made with the return or enter key) in your text file.

15

O

item
department

The name of the department that the item belongs to.
If the department does not exist, mSupply will create it.

16

P

account
code for
stock

The account code used for stock purchases .
Note that these accounts will be created if they don't exist.

17

Q

account
code for
cost of
goods sold

18

R

income
account
code

19

S

Price

20

T

Category

Category 1. This category is hierarchical and has 3 levels. You can enter
different levels separated by :: (for example
“Pharmaceuticals::Controlled::Anti-depressants” or “Controlled::Antidepressants”) or just the lowest level with no separator (for example “Anti-
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Column number

Column
letter

Field

Description
depressants”). mSupply will look for an existing category with the levels
you define, if it doesn't find one then it will create them and assign the
category to the name. If you enter only the lowest level category (for
example “Anti-depressants”), mSupply will look for any lowest level
category “Anti-depressants” with any or no parent. If it finds one, it will
assign the first one it finds to the name being imported, otherwise it will
create it with no parent and assign it to the name.
We strongly recommend you use the WHO EDL categories for this field

21

U

Weight

22

V

Critical
stock

“true” or “false”

23

W

Normal
stock

“true” or “false”

24

X

User field
5

number

25

Y

User field
6

“true” or “false”

26

Z

User field
7

“true” or “false”

All these are in this handy template: msupply_item_import_template.xlsx.
The chances are that you already have a set of codes that you use internally. In this case open up Excel or a similar spreadsheet program, fill in the
item description in the order shown above. For a quick solution, you only need to take account of the first four column, the rest can be ignored.
The third column representing “Units”, can be left blank, however, it is better to fill this in. The fourth column “reference pack size” can be set to “1”
for all rows unless you know what pack size you want to use as the “standard” (Don't worry about this. The reference pack is used for comparing
quotations. You can receive and issue any pack size you like).

Save a spreadsheet file as shown above as a tab-delimited text file.
Open up mSupply with a new data file and chose the import command. Direct the open/save dialog box to the text file and click “OK” to import the
file.
You will be asked if you want to remove quotation mark characters. If you have created the file in Microsoft Excel, it adds quotation marks around
fields that have a comma in them (even though it shouldn't). If this is an issue, choose the option to remove the quotation marks.
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Previous: Receiving payment from Customers Next: Importing items & stock
2011/04/13 02:24

·

Importing items & stock
Importing items
On the File menu, choosing Import items… only imports item codes and descriptions, which still leaves you with the task of entering quantities for all
items (usually by entering an inventory adjustment).

Importing items and stock
The Import items and stock command lets you import item codes, names and the initial stock of those items.

You can import items and stock into an existing data file; however, this is a
somewhat risky procedure, and we do not recommend it. If mSupply detects an
item in the import with the same code as an existing item, the stock will be added
to the existing item.
You have been warned!
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Make a backup before proceeding with this command.

More than one batch of an item
It is possible to enter in various batches of an item separately. For example, if your import file contains two batches of “ace250t” on separate rows.
mSupply will first fill in the item description and code and then enter in the stock for the first batch the item. For the next line of data, mSupply carries
out a search for the code, and adds another batch as the same item already exists, and then updates the total quantity.
It is not necessary to group the same batches together, but making sure that various batches of the same item have the same identical code is important,
otherwise extra items will be created. The actual full name of the product is taken from the first batch the program encounters; subsequent batches that
have the same code as an item that already exists in the data file will use the item name of the exisiting item. (You can even leave the item name blank
for subsequent lines if you want to).

Note on pack sizes
The “pack size” and “quantity” field should be entered taking into account the way you will issue stock (For example, say you are importing
Amoxycillin stock of 3000 capsules that are in boxes of 100. If you are going to issue stock of Amoxycillin individually (28 to this patient, 21 to
another patient), then enter a pack size of “1” and a quantity of “3000”. If you will only issue whole boxes, use a pack size of “100” and a quantity of
“30”. If you enter a pack size and quantity that does not fit, you will still have the option of repacking the items (using the “repack” function from the
“item” menu) to meet your supply needs.

Duplicate options
You will notice several options for what to do when a duplicate is found. The first three are disabled because these are for importing items only, the
others are available for choosing:
• Stop the import: Stops the import and removes any stock already imported before the duplicate was found (i.e. the data is exactly as it was
before the import was started).
• Update item details and add stock: If this option is chosen, you will effectively add all stock in the import file on to the stock already
recorded in mSupply, and also update the item details with any changes recorded in the import file.
• Update stock only: If this option is chosen, you will effectively add all stock in the import file on to the stock already recorded in
mSupply, but not change any item details.

Field order for import file
Column

Field

Note

1 (A)

Item code

Text, up to 18 characters

2 (B)

Item name

Text, up to 80 characters

Both of the above fields are mandatory for the rows to be interpreted in the import process at all.
3 (C)

Units

Text up to 60 characters, but recommend ea, ml, mg etc.

4 (D)

Pack size

Integer.

5 (E)

Quantity

Integer. The number of packs. This is only equivalent to the total quantity if the pack
size is 1.

The above three fields are mandatory if you are actually adding new stock, as distinct from just updating item details.
The following fields are optional and may or may not be included.

490

mSupply user guide July 2018

Column

Field

Note

6 (F)

Cost price

Real number. The price you pay for one pack

7 (G)

Sell price

Real number. The selling price of one pack. Set to the same as the cost price if you do
not actually sell the stock that you issue.

8 (H)

Batch

Text, Up to 20 characters

9 (I)

Expiry

Text, in short format (dd/mm/yy or mm/dd/yy, depending on the format set in your
computer's operating system)

10 (J)

Description

Text, Up to 32,000 characters. Full description of the item. Be careful not to have any
carriage return characters in the text though, or the import file will not be valid!

11 (K)

Item
Department

Text, up to 30 characters. If you import a department name that doesn't exist, the
department will be created.

12 (L)

Shelf
Location

Text, Up to 60 characters. The code for the shelf location of the batch being imported.
Note that this does not set the default location for the item; only the location of this
particular stock line.

In order to create a text file for importing purposes, first you need to enter your stock details into a spreadsheet (e.g. Microsoft Excel). It is useful for
the first row to be populated by column descriptions. If you do this, remember to tick the relevant tick-box during the import process.
As mentioned in the table above, you can omit the values in any column after the first five.

Make sure every line has an item code assigned: any lines without an item code
will be skipped when importing.

Once you have completed the spreadsheet list:
• Save the file as a tab-delimited text file.
• Open mSupply and choose File > Import items & stock.
• The following alert windows pop up, click OK to proceed on each one.
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• You will then be prompted to select the file to be imported.
• After selecting the import file. The following dialogue box will open. Make selections as described below.

1. Tick this box if the first line of the import file contains column headers. This is normally the case :-)
2. Tick this box to remove quote characters on import. Quote characters will be added by Excel or other equivalents if there is a space
character in the field, which is often the case for the Item name field. Quote characters are not normally part of a valid item description. It
is generally safer to tick this tick-box.
3. Tick the radio-button accordingly. If you are loading stock into the store for the first time, and you have not already defined / loaded the
items with Importing Items (refer tip box below), then you should tick the Update item details and add stock radio button. If you are just
loading stock in to a store and you don't want any new items created, the default option of Update stock only is appropriate.
4. Clicking on the Previous and Next buttons allows you to step through the import file so as to review what will be imported, and
particularly that the fields have matched up correctly.
5. Click Import now to proceed, or Cancel if you have cold feet…
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mSupply allows the Import Items and Stock function to both add new stock to
the store, and add new items to the whole system. Particularly in multi-store
environments, it is good practice to separate these two processes.
• Importing stock into a store, which may be done relatively frequently
- every time a new store is added to the system.
• Creating new items, which should be done rarely and with care, and
not accidentally while importing stock!
It is therefore important which radio button is selected in the above dialogue box.

mSupply does a quick scan of the import file, and may come up with the following alert:

This is not necessarily a problem. In fact, you will always get this message if the import file was created by MS Excel and you haven't manually edited
out the <CR><LF> at the end of the last line of data! If you have edited out the last <CR><LF> (recommended), then you likely have a problem with
your import file which needs to be investigated. Unfortunately, you are committed to doing the import at this point. That's why you are testing this on
a dummy version of your data file, right? ;-)
The import process will show a progress bar and then the following message once the import is complete:

This message needs interpreting:
• Number of new items imported: This should only be >0 if you selected the Update item details and add stock radio button
• Number of old items edited: This should only be >0 if you selected the Update item details and add stock radio button
• Number of items skipped: This should be =1 if you did not edit out the last <CR><LF> in the import file. If it is >1, then some lines of
the import file have a blank name or code, which is likely a problem and needs to be investigated.
Previous: Importing Items Next: Importing Customers, Suppliers, Patients
2011/05/16 05:24

·
493

mSupply user guide July 2018

Importing Names (customers, suppliers, manufacturers, patients)
Introduction

Patients can only be imported in Dispensary mode

The File > Import > Import customers & suppliers… menu item allows you to import customers and suppliers into an mSupply data file. If you are
working in Dispensary mode, this is where you can import patients.

Setting up the import file
A Tab-delimited file (see notes below) must be set up to import the data. The required field order is:
Column

Field

A

Code

B

Name

C

Type - see below for more details

D

Address 1

E

Address 2

F

Country

G

Email

H

Phone

I

Category 1. This category is hierarchical and has 3 levels. You can enter different levels separated by ::
(for example “State1::District2::Area1” or “District1::Area3”) or just the lowest level with no separator
(for example “Area2”). mSupply will look for an existing category with the levels you define, if it
doesn't find one then it will create them and assign the category to the name. If you enter only the lowest
level category (for example “Area1”), mSupply will look for any lowest level category “Area1” with
any or no parent. If it finds one, it will assign the first one it finds to the name being imported, otherwise
it will create it with no parent and assign it to the name

J

Customer group. If the group name does not exist, it will be created by mSupply on the fly.

K

Last name (make sure this field is blank if you are importing a supplier or if you are importing a
customer who is not a person (that is, an organisation)

L

First name (applies only to people)

M

Date of birth (please use 4-digit year)

N

Gender (enter “F” or “True” for females. All other values taken as male)
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Column

Field

O

Custom 1

P

Custom 2

Q

Custom 3

R

Category 2

S

Category 3

T

Address 3

U

Address 4

V

Address 5

W

Postcode (Zip code)

Column C describes the type of the name being imported. That is, whether it is a customer, supplier, manufacturer, donor or patient. A name could be
any one of these or several of them. To indicate which of these the name is, simply include the letter shown in the table below in the type field (letter
order is not important):
Value

Meaning

C

Customer or Patient

S

Supplier

M

Manufacturer

D

Donor

P

Patient

(blank)

Both a customer and a supplier

So, for example, a name which is a donor and supplier would have “DS” or “SD” in the type field.
You might find this template useful: name_import_template.xls or this export settings file: names_export_order.4si.zip

• The customer or supplier category1, 2 and 3 fields will be created if
they don't already exist. If the name is a customer and a supplier, a
customer category will be created.
• You must always include every column in every import file but, apart
from the first 3 columns (which are mandatory), you can leave columns
blank and mSupply will only import the information you have
provided.
• When you import the file you can choose whether or not to:
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◦ Ignore the first line. You will want to if you have used the
first row for column headings
◦ Strip out line feeds and quote characters. You will want to
do if you've used Excel to save the text file.

• Save the template as tab-delimited text (rows end with a carriage return
and columns are separated with a tab character) before importing into
mSupply.
• MS Excel tends to add extra characters (line feeds and quotes), but
mSupply will gracefully remove these without complaining!
• Avoid having the Code field containing a space character as this can
cause problems during import

Importing the file
When you choose File > Import > Import customers & suppliers… you'll be shown an open/save window where you choose the file to import.
Once you've done that, you'll be shown this window:

496

mSupply user guide July 2018

Please note that the visibility of any new names created will be subject to the state of the Names created in this store not visible
in other store preference (see Virtual stores, the Preferences tab for details) - if the preference is turned on, all new names will
be visible in the store you are logged into only. If it is turned off then all new names will be visible in all stores.

If the first line of your import file contains column headers then check the First line contains headers checkbox. This tells mSupply to ignore the first
line and start importing form the second line.
Check the Remove quote characters on import checkbox if some of the fields in the import file have had quote marks added to them. This can often
happen if you have created the import file by exporting it from Excel or some other spreadsheet application.
Now, in the If duplicate codes are selected section, select what you want to happen if a name code is found in the import file which is already used by
a name in mSupply.
You can use the Previous and Next buttons to go through the import file one line at a time to see what mSupply can see in each field and therefore
what it will try to import. Can be useful for checking whether extra quote characters have been added to any fields or if the first line of the text file
contains column header information only.

Importing patients
If you are importing patient names, leave column B (the full name) blank. Make entries in the Last name (col K) and First name (col L) columns, and
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mSupply will automatically generate the name field for you. Below is an example of a spreadsheet for importing patients, customers and suppliers
which demonstrates how to fill in the fields with respect to each import type.

If you have a lot of patients there will be a short delay once you have chosen the import file while mSupply counts how many records there are to
import, then a progress window will be shown displaying the rate of progress:

Previous: Importing items & stock Next: Importing prescribers
2011/05/16 05:51

·

Importing prescribers

Applicable in Dispensary mode only

From the File menu, choose Import Prescribers, and the Import alert window is displayed.
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You may import a list of prescribers who have the authority to prescribe medicines.
Your list should be in the format of a 6-column spreadsheet, saved as a tab delimited file. The columns should be in the following order:
Column 1

Unique code for each prescriber

Column 2

Last name

Column 3

First name

Column 4

Initials - these will appear on patient labels

Column 5

Registration code

Column 6

Category

Your tab delimited spreadsheet file would appear something like this:

Choose import options from the preview window and click OK to begin import.
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Previous: Importing Customers, Suppliers, Patients Next: Importing abbreviations
2011/05/16 06:06

·

Importing abbreviations
You can import a tab-delimited text file of abbreviations by choosing File > Import > Import abbreviations….
This feature allows patient instruction abbreviations to be loaded into mSupply so that they can be used in Dispensary mode. It is accessed from the
File menu by choosing Import abbreviations.
You may import the list of abbreviations used for patients' directions - e.g. the abbreviation tid would appear on the label as three times daily .
Your list should be in the format of a 2-column spreadsheet, saved as a tab delimited file. The first column should contain the abbreviation, and the
second column should contain the expanded text as it should appear on the label.
Your tab delimited file would appear something like this:

Previous: Importing prescribers Next: Printing Preferences
2011/05/16 06:14

·
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Importing customer budgets
You can set up budgets for customers manually if you wish (see here) but if you have to set budgets for many customers at a time then this feature will
save you a lot of time. As with the other import features of mSupply, this import uses a tab delimited text file (easily produced by exporting a
spreadsheet from Excel or other spreadsheet programme). The columns that must be present in the file and their contents are as follows:

Column number

Column
letter

Field

1

A

budget
description

The description for the budget, as it will appear in the list of budgets for a
customer.

2

B

customer
code

The customer's code as entered in mSupply. If this code does not match a
customer in mSupply an error will be generated.

3

C

customer
name

For your reference only. This column is ignored during the import and can
be left empty, but it must be present.

4

D

budget
period
start date

The start date for the period to which the budget belongs in the format dd/
mm/yyyy or mm/dd/yyyy (whichever your copy of mSupply is using).

5

E

budget
period end
date

The end date for the period to which the budget belongs in the format dd/
mm/yyyy or mm/dd/yyyy (whichever your copy of mSupply is using). The
budget period start and end dates must match an existing budget period
period in mSupply (set up using Budgets), otherwise an error will be
generated.

6

F

budget
amount

The amount of the budget. Must be a positive number with or without a
decimal point.

7

G

additional
budget

Whether the budget amount is to be considered an additional budget. A “T”
or “Y” is interpreted as true, anything else is interpreted as false.

H

effective
budget
date

The effective date for an additional budget in the format dd/mm/yyyy or
mm/dd/yyyy (whichever your copy of mSupply is using). Ignored if the
budget is not additional. If this field is left blank and the budget is
additional then the current date is used.

8

Description

When you have created the import text file go to File > Import > Import customer budgets and select your text file. You will be show the following
window:
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Now choose the import settings to match your file:
• First line contains column headers: check this if the first row in your text file contains the column descriptions. If checked, mSupply will
ignore the first line of the file.
• Remove quote characters on import: check this if fields in your file is surrounded by quote (“ or ') characters. If checked, mSupply will
attempt to remove them from each field.
And select how duplicates are to be handled (a duplicate is a row which matches another line in the file or a budget already in mSupply):
• Skip the duplicate without asking: The duplicate record is ignored completely
• Stop the import: mSupply will stop importing from the file if it detects a duplicate. Any budgets already imported will be kept but no
further lines in the file will be processed.
• Update customer budget: The budget already in mSupply will be updated with the new details found in the file and the import will
continue.
You can also click the Next and Previous buttons to see a preview of what mSupply will import on each row from your file. This can be useful for
showing differences in the contents of your file and what mSupply is expecting.
When you're ready to carry out the import, click on the OK button. mSupply will carry out the import and tell you how many lines were imported, how
many budgets already in mSupply were modified and if there were any errors. You can see more details by viewing the log (see The log).
Previous: Importing a supplier invoice Next: Importing locations
2014/05/15 09:47

·

Importing locations
Locations are the labelled places in your warehouse where you store stock. Locations can be created individually (see here) or can be created
automatically when you import stock (see here). The functionality to import locations described here will save you a lot of time if you need to put a lot
of locations into mSupply separately from importing stock.
As with the other import features of mSupply, this import uses a tab delimited text file (easily produced by exporting a spreadsheet from Excel or other
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spreadsheet programme). The columns that must be present in the file and their contents are as follows:

All columns must be present in the import file but only the first 2 (Location code
and Store code or name) are mandatory. If either of these fields do not have values
entered then the location will be ignored.

Column number

Column
letter

Field

1

A

Location
code

The code of the location. This is used to identify and select the location
throughout mSupply and is the label you apply to the location in your
warehouse e.g. “A01” or “A01.03.C”.

2

B

Store code
or name

The code or name of the store the location is to be created in. You can see
the list of store names and their codes currently in your copy of mSupply by
going to Special > Show stores…

3

C

Location
description

For your reference only, a longer description of the location e.g. “Aisle A,
shelf 1, position C”.

4

D

Volume

The total storage volume of the location in m3 (cubic metres).

Description

5

E

Priority

A whole number from 0 upwards. This is used when printing a picking slip.
Setting a priority for a location will override the default alphabetical
ordering of shelf locations in a picking list. A location with a lower priority
number will be printed before a location with a higher priority number. All
locations with 0 priority are counted as having no priority and will be
printed, in alphabetical order, after all locations with a priority.

6

F

Is
summary
location

Whether the location is a summary location that cannot hold stock. y, yes,
t or true is interpreted as true, anything else (including nothing) is
interpreted as false.

7

G

Location
type

The name of the location type for this location (must be an exact match and
the location type must already exist in mSupply, otherwise the location will
be created with no location type).

H

Parent
location
code or
description

The code or description of the location which is a parent to this one. If the
parent does not already exist in mSupply it will be created so make sure
your typing is accurate!

8

An empty Excel spreadsheet containing these columns for you to use as a template is here: location_import_template.xlsx
When you have created the import text file go to File > Import > Import locations and select your text file. You will be show the following window:

503

mSupply user guide July 2018

Now choose the import settings to match your file:
• First line contains column headers: check this if the first row in your text file contains the column descriptions. If checked, mSupply will
ignore the first line of the file.
• Remove quote characters on import: check this if fields in your file is surrounded by quote (“ or ') characters. If checked, mSupply will
attempt to remove them from each field.
And select how duplicates are to be handled (a duplicate is a row which matches another line in the file or a budget already in mSupply):
•
•
•
•

Import and continue: The duplicate record is created and import continues normally
Ask each time: You will be asked what you want to do with a duplicate each time one is detected; ignore it, create it or stop the import
Skip the duplicate without asking: The duplicate record is ignored completely
Stop the import: mSupply will stop importing from the file if it detects a duplicate. Any locations already imported will be kept but no
further lines in the file will be processed.

When you're ready to carry out the import, click on the OK button. mSupply will carry out the import and tell you how many locations were imported,
how many already in mSupply were modified and if there were any errors. You can see more details by viewing the log (see The log).
Previous: Importing customer budgets Next: Exporting invoices
2016/07/06 14:24

·

Exporting invoices
From the Customer menu the Export invoices command exports any customer invoice to a file. The file created is in a special format that can be
imported into another copy of mSupply using the Supplier>Import invoice… menu command. Do not use this command for sending invoices to
customers for them to view or print - use a PDF file for that purpose.
When using this command you will be asked to enter an invoice number. The default choice is the last invoice created. The invoice will exported to
the export folder you have set in the Preferences, and will be labeled with the invoice number.
Before you can export, you must set your “own code” in the Preferences. This is the supplier code that your customers will use to identify you when
importing the invoice.
Once the invoice is exported, you will be told where to find the file on your hard disk.
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Previous: Importing a supplier invoice Next: Exporting items and stock
2011/05/16 08:01

·

Exporting items and items & stock
Exporting items
Choosing Export items from the File menu allows you to export all of the stock items in your data file to a text file; see Importing Items where the
format of the text file is described under 'Field order for the text file'. This allows you to import them to another data file. When you select this option
you will see this dialog box:

Click continue to carry on. The standard file dialog window for your operating system will appear, allowing you to select a file name and location to
save the text file.

Exporting items and stock
This option, like the previous one, allows you to export all of the stock items in your data file together with the stock on hand; all details are exported,
including batch numbers and expiry dates. The output is a text file, in a format recognisable by mSupply so that you can later import it to another data
file.
Previous: Exporting invoices Next: Exporting names
2011/05/16 06:20

·

Exporting names
Choosing Export names from the File menu exports all the names (suppliers, patients, manufacturers, donors and customers etc.) in your data file in
exactly the same way as for exporting items.
The field order of the exported file and the contents of the various fields are exactly the same as for importing names so please see there for details.
Previous: Exporting items and stock Next: Exporting to MYOB
2011/05/16 07:24

·

Exporting to MYOB
If you use MYOB for your accounting then you may well want to export invoices from mSupply into MYOB. If that's the case then this is the page
that will tell you how to do it.

Setting up MYOB/mSupply
• set up mSupply to use the same account codes as MYOB (See Item units and item accounts). If necessary, the accounts associated with any
item can be edited via the Misc tab after selecting an item (See Item basics)
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• set up MYOB to use the same suppliers and customers as mSupply (See Names: Using, adding and editing) - the suppliers and customers in
mSupply need to be added to the Card List in MYOB, where the Charge to field in mSupply corresponds to the Card ID field in MYOB.

Exporting from mSupply
This can be done from two places:
• from Files>Export invoices for MYOB
◦ You can choose a range of dates, either from the drop-down list (e.g. last year) or by typing the date values directly
◦ You can choose either supplier or customer invoices
◦ If the show all item lines box is checked, then you will get a line for each item line in the transaction, otherwise you will just get
a line for each different account code used in the transaction
◦ If transaction categories have been setup, you can also select only transactions from a single category, or where the category
name matches
◦ Clicking OK will prompt you to create a tab-delimited text file in the folder of your choice.
• from the transaction list: See Viewing invoices
◦ Select the transactions you wish to export, and click the Export to MYOB button. This will create a text file in the same way as
before.

Importing to MYOB
• Select File>Import Data>Purchases>Service Purchases for supplier invoices (or File>Import Data>Sales>Service Sales for customer
invoices)
• In the Import File window, make sure that the settings are Tab-delimited, Data Record, Reject Them, and Card ID respectively
• Select Continue and browse to your exported file
• Double-click on the text file, and select the Match All button, and then Import
• MYOB will then attempt to import the records. If it reports that no records have been skipped, then all is well, otherwise you need to view
the MYOBPLOG.txt file (which will be in the same folder as the .MYO accounts file that you are logged into).

Understanding the MYOBPLOG.txt file
• MYOB inserts an error (negative number) or warning code (positive number) at the start of each line, and adds an explanation of the codes
at the bottom of the file
• You can most likely ignore warning messages
• The most likely errors will be because the supplier/customer code doesn't exist in MYOB, or there is a duplicate invoice number (i.e. the
record has already been imported)
◦ If the error is because of a missing supplier/customer, then you can see the mSupply code at the end of each record line
◦ Search for that name code in mSupply and create the corresponding Card record in MYOB
◦ Then you can try to re-import the same file (and this time, it will reject all of the records that it managed to import first-time
around).

Notes
• mSupply will only export finalised customer or supplier invoices, and it will ignore stock transfers and inventory adjustments → sometimes
it may not export as many records as you might think.
• mSupply doesn't export the customer/supplier name, otherwise MYOB will reject the invoice even if the customer/supplier code matches.
• mSupply will attempt to export as much reference information as possible into the Journal Memo field in MYOB - this will include the
Tender reference, Purchase order reference, and the Invoice reference.
• mSupply will include the quantity of each invoice line inside brackets, appended to the item name e.g. 'Amoxycillin (200)'
◦ MYOB doesn't have a field for unit price, but you can work out the unit price by dividing the total price by the quantity.
• MYOB expects every line to have a unique invoice number → the item line number has been appended to the invoice number when
exporting i.e. each line will have an invoice number like 812-1, 812-2 etc.
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◦ The invoice number shown in MYOB will reflect the total number of lines in the invoice
◦ The same applies to purchase order numbers
◦ If a blank purchase order number is exported from mSupply, then MYOB assigns the next one in it's internal sequence.
• MYOB will not allow you to import invoices with dates outside of the current financial year → make sure that you export everything you
need to from mSupply before the new year starts.
• The export format that mSupply uses is based on the current version of MYOB (version 12). If MYOB is upgraded, there is a good chance
that the format will change → importing to MYOB will no longer work until mSupply is updated to output the new format.
Previous: Exporting names Next: Exporting records
2011/06/03 04:12

·

Exporting records
Choosing Export on the File menu will display the export window, allowing you to export records from mSupply to a file.

You can search for a set of records by checking the New search check box, which displays the Query editor for you to specify your search criteria, or
else use the currently selected records.
If you tick the Open in Excel button mSupply will export any output to your spreadsheet application and will allow you to edit the Headings etc within
your spreadshhet. Otherwise mSupply will open a basic editor that will allow you to shape the look of the document.
After you click OK the Query Editor will open allowing you to filter the data you would like to export. Clicking on a field on the left will add it to the
filter criteria shown at the top. You then can add from the list of Comparisons and enter your own value in the text field below. To add another line of
criteria click the Insert Line button. Likewise to remove a line highlight the line and click the Del Line button.
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Once you have chosen your filtering criteria and if you did not click Open in Excel the the Export Editor will open. This is where you can choose
what fields to export.
You can add a field by highlighting it in the Fields box and clicking on the down arrow below it or you can remove a field by highlighting it in the
preview window at the bottom of the page and clicking the up arrow. If you want to add or remove all fields click the double arrows.
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If you want the fields to be ordered ready for item import, unzip the attached .4si file.
export_items_order.4si.zip
Previous: Exporting to MYOB Next: Dispensary Mode
2011/05/16 06:28

·

Printer Setup for Remote Desktop Client
In low bandwidth situations the mSupply client can become laggy and unstable, in these cases it may be recommended to use RDP through the
Windows Server Remote Desktop Client application. If the site is dispensing and using a printer, this introduces some complicated steps.

Requirements
At dispensary: - A computer with serial/com port and with RDP access to server - A Zebra printer with serial/com port
Server/machine that is remoted to: - mSupply Client installed and can connect to mSupply server - Windows server installed that has Remote Desktop
Client

Setup the remote Windows Server Machine
Use Windows Run to run tsconfig.msc and gpedit.msc.
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- In the tsconfig window, right click on “RDP-Tcp” and click “properties”. Go to client settings and make sure that the COM port is unchecked in
“Redirection - disable the following” list.

- In the gpedit window, follow the hierarchy shown below and make sure “Do not allow COM port redirection” is disabled (not configured probably
fine).
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Setup the local Machine
- The machine that you will be dispensing from needs to have the appropriate Zebra printer. - Check that your printer has a 9 pin serial/com port on the
rear - Check your Computer also has a 9 pin serial/com port (right most port below).

- You can verify that the computer has detected its external ports via device manager
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- Using a RS232 serial cable, plug the printer into the computer.
Caution: If you have a cable that has the female plug at both ends, it is likely a Null Modem cable. This cable will not work (even with adapter).
- If you have mSupply available locally on the machine, you can try testing printing a label to confirm your local setup is correct using misc. labels in
the special menu.

Remote Desktop Connection Settings
You must enable port sharing on the remote machine (at dispensary) in Remote Desktop Client for the machine you are going to remote into.
1.
2.
3.
4.
5.
6.

Enter the connection details for the machine you are going to RDC into
Show connection options
Select “Local Resources” tab
In the section “Local devices and resources” click the “More…” button
Ensure that the “Ports” checkbox is ticked
OK!
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Open mSupply Client in the rdc window and test printing, hopefully it works!
2018/02/24 01:16

·
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Dispensary mode
Dispensary mode allows you to use mSupply to issue medicines to patients. It is ideally suited for pharmacies, clinics, hospital dispensaries, and
facilities where medicines are supplied to individual patients.
The particular benefits of using Dispensary mode include:
• Prescription data can be entered into mSupply including:
◦ Patient details
◦ Prescriber details
◦ Prescribed items
◦ Item directions which can be quickly selected from standard abbreviations, and edited as necessary. Item directions do not need
to be printed in English.
• Labels can be printed with:
◦ Item description and quantity issued
◦ Patient name
◦ Prescriber name
◦ Directions
◦ Institution name
◦ More…
• Patient Histories are recorded, allowing repeat prescriptions to be:
◦ Duplicated
◦ Repeated

• Use of Dispensary mode depends on your mSupply registration type. Contact Sustainable Solutions if you wish to
upgrade your registration.
• Regardless of mode, each user can only use those functions for which they have permission, according to the
permissions set for that user. See Managing Users
• In client-server versions of mSupply, different users can be logged in in different modes at the same time, allowing
you to dispense to patients and supply wards, stores, clients or cost centres simultaneously.
• Users whose permissions allow them to operate in either Store mode or Dispensary mode may change from one to
the other by pressing Ctrl+2 on the keyboard. Re-entry of the user's password is not necessary.

Activating Dispensary Mode

Prior to version 3.5 you controlled dispensary mode for each user, and had to choose File > Edit users…
Now it's a setting for a store.

1. Choose Special » Stores
2. Double-click on the store you want to set to dispensary mode.
3. Check the Dispensary mode checkbox (or uncheck it if you want to revert to store mode). When you log out of the store and back in,
you'll be in the new mode.
• Choose File > Preferences > Invoices 2 then check the Show direction entry in dispensary mode box.
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What is a "name"?
In mSupply a “name” can be a customer, a supplier, both or neither. A “customer” can be anyone you supply goods to - e.g. another organisation, or a
ward in your hospital, or a patient.

What changes in Dispensary mode?
Different menus
The menus in dispensary mode have different names. For example, the Customer menu becomes the Patient menu.

In simple dispensary mode, there are a lot less choices in the menus. There should be enough options to allow a user to dispense medicines, but not to
do much else.

Different windows
The windows displayed are appropriate for dispensing medicines to individual patients; in addition to the ability to record individual patient's notes
(e.g. allergies), prescribers details are maintained. A patient history is maintained and other features specifically related to dispensing activities are
maintained.

Prescription entry
In dispensary mode, supply of items is made against a patient's prescription rather than an invoice as in store mode. Click on New prescription from
the menu bar to display the prescription entry window:
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How to look up a patient on file

When you are entering a patient name, mSupply will treat anything entered before a comma as a last name, and
anything entered after a comma as a first name.

• For example, to find John Smith, enter “Smi,J” or “smith,joh”
• If the patient's name code is known, enter a “*” (no quotes) and then the name code or part of it. eg “*58298”
In the Name field (screenshot above) enter your patient's name, or even just part of their name, for example, 'Sn, R' for 'Rick Snail' - so just part of the
patient's last name, comma, and then their first initial, and then press the tab key.
If your patient is already loaded in the system, then this entry should bring up the patient in question, or a list of patients for you to choose from.
• Always search for your patient in this way first, before entering a new patient, to avoid entering the same patient multiple times.
• If there is more than one matching name, you are shown the name choices window
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• Once you have found the correct patient, double-click the appropriate line, and then click Use.
• If the patient is not already stored in mSupply you'll need to add a new patient. How to do that is described here

Editing patient details
Once you have chosen a patient, you can click the small down-arrow to the right of the patient name to display a window where the patient details can
be edited (see below):
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Clicking the Print icon at this point will give you access to reports showing all prescription history.

Entering the prescriber

Once you've chosen a patient, the cursor will automatically advance to the prescriber entry field.
To enter a prescriber, you can type either their code, their last or first name in full or abbreviated, or “last comma first”. For example for the prescriber
Dr Felix Brown (whose code is 123) any of the following are acceptable:
•
•
•
•

123
bro
fel
bro,fe

Press the tab (not 'return') key after making the entry to show a list of matching prescribers. If only one presciber matches, the name will be entered
directly without the list being shown.
Note that there is a setting on the Dispensing page of the mSupply Preferences that affects whether or not you can accept and print a prescription
without entering a prescriber.

518

mSupply user guide July 2018

Entering prescribed items
On the Prescription entry window click on New line , and Add item window appears.
Once the item name and quantity have been entered, provided that the Show direction entry in dispensary mode option has been selected in
Preferences, directions on how to take the medicine should be entered.

Patient Events
This is the term mSupply uses to denote any item of information relating to a particular patient; for example, you may want to record the patient's
weight, the patient's blood pressure, any allergies from which the patient suffers, vaccination records, etc. - a wide range of information relating to a
particular patient may be recorded here.
First, some definitions of patient events need to be made;choose Patient > Show Patient events , then click the New button.

One patient event is already defined, the code is `NT', the description is `Note', and the type is Text ; you can also have events of type Numeric or
Boolean . For example, to create a patient event recording a patient's weight, the completed Add patient event window would look like this:

A further example, this time using the Boolean type - i.e. where the options are limited to two, `Yes' or `No' - could be to identify patients who have
insurance cover to meet the cost of their prescriptions; for this event, the Add patient event window, once completed, would appear like this:
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Once a number of patient events have been defined, choosing Patient > Show Patient events, will produce a window like this:

Now it is possible , using the Notes tab of the patient details window, to add individual items of information to the profile of any patient.
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View the record of the patient in the normal way (from Patient > Show Patients, enter the patient's name & double click the appropriate patient from
the 'names output' ) , and select the Notes tab. Click on the Add event button to bring up the window shown above.
In the Event field, Search event type appears by default. To display all the events you have defined so that you may choose the one you require, enter
the character “@” (without the quote marks), press the TAB key, and make your required selection from the list.
Alternatively, you may enter a word from the description of the event - e.g. if you have defined Patient's body weight as an event, you may enter the
start of the event name or code (e.g. pat ), and that event will appear in the Event field. If more than one event matches what you have entered, a list
will displayed for your to choose the event you want to enter.
Should you wish to add any note or comment, you may do so by moving the cursor into the Note area, clicking, then typing your entry. You can
customise the note in terms of when it will be displayed on screen etc. as described in the Items chapter of this guide. Here's the link - the_notes_tab.
After a period of time, a patient's notes may look like this:
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The default view shows all patient events, but you have the ability to vew single events by selecting the event code from the drop down menu Patient
events under Show
A new event may be added by clicking on the Add event button, and an event which is no longer of any relevance may be deleted by clicking on the
Delete event button.
Events may be edited by selecting the specific event, double clicking on it, when the Edit patient event window appears.

Entering directions
For many commonly prescribed items, default direction abbreviations can be defined - refer to the section on Item Default Directions. In the example
below, the item being dispensed is FRUSEMIDE 40mg tablets, and the default directions are “Take ONE tablet in the morning”. Alternative directions
present may be displayed by clicking on the down arrow to the right of the abbreviated direction field; directions not already present may be typed in
using either the Abbrev entry area, or the Expanded entry area.
Note that you can mix abbreviations and text like this.

The drop-down list shows any default abbreviations you have entered for the chosen item. If one or more default abbreviations exists, the highest
priority default abbreviation will be 'suggested' when you choose the item. If there is more than one standard abbreviation available, you can choose
another one by choosing it from the drop-down list.

mSupply stores the expanded text for each line, not the abbreviation. This means
that there is a full audit trail of what was printed on the label (unless you edit the
directions after printing!).
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Default directions
The set up of default directions is done on the dispensing tab when editing an item. You will find it described here.

Printing Labels
Patient labels are printed when the Print labels option is checked in the Prescription Entry window. Sample labels, produced by the Zebra TLP2844
printer are reproduced below:

mSupply currently is designed to work with the Zebra TLP 2844 label printer. The Zebra is a very nice printer. It can use either thermal labels or a
thermal ribbon which gives non-fading results.
We currently support plain 90 x 40mm label stock as this is cheap and readily available. The Zebra printer is auto-sensing of the ending of a label, so
you can most likely used labels longer than 40mm with no problems.
•
•
•
•
•
•
•

Label specifications:
90mm x 40mm high
White Matt Thermal Transfer Paper
Wide Edge Leading
1 Across on a roll
Perforation between each label
Produced on 1“ core to suit TLP2844

We are happy to support other printers if you use a different brand.

Reprinting labels
If you need to print the labels for an item again, choose Patient > Show Prescriptions to locate the prescription entry.
In the list of items dispensed, click on the line you wish to reprint, and then click OK (with the printing checkbox checked)
If you wish to reprint labels for all the items on the prescription, first click in the list of items below the last item so that now one item is highlighted.
Then all labels will be preinted when you click OK

Entering a new patient
To enter a new patient:
• In the Prescription Entry window, click the New Patient icon to the left of the name entry area. This window will be shown (Shortcut: CtlShift-P). All entry fields are blank, except for the Code field where the entry shown is the next number in the table of unique numbers
applied to each individual patient.
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• Code and Last are required fields but all applicable fields should be completed.
• Please note - the patient code will only appear if this setting has been selected in Preferences.
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If the new patient's date of birth is known, it should be entered, otherwise an entry should be made in the Age field; for a patient
aged 18 months, valid entries in the Age field may be in one of 3 formats, namely 18m, 1.5, or 18/12.

• When a patient's code is known, that patient's record may be rapidly displayed. Note also that the Male radio button is checked; if you are
entering details of a female patient, remember to check the Female radio button!.
• Custom fields are available for storing information such as insurance details etc.

Printing multiple labels
If you want to print more that one label for an item, hold down the Alt key ( Option on Mac) as you click the OK button. You will be asked for the
number of labels required as the label is about to print.

What if there is not sufficient stock of one batch?
As the quantity of a particular batch of an item gets used up, you will need to issue stock from more than one batch to a patient. mSupply handles this
when printing labels, and combines the totals for any item on a prescription so that only one label is printed for the total quantity.
The directions for the item with the first line number will be used, so enter directions for the first batch you dispense, and leave the directions empty
for subsequent batches.
Note: if you have the rare situation where you need to issue the same item to one patient with different directions you should either combine the
directions onto the one label, or enter two prescriptions with the directions entered differently on each prescription (That is enter the line, then print the
label(s), then choose Patient > New prescription and issue the item again with the second set of directions).
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View history
In the new prescription entry window, once you have entered a patient name you can click the “history” button to view a patient's history of what you
have dispensed.

Duplicating a prescription
Once you have a history window open you can click to select a single entry or control-click to select multiple entries, then click the “duplicate” button
to create new prescription line(s) with exactly the same details. Stock will be issued for these lines automatically.

Repeats
mSupply allows for the recording of repeat prescription. This is achieved when the prescription is first dispensed; in the Add item window, click on
Total field in Repeats box in the top right corner of the window, and enter the number of repeats that the prescriber has authorised. The Repeat
Dispensing procedure is described here.

Merging patients while dispensing
While dispensing, you may observe that a patient has been inadvertently entered twice.
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When the Choose patient window appears, you need to highlight the two patients to be merged, then clicking on the Merge button displays this
window:
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Here you need to decide which record should be kept, and which one should be merged, and check the appropriate radio buttons. This combines the
information in the record to be merged with the information in the record to be kept.

Viewing patient details
You can view a patient's details on-the-fly as you enter a prescription as described above. You can also view patients by choosing Patients > Show
patients.

Enter the details you want to search for and click Find
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You will be shown a list of matching entries, or taken directly to the detail view if only one patient matches the values you entered.

Patient history tab
The details displayed are similar to displaying a customer in store mode. However there is also a history tab that shows each item dispensed. Doubleclicking an item in the list will display the transaction in a new window.

Repeat Dispensing
The Repeats panel (upper right of the window shown below) allows details of repeat prescriptions to be recorded. Take the example of a patient
presenting a precription for Frusemide 40mg tabs x 30 on 1st January 2007, with the prescriber requesting “Repeat monthly x5”; in the Total field you
should enter “5”, and in the Expiry Date field you have the option of entering (a) the actual date on which the final repeat may be issued - in this
example, “1 July 2007” (allowing the patient one month's grace) - or (b) “6m” for 6 months. Note that the characters “D”,”W“ & “M” in upper or
lower case are interpreted in this particular field as the specified number of days, weeks or months before the repeat instruction expires. mSupply
defaults to an expiry date two months later than the current date, but this may be edited as appropriate. The system automatically updates the number
of repeats remaining as the patient makes further visits to have the repeats dispensed. The window below is displayed when you click on the New line
in ” Prescription window “
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The number of repeats is assigned in Total field in Repeats box, and as the repeats are dispensed, the number remaining is displayed in the Left field.
When you click on the blue arrows on the upper right side ,the total repeat number and total quantity for each repeat is shown. Clicking on the small
arrow displays the window below.

This window allows the user to alter the quantity of a particular repeat - e.g. if there is insufficient stock on a particular visit of the patient; the quantity
can be edited by clicking on the quantity line, and again clicking on the quantity, which may now be edited. The arrow on the left bottom corner
enables you to restore the default quantity setting.
Once you have filled repeat and other details on the Add item window properly, click on OK button to save details .
The Repeats icon is contained in Prescription entry.
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When the Repeat function is used, and there are future repeats to be issued, the icon appears on a red background:

The red background disappears when either:
• expiry date is reached
• all repeats have been dispensed
You can issue the repeat to a particular patient. Clicking on the Repeats icon displays this window:

The repeat window shows items to be dispensed, quantity, total repeats, repeats remaining and expiry date for a particular repeat. Process repeats and
OK button are described below.

OK
Click OK button to exit from the Repeats window

Process repeats
This button is used to issue the repeat for a particular patient and for a particular item line. For issuing the repeat, first select a desired item line and
then click on the Process repeats button. Now the system automatically manages the repeats internally.
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Printing receipts
When the Print Receipt option is checked in the Prescription Entry window, the printer will, after printing the medicine labels, produce a patient
receipt as shown below.

Should you wish to use a different printer for receipts, this option can easily be incorporated in mSupply if you advise us of your requirements.

Notes display
Any notes/events you enter in the notes tab will display each time you enter the patient name in the Prescription entry window. These notes can be
used to remind you of patient Preferences for certain dosage forms, or drug sensitivities.

Before you add an event for a patient, you need to make sure that patient events have been set up.
Previous: Exporting records Next: Prescribers
2011/04/19 07:20

·

Prescribers
From the Special menu choose Prescribers
We were going to title this section “Managing Prescibers” but we all know that's not possible ;-)
When you are in dispensary mode, issuing items to a patient allows you to add a prescriber. This menu item allows you to set up your list of
prescribers.
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To add a new prescriber, click the “New” button.

Add a code for the presciber. You can use the code quickly to look upthe prescriber when dispensing.
Other fields are fairly self-explanatory. Note that the code, first name and last name can all be used for looking up prescribers when dispensing.

Initials
The text you put in the “Initials” field will print on dispensary labels.

Active status
If you have a prescriber that is no longer used, you can change their status to “inactive” and the prescriber will not show in the choice list when
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dispensing. Inactive prescribers will still show when you choose Special > Show Prescibers…
We suggest you might want to add a “Miscellanous Prescribers” item to the list, and use this if you have a lot of prescribers whose prescriptions you
only dispense infrequently.

Category
This field can be used to group prescribers together, and can then be used to filter prescribers when producing a transaction report.

Merge prescribers
This item from the Special menu is used to merge two prescribers, where the same prescriber has inadvertently been entered twice. You are shown a
window like this:

Enter the two prescriber names by entering the start of their surname or their code, and then pressing Tab . The top prescriber is the one who will be
kept. The lower prescriber will be deleted.
Once you have entered the two names, check the details are correct, and then click OK. You will be warned one last time, and then the operation will
be completed.
All transactions that recorded the deleted prescriber will now show the name of the prescriber that was kept.

Import prescribers
For information on the procedure for importing a file containing your prescribers see Importing prescribers
Previous: Dispensary Mode Next: Abbreviations
2011/04/19 07:24

·

Using abbreviations
Choosing from the menu Special > Abbreviations allows you to enter directions quickly and accurately when dispensing medicines.
It is worth mentioning that abbreviations may also be used in other situations - e.g. if a significant number of customers live in the same locality, an
abbreviated form of their address could be employed. Such abbreviations are created in the same way as described below.
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As usual, you can sort the list by clicking on the column headers
Double-click an abbreviation to edit it.

Click the New button to add a new abbreviation.

Type an abbreviation and the text that it will expand to.
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Click the Report button to construct a simple report listing all abbreviations. This report can be previewed or printed.
When you are issuing an item you can mix abbreviations and your own text to add common directions quickly.
Do not use actual words as your abbreviation, or else attempting to type the word will result in the expanded text appearing on your label!

If you change an abbreviation or add a new one, you will see the change
immediately (v317 or later), but in a multi-user environment other users will have
to log out and log in (use Switch user to do this quickly) to see the edited or added
abbreviations.

Importing abbreviations...
The procedure for importing a file containing your abbreviations will be found here.

Printing a list
From the abbreviations window, click the Report button.

1.
2.
3.
4.

Double-click on Abbreviation
Double-click on Expansion
Right-click on Detail and set font size to 8 or 9
You can use the lines on the column headers to adjust column width
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5. Choose File > Generate to print the list

Item Default Directions
Once you have entered abbreviations, don't forget to enter the default directions for all common items. Instructions are here
Previous: Prescribers Next: Printing Preferences
2011/04/19 07:23

·

Label printing preferences
For setting up a label printer for the first time, see Label Printer Installation
Choosing this item from the Special menu shows the printing Preferences window.

Changing your default printer

The default printer is stored for each client computer - so each computer can be
set to print to a different default printer. When you alter this setting, you are only
altering it for the computer you are working at

To change the default printer, simply click the checkbox in the right-hand Default Printer column on the row of the printer you wish to use.

Adding a Printer
• click the New Printer button

Editing a Printer
• Double-click the printer in the list.
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Settings for a particular printer

• Description Here you give the printer a name
• Connection type
◦ If you are connection with a network cable (recommended) choose network
◦ If you are connecting with a serial cable choose serial
◦ If you are connecting with USB choose USB
• Port number For network connections this will usually be 9100
• IP Address- the address of the printer e.g. 10.1.1.253
• Label dimensions Enter width, height and margins in m.m.
• Make this printer default - Checking this box means that the computer you are using will always print to this printer.
◦ Important: this setting is “per computer” - you need to set each computer to have a default printer.
• Reset printer You can use this button to send a command to the printer to reset it. Occasionally a printer may misbehave if it's memory is
corrupted by an electricity spike or the like, and this button may help. If your printer is not behaving we recommend you contact
Sustainable Solutions rather than charging ahead on your own.

Setting up a USB printer

Once your chosen computer is set up and installed, go to Special > Printing Preferences > Add new to add a new printer.
Set up the window as follows:
Description: name of the printer, used by users to identify it
Connection Type: USB
Address: the Windows name of the printer. This can be found in Control Panel > Printers and Scanners. This must be accurate as it is used to identify
your printer. The name is written in the Printer properties inside the general tab.
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Three part label printing

Label Bottom Margin: margin between top label and lower labels
Bottom Left Label Width: width of bottom left label
Previous: Abbreviations Next: Warnings
2011/05/20 06:16

·

Warnings
From the Special menu this command allows you to view and edit the standard list of warnings.
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Once this list is created, you can apply one or more warnings to each item, and choose which warning will be automatically printed on labels.
To apply a warning to an item, see Adding a New item

Double-click a warning in the list to edit its details.

Click the “New” button to add a new warning.

We suggest you use the standard set of warnings as specified by the pharmaceutical authorities in your country.
Previous: Printing Preferences Next: Patient Medication Records
2011/05/20 06:36

·

540

mSupply user guide July 2018

Patient medication records
Introduction
A Patient Medication Record (PMR) is a way of recording all the medications a person is using, whether or not they were dispensed by you. The
record contains useful information for the patient such as
•
•
•
•

The dosage in a clear easy-to-understand format.
An (optional) picture of the dose form (tablet, capsule, etc)
The medication's purpose.
Common instructions for taking/using the medicine, which may be customised for each patient

Setting up items
Before adding items it is good to set up the standard purpose, instructions and item photo for common items at least. Once set up, you can add these to
a particular patient's PMR with just the click of a button.
1. Find the item you are interested in and go to the dispensing tab

2.
3. Enter purpose and instructions. Both these fields can take as much text as you wish to enter.
4. Add a photo by either dragging a photo from another application or pasting a photo from the clipboard.

mSupply will automatically resize large photos when you add them- there is no
need to resize photos yourself first.

Adding items to a Patient's PMR
There are 2 ways of adding items to a PMR
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1. From the patient history tab:
◦ Highlight the items from the patient's history you wish to add, then click the Add to PMR button.
◦ The record will be shown on the “PMR” tab if you switch to it.
◦ Note that on the PMR tab you still have to double-click on the added record and fill in the dose, instructions etc.
2. From the Patient details PMR tab
◦ Here you can add any item that is in the mSupply catalogue.
◦ For example, a patient might be regularly taking paracetamol or aspirin that they buy themselves. You can add such items here.

◦
a. To add an item, click the Add item button. You will be shown a new window:

b.
c. Item name: type the start of the item name and press <tab>, then select from the list
d. Dosage: Enter the number of tablets/drops/whatever to be taken/administered morning, noon, evening and bedtime.
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e. Purpose: If the item has a purpose entered, click the copy button to copy it to the right-hand box. Here you can edit the details
if you want to.
f. Instructions: If the item has instructions entered, click the copy button to copy them to the right-hand box. Again, you can edit
the details if you want to.
g. Click OK when you're done, or cancel if you decide not to add a record.
Editing a PMR record: Double-click the entry you wish to edit, change details, and click OK to save the changes and close the window. Deleting a
PMR: Highlight the record(s) you wish to delete, then click the delete button. (Do be careful- it's not reversible!)

Printing
Setting up printing preferences
When a PMR is printed, it has a header and footer. These are set up by choosing File > Preferences and then clicking the Patient Medication tab.

Note that you can style the text in these boxes by selecting text and right-clicking on your highlighted text to get a contextual menu to apply font
styles, colour and size.

Printing a PMR
Simply click the Print button. Note that you do not have to highlight records- all records will be printed.
Currently we have included a single PMR printing form in mSupply. We are happy to include others- send us your designs.
Previous: Warnings Next: Why an HIS module for mSupply?
2012/08/23 10:17

·
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Why an HIS module for mSupply?
As mSupply has become more widely used, it has become clear to us that many hospitals that use mSupply now have a functioning computer system
in their pharmacies, and not much anywhere else. Other clients have spent close to $1 million on systems that we don't think are financially justified in
their environments.

mSupply and mSupply-HIS
While mSupply and the HIS module are integrated, they also operate independently, and it is possible to use either module without using the other
one.
By incorporating an HIS module into mSupply, it allows a hospital to cover the basics while sharing a server with the pharmacy, so a hospital that uses
mSupply can start using the HIS module with little or no extra hardware costs. mSupply and the HIS module share a common patient database,
meaning that the pharmacy and other hospital functions are integrated.
Many of the menu items in HIS mode are similar (or the same) as the equivalent menu items in mSupply e.g. Show clinicians, Show connected users,
View log, Misc labels and Reminders.

What does mSupply-HIS do?
First, we should say that mSupply-HIS is not a fully-fledged Hospital Information System. It is designed to concentrate on a subset of a hospital's
activities that form the core of its operations. The software is under constant development. As new features and facilities are added, we strive to ensure
that the user guide and the graphics that it contains reflect these developments, but occasionally you may find that there are slight differences between
the program itself and the documentation. These are usually of a minor nature, but should you have any difficulties, do please send us an email with
details of your problem.
It does handle:
•
•
•
•

Patient registration and recording common static patient data.
Recording a hospital's wards and beds.
Recording inpatient admissions (admitting a patient, assigning them to a ward and bed).
Recordng ICD10 disease codes for each patient admission. You can assign multiple disease codes, and prioritise them (primary, secondary,
etc..).
• Moving patients to different wards/beds.
• Recording discharge data (patient status at time of discharge)
• Reporting on:
◦ Bed occupancy rates as a whole and by ward, and other useful statistics e.g. average length of stay.
◦ ICD10 statistics.
Previous: Warnings Next: Setting up wards and beds
2011/09/20 08:56

·

Setting up wards and beds
Wards
Choose Special > Show Wards
You will be shown a window like this:
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Click New Ward to add a ward.
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Fill in the name and description. You can also add a note if you want to.
For now, you can ignore the coordinates.
Click OK to save the information and close the window.
Repeat the process for each ward.

Beds
Make sure you have set up wards before setting up beds.
Choose Special > Show beds…

Click New Bed to add a bed.
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Fill in the bed number (or name).
If your wards have rooms, you can enter the room number or name. This is optional.
Choose the ward the bed is in from the drop-down list.
Click OK to save and close the window.

Modifying wards and beds.
To modify a ward or bed, show the list from the Special menu, then double-click on the entry you wish to modify.
Note that if you modify a ward or bed, all historical records will be updated. Therefor, don't change the name of a ward to a totally different name, and
don't move a bed to a different ward.

Setting up user access
Preferences
Choosing the Preferences menu item from the file menu opens a window with a side bar. Clicking on a subject in the side bar shows the options for
that subject:

General
Organisation name: Enter the hospital name here.
Country: Enter the country you are located in.
Max picture size: Enter the maximum size of patient pictures that can be inserted. We suggest you set this value to 500KB.
Maximum number of users: Enter the maximum number of users that can log into the HIS system at one time. For example, if you purchase a 10
user license, and assign 6 users to the HIS system, it will allow 4 users to log in to the pharmacy (mSupply) module.
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Previous: Why an HIS module for mSupply? Next: ICD10 disease codes
2011/04/19 11:50

·

ICD10 disease codes
These can be imported from File > Import ICD-10 codes.
A list of 65,000 ICD10 codes is available for download on the mSupply web site, or you can import your own, using the a text file with 2 tabdelimited columns, defined as follows:
Column number

Column letter

Field

Description

1

A

ICD10 code

8 alphanumeric characters (must be a unique value)

2

B

disease description

30 alphanumeric characters

Show ICD10 codes
On choosing Special > Show ICD10 codes you will be shown the current disease list.
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Find
To search for a particular code, type as much of the code or description as you know, and matching entries will be shown. For example, typing “foot”
will show all entries that have “foot” in their code (not that many, we imagine“!) or their description.
To Add a new entry, click the New button.
To Modify or view an entry's details, double-click the row.

Valid until...
This field allows you to use a code up until a certain date.
After that date is reached, you can't assign that code to any new encounters.
Note that you can use this field to disable use of a code at any time by entering yesterday's date and saving the record.
Previous: Why an HIS module for mSupply? Next: Procedures
2011/09/20 06:21

·
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Procedures

Internally, a procedure in HIS is treated like a service item in mSupply, so many of
the same concepts apply - see Items

The Special > Show procedures menu item allows you to track surgical and other procedures performed on patients. It brings up the following
window:

After setting the parameters, and clicking on OK, it will either show the list of procedures:

in which case, you can double-click on a procedure to view/edit it or select New item to create a new one. Or, if there are no existing procedures, it will
go straight to the Add procedure window:

The type of a procedure is fixed as “service”. As for items, once a procedure has been added, there are extra fields and tabs available. However, only a
subset of the normal item fields are available.
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Previous: ICD10 disease codes Next: Other lists
2011/09/20 10:18

·

Other lists
Apart from setting up beds, wards, ICD10 codes and clinicians, there are a number of other lists which can be customised from the Special menu:
•
•
•
•
•
•

Show discharges - add/edit the list of possible discharge reasons
Show religions - add/edit the list of possible patient religions (optional)
Show occupations - add/edit the list of possible patient occupations (optional)
Show ethnicities - add/edit the list of possible patient ethnicities (optional)
Show admitted from - add/edit the list of possible referrers (optional)
Show arrived by - add/edit the list of possible modes of transport used by the patient to attend the hospital (optional)

Previous: Procedures Next: HIS preferences
2011/09/20 09:49

·

HIS preferences
Organisation name: Enter the hospital name here.
Country: Enter the country you are located in.
Max picture size: Enter the maximum size of patient pictures that can be inserted. We suggest you set this value to 500KB.
Maximum number of users: Enter the maximum number of users that can log into the HIS system at one time. For example, if you purchase a 10
user licence, and assign 6 users to the HIS system, it will allow 4 users to log in to the pharmacy (mSupply) module.
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Previous: Other lists Next: Patients
2011/09/20 06:14

·

Patients
Adding a new patient
Choose Patient > New Patient, or click the New Patient button on the navigator. This will show the following window:
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Most of the fields are self-explanatory..
• First & last name (mandatory)
• Next of Kin
◦ Here you can link a patient to another existing patient.
◦ Type the last name then a comma, then the first name (or part thereof), and press tab. A list of matching names will be shown.
Double-click on a name to select that person.
• Patient Picture
◦ You can add a patient picture by clicking the Add button.
• Address and other contact details can be entered on the Contact details tab.

Showing and modifying patients
Choose Patient > Show Patients , or click the Show Patients button on the navigator.

To edit or view a patient’s details, double-click on their name in the list.
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Finding patients
Click the Find button, and a small window is shown:

Type as much of the Last name, First name or Code as you know, and matching patients will be shown. Note that you can search all patients or restrict
your search to only those in the already displayed list (the selection).
When you have a list of patients you can double-click on one to view the patient's details which will display up the following window:

Click on the different tabs to view different details. Note that on the Encounters tab you can double-click on the encounters shown to get their details.

Showing current admissions
You can also select Patient > Admitted to show a list of currently admitted patients.
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Previous: HIS preferences Next: Encounters
2011/05/18 11:01

·

Encounters
In mSupply-HIS an encounter is a record of an interaction between a patient and a hospital service. In this first version, the only type of encounter
handled is an inpatient admission, but we will be able to use “encounter” to allow for outpatient consultations and interactions with laboratory, x-ray
and other services in the future.

Entering a new inpatient encounter
Choose Patient > New encounter, or click the New Encounter button on the navigator.

Enter as much of the patient surname (and a comma, then the first name if you want to) then press <tab> to show a list of matching entries.
You can enter an expected discharge date (defaults to the next day), and where the patient was referred from and how they arrived at the hospital.
Once you choose a ward, a list of available beds is shown. If you choose to show the graphical view, you can see each bed, and you can click on a bed
to assign the patient to that bed.
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Available beds are shown in green, and beds that are occupied are shown in red (or if you are using the drop-down list, only beds that are available are
shown). The selected bed is shown in yellow.
The admission date defaults to the current date and time, but you can change these and the available beds will be updated accordingly. Once you have
chosen a bed, click OK or OK & Next.

Showing encounters
Choose Patient > Manage encounters, or click the Show Encounters button on the navigator.

The window has a side bar where you can show currently admitted patients or historical records. By default, it shows encounters for currently
admitted patients who have been admitted in the last 30 days.
Clicking the Find entry in the side bar allows you to search for specific records.
Click the triangle beside the “By date” entry allows you to search for encounters entered today, yesterday, etc…
In the tool bar there is a New Encounter button, allowing you to add an encounter directly from there.
If you double-click an encounter you are shown the encounter details. The first tab lists the location(s) (i.e. the beds/wards occupied) during this
encounter, and the fourth tab shows log records related to the encounter.
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Once a patient has been discharged, their encounter data can now longer be edited.

Adding disease records
The second tab shows the disease records entered for this encounter. Clicking the Add Encounter Disease button will show this window:

The cursor will be in the ICD field, and you can type as much of the code or name as you know to find matching records. Double-click the record you
wish to use in the list.
Choose from primary/secondary/tertiary for disease rank.
Enter any notes you wish to record.
You can enter the name of a clinician who diagnosed the condition if you want to. To do so, enter the start of the name and press <tab>… a list of
matching clinicians is shown. Double-click on the clinician you wish to choose. If you want to add a new clinician, click the New button. A window to
enter the clinician’s details is shown (see Prescribers). Enter details and click OK.
Once you have entered the disease details, click OK to close the list of diseases for the current encounter. You can now click the Add encounter disease
button again to add another disease, or double-click an entry to edit it.

Adding procedure records
The third tab shows the procedure records entered for this encounter. Clicking the Add Procedure button will show this window:
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As for encounter locations (see Encounters), you can specify a “bed” location (e.g. in a “ward” designated as an operating theatre) which is free for the
specified time slot, and this can be viewed graphically. The list of procedures is generated from those previously entered via Procedures.
From the procedure list, you can also double-click on an existing procedure record to view/edit it.

Adding birth records
If the patient is female, there is an extra fifth tab which shows the birth records entered for this encounter. Clicking the Add Birth button will show this
window:

•
•
•
•

The date/time defaults to the current date and time.
The last name defaults to that of the mother.
You can enter the birth weight (kg) and length (cm).
You can specify if it is part of a multiple birth, and whether the birth was normal, premature, or stillborn.
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When the record is saved, a new patient record will be created for the baby, with
its next of kin set to its mother. You can then add a separate encounter record for
the baby if needed.

You can also double-click on an existing birth record in the list to view/edit it.
Previous: Patients Next: Statistics
2011/09/21 05:08

·

Statistics
Select Reports > HIS Statistics to bring up the statistics window.
You can select a time period from the date range pull-down menu or enter specific dates. By default, the summary statistics page is shown. A bar chart
by ward for any column (except the first) can be generated by holding down the SHIFT key while clicking on any of the cells belonging to that
column. If you prefer a pie chart, hold down CTRL instead of SHIFT.

If any of the individual wards are selected from the pull-down menu (instead of “Summary”), then it displays the data for that ward on a daily basis. In
this case, a bar chart for any column (except the first) can be generated by holding down the SHIFT key while clicking on any of the cells belonging to
that column.
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In either mode, the displayed columns can be exported as a tab-delimited text file (which can then be imported into Excel or other spreadsheet
application) by clicking on the Export button.
Previous: Encounters Next: General Preferences
2011/09/22 08:13

·

General preferences

Note that many preferences are now set on a per-store basis i.e. each store has its own setting for
some preferences. See the Virtual stores preferences section for more information.

Preferences are used to configure some of mSupply's functionality to more closely match your needs. mSupply is very flexible and highly
configurable so there are lots of preferences! To access them, choose File > Preferences… from the menus. There is a scrolling side bar on the left
containing a list of tabs; click on the one you want to see the preferences on that tab.
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General tab

Organisation name: What is filled in here is quite important. Not only will it print on the top of invoices and various reports, but it is also tied to your
registration code. Please think carefully about what it should be before entering it. If you need to change your organisation name, please do so and
then re-contact info@msupply.org.nz for a new registration code.
Address lines (1, 2…): Enter the address information about your organisation that you wish to appear on invoices.

The Register button
This button is used for registering mSupply. (It will be dimmed if you have already registered). If you have not registered, clicking this button will
display the registration details window:
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• Here you are provided with the information needed to register. Two of these, if changed, will invalidate your mSupply registration:
◦ Your organisation name
◦ Your hardware id.
• Clicking the Copy details button will copy this information to the clipboard, which you can paste into an email and send to
info@msupply.org.nz (mailto:info@msupply.org.nz).
• Once we have received this registration information we will generate a registration code for you.
• The code is entered by clicking the Enter code button in the window shown above. You will then be shown another window where you can
enter the registration details you have been supplied:

Your registration instructions supplied with the registration code will describe what information to put in each field.

• mSupply registration codes are specific for the computer and organisation name and the expiry date of your licence
(if it is time-limited).
• If you change either your organisation name or the computer on which you are running mSupply, you will need to
contact Sustainable Solutions for a new code.
• If the internet is accessed via 3G USB dongle, the registration process will often use the hardware ID of the 3G USB
dongle rather than that of the computer's Ethernet card. The 3G USB dongle might be changed at a later date, and
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this would cause mSupply to become unregistered. To avoid this, make mSupply use the hardware ID of the Ethernet
card rather than the 3G USB dongle:
◦ Disconnect the the 3G USB dongle from the computer and re-start mSupply.
◦ Proceed with retrieving the registration details as described above. The computer should pick up the
hardware ID of the Ethernet card rather than the 3G dongle which has been removed.
• If the hardware id field is not showing 12 characters &/or numbers, this indicates that you do not have an Ethernet
card or 3G USB dongle installed on your computer. Please consult Sustainable Solutions for installation instructions
if needed.
• If you move your data file to a new machine you will either have to move the Ethernet card to the new machine or
obtain a new registration code and enter it within 3 months of the move.

Other fields on the General tab
Default customer: Leave this field blank for normal operation. If you usually (or always) only issue to one customer, enter that customer's code here.
You must set the value to the name code of an existing customer. Doing so will mean that this customer's details are automatically filled in when you
create a new customer invoice.
Default margin for suppliers: The percentage margin that will be filled in when you enter a new supplier. This value can be edited for each supplier
at any time. Enter “0” if you do not apply a mark-up to items you sell (for example, if you are issuing stock to hospital wards at cost).
Default tax rate The rate entered here will automatically be applied to customer and supplier invoices. Note that this amount can be edited when you
are entering an invoice by clicking on the tax rate at the bottom of the invoice entry window.
Period Closing: There are two fields allowing the entry of dates:
The Closed date is the date prior to which no transactions can be entered. Setting the closed date means that all transactions up to that date are
finalised and mSupply will not allow the entry of any transactions with an earlier date. The closed date can not be moved backwards- only forwards.
The Locked date is the earliest date that can be entered for a transaction. The lock date can be moved forwards as far as the oldest non-finalised
transaction, and backwards as far as the closed date

If you try to set an invalid locked or closed date you will be warned.
Be very careful setting the closed date. Changes to the closed date can not be undone.
Inactive user logout: This setting is only visible if you are using an mSupply client in a multi-user setup, not if you're using the single user version of
mSupply (because it's not applicable to the single user version). This is where you set the time in minutes before the mSupply client is closed and the
user is automatically logged out. To disable the function, set the time to 0 minutes (the default setting). This is really useful for preventing inactive
users holding onto a user license when they've forgotten to logout of mSupply. But BEWARE: any unsaved work will be lost when mSupply is closed
so remember to save your work regularly. The good news is that most of the things you do in mSupply are automatically saved as you do them (adding
and removing lines to customer and supplier invoices, inventory adjustments, stocktakes etc.) so the chances of losing work are minimised.
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Misc tab

Own code for electronic invoices The code that customers must have for your organisation in their copy of mSupply. This code is added to invoices
you export, and allows customers to import the invoice into their system automatically.
This is an old copy: warn me at startup. You may want to save an old copy of your data (for example the data as it stood on the last day of the
financial year). If you check this box, you will be warned at startup if the database is an old copy, to reduce the risk of accidentally entering current
transactions into an old file rather than your current file.
Use a lock file to warn if data already open If this box is checked, mSupply will maintain a record of when it is open outside of the database. This
option only applies to the single-user version of mSupply. This means that if a second user attempts to open your data file while the data file is already
in use, the user will be alerted, and no damage to the data will occur. Note that this option only applies to the single user version of mSupply. The
client-server version of mSupply allows multiple users to access mSupply at the same time.
What if your machine crashes? If, for example, you have a power failure and your computer shuts down suddenly, mSupply will not be able to delete
the lock file, and you will get a message when you attempt to restart mSupply that another user is already using the data file. If you are sure this is not
the case, use Windows Explorer or the Mac Finder to locate the folder that contains your mSupply data. Delete the file that has the same name as your
data file but ends in “_locked.txt”. You will now be able to start mSupply.
We recommend you do not turn this option on unless you understand the above paragraph or have a system administrator who authorises your use of
this option.
An example of where turning on this option might be useful is when you store your mSupply data on a file server, and allow multiple single-user
copies of mSupply to access the same data file. In such a situation to have 2 users attempt to access the data simultaneously would be disastrous.
Item codes must be unique When this box is checked, mSupply will ensure that each new item entered has a unique code.
Include catalogue code for item search When checked, a report can be produced where the item's catalogue code is one of the search parameters.
Currency formats This option specifies the format in which currencies will be displayed in mSupply. We provide two preset formats for currencies
with 2 decimal places and currencies with none. If you want to enter a custom format you can change the field below the drop-down list. For example
you may want to use a different separator than a comma. Note that if you type illogical values into the field the numbers may not display at all, or
display erroneous data. Contact Sustianable Solutions if you need more information.
Service items Service items are items that do not have any stock associated with them. For example, a fee for special handling of goods, or for
reprinting an old invoice, or a consulting charge.
These Preferences determine whether new items are allowed to be service items or not. Note that changing this preference will not affect existing
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items.
Names
• Customer code and charge code must match - If checked, when entering or editing a Customer, you will have to enter the same code for
both the “code” and the “charge code” fields. (It is a good idea to leave this checked unless you have several customers that are invoiced
separately, but whose invoices are collated onto a single statement at the end of the month)
• Supplier code and charge code must match - If checked, when entering or edit a Supplier, you will have to enter the same code for both
the “code” and the “charge code” fields. (It is a good idea to leave this checked unless you have several suppliers that are invoiced
separately, but whose invoices are collated onto a single statement at the end of the month)
• Name code for all codes to be unique (both 'store' and 'dispensary' mode) - If checked, when entering or editing a customer or supplier
mSupply will not allow the creation of a second name with the same name code.

Labels for custom item fields
mSupply provides you with seven custom fields that you can use to record your own data for each item.
•
•
•
•
•

the first three fields hold text or numbers,
the fourth field is yes/no (or true/false)
the fifth field is a numeric field
the sixth field holds text or numbers
the seventh field is yes/no (or true/false)

Here you can specify the label(or name) for each field. Note that field one is also displayed when you list items. Note also that when using the search
editor to search for items (for example when producing a custom report), the fields are labeled “user field 1” etc.., and not with the labels you might
have assigned.

Label for field on cash payment or receipt
The label of the Their ref field on Customer Receipts or Payments to suppliers can be changed to whatever you enter in this field. It is set to Cheque #
by default. If you leave the field blank then the field label will be Their ref.

Purchase order defaults tab
For an explanation of the sections on Purchase order defaults go to Purchase Order Preferences

Purchase order 2 tab
For an explanation of the sections on Purchase order 2 go to Purchase Order Preferences

Invoices 1 and 2 tab
For an explanation of these sections see Invoices Preferences
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Item tab

Default account code for new items
• There are 3 spaces for you to select the accounts to use. Choose one account for expenses when buying, one account for income when
selling and an asset account for stock.
• The accounts you enter here will become the default accounts for newly created items.

Item list (master & local)
If you check this box, then the visibility of items in stores will be set to match the items on master list(s) selected to be used by that store. For details
on how this works and how to set it up, see Controlling item visibility - the Master lists tab.

This preference can drastically affect item visibility. For instance, if a store has no master lists assigned, all items will be made
invisible in that store. Could lead to a scary moment!
If some items that are currently visible in a store need to be made invisible when this preference is turned on but they can't
(because they have stock, for example) then a temporary master list is created for each store containing the problem items.
mSupply will inform you but you should use that list to deal with those items.
Do not turn it on unless you know what you are doing! It affects ALL stores in the system.

If the box is unchecked then the visibility of items in a store is not affected by master lists.
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Assigning item codes automatically
If you want item codes to be assigned automatically, check this checkbox.

Price tab

On checking the box for “Use customer price categories”, mSupply will activate the price categories.

Price Categories
By default all customers are assigned a price category of “A”
To assign a different category to a customer, choose Customers > Show customers… and find the customer entry. Then set the price category field to a
different value
Here in the Preferences, you specify what percentage change to the default price will be made for each category.
For example, you might have a group of customers to whom you charge commercial prices, which are 20% above your normal price. Enter “20” in the
“B” category field, then assign your private customers a price category of “B”

Ignore price categories for items supplied by these suppliers
Suppliers in this list will have no price category assigned to the items they supply. To add a supplier in this list, click the Add supplier button. A
window will appear with a space to write the supplier's name. You can write the first character or two and press enter/return to bring up a list of
suppliers that start with those letters. You can then select your chosen supplier from the list. To delete a supplier from the list, highlight it by clicking
on it and then press the Delete Supplier button.
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Quotes tab

Require entry of quote validity date
Check this box if you want a validity date for a quote to be compulsory.

Automatically turn off preferred status after validity date
If you check this box then the preferred status will not appear when the validity date has passed.

Reports tab

Check this box if you want negative stock values to be ignored on stock history reports (negative values can be legitimate but concerning for some
users so negative values are left as zeroes if this preference is turned on).
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Names tab

Default field name/Custom field name table: In this list you can change the labels for name categories and custom fields - not the categories
themselves (see Name categories for instructions on how to do that) but the labels for the categories. To change one of the labels click on it in the
Custom name column to select it and click on it once again to begin editing it. Type the new name and then click outside the label to finish editing it.
Now, wherever you would have seen that label in mSupply you will now see the name you have given it. The defaults are shown in the screenshot
above.
Example: If category 1 was to be called 'Ownership' and category 2 was to be called 'Classification' then you could change their labels like this:
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Now, wherever you would have seen the label 'Category 1' or 'Category 2' in mSupply, you will now see the label 'Ownership' or 'Classification' e.g. in
report filters or, as in this screenshot, the General tab of the name details form:

Labels for custom fields on name category: Here you can enter labels for the custom fields used when creating or editing name categories. The
labels you enter here will appear on the New/Edit category window instead of the Category_user_field_1 and Category_user_field_2 labels. These
labels are used in some reports.

Tenders tab

Tender letter section
• Title: The title for the printed tender letter. If nothing is entered in here mSupply will use 'Invitation to tender'.
• Tender reference: The reference for the tender so that, when you communicate with others you both know which tender you are referring
to. If nothing is entered in here mSupply will use 'Tender reference'.

User details for Tender module section
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We run a Remote tender module
Click this to indicate that you operate an mSupply remote tender service where suppliers and you will log into a common web page to submit and
download tender information. You will need to contact Sustainable Solutions for the account information required below before using this option. If
this box is unticked you will need to enter bids manually. If it is ticked, you will see an extra Synchronise tab when you view the details of any tender.
Client ID This is the ID that you use to login to the remote tender web page and is unique to you. This will be supplied to you by Sustainable
Solutions.
Password This is the password you use to login to the remote tender web page. Like the ID, this will be supplied to you by Sustainable Solutions.
Tender Module Address The internet address of the remote tender web page in the format IP address:port number. Once again, this will be supplied
to you by the indefatigable Sustainable Solutions.

Reminders tab

Reminders provide a simple to-do list built into mSupply.
If the Show reminders on startup box is checked, any reminders that are not completed and whose due date has been reached will be displayed in a
window when a user logs on.
See Reminders
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Patient Medication tab

Here you can add a header and a footer that will appear on patient medication records.
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Drug Interactions tab

When operating in dispensary mode, you can choose to have mSupply alert you to drug interactions. Dispensary mode is covered fully in this section
The number of days of patient history …. field determines how far back from the current date mSupply should look for drugs that have a known
interaction with the drug you have just entered.
When drug interactions are activated, you will be shown a warning message when you enter a drug on a patient invoice that interacts with other
medicines dispensed to that patient during the history period specified.

Drug Registration tab
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If you have a license for the Registration module, you will need to check this tick-box, and click OK in order to activate it.
You can specify the number of months before a drug registration expires. So when you register a drug, the expiry date of your registration will be
calculated automatically by adding the number of months you have specified to that day`s date. For example, if you specify 24 months until a drug
registration expires and you register a drug on 24/07/2016, the expiration date will be set automatically to 24/07/2018. If you leave the number of
months at 0, you will have to set the drug registration expiry date manually.

Printing tab
For an explanation of this section please go to Printing Preferences

OK and Print tab
For an explanation of this section please go to OK and Print.

Logo tab
Here you can paste in a logo you have copied to the clipboard - you must copy the contents of a file to the clipboard, not the file itself. The file can be
in .jpg, .png, .bmp, .gif, or .tiff format. This logo will be displayed at the bottom right of the navigator.

Make sure the image you use is twice as wide as it is high. If it is not, mSupply will convert it to this ratio which will make it
look squashed or stretched, sometimes with interesting results!

If you have set a store logo (see here) for the store you are logged into this will be displayed on the Navigator and invoices instead of the one saved
here.
If you want the logo to be printed on invoices, check the checkbox.
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Please note that not all printing forms include the logo. If you would like customisation or assistance, Sustainable Solutions can quickly customize
forms for you to meet your requirements.

Dispensary mode tab
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Label Printing
Message on labels The text you type here will be displayed on medicine labels on the last line.
Custom identification code If you wish to identify the origin of the dispensed item, e.g. In-Patient Dispensary or Out- Patient Dispensary, create an
identification code, and enter it in this field. It will then appear as the last item printed on the the right of the third line of each label.
Printing options for units Three options are available from the drop down menu. You can choose to always print the units on labels, you can choose
for each item whether or not to print the unit or you can choose to never print the units.
Turn off cell padding in between direction and patient name mSupply will automatically pad the cell (leave some space in the cell) between
Direction and Patient name. If you do not want this to happen then check this box.
Print full prescriber name on label To have the prescriber's full name printed on labels, check the box in Print prescriber full name. Otherwise, the
initials will be printed.
Print organisation address 1 as separate line By checking the box Print organisation address 1 as separate line , you can print organisation address
1 as separate line . You have to set the text in Preferences: General »address 1 field. The text which you type here will be displayed on medicine labels
on its own line.
Print patient category on label If checked, when a prescription label is printed the patient's category will be printed alongside the patient's name in
the following format; Patient name (category). Note that if the Print Patient code on label option is also checked then the patient's code and category
will be printed alongside their name in the format Patient name (code/category).
Print Expiry date of Item on label When checked, the item's expiry date will be printed on the label.
Print Sales value of item on label When checked, the item's sales value will be printed on the label.
Print Patient code on label If checked, when a prescription label is printed the patient's code will be printed alongside the patient's name in the
following format; Patient name (code). Note that if the Print Patient category on label option is also checked then the patient's code and category
will be printed alongside their name in the format Patient name (code/category).
Print Batch on label When checked, the item's batch number will be printed on the label.
Don't print placeholder lines If this box is checked, placeholder lines will not be printed.
Print a receipt on labels by default mSupply allows you to print a patient receipt on a label; to enable this function by default, check the box Print a
receipt on labels by default in Preferences:Dispensary mode as shown above. This has the effect of enabling the “Print receipt” check box in the
Prescription entry window . Note that if the Print a receipt on labels by default is not checked, the function may still be turned on in the Prescription
entry window.
For more information on printing receipts, see Dispensary Mode

Patients
Default Patient category The text you enter into this field will be assigned to the category field for new patients.
Default Prescriber name With the cursor in this field, enter the first letter or first few letters of the prescriber's name and press Tab. A window
appears displaying prescribers who meet the criteria typed; note that both first and last names appear, and you should select the desired prescriber and
click OK to make that prescriber the default one.
Auto-generate patient code If this box is checked each new patient created will have a serial number assigned to them. The assigned code can be
overriden by the user.
Prefix codes with The text you enter in this field will be used as a prefix for automatically generated patient codes. e.g. if you enter “t” codes will be
assigned “t1”, “t2” etc.
Capitalise patient names Does what it says. The shift key will still override this option.
Prescriber must be entered If this checkbox is checked, then the user will be warned if a prescriber has not been entered when they click the OK
button for accept and print a prescription.
Expand abbreviations in patient address fields In the patient address fields, any abbreviations will be written out in full instead of the abbreviation
if you check this box.
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Share patient prescription over stores If this box is checked, viewing a patient history in one store will show transactions entered in other stores.

Apply stock to placeholder lines
This section gives you the ability to apply stock to placeholder lines on prescriptions. We know that in a fast moving dispensary it's sometimes hard to
keep up with the stock coming into the dispensary so, sometimes you can get into the position where you physically have stock on the shelves to
dispense to patients but you haven't been able to enter it into mSupply yet. mSupply allows you to keep dispensing by automatically adding
placeholder lines to the prescriptions instead of normal stock lines. When you eventually enter the stock that you physically dispensed to the patients
into mSupply, you need to allocate it to the prescriptions to keep your mSupply stock levels correct. This is the function to enable you to do that.
Simply select the dates between which you want mSupply to look for placeholder lines on prescriptions by manually entering them in the From and To
fields or selecting one of the preset selections in the drop down list. Then click on the Apply stock button. mSupply will then search for placeholder
lines on prescriptions between the dates you chose. If it finds one it will attempt to replace the placeholder line with real stock from your store on a
FEFO basis. If there is enough stock then mSupply will replace the placeholder with a real stock line. If there is only enough to replace part of the
placeholder line then it will allocate what stock there is and will leave a reduced quantity placeholder line to represent the stock that still couldn't be
allocated.

HIS tab

Log tab
The significant events which mSupply automatically logs are listed here. Additional events may be logged by checking the appropriate check boxes on
this tab.
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Item

What is recorded (Date, time, the user name are always recorded)

Invoice creation

The log will record each new invoice (customer or supplier) created

Invoice editing

An invoice (customer or supplier) is considered to have been edited if its total value has changed. Both
values, old and new, are logged

Creating a new customer or supplier

Whenever a new customer or supplier is created, their name and code will be recorded in the log.

Modifying an item's supplier field

The supplier field for each item can be used to determine to whom orders for goods are placed
(depending on the type of order you generate). If you use this method, you may want to know if
mSupply users change the preferred supplier for an item.

User Login and Logout

The log will record every occasion on which users login and logout.

A batch is taken off hold

The log will record every batch that is taken off hold (and so becomes usable)

A customer invoice is confirmed

When the confirm button is clicked, or an invoice is set to auto-confirm: the invoice number is recorded.

A Stocktake line is added manually

If a user manually adds a Stocktake line, this will be recorded in the log

Please contact us if you need more logging than is provided here. It is a simple matter to incorporate into a future version - the trade-off is that it
leaves the potential open to create very large log files, which may be a problem for some users.

Backup tab
Note - These Preferences are applicable only in single user mode; in client-server mode, the backup schedule is set on the server.
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Activation
To activate , the Automatic Backup checkbox should be checked, then the appropriate radio button checked to have automatic backups performed
according to your requirements.
This function allows a backup of your datafile to be made. There are two types of backup available.
• Local backups are made to another folder on your computer, or to a networked folder.
• Internet backup allows for your data to be copied from a special backup folder to a secure internet site.- this applies to both single-user and
multi-user systems.

Local Backups
You can perform a backup manually File> Backup as well as automatically. It is not necessary to quit the database before performing a backup.
The settings in this window are to be used only for single-user mode. In client-server user mode you must set the backup Preferences on the server
machine.

Choose backup folder
Click the “Choose” button to specify the destination of the backup files. For added security, we strongly recommend you backup to a different physical
volume from the one where your mSupply data is stored.
We recommend running mSupply server as a Windows service. This allows automatic log on, and control of the starting and stopping of the server
from command line tools that can be run when a UPS is shutting down. Please contact us for more information.

Compression rate
Choose whether backups should be compressed or not from this drop-down list. Compact will give the smallest backup size, but it will take longer for
backups to run. Fast is a compromise of speed and size.
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Internet backups
If you are using an internet backup system such as Spideroak, Dropbox or Memopal, these options allow you to set up a folder that is watched by your
backup software and backed up to the internet

Verify data file after backup
mSupply allows you to verify the data integrity of your main data file each time a backup is made. This is extra insurance against hardware failures
and other factors that can lead to data corruption. Check this box to activate.

Restore last backup if database is damaged
Check the box to activate this preference.

Use log file
Email results of check… If you check this option Sustainable Solutions will receive by email a report of the data file verification each time it is run.
Note that no confidential information is transmitted with the report.

Integrate last log if database is incomplete
If this checkbox is checked, then if your data becomes damaged, mSupply will automatically restore the data from a backup and use the log file to
restore all transactions between the date of the backup and the current date.

Backup 2 tab
Here you can set the secondary backup location.
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This is useful for making copies of just some of your backups that you can then upload to a cloud-based backup service for automated off-site
backups.

Automatic backup to secondary folder:
Checking this option results in mSupply trying to copy completed backups to another folder which you specify with the Choose button below. Fill in
the Backup every …..th file… field with number of backups out of which one copy will be kept. That is, entering 7 will result in one backup per week
being copied.
You should now configure your online backup software to use the folder chosen as the secondary backup location as the source folder for backups.
Note that if you have plenty of upstream bandwidth, you might simply wish to set your main mSupply backup folder as the source folder.
The duplication and block-level comparsisons that services such as Spideroak use mean that it may be better for you to use uncompressed mSupply
backups, as then only the changed portion of your data file will be backed up.

Secondary backup options 1, 2, 3
mSupply now allows you to make up to 3 secondary backups to separate locations if you would like to. You can use 1, 2 or all 3 if you would like to.
At least one is recommended for security purposes.

E-mail tab
You can choose to send orders, reports, invoices and notifications to recipients using e-mail in mSupply. However, before mSupply can send anything
by e-mail you must tell mSupply about the server you wish to use and details of the e-mail described below:

Provide me with a mail server to send emails
If this is checked you will use mSupply's own internal email server to send emails. If it is unchecked you will use your own email server, the details of
which you must enter in the Mail server name, Username, Password, Port and Use SSL fields.
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Mail server name
The name of your mail (SMTP) server. eg “mail.mac.com”. You can only enter this if you are not using mSupply's inbuilt e-mail server (i.e. Provide
me with a mail server to send emails is unchecked).

User name
The username mSupply will use to authenticate itself to the mail server. Only needed if you are not using mSupply's inbuilt e-mail server (i.e. Provide
me with a mail server is unchecked).

Password
The password which goes with the username. (Only when not using mSupply's e-mail server)

Use SSL
If this is checked mSupply will use the Secure Socket Layer protocol to send e-mail. A more secure way of sending e-mails but only check this if your
mail server can support SSL.

Port
The port on the mail server which mSupply will send e-mail to (must be the same port the mail server is listening on!). (Only when not using
mSupply's e-mail server)

Return email address
Enter an email address you would like any response to come to. mSupply cannot send email unless it also has a return address for email.

Signature
The text you enter here will be added to the end of all e-mails you send. You might want to put your organisation contact details here. It is generally
poor etiquette to make your signature too long.

By default use a mono-spaced font to view text
A mono-space font such as “Courier” or “Monaco” is better for viewing text in columns, such as is produced by the automatic order generation in
mSupply . However, visually it has less 'eye appeal'.

Default subject line when creating orders
When mSupply automatically turns an order for a supplier into an email, the text entered here will be put in the subject line. For example you might
want to put “Acme Hospital order” to advise the supplier of its contents. Note that you can edit the subject line of automatically generated emails
before you send them.

Sort order lines for email and HTML export by item name
This option allows emails generated automatically to be sorted alphabetically by item name before the email is created. If this option is left unchecked,
emails will use the creation order of the order lines to create the email.
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Server tab

These settings are all for mSupply's built-in webserver, which is used for things such as the Dashboard, mSupply mobile, online catalogue and the
Customer interface. Note: To use this feature an additional license is required. Please contact Sustainable Solutions for further information.

Starting the web server
The web server can be set to start automatically when mSupply starts by checking the box, or manually as and when you use the service by clicking
the button.

Run Webserver on the following port
The default port is 8080.

Disable the Customer order web module and display the following message:
If for any reason you want to take the customer ordering module off line you can choose a message to display for your customers.

Time out
For clients connected via a web browser, this is the maximum period of inactivity, after which the client must log in again.

Default store for web interface
Choose which store you want to be the default for the web interface (only applicable if you have more than one store). Be careful when changing this
option because it will change the default store that all the web interfaces will use to get information from mSupply, not just one of them.
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User can create XX uncompleted orders at a time
This limits erroneous submission of too many orders. Choose the maximum number of orders that a customer can make. If they have reached the
maximum amount, they will be able to create more when other ones are completed.

Maximum allowable time a mobile interface request can take
This sets how long mSupply will keep trying to supply report data before it gives up and displays an error message.

Synchronise tab
For an explanation of this section please go to Synchronisation.

Customisation Options

Should a client wish to have customised features which are specific to their version of mSupply, we are happy, whenever possible, to incorporate such
features.
If you are running such a customised version of mSupply, you will have received from us a Customisation code . To activate the customised features,
that code must be entered in this field.
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Moneyworks tab

If you use the superb Moneyworks accounting software, you can have mSupply directly input invoices into Moneyworks.
Contact info@msupply.org.nz for more information on these options.
Visit http://www.moneyworks.sussol.net (http://www.moneyworks.sussol.net) for more information on Moneyworks, including a free demonstration
version.

Link to Moneyworks accounting software
The Moneyworks application must be installed on your machine, and this option establishes a link between mSupply and Moneyworks. Don't turn it
on if you don't know what you're doing, or if you haven't set up Moneyworks as described below.
Three options are presented in the drop down menu:
• Gold - select this option if the Moneyworks application you are using is the one installed on your computer.
• Gold Client - select this option if you are connecting to the Moneyworks application installed on another machine on your network.
• Data Centre Client - select this option if you are connecting to a Moneyworks Data Centre

Export to Moneyworks when finalising individual invoices
This allows for production of individual invoices, e.g. for non credit customers, who make cash purchases; if you have such customers, check this box
, but if all your customers are credit customers, receiving monthly statements, it may be left unchecked.

Location of the Moneyworks application
mSupply needs to know the location on your computer of Moneyworks , and by clicking on the Choose button, a window appears, and you should
navigate to the location of the Moneyworks .exe file
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Document Log on
Enter your logon details to access the Moneyworks document that you want to access.

Data Center Log on
If you are using a partitioned data center, enter your logon details to gain access to the partition where your document resides. If you are not using a
partitioned data center then leave this section blank.

Location of the Moneyworks document (datafile)
You need to identify the Moneyworks document (datafile) you are using
If your link is to Gold, this is done by clicking on Choose , and navigating to the file's location. If access to the file is restricted, you need to complete
your user name and password in the fields under Document Logon
If your link is to the Client option, when you click on Choose , a window appears and you need to enter the name of the Moneyworks datafile to which
you are connecting; the file's restrictions will require you to enter your user name and password in the fields under Data Centre Logon

Type of customer invoice export
The drop down menu allows you to choose from several options:
• Single income account
• Separate income accounts by item account
• Choose for store

I.P. address of machine using Moneyworks
You only need to fill in the I.P. address here if:
• You are on Macintosh and
• You are connecting to a remote machine across a network.
If you are on Windows or a Mac connecting to a local installation of Moneyworks, make sure this field is empty.

Notes on setting up Moneyworks:
• The import into Moneyworks relies on using an import map. The map for supplier invoices must be named “si_import.impo” and the map
for customer invoices “ci_import.impo”. These map files must be stored in the “Import Maps” folder inside the “Moneyworks Customer
Plug-Ins” which is next to your data file.
• The advantage of using import maps is that it gives you flexibility in deciding which accounts will be designated for sales and purchases,
and the way the fields exported from mSupply are used inside Moneyworks.
• If you would like sample import maps from Sustainable Solutions, please email us at info@ss.org.np (mailto:info@ss.org.np).
• Once you have set up the import maps and turned on the “Link to Moneyworks accounting software” checkbox, mSupply will attempt to
send invoices to Moneyworks that are finalised using the “finalise customer invoices” and “finalise supplier invoices” commands.
• Note that the “Export invoices when finalising” option must also be checked. (See Preferences> Invoices)
• If you get an error when exporting, usually you will get a message telling you what the problem is. Things to check include
• Is Moneyworks running …… it must be!
• Make sure the correct I.P address is specified if connecting to a remote machine on Macintosh.
• Make sure any charge codes used are actually present in the Moneyworks data file you are using. We can supply a version of mSupply that
automatically adds names to the Moneyworks data file if they aren't found when exporting, but this costs extra!
• Make sure that Moneyworks has open periods for the dates of the invoices that are about to be imported.
• If you still have no success, turn off the Link to Moneyworks. .. checkbox, and produce a file. Then manually import the records into
Moneyworks using the File > Import > Transactions command (making sure you load the correct import map using the “Load” button). The
file has errors, Moneyworks will give a more complete error report.
• Note that if export to Moneyworks is not successful, the transactions will not be finalised in mSupply, so you will not get invoices that are
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missed in Moneyworks.
We are also able to provide a similar option to link with Quickbooks accounting software. Please contact info@ss.org.np (mailto:info@ss.org.np) if
this is of interest to you.

FrontlineSMS tab
If you use FrontlineSMS for sending information to mSupply via SMS messages (using mobile phones), this is the tab where you enter all the settings.
For an explanation of this tab please go to FrontlineSMS preferences.

eLMIS tab
eLMIS is an LMIS tool used by some countries to collect and aggregate supply information from health facilities. If you use eLMIS, you can interface
your mSupply server with it using these preferences.

Use the eLMIS interface Check this box to enable the interface.
Interface Folder Click on the Choose… button to select the main folder that eLMIS and mSupply will use to share data.
Time between scans for new information from eLMIS Enter the number of hours mSupply will wait between checking the interface folder set
above for new files to process.
When the Use the eLMIS interface checkbox is checked it tells mSupply to check the Interface folder/Orders/Incoming folder every Time between
scans for new information from eLMIS hours for new order files to process.
Scan now button Click this to make mSupply check the Interface folder/Orders/Incoming folder for new files to process immediately. Useful if you
have manually put a file in the Interface folder/Orders/Incoming folder and want mSupply to process it immediately instead of waiting for the Time
between scans for new information from eLMIS interval set above to elapse.
Send errors to this email address The email address mSupply will send any error information to. This would normally be the address of your eLMIS
helpdesk.
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LDAP tab
This section is where you define the details of the LDAP (Lightweight Directory Access Protocol) server you are using to provide user authentication
for logging into mSupply. There is no need to fill in these fields if you are not using an LDAP server to check user logins:

Server URL or IP: enter the URL or IP address for your LDAP server.
Port no.: enter the port number your LDAP database is being served on.

The Dashboard tab
See the Setting up Dashboards chapter for a detailed description of the process

Stock tab
This section is where you tell mSupply which custom stock fields a user can fill in when receiving stock on a supplier invoice. There are 8 fields
available. Fields 1 to 4 are free text but fields 5-8 contain values which are selected from a list you define:

588

mSupply user guide July 2018

Each of the fields you tick the “Show” checkbox for will appear on the bottom of the supplier invoice line detail form when receiving stock. They will
appear with the label you give them in the “Display name” column (click once in the column to make the cell editable then type the name).
The values you enter in these fields (or select for the fields if it's one of fields 5-8) will be attached to the stock and follow it through the system. For
full details see Custom stock fields.
Previous: Statistics (HIS) Next: Purchase Order Preferences
2011/05/09 06:52

·

Purchase order preferences
There are two tabs of purchase order preferences in the File > Preferences… menu item.
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Purchase Order Defaults tab

This window allows you to enter text that will be printed on Purchase Orders.
The easiest way to see how these fields will look on a Purchase Order is to fill in the fields and then print a sample Purchase Order. Note that we are
willing to design custom Purchase Order forms to meet individual needs.
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Purchase Order 2 tab

Print signature section on Purchase Orders
When this box is checked a section will be printed on Purchase Orders that shows the authorising officer(s) and includes a space for signatures. This is
applicable if you print Purchase Orders and post them to suppliers, but should most likely be turned off if you send Purchase Orders via email.

Number of decimal places for price field:
This field allows you to specify the number of decimal places that may be entered in the price field on Purchase Orders. This will override the
currency format setting in tne Misc tab only for the price field on Purchase Orders.

Prefix printed Purchase Order number with
Enter any required prefix in this field

Default number of days usage to evaluate when creating an order
Enter the number of days to “look back” when evaluating each item's usage to calculate the amount of stock needed. Entering a higher number will
give a better long term average, but will mean that orders take longer to create.
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Purchase Order category must be chosen
Check if you need a Purchase order category to be chosen on every purchase order.

When clicking the OK button on a purchase order you can override this setting by
holding down the shift key as you click OK

Expected delivery date must be chosen:
Check if required, leave unchecked if not.

Show purchase order custom field
Check this box if you would like an extra field added that you can customise and use for your own purposes.
The space below this check box is for you to enter the name of your custom field.

Purchase order contract date must be entered
If you require this information on your purchase orders then check this box - this will force users to enter it when a purchase order is created.

Purchase order advance payment date must be entered
If you check this, the Advance paid field must be completed when a purchase order is created - a user will not be able to save a purchase order
without entering it.

Purchase order received at port date must be entered
If you check this, the Received at port field must be completed when a purchase order is created - a user will not be able to save a purchase order
without entering it.

Procurement is done centrally
This option is only relevant for a synchronised system (refer Remote Synchronisation). If you select this option, purchase orders for stores on sync
satellites can only be prepared, confirmed and finalised on the sync primary. There is a work-around if you need some stores on some sync satellites to
do their own purchase orders. For help with setting that up, contact support@msupply.org.nz (mailto:support@msupply.org.nz).

Labels for custom fields on Purchase Order categories:
Fields 1 and 2 accept text entries, field 3 accepts numeric entries. The use of these fields is optional.
Previous: General preferences Next: Invoice Preferences
2011/05/09 07:00

·

Invoices preferences
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Invoices 1

All invoices
Allow editing tax rate and amount on invoices:
When checked the tax rate can be changed when entering an invoice. Otherwise, the default tax rate is always used. (On supplier invoices the actual
tax amount can be directly edited if this option is checked. This allows perfect matching of tax amounts with amounts charged by a supplier).

Allow entry of dates on invoices:
Normally the confirm dates on invoices are read only and are filled in automatically by mSupply when the invoice is confirmed. If you need to enter
your own dates, check this option and the confirm dates will be editable. Note that you will not be able to modify the dates on finalised invoices.
The entry date is still maintained by mSupply. You can only edit the confirm date.

Export invoices to disk when finalising:
If this box is checked, each time you finalise customer or supplier invoices, a tab-delimited text file of the finalised invoices will be created. This
allows you to import the data into an accounting application.

After deleting lines, redo the numbering:
If this box is checked, deleting invoice lines will result in all invoice line numbers being updated so there is no gap in the numbering.

Activate budget module:
In order to use the Budget feature, this box must be checked. This feature is applicable to store mode only. For more information on the budget module
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see Customer Budgets

Activate Ad Hoc items:
Ad Hoc items allow you to receive and issue items that you will only use once. That is, you have ordered the item for a particular customer, and do not
want to hold it in stock. For further information, see Ad Hoc items

Round prices:
You can choose to round prices to a given number of decimal places. By default prices will be rounded to 2 decimal places.

Supplier Invoices
Allow editing margins on supplier invoice lines:
If this option is chosen, you can edit the margin for individual supplier invoice lines. Otherwise the margin will be locked at the margin set for that
supplier in the window for editing supplier details (reached from the supplier > edit supplier menu.)

Hide batch number & expiry date entry:
Some people use mSupply for inventory control of all sorts of general goods. Hiding these fields will speed up entering information if you do not use
those fields.

Item margin overrides supplier margin on supplier invoices:
When receiving an item where there is a margin set for both the supplier and the item, if this option is checked the item margin will be used. If
unchecked, the supplier margin is used.

Activate supplier payment module:
Check this box if you want mSupply to record the outstanding amount to be paid on each supplier invoice. If this system is not activated, supplier
invoices will display a zero amount outstanding. (If you use a separate accounting system, and us mSupply's export facilities, there is no need to use
the inbuilt payment system).

Warn if expiry less than XXX days:
An appropriate figure can be entered .

Disallow "Remove hold" status if zero sell price:
If this option is checked you can't receive goods that haven't had their sell price set.

Sell price changes affect un-finalised customer invoices:
If you tick this, when you update a sell price the change will be reflected in all non-finalised customer invoices. You will be asked to confirm ticking
this box because it can make irreversible changes to customer invoices. Here is a table that shows the differences with having this preference turned on
or turned off
Original invoice
Item
Amoxy 250

Date
15 Feb

Invoice type
Supplier invoice

status
cn

price
8.00
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Item

Date

Invoice type

status

price

Amoxy 250

15 Mar

Customer invoice

cn

8.00

Amoxy 250

15 Apr

Customer invoice

cn

8.00

Amoxy 250

15 May

Customer invoice

fn

8.00

With preference turned off
Item

Date

Invoice type

status

price

Amoxy 250

15 Feb

Supplier invoice

cn

9.00

Amoxy 250

15 Mar

Customer invoice

cn

8.00

Amoxy 250

15 Apr

Customer invoice

cn

8.00

Amoxy 250

15 May

Customer invoice

fn

8.00

You have found that the price should have been 9.00 No customer invoices are updated. Reports on old customer invoices will show the old price of
8.00
With preference turned on
Item

Date

Invoice type

status

price

Amoxy 250

15 Feb

Supplier invoice

cn

9.00

Amoxy 250

15 Mar

Customer invoice

cn

9.00

Amoxy 250

15 Apr

Customer invoice

cn

9.00

Amoxy 250

15 May

Customer invoice

fn

8.00

You have found that the price should have been 9.00 Old customer invoices are updated unless their status is “fn”. Reports on old customer invoices
will show the new price of 9.00 (as long as no invoices were finalised)

Show inner and outer pack fields:
If checked, mSupply will allow the entry of the `inner' and `outer' pack sizes - if an item is packed 100 to a container, and 12 containers to a box, the
`inner' field entry would be `100' and the `outer' field entry would be `12'

Hold invoices by default:
If checked all newly created invoices will be on hold

Allow tracking of received stock by donor:
If checked, this option allows the user to track donated stock from source (supplier Purchase Order) to store (available for distribution in mSupply).
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Invoices 2

Customer invoices
These options apply to customer invoices only.

We run a backorder system
Check this item if you want to record backorders for customers for supply at a later date (For suppliers, backorders are recorded in the ordering system
as partially supplied orders).
Note that if you use a backorder system it will affect the way “placeholder” lines are handled.
A placeholder line is a line entered on a customer invoice which does not have any stock associated with it. Placeholder lines can have an item name,
a quantity, and a pack size, but the batch number is set to “none”.
When you confirm an invoice, if you are using a backorder system, placeholder lines will be transferred to make backorders. If you are not using a
backorder system, placeholder lines will be deleted if the option below is turned on.

Auto-issue customer backorders when stock arrives
Check this item if you want stock to be automatically issued to a customer with a backorder when it becomes available.

Show transport details
If this box is checked, then a transport details button will be shown on customer invoices, allowing editing of transport details (arrival dates, etc) and
box numbers.
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Allow placeholder lines on customer invoices
If you leave this box unchecked, all lines on an invoice will have to be actual stock. If you run a backorder system you must check this box.

Show notes in store mode
If this box is checked, the window for issuing stock will be enlarged to show the area to enter abbreviations and customer directions or notes under
store mode. These notes print on invoices after each invoice line.

Show direction entry in dispensary mode
If this box is checked, the window for issuing stock will be enlarged to show the area to enter abbreviations and customer directions or notes under
dispensary mode. These notes print on invoices after each invoice line.

Activate customer receipts module:
Check this box if you want mSupply to record the outstanding amount to be paid on each customer invoice. If this system is not activated, supplier
invoices will display a zero amount outstanding. (If you use a separate accounting system, and use mSupply's export facilities, there is no need to use
the inbuilt payment system).

Show item category while issuing goods:
If you are making use of the item category facility, checking this box will allow you to see the category of the item you are issuing as it is being
issued.

Show 'nw' transaction created by user on log-in
If you check this box then, after a user has logged in, if there are any customer invoices created by this user that are still at 'nw' (new) status then they
will be shown a message:

Clicking on the OK button will take the user to a list of their nw status invoices and they can double-click on any of them to edit as usual:
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Handy for helping invoices to not get forgotten!

Choose contact for transport details
Checking this box allows you to choose a contact from your list of contacts when entering transport details.

Show 'Add from BOM' button
Checking this box allows you to create an invoice using a Bill of Materials. The function inserts placeholder lines from BOM into the invoice - see
here for details.

Show custom transaction fields:
There are 4 customer transaction fields available for customised entries; their use is optional, and should you wish to use them, they have to be
activated here, where the Show custom transaction fieldscheckboxes should be checked. You will note that they are grouped in pairs, 1 & 2 and 3 & 4,
and this is also the window which allows you to define names for the fields; for example, you might wish to identify the person preparing the invoice
and so give field 1 the name “Prepared by”; similarly the person authorising the invoice could be entered in field 2, which would be named
“Authorised by”.

Warn if expiry is less than XXX days:
Entering a number in this box causes mSupply to alert the user when any item selected is due to expire before this number of days has passed.

Disallow issue of goods with short expiry:
If this option is checked, mSupply will not allow issue (customer invoices, prescriptions) of goods with an expiry date less than the number of days
specified here. Goods with no expiry date will not be affected. Note that once this preference is checked, there is no way for the user to override it- the
rule is enforced until the preference is turned off.
Enter zero in the field to disallow entry of goods that have expired.
Note that inventory adjustments and supplier credits can still be issued to remove goods from stock or return goods to a supplier.

Activate restricted item access by customer group:
When this check box is checked, any item that is assigned to a department may only be supplied to customers who are members of groups linked to
598

mSupply user guide July 2018

that item's department.
See the section in the Item Menu chapter on the Manage item access… for more information on how to set up item departments, customer groups, and
how to link groups to departments.
Warning: Checking this item may mean that some items can not be issued. Make sure you have set up the item access system properly before
proceeding.

Delete placeholder lines when confirming invoices:
When checked, placeholder lines are deleted when the invoice is confimed.

Print the following message for placeholder lines:
When this box is checked, the message typed in this field will be printed in the batch column for placeholder lines. For example, you might enter
“backorder” to show these lines will be backordered. If you check the box and leave this field blank , the batch field will be empty.

Require category entry on customer invoices
If this option is checked, when entering customer invoices the user will be required to select one of the available transaction categories. Transaction
categories are set up using the Special > Show transaction categories menu item. If no transaction categories for customer invoices have been set up,
this option will have no effect.

Hold invoice by default
Invoices will be put on `hold' if this box is checked.

Customer order written date must be entered
If checked, the Order written date field on a customer invoice (on the Transport details tab) must be filled in - if it isn't the user will be shown an
alert message and asked to fill it in.

Customer order received date must be entered
If checked, the Order received date field on a customer invoice (on the Transport details tab) must be filled in - if it isn't the user will be shown an
alert message and asked to fill it in.

Other invoices
Allow customer to enter stock balances and request on stock history
Checking this box allows a customer to enter the quantity of stock they have and mSupply will file it as part of their stock history and calculate how
much needs to be sent to them to replenish their stock.

Invoice Printing preferences
Please see Printing preferences
Previous: Purchase Order Preferences Next: Printing Preferences
2011/05/31 09:21

·
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Printing preferences

Preferences related to the printing of invoices appear in this window, allowing users to customise the printing of customer invoices.

Don't print placeholder lines on invoice
Check this option if you don't want placeholder lines to appear on your printed invoices.

Don't use label printer for prescriptions
Check this option if you want to use a normal printer (not a label printer) to print prescriptions.

When printing a pick list...
Sort by...
This refers to how the items on the list are ordered. You can choose to sort by
• line number: the order in which they were entered
• shelf location: which will enable a “logical” order for picking goods from the shelves
You can also set a priority for shelf locations, and this will override the default alphabetical ordering i.e. locations with a priority of 1 will come first
(in alphabetical order), then those with a priority of 2 etc., with priority 0 locations at the end. See Locations and location types for more details.

Print separate pick lists for these locations
By default mSupply will print a single pick list for all locations. If, for instance, you need separate pick lists printed for cool store items (whose
locations in your store start with “CS”), and for Dangerous drugs (whose locations in your store all start with “DD”), you would enter “CS,DD” (no
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quotes, each location separated by a comma) in this field. If a pick list being printed contains CS items, they will be printed separately, and the same
for items with a ”DD” location.

Edit messages on printed forms
If you would like to print a particular message on one or multiple printed forms you can do that here. Choose the appropriate form from the drop-down
list (menu), and then click the Edit button to edit the message that will appear on the bottom of every form of that type. For example, you may use the
special invoice for issuing narcotics, and have the following message:
*
*
*
*
*

I have received the above Narcotics.
Signed:.........................
Print name:..................
Position:.......................
Date:.............................

A message on a pick list might be as follows:
* Packed by:..................
* Date/time:..........................
* Checked by:........................

When you have written the message, click OK and you can either add another message to another form (choose another one from the drop down list)
or move on to another preference.

Other
Print customer statement balance on invoices
If this item is checked and you are using the mSupply cash receipts system, the outstanding customer balance will be printed at the bottom of each
invoice.

Default header/footer on reports
There are two spaces here. In one you can enter the header that you would like to appear on reports by default. The text will appear on the top left
header for most reports. A common use of this space is to include your organisation name.
In the other you can enter the default footer. Text you enter here will appear on the bottom centre space of each page of reports. You might use this
space to include a confidentiality clause on your reports.

OK and Print

Checking these boxes means that the printing checkbox will be checked by default when the corresponding window is opened.
Note that you can still manually turned the option on or off in a window- these settings just affect the default value.
Previous: Invoices Preferences Next: Setting up Dashboards
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2011/05/09 06:53

·

Setting up dashboards

In versions up to 3.9 dashboard setup was accessed from preferences. The following instruction are for versions prior to 3.9. For
versions 3.9 and above please use the instructions here: https://docs.msupply.org.nz/web_interface:dashboard_setup
(https://docs.msupply.org.nz/web_interface:dashboard_setup)

Before the settings in this section will work you must make sure your webserver is currently running. See Webserver. Most users will find it easier to
request mSupply support to set this up for you.
Before you set the dashboard up you must:
• know what ports are already in use on the server
• have an appropriate SSL Certificate set up. Sustainable Solutions can help with this if needed.

To setup the dashboard:
1. Check the “We use the web dashboard” checkbox.
2. In the Dashboard web URL field enter the base URL to reach the dashboard on e.g. http://dashboard.msupply.org:2048/
(http://dashboard.msupply.org:2048/) (i.e. everything up to 'dashboard' in the URL you browse to - don't forget the trailing slash (/)
otherwise it won't work!)
a. if you are running from localhost, use your IP rather than http://localhost (http://localhost) both here and in the browser
b. the URL users type in to the address bar of their browser to access the dashboard will be this URL with “Dashboard” on the end
3. Tick the reports in the Is active column to select them for display on your dashboard.
4. You can choose how often these reports are updated by clicking in the Update Period (mins) column and entering a number of minutes.
5. Setup which reports appear on which tabs. See the Dashboard tabs section below for details.
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6. Setup which if the dashboard reports each user can access. See The dashboard for details.

Editing Dashboard Reports
Double-click a report in the list shown above and the following window will open:

If there are any properties shown in the list, these can be edited to change what is displayed.
To edit a property or value, click once to select the row, and then click again in the appropriate cell to edit it.
To add or delete a row use the New line and Delete line(s) buttons at the top of the window.
In the example shown in the screenshot above (a map report), the coordinates of two of the map corners and the item code of the item whose stocks
will be shown on the map have been entered. Note that if you add extra properties to the default reports they'll be ignored.
See the section below for details of the various dashboard reports available and the settings that can be edited.

What the dashboards show and what can be edited
There are several built-in dashboard reports that everyone can use. Here's what they show and what properties can be edited to change what they
show:
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Report name

Property

Value

VEN items in stock: Shows stock on hand of each VEN (Vital, Essential, Necessary) category. Not split on the basis of items. (Method:
dashboard_rep_item_ven)
None

None

Total stock value: A single figure in your default currency, showing the total value of the stock you have in the store you are viewing the
dashboard for. (Method: dashboard_rep_total_stock_value)
None

None

This month's transactions: Shows a bar chart of the number of purchase orders, goods receipts, supplier and customer invoices created this
month. (Method: dashboard_rep_month_transacs)
None

None

Expiring stock: Shows the cumulative and monthly number of all items expiring within the year, split into columns by month of expiry. (Method:
dashboard_rep_expiring_stock)
None

None

Top facilities supplied: The 10 customers in your store to which you have sent the greatest value of stock in the past 90 days. Shows the value of
stock for each customer. (Method: dashboard_rep_top_facilities)
None

None

Transactions per store: Shows a table of all transactions per store within the past 7 and 30 days (Method: dashboard_rep_month_transacs)
store_tags

A comma-separated list of tags - or omit this parameter if you want to show
stock for all stores.

Vital items in stock: Shows a bar graph of the percentage of medicines of the chosen category in stock at each facility. (Method:
dashboard_store_stock_percent)
ven_category

v or e or n if you want to include items that are Vital or Essential or
Necessary

user_field_4

TRUE if you want to include items with this field checked

user_field_7

TRUE if you want to include items with this field checked
Note that the labels for fields 4 and 7 may be different, as they are set up in
the mSupply preferences (misc tab)

critical_stock

TRUE if you want to include items with this field checked, false for all items

store_tags

entering healthcentre will only include stores with the “healthcentre”
tag

Map stock on hand: Shows a map of the area specified, with an “X” if the facility is out of stock of the item, or a dot representing the amount of
stock on hand. (Method: dashboard_map_stock_on_hand)
lat_nw_corner

the latitude of the North-West corner of the map
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Report name

Property

Value

long_nw_corner
lat_se_corner
long_se_corner
item_code
country
store_tags

the longitude of the North-East corner of the map
the latitude of the South-East corner of the map
the longitude of the North-East corner of the map
the item code of the item to display
compulsory parameter
A comma-separated list of tags - or omit this parameter if you want to show
stock for all stores

Sync sites last connection date: Shows the last connection date and current mSupply version of each sync site. (Method:
dashboard_report_last_sync_date)
None

None

Sync sites sent and received statistics: Shows number of records sent and received by each syc site within the last day. (Method:
dashboard_report_sync_stat)
None

None

Stock_for_category_1_stores_by_item_list: Shows… (Method: -)
None

None

Trends in critical stock: Shows the historical stock on hand using parameters to filter store and/or items. Will show the current percentage, and
percentages from the last day of each month for the prior six months. (Method: dashboard_rep_in_stock_trends)
store_id
critical_stock

the ID of the store you're interested in, or no value for all stores
TRUE if you want to include items with this field checked, false for all items

Output: use the type “time_series_chart”
Reports Monthly Transactions Shows how many transactions of each type the chose store has processed this month (Method:
dashboard_rep_month_transacs)
store_name

the name of the store which you are interested in, or no value if you want all
stores

Items Issued This Month: Shows items issued by the facility within the last 30 days. (Method: dashboard_itemRow_storeCol_usage)
store_tag
master_list
period

include stores with this tag
include items on this master list
30 ( currently only 30 days is supported)
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Report name

Property

Value

Stock each item in each store: Shows a table of items in rows and stores in columns, with the stock on hand for that item in that store in each
cell. (Method: dashboard_rep_stk_StoreCols_Itm)

store_code

store code attached to the store. multiple stores can be specified by adding
more parameters that begin with store_code (e.g. store_code2). The
item_code parameter must be specified if using store_code

item_code

items whose code matches this code (append “@” for a “starts with” search)

master_list

selected master list of items. Category1_description must be specified if
using a master_list

Category1_description

Items with this category1

Unfinalised Stock Transfers: Table of unfinalised stock transfers (between mSupply stores) for each facility. (Method:
dashboardReportUnfinalisedStock)
store_tags
days_older_than

(optional) A comma-separated list of tags - or omit this parameter if you
want to show transfers for all stores.
(optional) show only transactions that are older than this value (days).

If you can't make a dashboard report that does what you want then please speak to us, it's usually a fairly simple matter for us to create one for you.

Dashboard tabs
You set up Dashboard tabs which will display on your dashboard. Dashboard tabs are “containers” for one or more dashboard reports. To edit them go
to File > Preferences and click on the Dashboard tabs tab on the left hand side:
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To add a tab click the Add button. To edit a tab, double-click it. You will be shown a window for editing a dashboard tab:

Now you add reports that will show on this tab.

Understanding Rows and Columns
Take this example dashboard tab:
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• The tabs themselves occupy their own space on the left of the window- they aren't considered when laying out the dashboard
• The first row has two reports- each report takes up half the row. So for the first report:
◦ Row 1, Col 1, width 12 (“12” means it takes up the full width of the cell it is in- “4” would mean it would take up 1/3 of the
width)
• For the report at the top right:
◦ Row 1, Col 2, width 12
• For the map
◦ Row 2, Col 1, width 12
• The next two reports are on the same row, but are divided into 5/12 and 7/12 of the width of the window, so we put them in the same cell
but change the width settings:
◦ Row 3, Col 1, width 5
◦ Row 3, Col 1, width 7

To add a report to a Dashboard tab
Click New Line to add a new report to the tab. Then edit the values in each column
• Row: The row it will be in
• Column: The column within the row- set to “1” if you don't have multiple reports on this row.
• Report tite: The title that will show in the Orange heading bar for the report. Note that the same report can display different information
depending on the parameters you set for that report- hence the need for the ability to customise report names
• Type: You'll need to know the appropriate type for the report you're displaying. The options are
◦ bar_chart
◦ table
◦ pie_chart
◦ time_series
◦ map
◦ line_chart
• Width: The fraction of the cell width in “twelfths” that this report will take up (“6” will make it take up half the cell width)
• Report: Choose the report name from the drop-down list of available reports

Add a dashboard tab to a user's dashboard
This is the final step in setting up dashboards: once the tabs have been setup you have to choose which users will see which tabs. You do this in
individual users' settings. See managing users for instructions on how to do this.
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Previous: Printing Preferences Next: Entering a New Logo
2016/09/12 07:25

·

Entering a new logo
Select File>Preferences. On the left hand side choose Logo.
If you want this logo to be printed on invoices then tick the box.
Copy your image onto your clipboard (control+c) and paste into the area provided (control+v). Be careful to use an image of the aspect ratio 16:10 (16
wide to 10 high) as mSupply will stretch the image to fill the available area.
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Previous: Setting Up Dashboards Next: Synchronisation
2011/05/09 06:54

·

Synchronisation
Note that the main page describing synchronisation is Remote Synchronisation
Synchronization is the process whereby mSupply maintains data integrity between a 'primary' mSupply server and 'satellite' mSupply servers. It
therefore only applies to situations where there is a multi-mSupply server setup.
• The primary server will maintain a master list of names and items which are 'pushed' to the satellite servers. Items and names can only be
added, deleted or modified on the primary server.
• The primary server can be configured to maintain a copy of stock and transaction data from the satellite servers as well as its own. This
allows a user on the primary server to run reports on data from the primary and satellite servers.
• Satellite servers can also be configured to maintain a copy of stock and transaction data for other stores in the system. This data is all routed
through the primary server.
• Transaction and stock records for any store in the system can only be added, deleted or modified on the server on which that store is
'Active'.
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General
These settings will normally only be changed by Sustainable Solutions. They are not intended for general use by customers.
Click to Un-lock button: Altering these preferences can have serious consequences for your mSupply® data so they are protected by an authorisation
code. Click on the 'Click to Un-lock' button and you are presented with the following screen:

To continue and edit the synchronize preferences enter your authorisation code in the box and click on the OK button. To return to the preferences
screen without unlocking the synchronize preferences click on the Cancel button.
Sync time interval: This is the time interval in minutes between requests for new information that the satellite servers make to the primary server.

Synchronize parameters
Sync ID: The ID of the current store to use in the synchronization process. You choose this - a number between 1 and 64. This must be unique to each
store to be synchronized. ID 1 is reserved for the primary server (so, if this is the primary server put 1 in here).
User name: Communication between the primary and satellite servers is authenticated. This user name and the password field must match what the
primary server is expecting. So, you can enter any valid username and password in these fields but they must all be the same for the primary and
satellite servers.
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Password: See above.
Sync with:

This list contains the names of the servers to synchronize with. If this is the primary server all the satellite servers will be identified in this table. If this
is a satellite server then the primary server only will be identified in here. Click on the '+' button to add a server to the list (takes you to another
window where you enter the Sync ID, Name, Store and URL for the server to synchronize. Note that these values, except URL will have been entered
in this page on the servers hosting the stores selected. Make sure you enter the right values! The URL field contains the full URL of the server hosting
the store to synchronize) and the '-' button to delete a server you have selected in the list.
Previous: Entering a New Logo Next: FrontlineSMS
2011/05/09 06:52

·

FrontlineSMS
If you use FrontlineSMS for sending information to mSupply via SMS messages (using mobile phones), this is the page where you enter all the
settings.
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The settings and what they mean are as follows:

We use FrontlineSMS:
Checking this makes mSupply periodically check the FrontlineSMS database for messages that have been sent to mSupply. If this checkbox is left
unchecked, mSupply ignores all the settings on this page and will not check the FrontlineSMS database for new messages.

FrontlineSMS database (MySQL) settings
To use FrontlineSMS with mSupply, FrontlineSMS must be configured with a MySQL database. In this section you tell mSupply the details of this
database to enable it to connect to it and retrieve new messages.

Server:
The name of the server hosting the FrontlineSMS database. You can enter the server's name e.g. myserver.mydomain or its IP address.

Database name:
The name of the FrontlineSMS database. This is the name it was given when it was created in MySQL.

User:
The username that mSupply will use to log into this database.

Password:
The password that goes with the username above.
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Port:
The port that the database is served at on the host. If you leave this blank, mSupply will set it to the default port used by MySQL (3306).

Test Connection Button:
This button will test the connection to the FrontlineSMS database using the settings above. You should click it after you've entered all the settings or
when you change any of them. It will tell you whether the settings allowed mSupply to connect to the database.

If a connection cannot be made to the database when clicking the Test Connection
button, the exact error message returned from MySQL is stored in the log. To view
it go to Special > View log. This can be very handy when trying to figure out why
you can't connect to the FrontlineSMS database.

Check database every //x// mins. for new messages:
This is the time in minutes between checks of the FrontlineSMS database for new messages. The minimum is 2 minutes and if you don't set it, this is
the value it will be given.

Message settings
Keyword to identify mSupply message:
This is what mSupply looks for at the very beginning of an SMS message received by FrontlineSMS to identify it as one that it must process. Can be
made up of any alphanumeric characters. Keep it short and unique - not something that will appear at the beginning of any SMS messages not
intended for mSupply.

Error Messages and Notifications
Because the process is otherwise silent, mSupply needs to notify users when a new message has been processed or if errors occur in the process (e.g. a
message is missing some information). mSupply will email such error messages and notifications to the users ticked in the list in this section. The list
contains all users in the system and you must select at least one of them.
Previous: Synchronisation Next: Reports Basics
2012/06/08 10:45

·

Report basics
Click Report , and this menu appears:
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For some reports, the default setting includes all items, and as most stores will
have several hundred items - maybe over 1,000 - reports on all items will, if
printed, use a great deal of paper. If you must have a printout of your report, please
exercise caution when selecting the criteria, and so avoid wasting paper.

Reports on purchasing are displayed when Purchasing is selected:

Reports on items and stock are displayed when Items and Stock is selected:
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Reports on debtors and creditors are displayed when Debtors and Creditors is selected.

Many reports are available from the Reports page of the Navigator, as shown below:
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Many of the reports present you with a window like this before printing the report:

This window allows you to set various options:

Report destinations
Printer: Select this option to display.the print window. The preview of the report can be displayed by turning on the print preview.
Open in Excel: If the Open in Excel box is checked, mSupply will immediately open the report as a spreadsheet in the spreadsheet application (MS
Excel, OpenOffice/LibreOffice Calc etc.) you have installed on your computer.
• When this box is checked, you will first be asked to save the report. Once you have given it a name, the report will be saved, and then
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automatically opened in spreadsheet form.
• mSupply automatically detects any spreadsheet application you have installed on your computer (i.e. any application that is associated with
.xls or .xlsx files). You do not have to set the location of this application.
Save to HTML file: If this option is selected, your report will be saved with extension “.html”. Hence, it can be opened by any web-browser or
spreadsheet application on any platform or operating system.
Save as Text file: Your report will be saved to a file as a tab-delimited text file. (That is, a tab character between each column and a return character at
the end of each row). After saving, you can open the file in a spreadsheet or word processing program.

Header and footer
You can choose what information will be displayed at the top and bottom of each page. The default report heading is set according to the report you
are printing. By default, the date will print on the left and the page number on the top right of each page.
If you have filled in a default header and footer in the Preferences, these will be displayed at the top left (for the header) and the bottom centre (for the
footer)

Preview on screen before printing
This option turns on print preview. Note that you can also turn on print preview from the print window that is displayed after you click the OK button.
Previous: General preferences Next The PagePro Report Editor
2011/04/19 07:21

·

Manage Reports

Choosing this item shows a list of built-in reports and any custom reports which have been added to your system:
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The built-in reports may well be sufficient for your needs, but mSupply's versatility allows you to add and manage custom reports to meet any specific
requirements you have.

Options in the Report Management window:
Delete selected reports
Report(s) no longer required may be selected and deleted from mSupply

Duplicate report
Should one of the built-in reports not quite meet your needs, you have the opportunity to create a duplicate of that report, and then modify it to meet
your needs. The first step is to select the closely matching in-built report; in our example we'll use the expiring_items_date report, then click on the
Duplicate report button;
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the window that appears has already selected a name for your report, using the name of the in-built report prefixed by “ my_ ”; you may change this
name should you wish. The Permissions drop down list allows you to specify users having access to your report; the options are All users , or Only me
. Should you wish your report to become the default one rather than the in-built report, then check the Make default checkbox. When you click on OK,
the report you have just created now appears at the foot of the list of reports from the item on the menu Report>Manage reports.

Edit report
The editing of reports using the powerful editor has been extensively covered earlier in this section.

Using the report editor is complex, but it has the potential to produce a wealth of useful information. Contact Sustainable Solutions for a link to
download a separate manual on the subject.
Note that in a multi-user installation, changes you make to a report will affect all users, so don't change a report without some forethought.

Add report
Click on this button, and the following window appears:
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Report type: Select the type of report you are going to add; PagePro if it was created using the PagePro editor, Quick Report if it was created using
the Quick Report editor (shown in the Edit report section above) or PPro Multiple if you want to select 2 or more previously created PagePro reports
to be printed out at the same time.
Custom name: Enter the name the report will have in the system. Users will select this from the appropriate list to run the custom report.
Permissions: Defines who has permission to edit this report, you only or everyone who has the Edit reports permission (“All”). Normally you would
set this to “All”.
Type of form: This defines where your report will appear in the system i.e. its context in the report manager list (Note: this only applies to PagePro
reports, not Quick reports - Quick reports do not have a type). For example, if you select “Pick list” then the custom report will be available when a
printing a suggested status customer invoice, if you pick “Supplier invoice” it will be available when printing a supplier invoice. If your custom report
should be available as a normal report and not for some specific purpose in the system then select “Report” here.
Comment: Enter anything here that you want to remember about the report or to help you recognise it in the future. The comment will only appear in
this window, when you open it to edit the settings of the report in the future.
Make this report default: Check this box if you want your report to be the default one of this type for all users of the system. You would check this
if, for example, you were adding a new supplier invoice printout that everyone should use.
Report file: This is the actual file containing the report. Locate it on your computer using the Open button.

Revert selected reports
This button allows intrepid souls to save face by undoing the damage they have done to a particular report! The report that was installed with mSupply
will be reloaded from the disk, and any changes you have made to the version stored with the data will be discarded.

Revert All
This button returns all in-built reports to their original state when you installed mSupply; exercise caution when using it. Custom reports which you
have designed are not affected.

Save selected reports
All reports are automatically saved by mSupply in the default folder. There may be occasions when you wish to save one or more reports on a
removable storage medium - e.g. a pen drive - and this button allows you to do this; a window appears allowing you to specify the location in which
you wish to save the selected reports.
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2017/08/14 21:09

·

The PagePro report editor
• As of version 3.03 mSupply includes the PagePro report editor.
• The graphic below shows the standard mSupply pick list being edited in PagePro.
• It gives almost unlimited customisation possibilities for forms and reports.

Due to security issues, report customisation via PagePro can only be done by
Sustainable Solutions. Contact us for more details

Previous: Report Basics Next: Custom Reporting Tutorial
2011/05/19 11:09

·
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Custom reporting tutorial

The custom report window is displayed allowing you to create a report according to your own requirements using the Quick Report editor; once
created you may save the form of the report in the custom reports folder for future use.
The window requires you to make three choices:

Report table
A list of tables on the left to choose which table (which type of records) you want to report on, e.g. Names, Items, etc.
As of version 1.6 there are two options for transaction lines. The “Transaction lines (Transaction query)” option allows you to search much faster on a
large number of transaction lines. For example, if you are wanting to get the quantity of each item given to customers in a specific month, you would
use this option.

Which records
A series of radio buttons to choose which records to examine
• All records
• New search (query), if you want to report on records meeting specific criteria. If chosen, you will be presented with the Query (search)
editor, where you can build search statements to your heart's content! A short description of using the query editor is given below, and two
example searches are later described. For a more comprehensive description, a range of books is available either in electronic or hard copy
versions. Please email info@msupply.org.nz for more information.
• The “Current selection” is the group of records that were last displayed. For example, you can use the Item | View or edit item command
quickly to find all items starting with “a”. When you click the OK button, the items in the list are the “current selection”. If you are not sure
which records represent the current selection, you should click the “new search” radio button.
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Report form
A drop down list displaying available options
• New report
◦ After clicking the OK button you will be presented with the report editor where you can design a report. The report editor is
somewhat complex, but time spent in learning how to use it is time well spent. It is a powerful and invaluable feature. A brief
introduction together with designing two simple reports are given in Designing a Report below, and more details are available in
training courses on using mSupply, and in publications available from Sustainable Solutions.
◦ If you want to save a report or search (query), you can save them on your hard disk, and retrieve them next time you run the
report.
◦ If you save the report you have created in the Custom reports folder it will show up in the report form drop-down menu on
future occasions when you choose custom report.
◦ The default location for saving your custom reports is My Documents\mSupply\custom reports; it is important to note here that
any custom reports you have created should not be saved in the My Documents\mSupply\Reports folder, otherwise problems
may arise.
• New label layout
◦ presents you with the label editor, where you can design and save label layouts. These are useful for use with names for
addressing envelopes, and with Items for making tags for labeling shelves in your warehouse.
◦ If you choose this option the “Order by” window will appear after a query. This allows you to sort the records into a particular
order before printing labels. (In a nutshell: Drag fields from the list on the left to the list on the right to use them for sorting)
• Other items in the menu
◦ if you have saved any reports in the custom reports folder they will be listed here.
A list of the fields in each table, and what each field contains is to be found elsewhere in the guide. Field descriptions are here

Using previously saved layout
Any report layouts which you have used previously, and saved, may be accessed by clicking on File >Open on the menu bar, and selecting the
required layout.

Using the Query Search editor
There are now many reports included in mSupply®, but there may still be occasions when you require a report that we have not included. The query
editor is a bit daunting, but is very powerful and once you are familiar with its capabilities, your competence to access the precise information you
may require from within the mSupply database will increase significantly.

When you open the Custom Report editor, it is ready to take input values for a simple single line query.
1. The field to query. Choose this by clicking on the Find drop-down list which allows you to also choose fields from related tables. If you
want to perform related queries, see note below.
2. The Comparator. Choose the comparator from the list of fields by using the middle drop-down list.
3. The Query value. Is entered in the third box. In the example above, the field chosen is an alphanumeric field (the item ID), so an entry
area is displayed where you can enter text or a numeric value - in this instance the item code “amox” has been entered. Note that you can
also use the “@” symbol as a wildcard in your query value to perform “contains” queries.
4. The Conjunction. This does not apply to the first line of a query, but the second and any further lines need to start with a conjunction. Set
the conjunction for the selected line by clicking the appropriate button in the left area of window ( And, Or or Except )
To add lines to a query, click the Add Line button.
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Related queries: If you want to perform related queries, you need to know a little
about the internal structure of mSupply data. Please contact us if you would like a
diagram of the table layouts. A simple example of a related table is that each
transaction line is related to a transaction (many to one relationship). The means
that you can use the information stored in the transactions table (eg invoice date,
number, status, etc.) to query transaction lines.

If you have created a complex query that you might wish to use on future occasions, you can save it to your hard disk and select it again using the
Save and Load buttons in the window.
Once your completed query is entered, click the Query button to proceed.
For more detailed information on the Query search editor see: http://doc.4d.com/4Dv16R6/4D/16-R6/Query-editor.300-3561635.en.html
(http://doc.4d.com/4Dv16R6/4D/16-R6/Query-editor.300-3561635.en.html)

Designing a Report
The designing of two custom report is now described:
1. listing in alphabetical order the small number of items which may be supplied to staff or customers who wish to make a purchase without a
prescription. These items have already been identified by making use of their User field 2, which contains the entry “Retail permitted”.
2. listing the sources (suppliers) and the distribution (customers) of a particular batch number of an item - useful if a manufacturer recalls a
particular batch of an item.
It is recommended that you study both examples, as features described in the first example will not be repeated in the second.

Report 1
Having selected Custom Report from the Reports page in the Navigator, you are presented with this window:
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For our example report, we select the Items table, and to perform a New Search, using a new report form, so with these options selected, the window
now looks like this:
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Click OK, and the Query Editor window appears, as shown in the upper figure below; this is where you specify the criteria on which you wish to
create your report - in our simple example, the single criterion is that there should be stock on hand of the item. In the lower window, we have
specified this by:
1. clicking on user_field_2 in the Available Fields panel on the left,
2. clicking on contains in the Comparisons panel on the right, and
3. entering “Retail” in the Value panel below.
You will see that the conditions we specified now appear in the upper panel - it's always a good idea to check here to confirm that the report will
conform to your specified criteria.
Now click on the Query button in the lower right corner.
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The Quick Report window appears; this is where you can design the layout of the report, and specify how you want the records to be sorted:

We'll start by taking a closer look at the Quick Report features.
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There are two operation modes available which generate two specific types of
reports: List and Cross table . Our examples are limited to the List mode. The
Cross table mode will not be described.

In the List mode, reports typically display records as a list with break rows where calculations are performed.
When you create a quick report, you can specify the following:
•
•
•
•
•
•
•
•
•
•

Columns that display fields or formulas, either from the current table or from related tables.
Sort levels and order.
Summary calculations.
Display format.
Text for labels.
Formats for numeric and Boolean data.
Font, font size, style, and justification for labels, summary calculations, and data.
Background colours on a cell column or row basis.
Borders, Page headers and footers.
Presentation style from a wide range of templates.

1. Master Table: This is the master table that will be used as a basis for generating the report. The fields of this table are displayed in the
Fields list and the related fields will be displayed in relation to this table.
2. Fields list: This list lets you select the fields to be inserted into the report by double-clicking or by drag and drop. You choose the type of
display in the Field selection list located just above the area. Indexed fields appear in bold. You can also display and select the fields of
related tables.
3. Column dividers: These lines show the boundaries between columns of the report. They can be moved manually to enlarge or reduce the
size of each column. Manual resizing deselects the Automatic Width option if it has been activated for the column concerned.
4. Cells: A cell is the intersection of a row and a column.
5. Scroll bars: You use the scroll bars to view parts of the quick report design that extend beyond the area of the quick report form.
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6. Sort list/Sort order display area: This list displays the fields of the report on which the sort will be carried out, as well as the sort order
and whether it will be ascending or descending. Each field inserted into this list causes a sub-total row to be added in the Quick Report
area.
7. Quick Report area: This area lets you build your report by inserting fields using drag and drop, double-clicking or via the contextual
menu; you can also adjust the width of the columns added, or delete breaks or formulas, define the colors and borders of cells, etc.

1. Title row: This row displays the names of fields or formulas that have been inserted into the report. It is repeated for each page of the
report. The Quick Report editor inserts field names by default, but you can modify the contents.
2. Detail row: This row contains information drawn from each record and is repeated in the report for each record. You can associate a
display format with it, depending on the type of data represented.
3. Subtotal rows: These rows display intermediate calculations as well as the wording that is associated with them. A row is created for each
sort order.
4. Column data sources: These titles indicate the source of the data for each column.

Contextual menus
The Quick Report editor has contextual menus that make it easy to access certain row, column, and cell operations. Instead of making menu selections
or working with the Cell or Column properties areas, you can perform certain operations by displaying a Quick Report contextual menu.
There are separate contextual menus for row, column, and cell operations.
To use a contextual menu:
1. Position the pointer in a cell, a row title, or a column heading and hold down the right mouse button (on Windows) or press the Control key
while clicking in the report area (MacOS).
A contextual menu appears. The commands in the contextual menu depend on where your pointer is (i.e., a row label, column heading, or
cell). Also, menu commands that are inappropriate for the particular row, column, or cell are disabled..
2. Choose the desired menu command:
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Selecting Rows, Columns, and Cells
When designing a Quick Report, you need to select rows, columns, and cells in the quick report form. A cell is the intersection of a row and a column.
• To select a row: - Click on the Title, Detail, Subtotal, or Grand total cells in the row label area.
• To select a column: - Click the Header row of a column.
• To select a cell: - Click the cell.

Adding and Modifying Text
You can add or modify text in the quick report form to label parts of the report. For example, if you requested summary calculations, you can label
them by adding text to other cells in the Subtotal and Grand total rows.
You can add and modify text as follows:
•
•
•
•

Edit the text that automatically appears in the Title row of the report,
Insert text in empty cells of the Subtotal and Totals rows,
Insert the value of a Subtotal field in the Subtotal rows,
Specify the font, font size, justification, and style for any text that appears in the report.

Returning now to our first report, we want two columns only, the first listing the items in alphabetical order, and the second confirming the entry in
User field 2. This is achieved by double clicking on item name in the list, and then to have the list sorted alphabetically, make sure item name remains
highlighted, and click on the green arrow in the centre:
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The second column in our report will show the present stock of each item, and the same procedure is followed; select the user_field_2 entry in the list,
and double-click on it. You should be aware that items which are presently out of stock will not appear in the report.
The Quick Report window should now look like this:

The column widths can be adjusted as appropriate by positioning the cursor on the dividing line between the column headings, clicking and dragging
to the left or right until the desired column width is obtained:
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The vertical red line to the right of the columns indicates the right hand edge of the page as it will be printed, so to keep the report to single page
width, columns should be positioned to the left of this line.
To preview on screen the report as it will be printed, click on File on the menu bar, and select Print Preview. Our example is very brief, but in reality,
reports may run to two or more pages, and you can scroll through the pages of the report. This shows how our simple report will appear:

The printed report may benefit from shading or colouring of alternate rows, and this is achieved while the report format is being set. In the Quick
Report editor, click on Detail to highlight the row, then click on the Alt.background colour icon, and a chart appears from which you can select the
colour(s) of your choice.

For our report, pale yellow has been selected for the alternate row colour, and the report now has this appearance:
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Adding report title
You may want to give your report a title to appear at the head of each page; this is achieved by clicking on File , then Header and Footer ; a window
appears in which you can create and/or edit such a header You will most probably want the header to appear in the centre of the line, and in this case,
type your entry into the Center panel in the Text Settings area; here you can also select the font of your choice, and features such as bold, underlined,
etc.; these apply only to the header, not to the body of the report. A title has been added to our example:

To print the report, click on File on the menu bar, and select Generate and - provided that your printer is connected, online and loaded with paper your report will be printed.

Report 2
The second report lists the sources (suppliers) and the distribution (customers) of a particular batch number of an item - useful if a manufacturer
recalls a particular batch. The item chosen for our example is Metoclopramide 10mg tablets, the code for which is Metclp10, and the batch no.is
BN1234
Having displayed the custom report window, this report requires us to select the trans_lines table, and to perform a New Search, using a new report
form:
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When the Query Editor window appears, expand the [Items] table, and once expanded, move down the list until code appears, and select it by clicking
on it;the upper panel now shows [items]code , the default comparator is equalto ,and so to complete the line, move the cursor to the Value entry panel
in the lower part of the window and enter 'metclp10'. Click on Add Line and accept the default conjunction And ; In the Available Fields panel, shrink
the [Items] table, expand the [item_lines] table and select batch, accept the is equal to comparator, and enter 'BN1234' in the Value entry panel. You
have now defined the criteria for the report, and the Query Editor window should look like this:
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You are now ready to click on the Query button.
The Quick Report design window appears, with the Master Table - in this example the 'Transaction lines' table - expanded for selection of the fields
required by our report; we'll be using four fields from the master table, namely item name, batch, pack and quantity; double-click on each of these in
the list, and the Quick Report design window should appear as shown:
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Don't be concerned at the order in which these fields appear in the report - we'll rearrange the order once all the fields have been selected. The fields
we now need to add are in other tables; presently Master Table is selected ,and we need Related Tables , which is selected from the drop-down menu.

The table to access is the Transactions table, and the fields we require are Invoice number, type, and confirm date. Double-click on each, then expand
the Names table, and double-click on [names]name.
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All eight fields for the report are now selected, and we can arrange them in their required order. This is easily performed by selecting the column to be
repositioned - we want the item name to be the first column, so we select it by clicking on the column heading, and move it by clicking on the 'Move
Left' icon.

Select and move the columns using the 'Move Left' icon and the 'Move Right' icon until the column order from the left is:
•
•
•
•
•
•
•
•

Item_name
Batch
Name
Type
Invoice_num
Confirm_date
Pack_size
Quantity
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The report will look better in landscape rather than portrait form, so click on File > Page Setup , and select landscape Once you have done this, you
can view your report on screen by clicking on the 'Print preview' icon.
The next steps are :
1.
2.
3.
4.

to sort the report
to perform some simple calculations
to display this information.
to adjust the column widths

All these are simple to perform on the Custom Report window:

1. Sorting the report. Drag and drop in the 'Sort order' panel the parameters required - in this example [Transactions]type and [Transactions]
confirm_date.
2. Performing calculations and displaying the information. We need to count the number of transactions, and display the totals involved.
Observe the two rows added to the report annotated with the sort parameters followed by 'change'; these are the break points in the report,
and the results of any calculations are displayed in these rows ….. here's how:
a. position the cursor in the Invoice column on the [Transactions]type changed row
b. click Cells on the menu, and check Count; we need to know how many customers have been supplied with this batch, so the
Count icon is inserted in the row - it does not matter which column has the Count icon - for the time being it is entered in the
'Invoice' column, and the reason for this will soon become apparent.
c. also required is the total quantity ordered, and the total quantity distributed, so the cell in the same row but in the Quantity is
selected, and this time the Sum box is checked in the Cells drop down list.

1. Column widths can be adjusted as described earlier, and having a look at the Print preview will enable appropriate widths to be defined.
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The report should now appear something like this:

Only two tasks remain! It's not necessary to display the Invoice type, so this column may be hidden - right click on the column heading, and from the
contextual Column menu, click on 'Hide'.
mSupply® by default enters the field name in the displayed column heading, but you can edit these column headings by double clicking on the cell in
the 'Title' row, when an insertion point cursor appears and the current entry is highlighted; you can replace the default text with whatever you consider
appropriate. This has been done in our example.
Finally, there is a large selection of presentation styles available, any of which can be applied to your report. On the menu bar, click on Style >
Presentation. In our example, after defining a header for the report, we have opted for Report 1, giving our report the appearance you see below.

At some time in the future, you may wish to run your reports again. You should, therefore, save a copy of each report in the Custom Reports folder;
this is performed by clicking on File on the menu bar, and selecting Save or Save as, giving the report a name, and saving it in the Custom Reports
folder, or any other appropriate location of your choice. Then when you're ready to run the report next time, having specified your criteria in the Query
Editor, when the Quick Report window first appears, click on File on the menu bar, select Open, and retrieve the desired report from its saved
location, preview it and print it.

Using custom methods in Quick Report Columns
Sometimes you will need to use a custom method in a column to extract data from a related table.
The following methods are available.
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Method

Description

date_day_number_to_text

returns 1 for Sunday, 2 for Monday etc.

qr_account_code_return

Returns the account code of an item

Parameters

item_id

qr_flag_value_change
qr_get_currency
qr_get_current_patients_stat
qr_get_item_store_field

return value of field as text

1:item.id 2:“price” or “is_in_catalogue” or “sellprice”

qr_get_location-from_key
qr_get_loc_from_key_new_process
qr_get_Name_code_from_key
qr_get_stockOnHand_from_itemKey
qr_get_store_name
qr_keep_accumulative_value
qr_ns_customer
qr_responsible_officer
qr_ship_method
Previous: The PagePro Report Editor Next: Items and Stock reports
2011/05/16 08:59

·

Items and stock reports
When Reports > Items and Stock is chosen, a range of available reports are displayed; click on the one you require to select it:
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Opening Stock
In the early days of mSupply, this report was designed to show the stock at the start of the financial year; it is dependant upon having Set the start of
year stock, a topic covered in the Special Menu section of the guide. The report produced lists the stock at the start of the year.
If you have not used this Set the start of the year stock feature we suggest you consider using the Stock on date report, entering the first day of your
financial year as the date, and selecting Stock at start of the day.
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Current Stock

A report will be produced that lists each stock line that is currently showing stock greater than zero. Should you wish the report to include items/
batches with zero stock, the box in the lower left needs to be checked.

Item filter
A “Find” report allows you to enter the normal item find criteria to choose which items to include.
A random report allows you to enter a number only. That number of items will be randomly chosen, and stocktake sheets for those items printed. This
facilitates spot checking of your actual stock situation.

Additional options
Should you wish the report to be department specific, then that department should be selected from the drop down list of the departments which you
have created.
Should you wish the report to give information on a particular location, then that location should be specified , selecting the appropriate operator of the
three available in the drop down box alongside the Filter by actual stock location option.

Report format
You can choose from three formats:
• “Each batch shown separately” will also give you a column on the right where, having done a physical stocktake, you can enter the quantity
that is actually in stock, allowing any corrections to be made in mSupply.
• “Total stock for each item” will not show individual batches, but the total quantity on hand of each item.
• List the price of each batch in stock, with a total at the end of the report.
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The lines are reported alphabetically either by item name or shelf location, depending on what you have chosen in the “Sort report by” options

Donor Reporting
mSupply provides the feature of printing the Donor name on the Current Stock report so that organisation donating the goods can be identified and
tracked.

Stock on date
This report allows you to produce a report for the stock in your store on a particular date. You are shown a window like this:

Enter the date for which you wish to show the stock.
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Type of report
You have 3 options:
1. Show items only: each item in your system will have a single entry with the total quantity on that date.
2. Show items with batches: each batch, its expiry and batch number along with the quantity of stock will be shown.
3. Show batches with summary: as 2, but every item has an aggregate line before the lines for each batch, showing the total quantity for all
batches of the item. So it's a bit like a combination of 1 and 2.
The Report on items whose box allows you to restrict the report to certain items only, using item properties or different categories as filters.

Open report in Excel
Check this checkbox to view the report directly in your chosen Spreadsheet program.

Show total stock value

This report is used to find the total stock value either for a particular department or all departments. The drop down menus allow customisation of your
report by entering appropriate search criteria from the many options.
Check this checkbox to directly open the report in Excel rather than printing.

Graph: stock by item
This report shows a graph for an item or items showing the quantity of stock on hand for each day over a defined period.
Note that if you have allowed editing of confirm dates on transactions, mSupply's ability to calculate accurately the data used in this report may be
affected.
Choosing this item from the menu displays this window:
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Enter the date range, or select the required period from the drop down list, the items on which you wish to report, and appropriate filters, if any.
Remember you can use the item flag field to select an ad hoc list of items to include in your report.
Clicking OK displays a window where you are shown a graph of the quantity in stock on each day for the first item that matched the criteria you
entered.

This window also displays a list of items that were found. To display the graph for a different item, choose it from the list.
This report can be used as one of a set of key indicators for performance of a facility by comparing days out-of-stock of key items from one year to the
next.

Graph: total stock
The total stock graph report allows you to view the value of your stock over a desired period of time. When you choose total stock graph, you are able
to enter the required period which you would like to view:
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Select OK and a graphical stock history report showing stock value will be displayed
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Item list

This report allows you to view an on-screen or printed list of items.
There is only one report layout listed in the window, but please tell us what you would like, and we'll consider adding it.

Local/Remote Report
This option will only show “local data” as an option unless you purchase a web services enabled version of mSupply, in which case you can view
reports from remote locations running mSupply. Contact us for more information.

Items out of stock
Selecting this report displays this window:
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Specify your required options from the drop down lists;

Days out of stock
Selecting this report displays this window:

Specify your required options from the drop down lists; the desired period may be identified either by entering dates in the From and To fields, or by
using the drop down list to the right.
Clicking ok will generate a report like the one below:
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Clicking the Complex find button opens the Query Editor, allowing you to enter specific criteria relating to your search.
You may also specify what level in percentage terms of the maximum stock should be considered as being “out of stock..” Here's an example over 1
month:
Day
of
month

1

2

3

4

5

6

7

8

stock
on
hand

20000

20000

20000

2000

1000

500

300

200

30000

m(

This day
had
maximum
stock. 5% of
30000=1500

Out of
stock

m(

m(

9

10

11

12

13

14

25200

20200

18000

18000

18000

Note the 5% stock out level = 1500

Item usage
This report gives you a breakdown of item usage for the last few months, with summaries for the last 2 years, It also includes stock on hand and stock
on backorder for each item in the report.
The report produced is very useful for forecasting or for seeing a list of items that need to be ordered.
When you choose the menu item you are shown a window like this:
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Your can choose the type of report you want to run from the drop-down menu

This menu includes an item usage report, a suggested ordering amount report, or to auto generate a tender from the drop-down list at the top. This
form is used for all 7 functions. For now, leave this as it is (Note that the Item usage report with pending purchase order option will show you item
usage with details of items currently on order and their expected date of delivery).
If you want to report on all items, leave the item name field blank:

otherwise enter an item name or code. For example, to report on amoxycillin stocks, you could enter “amox” into the field.
Depending on the entry in the first field, further options are available in the following two fields, but these will vary according to the entry in the first
field. Among the options, he first field allows you to make your selection from the names given to custom item fields in the Preferences if this feature
has been used.
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If you wish to use shelf locations, then select the shelf location option and specify the desired shelf.
You can use the drop-down list to find Items with a particular code, or to use the values you have entered into one of the custom user fields. If this isn't
powerful enough, use the complex find button to display the full query editor.

Click the refresh button
to calculate the number of items these basic parameters will find. This screenshot shows that 17 items meet the
parameter specified, i.e. items whose names begin with 'pro';

Only include items whose stock cover is less than...
If you want only to report on items whose stock is low, enter the threshold for days of stock on hand into the second field. For example, entering 90
into this field will only include items in the report whose stock is not sufficient to cover average usage for the next 90 days.
Enter “0” (zero) for this field to report on items with any amount of stock remaining.

Include items with no usage in the last 12 months
If this box is checked, items with no usage over the last year will be included. This check box will have no effect if the previous “days cover” field is
filled in, as an item with no usage will have “infinite” cover- any stock you do have is going to last you forever!

Include usage for build ingredients
If you manufacture items, you can choose whether the use of ingredient lines in manufacturing is included in the report or not.

Open report in Excel
Checking this box opens Excel (or any installed spreadsheet) and displays the report directly. If you want to save the report, choose File > Save as… in
your spreadsheet program.
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Item Usage Report Preview

Suggested Ordering Report

When in the Item usage report dialogue box, select the 'Suggested ordering report' option from the drop down box at the top left. Note the extra
options for including item usage when calculating item ordering quantities. Also note the option to include ordering for build items. See item builds
for more on built items.
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Suggested Ordering Report Preview

This report gives analysis per item and the final column provides a suggested quantity to order. It is then the responsiblity of the Purchaser to make the
final decision on how much stock to order.

Item usage with outstanding Purchase Orders
The window that appears when you choose this report is the same as the previous one; with exactly the same options available; the report produced
differs only in that any lines having outstanding Purchase Orders have the relevant details of the Purchase Order displayed.

Item slow movers
You will be shown a window to enter the item details:
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Enter your search criteria in the top section.

Item name field
• If you want a report for all items, leave this field blank. Otherwise enter some text to reduce the report to just a few items (e.g. entering
“am” will produce a report of just the items whose name starts with “am” (Amitriptylline, Amoxycillin, etc)

Category and Department
• Use the drop down boxes as appropriate to select Category and/or Department if required.

Days stock
• Enter the number of days stock to report on. Items with more than this number of days stock on hand will be included in the report. The
correct figure to enter here depends upon your desired stock turn. In general, if you are turning over your stock 3 or 4 times a year, you
would want to know about items which have more than 240 days stock on hand.
• The report is calculated using the last 12 months usage as a guide to the average monthly usage.
You can check the Open report in Excel box to open the report in Excel, or any installed spreadsheet.
The report produced is very useful for managing under-performing inventory. It allows you quickly to obtain a list of items where a reduction in stock
is desirable.
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Expiring items

This report will ask you to enter a date, and will then give a report of all item lines in stock whose expiry date is before the date you have entered.
For example, entering 31/8/11 will display all items with expiry dates before 31st August 2011 (Enter the date in short format in the way your
computer is set to handle dates (DD/MM/YY or MM/DD/YY or YY/MM/DD).
You can additionally filter the stock by the location type or the actual location in the warehouse. This is helpful for reporting on items in certain
sections of your warehouse.
Three report type options are offered; select as appropriate. You may refine the search by using the Name filter and/or the Item filter..

Donor Reporting
mSupply provides the feature of printing the Donor name on the Expiring Items report so that the organisation donating the goods can be identified
and tracked. This can help with disposing of or returning goods to the Donor.
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Expiring items vs cover
This is a versatile report which allows you to see at a glance the amount of any stock items, and the number of days' cover provided by that amount of
stock you have. Note: The cover calculation uses the last 12 months of usage data to calculate your rate of consumption.

Many filters may be applied in the drop down lists, which are the same as described under Item usage… above.
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Note that If the field you are searching is a boolean field, e.g.Essential Drug List, “false” appears as the default entry, which you may change to “true”.

Cover Calculation
This allows the user to include or exclude specific categories to be used in calculating coverage. Clicking the magnifying glass to the right lists
categories to be chosen.
If you wish mSupply to remember the criteria which you have entered, click on the paperclip icon, and your selections will appear the next time you
open the report.
Once you have selected your required criteria, click on the Refresh icon to show the number of items which match your criteria, and which will,
therefore, feature in the report.
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Item Ledger

Ledger entries may be viewed in this report; different formats of report are available in addition to several filter options from the drop down lists, so
the report may be designed to meet your specific requirements.

Previous: Custom Reporting Tutorial Next: ATC based reports
2011/05/20 07:58

·

ATC based reports
ATCs and DDDs
“ATC” stands for “Anatomical, Therapeutic, Chemical”, and is a method of classifying chemical entities, and identifying them by category.
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“DDD” stands for “Defined Daily Dose”, and provides a means of comparing the utilisation of different drugs in a meaningful way. - e.g. if a
dispensary has issued 10,000 x doxycycline 100mg and 20,000 x amoxycillin 250mg, a greater number of amoxycillin capsules has been used; but
according to the DDD method, a greater number of patients have received doxyxcycline.
Thanks to the help of the WHO Collaborating Centre on Drug Statistics and Methodology, we are able to offer a starting drugs file with their codes;
we have plans (not yet implemented) to maintain on our website an up-to-date list of ATC and DDD codes for essential drugs.

Reports using ATC and DDD codes
mSupply is designed for the ATC code to be entered in the Category field for each item, and is then able to report on supply transactions, giving a
breakdown according to the different levels of the ATC code.
The DDD Factor field is intended to store the item's number of dose units in its DDD; for example, if an item's DDD is 1,000mg, and the supply is
made using 250mg units, the DDD factor is 4. When designing a report, the total quantity of this item used should be divided by the DDD factor to
obtain the number of DDDs supplied.
Should you wish to store an item's DDD value (1,000mg in the above example), it is suggested that you record it in one of the available user fields.
The DDD value should not be recorded in mSupply's DDD factor field
The category analysis report is designed to be used in conjunction with the “category” field and the “DDD factor” field for each item.

When you produce a report, only some simple criteria are entered in the form. It is a simple matter to create reports giving, for example:
• A level one ATC summary for all items supplied to a specific hospital during a 12 month period
• A level two ATC summary for all items in ATC category “J” supplied to customers who are coded as “h” (for hospital) for a particular
month.
• A level three ATC summary for all essential drugs supplied to all customers for a particular quarter.
The report provides you with the number of DDDs supplied for each category at the level requested, presuming you have “DDD factor” values entered
correctly. Only the totals for each category are shown (not each individual transaction). The report may be printed, or exported for use in another
application.
Let's run through the different options in the window… summary level…- enter the summary level. The category field is then evaluated based on the
ATC coding system. Note that the code is “broken down” as follows
level

position

1

character 1 (A-Z)
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2

characters 2 & 3 (01-99)

3

character 4 (A-Z)

4

character 5 (A-Z)

5

characters 6 & 7 (01-99)

So, for example the code for “caffeine” is N06BC01. “N” is the level 1 code, “06” the level 2 code, “B” the level three code, “C” the level four code,
and “01” the level 5 code.
Note that if you choose “level 3”, you will also be shown the summary values for “level 1” and “level 2” as well.

Which type of item?
You can report on all items, or you can report on just a certain category. For example, you can enter “J” here to report only on items whose ATC code
starts with “J”. Note that you need to set the summary level to “level 2” or your report will only report the total for category “J” without any further
breakdown of data.

Only report on essential drugs
Check this if you only want to analyze items whose essential drug check box is checked.

Transaction type?
- Normally we will be interested in supply to customers. However, we might also be interested in “what percentage of purchases from IDA (a supplier)
are aniti-infectives?”, in which case we would click on the “items received from suppliers”

Date range...
Enter a starting date and an ending date. Only transactions whose confirm date was within the range will be analyzed. The default range is the last 90
days. Note that the dates you enter are included in the range (that is the “from” date is “on or after” and the “to” date is “on or before”)

Which customers/suppliers...
Leave this value blank to report for all customers. Otherwise, choose “code” or “category” from the popup menu, and the appropriate comparison
from the second popup menu. For example, if you want to report on a certain group of hospitals, you could enter those hospitals as having a category
“h”, and then report on “names whose category starts with 'h'”
Previous: Items and Stock reports Next: Customer Ordered Shortfall Report
2011/05/20 07:47

·

Purchasing
Purchasing reports (focused on what you have ordered and what you have received and what you want to order) are available at Report > Purchasing.
The following report types are available:

The first 2 options contain several different reports (see below). Select the required report type by clicking on it.
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Purchase Orders...

Types of report
There are seven reports currently available:

• The Ordered Item Report will list items that are on Purchase Orders according to criteria specified.
• The Goods Received date vs Order date report lists each Goods Receipt for a particular Purchase Order and the number of lines received,
then follows with details of the number of lines and date of the original Purchase Order, as in the example below. This is useful for tracking
supplier delivery performance.
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• The Goods Received date vs Order date - Show items report:

Note that the number of lines received may not match the number ordered as a single Purchase Order line may be supplied in split deliveries, as in
example shown, or an ordered line may not be supplied at all.
• The Outstanding Purchase Order Lines report, which will display all Purchase Order lines for Purchase Orders provided that
(1.) delivery is incomplete, and
(2.) the Purchase Order has a Confirmed (“cn”) status.
• Note that Purchase Orders whose status is Finalised (“fn”) will be ignored when producing this particular report.
• The Goods Received date vs Order date - show Delivery days report shows the number of days taken to deliver items.
• The Purchase order vs goods received broken down by batches report shows the dates particular batches were received.
• The Purchase order cashflow planning report shows you the values and times of expected deliveries so that you can plan when money
needs to be available to pay for them.

Date range and date type
A date option, for selecting which items/purchase orders to include in the report must be selected; options are:
•
•
•
•

creation date - the date purchase orders were created
sent date - the date purchase orders were confirmed
expected delivery - the expected date of delivery for items
actual delivery - the actual date that items were delivered

The report will include items/purchase orderswiht the selected type of date falling between two specified dates entered in the From and To fields. The
dropdown list on the right affords many quick-choose preset date range options such as “today”, “yesterday”, “this week”, “last week”, “this month”
etc.

Report on names...
The report may be confined to suppliers meeting specific criteria by selecting one of several supplier properties (“Name”, “Name code”, “analysis”,
“category”, “Price code” etc.) in the left dropdown list, “equals”, “starts with” or “contains” in the centre dropdown list and making an appropriate
entry in the field on the right. If this field is left blank, the report will include purchase orders from all suppliers within the chosen date range.

Report on items...
Similarly the report may be confined to items meeting specific criteria; you choose an item's property to filter on in the left dropdown list followed by
the comparator in the centre dropdown list and finally making an appropriate entry is made in the field on the right. Again, leaving this field blank will
produce a report on all items within the chosen date range.
You can also report on items that have a certain category and/or department. By default these options are set to “Don't care”, which means the item
categories and departments will be ignored.
Note that only reports that report on invoice lines will produce meaningful results when you choose item criteria. Reports that report on whole
transactions (e.g. “Each invoice grouped by name” or “Each invoice grouped by date”) will not produce meaningful data, as any one invoice can
contain multiple items. Choose reports that report on invoice lines (e.g. “Each invoice line by item” or “Totals for each item grouped by month”) for
these filters to have an effect.
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Report on purchase orders...
In the same way, you can also filter your reports on properties of the purchase orders involved: category, status and both purchase order custom fields.
For more information on purchase order categories see here

Purchases...

This report finds all purchasing transactions over a certain value within a specified time period
You should enter:
• The date range of transactions on which to report
• Four filters are available to refine the report - a name filter, and three item filters; all are optionally and will be ignored if nothing is entered
in the textbox or drop down lists are left at “Don't care”.
• The value of a transaction line above which the report will cover.
It may be good for your organisation to have a purchasing policy that stipulates that transactions over a certain value must be authorised by a second
party (that is, someone other than the purchaser). This report allows you to monitor such a policy easily.

Suggested order quantities
Use this report for mSupply to analyse your current stock and, based upon a required number of days stock cover which you enter, suggest how much
of each stock item you should consider ordering. You'll see this window:
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If you want to report on all items, leave the item name field blank, otherwise enter an item name or code. For example, to report on amoxycillin
stocks, you could enter “amox” into the field.

The drop down list, after the item name and code choices, lists several other fields, including any user defined fields, where the names that you have
defined for custom item fields in the Preferences are displayed.
If you wish to use item categories, then use the Item category list to choose the one on which you want to report.
You can use the drop-down list to find Items with a particular code, or to use the values you have entered into one of the custom user fields. If this isn't
powerful enough, use the Complex Find button to display the full query editor.
Click on the refresh button (double orange arrows) to show the number of items these basic parameters will find.
Only include items whose stock cover is less than…: If you want to report only on items whose stock is low, enter the threshold for days of stock on
hand into the second field. For example, entering 90 into this field will only include items in the report whose stock is not sufficient to cover average
usage for the next 90 days.
Enter “0” (zero) for this field to report on items with any amount of stock remaining.
Expected delivery: Enter an appropriate date based on previous delivery times.
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Include usage for build ingredients: If you manufacture items, you can choose whether the use of ingredient lines in manufacturing is included in
the report or not.
Basis of analysis: Enter the number of months of data (form the current date) mSupply should use to calculate your consumption.
Exclude transfers from calculations: Check this box if you wish transfers within your organisation to be excluded from the calculations.
Include items with no usage in the last 12 months: If this box is checked, items which have not been used over the last year will be included. This
check box will have no effect if the previous “days cover” field is filled in, as an item with no usage will have “infinite” cover- any stock you do have
is going to last you forever
Order quantity for X months stock cover: In this field, enter the number of days stock cover you want to have available. The report will
automatically take into account any stock you already have, so all you need to do is enter how many days cover you want, starting from right now, in
this box.
Open report in Excel: Checking this box opens Excel (or any other installed spreadsheet application) and displays the report as a spreadsheet. If you
want to save the report, choose File > Save as… in your spreadsheet application.

Report output
Cover column: if the column prints “»»” this means you have no usage of that item, so you have “infinite” cover (i.e. if you don't have any usage
your current stock with last forever, from a usage point of view, if not from an expiry date point of view!)

Suggest order quantities with prices and price extension
This report is an extension of the previous one, allowing you to see what the suggested order will cost. The filter choices you have are the same as for
the suggested order quantities report.
Previous: Customer Ordered Shortfall Report Next: Transactions reports
2012/06/07 00:44

·

Customer ordered shortfall report
When you choose Report> transactions and then select Customer ordered short fall report , the transaction report like the one below will be produced.
This report is used only for sales to customers.
Note that for this report to make sense the preference Allow placeholder lines on customer invoices must be checked, and the preference Delete
placeholder lines when confirming invoices must be un-checked.
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From the report window, select the desired parameters and click OK . An example report is shown below.

Previous: ATC based reports Next: Purchasing

Setting up mSupply to use the Customer Ordered Shortfall report
For this report to be used, you need to do the following
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• Choose File > Preferences > Invoices2 and ensure “Delete placeholder lines when confirming invoices” is not checked.
• Staff must enter requested amounts on invoices as placeholder lines.
◦ For example, a customer orders 1000 x Paracetamol syrup 60ml. You have 800 in stock, so you add 800 to the invoice, and you
also add a placeholder line for 200 bottles.
• You need to decide whether to (and if yes, how) to use the backorder system. If customers can rely on you to record shortfalls as
backorders, then they will no need to re-order the shortfall in subsequent ordering cycles, as they know you will deliver it when available.

2011/05/20 07:51

·

Transaction reports
Transaction based reports are accessed by choosing the Report > Transactions… menu item or by clicking on the Transactions item in the
Transactions section on the Reports tab of the Navigator:

All these reports (and there are many!) summarise supplier or customer transactions in many different formats. Many different filters have been
incorporated, allowing filtering on transactions, names, prescribers, items, categories and departments. The filters that do not apply to different reports
are hidden as required. Feel free to mix and match and experiment with the filters and different reports to see the different views of information that
you can get.
The basic sequence for creating a transaction report is this:
1.
2.
3.
4.

Select the type of report you want from the Type of report list in the top left.
Select the date range of transactions you want included in the report in the Date range section.
Select the transaction type you want the report to run over in the Transaction type section .
Set any other filters/settings you need to refine the contents of the report (Transaction category, Name, Item, Stock, Prescriber filter etc.
sections).
5. Click on the OK button to run the report - you can select whether you export it to Excel or print it on the next window that opens (well,
mostly - some reports are exported to Excel only so you won't have a choice for them!).
See below for more in-depth detail on all these steps.

Standard transaction reports
This is the window you will see:
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Type of report
Choose from several formats for displaying transaction information by:
1. selecting the report type in the Report list on the left, and
2. choosing the required radio button under Transaction type
The following table lists the available report names, and gives brief details of the information provided by each report .
Report name

What it does

Each invoice grouped by name

The report will sort each invoice in the date range according to the name (Supplier or Customer) and
give totals for each name.

Each invoice grouped by date

As above, but totals given for each day.

Each invoice line by item

Lists each item supplied or received, and the transactions for that item. This report can be very long

Each invoice showing profit

The cost and selling price totals for each invoice are displayed.

Each invoice line grouped by item
department then item

The invoices are grouped by the item department assigned to each item. Each item department is then
sorted in alphabetical order by items

Each invoice line grouped by name

The total value of items received/supplied from/to each name

Each invoice line grouped by item
and then name

Invoice lines are all displayed, grouped by item and then, within those groups, by name.

Totals for each item category

The total value for each category will be displayed - each transaction will not be shown.
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Report name

What it does

Totals for each item

Each item that has been received (or issued) will be shown with the total quantity and value received/
issued

Totals for each item - Net Inventory
adjustment

Each item on which an inventory adjustment has been made is shown; the net adjustment is displayed,
with both quantity and value shown.

Totals for each name

The invoice lines for the chosen date range are grouped together for each name. This report allows you
to see quickly what has been issued to a customer or customers.

Totals for each item broken down by
name

Lists all items, showing their distribution to recipient customers or delivering suppliers

Totals for each name broken down
by item

As above, but listing customers or suppliers and items received by or delivered by them

Totals for each item department

The total value supplied/received for each item department is shown

Totals for each item grouped by day

The total quantity and value of each item is shown for each day.

Totals for each item grouped by
month.

The total quantity and value of each item is shown for each month.

Totals for each item grouped by item
description.

First the report is sorted by item then the total quantity and price of each item is shown. It also provides
a grand total for the item quantity and price columns.

2 period comparison by item
category

User selects two periods, and the transactions for each period form a column. The rows are determined
by the item category. This is a special report that has different input options. See entry below.

Prescriber report

This report allows you to view the total value, mean item value and item count for prescriptions
dispensed for each prescriber

Cross tab: items in rows, names in
columns, quantity in cells

These reports are like Excel pivot tables. Warning: they can be slow to produce if you have a lot of data.
Start with small date ranges until you are comfortable your machine can handle the load. Note that
reports that produce a lot of columns won't print well - it is better to export them to a spreadsheet and
print from there.

Cross tab: items in rows, names in
columns, value in cells

See above

Cross tab: items in rows, days in
columns, quantity in cells

See above

Cross tab: items in rows, days in
columns, value in cells

See above

Cross tab: items in rows, months in
columns, quantity in cells

See above

Cross tab: items in rows, months in
columns, value in cells

See above

Cross tab: names in rows, months in
columns, quantity in cells

See above
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Report name

What it does

Cross tab: names in rows, months in
columns, value in cells

See above

Distribution of quantities issued

First the report is grouped by item name and then by the pack size issued. It displays the total quantity
and total count for each item.

Totals for each item grouped by
transaction category then item

The report is grouped by each item's transaction category first and then by each item.The report shows
the total count, total quantity and total value for each item. Lastly it also calculates a grand total of the
items count, quantity and value columns.

Each invoice sorted by Name
>Address1 field then by name

The invoices are firstly sorted by the address1 field, and then by the name they were supplied to. This
groups invoices together by whatever you entered in the “Address1” field for each name - e.g. you
might enter the region or province.

Each invoice sorted byName
>Address2 field then by name

As above, but the first sort is by the entry in “Address2” field.

Customer ordered short fall report

Where there has been a short fall, this report shows the short fall of each item and of each item category
by quantity and percentage. It shows what demand from customers has been met and what has not. It
applies only for issues to customers.

Customer transaction report 1

This report and the following three are, in fact, templates, and are the starting point for designing reports
on specific criteria not covered in any of the existing reports.

Customer transaction report 2
Customer trans line report 1
Customer trans line report 2

Order processing time

If you are filling out the order written date and order received date for incoming customer orders, then
this report will show you how long it is taking for orders to reach the store, and how long it is taking to
process orders from receipt to order entry and to order dispatch

Transaction type
You can choose to report on:
•
•
•
•
•

Sales to customers (customer invoices: type “ci”)
Sales to and credits from customers (customer invoices & credits: type “ci” & “cc”)
Purchases from suppliers (supplier invoices: type “si”)
Purchases from and credits to suppliers (supplier invoices & credits: type “si” & “sc”)
Inventory adjustment - Add stock: All inventory adjustment transactions that resulted in stock additions (e.g. when you did a stock take
of an item and counted more on the shelf than the total shown in mSupply).
• Inventory adjustment - Reduce stock: All inventory adjustment transactions that resulted in stock reductions (e.g. discarding stock due to
it being expired). Note that using a report that shows the total for each transaction category can give totals for expired/damaged etc.
• Inventory adjustment - Net movement: Taking into account both reductions and additions, the nett change in inventory due to adjustment
transactions.

Date range
Enter the date range of transactions to report on, having selected Confirmed date or Shipping date. Note that the date used may differ from the original
entry date, depending on how your system is configured in the Preferences.
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• Note the popup menu to the right of the date entry fields that allows you to choose quickly from a list of common date ranges:

• Note that “last year” refers to the year preceding the current year (that is, if the current year is 2012, choosing “last year” will set the dates
from 1st Jan 2011 to 31st Dec 2011).

Transaction Category Filter
Assuming you have set up transaction categories, your report may be filtered by category. For help setting up Transaction categories click this link.

Name filter
You can enter a particular customer code or category of transactions to be displayed.
• You can choose from either equals for an exact match or starts with to search for all names whose code or category starts with the entered
text.
• Each name has 6 different categories that can be used to group certain kinds of names together. You can filter on category 1 (which is
hierarchical) using the Category 1 filter in the screenshot at the top of the page (note that the Category 1 text will be replaced with any
name you have assigned to this category in the preferences) and one of the other categories using the Category 2 filter shown in the
screenshot at the top of the page.
• If you want to report on transactions for a single name, you can find their code by looking up their details using Supplier > Show suppliers
or Customer > Show customers.
• There is also a Customer group filter you can use to include names based on their customer group.

Item filter
Here you can specify the items to include in the report.
Note that sometimes the item choice options will be hidden because the chosen report is reporting on transactions, not on transaction lines:
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Donor filter
If you have donor tracking turned on in the preferences, and choose a report that bases it's data on invoice lines, then you will be given the option to
filter the report for a particular donor or group of donors.

Which mode?
If you are using mSupply in both store and dispensary mode, you might want to report only on transactions in store mode (items distributed to
customers) or in dispensary mode (items distributed to patients). You can do this by checking Store mode or Dispensary mode radio button depending
on your requirements.

Exclude transfers from calculations
This checkbox enables you to choose whether you include stock transfers (where stock is transferred from one store to another in mSupply) in the
report calculations. If you want stock transfers to be included in your report then uncheck this checkbox. If you want stock transfers to be left out of
the report then check this checkbox.

The 2 period comparison by item category report
This report allows you quickly to compare sales or purchases for 2 periods of your choice based on item categories.
When you choose this report a different set of options is shown.
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Set the date range for each of the columns and then choose a summary level. It should be noted that if no data is present for the first period defined,
this report will not run.

Dot notation and summary levels
The summary level is based on the item category field. If you have set up item categories using dot notation, then you can summarise categories.
To set up item categories, choose Items > Show item categories
Take the following simple example of categories that have been set up as follows:
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The rules for dot notation are
• Separate each level of your hierarchy with a period (dot).
• Within a level you can have as many characters as you like
• You can use any characters, as long as you don't use a period or a space within one level; e.g. “surgical.gloves.small” is a valid entry.
(Level one is “surgical”, level two is “gloves” etc.).
• When the hierarchy part of the category name is finished enter a space character. You can then enter a description for that level of the
hierarchy.
If we run the report with a summary level of “none” each category is shown
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If we run the same report with level one chosen, only the first level of the hierarchy is shown. Items with categories 1.1 and 1.2 and 1.1.1 have all been
summarised under “1 Antibiotics”

And with level two chosen, items with category 1.1.1 and 1.1.2 are summarised under the heading “1.1 Penicillins”

Note that if you have items to which no category has been assigned, they are shown under the heading `none“ at the top of the report.
The categories are printed in the order that you have specified by drag-and-dropping in the window shown by choosing Item > Show item
categories….
Transaction filter: Filters the report for given category
Prescriber filter: Reduces the found transactions to those for the given prescriber only, depending upon the selection made (equals, starts with,
contains, is not equal to).
• Obviously only useful in dispensary mode.
Exclude transfers from calculations: The check-box Exclude transfers from calculations when checked will ignore transfers between stores within
the organisation.
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Exclude Ad Hoc and non stock items: The check-box Exclude Ad hoc and non stock items is displayed accordng to the type of report selected. By
default, it is checked.
When checked, the transaction report generated will not include any Ad Hoc items or non stock items (items you don't normally keep in stock).

Custom transaction & trans lines reports
These four reports should be regarded as templates for you to design your own report .
Having decided whether you wish to report on transactions or transaction lines, you need to design the report according to your specific needs. Coose
Reports > Manage Reports :
You are presented with the Report management window. In this example, our report will be on transactions, so you should highlight
custom_transaction_report_1 , and click onthe Duplicate report button:

Choose an appropriate name for your report, and any comment you wish, and click OK. You are returned to the Report management window, where
you should scroll down until you reach the report you have created; note that the name you gave the report will appear in the Custom name column;
highlight the row and click Edit report .
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This brings up the Edit report window. Creating custom reports is described in detail earlier in this chapter. See the Custom Reporting Tutorial

The Save Template Button
The save template button allows you to save a given report as a template once you have input your chosen settings. Templates can be reused as
needed.
Pressing the Save Template button brings up the following window:

This dialog allows you to set a name and description for the report template. You can also define user permissions: at the moment, you can define
these as ‘Public’ - for anyone, or ‘Private’, in which case the permissions only apply to the user who created the template.
• View Preferences: define which stores will be able to view and use the template on the ‘Manage Reports’ tab (next screenshot).
• Edit Preferences: define which stores will be able to edit or delete templates on the ‘Manage Reports’ tab.
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• Displays all template reports that the user has permissions to view.
• Allows user to use the template:
◦ Redirects user to ‘Create Report’ tab
◦ Settings here will be set according to the preferences of the template report
• Users can also edit, delete, and duplicate the reports if user permissions allow.
◦ Duplicated reports will be named ‘ReportName[duplicate]’
• Quick search searches in all text columns of the table.
Previous: Purchasing Next: Other Reports
2011/05/20 07:48

·

Other Reports
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ABC analysis

This report will rank the items based on the value sold in the period specified. Sometimes such a report is referred to as an “ABC” analysis or a
“pareto” analysis. Statistics show that 20% of the items supplied by an organisation usually generates 80% of the total value of sales. Therefore, it is
useful (and wise!) to concentrate first on the 20% of items that are most important. This report makes it easy to do just that.
You might be interested in what Wikipedia has to say about ABC analysis (http://en.wikipedia.org/wiki/ABC_analysis)
You need to enter the following information:
Number of items to include in report: Enter the number of items to be included in the report.
Date range: Enter the dates you wish here. Each item will have its “analysis” field updated with the total value of sales during the period specified.
Filters: Should you wish to apply filters to the report, three are available - for items, categories and departments.
Which mode: You can choose store mode, dispensary mode or both modes of transactions for inclusion in the report.
Exclude Ad Hoc and non stock items: If you check this box then Ad Hoc and non stock items will not feature in the report.
The report lists the number of items specified, ranked by value of sales, starting with the highest. The value of sales and the percentage of the total
value are also shown. Note that the total value is the total for the items in the report, not the total sales for all items. If you want to report on the total
for all items, set the Number of items to report on to a number greater than the number of items in your data file (Note that this may make the report
very long, but you can choose just to print the first few pages if you wish).

Management summary
This report is designed with line managers in mind, or other people who want to “keep their finger on the pulse” of their organisation but are not
interested in the fine detail!
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You'll be shown a window where you can choose a date range for the report:

The report provides the following information:
•
•
•
•
•
•
•
•

The total value of stock on hand
The 10 items with the largest stock value
The 10 items with the largest value of supply to customers in the date range chosen.
The 10 suppliers from whom you have purchased the most in the date range chosen.
The 10 customers to whom you have supplied the most in the date range chosen.
If you check the “Include section on expiring items” checkbox, a section will be included that lists:
The cumulative liability for expiring items for each of the next 12 months.
The 12 most valuable expiring items (or at least batches of particular items)

Preview on screen before printing
Check this box if you want to view your report on screen first.

Open report in Excel
Check this box to view the report directly in your chosen Spreadsheet program.
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Quotation Summary

There are two options in Report on section, namely: All quotations and Preferred quotations , and there are two options in Group together by section,
namely Supplier and Item
All quotations shows the quotations in which Preferred is set to “true or false”.
Preferred quotations shows only those quotations in which Preferred is set to “true”.
Supplier option displays the quotation report on the basis of supplier.The quotations for the items related to a particular supplier are listed along with
that supplier.
Item option displays the quotation report with the items arranged in alphabetical order along with the corresponding supplier's name.
In addition there are filters allowing you to narrow your search further by:
• limiting the report to suppliers meeting your specified criteria - e.g. the supplier's name code may be entered, so the resulting report will
display only quotations from that particular supplier.
• specifying criteria relating to the item by choosing from the many options in the drop-down boxes as shown below:
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There is an additional filter, the Date filter, allowing you to specify the dates on which the Quotations you are examining were created or modified,
and the radio button toggles display of the quotations' expiry date ( Quotation valid date ) on or off.

Sync Report
This report allows you to to track remote site activity. It is available from the special menu. The report is only visible in the menu if you're on a
primary server (the main server in a sync system).
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Debtors Creditors
The following reports are available:

Select the required report by clicking on it.

Debtors
This report will produce a list of all debtors. mSupply uses an open-invoice system of accounting for debtors, so the outstanding amount for each
debtor is displayed; for debtors with more than one invoice outstanding, the amount displayed is the cumulative total of all outstanding invoices.
Note that the total outstanding on invoices is not reduced for any previous overpayment by a customer, but this is listed in a separate column in the
report.
To remove overpayment amounts from the system, choose customer | new payment… and enter the name of the customer with an overpayment. You
will be asked if you want to use the overpayment amount for this payment. Choose use, then allocated the overpayment to outstanding invoices.

Creditors
Aged debtors
Customer statements
You will be presented with a window to find customers.

If you want a report for all customers, leave the entry field blank. Click OK and a report will be produced for any customers who match the criteria
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entered. Note that customers with no amount outstanding will not have a statement printed for them.

Transport Report
This report allows you to print information about the transport details for a range of invoices.
First you are shown a window where you can select a date range and choose to report on only invoices supplied by a particular method, by a particular
responsible officer, or to a particular name or names.

Click “OK” to run the report.
Note that transport details can only be entered on customer invoices if you have checked the “We use box numbers” option in the Preferences

Prescriber Report
This report (v1.93 onwards only) allows you to view the total value, mean item value and item count for prescriptions dispensed for each prescriber.
You will be shown a window with the normal date range options, and the option to report only on prescibers whose type field is set to a certain type.
Click OK to proceed.
The window that appears is the Transactions report, but you will see that the Prescribers report is highlighted.
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As usual, the report options window is shown where you can choose the destination and set headers and footers.

User activity totals
This report was initially made for use in dispensing situations where you want a quick count of the number of prescriptions and items issued in a day.
However, it is also useful for getting a quick view of workload for a month or a year in store mode. This report gives the number of supplier invoices
(or prescriptions) and the number of stock lines on them, reported by user.
Choosing this menu item shows a window like this (once you have selected a date range).
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You can drop down to view data by clicking on the green arrows. Alternatively, you can click on the printer icon on the bottom right and export the
full list to Excel.

Date range
You can either enter dates manually or choose from the drop-down list to the right of the date fields.

Time range
Enter times here in 24 hour format (e.g.. 9:00 in the “from” field and 17:00 in the “to” field. Leaving these fields on 00:00:00 will calculate for the
whole day.
To calculate totals, click the Show button. If there are a lot of transactions to evaluate, a progress bar will be shown.
Click the OK button to close the window when you are finished.

Backorder report
This report shows a list of Items that are not available or insufficient stock is present to meet the requirements of the order placed by the customer.
Information about the item code, item name, current stock, customer code, b/ord quantity is displayed.
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If you are running a backorder system this gives you a quick way to check if backordered items are now in stock so they can be supplied to customers.

Suggest price list additions...
Note: the price list menu items are for those organisations that produce a price list or price indicator. (It is useful to call your publication a “price
indicator”, as it implies the published price is a guide, and not a fixed price). You are asked to specify the number oftransactions and the number of
months (e.g. 2 transactions in the last 3 months) that would make an item eligible for inclusion in the price list. A search is performed using the criteria
you enter, and a list of items is shown that meet the criteria but are marked as not being in your price list. You can double-click on items in the list and
click their “price list” check box to add them to the price list.

Update price list
This item updates the prices of items from the item line on hand that has the most stock.
Only items whose “price list” check box is checked are updated.
Each line of stock is evaluated to determine which stock line you have the most of. That line is used as the indicator price for its item.
Note that if an item has no stock, then the price for that item will not be altered.
It is a good idea to run the “suggest price list additions” report first.

Price list
All items that are marked as included in the price list are placed in a report. If you wish to export to a text file, choose “save to disk” in the report
options dialog that is shown. Note: items that are in stock, but that are marked as not in price list will not be included.
The exported file has fields separated by tabs and records separated by returns. The field order is:
• Item
• pack size
• price.
If you wish to include different information, you can create a custom report to do this.

Location report
This report is available in version 1.96 and later.
This report lists the location description, type, capacity, used volume and percentage available. Choosing this menu item shows you the location report
filter options widnow as below:

The report may be restricted to certain locations by using specific search criteria. Choose either “Code” or “Volume” from left drop-down list is . The
centre drop-down list allows you to choose a comparitor.
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You have to make an appropriate entry on the right-hand field. Leaving the field blank means no filter will be applied.

Location type
It allows you to choose a location type. You can select the one from the drop-down list on the right side. The graphic of location type is shown below.

For example, you can specify the location type“COOL” to show only refrigerated locations.
Check the “open in Excel” checkbox if you wish to directly open the saved report in Excel (or any installed spreadsheet).
Click the OK button to run the report.

Manage Reports
Choosing this item shows a list of built-in reports and any custom reports which have been designed:

The built-in reports may well be sufficient for your needs, but mSupply's versatility allows you to manage the reports to meet any specific
requirements you have.

Options in the Report Management window:
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Delete selected reports
Report(s) no longer required may be selected and deleted from mSupply

Duplicate report
Should one of the built-in reports not quite meet your needs, you have the opportunity to create a duplicate of that report, and then modify it to meet
your needs. The first step is to select the closely matching in-built report; in our example we'll use the expiring_items_date report, then click on the
Duplicate report button;

the window that appears has already selected a name for your report, using the name of the in-built report prefixed by “ my_ ”; you may change this
name should you wish. The Permissions drop down list allows you to specify users having access to your report; the options are All users , or Only me
. Should you wish your report to become the default one rather than the in-built report, then check the Make default checkbox. When you click on OK,
the report you have just created now appears at the foot of the list of reports from the item on the menu Report>Manage reports.

Edit report
The editing of reports using the powerful editor has been extensively covered earlier in this section.
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Using the report editor is complex, but it has the potential to produce a wealth of useful information. Contact Sustainable Solutions for a link to
download a separate manual on the subject.
Note that in a multi-user installation, changes you make to a report will affect all users, so don't change a report without some forethought.

Add report
Click on this button, and the following window appears

Revert selected reports
This button allows intrepid souls to save face by undoing the damage they have done to a particular report! The report that was installed with mSupply
will be reloaded from the disk, and any changes you have made to the version stored with the data will be discarded.
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Revert All
This button returns all in-built reports to their original state when you installed mSupply; exercise caution when using it. Custom reports which you
have designed are not affected.

Save selected reports
All reports are automatically saved by mSupply in the default folder. There may be occasions when you wish to save one or more reports on a
removable storage medium - e.g. a pen drive - and this button allows you to do this; a window appears allowing you to specify the location in which
you wish to save the selected reports.
Previous: Transactions reports Next: The mSupply Web Server
2011/04/28 09:15

·

Introduction to web interfaces
mSupply data can be accessed through simplified web interfaces for a number of purposes. These web interfaces are simpler than the standard
mSupply desktop interface described throughout most of this documentation. These web interfaces allow users to communicate over the internet with
a store on your mSupply server. They are very flexible, being able to run on a wide variety of devices:
• desktop / laptop
• tablet (recommended for most applications)
• smartphone (practicality depends on screen size and resolution!)
and operating systems:
•
•
•
•
•
•

iOS
Android
Windows
MacOS
Linux
any other operating system

In fact, anything which can run a browser and can get an internet connection can use an mSupply web interface. It means that you can now use the
power of mSupply to manage stock at remote sites which don't have access to local IT infrastructure, except, of course, access to the internet!
We are continually developing the web interface services. For details on various components see:
1.
2.
3.
4.

The mSupply Web Server
mSupply Mobile Interface
The Web Stocktake module
Customer Interfaces
a. Mobile Customer Interface
b. The 'Last Mile' Interface (under development)
5. Supplier Interface
a. Uploading and Downloading Web Tenders
b. Supplier instructions for using the tender submission web interface
6. mSupply Mobile API
Next: The mSupply Web Server
2014/10/13 11:32

·

The mSupply web server
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About the mSupply web server
When mSupply's web server is running, it allows you to access mSupply data from any networked computer that has a web browser.
Security warning: We have had thousands of uses of our mSupply web server on the public internet since 2005. To date we have not had a security
problem reported. However, we recommend you use SSL and a proper SSL certificate if your mSupply web server is publicly accessible. mSupply
fully supports SSL. Contact us for certificate installation instructions.
The advantages of accessing mSupply in this way are:
•
•
•
•

It's easy. Most people are familiar with using a web browser.
It's low maintenance. You do not need to install any client software.
It's cost effective. Once you have purchased a web server licence an unlimited number of people can connect.
it's secure. The web serversupports access using SSL, the standard for securing internet connections, stopping any malicious snooping of
passwords or data.
• It allows customer access to information. The web interface built into mSupply can easily be customised to allow clients, supplier or other
interested parties to have restricted access to the mSupply information you wish to show them. We are also able to include order submission
by customers, making it easy for them to place small orders, and have real time information on stock availability.
• You can access mSupply from anywhere on the internet. Once we supply you with a password protected version of the web interface, you
can access mSupply data from any internet connected computer.
• It's fast over low bandwith connections. The mSupply web server allows you to provide access to mSupply from locations with only dialup acccess.
mSupply web server functionality is being continually expanded according to client requirements. We welcome suggestions for more features.

Activating the web server
The mSupply web server feature is not included in the regular mSupply licence; in order to use this function, an additional licence is required. On
application to Sustainable Solutions this can easily and swiftly be arranged.
For practice purposes, an evaluation version is available on our server - should you wish to access this, please contact us for instructions.
Choose File > Preferences, then click on “Web server” in the list.

You can choose to start the web server or have it start automatically when mSupply starts (see General preferences for more details on these
preferences).
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Technical note: By default mSupply is set to use port 8080. This is because the default port number for http access (80) on unix systems running
mSupply can only be used by applications that have root privileges, and we don't want you to have to run mSupply as root! If this is a problem, we can
supply you with an application that redirects traffic on port 80 to port 8080.

Setting up mSupply Desktop Users for mSupply Mobile
Your mSupply server needs to be set up for mSupply Mobile use. Follow these simple steps to get started:
1. Create a virtual store to hold the remote facility's stock.
2. Create new users for the store or give some existing users permission to login to it. Note: Make sure that only the users who will use the
mobile interface have permission to login to this store.
a. Note that the important setting for mobile access is the “Default store.” You'll need to turn on “store mode” for the store too, else
you can't turn on “Default store.” For example, here's user Debbie set up so that when she logs into mSupply mobile she'll be
logged into Tulagi Mini Hospital:

b. Note that other user permissions (on the Permissions, Permissions(2) and Permissions(3) tabs) only apply to mSupply Desktop
Users, not to mSupply Mobile Users.
3. For the steps below, refer to Virtual stores for detailed instructions
a. Make only the items which the remote facility will use visible in the new store.
b. Make only the names which the remote facility will use visible in the new store.
c. Ensure the store can receive transfers from the store that will be supplying it (This is done by ensuring that the receiving store's
name record is visible to the sending store)
d. Ensure “Pack to one” is turned on for visible items in each store.
Now you're ready - have fun!

Setting up a Customer's user to access the web interface
You can set up multiple Contacts for each customer.
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1.
2.
3.
4.
5.
6.

Find the customer by choosing Customers > Show Customers and entering part of their customer name to search for them.
View their details by double-clicking the customer's record in the list
Click the Contacts tab.
Click new to add a new contact.
Fill in a user name and password
Check the Can log into web interface checkbox.

Previous: Introduction to web interfaces Next: mSupply Mobile Users Guide
2011/05/07 03:18

·

mSupply mobile (browser) users guide - legacy version
What is it?
mSupply Mobile (browser) is a simplified web interface which allows you to communicate over the internet with a store in your mSupply server from
browsers on any mobile devices (smartphones, tablets, net-books, etc.).

While smaller screen devices will function, it is generally impractical to use
devices smaller than a tablet.

Features and Limitations
mSupply Mobile (browser) is simplified because it is designed for 'lower level' stores that do not need the full functionality afforded by mSupply
Desktop. Conversely, mSupply Mobile (browser) is generally not suitable for 'higher level' stores which require the features of mSupply Desktop.
In particular, mSupply Mobile (browser)'s features are:
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• Customers: Display a list of existing Customers and the Billing Address of any selected Customer. There is no facility to add, delete or
edit Customer data; this can only be done with mSupply Desktop.
• Customer Invoices: Display a list of existing Customer Invoices and details of any selected Customer Invoice. Customer Invoices can be
added and edited (lines can be added or deleted). Once created, Customer Invoices cannot be deleted.
• Supplier Invoices: Display a list of existing Supplier Invoices and details of any selected Supplier Invoice. Supplier Invoices cannot be
created with mSupply Mobile (browser). Supplier Invoices to a Virtual Store will generally be Stock Transfers from a higher level store,
coming from a Customer Invoice in that store. Supplier Invoices that have been finalised cannot be edited. Supplier Invoices cannot be
deleted.
• Items: Display a list of Items and simplified details of any selected Item Line, including, of course, stock on hand. Inventory adjustments
are carried out through a stocktake process - refer below.
• Stocktakes: Display a list of Stocktakes and details of any selected Stocktake. Stocktakes can be added, deleted and edited (lines can be
added, deleted and edited).
• Reports: A selection of reports can be emailed (by the mSupply server) to pre-specified email addresses.
Note: There is no facility to display, add, delete, or edit Supplier data; this can only be done with mSupply Desktop.

Batch number and expiry date are not displayed, selectable or editable in mSupply
Mobile (browser). These details are recorded, maintained and reported for the
store by the mSupply Server on the basis of the assumption that the store is being
managed in accordance with FEFO (First Expiry First Out).
Removing the need to handle batch and expiry date information dramatically
simplifies the management of stock in the store.

A word of caution
If like us, you've got a long history of drug medicine dealing, it's easy to get confused when a tablet can now refer to something you swallow, and also
to something you use to run mSupply. To avoid confusion, we've provided this handy chart :-)
Instruction

Applies to Medicines

Crush, then swallow

8-)

Swipe

(Don't! You'll get fired for this!)

Dissolve in water

8-)

Applies to computing device

Plug into USB charger
Keep in a dry place

8-)

8-)
8-)

8-)

Setting up mSupply Mobile (browser)
Your mSupply server needs to be set up for mSupply Mobile (browser) use. Follow these simple steps to get started:
1. Create a virtual store to hold the remote facility's stock.
2. Create new users for the store or give some existing users permission to login to it. Note: Make sure that only the users who will use the
mobile interface have permission to login to this store.
a. Note that the important setting for mobile access is the “Default store.” You'll need to turn on “store mode” for the store too, else
you can't turn on “Default store.” For example, here's user Debbie set up so that when she logs into mSupply Mobile (browser)
she'll be logged into Tulagi Mini Hospital:
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b. Note that other user permissions (on the Permissions, Permissions(2) and Permissions(3) tabs) only apply to desktop users, not
to mobile.
3. For the steps below, refer to the chapter on Virtual stores for detailed instructions
a. Make only the items which the remote facility will use visible in the new store.
b. Make only the names which the remote facility will use visible in the new store.
c. Ensure the store can receive transfers from the store that will be supplying it (This is done by ensuring that the receiving store's
name record is visible to the sending store)
d. Ensure “Pack to one” is turned on for visible items in each store.
Now you're ready - have fun!

Some general information before you start
When you ask the interface to do something it will mostly need to communicate with your mSupply server over your internet connection. We have
done our very best to make the communication as fast and smooth as possible but we're still limited by your internet connection (we're good but we
can't perform the impossible yet!). When mSupply Mobile (browser) is doing something and you need to wait you'll see this small icon appear:

When the icon goes away this means that mSupply Mobile (browser) has successfully finished its communication and what you asked it to do has
been successful (it won't specifically tell you that it was successful). If there was a problem doing what you asked it to do then the interface will show
you an error message (which will usually be caused by a problem with the internet connection).

Accessing mSupply Mobile (browser)
To access mSupply Mobile (browser), open a browser on the device you will use and type in the address of your mobile store. The address will look
like http://xxx.xxx.xxx.xxx:xxxx/mobile. e.g. http://192.168.10.3/mobile. Tap the return key and after a few moments the login screen will appear.
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You can add a web page to your home screen. If you're using Safari® then it's tap 1, then 2 in the following screenshot:

Using mmSupply Mobile (browser)
Logging in
You can't do anything in mSupply Mobile (browser) until you've logged in and this is where you do it. The credentials that you enter must already
have been set up on the mSupply server through a Desktop client. Once you've entered your username and password, tap the login button and you'll be
taken to the navigator.
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The navigator
This is where you see all the things you can do in mSupply Mobile (browser). Tapping on a row in the navigator will take you to that function. This is
what it looks like:

Tap on:
•
•
•
•
•
•
•
•

Show Customers to see information about your customers.
Show Customer Invoices to see and edit your customer invoices.
New Customer Invoice to create a new customer invoice.
Show Supplier Invoices to see and edit your supplier invoices.
Show Items to see information on the items in your store.
Show stock histories to view and comment on upcoming supply issuing.
Show Stocktakes to view, create and delete stocktakes.
Reports to have reports emailed to you.

Viewing a customer
(Back up to The navigator)
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Tapping on Show Customers displays this list of all your customers (Note: If you have more customers than will display on the screen you can scroll
the list to see the others):

To see the details of a single customer tap on them to select their row in the grid then tap on the View customer details button. You will be taken to
the details screen which looks like this:
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The customer invoice list
(Back up to The navigator)

Transaction Status Codes
Before we go further we need to quickly discuss what is meant by transaction status. See Transaction Codes#transaction_status for a full list of codes
used in mSupply. In mSupply Mobile (browser) (for both invoices and stocktakes), you'll see the following codes used:
Status Code

Meaning

Explanation

sg

Suggested

The transaction or stocktake is editable, and stock has not been updated

cn

Confirmed

The transaction or stocktake is still editable, but stock has been updated

fn

Finalised

The transaction or stocktake is not editable, and stock has been updated

When you first arrive at this screen you will see a list of your 15 most recent customer invoices, just like in mSupply Desktop:

To see other invoices you can tap on the Find button to search for other invoices (see Searching for invoices here) or, to see more details for one of the
invoices shown, tap on it to select its row and then tap the View/Edit invoice button. You will be taken to the customer invoice detail screen which
looks like this (for a non-finalised invoice):
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If the invoice is finalised you won't be able to edit it (just as in desktop mSupply) but if it's not finalised you can edit it as follows:
•
•
•
•

Their ref Tap the Their ref text box to edit or enter a value. Handy for recording a customer's purchase order number for example.
Comment Tap the Comment text box to enter or edit a comment or anything additional you want noted about the invoice.
Add line Tap on the Add line button to add a line to the invoice - it will take you to the Add item screen as described below.
Delete line Tap on one of the invoice's lines to select it and tap this button to remove it from the invoice. Be careful: once it's gone, it's
gone!
• Quantity field You can directly edit the quantity of an item on the invoice by tapping the quantity field of the line. Immediately the field
changes to a text box and you can enter the new quantity.
• Finalise it If you've finished editing the invoice and you want to make sure it can't be edited by anybody you can finalise the invoice by
tapping on the Finalise button. You'll be asked to confirm that you really want to because once you've done it, it can't be undone and the
invoice will be un-editable.
Adding an item line to the invoice
If you click on the Add line + button you'll be taken to this screen to select the item and quantity to add:
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Tap the item field and an alphabetically sorted list of all the items in your store will appear. Type the first few letters of the item name and the list will
reduce to those entries which start with what you typed. Now choose the item you want from the list of matching entries. If the list is too long, keep
typing. The more letters you type the shorter the list of matching items will become:

Note that after each item name (in brackets) is the quantity you have in stock of each item. Now you've selected the item its available stock appears
next to the quantity text box (after the word 'of:'):
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Tap the quantity text box and enter the amount of the item you want to add. When you're done, tap the Add item button and you'll be taken back to
your invoice with the new line added to the bottom of those already there (or according to the sort order of the items list if you've previously sorted the
list by clicking on one of the column headers).
When you've finished viewing or editing the invoice tap on the Customer invoices button to go back to the list of customer invoices.

Adding a customer invoice
(Back up to The navigator)
Just as in desktop mSupply, customer invoices are for giving stock to a customer (e.g. a hospital ward or a patient) and, when confirmed, result in
stock being taken off what's available in your store. To create a new customer invoice tap New Customer Invoice in the navigator and you'll be shown
this screen:
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From this point, there are two possible ways to add items.
1. Line by line (next), or
2. Adding from a master list

Adding lines to an invoice individually
Tap on the Name text box and, enter the first few letters of the customer you're going to supply goods to and then tap on the matching entry from the
list:

If you want to, enter the customer's reference for this transaction (their purchase order number for example) or enter a comment such as Regular
monthly order or Emergency order (these are optional). Now tap the Add line button to add a line to the invoice. This will take you to the Add item
screen to select the item and quantity to add:
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Tap the item field and an alphabetically sorted list of all the items in your store will appear. Type the first few letters of the item name and the list will
reduce to those entries which start with what you typed. Now choose the item you want from the list of matching entries: if the list is too long keep
typing, the more letters you type the shorter the list of matching items will become:

Now you've selected the item its available stock appears next to the quantity text box (after the word 'of:'):
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Tap the quantity text box and enter the amount of the item you want to add. When you're done, tap the Add item button and you'll be taken back to
your invoice with the new line added to the bottom of those already there (or according to the sort order of the items list if you've previously sorted the
list by clicking on one of the column headers).
Repeat adding more lines until you've finished. Here's an example after a second line has been added:
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If you need to alter the quantities of any item on the customer invoice just tap on the quantity field and it will change to a text box and allow
you to enter a new quantity.

Don't forget to save your invoice by tapping on the Save button but don't worry if you do forget, as mSupply Mobile (browser) will prompt you. Also,
if you need to finalise the invoice (to prevent any further changes to it) then tap on the Finalise button. You will be asked to confirm the finalisation
because you can't undo it and no changes to your invoice will be possible afterwards.

Adding lines to an invoice from a master list
Firstly, this function will only work if you have assigned a master list to the customer you are issuing to. To do this, see these instructions
Assuming your customer has a master list assigned, then simply tap Add lines from master list and the invoice will be filled with one row for each
item. You can tap the button at any time - whether you've already added items to the invoice or whether it's still empty. Only items from the master
that you haven't already added to the invoice will be added to it. And the quantities you've added won't be changed either. To alter the quantities of any
item on the customer invoice just tap on the quantity field and it will change to a text box and allow you to enter a new quantity.
When you're finished editing, save the invoice.
Note that items that have zero quantity will be deleted when you leave the 'new invoice' screen. This means that:
1. You don't have to delete them yourself
2. Once you return to the navigator, if you then edit the invoice (via Show customer invoices) you won't see the whole master list - just the
items whose quantity was set to greater than zero. Note that using the save button while you have the invoice open on the 'new invoice'
screen won't affect your invoice, the 0 quantity lines will remain (so you can still save frequently and not lose the zero quantity lines you
still have to edit).
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An important thing to note is that when you do save your customer invoice for the first time it is automatically confirmed which means that
the stock is allocated to the customer immediately and taken off what is available in your store.

When you're finished, you can tap the Navigator button at top left to return to the Navigator.

Show Supplier Invoices
(Back up to The navigator)
Supplier invoices are for receiving goods into your store.

mSupply Mobile (browser) can only process stock transfers from another store
within your mSupply system. Supplier invoices from outside your mSupply
system must be received using mSupply Desktop.
Depending on the mSupply preferences, Stock Transfers may need to be finalised
in the supplying store before they are visible in the receiving store through
mSupply Mobile (browser).

If you tap on the Show Supplier Invoices item in the navigator you'll be taken to this screen, which shows your 15 most recent supplier invoices by
default (just like desktop mSupply):
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If you tap the Find button you'll be taken to the search for transactions screen, detailed here. If you tap on an invoice's row and tap the View/Edit
invoice button you'll be take to the supplier invoice detail screen which looks something like this:
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There are two things you can edit on a supplier invoice:
1. The Accepted status. If an invoice has been accepted before (status is cn or fn) then it cannot be 'unaccepted' so, if this is the case, instead
of a slideable switch you will see the word 'Yes' in the accepted field. An accepted status of 'No' means that the invoice is on hold and the
stock has not been added to the stock in your store. As soon as you change an invoice's accept field to 'Yes' and save it (by tapping the Save
changes button), the invoice will be confirmed and the stock on it will be added to your store.
2. The quantities in the No. received column. This column is for capturing exactly what you received from the supplier, so after a delivery you
should go through the invoice and make sure that this column contains exactly the quantity you received for each item. When you are sure
that the quantities are correct you should change the invoice's accepted status to 'Yes'. Note that the quantities in this column are set to those
that the supplier sent you (displayed in the No. sent column) by default.
Don't forget to save any changes to your supplier invoice. Don't worry if you forget, because mSupply Mobile (browser) will prompt you to save or
discard the changes.

Items
(Back up to The navigator)
Tap the Show items row in the Navigator to view items. You'll be shown a screen where you can find items by name or code or SMS code etc. (just
spin the wheels to change the criteria used to find the items you're interested in):
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Tapping the Search button will show you a list of results:

To view more details about a single item, tap on it's row to select it, then tap the Item details button.
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At the moment you can't edit an item's details. If an item needs editing, inform the users of mSupply desktop where your server is located so that they
can log in to the desktop version and make the necessary changes.

Stock Based Orders
This feature allows the viewing of and commenting on recommended supply quantities generated by a central store using the mSupply Stock Histories
feature. Quantities calculated using the records of previous quantities sent and adjusted using stock take information for your store allows the
generation of recommended quantities to be issued.
Clicking on Show Stock Based Orders displays a list of central store generated drug quantity issues.

Clicking on the SH no. and then “View/Edit” allows you to drill down and comment on the individual record.

Supplier SOH shows the amount of available stock on hand at the central store.
Our SOH at submission shows the stock on hand available at your store.
Previous usage history is used to calculate the amount to be sent to you in the final column.
The only editable field is the Your comment field where you may enter feedback to the central store.
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Stocktakes
(Back up to The navigator)
Tapping the Show Stocktakes row will show you a list of in-progress stocktakes:

To create a new stocktake, tap the New Stocktake button.

In the example above we're going to create a stocktake for all items whose name begins with “A”. To create a stocktake for all items, leave this field
blank.
715

mSupply user guide July 2018

Include items with no stock Usually you'll want to leave this switched to no but if you are doing an initial stocktake for a new store you have just set
up, you might want a list of all items, not just the ones with stock (which will be none for a new store). In that case slide the switch to yes before
creating the stocktake.
To proceed, tap the Create stocktake button at top-right. The wheels will spin (you might hear a whirring sound from your tablet) if you want to use
other criteria to select the items to go into your stocktake.

Now the stocktake is created, you can edit lines by tapping on the value in the actual quantity column of the row you wish to edit. In the example
below we've counted the Azathioprine and we're 100 tablets short:
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As you stocktake a store you might find items on the shelf that are not in your stocktake. To add an item, tap the Add line + button. You'll be shown
this screen, where you find the item, and enter the stocktake quantity for that line: Tap Add to stocktake once you've entered the item and quantity.
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Finalising the stocktake
(Back up to The navigator)
Once your stocktake accurately reflects your actual store stock, tap on Create inventory adjustments You'll be shown this warning:

If you tap I'm sure, do it the necessary adjustments will be made in mSupply.

You do not have to delete rows where the stock is already correct. mSupply will just ignore these when creating inventory adjustments.

Once inventory adjustments are created, the stocktake will have a status of “FN” (finalised) so it will not show up in the list of current (or pending)
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stocktakes.
Deleting a stocktake You can delete a stocktake by tapping on the row you want to delete, then tapping the delete stocktake button. You'll be warned
of impending doom:

Searching for invoices
(Back up to The navigator)
If you tap the Find button when viewing a list of invoices you will be taken to this screen:

Move the spinwheels until the search matches what you want, enter your search value in the text box then click on the Find transactions button.
When the search is complete you will be taken back to the customer or supplier invoice list (depending on which type of transaction you were
searching for) with all the transactions matching your search criteria displayed in the list.

Reports
(Back up to The navigator)
mSupply Mobile (browser) can email three different reports to you. Tapping the Reports row on the navigator will take you to the reports page:
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Tapping on any of the Email me this report buttons will make mSupply email you the corresponding report as an Excel spreadsheet using the values
you select. Obviously, it needs to know your email address to do this so remember to set this up in your user preferences in desktop mSupply first - see
here for instructions on doing this.

Tips and Tricks
You get a message "You haven't edited anything" when you have
This happens when you change a field (e.g. the description of a stocktake) and then tap Save without first tapping in another field. This only happens
on iPads (iPhones too we guess), not Android devices Solution: tap in another field before tapping save.
Previous: The mSupply Web Server Next: The mSupply Customer interface
2013/01/10 22:33

·

mSupply customer interface
What is it?
The mSupply Customer Interface allows staff of Customers in your mSupply system to report their stock levels and order stock from a store in your
mSupply system. It runs on a browser on any device: tablet, smartphone, net-book, desktop computer etc.

While the Customer Interface will run on smaller devices like smartphones, it is
generally impractical to use with screens smaller than 5 inches across the diagonal.
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Features and Limitations
The Customer Interface is designed to be used by staff of Customers in your mSupply system i.e. people working in places you supply, but they could
be people outside of your organisation.
The Customer Interface's features are:
• (Supplier) Invoices: Display a list of orders that have been processed and are waiting to be processed by the supplying store. You can also
see details of any selected Invoice.
• Orders: Orders for stock from the supplying store can be created, deleted and edited.
• Items: Display a list of Items available in the supplying store.
• Stocktakes: Display a list of Customer Stocktakes (including Imprests) and details of any selected Stocktake. Customer Stocktakes can be
added, deleted and edited.

Batch number and expiry date are not displayed, selectable or editable in the
Customer Interface. mSupply does keep record of those details for stock issued to
the Customer from the supplying store.
mSupply does not attempt to keep any record of stock issued / consumed by the
Customer. Customers can report inventory through the stocktake process and
mSupply does keep these stocktake records.

Setting up users to access the customer interface
You can find details of how to do this on The mSupply Web Server page.

Connecting to the Customer Interface
Once the mSupply web server is running, you can access it by typing http://example.com/customer/ (http://msupply.org:8080/customer/)

The hyperlink above links to Sustainable Solutions' mSupply Web Server for
mSupply Customer demonstration. You will not be able to proceed further without
a username and password - see below. Contact us on email:info@msuppy.org.nz
(mailto:info@msuppy.org.nz) if you would like a temporary username and
password to try it out.
Once set up with your own Web Server, the correct link can be bookmarked to
save you typing it each time.

Logging in
Firstly you will be shown the login page:
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Enter your username and password and tap Login

The Navigator
You are now shown the mSupply customer options:

Tap on:
• Show Processed Invoices to see invoices from the supplying store that have already been processed (goods have been picked and packed).
• Show In-Process Invoices to see invoices from the supplying store that have not finished being processed (still waiting for goods to be
picked and packed).
• Show Items to see information on items available in the supplying store.
• Show Orders to view a list of orders that have been created but not yet completed.
• Create Orders to create a new order for stock from the supplying store.
722

mSupply user guide July 2018

• Show Stocktakes to view and create customer stocktakes or imprests.

Show Processed Invoices
Tap Show Processed Invoices and the invoices that have already been confirmed in the supplying store (i.e. where the goods are picked and packed
and being sent to the customer) will be displayed:

Tap Find to show a screen where you can search for other invoices:

Choose the options using the selectors and enter some text in the textbox to define the search filter. Then tap Find to search for invoices. When the
search is complete the list will be updated with the results.

View Invoice details
If you tap on a particular row, then tap View you will be shown the details of that invoice:
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Tap Invoices to go back to the list of invoices.
(Back up to The navigator)

Show In Process invoices
Choosing this option will display the list of invoices that are still waiting to be processed in the supplying store (i.e. the goods have not been picked
and packed):

Again, tapping on a particular row and then then on View will show the details of the highlighted invoice.
Tap Navigator to go back to the main options screen.
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(Back up to The navigator)

Show Items
Tap Show Items to make a search of items available in the supplying store. It will display this screen:

Choose your search options using the selectors and enter something to search for in the textbox (or leave it empty to list all the items). Tap on Find
and the search will be made. When the search is complete the list of items matching your search criteria will be displayed:
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Tap the row of a specific item and tap on Item details to see the details:

Note: The Stock on Hand figure is the supplying store's stock on hand, not the
Customer's stock on Hand.

(Back up to The navigator)

Show Orders
Select Show Orders to display a list of orders that have been created.
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To view or edit an existing order, tap on the order's row to highlight it, then tap on View/Edit order
To delete an existing order, tap on the order's row to highlight it, then tap on Delete order
Tap on Navigator to return to the main options screen.
(Back up to The navigator)

Create Orders
Tap on Create Order to display the screen for entering an order:
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To add a new line, tap on New line and select the item and the quantity to add:

Tap on Add to order to proceed and return to the items in this order. If you wish to add a comment you can do so directly in the list by clicking the
blank row under each item:
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Note you can also edit the quantity directly in the list.
If you have been assigned an order List of the items you are allowed to order, tapping the Add lines from Order list button will display the items on
the list(s) defined for the customer you are logged in for.

For setting up a default order list, see Names: Using, adding and editing

The list will be displayed in the same order as was specified when setting up the list in mSupply.
Once the order is complete, tap the Finalise Order button to finalise the order that you have created. It will now be visible under the In process
invoices option until the supplying store processes it. It is also visible and available for processing in the supplying store in mSupply. And you might
even get your supplies delivered quicker than you would have by submitting a written order ;-)

A note for the user processing the order in the warehouse:
The customer's order will appear in mSupply desktop as a customer invoice with
'wf' (web finalised) status. This means the customer can no longer edit the order
but the desktop user can edit the order. The customer invoice displays the
customer's order with placeholder lines by default. This gives the mSupply
desktop user control to choose the stock for the customer's order.
To choose stock see the re-distribute section: Redistribute placeholder lines.

(Back up to The navigator)

Show Stocktakes
Tap Show Stocktakes and the stocktakes that have already been initiated will be displayed:
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The stocktakes feature is useful to those users at a central supply facility who are responsible for managing orders from a number of remote facilities
based on the stock levels in those facilities.
From this window you can view an existing stocktake by tapping on a row and then on the View/Edit button. You can choose to create a New
stocktake or New imprest by clicking the appropriate button. The option chosen depends on whether you are using the dynamic Stock History system
of stock management, or the Imprest system. These systems are covered under Stock Control methods for your customers.
By clicking either of the New stocktake or New imprest buttons you are presented with a screen showing the items you carry in stock, but with
quantities of 0.
Enter the stock on hand for each item into the My current SOH column:
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If you want to finish the entries later, click Save changes and then Stocktakes to return to the list. You can then use the View/Edit Button on the
stocktakes list to return to your stocktake later.
Once you have entered all your stock on hand figures, tap Finalise to send the stocktake to the central store. You will be prompted for a confirmation
to finalise the stocktake. Once you confirm the finalisation of the stocktake, you will be taken back to the Show Stocktakes window. The stocktake you
were just working on will now be invisible unless you change the view to include finalised stocktakes.
(Back up to The navigator)

Back at the supplying store...
The operator at the supplying store may then process the information entered by the remote customer by choosing from the menu Customer > Show
customer stock history, and looking in the Customer stock history list window for recent entries having a status of wf (web finalised). Double
clicking on the desired entry displays the Edit customer stock history window showing the data entered by the remote customer. The details may be
reviewed and figures entered in the Actual quantity given column before clicking on Create Customer Invoice, at which point the status changes from
wf to sg and it may no longer be edited by the remote customer.
(Back up to The navigator)
Previous: The Web Stocktake module Next: The Dashboard
2014/10/23 03:10

·

The dashboard
You can use the dashboard to monitor and access reports from anywhere.
To set up dashboards, see Setting up Dashboards.
Users browse to the IP address of their web server (with /dashboard/index.html added as in https://example.com/dashboard/index.html
(https://example.com/dashboard/index.html)) using their internet browser (such as Chrome, Safari or Firefox). This enables users to access reports
using their computer at home or even their tablet or cell phone!

Using the dashboard
Login
You'll need to be given the right URL (“web site”) to go to in your browser. Type it into the address bar of the browser you want to use (on the device
of your choice) and click on the Go button or tap the Enter key. You will be shown the login page:
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Enter your normal mSupply login username and password and click on the Log in button.
You will be taken to your dashboard which will show the first “page” or tab set up for you by default. You can click on other tabs at the left of the
screen (if they have been set up for you) to see other reports:

The dashboard works just as well on a tablet or your phone, but the different “pages” will be at the top of your screen, not on the left.
There are several very useful reports on the dashboard, helping you to keep up to date with current stock levels and much, much more. And, if one of
the standard reports doesn't give you what you want then it's fairly simple to create a new one from scratch or by duplicating and editing an existing
one (see Setting up dashboards). Below are just a few examples of the kinds of reports the dashboard can show for you:
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Previous: mSupply Customer Interface Next: The Online Catalogue
2015/03/03 04:57

·

Dashboard setup

In versions up to 3.9 dashboard setup was accessed from preferences. The following instruction are for versions 3.9 and above.
For versions prior to 3.9, please use the instructions here: https://docs.msupply.org.nz/preferences:dashboard
(https://docs.msupply.org.nz/preferences:dashboard)

Before the settings in this section will work you must make sure your webserver is currently running. See Webserver. Most users will find it easier to
request mSupply support to set this up for you.
Before you set the dashboard up you must:
• know what ports are already in use on the server
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• have an appropriate SSL Certificate set up. Sustainable Solutions can help with this if needed.

To setup the dashboard:
1. Check the Use the dashboard checkbox in the user settings.
2. Click on the Dashboard button on the Admin screen
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1. In the Dashboard web URL field enter the base URL to reach the dashboard on e.g. http://dashboard.msupply.org:2048/
(http://dashboard.msupply.org:2048/) (i.e. everything up to 'dashboard' in the URL you browse to - don't forget the trailing slash (/)
otherwise it won't work!)
a. if you are running from localhost, use your IP rather than http://localhost (http://localhost) both here and in the browser
b. the URL users type in to the address bar of their browser to access the dashboard will be this URL with “Dashboard” on the end
2. Tick the reports in the Is active column to select them for display on your dashboard.
3. You can choose how often these reports are updated by clicking in the Update Period (mins) column and entering a number of minutes.
4. Setup which reports appear on which tabs. See the Dashboard tabs section below for details.
5. Setup which if the dashboard reports each user can access. See The dashboard for details.

Editing Dashboard Reports
Double-click a report in the list shown above and the following window will open:
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If there are any properties shown in the list, these can be edited to change what is displayed.
To edit a property or value, click once to select the row, and then click again in the appropriate cell to edit it.
To add or delete a row use the New line and Delete line(s) buttons at the top of the window.
In the example shown in the screenshot above (a map report), the coordinates of two of the map corners and the item code of the item whose stocks
will be shown on the map have been entered. Note that if you add extra properties to the default reports they'll be ignored.
See the section below for details of the various dashboard reports available and the settings that can be edited.

What the dashboards show and what can be edited
There are several built-in dashboard reports that everyone can use. Here's what they show and what properties can be edited to change what they
show:
Report name

Property

Value

VEN items in stock: Shows…
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Report name

Property

Value
None

None

Total stock value: A single figure in your default currency, showing the total value of the stock you have in the store you are viewing the
dashboard for.
None

None

None

None

None

None

This month transactions: Shows…

Expiring stock: Shows…

Top facilities supplied: The 10 customers in your store to which you have sent the greatest value of stock. Shows the value of stock for each
customer.
None

None

Transactions per store: Shows a table of the transactions per stores within 30 days
method:dashboard_rep_count_store_trans()
store_code

Specify a store by entering a store code, or leave blank for the default
store

Vital items in stock: Shows a bar graph of the percentage of medicines of the chosen category in stock at each facility
method:dashboard_store_stock_percent()
ven_category

v or e or n if you want to include items that are Vital or Essential or
Necessary

user_field_4

TRUE if you want to include items with this field checked

user_field_7

TRUE if you want to include items with this field checked
Note that the labels for fields 4 and 7 may be different, as they are set
up in the mSupply preferences (misc tab)

critical_stock

TRUE if you want to include items with this field checked, false for all
items

store_tags

entering healthcentre will only include stores with the
“healthcentre” tag

Map stock on hand: Shows a map of the area specified, with an “X” if the facility is out of stock of the item, or a dot representing the amount of
stock on hand.
lat_nw_corner

the latitude of the North-West corner of the map
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Report name

Property

Value

long_nw_corner
lat_se_corner
long_se_corner
item_code
country

the longitude of the North-East corner of the map
the latitude of the South-East corner of the map
the longitude of the North-East corner of the map
the item code of the item to display
compulsory parameter
A comma separated list of tags - or omit this parameter if you want to
show stock for all stores

store_tags
Sync sites last connection date: Shows…
None

None

None

None

None

None

Sync sites sent and received statistics: Shows…

Stock_for_category_1_stores_by_item_list: Shows…

Trends in critical stock: Shows…
method:dashboard_rep_in_stock_trends
store_id
critical_stock

the ID of the store you're interested in, or no value for all stores
TRUE if you want to include items with this field checked, false for all
items

Output: use the type “time_series_chart”
Reports Monthly Transactions Shows how many transactions of each type the chose store has processed this month
method:dashboard_rep_month_transacs
store_name

the name of the store which you are interested in, or no value if you
want all stores

dashboard_itemRow_storeCol_usage: Shows the report of items issued by the facility within the last 30 days
store_tag
master_list
period

include stores with this tag
include items on this master list
30 ( currently only 30 days is supported)
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Report name

Property

Value

Stock each item in each store: Shows a table of items in rows and
stores in columns, with the stock on hand
for that item in that store in each cell.
method:dashboard_rep_stk_StoreCols_Itm
store_code

store tag attached to the store

master_list

selected master list of items

item_code

items whose code matches this code (append “@” for a “starts with”
search)

Category1_description

Items with this category1

If you can't make a dashboard report that does what you want then please speak to us, it's usually a fairly simple matter for us to create one for you.

Dashboard tabs
You set up Dashboard tabs which will display on your dashboard. Dashboard tabs are “containers” for one or more dashboard reports. To edit them go
to File > Preferences and click on the Dashboard tabs tab on the left hand side:

To add a tab click the Add button. To edit a tab, double-click it. You will be shown a window for editing a dashboard tab:
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Now you add reports that will show on this tab.

Understanding Rows and Columns
Take this example dashboard tab:
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• The tabs themselves occupy their own space on the left of the window- they aren't considered when laying out the dashboard
• The first row has two reports- each report takes up half the row. So for the first report:
◦ Row 1, Col 1, width 12 (“12” means it takes up the full width of the cell it is in- “4” would mean it would take up 1/3 of the
width)
• For the report at the top right:
◦ Row 1, Col 2, width 12
• For the map
◦ Row 2, Col 1, width 12
• The next two reports are on the same row, but are divided into 5/12 and 7/12 of the width of the window, so we put them in the same cell
but change the width settings:
◦ Row 3, Col 1, width 5
◦ Row 3, Col 1, width 7

To add a report to a Dashboard tab
Click New Line to add a new report to the tab. Then edit the values in each column
• Row: The row it will be in
• Column: The column within the row- set to “1” if you don't have multiple reports on this row.
• Report tite: The title that will show in the Orange heading bar for the report. Note that the same report can display different information
depending on the parameters you set for that report- hence the need for the ability to customise report names
• Type: You'll need to know the appropriate type for the report you're displaying. The options are
◦ bar_chart
◦ table
◦ pie_chart
◦ time_series
◦ map
◦ line_chart
• Width: The fraction of the cell width in “twelfths” that this report will take up (“6” will make it take up half the cell width)
• Report: Choose the report name from the drop-down list of available reports

Add a dashboard tab to a user's dashboard
This is the final step in setting up dashboards: once the tabs have been setup you have to choose which users will see which tabs. You do this in
individual users' settings. See managing users for instructions on how to do this.
Previous: Printing Preferences Next: Entering a New Logo
2018/05/11 02:52

·

The online catalogue
The online catalogue is a searchable list of items you stock, driven by data in mSupply. The information can easily be updated and items added to or
removed from the catalogue. By giving users access to the online catalogue you can, for example, replace the expensive printing of hard copy
catalogues.

Setup
1) Tell mSupply which store to run the catalogue from
Choose File > Preferences… from the menus, and on the Web server tab select the store in the Default store for web interface drop down list. If the
mSupply web server isn't already running you'll also need to click on the Start web server button. More information about these options can be found
here.

2) Tell mSupply which items are to be included in the catalogue
To do this, from the menus choose Item > Show items…, click on the Find button and double click on an item you want to appear in the catalogue.
This will open up the Item's details window. Click on the Misc tab on the left hand side and the screen will look like this:
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In the Price list section:
• Check the On price list checkbox (any item with this checked will appear in the catalogue)
• Enter the pack size of this item that is going to appear in the catalogue in the Catalogue pack size textbox
• Enter the price for this pack size in the Catalogue price textbox. This is optional and can be left at 0 if you don't want the price included in
your catalogue.
Repeat these steps for each item you want to appear in your catalogue. As with many repetitive tasks in mSupply, the OK & Next and OK & Previous
buttons are your friends here.
And that's it. Setup is complete and you are now ready for users to view your catalogue.

Operation
Once the mSupply web server is running users access the catalogue using a browser. The address to visit is
https://example.com/catalogue/

where example.com is the domain of your web server.
This is what the user will see:
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The catalogue can be searched by either item name (the top section) or the categories that items belong to (bottom section).

Searching by item name
To search by item name enter something in the top textbox and select the comparator in the drop down list next to it. These are the options you can
choose from:

Then click on the top Search button and mSupply will search for items with names matching the options you have entered. When the search is
complete the item detail screen (shown below) will be displayed and you can browse the items found.
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Searching by category
The category used to search for items in the catalogue is item category 1. This category is hierarchical and has 3 levels. For more details about this
category, including setting it up and assigning it to items, see here. Note that in the catalogue, Top level corresponds to level 1 of category 1, Mid level
to level 2 and Bottom level to level 3.
To search by category, click on one of the 3 Search buttons in the lower section of the search screen. When you do that, mSupply will search for items
belonging to the category of the level of category 1 you selected in the corresponding drop down list. If the All option is selected then mSupply will
search for items belonging to all the corresponding categories at that level of category 1.
When you select an option other than All in the Top level category drop down list, the options in the Mid level drop down list are changed to be all the
children of the top level category you selected. And when you select a Mid level category, the options in the Bottom level drop down list change to be
the children of that mid level category.
The Bottom level category drop down list has an additional “None” option. Using this option will search for all items which are not assigned to a
category 1 category.

The Item detail screen
The screen looks like this:

When you've finished browsing the items displayed you can click on the Search button on the top left hand side to return to the search screen, where
you can perform another search if required.
Previous: The dashboard Next: The mSupply mobile API
2016/03/23 12:17

·
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Stock Web App
You can use the Stock Web App to look up the stock on hand of items, including batch and expiry information, from anywhere you have access to the
internet. Very handy if you are away from the computer you normally use to access mSupply, or travelling overseas and still need to check the stock
information in your store.
Users will be able to see the stock information for their default store only (Note: in a sync system, it is the primary server information that is shown).
To access the Stock Web App, point your browser to https://yourserver.msupply.org:2048/stock where yourserver.msupply.org is the domain name
and 2048 is the port for your mSupply web server (these details will be supplied to you by Sustainable Solutions if you are using this functionality). If
you are going to use the App a lot, it would be a good idea to set its location as a bookmark or favourite in your browser.
This is the screen you will see:

Type in your normal mSupply username and you normal mSupply password and click on the Login button to move to the search screen:

You can either search by item name or stock location code - select “Location code” instead of “Item name” in the screenshot above to search by
location code. mSupply will search for stock belonging to items with names or in locations with codes that begin with what you type in the “Search
by item or location code” field shown in the screenshot. When you have entered the text to search for, click on the magnifying glass icon to make the
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search. The results are displayed below the search filter, as shown in this screenshot:

And this is an example of a search by stock location code:
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Previous: mSupply mobile API Next: Miscellaneous topics
2018/05/09 00:18

·

mSupply sync API
What is it?
There are multiple ways to configure an mSupply installation. Where the internet is good, or you are using a local area network, you can have realtime communication with an mSupply server. Where internet access is poor or non-existent, we have mSupply sync. You can have a local application
that saves all the changes the user makes to a local database - this can be a mobile app, a single user application on a PC or a tablet, or a client-server
application on a local LAN.
The machine on which the data is stored, which we call a satellite, then periodically communicates with a central mSupply server, which we call the
primary - this may be in a central location in the country, or it may be a cloud-based server. The REST API described here is used to send and receive
data from the primary server to keep both satellite and primary sites up to date with data additions, modifications and deletions. See Remote
Synchronisation for more details on how sync works.

Basics
You might want to read about our mSupply Mobile API, as the basics are the same. That is:
1. The SYNC API is a subset of the mSupply REST API.
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2. All calls to the sync API use a pseudo-resource of “sync”.
3. The second URI segment is the API version. Allowable values:

Value

Release Date

v1

25 Jan 2016

v2

01 Mar 2017

Our Android mobile app uses v2 exclusively to communicate with the primary mSupply server, whereas mSupply itself uses v1 for synchronisation
between different instances of mSupply. For example, you call “https://example.com/sync/v1/somethinghere (https://example.com/sync/v1/
somethinghere)”.

Server requirements
You will need to be querying an mSupply standalone or server that:
1. Has a fixed IP address.
2. Ideally has a domain name and a valid SSL certificate - we rely on SSL for stopping your communications and password(s) being acquired.
You should use it.
3. Is reachable from the machine you are using these APIs on.

Authentication
We use basic HTTP authentication:
1. v1 of the API only supported a simple username:password, with each satellite sharing the same credentials for a single special sync user on
the primary server.
2. v2 expects the password part to be SHA256 encoded i.e. sitename:SHA256_encoded_password, and each satellite can have its own
individual site name and password credentials on the primary server.
3. v1 now also supports SHA256-encoded passwords and individual satellite site credentials.

Available calls (v1)
Note that each site has a unique integer ID, and that the ID for the primary server (running a web server) is always set to 1.

HTTP GET
https://example.com/sync/v1/queued_records/count?from_site=4&to_site=1

will retrieve the number of sync records in the outgoing queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1.
https://example.com/sync/v1/queued_records/?from_site=4&to_site=1&limit=10

will retrieve the first 10 sync records in the outgoing queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1. If limit
is missing, it will only retrieve a single record from the head of the queue.
https://example.com/sync/v1/queued_records/?from_site=4&to_site=1&sync_id=GSHJDJKSKS

will retrieve a single sync record from the outgoing queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1, where
the sync record ID=GSHJDJKSKS (UUID).
https://example.com/sync/v1/initial_dump/?from_site=4&to_site=1&type=full

will request the sync site with ID=1 to regenerate all sync records for the sync satellite site with ID=4 (the requesting site). This is used to (re)initialise
a new satellite. If type is missing, or has any other value, then only the subset of sync records necessary for a mobile store will be generated.
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HTTP POST
https://example.com/sync/v1/acknowledged_records/?from_site=4&to_site=1

will inform the server that the sync records whose IDs (UUID) are specified (as JSON) in the HTTP BODY have been consumed from the outgoing
queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1.
https://example.com/sync/v1/queued_records/?from_site=4&to_site=1

will apply the sync record data specified (as JSON) in the HTTP BODY from the sync satellite site with ID=4 (the requesting site) to the sync site
with ID=1. Multiple sync records can be sent in one packet.

Format of a record
•
•
•
•
•
•

The format is JSON.
If there is more than one record returned or to be sent, each record is an element of a JSON array.
v1 uses internal field numbers and table numbers.
Text ID fields are always UUIDs.
Blobs, pictures etc. are BASE64 encoded.
Example for v1:

[
{
"SyncID": "asdlkfj",
"TableNumber": 3,
"RecordID": "dkfaadj",
"KeyFieldID": 5,
"SyncType": "U",
"StoreID": "knvslkj",
"fields": [9, 11, 3],
"values": ["sadflkj", "Trinity", "12"]
}
]

Available calls (v2)
The v1 API calls above behave in exactly the same way for v2, except that the format of any sync records transferred is different. The extra
v2-specific API calls below are used to retrieve the necessary parameters for our mobile app, which is designed to host a single store.

HTTP GET
https://example.com/sync/v2/queued_records/count?from_site=4&to_site=1

will retrieve the number of sync records in the outgoing queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1.
https://example.com/sync/v2/queued_records/?from_site=4&to_site=1&limit=10

will retrieve the first 10 sync records in the outgoing queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1. If limit
is missing, it will only retrieve a single record from the head of the queue.
https://example.com/sync/v2/queued_records/?from_site=4&to_site=1&sync_id=GSHJDJKSKS

will retrieve a single sync record from the outgoing queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1, where
the sync record ID=GSHJDJKSKS (UUID).
https://example.com/sync/v2/initial_dump/?from_site=4&to_site=1&type=full

will request the sync site with ID=1 to regenerate all sync records for the sync satellite site with ID=4 (the requesting site). This is used to (re)initialise
a new satellite. If type is missing, or has any other value, then only the subset of sync records necessary for a mobile store will be generated.
https://example.com/sync/v2/site/?site_name=Satellite4
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will retrieve the site ID (integer) and the corresponding store ID (UUID) and store-name ID (UUID) for the sync satellite site with name=Satellite4 on
the primary sync site.
https://example.com/sync/v2/user/?store=CVCBNXNSHHSH

will retrieve the user ID (UUID) for the sync satellite site having store ID=CVCBNXNSHHSH (UUID, returned by the above REST call) on the
primary sync site.

HTTP POST
https://example.com/sync/v2/acknowledged_records/?from_site=4&to_site=1

will inform the server that the sync records whose IDs (UUID) are specified (as JSON) in the HTTP BODY have been consumed from the outgoing
queue for the sync satellite site with ID=4 (the requesting site) on the sync site with ID=1.
https://example.com/sync/v2/queued_records/?from_site=4&to_site=1

will apply the sync record data specified (as JSON) in the HTTP BODY from the sync satellite site with ID=4 (the requesting site) to the sync site
with ID=1. Multiple sync records can be sent in one packet.

Format of a record
•
•
•
•
•
•

The format is JSON.
If there is more than one record returned or to be sent, each record is an element of a JSON array.
v2 uses field names and table names as described in the Field descriptions chapter.
Text ID fields are always UUIDs.
Blobs, pictures etc. are BASE64 encoded.
Example for v2:

[
{
"SyncID": "kjhkljg",
"RecordType": "trans_line",
"RecordID": "dsfhjd",
"SyncType": "I",
"StoreID": "klsvnsl",
"Data": {"item_name": "hello", "quantity": "95555", "cost_price": "65.5"}
}
]

2015/12/16 22:18

·

Miscellaneous topics
Inactive Logout
You can set mSupply to log an inactive client out after a customisable length of time. Set the length of time in general preferences.
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End of Month tasks
We are presuming that you will finalise and export your invoice data once a month. If you choose a different frequency, you should still follow the
same procedure.
Tasks to perform:
•
•
•
•

Check your invoices are correct. Once you have finalised an invoice, it can not be edited.
Finalize and export supplier invoices. See the file menu chapter.
Finalize and export customer invoices. See the file menu chapter.
Record the stock on hand value (this is only necessary if your accounting system requires the information). See the special menu chapter.

Hints:
• Each month, take your finalised invoices and file them. We suggest you file invoices in order of their invoice number (a separate file for
supplier and customer invoices).
• Keep a file with the summary printout from each month produced when you finalize invoices.

End of Year Tasks
It is usual to run according to a financial year. mSupply does not require you to delete records or perform special operations for the end of the financial
year. If you want to, you can just carry on using mSupply as usual.
However, there are certain procedures that will improve operation, and make an audit of your operation easier.
• Perform a stocktake.
• Print out stocktake sheets to record differences easily between actual stock and stock according to mSupply. See the stocktake sheets
section of the “Report menu” chapter.
• Use inventory adjustment transactions to correct errors. See the Inventory adjustment- add stock and the Inventory adjustment- reduce
stock sections of the “Item menu” chapter.
• Finalize all outstanding invoices. Use the Finalize Customer invoices … and Finalize Supplier invoices… commands to do this. (Note that
any customer invoices with a status of “sg” (“suggested”) must be confirmed before they can be exported.)
• Finalize inventory adjustments. Use the Finalize inventory adjustments command to do this.
• Make a backup copy of mSupply as it stands at year-end. It is a good idea to keep this backup in a secure place for long term storage.
• Print a ledger for each item. Choose “print item ledger” from the “report” menu. You can use your backup copy of mSupply to print this
ledger at a later date.
• Choose “set start of year stock” from the “special” menu. This simply records the date and next transaction number, and records the total
opening stock quantity for each item to allow a ledger calculation for the coming year.
• You are now ready to begin entering transactions for the next year.

Maintenance and Repair
If you are using your data file regularly, it is a good idea occasionally to check that no problems have developed. Problems can develop due, for
example, to faulty hardware and other reasons outside our control.

For technically competent users or professional IT staff
In the case of a serious hardware failure, the first option should always be to revert to the last known good backup of your data.
If for some reason you must repair a damaged data file, please contact Sustainable Solutions for advice.
To check your data, download a product called 4D Tools . (4D Tools and a manual is included on the CD) from ftp://ftp.4d.com (ftp://ftp.4d.com).
4D Tools can simply check your data file for errors, or repair your file. Please contact Sustainable Solutions if you believe your data file has a
problem, before repairing it.
Always use 4D Tools on a backup copy of your data first.
If 4D Tools is unable to repair your data, Sustainable Solutions is able to use specialist tools to examine your data, and even export your data and re754
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import into a new data file. We have not had to do this for a customer yet, but the option is available as a near-last resort.

How do I move a window whose title bar has been hidden?
On Windows:
• Method 1: Press Ctrl and both mouse buttons, and drag the window to the new location.
• Method 2: Press Alt-Ctrl-right mouse button, while dragging the window to the new location.
On Mac OS
• Press Control-Command-mouse button, and drag the window to the new location

Security of your data
If you maintain the mSupply password system carefully, your data is fairly secure.
Note, however, that if a person has access to the original copy of mSupply, they will easily be able to open the data file, as the “user 1” password is
clearly shown in the password entry screen until it is overwritten the first time you click “OK”. It is your responsibility to keep copies of your
mSupply software and data in a safe place.
As of version 1.4, passwords stored in the data file are encrypted with strong (512 bit) RSA encryption, so there is little danger of someone finding
your password.

Supervisor Mode - All stores
mSupply was initially designed to maintain data relating to a single store in each data file, and for many users, this is how mSupply continues to be
used.
Version 2 (and later) now meets the requirements of organisations/institutions operating with more than one store. Normally you will log into a
particular store when starting mSupply, and only see stock and transactions relating to that store. However, users can be given the ability to login in as
Supervisor - All stores. See about_stores. In this mode, users may now access data relating to more than one store - either selectively or cumulatively.
In Supervisor - All stores you can also create Purchase Orders that will be based on data for all stores, and can specify delivery destinations for
different lines within the order.
In this mode, all of the report dialogue boxes relating to stock will display an additional panel. See the example of an organisation having four stores General, Northern Medical, Southern Medical and Island Medical.

Any user in 'Supervisor - All stores' mode will only see the stores they are allowed to log into in the list of stores to select from.

The store(s) to be included in the report should be selected in the normal way by clicking with the mouse; to select more than one store, hold down
Ctrl (Windows) or Cmd (Mac) while clicking on the desired store(s).
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Note also that when you search for items, the filter window has the same store selection:
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The item search filters will be applied to items visible in the stores selected only. If there are a lot of stores in the datafile you can click on the Bigger
List button to select the required store(s) in a separate window.
Previous: Foreign Currencies Next: Reminders
2011/05/16 15:14

·

Reminders
From the Special menu, choose Reminders; this feature of mSupply allows you to create notes of tasks that users may need to be reminded about. In
the Reminders window of the Preferences , you can check the box which will, if the particular user has been issued with one or more Reminders,
display them whenever the user logs in.
The Reminders command shows reminders for tasks that are not yet completed.
The window defaults to reminders which are Incomplete and Assigned to me, but other options are available:
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To add a new reminder, click the New reminder button.
To edit a reminder, double-click it in the list.
To delete a reminder, click on the reminder to delete, then click the Delete button.
You can sort the list by clicking on the column headers. Click a second time to sort in the opposite direction.

Filtering the list
You can change the reminders displayed according to the status and whether the reminder is for you to complete or was created by you.
To show only complete or in-complete reminders, choose from the status drop-down list.

The Reminder details window

Date: The due date of the task
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Assigned to: By default you create reminders for yourself, but you can also create them for other users. If you're the micro-managing type, you could
put everyone else's work plans in for each day or week!
Message: The text of the reminder message. Reminders may be shown in any one of eight colours, according to the colour selected when you click on
the box in the upper right corner of the New Reminder or Edit Reminder window
Completed: Check this box if the reminder is completed (but note that it won't usually show in the list once is is checked)
Repeats automatically: Once this box is checked, you will be shown options for the reminder to repeat daily, weekly or monthly.

Options for repeating reminders:
• Start date: the first date after which the reminder will repeat. For example, if you want an event to repeat every Wednesday, you'd set this
date to the first Wednesday you want the reminder to repeat on
• Every X days/weeks/months: For example, if you want a reminder to be created every three months to do a stocktake, you'd enter 3 and
choose months
• Preview button: clicking this button shows a window with a list of dates that the reminder will recur on.
Colour: Use the Drop-down list of colours to set a reminder colour. This colour will be used to colour the reminder in the list. For example, you might
want to choose Red for all tasks you intend to do today.
Previous: Miscellaneous topics Next: Remote Synchronisation
2011/05/20 06:18

·

Remote synchronisation
mSupply's remote synchronisation allows stores running mSupply to send data to a central mSupply server for combined reporting.

Synchronisation Explained
It's like this:
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Definitions
• The primary server is the central mSupply server, which controls the master system data which is common across all stores e.g. names,
items etc.
◦ In any given setup, there will only be one primary server, and it must be running a web server.
• A satellite server is a regional mSupply server (or single-user standalone copy of mSupply) which connects to the primary server when an
internet connection between them is available.
◦ The syncing process is controlled from the satellite server, so the satellite server doesn't need to be running a web server for
syncing.
• The primary server and all of the satellite servers are sync sites.
• Each sync site has a unique ID and connection parameters (IP address, username and password), setup in the synchronisation preferences,
along with a list of the other sync sites with which it can send/receive synchronisation data. These settings are complicated, easy to get
wrong, and so should only be modified by Sustainable Solutions.
• To preserve data integrity, and to avoid potential clashes where more than one sync site tries to modify the same data, only one sync site
can edit/update any specific type of data.
◦ System data which is common to all stores (e.g. suppliers, customers, items) can only be edited or imported on the primary
server - changes are synced to all satellite servers (see below for details).
◦ Store-specific data (e.g. transactions, locations, abbreviations) can only be edited or imported on a sync site. Any changes to
store-specific data are only synced to the instance of the corresponding store on other sync site(s), depending on the store sync
preferences (see below for details).

Store Setup
Stores to be synced will exist as separate instances of the same store on more than one sync site (one of which will be the primary server), but storespecific data, and the core data for the store itself (i.e. not including store preferences), can only be edited on one of these sync sites - the site on which
the store is defined as Active. This is controlled by the store preferences on the Synchronisation tab for each virtual store on each sync site:
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Synchronisation type drop down list: Shows the sync type of the current store. Will be editable if you have unlocked it using the Click to unlock
button.
Click to unlock button: Click it to enter the unlocking password to enable you to edit the settings on this tab.
Set as local store checkbox: Will be editable if you have entered the password using the Click to unlock button and the store's Synchronisation type
is set to Active. If checked, this will change the store's Sync ID to be that of the current site and will uncheck any of the elements in the Local column
in the Sync with table.
Include prescriptions in sync checkbox: Only appears when the Synchronisation type is set to Active. If checked, this will also sync prescriptions
and related dispensary data. As this can potentially generate a lot of extra sync traffic, the default is that it is switched off.
Sync ID field: Displays the sync ID of the current store so that you can see which one in the table below you're talking about! The store's sync ID
should almost always be the ID of the site where the store is active.
Sync with table: Shows the other sites in your sync setup that the current store will sync with. Also defines what relationship those other store
instances have to your current one and therefore what records need to be sent to that site from the instance of the current store on the current site. Will
be editable if you have entered the password using the Click to unlock button. Note that the Local column is only editable if the Synchronisation
type is also set to Active. Checking any checkbox in the Local column will set the store's Sync ID to be that of the selected row, and will uncheck any
others as well as the Set as local store checkbox.

This setting is a bit confusing, but it does work to understand it as 'whatever the
sync type of the store is on that server'.
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If your version of mSupply server is pre 3.50, after changing sync settings for a
store you will have to restart the mSupply application on the primary server
for the changes to be applied.

• Once a store has been set up (see the relevant parameters below), item and store visibility for the store needs to be set up on the primary
server - see Virtual stores, Controlling item visibility.
• To do that, once you log in to the primary server, you need to switch to the new store - see Switching store
• To do that, you need to have permission to log in to it - see Managing users (It's a good thing this doesn't happen often! :-D)

These settings are necessarily complex and should only be modified by
Sustainable Solutions, after discussions to agree on the configuration which is the
best fit for requirements.

Store sync types
Each store in a synchronised system needs to have a sync “type” as described here.

Active
A store whose sync type is Active means that the store's site-specific data can be edited (added, edited, deleted) on the sync site where you are editing/
viewing this store.

Collector
A store whose sync type is Collector means that the store's site-specific data can not be edited on this sync site. The store on this server receives all
store data from an active store on another sync site. i.e. it is a replica of a corresponding active store on another sync site. This means that the store can
be examined and reports generated on this sync site.

Transfer
A store whose sync type is Transfer is similar to the Collector type except that the store on this sync site is used only as a vehicle for receiving stock
transfers or requisitions from other stores on the same sync site and passing them on to the corresponding store on other sync sites. It doesn't receive
any other store data (such as stock lines). That is, it is not a replica of an active store, and should not be used as such. The store can not be examined
or have reports generated on this sync site. The benefit of a Transfer store over a Collector store is that Transfer stores require less data to be synced
between servers.

None
A store whose sync type is None means that the store's site-specific data can be edited, but that data is not synced with any other sync site. The only
exception is for the store record itself on a satellite, which will be synced to the primary server (so that the primary has a copy of all stores and can
control visibility). In that case, the instance of that store on the primary should have a sync type of Transfer.

Even if a sync store has sync type = none, it can still receive incoming sync
records from outside. These incoming records will trigger the code to see if the
records need to be forwarded on elsewhere.
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Store sync-with options
The Store 'sync-with' options control which store-specific synchronisation data gets sent to the other sync sites which are linked to that sync site:

None
A value of None means that this store doesn't sync with the corresponding store on the selected sync site. That is, there is no instance of this store on
that sync site.

Active/collector
A value of Active/collector means that store-specific data edits, including any edits to the core store data, are synced to the corresponding store
instance on the selected sync site. The store instance on the selected sync site will normally be of type Active or Collector.

Transfer
A value of Transfer means that any updates to the core store data, or any stock transfers or requisitions into that store, are synced to the corresponding
store instance on the selected sync site. No other transactions or other store-specific data will be transferred. The store instance on the selected sync
site will normally be of type Transfer.
For example:
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Store A
An example of a store on the primary server which needs to also be reportable on another satellite server.
Store A exists as an Active store on primary server and as a Collector store on satellite server 1:
• On primary server store-specific data for this store can be entered. This data is then synced to satellite server 1.
• On satellite server 1 store-specific data for this store cannot be entered. The store can receive stock transfers or requisitions from other
stores on the same sync site (satellite server 1). These will be synced to primary server.

Store B
An example of a store on one satellite server which needs to receive stock transfers from a store on another satellite server.
Store B exists as a Collector store on primary server, an Active store on satellite server 1, and a Transfer store on satellite server 2:
• On satellite server 1, store-specific data for this store can be entered. This data is then synced to primary server.
• On primary server, store-specific data for this store cannot be entered. The store can receive stock transfers or requisitions from other
stores on the same sync site (primary server). These are then synced to satellite server 1.
• On satellite server 2, store-specific data for this store cannot be entered, and is not synced from primary server. It can receive stock
transfers or requisitions from other stores on the same sync site (satellite server 2). These are then synced to primary server, and then to
satellite server 1.

Store C
Another example of a store on one satellite server which needs to receive stock transfers from a store on another satellite server.
Store C exists as a Collector store on primary server, an Active store on satellite server 2, and a Transfer store on satellite server 1:
• On satellite server 2, store-specific data for this store can be entered. This data is then synced to primary server.
• On primary server, store-specific data for this store cannot be entered. It can receive stock transfers or requisitions from other stores on
the same sync site (primary server). These are then synced to satellite server 2.
• On satellite server 1, store-specific data for this store cannot be entered. It can receive stock transfers or requisitions from other stores on
the same sync site (satellite server 1). These are then synced to primary server, and then to satellite server 2.
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Store D
An example of a store on a satellite server which needs to also be reportable on the primary server.
Store D exists as an Active store on satellite server 2 and as a Collector store on primary server:
• On satellite server 2, store-specific data for this store can be entered. This data is then synced to primary server.
• On primary server, store-specific data for this store cannot be entered. It can receive stock transfers or requisitions from other stores on
the same sync site (primary server). These are then synced to satellite server 2.

Store E
An example of a store which is local to the primary server only.
Store E exists only on primary server:
• On primary server, store-specific data for this store can be entered. This data is not synced anywhere.

Store F
An example of a store which is local to a single satellite server
Store F exists on satellite server 1 as type 'None' but it must also exist on the Primary server (as type 'Transfer' so that it can be managed (e.g.
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visibility):
• On satellite server 1, store-specific data for this store can be entered. This data is not synced anywhere.

Server configuration settings in the graphic below are incorrect!

System vs Store-specific Data
The table below defines which data types are considered as system or store-specific. Other types of data (e.g. preferences, user permissions are always
local to the sync site, and are not synchronised).

Data

Sync
records

Notes

Items

System

Including item-related data e.g. item categories, units

Names (except patients)

System

Including name-related data e.g. name categories, contacts

Visibility of items and names

System

Merging of items and names

System

Groups and departments

System

Item master lists

System

Budgets and accounts

System

Transaction categories

System

Purchase order categories

System

Location types

System

Customer stock history and
requisitions

Store

Locations

Store
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Data

Sync
records

Notes

Stock and stocktakes

Store

Transactions

Store

Including other transaction-related data e.g. inventory adjustments, backorders, builds, but
not prescriptions

Purchase Orders

Store

Unless the Procurement is done centrally preference is switched on, in which case purchase
orders can be entered on the primary for any store, regardless of its sync type

Goods received

Store

Patients

Store

Prescribers

Store

Prescriptions

Store

Including other patient-related data e.g. medication records

Only if an additional store preference is turned on (off by default)

Stores
These are a special case. The rule for these is that, if the store is an Active store, then any changes to the store record itself (anything on the General
tab) will be synced to the primary server, and then propagate on to any other sync sites as determined by the “syncs with” settings for that store on the
primary server (i.e. to any other sync sites where “syncs with” is not None). A store should only ever be an Active store on one sync site at a time.
The Set as local store checkbox is only editable for an Active store. This is used internally, and is set when the store is originally created in order to
record which sync site it was created on. It should not normally be changed.
Note that store preferences and sync settings are always local to the sync site and are not synchronised.

Centralised procurement
If this preference is switched on in the primary site, then purchase orders can be entered for any store on the primary, regardless of its sync type (i.e.
not just for active stores).
If it is switched on in a satellite, then purchase orders cannot be entered for any store on the satellite, even if it is active.
When this preference is changed on the primary, the change will propagate to all the satellites as well.

It is still possible to edit the preference on the satellite (e.g. to allow local
procurement for stores active on that site), but if that is the case, then the related
permissions for purchase orders for those stores on the primary will need to be
disabled manually in order to prevent purchase orders for those stores being
editable on both sites.

Dispensary data
Prescriptions
By default, prescriptions and any other operations in dispensary mode which affect stock levels are not synced to the primary server, unless the
Include prescriptions in sync option is enabled in the store sync preferences, as these can potentially generate a lot of sync traffic and there is usually
no need for the central users to have this level of detail - the satellite will usually have another store which supplies the dispensary and its transactions
will be synced to the primary.
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If this preference is switched off in a dispensary store on a satellite, the following data will not be synced back to the primary:
• Transactions (including backorders, builds etc.)
• Prescriptions
• Stock and stocktakes

Patients
Patients in mSupply are a special kind of customer, but for the purposes of synchronisation, we need to treat them differently - as store-specific data
rather than system data. This is because patient data only needs to be shared with other dispensing sites.
For an Active store which is also a dispensary, patient records will be synced to the primary server. Newly created patients will also be made visible in
any stores on the primary server which have been set to dispensary mode. Subsequently, patient visibility is controlled from the primary server in the
same way as other name (customer & supplier) records.
At the moment, patient records are not shared with other dispensary satellites although this may change in future e.g. if there is a country-wide patient
registration system, in which case we would have to assign a store to each patient in order to control where it can be edited. Otherwise, if the same
patient record existed on more than one dispensary satellite, then either satellite could update it and that would update the copy on the primary server,
but the copy on the other satellite would remain untouched.
Patients are not editable on the primary server unless all dispensary stores are local to the server itself (i.e. there are no dispensary stores active on any
of the satellite sites).

Other Dispensary Data
Prescribers, abbreviations, patient medication records, and repeats are also treated as a special kind of store-specific data, similarly to patients i.e. they
are synced from an active dispensary store on a satellite back to the primary server, but not shared with other satellite dispensary stores, and not
editable on the primary server unless all dispensary stores are local to the server.

Transfers
Transfers occur when there are two stores involved in a transaction, and includes stock transfers, requisitions (from a mobile store) and internal
requisitions (from another desktop store). In a syncing system, very often these two stores are not active on the same site, so there has to be extra
processing to ensure that both halves of the transaction are synced to both the initiating store/site and the responding store/site.
Both stores need to exist on both sites, and usually the initiating store is a transfer store on the responding site, and vice-versa. As of mSupply v3.83,
unless both stores are active on the same site (in which case, everything can be done locally), the bulk of the processing is done on the central primary
server when it detects the initiating half of a transfer transaction. In simple terms, the logic is something like this:
1. when the primary detects the initiating half of a transfer transaction
a. it creates the responding half of the transaction, but with a dummy invoice/serial number of -1
b. it ensures that both halves of the transaction are synced to both initiating and responding sites
2. when the responding site receives the responding half of the transaction
a. it assigns the next invoice/serial number for the store and sends that back to the primary
b. it creates a log message for the initiating half of the transaction and sends that back to the initiating site via the primary
3. any subsequent changes to the initiating half of the transaction (usually very limited in scope) on the initiating store/site will be synced
back to the primary (according to the normal sync rules)
4. any subsequent changes to the responding half of the transaction on the responding store/site will be synced back to the primary (according
to the normal sync rules)

Stock transfers
• This is where the customer in a customer invoice is another store
• The initiating half of the transaction is where the customer invoice is finalised in the initiating store/site
• The responding half of the transaction is a supplier invoice (on hold by default) in the responding store/site
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Mobile Requisitions
• This is where the supplier in a supplier (aka request) requisition is another store
• The initiating half of the transaction is where the supplier requisition is finalised on mobile
• The responding half of the transaction is a response requisition in the responding store/site
◦ this shows up as a customer requisition on mobile if the responding store is active on another mobile site
◦ or as a response requisition if the responding store is active on a desktop site
▪ the user can create one or more customer invoices to fulfil the requistion
▪ these customer invoices (when finalised) will generate corresponding supplier invoices back in the initiating store as
stock transfers

Internal Requisitions
• This is where the supplier in a purchase order is another store, and is a two-stage process
• The initiating half of the first transaction is where the purchase order is confirmed in the purchase order store/site (i.e. where the purchase
order is editable)
◦ if centralised procurement is enabled, this will be the primary site, otherwise it will be the normal initiating store/site (i.e. where
the purchase order's store is active)
• The responding half of the first transaction is a customer invoice in the responding store/site
• The initiating half of the second transaction is where the customer invoice is finalised in the responding store/site
◦ note that adding extra customer invoice lines before the invoice is finalised will create corresponding new goods received lines
• The responding half of the second transaction is a goods received record in the initiating store/site (i.e. where the purchase order's store is
active)
• If centralised procurement is enabled:
◦ the received quantities for the original purchase order lines will be updated on the primary whenever the corresponding goods
received lines are received there (and forwarded from there to the initiating store/site)
◦ when the primary receives any subsquent updates to goods received lines from the initiating store/site, it will update the
quantities in the corresponding purchase order lines
• If centralised procurement is not enabled, the received quantities for the original purchase order lines will be updated in the initiating store/
site when it receives the goods received lines from the primary

Reporting
• On the primary server if you login in supervisor mode, you can then run reports on one or more stores. The reports can answer questions
such as:
◦ How much stock on hand of item X (or all items) are there at each location?
◦ What is the value of stock on hand across the whole system?
◦ How many of item X is being used each month at each location?
• When the synchronisation system is turned on, a new Special > Users report… > Sync report… menu item is available. Choosing this
will create a report showing the last time each of your sync stores connected to the primary server. Those that connected more than a month
ago will be highlighted in red.

Requirements
• A license from Sustainable Solutions to use the web server module and the synchronisation module on the primary server.
• Internet at each sync site. This doesn't have to be on all the time for each satellite server, but at least an hour or so per day or per week
(depending on the transaction volume and the speed and latency of the internet, and how often you need primary server data updated).
Obviously, the internet needs to be on at the primary server at the same time.

How to tell if synchronisation is happening
On a satellite server
If there are queued sync records, there will be a message at the bottom left of the navigator which shows the number of sync records in the queue.
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On the primary server
• Choose Help > About mSupply
• At the bottom left of the window there is a list of tables and the number of records in each table.
• Scroll the list to near the bottom, and you will see the number of records in the sync_out table.
◦ If the number is zero, your copy of mSupply is up to date
◦ If the number is growing from day to day, there are possible reasons:
▪ you need to provide more internet time or faster internet
▪ there may be a problem that needs the attention of Sustainable Solutions. Before contacting us, make sure the internet
is connected for an hour, and see if the number is decreasing or not.

Setting up a server and satellites from scratch
Don't try this at home unless you are very confident in your abilities!
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This example is for a simple sync system with some satellites where data is entered, one store on each satellite, and a primary server that is just used to
aggregate data, set up core data, and run reports.
1. Create new data files
2. on primary;
a. choose prefs > sync
b. enter “1” for sync ID
c. enter remote sites into the syncs with list. The name is only for identification of the site
d. Choose file > edit users
I. create a user like xsyncuser
II. note the password,
III. xsyncuser must have a default store set
3. If stores are to be created on satellite, then: on each satellite site (else if creating on primary, skip to below)
a. Choose prefs > sync
b. enter site’s own ID in “sync ID” field (same ID set on primary)
c. Enter 1 entry in “sync with” section
d. ID is the ID of the primary site
e. user & pass: as for user set up on primary
f. IP address of primary (include :port)
g. Choose Special > stores
I. There will be one store created by default with the data file (General)
II. View (double-click) the General store, go to > sync tab
III. set to active store
IV. set to local store
V. set the type for the row in the list for syncing with the primary to “active/collector store”
VI. Rename the store to the name you want (e.g. My Site General store)
VII. Click OK to Save the record- it will show in the sync queue in the Navigator, and will sync up to the primary.
4. Back on the primary:
a. Open the store that has just synced :
I. Set to be a collector
II. Set sync with for satellite ID to be active/collector
III. The Sync ID field should show the ID of the remote site
IV. On the visibility tab set item and name visibility as needed.
b. Choose prefs > sync
I. double click the site in question. Click generate sync records for site
A. Choose the option- update existing store
B. Records will be generated for items, names etc and will sync to the satellite
5. Repeat step 3 on each Satellite and Step 4 on the Primary after setting up each Satellite
1. If stores are to be created on primary, then:
a. create stores
b. set item and name visibility as needed
c. in File > Prefs
I. on sync tab, add a record for each site, assigning a sync id and a name (it's not really “user name” - more “site
name”)
d. in Special > Stores
I. for each store
II. Open the store that has just set up in prefs :
A. Set to be a collector
B. Set sync with for satellite ID to be active/collector
C. Enter the Sync ID field for the remote site
e. Print a custom report for all recs in the store table to get IDs
f. Choose prefs > sync
I. double click the site in question. Click generate sync records for site
A. Choose the option- new store
B. Records will be generated for items, names etc and will sync to the satellite
II. run Footrunner code:
A. sync_create_records_for_store
B. (<store_id>;"THIS_IS_THE_UUID_OF_THE_STORE_ON_PRIMARY")

\\ ALERT("Bhayo")

Previous: Reminders Next: Transaction Codes
2011/05/19 06:04
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Transaction codes
Transaction type codes
mSupply uses a series of two letter codes to denote the different types of transactions it can handle.
Code

Meaning

ci

customer invoice (goods supplied to a customer)

cc

customer credit (goods returned by a customer)

si

supplier invoice (goods received from a supplier)

sc

supplier credit (goods returned by you to a supplier)

sr

repack (A stock line is broken down into smaller pack sizes)

bu

build- an internal transaction where you manufacture (build) items from raw materials in stock.

rc

receipt (cash receipt) from a customer (a customer pays for invoices issued)

ps

payment (cash payment) to a supplier

Inventory adjustments have a type of “si” if stock is being increased and “sc” if stock is being reduced. They have a reserved
name whose name[type] field has a value of “invad”

Transaction Status Codes
Transaction status
mSupply uses a set of two letter codes to keep track of the status of each transaction:on:
Code

Meaning

nw

new invoice

sg

Suggested

cn

Confirmed

fn

Finalised

wp

The order has been received over the internet (a “web” order), and it is currently being processed

wf

The order has been received over the internet (a “web” order), and it is finalised
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For orders
Code

Meaning

sg

The order has been created, but the “stock on order” value for each item has not yet been updated. If
another order for the same item is processed, mSupply will not take account of suggested orders.
Suggested orders can be deleted.

cn

The “stock on order value” for each item has been updated. Confirmed orders can also be
“unconfirmed” if you cancel an order. Items & quantities can still be edited.

fn

The order has been received, a price calculation done, and the order has been turned into a “supplier
invoice”. The order is now completed, and can be deleted.

For Supplier invoices
Code

Meaning

nw

The “new supplier invoice” menu item has been chosen, but the OK button on the invoice has not yet
been pressed, or confirming the invoice has been postponed. (This option is only available if “confirm
supplier invoices automatically” is unchecked in the Preferences). Note: quitting mSupply by choosing
the “quit” command from the file menu or click the application close box (Windows only) while you are
entering a new supplier invoice will result in the invoice being saved with status “nw”. To confirm the
invoice, open it then click the OK button

sg

This status is not used for supplier invoices- invoices of status “nw” become status “cn” when the OK
button on the form is pressed

cn

The invoice has been entered, but can still be edited.

fn

The invoice has been finalised , and can no longer be edited.

For Customer invoices
Code

Meaning

nw

The “customer new invoice…” menu item has been chosen, but the OK or “confirm” button has not yet
been pressed.

sg

The invoice has been created. An order from a customer has been received, and the items put against the
invoice are still in your store, but are no longer “available” to issue to other customers. (i.e., the
“available” amount for each item line has been reduced, but the “quantity” amount has not). Note that if
“one step confirm” is checked in the Preferences, then customer invoices move straight from being
status “nw” to status “cn”

cn

The invoice has been confirmed by clicking the “confirm” button, which is done when the stock leaves
the store. Lines that couldn't be supplied are added to the “backorder” file. The invoice can still be
edited.

fn

The invoice has been finalised, and can no longer be edited. If the Customer invoice is to another store
in your system, then finalisation of the Customer Invoice also triggers generation in the receiving store
of the Supplier Invoice or Goods Receipt (if the Customer Invoice is the result of a Purchase Order /
Requisition from the receiving store)
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For Builds
Code

Meaning

nw

The build is being entered for the first time.

sg

Suggested - the raw materials are taken out of stock, but the finished product (the item to build) is not
yet entered into stock.“

cn

Confirmed - the raw materials are taken out of stock and the finished product is entered into stock

fn

Finalised - the build can no longer be edited

Previous: Remote synchronisation Next: Budgets
2012/12/04 14:49

·

Budgets
To show the budgets window, choose Special > Show budgets

Two kinds of budgets
mSupply supports two different types of budgets.
• The budget module described here allows you to track spending and/or sales of items against your targets, which are entered as budgets.
Items are grouped together by their account code.
• The customer budget module allows you assign a budget for each supply point (customer), and both report on how much they have been
supplied, and limit supply of that item. Information on the customer budget module is available here.

Activating the budget module
To use this feature, you must check Activate budget module on the Invoices 1 tab of the mSupply Preferences window:
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But please note, before you do this you must enter a budget period - see the Adding a budget section below.

Overview
Firstly, you define budget periods which can be any length you choose - months, quarters, years or whatever.
Once budget periods are set up, you must allocate each transaction that issues stock (customer invoice, inventory adjustment - reduce stock or supplier
credit) to a budget period (see the Including transactions in your budget section below for details). The items on that transaction will have been
assigned accounts (See here for how to add item account codes, and you can then view budget reports based on expenditure or sales broken down by
the accounts you have assigned to items.
At the end of a budget period, that budget period may be locked so that no further entries may be made.
To use the budget feature, these are the steps to be taken:

Viewing budget details
Choosing Special > Show budgets presents you with the Budget period list window as shown (note that the latest entry appears at the top of the list
and the oldest entry at the bottom):
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Adding a budget
Click on the New button in the Budget period list window to add a new budget. This window is displayed:

In the Description field, enter the name of the budget period - for example FY 2008.
The Start date is non enterable; the first time you use this feature, the field is set to 00/00/00, on subsequent occasions the it will show the date one
day later than the End date entered on the previous occasion.
You should enter the End date, the date the budget period ends.
In the Account Description column, a list of account names and code(s) will be displayed. To set budget figures for these accounts, select the Account
to which the budget applies by clicking on the line. Once selected, click on the figure in the Budget column of that line, and enter the budget figure.
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Deleting a budget
Select a budget from the list in the budget list window shown above and click on the Delete button to delete a budget. You will be asked to confirm the
deletion. Note, you can only delete budgets in order, starting from the most recent and you cannot delete a budget that has been used in any
transactions (customer invoices) or has accounts with a budget amount of more than zero.

Editing budgets
Should you wish to edit a figure allocated to an account, double click on the appropriate line on the Budget period list and this brings up the Budget
edit window; Click on the Account description, End date and various budget value fields and change them as required. Note that a budget can only be
deleted when all of its accounts are allocated zero budget amount.

Budget Reports
To find out information like expenditure against budgeted amount for a particular budget (and a whole lot more!) then you need to open the budget
first by double-clicking on it in the Budget period list mentioned above. This opens the Edit Budget period window:

The Show budget against income and Show budget against expense buttons change the table to display the selected information for each account for
that budget period. The Show budgets button changes it back to show the budget account information for the period.
The Print button prints out the table which is displayed at the time it is clicked.
The Show related button will display all the purchase orders, goods received notes, customer invoices, supplier invoices, supplier payments, customer
payments or inventory adjustments which are related to the budget period. You simply click the button and choose which you want to see.

Including transactions in your budget
When the budget module is activated, a new Period field appears at the top of transactions that issue stock. Here it is on a customer invoice:
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It is set to “Unconfirmed or none” by default and you must select a period before the invoice can be saved or closed. If you don't, mSupply will give
you a warning message when you click on the OK or OK & Next buttons.
Note: you don't have to select a period if you're viewing or editing a customer invoice (or other stock issuing transaction) that was created or
confirmed before the first budget period starts.
Once the transaction has been saved with a budget period, when it is confirmed the goods on it will automatically be accounted for in your budget and
will affect any budget reports you run.
Previous: Transaction Codes Next: The Edit Menu
2011/05/20 06:17

·

The edit menu
The commands in the Edit Menu can be used when you are entering text, just the same as in a word processor.
Undo: The previous contents can be retrieved if the document has not been saved.
Cut: Deletes the currently selected text and places it on the clipboard
Copy: Copies the currently selected text and places it on the clipboard
Paste: Replaces the selected text (if there is any) with the contents of the clipboard. If there is no selected text, the clipboard contents are inserted at
the insertion point (the blinking cursor)
Clear: Clears the text in the particular field.
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If the Cut/Copy/Paste items are dimmed out, it is because you are
not currently in a text entry field.

Previous: Budgets Next: Transaction categories
2011/05/10 04:35

·

Transaction categories
From the Special menu, choose Categories to allow you to group transactions together. Each type of transaction can have its own list of categories.
For example customer invoices might have a category “normal” and “urgent”. Inventory adjustements might have categories “expired”, “damaged”
and “stocktake”

Click on “New” button to create a new category.

The categories can be added to customer, customer credit, supplier, supplier credit, repack, build, inventory adjustment while creating or editing
transactions.
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Once you have assigned categories they will show as a drop-down list when you enter a new invoice or transaction.
(In versions of mSupply prior to v1.8 categories were set in the Preferences, and there were only categories for supplier and customer invoices), and
they can be reported on, refer How to report by invoice category.
Previous: The Edit Menu Next: Virtual stores
2011/05/20 06:36

·

Virtual stores
From the Special menu, choose Show stores

What is a "Virtual Store"?
In mSupply a virtual store is a way of segregating particular stock so that some users only see that stock and the transactions associated with it. When
a user logs into mSupply, they choose a particular store to login to - this we call the current store. mSupply then operates as if:
1.
2.
3.
4.
5.
6.

the stock in that store is the only stock available.
Only stock from the current store will be available for issuing,
Reports will relate to stock in that store
Issues from and receipts to that store only use the stock in that store
Only suppliers and customers sets as “visible” for that store will be able to be chosen for receiving and issuing goods
Only items set as “visible” in that store will be usable (So for example if you have a store that handles only vaccines you can make
vaccines visible in that store (and invisible in all stores that don't handle vaccines)

Many users of mSupply will only have a single store, and so will have no need of this functionality.
The following examples illustrate situations where you might want to run more than one store.
• A hospital pharmacy where you have two dispensing locations: an inpatient pharmacy and an outpatient pharmacy.
• A pharmaceutical warehouse where stock from a particular donor is received, issued and accounted for separately to stock in the rest of the
warehouse.
• A hospital pharmacy where the pharmacy store stock is treated separately to the dispensary stock. You would set up mSupply with a store
called “Pharmacy store” and a store called “Dispensary”. You would use the stock transfer feature to move stock from the pharmacy store
to the dispensary.
• A pharmaceutical warehouse where you have 2 or more actual warehouses. These may be adjacent or several hundred kilometres apart. (Of
course you need network connectivity between sites to run mSupply at each site).
• You're using mSupply mobile- each mobile site will synchronise data with a virtual store on the mSupply server.
Note: In the above examples, when you log on, you would select the appropriate mode - see table:
Examples
Hospital Pharmacy

Hospital Pharmacy

Warehouse

Stores

Log on mode

In-patient Dispensary

Dispensary

Out-patient Dispensary

Dispensary

Pharmacy store

Store

Dispensary

Dispensary

Adjacent Store

Store

Remote store

Store
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Viewing available stores
From the Special drop down menu click Stores. The Stores list window (shown below) appears and displays a list of all the stores which currently
exist including their sync type:

Editing a store
Double-click on any store in the list in the View stores window described above to view or edit its details. You will see the same window as in the
Creating new stores section below but the various fields will be filled in with the store's current settings. You can click into the fields and edit them as
desired. Note that in the top left of the window, the name of the store you are editing is always displayed, regardless of which tab you are on, so that
you always have a reminder of which store you are editing!

Creating new stores
To create a new store click the New store button in the Store list window shown above. This will display the Store details window shown below, which
allows you to enter the details of the new store:
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Store code: The code used to identify the store. If you have a lot of stores it would be helpful if you decide on a good pattern to use for the codes.
Store type: Set in the drop down list to the right of the Store code field. Can be one of:
• Store: a normal store used for managing inventory and issuing to customers
• Dispensary: a store used for managing inventory and dispensing to patients
• Report: a special type of store used for reporting information only, not managing inventory. Don't use this unless specifically told to do so!
Name: The name used to identify the store throughout mSupply.
Organisation name: The name of the organisation running the store. Defaults to the organisation name entered in File > Preferences.
Address line 1-5, Postal /Zip code, phone: Enter the address and contact details for the store in here if there are any. These details can be used in
reports
Disable this store: Check the Disable this store checkbox to stop the store from being used. You might want to use this feature if the store is not ready
for use yet or is no longer to be used and can't be deleted. You will be asked to confirm the disabling after clicking on the OK button on this window.
Responsible officer: Select the officer responsible for the store in this drop down list. A helpful reminder for others and can be used in reports.

Tags
Tags are used in reporting to group stores together. This area shows the tags that the store currently has. To add a tag, simply click into the area and
type the tag's name. When you have finished typing the tag's name then press the Tab or Space keys on the keyboard (not Enter or return, that will
close the window!). You know when you have done it right because the tag will appear in its own little box with an 'x'. If you want to remove any tag
from the store, simply click on that 'x'. In this way you can add or delete as many tags from a store as you like.
After having created a new store, the Stores list window will display the new list of all stores and you may double-click an entry to edit that store's
details. A number of things that will need to be attended to are:
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To do a number of the following steps, you will need to log in to the new store. To do this, you will need to give yourself access
to the new store by Managing users. Any other users who need to access the store will also need their permission altered
accordingly. After giving yourself permission to log in to the new store, log in to it and carry out these steps.

• Set the preferences for the store.
• Set the store's logo so that it can appear in print-outs and reports.
• Set the visibility of items in the store. All items in the system will be set to invisible in the new store when it is created. You will need to
modify visibility of items in order to be able to handle stock of those items.
• Setup Synchronisation if you are going to use a synced system. See Remote Synchronisation.
• Setup any custom store data (used for reporting).
• Set the master lists used by the store (a convenient method for controlling item visibility).

If this newly created store will be 'Active' on a satellite server on a synced mSupply system (refer to Remote Synchronisation,
then user access to the store will need to be defined on that satellite server.

The preferences tab
This tab contains the preferences that can be set for a store. Each store has its own settings for these preferences: this is different for the settings in File
> Preferences which apply to all stores.

This is what each preference does:
Sort available batches by VVM status If the store is only to be used for vaccines, this option allows you to sort the list of available batches by the
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vaccine status column rather than the expiry date
Patient created in this store not visible in other stores If you check this box, patients that are created in this store will not be visible in any other
stores - they will only be visible in this store.
Names created in this store not visible in other stores When this box is checked, if you create a name (a customer, supplier, manufacturer or donor
etc.) in this store then it will be visible only in this store and not in any others.
Allow users to enter total quantities to distribute to appropriate packs If you check this checkbox, users will be able to enter the total quantity that
they wish to distribute to appropriate packs.
Round up the distributed quantity Checking this box means that mSupply will round the value for the distributed quantity upwards.
Able to pack items into multiple boxes If this box is checked, then mSupply will provide a detailed way of packaging goods in to boxes to be
distributed to clients.
Store: Able to issue in foreign currency If you check this box, you can use foreign currencies on supplier invoices for overseas suppliers.
Allow editing selling price on customer invoice lines Checking this box means that you can edit individual selling prices on customer invoice lines.
Purchase order must be authorised If checked then purchase order authorisation is turned on. See Ordering Items From Suppliers for details on this
functionality.
Finalise customer invoice automatically This setting automatically finalises a customer invoice when it its status is set to confirmed, which is
normally when the goods are dispatched.
Customer invoices must be authorised If this preference is checked then all customer invoices must be authorised by a user with permission to do so
before they can be confirmed (i.e. goods can only be sent to a customer after the action has been authorised). See Invoice Authorisation for details.
Confirm customer invoices automatically This setting is used to set a Customer Invoice's status to confirmed when the OK button of a New
Customer Invoice is clicked. This means that it is not possible to print a picking slip for the issued goods.
Supplier invoices must be authorised If this preference is checked then all supplier invoices must be authorised by a user with permission to do so
before they can be confirmed (i.e. goods can only be brought into stock when the action has been authorised). See Invoice Authorisation for details.
Confirm supplier invoices without asking This setting is used to set a Supplier Invoice's status to confirmed when the OK button of a New Supplier
Invoice is clicked. This means that when the OK button is clicked the goods are made available in stock without informing the user.
Goods receipt lines must be authorised This setting is used to restrict authorisation of a Goods Receipt to authorised users only. Only when a Goods
Receipt is authorised can it be processed for the goods to be made available in stock.
Locations must be entered for goods received This setting requires the user to type a shelf location on the Goods Receipt Item Line form when
receiving goods into Store. This feature enforces identification of shelf location of stock.
Able to specify manufacturer when receiving, ordering or quoting for items This setting gives the user the option to record the manufacturer of
goods when making Purchase Orders or when doing a Goods Receipt or entering a Quotation from a supplier
Custom stock fields In this area you can choose to use up to four custom fields for labelling incoming stock. The checkboxes tell mSupply to use the
various custom fields and the textboxes contain the labels that mSupply will use for these fields. Each custom field that is checked here will appear
(with the label it has been given) on a supplier invoice when an item is being received (see here and here for details). The information entered will
then be visible whenever stock is shown (e.g. when issuing stock on a customer invoice or when viewing the stock of an item on the stock tab of the
item details window).

When finalising a Goods Receipt
There are three options:
• Don't receive goods into stock until supplier invoice is taken off hold - for goods to enter stock you must finalise the goods receipt and then
take the automatically generated supplier invoice off hold
• Receive goods into stock, and leave supplier invoice confirmed - goods enter stock as soon as the goods receipt is finalised. The
automatically generated supplier invoice is created with confirmed status.
• Receive goods into stock, and finalise supplier invoice immediately - goods enter stock as soon as the goods receipt is finalised. The
automatically generated supplier invoice is created with finalised status.
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How you set this preference is determined by how separate your goods receiving and finance sections are. If they are not in the same building, you
might want to use the “Receive into stock and leave confirmed” option, as this will allow you to proceed with issuing goods without waiting for the
finance department's approval.

For stock transfers, the supplier invoice in the receiving store should be...

This option applies to all stores that this store transfers stock to.

This option is used to determine whether stock transferred from one store to another is received to a destination store and automatically introduced to
stock or not. The On hold option prevents stock from being introduced, while the Finalised option automatically makes the stock available for use in
the destination store - without the receiving store having the opportunity to amend the Goods Receipt.
• Choose Finalised if there is no need to check / alter the quantity received compared to what was sent.
• Choose On hold if the store is being used by mSupply mobile, and the goods receipt needs to be confirmed before receiving.

The logo tab

Here you can paste in a logo you have copied to the clipboard - you must copy the contents of a file to the clipboard, not the file itself. The file can be
in .jpg, .png, .bmp, .gif, or .tiff format. This logo will be displayed at the bottom right of the navigator when you login to this store only. It will
override any logo saved in the file preferences. This store logo will also print out on standard customer and supplier invoices etc. instead of the logo
stored in file preferences.
Note, after saving the image you must login to mSupply again or switch to the store to see it.
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The Custom fields tab

This tab is used to save any custom information for the store that you might need to be made available in mSupply, for instance in reports. Each piece
of information that you save has a label (which mSupply will use to refer to it) and a piece of data. At the moment you cannot edit reports or other
parts of mSupply yourself to make use of this information, this must be done by Sustainable Solutions. This might change in the future, we're always
listening to our users!

Adding a custom field
To add a new field, click on the New line button; a new line with default values of “Field label” and “Field value” in the two columns is added to the
table and highlighted. Click on the value in each column and type the real label and value for the piece of information.

Editing an existing custom field
To edit the label or value of any custom field, simply click on the cell in the table and edit the entry.

Deleting a custom field
To delete any custom field simply select its row in the table and click on the Delete line(s) button. You can use Shift+click, Control+click, Control A
(or Cmd instead of Ctrl if you're using a Mac!) to select multiple lines and delete them all at once if you like.

Controlling Item Visibility: the Master lists tab or the Visibility tab
Controlling the visibility of items in different stores is important because you can only order, distribute, receive goods for and report on items that are
visible in your store. It's also important that stores don't have items visible that they don't use so that they don't accidentally order them etc.
If you have lots of stores in your data file, managing item visibility can turn into a difficult task. Thankfully, mSupply has some helpful tools to make
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it simple! There are 2 ways to manage item visibility and you use one or the other, not both:
1. automatically using the Master lists tab or
2. manually using the Visibility tab
Each are useful in different situations and are described below.

The Master lists tab
If you have a lot of stores in mSupply, we recommend that you use master lists to control item visibility. Especially in a syncing system because it
means that the visibility of newly created items will be automatically handled correctly. The visibility of items in a store whose visibility is controlled
by master lists is immediately updated if any changes are made to any of the master lists. For instance, if a new item is added to a master list
controlling visibility then that new item is made visible in all stores that use the master list. And any items deleted from the master list are made
invisible in any store using that list.
The first thing to do is to turn on the preference to make master lists control item visibility in stores. Do that in File > Preferences… on the Item tab see General preferences, the item tab for details.
The next thing to do is to create the master list(s) that will control item visibility. See Item master lists for details on how to do that. Giving your
master lists helpful names will help you remember what they're for e.g. “Store xxx visibility list”.
Now edit the store to tell mSupply which master list(s) will be used to define which items are visible in the store:
1. Click on Special > Show stores… (or click on the Stores icon on the Special tab of the navigator)
2. Double-click the store who's visibility you would like to manage:

3. Click on the Master lists tab:
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4. Select which master list(s) you would like to control the visibility of items in your chosen store by checking their checkbox in the Use
master list column:

In this example, the District warehouse master list has been selected to control the visibility of the District warehouse 1 store.
5. Click the OK button to finish. As soon as you do that the items on the selected master list(s) are made visible in the store and any items not
on the selected master list(s) are made invisible. Any new items added to the selected master list(s) will be made visible in the store and
any items removed form the master list(s) will be made invisible in the store.

The Visibility tab

If your system is a Sync system (with Primary and Satellite servers) and your store is hosted on a Sync Satellite server, then you
will not see the Visibility tab. These settings need to be made while logged in to the Sync Primary Server.
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You will also only see this tab if you are editing the store you are logged in to.
To log into a store you may need to first give yourself permission to do so under File > Edit Users > Double-click your user
name > the Log in rights tab. Phew!

The Visibility tab contains tools for manually setting the visibility of items in a store. These are good tools to use if you do not have many stores in
mSupply and only need to make occasional changes to item visibility to a number of items. If you want to make a change to a single item's visibility in
a single store then you can do that by going to the item's details window and using the store tab (see Item basics, the stores tab).
If you have turned on the preference to control item visibility by master list then you will not be able to use the visibility tab or the visibility settings
on the store tab of an individual item's details window.
Here's what the tab looks like:

The buttons provide you with different ways to hide and show items and names in the store (Note: be careful showing names in databases that have a
lot of names records. For example if you have 20 virtual stores and 200,000 names in your database, showing all names in all stores will create 4
million (20×200,000) records to map the visibility of each name in each store):
• The Show stats button shows how many items and names are currently hidden and visible
• The Set item visibility to match master lists for this store button matches the item visibility to the master lists that are selected on the
Master lists tab. (Note: this is a one-off operation, no changes will be made to item visibility if the master lists are changed after you click
this button. See the section above if you want that to happen!) If there are some items that can't be set to invisible (because they have stock,
for example) a temporary master list will be created containing the items which could not have their visibility removed. Use the list to
decide what to do with each item.
• The Make all items in this store visible and Make all items in this store invisible both do just as they say.
• The Set pack to one for all visible items in this store will check the Allow pack to 1 conversion and Convert pack to 1 when receiving
checkboxes for all items in the store so that all stock received into the store will automatically be received in packs of 1. This is useful in a
dispensary store, for example.
• The Set to match button requires you to choose a master list. Clicking the button makes the items that are on the master list selected in the
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drop down list next to it visible in the current store. Note that it does not hide items that are already visible but not on the master list.
• The Make all names in this store visible button does exactly what it says and makes all names in the datafile visible in the current store.
• The Make all names in this store invisible button does the opposite and makes all names in the datafile invisible in this store. Be careful
using this - you won't be able to receive or distribute stock from/to anyone until you make some names visible in the store!
• The Query names button enables you to search for names (customers, suppliers, manufacturers, donors etc.) in the datafile. Every search
you run creates a selection which is then operated on by the Make found names visible in this store button.
• The Make found names visible in this store will make all names in the last selection made with the Query names button visible in this
store. Ask Sustainable Solutions for help if you're not sure about getting the right selection of names, as the consequences of making a
mistake can be time consuming to fix!

The Synchronisation tab
mSupply has a synchronisation system designed to cope with environments which have weak or intermittent internet. The system passes information
between a server and satellite (or tablet running mSupply mobile) when there is an internet connection and stores information to be sent when there is
not.
This tab is where the store specific settings for synchronisation are mad. See Remote Synchronization for more details.

Deleting a store
To delete a store, click on the Delete button in the View stores window. Note: deletion of a store is a serious thing to do and is only possible when that
store contains zero stock and there have been no transactions recorded. mSupply will check and tell you that deletion is not possible if these criteria
are not met. If you can't meet these criteria and you still want to stop people using the store then you can disable it. Do that by checking the Disable
this store checkbox on the Store details window (see above).

Transition from a customer to a virtual store
If you have a customer that is about to start using mSupply mobile, once you create the virtual store you will end up with two customers with the same
(or similar) names, as creating a virtual store also creates a linked name. Fear not: you can use mSupply's Merge names functionality to join the two
names into one record. Note that you must choose the newly created store's Name as the “Name to keep” and the older Customer's name as the “Name
to delete”
Previous: Transaction categories Next: Custom Data
2011/05/20 06:32

·

Custom data
Custom data allows you to add data to mSupply that doesn't naturally fit into one of the existing fields.
• Choose Special > Show custom data… to show the list of custom data sets.

790

mSupply user guide July 2018

Setup Fields
• Click New
• This window is shown:
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• For our example, we're going to record population in several regions each year, so we need
◦ A real number field to store the population number
◦ A text field to store the region name
◦ A date field to store the year
• We've labelled the data set RegionalPopulations
• To change the field names, click once on the name, and then wait a second or two and click again- now it is editable:

Adding data
• Click the data tab then click New
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Using data in reports
• You can extract data by using the following method in a pagepro report
• custom_value_get(“data_set”;“field_to_query”;“search_value”;“field_to_return”;→“variable_to_return”)
◦ “data_set” is the name of the data set. e.g. "RegionalPopulations"
◦ field_to_query is the internal name of the field “text_1” , “Text_2”, “real_2”, “date_7”
◦ “search_value” is the value you're looking for in “field_to_query”
◦ “field_to_return” is the field name of the value to return
◦ “variable_to_return” is a pointer to the variable that will contain the data returned.
• Sound too complicated? We usually build these reports for clients, but this documentation is for the technically minded who want to build
their own.
Previous: Virtual stores Next: FrontlineSMS Integration
2011/04/19 07:25

·

Currencies
Choosing Currencies from the Special menu opens a window with a list of currently entered currencies. The home (default) currency always has a rate
of 1, and the entry in the rate column of additional currencies is the number of units of the default currency equivalent to 1 unit of the other currency.
In the screenshot below, the home currency is the Australian dollar (AUD) and the Rate of the Euro is 1.3317, so, at the time of writing, 1.3317
Australian dollars (the default currency) was equivalent to 1 Euro, 0.7485 Australian dollars was equivalent to 1 New Zealand dollar, etc.
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Buttons in the currency list window :
New: To add a new currency.
Get internet rates: Providing you have an internet connection, clicking this button will update the rate of exchange from the Yahoo website.
Update mSupply rate: The refreshed rates will only become active when you click this button.
OK: Click OK to close the Currencies window when you have finished editing currencies.

Editing a currency entry:
Double click a currency to edit it manually. Note that your “home” currency should be entered with a value of “1”, and all other currencies should be
entered with a rate relative to your home currency. A window with the currency code and the current rate will appear.

You can edit the rate. Note that doing so will automatically update quotes that use that currency.

To change your default currency
1. Double-click on your default currency in the list
2. Click the padlock icon
3. Choose a different home currency.
Note that all other currencies will have to have their rate entered relative to the new default currency
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Buttons in the Edit currency window :
Delete: Click to delete the currency. If the field is dimmed, the currency is in use by quotations, and cannot be deleted.
Cancel: Click to exit the window without saving changes.
OK: Click this button when you are finished editing currencies.
Previous: Using the Remote Client Next: Using Foreign Currencies in Transactions
2011/05/20 06:18

·

FrontlineSMS integration
mSupply has the ability to integrate with your FrontlineSMS installation. This allows you to send your current stock levels to mSupply using an SMS
(text) message from any mobile phone. This is particularly useful if, for example, you are a mobile or remote health post or dispensary which doesn't
have internet access and only needs to send in information about a few items at a time.
To get mSupply talking to your FrontlineSMS installation, follow these simple steps:

1) Tell mSupply the details of your FrontlineSMS database
You do this on the FrontlineSMS tab of the mSupply preferences page (File > Preferences). See here for a detailed description of how and what to set.

2) Set the SMS code and pack size of the items you want to receive information about
Because SMS messages need to be kept short (they are only allowed a limited number of characters), instead of writing the full name of an item in an
SMS message you simply write a short code which represents it. It is impossible for mSupply to know the pack size of the items being counted in the
remote store so you also need to enter a pack size to be used for calculating item quantities from the pack quantities supplied in an SMS. You set both
the SMS code and SMS pack size for an item in the Misc tab of the item's Item details window (via the Items > Show items menu). For detailed
instructions see the 'The Misc(ellaneous) tab' part of 'The Item Details Window' section on the items basics page here.

3) Add SMS senders as contacts to customers
mSupply needs to know which of your customers an SMS message has been sent from. To give it this information you simply add each mobile phone
number that will be sending messages to mSupply to the appropriate customer as a contact. To do this use Special > contacts (see here for details) or
Customers > show customers, select the customer, go to their contacts tab, click on the Add contact icon and enter the contact's details.

Please note: whichever way you do it, the phone number must be entered exactly
as it is recorded in FrontlineSMS (it will probably include the international
dialling code e.g. +977 but this will vary with phone service providers). You can
find out how FrontlineSMS stores a sender's number by sending a dummy text
message and viewing its details in FrontlineSMS.

4) Make sure that emailing is turned on in mSupply
mSupply will inform the people selected in the preferences (see step 1 above) by email when a message has been received and is successfully
processed or has an error. But mSupply can't send the emails if you haven't configured it to. To set up emailing, go to File > Preferences and click on
the Email tab. See the E-mail section of the general preferences page here for details of the various settings.
OK, that's the setup complete and you're ready to…
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5) Send an SMS message to mSupply
The text message you send to mSupply must be in the correct format. Any mistakes and the message will be rejected and will have to be resent. The
correct format is this:
keyword item_code item_value item_code item_value…
keyword: This is the keyword you set in the Frontline preferences (step 1 above) that enables the software to recognise a message as intended for
mSupply. If this keyword does not exactly match what is set in the FrontlineSMS preferences mSupply will ignore the message.
item_code: An SMS code identifying an item in mSupply. You set these in step 2 above.
item_value: The number of the item represented by item_code that you have in stock. Obviously, the number must not be negative!
You can have as many item_code and item_value pairs as a single text message will allow. But they must always be paired. If mSupply finds an
item_code not matched with an item_value it will reject the message and it will need to be resent.
Every single element (the keyword, an item_code or an item_value) of the message must be separated by a space.
To make all this clear, let's have some examples:
• A valid text message: msm am 1000 lp20 2000 cf 1 (msm is the keyword; am, lp20 and cf are item SMS codes; 1000, 2000, 1 are amounts
of the corresponding items in stock and each element is separated by a space)
• An invalid text message: msm am 1000 lp202000 cf 1 (msm is the keyword; am, lp20 and cf are item SMS codes; 1000, 2000, 1 are
amounts of the corresponding items in stock but the space between lp20 and 2000 has been missed out. mSupply will interpret lp202000 is
an item SMS code which doesn't have a paired value and reject the message)
• A valid text message: s 201 1000 102 3000 lf 200 (s is the keyword; 201, 102, 1f are item SMS codes; 1000, 3000, 200 are amounts of the
corresponding items in stock and each element is separated by a space)
• An invalid text message: msm am 1000 lp20 -2000 cf 1 (everything's OK except the -2000. A stock value can't be negative so mSupply will
reject the message)

It is OK to enter multiple spaces where there should only be one or to add leading
and trailing spaces to the message. Because mSupply is clever software it will
know what you meant and ignore the extra spaces.

When an SMS message has been received by mSupply an email will be sent to the recipients selected in the FrontlineSMS preferences (set in step 1
above). It will tell them that it has been successfully processed or that there was an error (and will give details of the error). In the case of a successful
message mSupply will also create a reminder (see here for information about reminders) for the recipients selected in the FrontlineSMS preferences.
In the case of an error, the e-mail recipient should contact the sender to correct the mistake and resend their message.

6) View and complete the stock history record
When mSupply has successfully processed an SMS message it produces a Customer stock history record of the appropriate type (imprest or stock
history) for the appropriate customer. See Customer stock history records for more information on these. The stock history record will have a status of
'suggested' and must be viewed and completed by someone in mSupply before it is turned into a customer invoice.
The point of creating reminders for people on successful receipt of an SMS message is that the customer stock histories don't get forgotten!

7) If anything goes wrong
Any errors which occur during the processing of SMS messages are sent by e-mail to the people selected in the FrontlineSMS preferences so that
appropriate action can be taken. The error messages detail the problem to make troubleshooting easier. The most likely problems with SMS messages
are:
• Sender phone number not added as a contact to a customer in mSupply or not added exactly as it appears in the FrontlineSMS database.
• Keyword forgotten or wrongly typed. In this case the message will appear to have disappeared into thin air! mSupply will ignore it because
it is the keyword that identifies it as an mSupply message.
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• Space missing between message elements. You will receive an error message about item codes and item values not being paired in this
case.
Please note that all SMS and FrontlineSMS database error messages are also written to the log: to view them go to Special > View log (if you want to
display only SMS errors select the 'SMS error' item in the right hand drop down list in the log display window). This can be very helpful for working
out if anything's gone wrong, especially if emailing is not working (because you've forgotten to set it up - in step 1 above - or your internet connection
is broken or slow).
Previous: Custom Data Next: Asset management
2012/06/08 09:51

·

Using foreign currencies in transactions

The foreign currency feature enables you to receive stock from suppliers in the suppliers own foreign currency and also distribute goods to customers
in their own currency.

Set up Foreign Currencies for Customers and/or Suppliers

You must have Foreign Currencies configured in mSupply if you are using this
feature; you can set them up now using Currencies and once you have done this,
performing the steps below.

Set the Store to use foreign currency
1. From the Navigator click drop down menu Special> Show Stores… double click to select the store in which you want foreign currencies
to be used and in the window that appears hit tab Preferences.
2. Check Store mode: Able to issue in foreign currency.
3. Click OK and return to the mSupply Navigator.
Set the currency of the Customer or Supplier
1. From the Navigator choose Customers > Show Customers.
2. Locate the Customer and double-click it. In the window that appears click the General tab and in Currency drop-down list (top-right)
select the appropriate currency for that Customer.
3. Click OK to return to the Navigator and do the same for the Supplier if required.

Using the Foreign Currencies
• Generating an invoice for goods (either from a Supplier or to a Customer):
◦ receive goods from a Supplier in a foreign currency
◦ issue goods to a Customer in a foreign currency
• Generating a credit for returned or unwanted goods (either from a Customer or to a Supplier):
◦ receive returned goods from a Customer in a foreign currency
◦ send/return goods to a Supplier in a foreign currency

Supplier invoices

As an example for the guide, our store operates with Australian dollars (AUD) as
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the local currency, and is making a purchase from a European supplier which uses
the Euro (EUR)

•
•
•
•
•
•

From the Navigator choose Suppliers > New Supplier Invoice
In the Supplier Invoice window that appears select your supplier and view its details by double-clicking.
Click the Price tab and change the currency (as highlighted in box 1 below) to the currency in which the supplier provides the items to you.
Return to the General tab and click button New line to add a new item line.
In the window that appears type the details of the item you are receiving and hit button OK & Next to add further items.
Once all items are added, again click the Price tab and review the item prices as highlighted in 2 below:

The columns headed 'Price FC' and 'Extension FC' in box 2 above show the cost
price of goods to you in Euros - i.e. the Foreign currency which the supplier uses,
while the figures in the columns on the right show the prices in Australian dollars i.e. your local currency.

• Click OK to save the Supplier invoice and introduce the items to stock.
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Customer invoices
• Ensure Foreign Currencies are active as per the instructions at the top of this page.
• From the Navigator choose Customers > New Customer Invoice.
• In the Customer Invoice window that appears select your Customer in field Name and note the currently set currency and its rate as
highlighted in box 1 below.
• Now click the New Line button to add a new item line.
• In the window that appears type the details of the item you are issuing and hit button OK. Repeat as needed.

In our example, the supplier uses Australian dollars (AUD), and is creating an
invoice for Highland Health Centre which uses Solomon Islands dollars (SBD).

• Box 1 shows the customer's currency, SBD, the Currency Rate, which shows the value of 1 Solomon Island dollar in the supplier's
currency, Australian dollars, and the invoice value in the customer's currency.
• Note the item's foreign currency values (SBD) in the columns Price fc and Price fc ext on the Customer Invoice in box 2 below:

• Click OK to save the Customer invoice.
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If you change the customer on an invoice that has item lines, the following
message will appear. Check the currency is correct for the new customer and
adjust it if necessary.

Note that this message also appears on a Customer Credit and Supplier Credit.

Supplier credit
• Ensure Foreign currencies are active as per the instructions at the top of this page.
• From the Navigator click drop down menu Supplier> New Supplier Credit.
• In the Supplier Credit window that appears select your Supplier in field Name and note the currently set currency and its rate as highlighted
in box 1 below.
• Now click button New Line to add a new item line.
• In the window that appears type the details of the item you are receiving and hit OK. Repeat as needed.
• As this is a credit note, the value is shown as a negative amount

In our example, the supplier, International Dispensary, uses Euros (EUR), while
we use Australian dollars (AUD).

• Box 1 shows the supplier's currency, EUR, the Currency Rate, which shows the value of 1 Euro in our currency, Australian dollars, and the
credit note value in the supplier's currency.
• Note the item's foreign currency values (SBD) in the columns Price fc and Price fc ext on the Supplier Credit in box 2 below:

800

mSupply user guide July 2018

• Click OK to save the Supplier credit.

Customer credit
• Ensure Foreign currencies are active as per the instructions at the top of this page.
• From the Navigator click drop down menu Customer> New credit…
• In the Customer Credit window that appears select your Customer in field Name and note the currently set currency and its rate as
highlighted in box 1 below.
• Now click button New Line to add a new item line.
• In the window that appears type the details of the item you are crediting and hit button OK.

In our example, the supplier uses Australian dollars (AUD), and is creating a credit
note for Highland Health Centre which uses Solomon Islands dollars (SBD).

• Boxes 1 and 2 show details exactly the same as explained in the previous two examples
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• Click OK to save the Customer credit.
Previous: Currencies Next: Authorisation
2013/03/21 09:04

·

Asset management
mSupply allows you to manage assets you may have in your facility such as computers and vehicles.

In order to use this function users will need to have assets enabled in page 3 of permissions. See Managing users

The functionality allows you to record
• The location of the asset
• It's current condition
• A unique ID you've given it (e.g. the license plate if a vehicle, or the serial number of a computer)
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Showing the Asset list
Choose Special > Show Assets

Setup
Before starting to track your items you may need to set up the kinds of data you are tracking. For instance. If you are tracking Oxygen cylinders you
may want to keep records of whether they are full or empty. To do this we would set up a “Status” field.
To do this click on Setup

A new window will open:
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To setup tracking for our oxygen cylinders we would choose “Status” at the top field (1). Then click “New” (2). Type in Full and click OK. Repeat the
process for “Empty”
Now you have two statuses set up that can be linked to an asset.
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Let's create an asset to track.

New
Clicking New Opens a window allowing you to enter new assets:

In this example I have created the Asset: Oxygen Cylinder. I have recorded its serial number and I have chosen the Status: Full.

Editing an Asset
If you want to change one of the Conditions, Type, Status or Location of an asset you can do so by double clicking the asset from the Show Assets
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window.

You can switch between the Details and Log tabs to either edit the fields or view the log for this asset.
Previous: FrontlineSMS Integration Next: ARV regimen data recording
2013/08/06 03:04

·

ARV regimen data recording

The ARV regimen data recording module was built for the MOH in Zanzibar/
Tanzania. To date this module is not available as part of the standard mSupply
package. We are willing to make this module available if our clients feel the need.
Please get in touch: info@msupply.org.nz (mailto:info@msupply.org.nz)

mSupply allows you to record ARV regimen data; you can record for each customer how many patients are following particular regimens, how many
have defaulted on their regimen, and how many have died while on different regimens. There is a fixed list of regimens which applies to all customers.

Viewing/editing recorded regimen data
To view regimen records click on the Customer > Show regimen records menu item. The following window will be displayed:
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The window, when it first opens, lists all the regimen records entered for the current year (i.e. all those which have an entered date which falls in the
current year) sorted by entered date, most recent at the top. The various items in the window do the following:
• New regimen record button: Clicking this button opens the editing window shown below in the Adding/editing a regimen record section
with all fields empty, waiting to be filled in.
• Delete button: Click on this to delete the records you select in the list. You will be asked to confirm the deletion first.
• Find button: Opens the search window shown below in the Searching for regimen records section to enable you to find and display other
regimen records.
• Search bar: The list of displayed regimens will be filtered to show only those for customers with names which begin with the letters
entered in here. Useful for removing the clutter and seeing records for a single or small number of customers.
• OK button: Closes the window without doing anything.
You can edit the contents of any regimen record by double-clicking on it in the list. This will open the editing window shown below in the Adding/
editing a regimen record section, but loaded with all the information for the selected record. All the information is editable.

Searching for regimen records
To search for regimen records, click on the Find button on the regimen record list window shown above. This window will be displayed:
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You can either enter the from and to dates manually or use the quick-pick drop down list on the right hand side to quickly set the dates based on
common selections (e.g. This year, Last year). Click on the OK button and mSupply will search through all the regimen records and display in the list
all those which have an 'Entered for date' (see the Adding/editing a regimen record section below for a description of this field) which falls between
the dates you have entered.

Adding/editing a regimen record
When adding a new regimen record or editing an existing one, you will be shown this window:

The window is shown as it looks when adding a new record. When editing an existing record it looks the same but all the information entered for the
record is displayed, all of which is editable. Enter information in the various fields as follows:
• Name: The name of the customer to which this record belongs. Type the first few characters of the customer's name and press the Tab key
to choose the customer from a list of names starting with the characters you typed. Much quicker than typing the whole thing!
• Entry date: The date this record is entered for. mSupply matches this date against against dates you enter when searching for regimen
records and also for deciding which regimen records to include in a report. It will be different from the current date if, for instance, you
want the record included in a different reporting period than which the current date falls.
• Number of patients… columns: Each cell in these columns is editable. Each row represents the figures for that particular regimen. Click
once to select a cell and once more to begin editing it. Tip: when you have finished editing a particular cell you can use the Tab key to edit
the next cell or shift+Tab to edit the previous cell - this can really speed up entering a whole new regimen record.
• Remarks: Same as the Number of patients… columns, the cells in this column are all editable. Click once on a cell to select it and once
again to start editing it. You can enter any text you need which pertains to that particular regimen and its figures.
When you have finished entering or editing information click on the OK button to save your work and close the window.
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Reporting on regimen data
A single report is available for regimen data and it is accessed from the menu item Report > Regimen report. You must select the regimen records
which are to be included in the report. You do this by giving the dates between which a record's entered date must fall to be included in the report in
this window:

You can either enter the from and to dates manually or use the quick-pick drop down list on the right hand side to quickly set the dates based on
common selections (e.g. This year, Last year). Finally, click on the OK button and mSupply will generate your report.
Previous: Asset Management Next: Drug Registration
2014/04/29 05:06

·

Product Registration
Introduction
Registration is the process by which the government authority charged with controlling what can be supplied in a country manages this process by
authorising particular suppliers and products. Each supplier must:
• Obtain a supplier registration number and
• Obtain a registration for each product they wish to supply. This registration will be per brand and dose form, and will usually be timebound and need renewal.
A critical part of the process is supplying documents to verify product quality. This functionality is all about recording and tracking the status of
supplier's registrations and storing the documentation for easy retrieval.

Getting started with the Registration Module
Activate the Registration Module
Before using the Registration module you will need to activate it in the Registration Module section of the General Preferences.

Making the Registration Module visible
mSupply treats the Registration module like a store - refer Virtual stores. A user won't be able to log in to a virtual store on the login window unless
they have permission to do so - refer Managing users. You will need to allow the users who are going to do the registration work to see the
Registration Module 'store'. Unless that is only one person, you may well be useful to make a user group for that purpose.

Making things visible in the Registration Module 'store'
When a new store is created, no existing items or names (suppliers, manufacturers, customers, etc.) are visible to it. This clearly needs to be fixed if
you are going to register existing items, suppliers, or manufacturers!
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Any items, suppliers and manufacturers created after the Registration module
'store' has been created will be automatically made visible in the Registration
module 'store'.

Make existing suppliers and manufacturers visible
To make existing suppliers and manufacturers visible, you need to make them visible in the Registration module 'store' - refer Names: Using, adding
and editing, the Store tab.

Make existing items visible
To make existing suppliers and manufacturers visible, you need to make them visible in the Registration module 'store' - refer Items, the Stores tab.
This must be done while logged in to another store.

Using the Registration Module
The Registration module has it's own Navigator. If mSupply doesn't start in Registration mode when you log in you may switch to it by choosing
Files>switch and selecting Registration.

You will then be presented with the Navigator for Registration:

810

mSupply user guide July 2018

Show (list) Registrations
To see a list of registrations click on the List button.

This page allows you to refine your search. If you want to list all registrations leave this form blank.
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Clicking the Find button will bring up the results of your search.
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New
This will allow you to enter new registrations. See the section New Registration.

Delete
You may remove registrations by highlighting an item on this list and clicking the delete button.

Find
This allows you to refine your search without having to go back to the previous window.

View / Edit registration
To view and edit the details of a registration on this list double click on the item and it will bring up a window where you can view and edit the
details.
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New Registration

To enter a new drug registration record, click on
This will open the following window where data can be entered in fields as described below:

Supplier
• To get a list of suppliers starting with a particular letter, enter the letter and press Tab. This will let you select the supplier from a list.
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•
•
•
•
•

If you enter a letter and there is only one supplier beginning with that letter it will automatically be entered into the Supplier field.
If the supplier is not listed you may need to create a new supplier record by clicking on the New Supplier button.
If you want to list all suppliers you can enter @ and click Find.
For more details see the New Suppler section below.
Once you have chosen a supplier you will be able to edit the supplier details by clicking on the Edit Supplier button.

Item Name
Enter the first letter of the item, press Tab, and select the item from the list that displays.

Manufacturer
As above enter the first letter of the manufacturer, press Tab, and select from the displayed list. If the manufacturer is not displayed a new record for
the manufacturer will need to be created by clicking on the New Manufacturer button.

Trade Name
As trade names for drugs vary widely this is a field to fill out manually.

Currently Registered
If this item has been approved for registration then tick this box. The approval date will change to today's date once the window has been closed.

Status
You can assign a drug registration a status you have previously defined in the Drug Registration status window

Documents
You may attach documents to the registration record by clicking the plus button. This will open a window to allow you to navigate to and choose a
locally stored document. To view documents stored in this way simply double click the document listed below.

Logs
The log tab allows you to see a list of events such as when this item was approved.

Show (list) Suppliers
See Show Suppliers

New Supplier
See Names: using, adding and editing
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Show / new Manufacturers
The process for viewing or adding a new manufacturer is the same as the process for viewing/adding a supplier - refer to the instructions above.

Reports

Clicking on Registrations will open a report listing all of your registration records.

Registration Categories
Item categories are a great way of grouping your items. This enables you, for example, to report on specific groups of products by filtering by
category. This can be extremely helpful.

To create a new category click on the Cat. This will open this window:
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View registrations in category
• To view a list of registrations assigned to each category double click on the category in the list.

New
• Click the New button to add a new category.

Delete
• Click the Delete button to remove a category.

If there are registrations assigned to a category, then mSupply will not let you delete the category until you have removed the
category from the drug registration records. mSupply will open the category so that you can see the Registration records that
are assigned to this category.
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Drug Registration status Window
In this window you can define for yourself the different states or phases of a Drug Registration (for example, In Process, Refused, Waiting for
documents, etc). This means that the status of a registration can be seen at a glance.

To show, create or delete a status click on the above button in the Navigator.
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Edit a Status
To edit a status, double-click on it. You can change its name or identifying color. The drug registrations that have been assigned this status will be
affected by the change.

Add a new status
* Click the New button to add a new status.
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Delete a status
* Click the Delete button to remove a status.

If this status has been assigned to registrations, then mSupply will not let you delete the status until you have removed the status
from the drug registration records. mSupply will tell you how many drug registrations have been assigned this status.

Previous: ARV regimen data recording Next: Using the mSupply Remote Client
2015/04/20 01:54

·

Using the mSupply remote client
As well as using an mSupply client connecting to a local mSupply server, or using a standalone version of mSupply, it is possible to access a copy of
mSupply running on a remotely hosted server. In this case, we use remote access software called TSplus (http://www.tsplus.net
(http://www.tsplus.net)).

Connecting to mSupply
The first time you run the remote access client, you'll have to enter your TSplus username and password. These correspond to a Windows account on
the remote server and are completely separate from your mSupply username and password.

We recommend that you select the “Allow me to save credentials” box so that you don't have to remember it in future.
After clicking Connect, you may get a warning Window similar to this one:
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If so, then select the “Don't ask me again for conections to this computer” box to avoid seeing it again in future.
You should then see the normal mSupply login screen - simply login as usual to get to the mSupply navigator, which looks exactly the same as normal
except that it is enclosed in a session window:

When you're finished, exit mSupply by using the File → Exit mSupply menu item.
If you simply use the X button at the top right of the session window, it will close
the window but mSupply will continue to run on the server, and use a license
which may be needed by someone else.

Printing from mSupply
Because mSupply is running on a remote server, printing forms and reports is slightly different as there is an extra step involved to download them to
your local computer. There are several ways to do this, depending on which print option you choose e.g. printing a customer invoice:
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Universal Printer
TSplus comes with a “Universal Printer” driver, and if you select the Printer option and then choose this as your printer, the print job should get
downloaded to your local computer and then prompt you to choose one of the printer drivers on your local computer to receive the print job.

PDF Printer
Foxit or some other virtual PDF printer driver will have been installed on the remote server. You can either:
• select the Printer option and choose the virtual PDF printer driver as your printer - this will prompt you for a location to save the PDF file
and then open it in the default PDF viewer (you may be prompted to choose either Foxit or Sumatra - the screen shots below use Foxit, but
Sumatra is similar)
• select the Preview option - this will generate a PDF file in the default location (C:\mSupply client\Documents\temp) and then open it in the
default PDF viewer
• select the PDF file on disk option - this will generate a PDF file in the default location and open that folder, and then you can double-click
on the file to open it in the default PDF viewer
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Regardless of which of these you choose, you can use File → Save As to save the PDF file to a folder on your local computer:

Click on Browse to choose where to save it - This PC includes all of your local drives as well as the ones on the remote server:
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Exporting to Excel
MS Office won't normally have been installed on the remote server, but Open Office will have been. The first time you try to export to Excel, you'll
have to choose the location of “Excel” - in this case, it will be something like C:\Program Files(x86)\Open Office 4\program\scalc.exe.
Select the Export to Excel option to open the report/form in Open Office:
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In the same way as for PDFs, you can select a local drive from the File → Save As menu (either as an Open Office .ods document, or an Excel .xls
document):
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Transferring Data
Dropbox will have been installed on the remote server, and can be used to transfer saved reports or other data between the server and any other
computer which has access to the Dropbox account.
Previous: Drug Registration Next: Currencies
2016/12/07 11:10

·

Authorisation
Sometimes it is important that goods are not distributed to customers or receipted into stock until such an action has been authorised. mSupply has
invoice authorisation functionality to make this possible and allows, for example, a manager to control the processing of invoices.

While invoices can be edited after authorisation, once authorised, Goods Receipt
Lines cannot be unauthorised to fix mistakes! Any authorised errors can only be
fixed using stock adjustments.
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When invoices have to be authorised, it means that they cannot be confirmed until
they have been authorised i.e. invoices without authorisation are held at status 'sg'
or suggested. This means the official invoice can not be printed (and goods taken
out of or receipted into stock) until the invoice has been authorised.

Configure mSupply for Authorisation
You can set the authorisation of customer and supplier invoices and Goods Receipt Lines independently. You do it by setting the store preferences to
make authorisation compulsory:
• Click on the Special> Show stores.. menu item, click the Preferences tab. Now check the appropriate boxes as required. This is shown on
the following screenshot:

• Finally, click on the OK button to close the window and save the preferences. From now on, the invoice types you set the preferences for
must be authorised before being confirmed.

Supplier Invoice authorisation
With the Supplier invoices must be authorised store preference set, your newly created supplier invoices will look like this:
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Notice the Authorised checkbox at the bottom left of the window. If you click the OK button button with this checkbox unchecked, you will get a
warning message telling you that unconfirmed invoices cannot be confirmed and nothing will happen. If you have the permission set to allow you to
authorise invoices (see here for details) then you can click on the Authorise checkbox and continue. However, if you do not have the permission set,
the Authorised checkbox will be disabled and you cannot authorise the invoice. Another user who has the permission must check the box for you
before you can proceed.

Unauthorising Supplier invoices and inventory additions
If you have permission to authorise an invoice, you can also unauthorise it. If the invoice has status “NW” then it has not been entered into stock, and
you can allow users to edit it and you will still control the process of authorisation before the goods are put into stock. However, if the invoice is
already confirmed, the goods have already been entered into stock, and any changes users make will affect stock levels immediately, even though the
invoice is not authorised. Therefore, only unauthorise a confirmed invoice to make immediate changes yourself, then immediately reauthorise it.
Alternatively, if goods have not been issued, you can delete the lines off the invoice (and optionally then delete the whole invoice) and require users to
enter a new invoice to receive the stock, and the normal authorisation process will apply to the new invoice.

Customer Invoice authorisation
With the Customer invoices must be authorised store preference set, newly created customer invoices will look like this:
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Again, notice the Authorised checkbox at the bottom left of the window. This behaves exactly the same as the Authorised checkbox on the bottom left
of a supplier invoice: the customer invoice cannot be confirmed until this checkbox is saved as checked. And, once again, if you do not have the Can
authorise invoices permission set, it will be disabled and you will be unable to authorise the invoice; someone else, with the permission set, must do it
for you.

Printing invoices which must be authorised
When an invoice is not authorised an attempt to print it will produce an invoice with an 'Unauthorised' watermark, just like this:

829

mSupply user guide July 2018

As soon as the invoice is authorised it will print normally without the unauthorised watermark.

Purchase Order Authorisation
Purchase Orders can also be authorised - refer to Authorising Purchase Orders.

View authorisation logs
mSupply records the authorisation and unauthorisation of invoices and creates a log record every time the authorisation status of an invoice changes.
To view the log records click on the log tab of an invoice, as shown in the screenshot below.
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You can also view all logs from Special > View log…. See here for details.
Previous: Foreign currency transactions Next: Miscellaneous labels
2013/06/02 09:15

·

Misc labels
This function allows you to create and save labels that you can print at any time from a label printer. Before actually printing the labels you create
using this function, you must setup the printer and configure it in mSupply's setting - see the Label printer installation and Printing preferences (setup)
section for information about this.
To access the function, choose the Special > Misc labels menu item. A window displaying a list of all the currently saved labels appears:

The labels are designed to print to plain 90mm x 40mm (w x h) labels from a
Zebra label printer. Please contact us if you require support of other printers and
other label formats.
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Double-click an item in the list to edit/print that label, or click the New button to add a new one. The window for adding a new label or editing an
existing one looks like this (the only difference is that when editing an existing label, the window will be populated with the label's current settings):
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Normal tab
This is for normal layout
• Label name: This field will not print on the label, it is for you to identify the label in the list. It is shown in the list of available labels when
the Misc labels menu item is chosen.
• Heading, Body, Footers: These fields will print on the label in roughly the position that they are on the screen. Note that if you enter a
very long left and right footer they may overlap in the middle of the label. Print a single test label to check first.

Multiple tab
This is for printing the same thing multiple times on the same label:
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• Layout: Select “2” for the same thing printed twice on the label, side by side. Select “4” for the same thing to be printed 4 times on the
label in a 2×2 grid layout.
• Body: The text you want printed on the label
The buttons at the bottom of the window:
• Print button: Clicking this button will print the number of labels specified in the Quantity to print field to your label printer using the
format you have defined using the various fields.
• Cancel button: Clicking Cancel will close the window without saving any changes you have made.
• OK Button: Clicking OK will save any changes you have made and close the window. (Note that the quantity to print is not saved - it is
reset to 1 each time you open the window).
Previous: Authorisation Next: Keyboard Shortcuts
2011/05/20 06:35

·

Keyboard shortcuts
These are the keyboard shortcuts you can use in mSupply. They can really speed up your work because using them is much quicker than using a
mouse once you get used to them. Try it and see!

The Windows operating system uses the Control key and the Mac operating system uses the Command key to activate keyboard
shortcuts. For clarity's sake we've used the control key in the table below. If you're using a Mac just substitute Command for
Control.
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What it
does

Shortcut
General useful computer shortcuts / Navigation keys - work in most applications

Ctrl + A

Select All
text in a
field / cell

Control + X

Cut

Control + C

Copy

Control + V

Paste

Control + Z

Undo

Control + Y

Redo

Control + Q

Quit the
application

Tab

moves
focus to
next field /
cell. Also
used after
typing in a
selection
textbox
(e.g. item
name) to
bring up a
window
showing
selections
which
match what
was typed.
But this
isn't
technically
a shortcut,
just the way
the fields
work!

Shift Tab

moves
focus to
previous
field / cell

Spacebar

toggles
between
two options
(with a
checkbox
or radio
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What it
does

Shortcut
General useful computer shortcuts / Navigation keys - work in most applications

button), e.g.
Male /
Female in
Patient
details
entry
window
Almost Everywhere

Enter

Activates
the default
button
(which is
highlighted)
on the
active
window.
Default
button is
usually OK.

Control + . (full stop)

Cancel/
Delete

Control + Shift + N

OK & Next

Control + Shift + P

OK &
Previous
Navigator

Control + F

Show
customer
invoices

Control + I

Show items

Control + N

New
customer
invoice

Control + J

Show
supplier
invoices

Control + H

New
supplier
invoice

Control + 1

Show log in
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What it
does

Shortcut
General useful computer shortcuts / Navigation keys - work in most applications

window

Control + 2

Show
switch
stores
window
(same as
log-in but
no need to
enter user/
pass)

Control + 0 (zero)

Show
purchase
orders

Control + Y

Show
customers

Control + U

Show
suppliers
Invoice entry

Control + N

Add a new
line to the
invoice

Control + Shift + N

OK & Next
to save,
print (if
printing
checked)
and open a
new
prescription
entry
window
Invoice line entry
Same as
clicking
OK (Enter
key is the
default OK
& Next
button)

Control + K

Choice lists
U or up arrow

Highlight
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What it
does

Shortcut
General useful computer shortcuts / Navigation keys - work in most applications

the next
line above
the
currently
highlighted
line
Highlight
the next
line below
the
currently
highlighted
line

D or down arrow

Stocktake list
Control + N

Add a new
stocktake

Control + Shift + N

Add a new
blank
stocktake
Stocktake entry

Control + N

Add a new
line to the
stocktake

Previous: Miscellaneous labels Next: The mSupply eLMIS Interface
2011/06/02 09:27

·

The mSupply eLMIS interface
This is a work in progress - will be completed soon!
eLMIS stands for Electronic Logistics Management System and is a piece of software developed under the USAID Deliver project. mSupply has an
interface for receiving orders from eLMIS and sending shipment details back to it. Because eLMIS does not have an API, the interface uses files
stored in a commonly accessible location to share information.

Setup
Before the interface can be used it has to be setup correctly. These are the setup steps you need to follow:

1. Create folders in a commonly accessible location
A computer file storage location must be created somewhere that is accessible by both the mSupply and eLMIS servers to directly write files. If a
common location does not exist because the mSupply and eLMIS servers are on separate non-linked networks you can create a separate location on
each of the mSupply and eLMIS servers and link them using a file synchronisation utility such as Dropbox.
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When you have the centrally accessible location sorted out, create a main folder then some sub-folders according to the following:

In this picture we have called the main folder Transfer. You can name yours anything you like but the other folders must have exactly the same names
as shown.

2. Enter the setup information into mSupply
Go to the eLMIS tab of File > Preferences and enter the settings for the interface there. You can find instructions for that here.

3. Setup eLMIS
1. Set eLMIS to export its order files to the main folder/Order/Incoming folder when orders are created.
2. Set eLMIS to look for incoming shipment files in the main folder/Shipment/Incoming folder on a regular basis.
Please consult your eLMIS documentation for information on these steps.

What the interface does
When it's running the interface does 2 things:

1. Processes new orders from eLMIS
Each time the interval set in the settings elapses, mSupply checks the main folder/Order/Incoming folder for new order files from eLMIS. If it finds
one it reads the file and turns it into a customer invoice. The customer invoice will have these features:
• its status will be “sg” (suggested)
• its Their ref field will have the value “eLMIS:XXXX.” where XXXX is the eLMIS order number
• it will have a placeholder line for every item in the order file
The Their ref field makes a customer invoice created by the interface easy to spot. Feel free to add anything to the Their ref field after what the
interface has put in there but not before. mSupply uses it to generate the shipment file for this order later on.
See the Order file format section below to see the format the order file must have.
If the order is successfully converted into a customer invoice the eLMIS order file is moved from main folder/Order/Incoming to main folder/Order/
Processed.
If there is a problem and the order file is not converted into a customer invoice then the order file is moved to main folder/Order/Error. In addition, an
error file is created and is also placed in main folder/Order/Error. The error file has the name “XXXX-YYYY-MM-DD-HH-MM.err.csv” where XXXX
is the order file's filename without its extension. See the Error file format section below for the format of the error file. An error email with the error
file attached will also be sent to the error email address set in the mSupply preferences.
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2. Creates eLMIS shipment files for confirmed customer invoices
When a customer invoice that was created by this eLMIS interface (mSupply recognises them by the contents of the “Their ref” field) is confirmed
then mSupply will create a shipment file for it. The shipment file will have the filename “SHPXXXX.csv” (where XXXX is the invoice number of the
customer invoice) and will be saved to the main folder/Shipment/Incoming folder.
See the Shipment file format section below for the format of this file.
If there are any problems creating the shipment file, mSupply will display a message describing the problem. Please note that you will not be able to
confirm the customer invoice until all the problems preventing the creation of the shipment file are corrected.

Using the interface
Well, the good news is that day-to-day you don't have to do anything. The interface will continue running quietly in the background processing order
files and creating shipment files as the customer invoices are confirmed.
Periodically you should check the error email address set in the mSupply preferences for messages about errors. Remember the order files that have
caused errors can be found on the main folder/Order/Error folder. Note that mSupply does not put anything in the main folder/Shipment/Error folder eLMIS only uses that folder when processing the shipment files.
The only other time you will hear anything from the interface is if mSupply detects an item on a customer invoice that wasn't in the original eLMIS
order. This will happen if one of the item placeholder lines was replaced with a different item (e.g. because of low stock or a preferred item is to be
used). In this case, mSupply will show a window and ask you to tell it which item on the original order you replaced with the item in question. Once
you have selected the item that has been replaced mSupply will continue creating the shipment file.

eLMIS order file format
This a text file in csv format, each element of data is enclosed in “ characters. The first line of the file will contain headers only (ignored by mSupply),
subsequent lines contain data in the following order:
1.
2.
3.
4.
5.
6.
7.

Warehouse code. This is the code the store in mSupply that this order (customer invoice) belongs to.
eLMIS order ID. Stored in the Their ref field of the customer invoice.
Item code. The code of the item being ordered.
Product name. The name of the item, as stored in eLMIS. For reference only, not used by mSupply.
Customer ID. The code of the customer this order is from.
Quantity. The number of packs (default pack size) of this item ordered.
First day of reporting Period. The date of the first day of the reporting period (budget period in mSupply) to which this customer invoice is
to belong in the format YYYY-MM-DD.
8. Line number. The number of this line in the order.
9. Order date. Date the order was placed.
10. Price. The unit price of the item. Optional, might not be sent from eLMIS, not used by mSupply.

Shipment file format
This a text file in csv format with the name “SHPinvoice number.csv” where invoice number is the customer invoice's number in mSupply (e.g.
“SHP1234.csv”). The first line will always be “Order No, Product Code, Batch, Quantity Shipped, Cost, Packed Date, Shipped Date, Facility Code,
Quantity Ordered, Substituted Product Code, Substituted Product Name, Substituted Product Quantity” (i.e. the column headers only), subsequent
lines contain data in the same column order, each element enclosed in ” characters.

Error file format
A text file with the name “filename without extension-YYYY-MM-DD-HH-MM.err.csv” where filename without extension is the filename of the order
file which the error file is generated for and YYYY-MM-DD-HH-MM is the current date and time in 24 hour format (e.g.
ORD12345-2015-05-30-14-35.err.csv).
The file contains 3 lines:
1. file name without extension: Error description where file name without extension is the eLMIS order file name without its extension and
Error description is a description of the error that has been found e.g. “ORD10002: Facility code not found”
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2. Line number: XX where XX is the number of the line in the order file which has the error. e.g. “Line number: 3”
3. Hint: Hint to fix it where Hint to fix it is a hint on how to fix the error e.g. “Hint: Make sure facility code is available in eLMIS, enter the
facility code into the file”
Previous: Keyboard Shortcuts Next: Asset Management for East Timor
2017/05/19 15:57

·

Asset management for East Timor
This guide is specifically for East Timor (SAMES). If you are using a general version of mSupply you will not see the same functionality described
here.

Basic principles
This module has been made to handle different kinds of assets. An asset is something owned by SAMES that you want to keep track of. Specifically,
SAMES will use the module to track oxygen cylinders. Each cylinder has a serial number, as with most assets. What is unique about oxygen cylinders
is that
1. You supply them to customers, and return them to the supplier, although they are still owned by SAMES
2. There is a financial transaction associated with the supply

Setup
Setting up Service items
Certain movements of oxygen cyclinders will automatically create an invoice for the Oxygen supplied during that movment
Movement

Invoice created

Supplier to SAMES

Supplier invoice

SAMES to Supplier

none

SAMES to Customer

Customer invoice

Customer to SAMES

None

When assets

Setting up types, sizes, conditions
Having shown the asset list, click Setup You'll be shown this window
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Here you can set up types, sizes and conditions by choosing these options from the show drop-down list at the top of the window. Sustainable
Solutions will do this for you on installation. Don't change any settings without contacting us.

Set up permissions to use the asset module
There are 3 user permissions associated with the asset module:
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User permissions are accessed from the File > Edit users menu item. Note that Setup assets permissions should only be give to one person, as wrong
use will create problems.

Creating assets
Each time you purchase a new asset, you need to create it in mSupply. The quickest way is usually to select a similar asset, highlight it, then click
?Duplicate
• You will still need to fill in the serial number, as this will be unique for the new asset.
Otherwise you can click New in the toolbar and you'll be shown this window
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Fill in the name and serial number, and choose from the list for condition, size and status.

Working with the asset list
To show the asset list, choose Special > Show assets

Finding items in the list
•
•
•
•

You can click on a column header to sort by that column
You can use the “Type” and “Status” drop-down lists to choose just a certain type or status of asset to be shown.
You can enter a value in the search field (customer name or asset serial number) to find the asset(s) you want.
Entering a star in the search field will find all cylinders at SAMES.

844

mSupply user guide July 2018

Transferring oxygen cylinders
Transferring can happen in four directions
1.
2.
3.
4.

You supply to a customer
Customer returns them to you
SAMES returns empty cylinders to a supplier
The supplier supplies SAMES with filled cylinders

Let's take the example of sending cylinders to a customer.
1. enter “*” in the search field to find all the cyclinders at SAMES.
2. Click the checkbox beside the cylinders you wish to send to the customer.
3. Click Send/Receive to show this window:

4.
5.
6.
7.

◦
Click the ??Customer : Send radio button.
Enter the start of the customer name and press <tab> then choose the customer from the list if there is more than one to choose from.
The create invoice checkbox will be checked, and you should leave it checked unless there is a reason not to create an invoice for this
shipment.
When you click OK the transfer will be made and an invoice will be created. You can view the invoice by choosing Customers > Show
Invoices
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The invoice that is made will have lines that are purple, showing that they're service lines, and don't involve stock.

The Log
Every tansfer of an asset creates a log entry- you can see the log for an item by double-clicking on it and then click the Log tab:
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Reporting
Click the Report button in the list toolbar will show the report options window:

A report is produced that gives a summary of where cylinders are, and how many at SAMES are full or empty.

If you wish to get a list of assets at a particular customer, in SAMES, or with a supplier you can do so using the search function of the list window. If
you need to report on the value of assets sent and received, this can be done using the normal transaction reports.
Previous: The mSupply eLMIS interface Next: Field Descriptions
2013/04/11 18:07

·
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Tips and tricks
Entering dates
Expiry Dates
• Note that the “normal” way to enter a date (dd/mm/yy or mm/dd/yy is determined by your computer, not mSupply. If you want to change it
◦ Windows: https://www.windowscentral.com/how-change-date-and-time-formats-windows-10
(https://www.windowscentral.com/how-change-date-and-time-formats-windows-10)
◦ Mac: https://support.apple.com/kb/PH18435 (https://support.apple.com/kb/PH18435)

Print preview problem
Sometimes users will have issues with previewing PDFs before they print. Our experience is that this is often due to some incompatibility between
mSupply and certain XPS viewers. We recommend use of the excellent, free Sumatra PDF reader (https://www.sumatrapdfreader.org/free-pdfreader.html) to view XPS files, which is one of the reasons why we include it as a recommended install with mSupply Client software! Installing
Sumatra PDF and making it the default XPF viewer will normally fix any print preview issue.

Using Sumatra as XPS Viewer
How to set Sumatra as default XPS viewer on Windows
1.
2.
3.
4.

Open Settings > Apps > Default apps.
Click the Choose default apps by file type link.
Scroll down to find .xps (XPS File), and click the button on the right side to select a different program as default.
Select 'Sumatra PDF' from the list to set it and click the option 'Switch anyway'.

Change the default XPS viewer on Windows
You might also need to do the following.
1.
2.
3.
4.

2012/02/21 23:39

Follow the menu path Start > Devices and Printers
Right click on the Microsoft XPS Document Writer
Select Printing Preferences
On the tab XPS Documents uncheck the checkbox that says: Automatically open XPS document using the XPS viewer

·

Backup
Running a backup
Choose File > Backup… to run a manual backup of your data. The backup will be carried out according to your configuration settings, described
below.

While backup is run, all clients connected to the server will pause whatever they
are doing until the backup is complete. So make sure you do it when users are not
busy using mSupply. And make sure you configure your automatic backups to run
at a time when the system is not busy e.g. lunch time, the end of work or, better,
the middle of the night.
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• The location of the backup file is set in File > Preferences, Backup tab.
• You can perform a backup manually and/or automatically. Automatic backups should be scheduled to run frequently (every day), manual
backups should be done before updates or other potentially risky changes.
• It is not necessary to quit the database before performing a backup.
• Automatic backup settings are configured in the Preferences window - see General preferences, Backup tab for details.
The Backup function works both in single user as well as multi-user mode. Under multi-user mode, this command performs a backup of the server
data on the server. A progress window will show how the backup is proceeding.
Note: In multi-user mode, you can't run the Restore function from the client. These must always be run from the server computer.

Backup: Best practice
We recommend you set up your mSupply backups in the following manner

Disk configuration
Use RAID 1 or 5
• RAID 1: two disks mirrored, so data is written to each disk
◦ Advantages
▪ if one disk fails you continue work from the other disk
▪ if the RAID controller fails, you can directly connect one disk and continue work.
• RAID 5: 3 or more disks, with one disk containing checksum information so that if any disk in the set fails, the set can be rebuilt.
◦ Advantages:
▪ The disk set can be easily expanded by adding disks if needed.
◦ Disadvantages
▪ You are reliant on the RAID controller, as disks can not be used without the controller. For critical data we
recommend you have a spare RAID controller of exactly the same model you have installed in the server available.

Use a hot spare
This is a spare disk that the RAID controller will use if a disk in the RAID set fails.

Add another single disk to receive backup data
This disk is not part of the RAID

Backup your live data
Configure mSupply server to
• use the single disk as it's backup location.
• backup your data nightly.
• use a log file. A log file (journal) records each database action as it happens. In the event of a power failure or other adverse event, all
changes can be recovered from the log file.

Configure a secondary backup location in mSupply
mSupply can be configured to copy every Xth backup from the backup folder to another volume. The destination can be on the same machine, or
elsewhere on the network. Refer Preferences > Backup 2 tab.

Configure off-site backup
Use Spideroak™ or Dropbox™ to backup your secondary location to their internet servers.
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If needed configure an off-site computer to also synchronise with the backup service provider so you have an off-site copy as well as the “cloud” copy.

Mirrored servers
We have the technology to provide mirrored servers when very high availability is required. Contact us if interested. A charge will apply for
implementation

Restoring your data
Choosing this item allows you to choose a backup data file, uncompress it and start using it as your main data file.
• Log in to msupply with an old data file or by creating a new data file and click menu File > Restore…
• Locate your backup file in the Open dialog that appears. Your backup file has file extension .4BK, eg. mSupply.4BK. Hit OK.
• Clicking on the small red down arrow next to the data file name will show the current destination location to where the data file will be
restored. You are being prompted for a folder where the data file will be restored to. Change the destination location of the data file by
clicking on the … button. Once you are happy with the destination location, hit the Restore button.
• After the file is restored, the file location is then displayed using your computer's default file manager. You can close this window.
• Now go back into mSupply and click menu File > Open data file…
• Locate the newly restored data file in the Open dialog that appears. Your data file has file extension .4dd, eg. mSupply.4dd.
• Select the data file and hit the OK button.
• You may be prompted for a log file. Click on the Create button. Select the suggested location, which is the same as your new data file
location, and click on the Save button.
• You will be prompted to do a backup. It is not necessary to do this at this stage. It will take a few moments to open this new data file,
particularly if it is a large data file.
• mSupply should open your restored data file and you should be presented with the log in screen to the new data file.
In client/server usage this command will have no effect.
Be very careful about restoring. We suggest you consult Sustainable Solutions before attempting a restore.

Setting up Backup and a Log file for Single User mSupply
If you are using a synchronisation system with mSupply it's very important that you don't lose any data on the remote site. To ensure that power
failures (or a dead battery on a laptop) don't cause mSupply to quit unexpectedly and therefore to lose data, you should configure mSupply to use a log
file.

Use a standard place to store backups
We suggest that
• You store your mSupply data in Documents/mSupply_data/
• You store your backups in Documents/mSupply_backups/

Configure Backups
You can configure backups to run on a schedule that you set. To do this go to Admin > Preferences and select Backup from the left panel. You must
have an existing backup to use these features (see running_a_backup).
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Select Automatic Backup and schedule by hour(s), day(s) or week(s) as indicated.

Choose your backup folder and select Use log file.
You will be prompted to specify the location of your log file.

Press Continue
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When all settings are correct, press OK to save.
Previous: Field Descriptions Next: Changing users and Passwords
2011/05/10 07:14

·

Automatic updates
Occasionally we release updates for mSupply. At the moment the mSupply server, if you're using it, must be manually updated. But the mSupply
client and mSupply single user can both be automatically updated.

mSupply Client
To automatically update your mSupply client, simply start it running. If it needs an update (because the server has been updated, for example) it will
automatically update itself. You will see messages with progress bars describing what's happening. The update process should take less than 5
minutes, depending on the speed of your connection to the mSupply server and the speed of your computer. When the process is complete you'll see
the usual mSupply login screen.
The only thing that can go wrong with this update process is if the connection to the server is broken or the client does not have the necessary
permissions to create new files in the directory or folder it is installed. Symptoms of these failures vary from a failure message to the update process
beginning then stopping without displaying the mSupply login window.

mSupply single user
mSupply single user is often used in a distributed sync setup where the various copies of mSupply are spread far and wide throughout a country. So
the ability to remotely update them can be very useful!
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Simply choose Special > Check for updates… or click on the Check for updates icon on the Special tab of the navigator:

mSupply will then check whether there is an update available for your version. If there is, you will be shown the new version and asked whether you
want to continue with the update. If you do, mSupply will download it and install it automatically. When the process is finished, you will be asked to
restart mSupply for the changes to take effect.
Previous: Field Descriptions Next: Changing users and Passwords
2017/07/19 09:48

·

Changing users and passwords
Changing the current user
Choose File » Change User This menu item allows you to change to a different user without quitting mSupply.
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If more than one user is sharing your computer, choose this item before you leave the computer so that the next user will have to log in with their user
name & password before gaining access.
If you find yourself on this page accidentally and if you do not have sufficient permissions to change to another store or user then you will have to
close and restart mSupply by clicking Quit or the red X at the top right of the screen and launching the program again.

• user 1 and user 2 (the first 2 users in the list when opening a new
datafile) are special. You cannot delete these users, and they always
have access to mSupply (even if they belong to a group that has been
de-activated). If you only want one person to have full access, set the
user1 password to be the same as the user2 password.

Switching stores
This menu item lets a user (whose permissions allow) switch stores and/or login mode without the need to re-enter their password. Note that this
screen does not allow a change of user; pressing Cancel reverts to the current store/login mode, so caution in using this feature should be exercised,
and this screen should not be displayed when the computer is left unattended.
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Change Password
You can change your password by choosing File>Change Password….

You need to enter the new password twice to make sure you have typed it correctly.
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• Passwords are case sensitive; make sure you don't have Caps Lock on.
• When you enter a password you have to enter exactly the same text into
the second field.
• If you forget your password you must ask user 1 and user 2 to change
your password for you - refer Changing the current user.

Edit users
See Managing users
Previous: Backup Next: Diagnostics
2011/05/10 07:06

·

Diagnostics
This feature is primarily intended for use by our technical staff when there is reason to believe that there may be some errors in the database; it is
unlikely to be of practical use to users of mSupply. However, feel free to run some checks if you're bored or need help to get to sleep ;-). This is a brief
description of the functionality only - we don't want to be too good at helping you sleep after all…
Choose Special > Diagnostics… from the menus and this window will open:

Check all the tests you want to run (all are checked by default - might take a long time to run if your datafile is big):
Pack size integrity: Each item's pack size is examined by batch number to confirm that stock in balances with stock out.
Store integrity: Each customer invoice is examined to confirm that each transaction has been applied to the appropriate store.
856

mSupply user guide July 2018

Purchase Order integrity: A check is performed to confirm that Purchase Order quantities and Goods Received quantities tally.
Miscellaneous checks: Includes a check that any repacked items have not resulted in negative amounts being recorded.
Look for ledger problems: This report presents you with a list of items whose ledger balances (total in minus total out) does not equal the difference
between the opening stock and the actual stock on hand. It is also useful for finding unauthorised adjustment of stock values.
Click on the Check button when you're ready, mSupply will start the tests and report the results in the blank area below it. When you've finished,
close the window by clicking on the OK button.
Previous: Change user Next: Field descriptions
2011/05/20 06:48

·

Finalising transactions
There are three methods of finalising invoices:
1. The method described here.
2. By highlighting transactions in the transaction list and clicking Finalise
3. By checking the Finalise checkbox when viewing a particular invoice and clicking OK to close the window.

Finalising is controlled by user permissions. If you are not able to finalise
invoices, you likely don't have the user permission to perform the operation. There
is more information on permissions here (http://www.docs.msupply.org.nz/
admin:controlling_user_access)

Finalise customer invoices
All invoices that have status “cn” (i.e. confirmed invoices) may be finalised.
If you have the export option turned on in the Preferences, finalised invoices will also be exported to allow import into an accounting program. They
can also just be “exported” to a printed list.
Once an export is done, invoices can no longer be edited. (They have status “fn” for finalised).
Each time a group of invoices is exported, they are all assigned a common “batch” number. You can use this batch number to export an invoice again,
should your export file become lost or damaged.
On choosing File > finalise customer invoices you will be shown a window displaying all the customer invoices that have not been finalised.
Note that if “export invoices when finalising” is turned on in the Preferences, invoices that have been finalised but not yet given an export batch will
also be included in the list. If any such invoices exist you will be alerted to the fact.
The first screen advises you of the folder to which your file will be saved. The next screen displays a list of invoices not yet finalised.
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Follow these steps:
• Hold down the control key (Windows) or command key (Mac) while clicking on the lines you wish to finalise. The lines you have selected
will be highlighted.
• To reverse a choice click on the line again.
• If you want to choose all the transactions displayed, type control “a” (Windows)/ command “a” (Mac)
• Once you are satisfied with the records you've selected, click the OK button. (In fact, don't just be satisfied, be extra sure- you can't reverse
a finalisation. It really is final).
• The transactions will be marked as “finalised” (status “fn”), and they may no longer be edited.
You will be given the opportunity to print the list of finalised invoices.
If you have specified the option in the Preferences, a text file called “cust_invoice_expt.txt” will be created on the disk (& in the folder) you have
specified in the Preferences.
Each time you finalise a group of invoices, they are given an export batch. This is a unique number that allows you to recall those invoices.

Finalise supplier invoices... .
As for the finalise customer invoices…. section above, but for supplier invoices
The export file created is called “supp_invoice_expt.txt”

Finalise inventory adjustments...
You need to finalise inventory adjustments so that they can be purged from mSupply at a later date. Also, you will not be able to set the start of year
stock at the beginning of the next financial year until all inventory adjustments have been finalised.
On choosing item | finalise inventory adjustments … you will be shown a window displaying all the inventory adjustments that have not been
finalised. Follow these steps:
• Hold down the control key (Windows) or command key (Macs) while clicking on the lines you wish to finalise. The lines you have selected
will be highlighted.
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• To reverse a choice click on the line again.
• If you want to choose all the transactions displayed, type control “a” (Windows)/ command “a” (Macs)
• Once you are happy with the records you've selected, click the OK button. (In fact, don't just be happy, be extra sure - you can't reverse a
finalisation. It really is final).
The transactions will be marked as “finalised” (status “fn”), and they will no longer be able to be edited.

Moneyworks exports
If you are using “Moneyworks” accounting software, you can export invoices directly to Moneyworks.
If you have turned this option on in the Preferences, rather than exporting a text file to disk, mSupply will attempt to connect to Moneyworks, and
directly send the invoice data to Moneyworks, where a debtor invoice is created for each invoice in mSupply. You can then use Moneyworks superb
statement production (with full control over the form design) along with it's open item handling of debtor and creditor payments to take over the
handling of payments and receipts. Contact info@sussol.net (mailto:info@sussol.net) if you would like more information.
Finalising. Note that if “export invoices when finalising” is turned on in the Preferences, invoices that have been finalised but not yet given an export
batch will also be included in the list. If any such invoices exist you will be alerted to the fact. A text file called “supplier_invoice_expt.txt” will be
created at the location you have specified in the Preferences.
Note: if you are using mSupply in Client/Server mode, exports will be sent to the “export” folder located in the same folder as the 4D client
application.

Finalise builds...
You need to finalise builds so that they can be purged from mSupply at a later date, or to disallow any further editing of particular builds. Also, you
will not be able to set the start of year stock at the beginning of the next financial year until all builds are finalised.
See the sections above for the details of how to finalise transactions. The process is just the same for builds.

Export a batch again...
Choosing this item presents you with a window where you can choose a batch number to export again:

Invoice batch numbers are shown on the right hand side of invoice lists.
Previous: Field descriptions Next: Managing data files
2011/05/10 07:07

·
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mSupply client/server installation

• mSupply Server can be installed on a range of Windows OS hardware
platforms. Installations of the mSupply Server and client software on
these different platforms will not be identical.
• This page includes instructions for installing the mSupply Server and
client software on a typical Windows 10 Pro platform. This will include
many hardware configuration issues as these have been known to be
important for mSupply Server operation and troubleshooting.

Recommend Hardware
The following table lists minimum recommended hardware for an mSupply server
Item

Recommendation

OS

Windows 2008 / 2011 / 2012 / 2016 or Win 7 / 8 / 10 Pro with latest service packs

Processor

Dual core Xeon or equivalent. For greater than 15 users: Quad core Xeon

Memory

ECC memory Minimum 4Gb +1Gb per user over 8 users

Hard disks

3 Hard drives to run RAID 1 (or 5) Array + Hot Spare. 1 separate Hard disk for primary back up

Network card

Single Gigabit

RAID controller

RAID 1: Onboard RAID controller is fine

Power supply

Dual hot-swap power supply is best, single power supply acceptable with good power quality

Indicative pricing before local taxes: USD3,000 to USD5,000
For a Terminal server, the general specification changes in that
• More RAM is needed.
• Hard disks are less important, as no data is stored on the server (unless you are using the same server for both hosting the mSupply server
and hosting the terminal sessions).

Item

Recommendation

OS

Windows 2008 / 2011 / 2012 or Win 7 / 8 / 10 prof with latest service packs

Processor

Dual core Xeon or equivalent. For greater than 15 users: Quad core Xeon

Memory

ECC memory 8Gb plus 1Gb per connected user

Hard disks

3 or 4 SATA or SAS disks. RAID 1 or 5 with hot spare

Network card

at least one Gigabit
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Item

Recommendation

RAID controller

RAID 1 plus Hot spare, or RAID 5 with hot spare

Power supply

Dual hot-swap power supply is best, single power supply acceptable with good power quality

Indicative pricing before local taxes: USD3,000 to USD5,000

Installation pre-checks
UPS (Interruptible power supply)
• Unless you have extremely reliable power we strongly suggest you install a UPS with external batteries that will provide several hours run
time, e.g.:
◦ Eaton EDX1000HXL (http://powerquality.eaton.com/EDX1000HXL-AU.aspx) or
◦ KStar HP910C (http://www.kstarpower.com/index.php/hp900c-series/).
• The UPS must be able to communicate with the server (usually with a USB cable) to initiate a graceful shutdown in advance of UPS
shutdown.
• For the UPS to protect the server from power surges / spikes, the UPS needs to be connected to a power socket that is properly earthed
(https://en.wikipedia.org/wiki/AC_power_plugs_and_sockets#Earthing_(grounding)).
More details on configuration of the UPS is contained below.

ICT capacity
Do you have sufficient in-house ICT capacity to do the rest of the server installation yourself?
• This server hardware belongs to you (or maybe not… see tip below).
• Sustainable Solutions is a software development company and our core business is not hardware
However, we know that if the server is not installed and configured correctly, the mSupply software and your medical supplies data is vulnerable.
Therefore, in most instances, we end up playing a significant role in installing and configuring the mSupply Server.

Over recent years, with the development of reliable and relatively low-cost cloud
based server solutions, more and more mSupply client / server installations have
used a cloud based server. In many cases, Sustainable Solutions has provided this
cloud based server as a separate service, thus relieving you of any responsibility
for installation, configuration and management of the mSupply Server hardware.

Initial server hardware setup
Set up the physical hardware including
•
•
•
•

RAID 1 volume with Spare (3 disks total)
Separate backups volume
OS install with correct region, and keyboard
Administrator account called Sussol (mSupply server will operate from this account.

Miscellaneous Server Tweaks
There are a number of miscellaneous server tweaks that we recommend:
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Remove Windows / OEM bloatware
• Remove all icons pinned to the Start bar except File Explorer
• Remove / uninstall all tiles on the Windows start area

Hibernation / sleep
• The pc can go to sleep after a few hours so change the power settings to never sleep etc. Even after setting the sleep setting to never you
still must go into the advanced settings and change the hibernate setting to never: How to turn off Hibernation on Windows 10
(https://www.drivereasy.com/knowledge/disable-or-enable-hibernate-on-windows-10-in-2-ways/)

Turn off Cortana
Cortana is unhelpful on mSupply servers. It is worth disabling - refer https://www.windowscentral.com/how-turn-cortana-and-stop-personal-datagathering-windows-10 (https://www.windowscentral.com/how-turn-cortana-and-stop-personal-data-gathering-windows-10)

Automatic Updates
• Update Windows when configuring the computer on a good internet connection.
• This will take a long time, so start it when you have something else to do! Don't panic when the update manager reports 0% Complete for a
looooong time!
• Set 'Windows Update' to auto download, don't install - refer https://www.windowscentral.com/how-stop-updates-installingautomatically-windows-10 (https://www.windowscentral.com/how-stop-updates-installing-automatically-windows-10)

Turn on Windows Update Delivery Optimization
While it is good to control when Windows updates take place, it is often beneficial to use Windows Update Delivery Optimization
(https://privacy.microsoft.com/en-ca/windows-10-windows-update-delivery-optimization) to minimise bandwidth for Windows Updates. It is
recommended to turn on Windows Update Delivery Optimization for the server.

Turn off DEP (data execution protection)
DEP can interfere with 4D - refer 4D Knowledgebase: Tech Tip: Windows Server 2008 also uses DEP (http://kb.4d.com/assetid=75181), so, we may
need to adjust it - refer https://www.online-tech-tips.com/windows-xp/disable-turn-off-dep-windows/ (https://www.online-tech-tips.com/windows-xp/
disable-turn-off-dep-windows/)
• Initially, try things with the default setting (Turn on DEP for for essential Windows programs and services only)
• Then, if 4D / mSupply has issues, try Turning off DEP for all programs and services:
◦ Open command prompt (as administrator)
◦ Run the following: bcdedit.exe /set {current} nx AlwaysOff

Correct Keyboard
Even if you chose the correct keyboard (normally US) during setup, another keyboard (like the UK keyboard) can sometimes still be the default
keyboard. Check this by trying to type the @ character… To fix this, you will need to:
• Go to Settings → Time & Language → Region & Language → Language
• Add the correct language (e.g. English (Australia)). This will auto select US keyboard
• Move it up to the default position and delete the other language option(s).

Remote connectivity efficiency - Best performance
Remote access speed gain by disabling visual effects.
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• Go to System → Advanced System settings → Performance and choose Adjust for best performance.

Remote connectivity efficiency - Remove background picture
Remote access speed gain by removing the background picture on the Windows 10 sign-in screen (https://www.windowscentral.com/how-removewindows-10-background-picture-sign-screen).
• Go to Settings (keyboard shortcut: Windows + I) > Personalization > Lock screen.
• Scroll down and turn off the option, Show Windows background picture on the sign-in screen.

Improve Windows Explorer file visibility
To carry out some of the server configuration tasks, file visibility in the Windows OS needs to be improved from the default.
Follow these instructions to View hidden files and folders in Windows 10 (https://support.microsoft.com/en-us/help/4028316/windows-view-hiddenfiles-and-folders-in-windows-10)
While doing this, make the following changes:
•
•
•
•
•
•
•

Always show menus
Display the full path in the title bar
Show hidden files, folders and drives
Don't hide empty drives
Don't hide extensions for known file types
Don't hide protected operating system files (Recommended)
Use check boxes to select items

Install associated server application software
Install Dropbox
Sustainable Solutions recommends using Dropbox (https://www.dropbox.com/) to assist with transferring installation files to the server, and as a
means of moving mSupply secondary backups off site.
• Contact Sustainable Solutions to organise a DropBox account for the server and for instructions on setting it up on the server.

Do this step first so that you can use the Dropbox folder to transfer software and
files to the server.

Install Remote Support software
Sustainable Solutions uses software to provide remote support. We have used a few packages over the years. At the time of writing this (May 2018),
we are using TeamViewer (https://www.teamviewer.com).
• Contact Sustainable Solutions to organise setting up TeamViewer on the server.

If possible, please change the computer name (https://www.cnet.com/how-to/howto-change-your-computers-name-in-windows-10/) to something recognisable, e.g.
Nonga GH Server.
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Install UPS hardware and software
If its not already done, install the UPS hardware and software, refer UPS above.

Install Anti-virus software
Anti-virus can be a hotly contended issue. This web page is pretty convincing: What’s the Best Antivirus for Windows 10? (Is Windows Defender
Good Enough?) (https://www.howtogeek.com/225385/what%E2%80%99s-the-best-antivirus-for-windows-10-is-windows-defender-good-enough)
Conclusion:
• If the OS is Win8 or later, Windows Defender is probably good enough for anti-virus, and better than much of the competition.
• Once configured, the server should not be vulnerable to exploit programs as these are usually downloaded and triggered by human activity!
However, to be safe, it is recommended to install an Anti-exploit program such as Malwarebytes (https://www.malwarebytes.com/). The
website suggests that Malwarebytes is not free, but as at the time of writing this (May 2018), Malwarebytes successfully reverts to a free
version after the 14 days trial. This means that it has to be manually run.

Install another Web browser
If you're not a fan of Microsoft Internet Explorer (https://en.wikipedia.org/wiki/Internet_Explorer), (12 reasons not to use Internet Explorer, ever
(https://www.computerworld.com/article/2470270/internet/12-reasons-not-to-use-internet-explorer--ever.html)) then install another browser. Good
options include:
• Google Chrome (https://www.google.com/chrome/)
• Mozilla Firefox (https://www.mozilla.org/en-US/firefox/)
Pin the browser to the Taskbar.

Install LibreOffice
mSupply can produce reports in Microsoft Excel (https://en.wikipedia.org/wiki/Microsoft_Excel) format. Client machines will need to have software
to open these reports. Occasionally there will be need to run and open these reports while logged in to the Server. If you do not have Microsoft Excel
installed on the server, a good option is:
• LibreOffice (https://www.libreoffice.org/download/download)
It's a good idea to stick this in to the Dropbox

Install TurnedOnTimesView
As part of troubleshooting, it is valuable to be able to analyse when the server has shut down ungracefully.
• TurnedOnTimesView (http://www.nirsoft.net/utils/computer_turned_on_times.html) is a simple tool that analyses the event log of
Windows operating system, and detects the time ranges that your computer was turned on and whether the last shutdown was graceful or
not.
• Installation instructions are on the website, but is very straightforward:
◦ Copy the TurnedOnTimesView.exe file to the Desktop
◦ Pin it to the Taskbar.
TurnedOnTimesView.zip
It's a good idea to stick this in to the following folder in Dropbox:
• TurnedOnTimesView
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Install Logoff and Lock utilities
It is too easy for support workers accessing the server remotely to accidentally shutdown the server. Therefore, two Windows shortcuts have been
created to allow support workers to easily logoff or lock their windows session without having to go through the usual Windows procedure:
• Lock computer
• Logoff computer
Lock / Logout utilities
It's a good idea to stick this in to the following folder in Dropbox:
• Lock Logout Shortcuts
The Yellow Lock computer utility needs to be copied to the Admin desktop and then pinned to the task bar.
The Green Logoff computer utility needs to be copied to the C:\Users\Public\Desktop folder. This will place the shortcut on the desktop of
each normal user. Users of each normal user account will need to pin this shortcut from the desktop to the taskbar. We try to keep the Admin account
open so as to keep Dropbox working.

The C:\Users\Public\Desktop folder is normally a hidden folder. You will likely need to make it visible
(https://support.microsoft.com/en-us/help/4028316/windows-view-hidden-files-and-folders-in-windows-10)).

If you are upgrading from a previous version...
If you are upgrading from a previous version of mSupply, first perform a data backup:
• With mSupply server open as an application click on File> Backup…. This will generate a backup file of your current data with file
extension .4bk.
• Copy this file to at least one safe place, e.g. USB drive, a cloud service such as Dropbox.
• Continue only when the .4bk file has completed transfer to the remote location.

There was a major upgrade of mSupply's internal structure in v3.50. If you are
upgrading from a pre v3.50 installation of mSupply, Sustainable Solutions will
need to convert your data so that it can be read by mSupply versions after v3.50.
This conversion process is provided free of charge.

Installing mSupply server

The client/server version of mSupply has two installers:
• One installer, with the word server in the title, is used to install the
mSupply Server software on a single server computer.
• The other installer, with the word client in the title, is used to install
the mSupply Client software on as many computers as you wish
including on the server computer. You will be limited in how many
clients can connect at any one time by the server licence you have
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purchased.

Obtain and run the mSupply Server installer

You must be logged on as Administrator to install mSupply Server with the correct
permissions. Please consult your IT support staff if you require assistance to
achieve this.

Once you have obtained the mSupply Server installer file, double click it to install. Here is what the mSupply server installation window should look
like:

•
•
•
•
•
•
•

You may be asked by the OS whether 'you want to allow this app to make changes to your device?'. Click Yes
At the mSupply Server Setup Welcome screen, click Next
To proceed with the installation, you will need to click on the 'I agree to the terms of this license agreement' radio button and click Next
Unless you have good reason to do otherwise, don't change the installation folder, and click Next
Unless you have good reason to do otherwise, don't change the Shortcut folder, and click Next
At the Ready to Install window, click Next
After some time (minutes!) you will be shown the Installation Successful window. Click Finish

What is installed where:
We strongly recommend you do not change the default installation directories, which are as follows:
• mSupply Server: C:\Program files\mSupply\mSupply Server
• mSupply Client (see Installing mSupply Client below): C:\mSupply Client
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mSupply Server installer also installs the following files and folders:

Starting the Server for the first time

There is no point in carrying out the following steps unless:
• You have the the license registration file
• You are ready to create a new mSupply data file, or you have one to
load.

Registering the 4D License
• mSupply is built on the 4D (http://www.4d.com/) database engine. 4D Licenses are required for the Client - Server operation.
• You will need the license registration file(s) sent to you by Sustainable Solutions and paste them to the following folder:
◦ C:\ProgramData\4D\Licenses
• Alternatively, if Sustainable Solutions staff have remote access to your server, they can apply the license.

Run mSupply Server

We need to run mSupply Server as an application until all configuration is completed. Don't run as a Service now as some configuration
functionality is not enabled when run as Service.

There should be a shortcut on the Desktop called mSupply Server.
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Right-click on the icon and select Run as administrator

You will then be presented with the following dialogue box:

Click Create to create a new data file or Open to choose an existing data file. The below image shows an existing data file.
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• You can create the data file anywhere you like, as long as you have
read/write access to the directory.
• To assist with provision of support we recommend that you create a
place the data file in a folder called mSupply data inside your
Documents folder (My Documents before Windows Vista!).

You may get a question from the Windows Firewall requesting permission for mSupply to communicate through the Firewall.
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Allow mSupply to communicate on both private and public networks.
If the above steps have succeeded, you should see the 4D Server Administration window:
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Configure Backups
• Select Maintenance and then, under the 'band' titled Last backup select Preferences.
◦ Scheduler: Set Automatic Backup: to Every day, at 20:00 or later, as long as it is a time when work is likely to be
finished. It will have to be set earlier, say 16:00 if the server is switched off of an evening.
◦ Configuration:
▪ Content:
▪ tick Data File
▪ untick Structure File
▪ untick User Structure File
• Backup File Destination Folder
◦ If on physical hardware, this should be a separate physical disk (e.g. D:\mSupply_backups).
◦ If on a virtual machine, it is meaningless to have a separate physical disk, and it should be C:\Users\Administrator\
Documents\mSupply backups.
• Log Management: Set .journal to the same parent folder as the backups.
◦ If on physical hardware, this should be a separate physical disk (e.g. D:\mSupply_journal).
◦ If on a virtual machine, it is meaningless to have a separate physical disk, and it should be C:\Users\Administrator\
Documents\mSupply journal. *

If a location of the log file is already specified, and you want to change it, you
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need to untick the “Use Log” tick-box and then when you re-tick it you will be
prompted for a new location.

• Backup & Restore
◦ General settings
▪ tick Keep only last 60 backup files. Of course if the drive you are backing up to doesn't look like it will have 60x
the space one backup file will need then lower the number appropriately.
▪ tick Backup only if the data file has been modified
▪ Delete oldest backup file after backup
▪ If backup fails: select Retry after 60 Seconds
▪ tick Cancel the operation after 3 attempts.
◦ Archive
▪ Segment Size (Mb): None
▪ Compression Rate: Compact
▪ Interlacing Rate: None
▪ Redundancy Rate: None
• Automatic Restore
◦ tick Restore last backup if database is damaged
◦ tick Integrate last log if database is incomplete
• Click OK
You will see the following dialogue box:

• Click OK to create the first backup.

Configure Cache
Confirm Cache settings (there will likely be no changes):
• Select Maintenance > Last backup: > Preferences > Database > Memory:
◦ Tick Calculation of adaptive cache. Settings here are set by 4D on the basis of the system memory. It is probably safe to keep
them as is. Otherwise, set them to:
▪ Memory to be reserved for other applications and for the system: 500 MB
▪ Percentage of available memeory used for cache: 50%
▪ Minimum Size: 100??
▪ Maximum Size: 1024??
◦ Un-tick Keep the cache in physical memory for 4D Server and 4D Volume Desktop
▪ Flush Data Buffers every: 10 Minutes
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Exit 4D Server Administration window.

Enter Extra 4D serial numbers
When you registered 4D server the licence allowed 2 concurrent connections. If you have purchased extra connections, you should enter the serial
number(s) now.
Choose Help > Update licence. This window is shown:

Click the Add button to enter additional licences.

Setting the server to run as a service
The server should now be set to start automatically when the machine is turned on. This can be accomplished by setting the server to run as a service.
Choose File > Register Current Database as Service.

If the Register Current Database as Service option is greyed out, you need to
quit the server and run as administrator.
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Quit the 4D Server Administration window by clicking the close box on the top right (or choose File > Quit from the menus). You will then be
shown a disconnect window something like this:

Type 0 into the box, and click OK . The server will quit.

Pin Services to the taskbar
It is important to be able to quickly observe the status of the 4D / mSupply Service. Therefore, we pin Services to the taskbar:
•
•
•
•

Click Windows icon
Type Services
Right-click the Services Desktop App
Select Pin to taskbar

Configure mSupply Service settings
Click on Services in the task bar. You will be shown a window like this.
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Double-click on 4DServer: mSupply - fortunately it is usually the first item in the list!
You will be shown the 4D service properties window. Change the Startup type in the drop-down list to automatic (Delayed start) .
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On the Log On tab, the settings should be shown below:
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•
•
•
•
•

Make sure “Log on as” is set to “local system account”
Make sure “Allow service to interact with desktop” is checked.
Click OK to return to the list of services.
You can now start the service by clicking the little play button (right facing triangle) on the toolbar with the 4D service highlighted.
Scroll down the list of services until you see Interactive Services Detection.

•
•
•
•

Double click this and then change “Manual” to “Automatic”.
Then click on the Log on tab and tick the box, “Allow service to interact with desktop”
Click OK at the bottom of the window
Click the Start Service button (see the button in the red box above). At this point the status should start reporting either “started” or
“running”.
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• Click the red X to close the Services window.

If clicking the Start Service button results in the , a registry edit (regedit) is
necessary. Please only do this if you are confident and familiar with editing the
registry. mSupply Support can help with this. Edit registry value:
Hive: HKEY_LOCAL_MACHINE
Path: SYSTEM\CurrentControlSet\Control\Windows
DWORD: NoInteractiveServices

Change value “1” to “0”
Once finished editing the registry, close regedit and return to the list of services
and start the ISD service. It should now start!

From now on the 4D server will start automatically when the machine is turned on. There is no need to log-on to the machine.
Should you need to manually stop and start the server in future:
• To start, double-click the “Services” shortcut you made on the desktop, highlight the 4D server service, and click the “start” button (looks
like a “Play” button on a VCR )
• To stop the server, make sure clients are not connected, then choose File > Quit on the server.

Delete mSupply Server shortcut
Now that mSupply server is running as a service, we want to make it difficult to accidentally run the mSupply application manually. We recommend
that you delete the mSupply Server shortcut.

Creating a new data file or choosing a different data file
From this point there should be no need to revisit any of the above procedures to operate mSupply. However, if you are testing, or starting a data file
for a second organisation, you may wish either to change the data file mSupply is using or to create a new file.
The mSupply program (the files named “mSupply.4DC” and “mSupply.RSR”) store the path to the last data file used, and the next time mSupply is
started, the previous data file that was open is opened again unless there is user intervention or the “old” data file has been moved to a new location.
To intervene, hold down the “alt” key as the 4D server starts up.
You will be shown the standard open/save window:
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To create a new data file, click the “New” button.
To select an existing data file, navigate to the file's location then click the “Open” button.

Installing mSupply Client
Needed: mSupply Client software of the same version (or relatively recent) as the mSupply Server.

• The mSupply server should run as a service on the server computer see above. If any user needs to use mSupply on the server (not
recommended, but possible, and sometimes necessary) then they should
not be running the mSupply Server software. They should run the
mSupply Client software, which should be made available to all user
accounts.

OS date settings
Generally, mSupply will interact correctly with the local OS in terms of date format. However, as OS versions continue to evolve and handle dates
differently, sometimes this does not work. We have found that very occasionally, if the OS date format is set to DD-MMM-YY (e.g. 20 APR 2020)
then mSupply will not always handle the date well. It is recommended to set the system date to DD-MM-YY.

Obtain and run mSupply Client installer

You must be logged on as Administrator to install mSupply Client with the correct
permissions. Please consult your IT support staff if you require assistance to
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achieve this.

• Once you have obtained the mSupply Client installer file, double click it to install.
The mSupply client will be installed in the folder C:\mSupply\mSupply client on your computer.
mSupply client installer also installs the following files and folders:
• A folder called “\4D\Network” in the Windows folder on the startup volume, which contains network component files that need to be
present for 4D to communicate over a TCP (and other types of) network(s).
• Note that no reports are installed on 4D client. Each time 4D client connects to the Server, reports that have been added or modified on the
server are automatically copied to the client.
• Note that the installers have been set up to overwrite existing files, so reinstalling the software will restore any potentially corrupted files to
their original state. The installer will not overwrite your data files, unless you have been unwise enough to name your data file “example
data” and put it in the “example data” folder;-).
Once the installation is completed, double-click the “start mSupply Client” shortcut on your desktop. A window something like this should appear:

The window lists available mSupply servers on your network (there should be only one!) Click on the server you wish to connect to.

• Once you have connected successfully, the mSupply Client 'remembers'
which Server you last connected to and stores this in the Recent tab.
Whenever you run the mSupply Client, it will automatically connect to
that server.
• If, mSupply Client cannot connect to the mSupply Server, this window
will pop up showing the Recent tab. You can try choosing the server
there.
• If, for some reason, network settings have been changed and you
cannot connect from the Recent tab, remember to look at the TCP/IP
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tab as well.

Clicking the “OK” button will take you to the mSupply password entry window. For new data files, the password is user1 for the first user in the list.
Click on the first user, then enter the password and click OK

Server is not visible?
• To make it easy for you to connect, mSupply Server publishes details
about available servers on a specific port. It is quite possible that
products such as “Zone Alarm” and “Norton Personal Firewall” will
block access to this port and stop discovery of the servers. Contact your
system administrator if the list of available servers is blank.
• Of course, it may be possible that the mSupply Server service is not
running. Check Services to establish that.
• Lastly, the Windows firewall may be blocking the Server publishing it's
presence - see below.

Configuring Windows firewall on server
The Windows firewall may need to be adjusted to allow the Client to receive Server identification.

From the 4D tech email list:
• When you launch 4D client, it broadcasts a udp message on the subnet,
requesting all 4D servers to identify themselves.
• The UDP message is sent from a random port to a destination port =
19813 (default)
• When responding, each 4D server replies with a UDP unicast message
from its address to the client's address with source port = 19813 and
destination port = whatever port the client had used to broadcast.
• So in order to let the client receive the answer back from the server, one
has to punch a hole in the firewall for all UDP packets with a source
port of 19813.

mSupply Server Configuration
Register mSupply
The procedure is described earlier in “Preferences” chapter of the mSupply manual. See the_register_button
You will either have to phone or email the information to Sustainable Solutions to obtain a registration code.

The registration code is keyed to your Organisation name and the MAC address of
the server. Changing either of these will require a new code, which we shall
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willingly provide. So, take care when setting the Organisation Name!

Configure mSupply Preferences
Once registered, you may want to systematically to go through the mSupply Preferences and choose appropriate settings, and particularly setting up
the ! Start here: Preferences > General

Your installation of mSupply may have customisations made specifically for your
work scenario. Please contact our support staff on support@msupply.org.nz to
manage these customisations.

Configure label printer
If you are dispensing, you will need to set up label printer preferences

Upgrading to a newer version of mSupply

User Access Control, a feature of Windows 7, requires that the undernoted steps
are followed when you are upgrading mSupply

1.
2.
3.
4.
5.

In Windows 7 click Start Menu> Control Panel> User Accounts
Click 'Change User Account Control Settings'
In the window that appears move the slider to the bottom and hit OK
You will be requested to restart the computer - do so(!)
If you copied the files already (which wont work as the pseudo copy occurs) these copied files should now automatically work

Graceful shutdown in the event of a power failure
Your mSupply server should be attached to a UPS. The UPS should be fitted with a control cable (serial, USB or network cable) that allows control
software to detect a low power situation and shut down the server.
In the UPS control software set the shutdown to start at least two minutes before the power will fail.
Set it to run a batch file at that point. The file should contain the single line “net stop Service name” where the service name is the name displayed in
the properties when you double-click the service name in the services window. In the example below the service name is “4DS mSupply.4DC” (not to
be confused with the display name)

You may wish to test your typing skills by opening a command prompt:
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Accessing a cloud hosted server
Access to a cloud hosted mSupply server is through the Windows Remote Desktop Protocol (https://en.wikipedia.org/wiki/
Remote_Desktop_Protocol).

Windows client
If the mSupply client software is running on a PC, there are a range of applications that can be used for accessing the cloud hosted mSupply server
including Microsoft's own Remote Desktop Connection software (https://support.microsoft.com/en-us/help/17463/windows-7-connect-to-anothercomputer-remote-desktop-connection) that comes included with Microsoft Windows. There are third party implementations that provide additional
security and controls. One that we are currently (2016) finding effective is TS-Plus (http://www.tsplus.net/).

Macintosh Client
Access to the the Microsoft Remote Desktop App is available on the Apple Store: https://itunes.apple.com/en/app/microsoft-remote-desktop/
id715768417?mt=12 (https://itunes.apple.com/en/app/microsoft-remote-desktop/id715768417?mt=12)
• The Display Name is the name that will appear on your computer. We suggest you make it: mSupply Remote Access
• The Computer Name is the name of the domain name of the mSupply server computer that you are connecting to.
Previous: Managing Data Files Next: Configure Dispensary mode
2011/05/16 15:09

·

Managing data files
Creating a New Data File
This command will present you with a standard open/save window where you can choose the name and location of a new data file: If you click the OK
button, mSupply will close the data file currently in use (saving any changes made automatically), and then open the new data file. The new data file
will contain no items, names or transactions. You can either enter these manually or use the import commands (see later in this chapter) to import
items, names and stock.

Open an existing data file
This command will present you with a standard open/save window where you can select an existing data file to open. If you click the OK button after
successfully selecting a valid mSupply data file, mSupply will close the data file currently in use (saving any changes made automatically), and then
open the new data file. Note that if you regularly use more than one data file, use the “About mSupply…”. Command from the help menu (mSupply
menu on Macintosh), where the data file currently in use is displayed. Warning:: Do not try to open the same data file from 2 or more single user
copies of mSupply at the same time. You will corrupt your data. If you require multi-user access, buy a multi-user licence!
Previous: Finalising transactions Next: mSupply Client/Server installation
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·

mSupply dispensary installation
mSupply provides a fully featured Pharmacy Dispensary module. The following steps describe how to configure mSupply for Dispensary use. This
document specifically applies to Pharmacy Dispensary staff.

Users
• Set up users to log in in dispensary mode

Permissions
Misc
•
•
•
•

Show direction entry: checked
Item codes must be unique: checked
Service items: can be set to “allowed” if recording non-stock charges- like a dispensing fee.
Show direction entry: checked

Invoices 2
• Allow placeholder lines: checked

Handling stock on hand
You may want to consider setting stock to a very large number for each item. This will mean that stock is effectively ignored. Experience tells us it is
very (very) hard to accurately track stock in a busy dispensary, and most likely unnecessary if you are tracking issues to the dispensary from another
virtual store.

Per store preferences
Preferences in the dispensing store
Go to Special > Stores > Double-click the dispensary store and set these preferences (and maybe others)
• Patients created in this store not visible in other stores: checked
• Names created in this store not visible in other stores: checked (may vary depending on situation)
• Your training will have to take into account the setting for stock transfers that you choose here.

Pack to one
As dispensing is invariably in multiples of single tablets etc, you will want incoming stock converted to packs of one. You can do this on a per-item
basis, but the better way is to go to Special > Stores > Double-click the store you're logged in to, and you'll see a visibility tab. On that tab click “Set
pack to one for all visible items in this store”

If your dispensary store is 'Active' (refer Remote synchronisation, Store sync
types) on a Sync Satellite server, then you will not see the Visibility tab when
logged in to the store on that Sync Satellite server. These settings need to be done
while logged in to the Sync Primary server.
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Abbreviations
Choosing a set of abbreviations should be a collaborative activity with staff. Note you can import abbreviations
If more than one language is used, you might want to make the same abbreviation with a suffix for the less common language. eg
Abbreviation

Expansion

Comment

tid

dinko tin palta

In your common local language (in this case Nepali)

tide

three times a day

add a suffix “e” to the same abbreviation when using for the English expansion

Latin abbreviations are universal
Abbreviation

Expansion

od

once a day

bd (or bid)

twice a day

tid

three times a day

qid

four times a day

hs

at bedtime

nocte

at night

pr

in the rectum

po

orally (by mouth)

pv

into the vagina

qqh

every four hours

q6h

every six hours

It is important to be consistent with choosing abbreviations so people can remember them. e.g.
Abbreviation

Expansion

1t

Take one tablet

2t

Take two tablets

3t

Take three tablets

ht

Take half a tablet

1c

Take one capsule
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Abbreviation

Expansion

2c

Take two capsules

wtf

with tasty food

Users should be trained that you can mix abbreviations and normal text- wherever an abbreviation is encountered it will be expanded. It is important
not to make an abbreviation that is a normal word in the language, else the expansion will happen when the word is typed.

Item abbreviation shortcuts
This is important. See here The aim should be that every common item has all common directions saved as a shortcut. Pay attention to having the most
common shortcut at the top of the list.

Patients
In a dispensary, your customers are the patients. Their details need to be recorded. This can be done prior to implementing dispensing through
importing of patients - refer Patients. In many cases, you will find that there is no accessible database of patient names and that you will need to enter
patients 'on-the-fly'. A New Patient button is on the Prescription entry window for this purpose. This will slow down the dispensing process, but over
time, as more and more prescriptions are for 'existing' patients (e.g. for inpatients and chronic patients), this will become less of an issue.

Patient Code
Each new patient requires a patient code. This patient code can be applied automatically be ticking File > Preferences > Dispensary Mode > Autogenerate patient code. You also have the option here to prefix the codes with a string of text. This is particularly helpful in a multi-facility installation
where patients may be referred from one facility to the next and you would like to know in which facility they first entered into the system.

Prescribers
mSupply allows prescribers to be recorded against each prescription. This can be made a requirement by ticking File > Preferences > Dispensary
Mode > Prescriber must be entered. Making the recording of the prescriber mandatory will obviously slow down data entry during the dispensing
process. In order to record prescribers with prescriptions, prescribers must be entered into the system - refer Prescribers.

Printing
Set printing to be on by default for new entries, and off by default for edits.
Train users on changing printers using Special > Printing preferences
It is important that printers have a static IP address. You can do this in two ways:
1. Set a static IP address on the printer. Log on to http://printer_ip_address (http://printer_ip_address) to do this. It's under network settings.
The default IP for Zebra printers is 192.168.254.254
2. Use the DHCP server on your network to set a Static DHCP mapping. This is preferred, as it's much easier to change.

With a Zebra GK 420 you can hold the front button until it flashes once, release it,
then it will print out the IP address. Read all about it

Previous: mSupply Client/Server installation Next: mSupply Server Administration
2014/11/14 06:26

·
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mSupply server administration
mSupply server provides a number of administrative features that enable fine-tuning and robust management of the system.

Server Monitor
The server monitor tells us our computer hardware specification, database engine version, and license information including maximum connections

Users
The Users tab shows us connected users with LAN information, IP address, machine name and Windows logon user name
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Processes
The processes window shows system resource consumption for each process. This is a useful screen to analyse slow or otherwise unresponsive
systems.

Maintenance
The maintenance tab is where data info and actions can be retrieved and performed. The window shows when tasks were last performed and provides
the settings to perform verification, data compacting and log recording.
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Backup
The Backup tab provides settings to manage the way your data is backed up and where the backup file resides. This is a critically important section to
manage properly as your data is a key asset of your system.
Schedule a backup:

Configure content and destination of the backup:

889

mSupply user guide July 2018

Backup & Restore: Decide how many backups to store in your destination folder. You may also set the system to retry backups if a backup is not
possible at the scheduled date and time. Eg. if the system is not running.
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Application Server
Application Server: The application server provides settings to manage the structure (.4DC file) and data (.4DD) files. It also provides information
about LAN and system memory.
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Web Server
Web Server: The Web server tab shows the web server status and running ports. The web server can be started or stopped form this tab.
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mSupply file extensions and types
This information is just for reference and to help your understanding.
On both Macintosh and Windows OS - five files.
•
•
•
•
•

A structure file (.4DC suffix)
A structure resource file (.rsr suffix)
An executable file (.exe suffix)
A data file (.4DD suffix)
A data resource file (.4DR suffix)

File arrangement
It is easiest to keep all relevant files in the same folder, in a reasonably accessible place on your hard drive. (For example, directly on your “C” drive.)
If you make copies, don't leave them in the same folder, or you'll just get confused!
There are several folders to store reports and queries that need to be in the same folder as your structure file. Note that these folders are automatically
created when you unzip the program files the first time. They are mentioned here so those of you with an inquisitive streak won't unknowingly do
damage!
• A reports folder. This stores reports that are used by the program. Leave this folder alone- store your own reports in the custom reports
folder.
• A custom reports folder. Store the reports you create here.
• A custom queries folder. Store the queries (searches) you create here.
• A custom labels folder. Store any label templates you create here.
Note that on Windows or Macintosh the run time application (that is, the database engine- “4Drun.exe” file on windows) can reside anywhere on your
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hard disk, and does not need to be regularly backed up (although you should have one backup copy somewhere!)

Getting the right data file when you open mSupply
Important! If you open mSupply by double-clicking the “start mSupply” icon on the desktop (Mac users- by double-clicking the structure file),
mSupply will try to open the same data file that was last opened. It will open the same file each time if you repeat the same procedure. If you make a
copy, and then double-click the copy of the structure file, mSupply may still open using the data file from the original if it can find it.
To choose the data file manually do this:
Mac: hold down the option key as you click the OK button in the password window. You will then be given an open/save box to choose the correct
data file.
Windows: Launch the program and then quickly hold down the Alt button until you see a box come up. It will give you an option to Select another
data file.
If you are not sure which structure and data file you are currently using, on a pc logged into the correct datafile, choose about mSupply… from the
help menu (Windows) or the apple menu (Mac).
Previous: mSupply Dispensary Installation Next: mSupply Deployment
2013/05/24 05:55

·

mSupply deployment
This document gives an overview of the process of installing mSupply at a new location.

Terms
• A virtual store will usually map to a physical location- either a separate warehouse or an entity within a warehouse that has it's own items
and facilities and transactions
◦ All virtual stores share the same item and customer/supplier lists, but if an item is not used in all stores, it can be hidden in
stores where it is not used. The same applies for customers/suppliers.
• A transaction refers to a record that records stock movements- from a supplier, to a customer/facility, or to adjust stock
• A name refers to a customer or supplier.
• A customer may be a supply point- not necessarily an entity that pays for supplies.

Cloud or Local
Criteria for for a robust local installation of mSupply:

Physical locations
• Dry, secure locations with the infrastructure connections as detailed below
• Management of security for human access.

Hardware
• You will need to buy hardware as per specifications on this web site.
• Scalability- as the size of your installation grows you might have to buy new hardware (more speed, RAM, storage)
◦ Expect to purchase a main server plus one extra server for every 35 remote desktop users and one web server for every 1000
sync users.
◦ This is much easier for a cloud or virtual server - you just assign more RAM, storage or CPUs to the server
• Redundancy
◦ if hardware failure will create more downtime than is acceptable (realistically it will create one or two days of downtime), then
you need to have a redundant system. That is, you need to:
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▪
▪
▪
▪

replicate the hardware at a different physical location
Have a fast network connection between the two sites.
The second site will need the same network connectivity for client access as your main site.
Have control of DNS to redirect users to the backup site when the primary site fails.

Electricity supply
• Stable, earthed electricity supply
• UPS systems with enough runtime to cover outages and the ability to communicate with the server so it can gracefully shutdown before
batteries are exhausted.
• A generator system with auto-start might be needed.
• All of the above at the redundant site as well.

Network
•
•
•
•

Enough ingress and egress network capacity for the software's requirements.
Ability to expand the capacity as the system grows.
The same capacity at the redundant site.
A high capacity network connection between the main and the redundant site for realtime replication of server data so the redundant site is
up to date.
• You may also decide that redundant connections are needed to the primary server site.

Local IT expertise
•
•
•
•
•

Sufficient local expertise to distinguish between hardware, software, network and electricity issues.
The expertise must be available during all hours the system must be available
Written fail-over plans for failures in the above systems.
Ability to execute plans on time when there is a failure.
Knowledge transfer to new staff when existing staff leave.

Structure
It is important to design the overall structure to meet your organisation's needs. This mainly focuses on:
• Deciding how to connect users
◦ Direct LAN connection
◦ Terminal services
◦ Discreet servers with synchronisation. This option is useful when internet access is intermittent.
• setting up virtual stores
• Setting up preferences
◦ General Preferences
◦ Invoices Preferences
◦ Printing Preferences
◦ Purchase Order Preferences
◦ Synchronisation

Importing data
Most sites will have existing lists of items and names. The user guide has sections on:
• Importing items & stock
• Importing Items
• Importing Customers, Suppliers, Patients
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Users
The permissions system can be set up for individual users, or be based on groups. See Managing users

Warehouse management
If your warehouse has existing locations you can import them: Locations and Location types Otherwise you will need to design a location scheme.
Previous: mSupply Server Administration Next: Managing Users
2014/11/19 12:38

·

Managing users
Updated: Version 3.74

About users and groups
As of version 3.13, mSupply has important improvements to its user management:
1. User permissions are now per-store, so a user can have different permissions when logged into different stores.
2. You can create and use user groups. Once a group is set up and permissions for the group assigned, any users that are assigned to the group
will inherit the group's permissions, rather than having to set permissions for each user individually. When you change a group's
permissions, you change the permissions for all users who belong to that group. This is very useful if you have a lot of users.

If you want to change a user's permissions and find out that all their permissions
are greyed out and uneditable then it means they are a member of a group. To edit
their permissions separately from the group, they must first be removed from the
group:
• Edit the user, change the Is a member of to None, click OK.
• Edit the user, set permissions as required, click OK.
Refer to Using groups below for more details. If the user is to remain part of the
group then you must change the group's permissions (see Editing a group below)
but beware, this will change the permissions for all users who belong to the group,
not just the user you're interested in.

If you want to disable a user, perhaps because the staff member has left the
organisation, then they must be made 'inactive':
• Edit the user, uncheck the Active checkbox, click OK.
If the Active checkbox is greyed out, it is because they are a member of a group.
You will need to first remove them from the group before you can make them
'inactive':
• Edit the user, change the Is a member of to None
• Edit the user, uncheck the Active checkbox, click OK.
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To prevent all users being disabled in the system, mSupply does not allow the first
2 users created to be disabled, even if they belong to a group which has been
disabled.

Adding and editing users and groups
mSupply has a comprehensive system of controlling user access, allowing you to manage in fine detail what each user can do and see in the system.
You can manage users individually, in groups or a mixture of both - whichever is most suitable for your situation.
User access is managed by choosing File > Edit users from the menus, or by choosing Admin > Edit users in the Navigator. When clicking on this
option you are presented with a list of current users:

The list shows you the following information:
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•
•
•
•

User The user's name.
Job title The user's job title, as entered on the details tab of the user's details form.
Group The group the user belongs to. Will be blank of the user does not belong to a group.
Active Checked if the user is allowed to login to the system.

To view groups rather than users, choose Groups from the Show Drop-down list at the top-right of the window. The list changes slightly to look like
this:

Now the list shows you slightly different information:
• Group The name of the group
• Active Checked if the group is active. If the group is active then all users in the group are allowed to login to the system. If the group is
inactive (checkbox unchecked), all users in the group are inactive and are not allowed to login to the system.
To get a list of all current user permissions, click the Permission Report button. An Excel spreadsheet will be generated; it will have one worksheet
for each store showing all the users and groups and what permissions they have in that store.
Double-click a user (or group) to edit their details or delete them. Click the New User button to add a new user (or the New group button to add a new
group). Doing either will open the user details window (described below - for a new user or group all the tabs are empty, for an existing user or group
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the tabs are filled with their current settings)

The user details window

This window has several tabs, all described below.

The General tab
• Is a member of drop down list: Used to select the permissions group the user belongs to (see below). When the window loads, it displays
the group the user currently belongs to - will show “None” if they are not a member of any group.
• Password textbox: Will always appear empty when the window is loaded. Must be set for a new user, can be used to change the password
of an existing user.
• Confirm password textbox: If something is entered in the Password textbox then the same text must be entered in here. Makes sure you set
the password to what you think you're setting it to!
• Active checkbox: If this checkbox is checked, then that user has permission to use the system, and their name will appear in the login
window. If this checkbox is unchecked the user will not be allowed to login to the system and their name will not appear in the login
window.
• Can be responsible officer checkbox: If this box is checked, the name of that user will appear for selection in the Responsible Officer
selector on the Transport Details tab of a customer invoice.
• User initials User initials should be entered in this field.
• Language drop down list: Allows you to select which language the user wants to use in mSupply. Supported languages are
◦ English
◦ French
◦ Lao
◦ Spanish (incomplete translation- free free to offer to help!)
• LDAP section: used to check a user's login credentials against an LDAP (Lightweight Directory Access Protocol) server. If you are going to
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•
•
•
•

use LDAP you must fill in the server details in the General preferences first.
◦ Login using LDAP: Check this if you want this user's login details to be checked against your LDAP server. Means that you
can have some users logging in normally and some being checked against your LDAP server. Helpful if there's a delay in users
being given LDAP credentials for any reason.
◦ LDAP login string: Enter any string which has to be used with the LDAP login. Will be provided by the LDAP administrator if
required.
Windows username textbox: the username the user logs into window systems with. Used to provide single-sign-on capability when the user
is logging in remotely to an mSupply client running on a Windows server.
License category drop down list: Used to select which user license category the user belongs to. Will contain a list of all user categories
currently set up in the datafile. See License management for details.
User belongs to State/Region drop down list: Used to select the name category 1 that the user belongs to. Only used in some customised
versions of mSupply.
Signature section: use to add or remove an image of a user's scanned signature for displaying on invoices for example

The Permissions tabs
These are where you can set access to the many features and functions on a store-by-store basis for each user or group. There are three Permissions
tabs and each are shown in the screenshots below.

Buttons on the permissions tabs
• The Store drop down list: Selects the store for which permissions are being displayed and set on the current tab. This is how you set
permissions in different stores for users.
• The All on button: Checks all the permissions on the current tab i.e. turns them all on. There are exceptions to this for safety reasons e.g.
the Can update pack size, cost and sell price permission on the Permissions tab.
• The Copy button: Copies the state of all the checkboxes on the tab for this store to an internal clipboard for that tab.
• The Paste button: Pastes the checkbox settings saved to the clipboard for the current tab to this tab. In this way, the Copy and Paste buttons
are a great way of copying permission settings for tabs between stores - really handy when users have similar permissions in different
stores.
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Most of the permissions are self explanatory. Those that need more explanation are given below:
Permission

Details

Permissions Tab

Add/edit users

To prevent you being locked out of your datafile permanently, mSupply will not allow you to turn off
this preference for the first 2 users which already exist when you open mSupply for the first time. You
should always treat these users as admin users.

Permissions (2) Tab
Change transportation dates on
finalised invoice

If checked, the user can edit the Order written date, Order received date, Expected arrival date,
Actual arrival date and Ship date fields on the Transport details tab of finalised customer invoices

Edit user fields on finalised invoices

The user fields are the 4 custom transaction fields that can be enabled in the preferences - see Invoices
Preferences for details. If this is enabled the user can edit the contents of these fields on transactions that
have already been finalised

Change invoice category on finalised
invoice

If checked the user can edit the transaction category of invoices (customer, supplier and inventory
adjustments)

Transfer goods between stores

If checked the user can create a customer invoice with a store as the customer (i.e create a stock transfer)

Finalise stock transfers

If checked the user can finalise a customer invoice where the customer is another store (i.e. a stock
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Permission

Details
transfer)

Permissions (3) Tab
Can edit stocktake dates

If checked the user can edit the Stock take date field at the top of a stocktake and the confirmed date of
inventory adjustments created from the stocktake (see Creating a new stocktake) for details

Edit visibility in stores

If checked the user can edit the visibility of names and items in different stores. If it is unchecked they
can't - either in the Store tab of a name or item's details window or the Visibility tab of a store's details
window (in fact, the Visibility tab won't even be visible for them)

Add/import customer budgets

If this is checked the user can import or add budgets for a customer, if unchecked they cannot

Edit/delete customer budgets

If this is checked the user can edit or delete budgets for a customer, if unchecked they cannot

The Login rights tab
On this tab you set which stores the user can login to:

The Is disabled column indicates whether a store is disabled or not and can't be edited.

904

mSupply user guide July 2018

You can check one box in the Default store column - this will be the store the user is offered by default every time they login or switch stores.
In the Can login column you can check the box for each store the user is allowed to login to. All the stores in your mSupply datafile are displayed here
in alphabetical order. Please note:
• The “Drug Registration” store is a special store used for the mSupply medicine registration functionality. See Registration for more details.
Checking this box will allow the user to login to the Registration module.
• The “Hospital Info System” is another special store used for mSupply's built-in Hospital Information system. See here for more details.
Checking this box will allow the user to login to the HIS module.
• “Supervisor - All stores” stores is a special mode to allow users to view information in and run reports over multiple stores. See here for
more information.

The Details tab

Here some personal details including job title, address and email address of the user can be recorded. The job title will appear in the Job title column
in the list of users and the email address is used when using email functionality or other special functions in mSupply.
Other than that, these fields are for reference only, providing a handy place to record information about your system users.
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The Dashboard tab

On this tab you set which dashboard tabs will appear on the dashboard when the user logs into it. Of course, you have to set up the dashboard tabs
before you can assign them to a user's dashboard. See Dashboard for instructions on doing that.
Once the dashboard tabs have been setup, they will appear in the Available column of this tab. You can see the “Test_tab” in the screenshot above.
Anything in the Chosen column will be displayed on the user's dashboard. So, to make a dashboard tab appear on the user's dashboard, select it in the
Available column and click on the >> icon to move the tab into the Chosen column. And to remove a dashboard tab from the user's dashboard, simply
select it in the Chosen column and click on the << icon to move it back into the Available column.

To Create a new user
To create a new user do this:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Go to File > Edit users… and click on the New user button
Enter the user name
Assign a password
Enter the password again in the Confirm password text box
Go to the permissions tabs and set up permissions (3 tabs) OR select which group the user is to belong to using the Is a member of drop
down list on the General tab (you must do one of these because you'll have noticed that when you create a new user they have absolutely no
permissions at all!)
Go to the Login rights tab and set the stores the user can login to.
Click OK when you're done.
The user should now be able to log in.
After the user logs in, they may want to change their password.
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To Delete a user or group
To delete a user do this:
1. Go to File > Edit users…
2. Double-click the name of the user or group you want to delete in the list
3. Click on the Delete button on the bottom of the edit user window that opens
Note that you won't be able to delete a group that has users belonging to it. If you really want to delete the group, remove all users from the group first
by editing their Is a member of fields.

Managing and using groups
Adding a group
Show the list of groups by opening the “Edit user” window and then choosing “Groups” from the “Show” Drop-down menu
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To add a group, click the Add Group button. You will be shown a window where you add the group name. You then set permissions for the group in
the same way as you set permissions for a user (above):

Note that you will only be able to set checkboxes which can have different settings in different stores. Anything that is not a checkbox and that applies
across all stores cannot be set in a group's permissions. These items will all be disabled when creating or editing a group.

Editing a group
First, show the list of groups by opening the “Edit user” window and then choosing “Groups” from the “Show” Drop-down menu
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Then double click on a group in the list. The same window as for adding a group opens but it is populated with the group's current settings. Change
these settings as described for a new group above and click on the OK button to save them.

Using groups
Groups are a quick way of setting and managing permissions for many people at a time. Users belonging to a group take the permissions of that group:
when a user is a member of a group you cannot edit their permissions directly, you must edit the group's permissions. And if you edit the group's
permissions, you edit the permissions for every user in the group. To assign a user to a group, do the following:
1. Go to File > Edit users
2. Double click on the user you want to edit
3. On the general tab of the window which opens, use the Is a member of drop down list to select the group the user is to belong to:
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4. Click on the OK button to save you changes.

User License Categories
A menu item on the Special menu of the navigator gives access to a form to view and edit user license categories, including the number of users
belonging to them that can be logged in at any one time. A DDL on the user input form allows a user to be assigned to a category and a new
permission covers the ability to edit these license categories and membership of them. Finally, a check on the OK button of the login form will check
that there are less than the maximum users belonging to the license category the user belongs to already logged in.
Previous: mSupply Deployment Next: Show Connected Users
2011/05/05 04:22

·

Show connected users

Note: Not applicable when running mSupply in single user mode

To display a list of users currently logged on to mSupply, select Special > Show connected users (Ctrl + Shift + U). The window below is displayed.
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Messaging other users
By highlighting one or more users (use control on Windows/ command on Mac to highlight multiple users), a message typed into the Message box
will immediately appear on the selected user(s) mSupply window when you click on the Send button.
Such messages are not stored on the system.
Previous: Managing Users Next: License Management
2011/05/20 07:02

·

License management
On any mSupply server, you have concurrent user licenses. When a user logs in, they take one of these licenses, when they logout the license is
returned. These licenses sit in a single pool, to be used by all users who login to that server.
Sometimes, it can be helpful to split this single pool up into multiple smaller pools. This would be the case when, for example, different organisations
use the same server and buy licenses separately for use by their organisations. It is then important that one organisation does not start to use the other's
licenses.
To help manage this kind of situation, mSupply has the concept of user license categories. Each of these categories has a maximum allowed number
of users logged in at the same time. Each time a user logs in, mSupply checks whether they belong to a license category and, if so, whether there is
already the maximum number of users for that category logged in. If so, then the user is shown a warning message and not allowed to login, otherwise
they are logged in as usual.
Please note that user license categories are still subject to the concurrent user limit (set by the number of licenses you have purchased), they do not
override it. So, if you have 10 concurrent user licenses on your server and you have one or more user license categories with a total maximum number
of logged in users set at 20, only 10 users will still be able to log in to your server at any one time. This functionality is not a free way to get yourself
extra mSupply licenses, rather it's a way of helping you manage access to the licenses you have purchased!
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User license categories only apply to an mSupply server so you won't be able to set them on a single user copy of mSupply
(including single user satellite copies in a sync system). There's no point since only a single user can log in at a time to these
versions of mSupply!

It is also important that you understand that each mSupply server has its own pool of concurrent user licenses so, if you have
more than one mSupply server in your system, you can set user license categories on each server. You cannot set user license
categories that affect more than one mSupply server.

Viewing existing user license categories
Choose Special > Show user license categories… from the menus. The following window will open showing a list of all the user license categories
you have setup in your datafile:

Creating a new user license category
To create a new license category, click on the New button in the window displayed above and a new window will open:
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Enter the details of the new license category:
• Description: the name the category will be known as throughout mSupply
• Maximum number of users logged in: the maximum number of users that belong to this group that are allowed to login to this mSupply
server at the same time
Click on the OK button when you're finished and you'll be taken back to the license category list window, which will now include your new license
category.

Editing an existing user license category
To edit an existing user license category, view the list of existing ones by choosing the Special > Show user license categories… menu.
Now double-click on the license category you want to edit in the list and, in the window that opens, edit the category's description or maximum
number of logged in users and click on the OK button to save your changes. You will be returned to the list of user license categories which will show
the changes you just made.

Changing the maximum number of logged in users of a license category will not affect any users already logged in who belong
to the category (even if there are more than that number already logged in) since the check against this number is only made
when a user logs in. But it does mean that it will affect any users who login from that point forward. So, if there are more than
the maximum number logged in after a change, then no more users belonging to that license category will be able to log in.

Deleting a user license category
To delete a user license category simply view the list of existing ones by choosing the Special > Show user license categories… menu, select the
license category you want to delete in the list and click on the Delete button.
Note: you will only be able to delete a license category if it has no users assigned to it. If you receive a warning to that effect then edit all the users to
remove them from the license category first (see below for details), then return here to delete the license category.

Assigning users to license categories
To complete the setup you must assign users to the different user license categories you have created.
You do this by selecting the user license category the user should belong to in the License category drop down list on the General tab of the user's
details window. See Managing users for more details on how to set this.

Any users not assigned to a user license category will always be able to login (as long as there is a concurrent user license
available in the server's pool). So be careful when using user license categories - leaving many users not assigned to license
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categories can undermine what you are trying to achieve.

Normally, you will assign more users to a user license category than the maximum number of users logged in setting for the category. Otherwise, the
user license category check on login will have no effect!
Previous: Show Connected Users Next: Printer Installation
2011/05/20 06:48

·

Label printer installation
We recommend Zebra GK420 TT printers with a network port. You may use other printers that support the ZPL printing language (or EPL if using
mSupply 3.2 or earlier), but we can not provide much support for these models as we have not used them ourselves.

Setup
1.
2.
3.
4.

Load the printer with ribbon and labels.
Turn on
Plug in network cable.
By default the printer is set to obtain an address by DHCP. Assuming you have a DHCP server on your network: press the button on the
front and hold until it flashes once, then release the button. A configuration label will print. Note the IP address. If the printout is the wrong
width and unreadable, see “Setting label width” below
a. You may also be able to get the IP address from the list of DHCP leases when logged in to your router (e.g. for pFsense: Status
> DHCP )
5. There are now 2 options for setting a static address
a. (Preferred method): Configure your DHCP server to assign a static address to the printer. Note that after doing this, you may
have to turn the printer off and back on to get the new address from the DHCP server.
b. Alternative: Assign a static address on the printer itself. The default static address for the printer is 192.168.254.254.
I. You can now log on to the printer using it's current IP address http://printer_ip_address (http://printer_ip_address)
where printer_ip_address is the current printer's ip address.
II. Go to “Print Server Settings”, then click “Print Server” and log in
▪ user: admin
▪ pass: 1234
III. Go to “TCP/IP Configuration” and set an IP address that is not within a range controlled by DHCP (Ping it to ensure
it is not already assigned)
IV. Set the IP Protocol to “Permanent”, and submit
V. Reset the printer (you can do this from the web interface)
6. Ping the IP address you have set to ensure the printer has the right address
7. Finally, tell mSupply about the printer: see Printing Preferences for instructions on doing that.

Setting label width
Note that you do not have to do this to get the right width when printing from mSupply. This is only for viewing a configuration label before using
mSupply:
Hold down the button on the front of the printer - it will flash once, then twice, then three times, then four times, then five times: immediately release
the button. Labels will print with a box that gets wider with each one: press the button again when the box is the width of the label. If needed, you can
use the “one flash” sequence above to print out the IP address and other information once you have the printer detecting the label width correctly.

Flash sequences for the GK420
The following flash sequences occur in order by holding down the front button (“3” means you hold the button and it flashes once, then twice, then
three times, and you immediately release the button for that action to be performed)
1. Print status
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2.
3.
4.
5.
6.

Media callibration: use to make the printer detect the length of the labels you're using
Serial port config: not needed
Factory defaults: Sets everything back to default settings
Print width adjustment (above)
Manual media calibration (you most likely don't need this)

Previous: Set Start of Year Stock Next: The Log
2014/10/23 22:41

·

The log
The log contains records of who did what and when in the system. It's a useful place to look to find out what happened to certain records and when
certain things were done. Some events (lots!) are always logged by mSupply but some are optional and are chosen in the Log tab of the General
preferences page.
To view the log, choose View log… from the Special menu. You will be shown all today's log entries when the window loads:

Buttons in the window:
• Export Export the log to a tab delimited text file. You can then import this into other applications (such as a spreadsheet application) for
editing and printing.
• Print Prints the displayed list of log entries on your printer.
• Order by Sort the log by something than the default date/time order.
• Find Search for particular records in the log.
• OK Close the window.
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Double-clicking a log entry will bring up a small window with the full item
details. You can not edit this information.

Dates
If you want to see log records that were generated over a different period then manually edit the dates in the From and To boxes as required or choose
one of the many quick-select options in the drop down list to automatically set them (Today is selected by default):

Event types
Additionally, you can choose to show only certain types of event which occurred in the period you have selected. To do that, select one of the entries
in the final drop down list on the right hand side (All is selected by default):
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See this section for a complete description of which events are recorded in the log.
Previous: Printer Installation Next: Server Troubleshooting
2011/05/20 06:46

·

Server troubleshooting
Service not running
If the client is unable to connect to the server, it is quite possible that the mSupply Server Service is not running.
You can check by going into Control Panel>Administrative Tools>Services

917

mSupply user guide July 2018

Look for the service named 4D. THe status should be “running” or “started” and it should be set to automatic.

If it is not running or started you can click the play button above the list of services while you have 4D highlighted. The status should now read
“running” or “Started”. If it doesn't please contact mSupply Support for help. support@msupply.org.nz

Sync not working
If, on a sync satellite client, the number of sync records stays static, or continues to grow over a significant period (hours), then sync between the
(Sync Satellite server to the sync Primary server) has stalled.
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A probable reason for this is that the Sync Satellite server can not connect to the sync Primary server. You can check this by checking the logs (Special
> View log…):

There are a number of possible reasons for this:
• The Sync Primary server hardware is down. Check that the Sync Primary server hardware is up.
• The Sync Primary service (software) is down. Check that the Sync Primary service (software) on the Sync Primary server hardware is up.
• The IP address of the Sync Primary server hardware is incorrect. The IP address of the Sync Primary server should be a domain name,
orgname.msupply.org. However, this domain name will be mapped to an IP address that should be static. If the ip address of the
Sync Primary is different to what the domain name server maps it to, then sync will fail. To confirm this:
◦ Find the IP address of the Sync Primary server hardware, at the Command Prompt on the Sync Primary server, enter
ipconfig.
◦ Find the IP address that the domain name server thinks is associated with the domain name, at the Command Prompt on the
Sync Satellite server, enter nslookup orgname.msupply.org. Compare the reported ip addresses.
• Access to the Sync Primary server hardware may be blocked by a firewall or proxy server on the Sync Satellite server network. A simple
diagnostic test for this is to open a browser and enter the following in to the address field: https://myserver.msupply.org/
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sync/ (https://myserver.msupply.org/sync/).
◦ If the web page responds with an error message from the Primary Server, then the Primary Server is reachable:

◦ If the web page responds with a firewall or proxy error message, then the firewall / proxy server needs to be configured to allow
access from the Primary secondary server to https://myserver.msupply.org/sync/
(https://myserver.msupply.org/sync/):
Previous: The Log Next: The Help Menu
2015/05/05 00:34

·

The help menu
Help > About mSupply
Choosing this item displays information about the version of mSupply in use, and provides details of the location and size of your data file.

You can click the blue arrows icon to retrieve the current version number from the internet. (This will not download a new version- it will only advise
whether a newer version is available for download).

Authorisation
The Authorisation button is provided largely for developers' use. Its purpose is to assist our technical staff to resolve clients' problems. It is
recommended that you ignore it.

Updating mSupply
For single user versions of mSupply, you can see if you have the latest version by choosing Special > Check for updates
Choosing this item from the Special menu will connect to the mSupply web site and compare your current mSupply version with the version you are
now using.
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If an update is available, you will be shown a window where you can click to download the latest version.

Previous: Server Troubleshooting Next: FAQ: Why is my stock balance negative?
2011/05/20 06:52

·

The mSupply support portal
We all like it when things run smoothly but every so often things go wrong. The mSupply Support Portal is where you go to get technical support for
mSupply.

Log a one-off Support Ticket
To log a support ticket with our support team, go to https://support.msupply.org.nz/ (https://support.msupply.org.nz/) and enter the details of the issue
and click the “send message” button.

921

mSupply user guide July 2018

Register
If you are a regular support user, it makes sense for you to register with us so you can keep track of your support tickets.
To register, click the green sign in button on the right

then click on the link “Don't have an account? Create one for free.”.

Enter your email address and click the “Send Confirmation Email” button.

This will send an email with a code to your selected email address. Enter this code and your name and password into the next screen and click the
“Register” button.
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Once registered and signed in, you will be able to lodge support tickets, access ticket history and administer your account. Under my account, you can
also use the “Sharing/Collaboration” link to the left of the window to share tickets with others in your organisation.

2018/02/19 02:46

·

Why is my stock balance report showing negative
Occasionally mSupply will show negative stock balances when running reports to view stock levels at a past date. This may look to be wrong but in
many cases this is mathematically correct.
The two primary reasons for the cause in negative stock values are :
• You may have entered backdated customer invoices using the current available stock. Here you would have created a customer invoice, but
modified the confirmed invoice date to reflect past transaction.
• You issued backdated placeholder lines on confirmed invoices using the current available stock. Initially when you created a customer
invoice, you had no stock but had to resort to placeholder lines. After receiving stock, you re-open the old confirmed customer invoice to
issue the placeholder lines with recently available stock.
In both the cases if you were to report on stock level at a certain point ( the date before you receive supplies), then you may get negative stock values.
mSupply to calculate stock level at a certain date needs to work back from current stock level. So if your data shows that you have issued stock that
you haven't technically received due to the order of the confirmed date, then you are likely to see Negative stock balance.
The image below shows a ledger for a single batch that was received in 16/2/2016, but between 04/09/2015 to 27/10/2015, the stock has been issued
inside three backdated invoices.
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Previous: The Help Menu Next: FAQ: How Do I Remove Stock Lines That Have 0 Available?
2016/06/23 11:15

·

How to remove stock lines that have ‘0’ available
Occasionally users will come across stock lines in mSupply that cannot be removed easily. It almost like you have stock but you cannot carry our
stock take or inventory adjustment to reduce the stock level to zero.
Below are two examples :
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Above we have Paracetamol 500mg where for the highlighted batch ( red square ) we have a total of 100 but available is 0. This means that 100 in
stock but all of this has be reserved for a customer.
Below is another example :
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For Amoxycillin 250mg we have 92 in total and 42 available. This means that we have 92 - 42 = 50 reserved for customers.

Handling reserved stock
Customer invoices that are of status “nw” or “sg” will end up reserving stock. This theoretically means that you have the stock but it cannot be used as
it has been reserved by the invoices.
You as a manager will be required to view the “nw” and “sg” invoices and decide if they are still valid or not. If the invoices are valid then you should
“confirm” them if not they can be deleted.
So search for customer or prescription that are of “nw” status. Follow the image below. Do customer > Show invoices… or patient > Show
Prescriptions…
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Search for “Status” equal to “nw” as above. If the “nw” invoices exist, then you will be shown a list. Double click to review. Delete if the invoice is
not valid otherwise “Confirm”.

“nw” invoices will exist in the database if you have suffered un-expected hardware
or network communication failure.

Now repeat similar for “sg” type invoices :

“sg” invoices are part of the warehouse functions. You may have simply forgotten
about these invoice or the customer lost interest in the order.

Your search for “nw” or “sg” invoice may result is the list below.
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Note the highlighted “Status” column
Your job is now to review each invoice and to either “confirm” them or to delete them. Theses invoices may no longer be valid, you have to decide on
this.

Confirming a invoice
Just incase, if you don't know this, then this is how you confirm the invoice.
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Note the status detail. We want this to show “cn” and not “nw” or “sg” Hit the “confirm” truck.
For prescription, you won't see the “confirm” truck, simply review and click “OK” to close the prescription and mSupply will automatically confirm.
For prescription, you will be facing “nw” invoices.

The Result
Once all the “sg” and “nw” invoices are processed, then your stock figures should update and they shouldn't be any stock that has been held as reserve.
Below the images should speak for themselves. Please compare the image below with the ones above at the start of this topic.
Paracetamol 500mg :
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Amoxycillin 250mg :
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Previous: Why Is My Stock Balance Showing Negative? Next: FAQ: How to Correct Wrong Pack Sizes
2017/02/03 09:01

·

What do I need to set up mSupply mobile
Information Required
• The new mSupply Mobile store needs to be set up in mSupply desktop. The Sustainable Solutions team can help you with this, but some
information is needed:
◦ Store Name e.g. Mobile Clinic HC
◦ Store Code e.g. mobilehc
◦ Sync Site Name This is a Sync Site associated with the Store Name, and is usually the same as the Store Name, e.g. Mobile
Clinic HC
◦ Item Master list for items to be visible in the mobile store, e.g. TB Clinic Items
◦ A list of Stores and Customers to be visible in the new mobile store.
◦ A list of Stores where the new mobile Store will be visible.
◦ A list of 'transfer' Stores. These are stores that current mobile store can order/send stock. This should be the same list as the list
of Stores where the new mobile Store will be visible.
• A few things that can be done by a user:
◦ Create the User Name (and Password) in mSupply desktop for the user that will log in into the new mSupply mobile store on
the tablet - refer Managing users.
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The Sync Site Name, User Name and Password will need to be entered when
logging in to mSupply Mobile on the tablet. It's advised to consider making them
easy enough to enter via touchscreen keyboard!

Installation of mSupply Mobile APK and initiation
• Download the mSupply Mobile .APK file to your tablet from the link provided by Sustainable Solutions. Check with Sustainable Solutions
for the download link. Depending on your mSupply server version, you may require specific version of mSupply Mobile.
• Once the download is completed and the app starts, it will ask for:
◦ Primary Server URL, which will look something like https://msupply.demo.org:2048
(https://msupply.demo.org:2048). This will be advised to you by Sustainable Solutions.
◦ Sync Site Name, e.g. Mobile Clinic HC (as provided above) .
◦ Sync Site Password. This will be provided by the Sustainable Solutions team once the store has been configured in mSupply).

• Now the initial sync will start.

The initial sync could take quite some time. Please ensure that the internet
connection is stable, and be patient. If the initial sync has been interrupted, you
will need to restart the app and re-enter the above information.
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User Login
After the initial sync is complete, another page will open asking you to login as a user:
• User Name, as created in mSupply desktop, above
• Password

• An existing store can be be turned into an mSupply mobile store
• An existing customer (that is NOT a store in mSupply) can also be
turned in to an mSupply mobile store. However, this requires that all
Customer Invoices for the customer are finalised.
• To help Sustainable Solutions set up multiple stores at once, please use
the attached excel template, filling out ALL information.
msupply_mobile_setup_template.xlsx

2018/02/15 05:33

·

Why is my stock on hold?
There are a number of reasons why stock can be On hold, and therefore cannot be issued by mSupply. Depending on the reason, there will be different
actions required to issue the stock.
• The Item is On hold - refer About items, Tabs on the Item Details Window, The General tab
◦ mSupply will allow you to manage this stock, but it will not allow you to select this item for issue. To issue stock, you will need
to take the Item off hold.
• The Stock line is On hold - refer Issuing goods to a customer (customer invoices), Adding lines to an invoice, Selecting from Item Lines,
Lines on Hold for an explanation and instructions on how to change the hold status of the stock line.
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• The Location is On hold - refer Locations and location types, Adding a location, General tab for an explanation and instructions on how to
change the hold status of the location.

2018/03/15 09:58

·

How to correct wrong packsizes
Within a warehouse or pharmacy, it is quite common for procurement managers to introduce bulk stock into mSupply and then for the dispenser to
issue the bulk stock wrongly to the customer or patient. So physically the bulk stock may have been broken down to smaller pack sizes and distributed
but this activity may not have been registered properly within mSupply.
In an warehouse environment, bulk stock from the supplier may have been received and the stock may have been issued by the dispenser without
paying attention to the pack sizes. An administrator may have forgotten to carry out a “Repack” or “Split” process within mSupply.
In an pharmacy environment, the above could also be true. However, most users tend to rely on the stock being introduced to the system in the correct
pack sizes (suitable for patient consumption) and when this is not done, the dispenser simply issues stock with large pack sizes.
In both cases the customer or patient receives drug quantities that tend to be less than what mSupply says. Depending on the user permission allocated
to an mSupply user, the pack sizes can be corrected. However we emphasise that our clients should take measures to ensure that these errors do not
occur frequently. Only high level users should have the appropriate user permissions to carry out the task below.

User permissions
Firstly to correct pack sizes you need to have the following user permission :
• Can update pack size, cost and sell price
Do the following :
•
•
•
•

View File > Edit Users…
Double click on the user that requires the right to correct pack size mistakes.
View the “Permissions” tab
Make sure the permission “Can update pack size, cost and sell price” is ticked (see image below)
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Locating the item
For this tutorial let's assume that we are inside a pharmacy where Amoxicillin 250mg tab/cap should have been introduced as single tablets rather than
boxes of 100 tablets. The pharmacy never has to dispense the whole bottle (100 tablets) to one patient.
View the item where the pack size needs to be adjusted :
• Item > Show items… from the mSupply menu. Use the search filter
• Navigate to the item in the list and double click.
• Go to the “stock” section. View the image below:
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The image above shows that a batch of Amoxicillin 250mg tab/cap has been received in packs of “100”.
Double click on this stock line and view the ledger associated with this batch:

The image above shows that two patients (John Smith and Jennie Parker) were issued in total 500 and 200 tablets when the correct amount should
have been 5 and 2 tablets. Let's assume that the pack size on all should in fact be “1”
Now close the item stock line details window and view the item again.

Getting to the source
To correct the pack size from “100” to “1”, we now need to locate the invoice that initially introduced this batch (b39399) of Amoxicillin 250mg tab/
936

mSupply user guide July 2018

cap to our stock.
Do the following :
•
•
•
•

Get back to the item detail window showing the batch lines.
Select the batch line.
Then click on the “Show related invoices” icon
You will now be presented with a list of invoices connected to this particular batch of stock.

Locating the stock introducing invoice
From the list of invoices we now need to view the invoice that initially introduced the stock.
The image below contains customer and patient invoices (“ci” type), an inventory adjustment (“sc” type) and a supplier invoice (“si” type). The
supplier invoice has been highlighted.
Double click on the line for the supplier invoice to open it.
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Viewing the invoice
View the invoice and you will see one or more lines showing items that have been introduced to stock. Among them will be one containing the item
you're interested in - make sure you identify the right one because there could be more than one batch of that particular item. For this example the
invoice only contains one line. This invoice line was responsible for introducing an unsuitable pack size for dispensing purposes.
Double click on the line to open up the supplier invoice line:
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Correcting pack size
You should now see a window similar to the image below :

For this example lets assume that the total quantities are correct. Here we did indeed receive 20,000 tablets. So we are going to make the following
adjustments.

The step below is only possible if you have the user permission “Can update pack
size, cost and sell price” set as described above. If this permission is not set, the
pack size is disabled but still viewable.

Below we have changed the packsize to “1” and pushed the quantity to 20,000
So, as before, the total tablets we have received is : 20,000 X 1 = 20,000
Click “OK” to save the changes.
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We are done. Close the invoice.

Review of the changes
Now, to see the result of the pack size adjustment, view the item and its ledger associated with batch “b39399”:

From the image above we see that the available and total stock figures have changed.
We can also see that pack sizes on past ledgers have been converted from “100” to “1”.
Previous: How To Remove Stock Lines That Have '0' Available Next: How to report by invoice category
2012/02/13 04:44

·
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How to report by invoice category
Within mSupply if you have categorised invoices (or transactions) in a particular manner then you will be able to run reports based on this category. In
dispensary mode Prescriptions can also be categorised. For example you may be required to tag your customer invoices as “Government” or “Private”
facilities.
Follow these steps to generate a report by invoice category :• Make sure there is at least one transaction category available in your data file. If not, then follow the instructions at transaction_categories
to create a transaction category.

For this example the image above shows the addition of two categories for customer invoices.
• On your Invoices window, all of your categories will be displayed under the “Category” drop-down list.
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• Choose the category from the list and click on the OK button. For reporting purposes, the invoice will need to be confirmed.
• For reporting, from mSupply menu or Navigator , View Report → Transactions.
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• On the right hand side of that window, you will see the section “Transaction filter”. Here we have chosen to search for “Code” contains
“govern”, which is equivalent to searching for “Code” equals “Government”. Click on the OK button and you will now have the
opportunity to view items issued to government facilities.
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Previous: How To Correct Wrong Packsizes Next: FAQ: Imprest Work Flow
2012/03/02 06:17

·

Imprest work flow
Version : v3.11 or v3.12 or later
The imprest module allows a pharmacy or warehouse to decide on quantities of drugs its receiver facilities (customers or Virtual stores) should
receive. Periodically a stock take is carried out at the customer's site and drugs are replenished to meet the predefined (imprest) level.
The tutorial below suggest how an imprest should now be carried out.
We will assume that the facility or customer has been assigned with a suitable imprest list. If this is not the case then please do the following:
• Select Item > Show Item master list… from the menus to create a master list (see here for details).
• Assign the master list to the customer. See Item Lists > Assigning a list to a customer for instructions.

Create an Imprest
Click on ‘Requisitions’ in the ‘Customer’ (or Patients) tab.. Click on the New customer imprest icon in he window which appears.

Type the first few few characters of the customer name in the Name field and press tab. A List of matching customers is displayed (unless only one
customer name matches what you entered). Choose the intended customer and click the Use button.
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At this point the master list of items associated with the customer is displayed in its default sort order.

Print the imprest
The image below shows an example of what you now see: a list of items with their required imprest quantities. The next task is to print the list and
carry out a physical stock take at the customer site.
First of all, make sure the list is in the correct order. If it is, fine. If not, re-order it as appropriate (by clicking on the column headers or dragging items
up or down the list) and click on the Save Sort Order button.

Now print the list by clicking on the Print button

and selecting the “Customer stock takes” option.

The print dialogue opens. Here you can add header and footer information for your printouts. Press OK when ready and print the list.
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Please note that after printing the list you should not re-order it - it will be confusing later when you come to enter the counted quantities for each
item.
Now, using the printout, carry out the actual stock take.

Updating the stock quantities
After carrying out actual stock take at the customer's site it's time to enter the actual stock quantities. In the window displayed below, edit the value in
the Customer current stock on hand column with the stock take quantities you've written on the print out for each item.
mSupply automatically completes other two columns (Our suggested quantity and Actual quantity given).

Imprest formula:
• Our suggested quantity = Maximum of
◦ 0, and
◦ Imprest quantity - Customer current stock on hand
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Assigning stock
Once the updating of stock quantities is done and you are satisfied, you can click the Create customer invoice button to assign stock to the customer.
Clicking the button will open the following window:
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All the entries appear in red - they are placeholder lines which have the correct quantity but have no batch chosen (notice 'none' in the batch column
for each line). You have to double-click each line in turn and select which batches you wish to assign to the customer.
As an example, you will see the window below when you double click an item line:
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Normally you would click on the Re-distribute all button to have mSupply make the appropriate selection for you (it chooses batches with shortest
expiry first). Having done that, the window now appears like this:

Clicking on OK & Next displays the next item on the invoice. When the final item has been processed, clicking on OK or OK & Next will display the
complete invoice (all red lines replaced with black lines with the chosen batch displayed). The image below shows the invoice part way through this
process:
When you've selected batches for every line, make sure the Hold checkbox is not checked then confirm the invoice to assign the stock to the customer.
Now all you have to do is print off the pick list, physically pick the stock off the shelves and send it to the customer. Congratulations - job done!
Previous: How To Report by Invoice Category Next: FAQ: Tips and Tricks
2012/11/27 07:38

·

Tips and tricks
mSupply Client: Connecting to a different server
It is unusual, but you may be in a situation where your mSupply client application needs to switch between more than one mSupply Server.
Launch the mSupply client application by double-clicking on the mSupply client icon, then immediately hold down the Alt key until the mSupply
Server connection dialog box appears:
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If you tick the Display this dialog at next startup tick-box, this dialog box will automatically be displayed on startup of the
mSupply client application, and you will not need to do the double-click, Alt routine described above.

There are three ways of selecting the mSupply server to connect to. These are accessed via the tabs: Recent, Available and Custom:
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Recent tab

The Recent tab retains a list of all mSupply servers recently used. The list is sorted by alphabetical order. To connect to a server from this list, doubleclick on its name or select it and click the OK button.
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Available tab

The mSupply Server includes a built-in TCP/IP broadcasting system that publishes by default the name of the mSupply Server databases available
over the network. These names are listed on the Available tab of the connection dialog box.
This list is sorted by order of appearance and is updated dynamically. To connect to a server from this list, double-click on its name or select it and
click the OK button.

Computer networks can be configured to stop dynamic publication of the database name on the network. In this case, you will
need to manually configure the the connection on the Custom tab.
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Custom tab

The Custom tab allows assigning a published server on the network using its IP address and database name.
Database name: allows defining the name of the mSupply Server database.
Network address: allows entering the IP address of the machine where the mSupply Server was launched. If two servers are operating simultaneously
on the same machine, the IP address must be followed a colon and port number, for example: 192.168.92.104:19814.
By default, the publishing port of a mSupply Server is 19813. This number can be modified in the Database Settings… under Client-server tab of
mSupply server.

If a database was selected in the Recent or Available tabs when you clicked on the Custom tab, these two fields display the
corresponding information from that tab.

Once the server details have been entered, clicking the OK button will connect you to the server.

If you tick the Force the update of the local resources tick-box, it allows you systematic updating of the local resources on the
client machine when it connects. As a rule, updating of the local resources is automatic on the remote machine each time it
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connects, when the structure of the database has been modified between two connections. Most of the time, this option is
unnecessary. Nevertheless, in certain specific cases, it may be necessary to force the update.

Emptying out a store and starting again...
Sometimes, the actual stock situation in a store becomes so out of step with mSupply's records that you want to start again from scratch with a brand
new stocktake. To do this, you will need to:
• Confirm or delete all customer invoices with status = nw (New) or sg (Suggested). This should remove from stock all lines that have been
made unavailable, but are still showing as in stock - see figure below.
1.
2.
3.
4.
5.
6.
7.
8.

Click on Customer
Click on Show Customer Invoices
Click on By Status
Click on All new and suggested
Double-click on the first displayed invoice
Click on Confirm (or, if you want to delete the CI, delete each of the lines, and then Click on Delete)
Click on OK & Next
Repeat steps 6 & 7 until all invoices are confirmed (or deleted).

• Empty the mSupply store of all stock by means of an Inventory Adjustment based on an mSupply stocktake of all stock in the store
◦ Create the stocktake - see figure below.
1.
2.
3.
4.

Click on Item
Click on Stocktakes
Click on New stocktake
Click OK (accept default filter values which includes all stock)
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• Set all actual quantities to zero (0) - see figure below.
1. Click once on the first stock line. The whole line will become highlighted.
2. Click once on the value in the 'Enter Quantity' column. The Enter Quantity value will become highlighted
3. Type 0, then press Tab. Repeat this for each line of the whole stocktake. You should be able to be faster than 2 stock lines per second,
maybe a lot faster. At 2 stock lines per second, you can get through 1000 stock lines in less than 10 minutes…
4. Click on Create Inventory adjustments If you've got a lot of stock lines, this could take a while…
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• Import new stock as described in Importing items & stock
Previous: FAQ: Imprest Work Flow Back to beginning: Why mSupply?
2016/05/24 23:04
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8)

·
Essential Drug List
First Expiry, First Out
Vaccine vial monitor (http://www.who.int/immunization_standards/vaccine_quality/vvm_10years_index/en/)
International Classification of Diseases
Remote support - almost 24/7. We aim to provide a first response within 2 hrs
Gives you access to the latest software updates, including assistance with upgrading if needed.
If you don't want to allow this, then simply turn the user preference off
also known as “Cancel invoice” or “Cancel a transaction” or “Cancel an invoice”
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